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KAPITOLA 0.0

A.1

 
Obecné informace A.1
Tato kapitola obsahuje všeobecné informace o programu 
syngo®. 

A.1

Operaèní systém A.1 Program syngo® je urèen pro operaèní systém Windows XP®. A.1

➭ syngo® je registrovanou obchodní známkou firmy Siemens 
AG. 

Uživatelské rozhraní A.1 Uživatelské rozhraní vašeho systému je dostupné v šesti jazycích 
v závislosti na konfiguraci: angliètina, nìmèina, francouzština, 
španìlština (mezinárodní), èínština a japonština. 

A.1

Pøihlášení A.1 Abyste mohli zaèít pracovat, zapnìte poèítaè a pøihlaste se jako 
uživatelé.  
Další informace viz pøíruèka Systém zabezpeèení. 

A.1

Spuštìní programu A.1 Po pøihlášení se automaticky spustí aplikace. 
A.1

Restart hlavní a satelitní 
konzole A.1

Pøi spouštìní systému se také automaticky spustí hlavní konzola 
a satelitní konzoly. Pokud restartujete hlavní konzolu ruènì, 
nezapomeòte také restartovat satelitní konzoly. 

A.1

Zabezpeèení systému 
syngo A.1

Kapitola „Zabezpeèení systému syngo” obsahuje veškeré 
informace o zabezpeèení údajù o pacientovi. A.1

Oprávnìní umožòují uživatelùm spouštìt rùzné funkce 
programu syngo, napøíklad odesílání dat prostøednictvím sítì 
nebo registraci pacienta.  

A.1
Verze VE31D A.1–1 
únor 2006   
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Obecné informace Základy
Kontrolní protokol A.1 V zabezpeèených systémech jsou všechny akce 
zaznamenávány.  
Další informace viz pøíruèka Systém zabezpeèení. 
 

A.1

Správa systému A.1 Více informací o zabezpeèení a správì systému najdete v 
pøíruèce Systém zabezpeèení. 
 

A.1

Používaná jména a názvy A.1 Všechna jména a data pacientù a institucí používaná v tomto 
návodu k použití jsou zcela smyšlená. A.1

Jakákoli podobnost se jmény skuteèných osob èi organizací je 
èistì náhodná. 

A.1

Názvy týkající se konfigurace programu, jako jsou názvy diskù, 
sí¤ových uzlù a databází, které se v tomto návodu k použití 
používají, se vìtšinou liší od názvù, jež se vyskytují v rámci 
systému v urèité nemocnici. A.1

A.1

A.1

UPOZORNÌNÍ A.1

Operaèní systém nemusí podporovat všechny znaky pøijatého 
dokumentu. A.1

Zobrazení jména, napø. jména pacienta, mùže být neúplné 
nebo zavádìjící. A.1

✧ Systém syngo nepoškodí použité znaky (napø. minoritní 
znaky), i když je nemùže zobrazit. Je-li to možné, použijte k 
identifikaci jiné atributy.  
A.1–2 Návod k použití pro uživatele systému syngo
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Základy Obecné informace
Tiskárna na papír A.1 Pøi tisku na tiskárnì jsou k dispozici dvì možnosti: nová úprava 
celých èísel a nová úprava pohyblivé øádové èárky. Výchozí 
nastavení po instalaci je nová úprava celých èísel. A.1

U nové úpravy celých èísel: A.1

❏ obrazy exponované jako pøizpùsobené segmentu nejsou ve 
skuteènosti pøizpùsobené segmentu

❏ obrazy exponované jako oøezaný dokument zobrazují 
mezeru mezi obrazem a segmentem

❏ na tištìných obrazech nejsou žádné artefakty

U nové úpravy pohyblivé øádové èárky: A.1

❏ na tištìných obrazech nejsou žádné artefakty
❏ funkce pøizpùsobit segmentu a oøezat dokument pracují, jak 

se oèekává

Další informace vám poskytne servisní technik. A.1
Verze VE31D A.1–3 
únor 2006
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Obecné informace Základy
Bezpeènostní informace A.1

Bezpeènostní pokyny nebo ostatní dùležité informace, které 
jsou souèástí obecného textu, jsou v tomto manuálu oznaèeny 
tímto zpùsobem: A.1

Varování A.1 Slouží pro oznaèení možného nebezpeèí, které mùže zpùsobit 
zranìní nebo ve výjimeèných pøípadech i smrtelný úraz. A.1

Pøíklad varování A.1 Obsah varování sestává ze tøí rùzných oddílù (Pøíèina, Následek, 
Náprava). A.1

A.1

➭ Systém syngo byl navržen a vyroben tak, aby pøi správném 
používání nemohl zpùsobit smrt.

A.1

VAROVÁNÍ

Nejprve se specifikuje zdroj nebezpeèí. A.1

Poté jsou popsány možné následky. A.1

✧ Nakonec se stanoví opatøení pro prevenci nebezpeèné 
situace.
A.1–4 Návod k použití pro uživatele systému syngo
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Základy Obecné informace
Upozornìní A.1 UPOZORNÌNÍ oznaèuje možné (pøímé) nebezpeèí, které by 
mohlo zpùsobit zranìní nebo poškodit systém. A.1

Pøíklad upozornìní A.1 Obsah upozornìní sestává ze tøí rùzných oddílù (Pøíèina, 
Následek, Náprava). A.1

A.1

A.1

!0

A.1 A.1

A.1

A.1

UPOZORNÌNÍ

Nejprve se specifikuje zdroj nebezpeèí. A.1

Poté jsou popsány možné následky. A.1

✧ Nakonec se stanoví opatøení pro prevenci nebezpeèné 
situace.

V poznámkách najdete užiteèné tipy, napøíklad informace o 
snadnìjším ovládání. A.1
Verze VE31D A.1–5 
únor 2006
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Obecné informace Základy
Varovná hlášení A.1

Systém na vzniklé problémy upozoròuje zobrazením 
dialogových oken s výstražným hlášením. Používají se tøi druhy 
hlášení: A.1

Varování týkající se 
obecného ohrožení (chyba s 
vysokou prioritou) A.1

A.1

A.1 Tento typ varování upozoròuje na vážné problémy, které 
vyžadující bezodkladný zásah èi reakci (mùže být napøíklad 
ohrožen pacient nebo systém). Výstražné hlášení zùstane na 
obrazovce, dokud je nepotvrdíte. 

A.1

Varování týkající se urèitých 
úloh (chybové hlášení typu 
1) A.1

A.1

A.1 Tato varování se týkají urèité aplikace nebo karty úloh. Hlášení 
se zobrazí v rámci aktivního pracovního toku èi aktivní úlohy a 
vyžaduje zásah uživatele, který však nemusí být okamžitý. 
Hlášení mùžete potvrdit a pokraèovat v práci; mùžete však také 
aktivovat jinou kartu úloh a hlášení potvrdit pozdìji. 

A.1

Informaèní hlášení A.1

A.1 Tento typ hlášení obsahuje pouze doplòkové informace 
(napøíklad o výsledku provedené úlohy). Hlášení potvrïte 
stiskem tlaèítka OK. A.1
A.1–6 Návod k použití pro uživatele systému syngo
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Základy Obecné informace
Instalace softwaru a sí¤ A.1

Program syngo se dodává s bezpeènostními pokyny k zamezení 
nežádoucího vnìjšího pøístupu k datùm. S tímto programem se 
nedodává žádná další bezpeènostní technologie (firewall). A.1

A.1

A.1

A.1

UPOZORNÌNÍ

Nedovolené èi nesprávné použití nebo úpravy softwaru, 
hardwaru nebo pøipojení systému k síti. A.1

Neoprávnìný pøístup, poškození zaøízení. A.1

✧ Pøed pøidáním funkcí nebo úpravou dodané konfigurace je 
nutno zvážit veškerá bezpeènostní opatøení s ohledem na 
stávající úroveò zabezpeèení.

A.1

UPOZORNÌNÍ

Použití programu syngo pøímo na veøejné nebo neveøejné síti 
mùže zpùsobit nedostateèný výkon systému A.1

Možné snížení výkonu systému nebo neoèekávané 
chování systému A.1

✧ Program syngo používejte výhradnì ve správnì 
dimenzované a zabezpeèené síti.
Verze VE31D A.1–7 
únor 2006
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Obecné informace Základy
Protivirová ochrana A.1

Jako uživatelé poèítaèe v síti nezapomínejte na to, že systém 
mùže být napaden poèítaèovými viry nebo jiným škodlivým 
softwarem. A.1

Prevence A.1 Svou pozornost zamìøte pøedevším na prevenci: A.1

❏ Byla provedena veškerá bezpeènostní opatøení, která systém 
syngo a data v nìm chrání pøed nežádoucím pøístupem.

❏ Pøenos dat pøes veškeré nežádoucí porty nebo “dveøe” byl 
zablokován. Výmìna dat probíhá výhradnì prostøednictvím 
definovaných komunikaèních cest. Toto opatøení se týká i 
servisního rozhraní, proto je zabezpeèení programu syngo na 
mimoøádnì vysoké úrovni. 

Vhodná topologie A.1 Kvalitní a bezpeèná struktura sítì odolá útokùm vìtšiny virù, 
èervù a podobnì. A.1

Poskytovatelé sítí a správci IT v nemocnicích využívají optimální 
topologii s maximálním zajištìním pøipojených zdravotnických 
zaøízení. A.1

❏ Lékaøská zaøízení se vždy pøipojují do podsítí, které jsou od 
ostatních kanceláøských zaøízení oddìleny poèítaèem s 
bezpeènostním systémem firewall.

❏ Pro všechny systémy pøipojené ke stejné podsíti pøedstavují 
potenciální nebezpeèí programy pro správu pošty, u nichž 
existuje riziko pøijetí virù ukrytých v pøílohách, a prohlížeèe s 
pøipojením k Internetu. 
Doporuèujeme zakázat pøenos tìchto týpù dat do podsítí 
lékaøských zaøízení.

➭ Co se týká dotazù, systém smí pøijímat dotazy výhradnì ze 
vzdálených uzlù.  
A.1–8 Návod k použití pro uživatele systému syngo
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Základy Obecné informace
Vyhledávací antivirový 
program A.1

Doporuèujeme spustit instalovaný antivirový program. A.1

✧ Otevøete nabídku Start a zvolte položku Programs > Trend 
Micro Officescan WinNT > Officescan NT.

➭ Další podrobnosti najdete v online nápovìdì k antivirovému 
programu Trend Micro.

A.1
Verze VE31D A.1–9 
únor 2006
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Obecné informace Základy
A.1–10 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

A.2

 
Základy pro zaèáteèníky A.2
Tato kapitola je urèena pro zaèáteèníky, jejichž zkušenosti s 
prací na poèítaèi v operaèním systému Windows XP® jsou 
omezené. A.2

V této kapitole se nauèíte používat aplikace a zadávat data. A.2

Nejprve se v krátkosti seznámíte s uživatelským rozhraním 
programu. Poté se dozvíte, jak používat poèítaè pomocí myši a 
klávesnice. A.2

V této kapitole naleznete také vysvìtlení ovládacích a vstupních 
prvkù uživatelského rozhraní programu. 

A.2
Verze VE31D A.2–1 
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Základy pro zaèáteèníky Základy
Aplikace A.2

Po spuštìní systému se na obrazovce objeví uživatelské rozhraní 
programu. 
Je dále rozdìleno do tìchto oblastí: A.2

(1) Øádek nabídek
(2) Snímek a pracovní prostor pro karty úloh
(3) Záložky karet úloh
(4) Záložky karet dílèích úloh
(5) Øada karet dílèích úloh
(6) Stavový øádek
A.2–2 Návod k použití pro uživatele systému syngo
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Myš a klávesnice A.2

Myš a klávesnice slouží k zadávání pøíkazù a ke vkládání 
uživatelských dat. 
 
 

A.2

Kurzor myši A.2

A.2 ➭ Pokud kurzor myši na obrazovce nevidíte, jednoduše myš o 
kousek posuòte.

Kurzor myši mùže mìnit vzhled podle toho, jaká aplikace je 
právì aktivní nebo jakou akci chcete provést. 
 

A.2

Kurzor 
A.2

✧ Posuòte kurzor myši do oblasti, do níž chcete zadat text.

Kurzor myši zmìní tvar a stane se z nìj svislá èárka. Nyní se z nìj 
stal textový kurzor, který ukazuje, kde se zobrazí zadané znaky.A.2
Verze VE31D A.2–3 
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Používání myši A.2

Nejprve posuòte myš na nìjaký objekt (napøíklad snímek). Pak 
mùžete provést následující akce: 

A.2

Jednoduché kliknutí 
A.2

Tlaèítko myši krátce stisknìte a uvolnìte je. Bìhem tohoto 
úkonu myší nepohybujte. A.2

Levým tlaèítkem myši vyberáte objekt, 
pravým tlaèítkem myši vyvoláte místní nabídky. 
 

A.2

Dvojité kliknutí 
A.2

Poklepání znamená, že dvakrát za sebou rychle klepnete na 
tlaèítko myši a opìt je uvolníte. A.2

Dvojitým kliknutím lze napøíklad spustit programy (levé tlaèítko 
myši) nebo provést automatickou úpravu okna (prostøední 
tlaèítko myši). 
 
 
 

A.2

Pøetáhnutí myší 
A.2

Stisknìte tlaèítko myši a myší poté pohybujte, tlaèítko však 
neuvolòujte. Tímto zpùsobem mùžete napøíklad kreslit grafické 
objekty (levé tlaèítko myši) nebo urèovat úrovnì oken 
(prostøední tlaèítko myši). 
 
 

A.2
A.2–4 Návod k použití pro uživatele systému syngo
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Pøetažení a puštìní A.2 Klepnìte na objekt levým tlaèítkem myši, tlaèítko pøidržte a 
pøesuòte objekt na jiné místo. Potom tlaèítko opìt uvolnìte. A.2

 

Otevøení  
místní nabídky A.2

Kliknutím pravým tlaèítkem myši lze zobrazit místní nabídku pro 
vybraný objekt nebo aktivní oblast obrazovky (kromì karty 
Viewing). 
→ Strana A.2–4, Používání myši 

A.2
Verze VE31D A.2–5 
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Klávesnice A.2

Klávesnice slouží k zadávání textu a èíslic. Pomocí kombinací 
kláves a èíselné klávesnice lze také spouštìt urèité funkce a 
programy. A.2

 

(1) Funkèní klávesy
(2) Klávesy pro psaní
(3) Kurzorové klávesy
(4) Klávesnice se symboly
A.2–6 Návod k použití pro uživatele systému syngo
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Používání klávesnice A.2

Pomocí myši a klávesnice lze vykonat témìø všechny pøíkazy. 
A.2

Vyvolání nápovìdy A.2 S programem se dodává nápovìda, kterou lze otevøít klávesou 
F1. 

A.2

Aktivace karet úloh A.2 Další funkèní klávesy slouží k aktivaci jednotlivých karet úlohy. 
→ Strana A.2–32, Karty úloh A.2
Verze VE31D A.2–7 
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Spouštìní aplikací a funkcí A.2 "Symbolová klávesnice" Vašeho systému vypadá jinak, než 
numerické klávesy na klávesnici u standardního PC. V tomto 
systému byly k tìmto klávesám pøiøazeny urèité funkce. Tyto 
klávesy rozpoznáte snadno, protože jsou na nich rùzné 
obrázky. A.2

➭ Pokud systém není vybaven originální klávesnicí Siemens, 
mùžete tyto funkce a programy aktivovat pomocí 
odpovídajících kláves bìžné èíselné klávesnice.

A.2 Støed okna - (èíselná klávesa Num) 
(Jas -) 
 

A.2

A.2 Støed okna + (èíselná klávesa /) 
(Jas +) 
 

A.2

A.2 Šíøka okna - (èíselná klávesa *) 
(Kontrast -) 
 

A.2

A.2 Šíøka okna + (èíselná klávesa -) 
(Kontrast +) 
 

A.2

A.2 Automatické nastavování okna (èíselná klávesa 9) 
 
 

A.2
A.2–8 Návod k použití pro uživatele systému syngo
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A.2 Posun ve studii zpìt (èíselná klávesa 7) 
 
 

A.2

A.2 Posun ve studii vpøed (èíselná klávesa 8) 
 
 

A.2

A.2 Posun v sérii zpìt (èíselná klávesa 4) 
 
 

A.2

A.2 Posun v sérii vpøed (èíselná klávesa 5) 
 
 

A.2

A.2 Posun obrazu zpìt (èíselná klávesa 1) 
 
 

A.2

A.2 Posun obrazu vpøed (èíselná klávesa 2) 
 
 

A.2

A.2 Opravit text obrazu (èíselná klávesa 6) 
(tato funkce v této verzi softwaru není podporována) 
 

A.2
Verze VE31D A.2–9 
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A.2 Zvolit položku Patient Registration (èíselná klávesa 0) 
 
 

A.2

A.2 Zvolit položku Patient Browser (èíselná klávesa .) 
 
 

A.2

A.2 Copy to Film Sheet (èíselná klávesa Enter) 
 
 
 
 
 

A.2

A.2 Mark (èíselná klávesa 3) 
 
 

A.2

A.2 Odeslat do uzlu 1 (èíselná klávesa +) A.2
A.2–10 Návod k použití pro uživatele systému syngo
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Používání klávesových 
zkratek A.2

Stisknutím kláves Ctrl, Alt nebo Windows a další klávesy lze 
velmi rychle zadávat pøíkazy poèítaèi. A.2

➭ Všechny funkce lze vykonat stisknutím klávesy Alt spoleènì s 
klávesou písmene, které je na tlaèítku nebo v nabídce u dané 
položky podtrženo. Program lze takto ovládat bez použití 
myši.

V následující tabulce najdete nejdùležitìjší kombinace kláves: A.2

A.2

A.2

Alt + F4 Zavøít prohlížeè Patient Browser

Alt + Tab Pøepnout na další aktivní aplikaci Windows

Ctrl + Tab Pøepnout na aktivní kartu úlohy nebo procházet 
øadou karet

Ctrl + Shift 
+ Tab

Pøepnout na pøedchozí aktivní kartu úlohy nebo 
procházet øadou karet smìrem dozadu

Ctrl + C Kopírovat

Ctrl + I Importovat data

Ctrl + P Úloha expozice filmu

Ctrl + S Uložit (pouze u karty úlohy 3D)

Ctrl + X Vyjmout (pouze u karty úlohy Filming)

Ctrl + V Vložit

Ctrl + W Uložit hodnoty vyvážení
Verze VE31D A.2–11 
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A.2

Windows Zobrazit nabídku Start

Windows + D Minimalizovat nebo obnovit všechna okna

Windows + E Otevøít aplikaci Windows Explorer

Windows + F Otevøít dialogové okno Najít

Windows + 
Ctrl + F

Otevøít dialogové okno Najít: poèítaè

Windows + 
F1

Zobrazit nápovìdu

Windows + R Zobrazit dialogové okno Spustit

Windows + 
Pause

Zobrazit dialogové okno Systém – vlastnosti

Windows + 
Shift + M

Vrátit pøíkaz minimalizovat všechna okna

Windows + L Otevøít dialogové okno Log-off

Windows + U Otevøít správce nástrojù
A.2–12 Návod k použití pro uživatele systému syngo
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Zadávání pøíkazù a údajù A.2

Pøíkazy a data lze vždy zadávat nìkolika zpùsoby. Mùžete k 
tomu použít myš nebo klávesnici. 
 

A.2

Výbìr objektù A.2

A.2 Objekt (jímž mùže být napøíklad snímek èi pacient) lze vybrat 
tak, že na nìj klepnete levým tlaèítkem myši. A.2

➭ Vybrané objekty budou oznaèeny. Snímky budou orámovány, 
grafické objekty jako ROI (oblast zájmu) se zobrazí s úchyty, 
ikony a text (napøíklad u položek seznamu) budou zvýraznìny 
(zobrazí se napøíklad bíle na èerném pozadí).

Pøíklady: A.2

❏ V oknì Patient Browser je zvýraznìn vybraný záznam 
pacienta.

❏ Na hranicích vybrané oblasti jsou vidìt malé ètvereèky – 
úchyty pro zmìnu velikosti (vpravo).

 

Verze VE31D A.2–13 
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Výbìr nìkolika objektù A.2 Vyberte objekt myší a potom stisknìte klávesu Ctrl nebo Shift.A.2

Pomocí klávesy Ctrl mùžete vybírat jednotlivé objekty. A.2

✧ Stisknìte a podržte klávesu Ctrl stisknutou.

✧ Klepnìte na všechny objekty, které chcete vybrat.

✧ Pokud chcete volbu vybraného objektu zrušit, kliknìte na 
objekt znovu. 

Pomocí klávesy Shift lze vybírat skupiny objektù. A.2

✧ Stisknìte klávesu Shift a pøidržte ji stisknutou.

✧ Klepnìte na další objekt.  
Takto budou vybrány i všechny objekty uprostøed. 
 

Zrušení výbìru objektù A.2 Zrušit výbìr objektu lze zvolením jiného objektu nebo 
klepnutím myší na pozadí. A.2
A.2–14 Návod k použití pro uživatele systému syngo
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Pøesouvání a kopírování objektù A.2

Objekty (napøíklad obrazy) mùžete pøesouvat èi kopírovat z 
jednoho místa na obrazovce na jiné. 
 

A.2

Pøetažení A.2 Pøi pøetažení se objekt „uchopí", pøesune na jiné místo a tam 
„upustí". A.2

✧ Klepnìte na objekt (napøíklad sérii) pravým tlaèítkem myši a 
toto tlaèítko podržte.

✧ Myší pøetáhnìte objekt na nové místo (na kartu další úlohy 
nebo do jiného okna).

✧ Pus¤te tlaèítko myši. Objekt se zkopíruje nebo pøesune na 
nové místo. 
→ Strana A.2–4, Používání myši 

Vyjmout, kopírovat a vložit A.2 S objekty lze manipulovat také pomocí funkcí vyjmout a vložit
a kopírovat a vložit. A.2

✧ Vyberte objekt, který chcete pøesunout nebo zkopírovat.

✧ Chcete-li objekt pøemístit, aktivujte funkci Edit > Cut nebo 
použijte zkratku Ctrl + X (pouze u karty úlohy Filming).

Nebo A.2

✧ Aktivujte funkci Edit > Copy nebo použijte zkratku Ctrl + C, 
pokud chcete objekt kopírovat.
Verze VE31D A.2–15 
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Objekt se pøesune nebo zkopíruje do schránky Windows. V této 
schránce zùstane tak dlouho, dokud nebudete kopírovat nebo 
vyjímat další objekt, jímž bude pøedchozí objekt nahrazen. A.2

✧ Klepnìte na nové místo.

✧ Objekt na nové místo zkopírujete nebo pøesunete aktivací 
funkce Edit > Paste nebo pomocí zkratky Ctrl + V. 
→ Strana A.2–11, Používání klávesových zkratek 
→ Strana A.2–34, Použití nabídek 
 

Poklepání A.2 Pokud na objekt poklepete levým tlaèítkem myši, provede se 
standardní funkce pøiøazené funkèní nabídky, která také závisí 
na typu objektu. Dvojitým kliknutím lze vybraný objekt pøemístit 
do jiné aplikace. 

A.2

Nabídky A.2 Objekty mùžete pøesouvat z jedné aplikace do druhé také 
pomocí položek rozevírací nabídky. A.2

✧ Vyberte objekt (nebo nìkolik objektù), který chcete pøemístit 
na jinou kartu úlohy.

✧ Aktivujte odpovídající položku nabídky. 
→ Strana A.2–34, Použití nabídek
A.2–16 Návod k použití pro uživatele systému syngo
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Zmìna zobrazení obrazu A.2

Pomocí myši mùžete mìnit zobrazení snímku: A.2

❏ nastavení hodnot (vyvážení),
❏ velikost snímku (zvìtšování, zmenšování),
❏ posouvání snímku (posun).

K vyvážení se používá prostøední tlaèítko myši. Pøi pøiblížení/
oddálení a posunu obrazu nejprve myš pøepnìte do režimu 
pøiblížení/oddálení nebo posun. Potom levým tlaèítkem myši 
zmìòte zobrazení obrazu. 
→ Strana E.4–22, Zvìtšování a posun snímkù A.2

✧ Pøesuòte kurzor myši na snímek a stisknìte a pøidržte její 
prostøední nebo levé tlaèítko. Pohybem myši zmìòte zpùsob 
zobrazení snímku.

A.2 Pøi pøiblížení/oddálení a posunu se zmìní kurzor myši. A.2
Verze VE31D A.2–17 
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Zadávání textu A.2

Pokud uvnitø pole pro zadávání textu klepnete myší, kurzor se 
zmìní v textový kurzor (svislá èárka). A.2

✧ Zadejte text pomocí klávesnice. 

➭ Text mùžete také zapsat do kombinovaného pole. 
→ Strana A.2–28, Kombinované okno

Oznaèování textu A.2 Text oznaèíte tak, že pøidržíte levé tlaèítko myši a pøejedete pøes 
požadovaný text kurzorem. Vybraný text se zvýrazní. A.2

 

Oznaèování slov A.2 ✧ Umístìte kurzor na slovo a poklepejte levým tlaèítkem myši. 
Slovo bude oznaèeno. 

Odstraòování textu A.2 ✧ Oznaète text myší. Stisknìte klávesu Del nebo Backspace. 
Text bude odstranìn.
A.2–18 Návod k použití pro uživatele systému syngo
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Okna A.2

V operaèním systému Windows XP® se programy zobrazují v 
oknech. Spuštìná aplikace se zobrazí v oknì. 
 

A.2

Rozvržení oken A.2

V oknì se nachází následující grafické prvky: A.2

(1) Záhlaví okna 
V záhlaví okna se zobrazuje název programu, s nímž právì 
pracujete.

(2) Ikona záhlaví okna 
Ikona pro otevøení nabídky pøíkazù pro manipulaci s oknem

(3) Øádek nabídek 
Obsahuje funkce programu v rozevíracích nabídkách.

(4) Panel nástrojù 
Obsahuje ikony pro spouštìní funkcí a programù.

(5) Pracovní plocha 
Zde mùžete provádìt funkce daného programu.

(6) Tlaèítka okna 
Tlaèítka pro ovládání zobrazení okna 
Zde mùžete okno minimalizovat, maximalizovat nebo 
zavøít.
Verze VE31D A.2–19 
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A.2 (7) Posuvník 
Pokud je obsah okna pøíliš velký na to, aby se zobrazil na 
ploše obrazovky, v pravém a dolním okraji okna se objeví 
posuvníky.

(8) Okraj 
Pokud chcete zmìnit velikost okna, umístìte kurzor myši na 
jeho okraj a zmìòte jeho velikost.

(9) Stavový øádek 
Zobrazuje pokyny a informace (odezvu) o programu. Také 
obsahuje ikony poskytující informace o velikosti úložného 
místa.
A.2–20 Návod k použití pro uživatele systému syngo
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Zmìna velikosti a pøesouvání okna A.2

Mùžete zmìnit zobrazení okna (okno, celá obrazovka nebo 
ikona), velikost okna a umístìní okna. 
 

A.2

Zmìna typu okna A.2 V pravém horním rohu záhlaví okna jsou tøi tlaèítka, jimiž 
mùžete mìnit velikost a umístìní oken. A.2

A.2 Tato tlaèítka umožòují mìnit aktivní okno následujícím 
zpùsobem: 

A.2

A.2 ✧ Klepnìte na tlaèítko uprostøed levým tlaèítkem myši. Okno se 
minimalizuje.

A.2 ✧ Klepnutím na tlaèítko uprostøed lze pøepínat mezi velikostí 
okna pøes celou obrazovku a zmenšenou velikostí okna. 
Pokud na tlaèítko klepnete znovu, okno se zobrazí v 
pøedchozí velikosti.

A.2 ✧ Kliknìte na pravé tlaèítko zavøete okno, a tím ukonèíte 
aplikaci. 

Nebo A.2

✧ Klepnìte na ikonu na titulní lištì a z nabídky zvolte 
odpovídající položku.

➭ U nìkterých oken nejsou všechny tyto funkce k dispozici.
Verze VE31D A.2–21 
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Zmìna velikosti okna A.2 Pokud posunete kurzor myši na okraj okna, vzhled kurzoru se 
zmìní. Podoba kurzoru je závislá na jeho umístìní: A.2

A.2 ❏ Na dolním nebo horním okraji se zmìní na svislou dvojitou 
šipku. 
Nyní mùžete zmìnit výšku okna.

A.2 ❏ Na levém nebo pravém okraji se zmìní na vodorovnou 
dvojitou šipku. 
Nyní mùžete zmìnit šíøku okna.

A.2 ❏ V rohu okraje se zmìní na diagonální dvojitou šipku. 
Nyní mùžete zmìnit výšku a šíøku okna.

A.2 ❏ Na vnitøním okraji okna se z nìj stává rozdìlená dvojitá šipka 
(pokud jsou v oknì dílèí okna). 
Mùžete zmìnit výšku oddílù okna.

✧ Stisknìte a pøidržte levé tlaèítko myši a pøetáhnìte okraj okna 
na nové místo.
A.2–22 Návod k použití pro uživatele systému syngo
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Zmìna umístìní okna A.2 Okno mùžete pøesunout na jakékoli místo na obrazovce, pokud 
není maximalizované èi minimalizované. A.2

✧ Kliknìte na záhlaví okna a pøetáhnìte okno na nové místo, 
pøitom držte tlaèítko myši stisknuté. 
Verze VE31D A.2–23 
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Posunování obsahu okna A.2 Na posuvnících najdete tlaèítka s šipkami a táhlo, jimiž mùžete 
posouvat obsah okna. Jestliže je okno pøíliš krátké nebo pøíliš 
úzké, aby se zobrazil celý jeho obsah, napravo od okna nebo 
pod ním se objeví posuvník. A.2

A.2 ✧ Levým tlaèítkem myši kliknìte na tlaèítko se šipkou (1). 
Obsah obrazovky se posune ve smìru šipky.

✧ Kliknìte na jezdce (2) myší a posuòte jej. Obsah obrazovky se 
pohybuje v odpovídajícím smìru.

✧ Klepnìte myší na jakýkoli bod mezi jezdcem a tlaèítky 
posuvníku. Obsah obrazovky se posune smìrem k tomuto 
bodu o vzdálenost, která je úmìrná vzdálenosti tohoto bodu 
od jezdce.
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Pøepínání mezi okny A.2

Èasto je otevøeno nìkolik oken nebo karet souèasnì, napøíklad 
pøi použití funkce Patient Browser pro vyhledávání pacienta 
pøed zahájením vyšetøení. 

A.2

Aktivní okno A.2 Aktivní okno je v popøedí. 
Záhlaví aktivního okna má jinou barvu než záhlaví neaktivních 
oken. A.2

➭ Objekty (napøíklad snímky) mùžete pøesouvat (pøetažením) z 
aktivního okna do okna na pozadí. Pøièemž obì okna musí být 
pøi této akci viditelná.

Pøepínání oken A.2 Pokud chcete aktivovat jiné viditelné okno, klepnìte na 
požadované okno. A.2

Toto okno se pøesune do popøedí a barva záhlaví okna se zmìní. 
Toto okno je nyní aktivní, tj. mùžete s ním pracovat. A.2

Pøíklad: Patient Browser a Patient Registration. A.2
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Dialogová okna A.2

Dialogová okna se užívají pro zadávání dat nebo pro volbu a 
potvrzování nastavení. A.2

Zpravidla se zobrazují po zvolení funkce. A.2

Pøíklad: A.2

V dialogovém oknì se nachází pole pro zadávání znakù, 
seznamy pro volbu položek, pøepínaèe nebo zaškrtávací políèka 
pro volbu možností a tlaèítka pro potvrzení nebo odmítnutí 
zadaných dat. A.2
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Ovládací prvky v oknech a na kartách A.2

Dialogová okna a karty obsahují rùzné ovládací prvky, které 
mùžete používat pro zadávání dat nebo pro provádìní výbìrù. 

A.2

Pøepínaèe A.2

A.2 Možnosti lze vybrat levým tlaèítkem myši. Lze vybrat vždy jen 
jednu možnost. 
 

A.2

Zaškrtávací políèko A.2

A.2 ✧ Klepnìte na ètvereèek levým tlaèítkem myši.

Zobrazí se køížek nebo zaškrtávací znaèka. Položka je zvolena. A.2

✧ Opìtovným klepnutím na ètvereèek volbu zrušíte.

Nìkdy lze tímto zpùsobem vybrat i více než jednu možnost. 
 

A.2

Výbìrový seznam A.2

A.2 ✧ Pokud chcete nabídku otevøít, klepnìte levým tlaèítkem myši 
na šipku vpravo od výbìrového seznamu.

✧ Posunováním kurzoru myši v seznamu se položky jedna po 
druhé zvýrazòují. 

✧ Kliknìte na požadovanou položku. 
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Zadávací pole A.2

A.2 Zde mùžete zadávat text nebo èísla. A.2

✧ Klepnìte kurzorem myši dovnitø zadávacího pole. Na místì 
textového kurzoru zadejte text. 
 

Èíselník A.2

A.2 Pomocí èíselníku mùžete vybírat rùzné hodnoty. A.2

✧ Kliknutím levým tlaèítkem myši na jednu ze šipek danou 
hodnotu zvyšte (nahoru) nebo snižte (dolù). Hodnotu také 
lze zadat pøímo do zadávacího pole. 
 

Kombinované okno A.2

A.2 Tento rámeèek je kombinací zadávacího pole a výbìrového 
seznamu. Položky lze buï vybrat ze seznamu nebo je mùžete 
zadat pomocí klávesnice.  
 
 
 
 

A.2
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Jezdec A.2

A.2 Jezdcem lze nastavovat rozsah hodnot. A.2

✧ Pøetažením koncových okrajù jezdce zvýšíte nebo snížíte 
rozsah hodnot.

✧ Posunutím støedové znaèky jezdce zmìníte polohu rozsahu 
hodnot.

✧ Poklepejte na levý nebo pravý konec. Levý nebo pravý konec 
se automaticky posune na levou nebo pravou hranici rozsahu 
jezdce.

✧ Dvojitým kliknutím na støedovou znaèku pokryjete celou 
oblast jezdce. 

Tlaèítka pro spouštìní 
pøíkazù A.2

Klepnutím na tlaèítko lze zahájit akci. Dialogové okno mùže 
obsahovat rùzná tlaèítka, napøíklad: A.2

A.2 ❏ Všechna nastavení daného okna se potvrdí a okno se zavøe. V 
nìkterých dialogových oknech spouštíte akci pomocí tlaèítka 
OK, napøíklad pøi exponování na film. 

A.2 ❏ Stejné jako u tlaèítka OK, okno se ale nezavøe. 
 
 

A.2 ❏ Dialogové okno se zavøe bez provedení zmìn. 
 

A.2 ❏ Zobrazí se nápovìda k dialogovému oknu. 
 

Verze VE31D A.2–29 
únor 2006

 0.0



Základy pro zaèáteèníky Základy
Tlaèítka pro zvolení funkcí A.2 Øadu funkcí v programu mùžete spustit pomocí nabídek nebo 
pomocí tlaèítek s ikonami. A.2

A.2 Tlaèítka s ikonami se nachází na panelu nástrojù, na kartách 
dílèích úloh a v ovládací oblasti karet úloh. Kliknutím na takové 
tlaèítko se snadno a rychle vykoná urèitá funkce. 
 

A.2

Zastøená pole a tlaèítka A.2 Jsou nìkteré funkce, které mùžete provést pouze v pøípadì, že 
máte vybrán napøíklad obraz nebo naètená data do karty úloh. 
Tlaèítka a vstupní pole jsou zastøená (zobrazují se jako šedá 
nebo stínovaná), jestliže nemùžete spustit funkci, která je jim 
pøiøazena. A.2

A.2 Neaktivní tlaèítko, funkci nelze vykonat. 
 
 

A.2

A.2 Tlaèítko již není neaktivní, funkce je k dispozici. 
 
 

A.2

A.2 Ikona je aktivní, nyní mùžete na obrazu napøíklad zakreslit 
oblast zájmu (ROI). 
 
 

A.2

Nástrojové tipy A.2

A.2 Pokud umístíte kurzor myši na ikonu, objeví se struèný popis její 
funkce. Popis za nìkolik vteøin zmizí. A.2
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Práce se záložkami karet A.2

Záložky karet jsou umístìny ve skupinách. Pokud chcete 
nìkterou z nich pøemístit do popøedí, klepnìte na její záložku. 
Pokud záložku karty aktivujete, požadovaná karta se zobrazí na 
popøedí. Funkci lze aktivovat jen z aktivní karty. 

A.2

Aktivování karty A.2 ✧ Klepnutím na záložku aktivujte její kartu.

Aktivní karta má jinou barvu pozadí než ostatní záložky 
(neaktivních) karet. A.2

Nastavení nebo data zadaná na kartì pøesunuté na pozadí 
(protože jste napøíklad aktivovali jinou kartu) se neprojeví. 
Pokud takovou kartu znovu aktivujete, všechna nastavení i 
údaje budou beze zmìny. A.2

Existují dva druhy karet: A.2

❏ Karty úloh
❏ Karty dílèích úloh
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Karty úloh A.2

Karty úloh jsou uspoøádány podle pravidelných úkonù v 
nemocnici a jejich rozložení je pøizpùsobeno napøíklad postupu 
vyšetøení: A.2

❏ Na kartì úloh Examination lze provádìt vyšetøení.

❏ Na kartì úlohy Viewing lze zobrazovat nebo zpracovávat 
výsledky.

❏ Listy filmu se upravují na kartì Filming.

❏ Trojrozmìrné následné zpracování obrazù se provádí na 
kartì 3D. 

Aktivace pomocí záložek A.2 ✧ Klepnutím na záložku (1) na pravé stranì obrazovky 
aktivujete kartu úlohy.
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Aktivace pomocí funkèních 
kláves A.2

Mezi jednotlivými kartami úloh se mùžete pohybovat i pomocí 
funkèních kláves. A.2

✧ Stisknutím klávesy F5 aktivujte kartu úlohy  Examination.

✧ Stisknutím klávesy F6 aktivujte kartu úlohy Viewing.

✧ Stisknutím klávesy F7 aktivujte kartu úlohy Filming.

✧ Stisknutím klávesy F8 aktivujte kartu úlohy 3D. 

Karty dílèích úloh A.2

Na kartách úloh se nachází menší karty nazvané karty dílèích 
úloh. A.2

Ty se používají pro následující úèely: A.2

❏ okna nástrojù, napøíklad pro grafické vyhodnocení,
❏ nastavení parametrù,
❏ spuštìní funkcí a programù.
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Použití nabídek A.2

Aby byla obrazovka pøehledná a jednoduchá, funkce jsou 
uspoøádány v rozevíracích nabídkách. A.2

Nabídky specifické pro danou aplikaci A.2

Øádek nabídek se mìní podle karty úlohy, která je právì aktivní, 
nebo podle okna, které je právì otevøené. Takto jsou pøístupné 
jen funkce, které jsou urèeny pro danou aplikaci. 

A.2

Øádek nabídek okna Patient 
Browser A.2

Øádek nabídek oknaPatient Browser obsahuje následující 
položky: A.2

 

Øádek nabídek karty 
Viewing A.2

Øádek nabídek karty úlohy Viewing obsahuje následující 
položky: A.2

 

Øádek nabídek karty úlohy 
Filming A.2

Øádek nabídek karty úlohy Filming obsahuje následující 
položky: A.2

 

Øádek nabídek karty úlohy 
3D A.2

Øádek nabídek karty úlohy 3D obsahuje následující položky: A.2
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Doplòkové aplikace A.2 Pokud jsou do systému integrovány nìjaké volitelné aplikace 
nebo používáte aplikace licencované pro tento systém, k jejich 
spuštìní slouží doplòková položka nabídky Applications. A.2
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Rozevírací nabídky øádku nabídek A.2

Nabídková lišta se skládá z øady rozbalovacích menu. Tyto 
nabídky umožòují pøístup k øadì funkcí a nastavení. A.2

Volba nabídky A.2 ✧ Kliknìte na položku nabídky v øádku nabídek levým tlaèítkem 
myši. 
Otevøe se rozevírací nabídka. 
Položka nabídky je zvýraznìna.

✧ Posunute kurzor myši dolù po nabídce a postupnì se otevøe 
každá rozevírací nabídka. 
Otevøená zùstane pouze rozevírací nabídka, na které je 
umístìn kurzor myši. 

Zavírání nabídky A.2 ✧ Jestliže nechcete vybrat žádnou funkci, klepnìte znovu na 
øádek nabídek nebo na pozadí, tj. mimo rozevírací nabídku.
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Výbìr akce A.2

A.2 ✧ Pohybujte kurzorem myši po položkách rozevírací nabídky. 
Položky se jedna po druhé zvýrazòují.

✧ Zastavte se na akci, kterou chcete provést. 
Kliknìte na ni levým tlaèítkem myši. 
Akce se spustí a nabídka se zavøe.

➭ Položky menu, za nimiž jsou tøi teèky, otevírají dialogová okna  
(napø. Browser...).  
Položky nabídek bez tøí teèek spouštìjí akce pøímo (napø. 
Expose Film Task). 
 
 

Možnosti A.2

A.2 Když na nìkteré položky nabídky klepnete, mùže se zdát, že se 
nic nedìje. Když se ale na rozevírací nabídku dobøe podíváte, 
zjistíte, že je vedle položky nabídky zaškrtávací znaèka. Pøíslušná 
možnost je nyní aktivní. 
Chcete-li tuto možnost zrušit, znovu na ni kliknìte. 
 

A.2
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Dílèí nabídka A.2 Na nìkterých øádcích rozevírací nabídky se vpravo nachází malá 
šipka. Pokud k jedné z tìchto šipek pøesunete kurzor myši, 
zobrazí se podnabídka. A.2
A.2–38 Návod k použití pro uživatele systému syngo

 0.0



Základy Základy pro zaèáteèníky
Místní nabídky A.2

Místní (kontextové) nabídky obsahují informace týkající se 
urèité položky. V závislosti na druhu vybraného objektu se tedy 
zobrazí jiný typ místní nabídky. Tyto nabídky obsahují akce, 
které lze s tímto objektem provádìt. 

A.2

Spuštìní místní nabídky A.2 ✧ Nejprve vyberte levým tlaèítkem myši požadovaný objekt.

✧ Místní nabídku zobrazíte stisknutím pravého tlaèítka myši 
nebo klávesové zkratky Shift + F10. Zobrazí se nabídka 
pøiøazená aktuálnímu typu objektu. 
 

Výbìr akce A.2

A.2 ✧ Posuòte kurzor myši na nabídku. 
Položka, na které je umístìn kurzor myši, se zvýrazní. Funkci 
spustíte kliknutím na pravé èi levé tlaèítko myši. 

➭ Kontextová nabídka se otevøe i v pøípadì, že jste objekt 
nevybrali, ale klepli pravým tlaèítkem myši. Tato nabídka 
poskytuje pøíkazy, které mùžete provést v aktivním oknì èi na 
kartì úlohy, pokud není nic vybráno.
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Stavový øádek A.2

Stavový øádek na dolním okraji okna zobrazuje hlášení a pokyny 
a dále obsahuje ikony týkající se velikosti úložného místa. A.2

Je rozdìlený do tøí èástí: A.2

❏ V první èásti se zobrazují informace týkající se vyšetøení.

❏ V druhé èásti se zobrazují varování a hlášení.

❏ Pokud se na pozadí vykonává nìjaká funkce, ve tøetím 
sloupci, vedle ikon s informací o kapacitì úložného prostoru, 
se zobrazí pøíslušná ikona aplikace. 
 

Historie akcí A.2 Akce provádìné programem se automaticky zaznamenávají 
spoleènì s informacemi o tom, zda byly jednotlivé kroky 
úspìšnì dokonèeny a zda nenastala chyba. Seznam posledních 
záznamù historie akcí lze kdykoli zobrazit. A.2

✧ Klepnìte levým tlaèítkem myši na lištu úlohy, abyste zobrazili 
seznam posledních pøíkazù a programových akcí.

➭ Poèet záznamù v protokolu lze urèit v dialogovém oknì 
History Size, které lze otevøít kliknutím pravým tlaèítkem 
myši na stavový øádek.
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Kontrola prostøedkù A.2

Systém sleduje využití pamìti a množství úložného prostoru pro 
hlavní databázi, databázi plánovaèe a virtuální pamì¤.  

A.2

Hlavní databáze a plánovaèA.2

A.2 Ikona množství úložného prostoru znázoròuje, kolik místa 
využívá místní databáze. Pokud databáze zabírá více místa, než 
je urèeno konfigurovatelným limitem (standardnì 95%), zelená 
barva ikony se zmìní na èervenou. A.2

Pokud umístíte kurzor myši na tuto ikonu, zobrazí se 
procentuální hodnota využitého úložného místa. A.2

➭ Pokud byste se chtìli dovìdìt více o specifickém uložení a 
monitorování dat, obra¤te se na servisního technika.

✧ Aby nedocházelo k problémùm s nedostateènou kapacitou, 
provádìjte pravidelné ukládání údajù o pacientech a 
vyšetøení. Uložené údaje potom odstraòujte v oknì Patient 
Browser. 
→ Strana F.2–1, Ukládání dat 
→ Strana C.6–8, Odstraòování dat

A.2
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Virtuální pamì¤ A.2 A.2

A.2 Pokud ikona množství úložného místa na stavovém øádku bliká, 
virtuální pamì¤ je zcela zaplnìna. A.2

Objeví se hlášení Resource Monitor. A.2

A.2

A.2

UPOZORNÌNÍ

Nedostatek pamìti nebo místa na disku mùže zpùsobit 
nestabilitu nebo zhavarování systému. A.2

Systém není v nouzových stavech dostupný A.2

✧ Vìnujte náležitou pozornost ikonám znázoròující množství 
úložného prostoru. Neignorujte varovné hlášení.

A.2
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Textové informace na snímcích A.2

V obrazech se zobrazují rùzné textové informace. Tyto textové 
informace oznaèují pacienta a obsahují údaje o vyšetøení a 
parametrech obrazu. A.2

➭ Pomocí aplikace Image Text Editor mùžete urèit, které èásti 
textu budou na obrazech zobrazeny. 
→ Strana A.4–8, Konfigurace textu snímkù
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Text snímku se tøídí podle témat do ètyø rohù snímku. A.2

 

(1) Údaje o pacientovi a vyšetøení
(2) Orientaèní znaèka
(3) Informace o systému
(4) Mìøítko
(5) Hodnoty vyvážení a matice snímku
(6) Poznámky
(7) Vyšetøení a parametry obrazu
(8) Orientaèní znaèka
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Použití více monitorù A.2

Využitím dvou monitorù mùžete souèasnì zobrazit více 
informací (napøíklad dvì rùzné karty úloh). A.2

Zobrazení A.2 Obsah obou monitorù zùstává nezmìnìn, to se však netýká 
karty úloh Viewing. A.2

S kartou úlohy Viewing na levém monitoru je oblast snímku 
umístìna vpravo a oblast s ovládacími prvky vlevo. A.2

Na obou monitorech je k dispozici øádek nabídek i stavový 
øádek. A.2
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A.2

A.2

Zpùsob fungování A.2 Volba funkcí zùstává nezmìnìna. A.2

Dialogová okna se zobrazí na monitoru, na kterém jsou vybrána.A.2

Pokud vyberete okno, které je již otevøené, napøíklad Patient 
Browser, na jiném monitoru, okno bude z tohoto monitoru 
pøesunuto na druhý monitor. A.2

A.2

UPOZORNÌNÍ

Pøi práci se dvìma monitory náleží jméno pacienta zobrazené 
ve složce karty úlohy pouze této kartì úlohy. A.2

Je možná nesprávná diagnóza. A.2

✧ Kvùli jednoznaèné identifikaci použijte demografii pacienta 
zobrazené v obrazovém textu.
A.2–46 Návod k použití pro uživatele systému syngo
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Základy Základy pro zaèáteèníky
Ukonèení programu A.2

Program lze ukonèit a systém vypnout rùznými zpùsoby. A.2

✧ Zvolte pøíkaz Options > End Session... v hlavní nabídce.

Zobrazí se dialogové okno End Session. A.2
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Základy pro zaèáteèníky Základy
Uzamèení poèítaèe A.2

A.2 ✧ Klepnutím na tlaèítko Lock Computer zamezíte pøístupu k 
poèítaèi.  

Odhlášení A.2

A.2 ✧ Kliknutím na tlaèítko Log Off <user name>... program 
ukonèíte.

Systém po uložení provedených nastavení postupnì ukonèí 
veškeré souèásti programu. Potom se zobrazí pracovní plocha 
systému Windows XP®. A.2

Jiný uživatel A.2

A.2 ✧ Kliknutím na tlaèítko Log In Different User... se pøihlásíte do 
již spuštìného systému.

✧ Zadejte uživatelské jméno a heslo.

V závislosti na pøístupových právech mohou být údaje o 
pacientch skryta.  
Viz pøíruèka Systém zabezpeèení. A.2

Vypnutí A.2

A.2 ✧ Pokud chcete systém vypnout, kliknìte na tlaèítko Shutdown 
System....

✧ Vypnìte poèítaè pomocí hlavní vypínaèe.

A.2

A.2

UPOZORNÌNÍ

Vypnutí poèítaèe v pohotovostním režimu nebo bez ukonèení 
operaèního systému A.2

Nebezpeèí poškození dat nebo systému A.2

✧ Poèítaè vypnìte až po ukonèení operaèního systému.
A.2–48 Návod k použití pro uživatele systému syngo
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Základy Základy pro zaèáteèníky
Restart A.2

A.2 ✧ Pokud chcete systém restartovat (vypnout a ihned 
automaticky zapnout), kliknìte na tlaèítko Restart System.... 

Nebo A.2

A.2 ✧ Pokud chcete restartovat aktuální aplikaci, kliknìte na 
tlaèítko Restart Application.... 
 

Hibernate/Standby A.2 Podle konfigurace mùžete mít k dispozici možnost Hibernate...
nebo Standby.... A.2

A.2 ✧ Kliknìte na tlaèítko Hibernate... nebo Standby..., pokud 
chcete ukonèit a vypnout systém, aniž byste nejprve ukonèili 
uživatelské rozhraní programu. 

A.2 Pokud systém restartujete, na monitoru budou stejné položky a 
stejná nastavení, která byla zobrazena v dobì pøed vypnutím 
(zobrazí se všechny snímky a dialogová okna). A.2

A.2

A.2

A.2

UPOZORNÌNÍ

Pøihlášení jiného uživatele, vypnutí systému, odhlášení nebo 
restart bez uložení dat A.2

Možná ztráta neuložených zmìn A.2

✧ Pøed pøihlášením jiného uživatele, vypnutím nebo 
restartováním systému uložte data.
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Základy pro zaèáteèníky Základy
A.2–50 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

A.3

Antivirová ochrana Siemens 
(volitelný doplnìk) A.3
Dálková služba antivirové ochrany spoleènosti Siemens je 
komplexní obslužný program, který zpracovává veškeré otázky 
týkající se zabezpeèení systému proti virùm. A.3

Spoleènost Siemens podniká preventivní opatøení, aby 
nebezpeèný software, napøíklad viry nebo viry typu èerv 
(worm), nepronikl do vašeho systému Siemens. S rostoucí 
mírou využívání poèítaèové komunikace a nárùstu elektronické 
výmìny dat však klinické sítì a lékaøské systémy nejsou nadále 
imunní proti virovým útokùm. Z tohoto dùvodu spoleènost 
Siemens nyní vytvoøila program antivirové ochrany urèený 
primárnì k zabezpeèení vašeho systému Siemens. A.3

!0

A.3 A.3

Chcete-li ve svém systému aktivovat antivirovou ochranu 
spoleènosti Siemens, obra¤te se na místní servisní støedisko 
UPTIME nebo na obchodního zástupce spoleènosti Siemens. A.3
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Antivirová ochrana Siemens (volitelný doplnìk) Základy
Používání programu pro 
provìøování virù A.3

Díky antivirové ochranì spoleènosti Siemens je váš systém 
vybaven ovìøeným programem Trend Micro™ Office-Scan™ pro 
provìøování virù, což je software od pøedního dodavatele 
antivirového softwaru - spoleènosti Trend Micro, který byl 
komplexnì testován a adaptován spoleèností Siemens jako 
kompatibilní se systémy spoleènosti Siemens. Program 
OfficeScan™ je konfigurován tak, aby automaticky provìøoval 
systém, zda neobsahuje známé viry a zajistil tak, že nedojde ke 
zpomalení základních funkcí systému. Pøi vyhledávání virù bude 
nástroj spuštìn na pozadí, aniž by rušil vaši klinickou práci. A.3

➭ V pøípadì zjištìní viru se zobrazí kontextová zpráva s 
informacemi o dalším postupu. Více informací získáte v èásti 
"Co dìlat v pøípadì napadení virem".

➭ Chcete-li program TrendMicro™ Office-Scan™ v systému 
vypnout nebo znovu aktivovat, obra¤te se na místní servisní 
støedisko UPTIME.

Aktualizace programu pro provìøování virù A.3

Za úèelem zajištìní optimální ochrany systému bude program 
pro provìøování virù neustále pøijímat automatické vzdálené 
aktualizace s nejnovìjšími soubory se vzorky virù a 
provìøovacími moduly ovìøenými spoleèností Siemens. 
Spoleènost Siemens pøevede tyto aktualizace do vašeho 
systému prostøednictvím infrastruktury vzdálených služeb 
Siemens (Siemens Remote Service). Pøi dalším spuštìní systému 
se automaticky provìøí, zda je k dispozici další softwarový 
balíèek pro instalaci. A.3
A.3–2 Návod k použití pro uživatele systému syngo
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Základy Antivirová ochrana Siemens (volitelný doplnìk)
Nový softwarový balíèek A.3

Pokud ano, zobrazí se dialogové okno Software-Distribution.A.3

➭ V horní èásti dialogového okna jsou uvedeny informace o 
novém softwarovém balíèku.

A.3 ✧ Kliknutím na tlaèítko HELP pro nápovìdu online v pravé dolní 
èásti okna vyvoláte popis jednotlivých polí.

!0

A.3 A.3

A.3

Zajistìte, aby vzdálené pøipojení k infrastruktuøe vzdálených 
služeb Siemens bylo stále aktivní a spuštìné. Jinak nebude 
systém pøijímat nejnovìjší aktualizace. A.3
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Antivirová ochrana Siemens (volitelný doplnìk) Základy
Instalace aktualizace A.3

✧ Klepnutím na tlaèítko Yes potvrdíte instalaci aktualizace. 
Instalace zaène ihned a její prùbìh se bude zobrazovat v dolní 
èásti dialogového okna.

Nebo A.3

✧ Pokud si aktualizaci nepøejete instalovat ihned, klepnìte na 
tlaèítko LATER. Dialogové okno se zavøe bez instalace.

➭ Dokud nenainstalujete nový softwarový balíèek, dialogové 
okno Software-Distribution s výzvou k provedení instalace 
se zobrazí pøi každém dalším spuštìní systému.

!0

A.3 A.3

Spoleènost Siemens dùraznì doporuèuje okamžitou instalaci 
aktualizací. Pokud aktualizaci musíte provést pozdìji, 
proveïte ji co nejdøíve. Jinak nebude program provìøování 
virù moci rozpoznat nejnovìjší typy nebezpeèného softwaru.A.3
A.3–4 Návod k použití pro uživatele systému syngo
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Základy Antivirová ochrana Siemens (volitelný doplnìk)
Tiché instalace souboru se 
vzorky virù A.3

Protože se aktualizace souboru se vzorky virù dìjí víceménì 
dennì a jsou instalovány bìhem nìkolika sekund, máte také 
možnost jednou definovat, aby se budoucí aktualizace tìchto 
souborù instalovaly bez upozornìní a bez výzev k potvrzení. A.3

✧ Chcete-li pøijímat tiché instalace aktualizací souborù se 
vzorky virù, zaškrtnìte políèko „Accept silent installation of 
virus pattern updates" (Pøijmout tichou instalaci aktualizací 
souborù se vzorky virù).

✧ Kliknutím na tlaèítko Yes potvrdíte instalaci èekající 
aktualizace a tichou instalaci budoucích aktualizací souborù 
se vzorky virù.

Úspìšné ukonèení instalaceA.3 Po úspìšném dokonèení instalace se zobrazí odpovídající 
zpráva. A.3

✧ Kliknutím na tlaèítko OK ukonèíte proces instalace a zavøete 
dialogové okno. 
Verze VE31D A.3–5 
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Antivirová ochrana Siemens (volitelný doplnìk) Základy
Selhání instalace A.3 Pokud se instalace z nìjakého dùvodu nezdaøila, zobrazí se 
odpovídající zpráva. V takovém pøípadì budou informace o 
nepodaøené instalaci automaticky pøedány prostøednictvím 
vzdálené služby servisnímu støedisku Siemens UPTIME, které 
problém vyøeší. A.3

Klepnutím na tlaèítko OK zavøete dialogové okno. A.3

!0

A.3 A.3

!0

A.3 A.3

Systém Siemens mùžete bez omezení používat i v pøípadì, že 
instalace souboru se vzorky virù nebo programu pro 
provìøování virù selhala. Služba Siemens UPTIME zjistí pøíèinu 
chyby a problém opraví. A.3

Pokud je k dispozici nìkolik softwarových balíèkù, budou 
instalovány postupnì. A.3
A.3–6 Návod k použití pro uživatele systému syngo
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Základy Antivirová ochrana Siemens (volitelný doplnìk)
Aktualizace operaèního systému pomocí 
oprav hotfix A.3

Aby se zajistila optimální ochrana systému Siemens pøed 
virovými útoky, bude systém kromì nejnovìjších aktualizací 
antivirového programu pøijímat také opravy hotfix související se 
zabezpeèením. Opravy hotfix jsou balíèky aktualizací souborù, 
jejichž cílem je vyøešit chybu zabezpeèení operaèního systému. 
Spoleènost Siemens posoudí dùležitost každé nové opravy 
hotfix, kterou vydá výrobce operaèního systému, pro 
zabezpeèení jednotlivých našich systémù a pokud ji bude 
považovat za relevantní, komplexnì ji otestuje a schválí pøed 
poskytnutím prostøednictvím infrastruktury vzdálených služeb 
Siemens (SRS) do systému. Systém pøi spuštìní automaticky 
provìøí, zda je k dispozici nová oprava hotfix èekající na 
instalaci. A.3
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Antivirová ochrana Siemens (volitelný doplnìk) Základy
Nová oprava hotfix A.3

Pokud je nová oprava hotfix k dispozici, opìt se zobrazí 
dialogové okno Software-Distribution známé z aktualizací 
programu pro provìøování virù. A.3

➭ Po instalaci nové opravy hotfix mùže být nutné restartovat 
systém, aby se aktualizace mohla uplatnit. Pokud je k 
dokonèení instalace nutné restartování systému, v 
dialogovém oknì se zobrazí pøíslušná zpráva.
A.3–8 Návod k použití pro uživatele systému syngo
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Základy Antivirová ochrana Siemens (volitelný doplnìk)
Instalace opravy hotfix A.3

✧ Kliknutím na tlaèítko Yes potvrdíte instalaci opravy hotfix. 
Instalace zaène ihned a její prùbìh se bude zobrazovat v dolní 
èásti dialogového okna.

Nebo A.3

✧ Pokud si aktualizaci nepøejete instalovat ihned, klepnìte na 
tlaèítko LATER. Dialogové okno se zavøe bez instalace.

➭ Dokud nenainstalujete novou opravu hotfix, dialogové okno 
Software-Distribution s výzvou k provedení instalace se 
zobrazí pøi každém dalším spuštìní systému.

!0

A.3 A.3

Spoleènost Siemens doporuèuje instalovat opravy hotfix 
ihned. Pokud instalaci musíte provést pozdìji, proveïte ji co 
nejdøíve. Jinak bude systém spuštìn s nízkou úrovní 
zabezpeèení a bude více ohrožen možnými viry. A.3
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Antivirová ochrana Siemens (volitelný doplnìk) Základy
Ukonèení instalace A.3

Úspìšná instalace A.3 Po úspìšném dokonèení instalace opravy hotfix se zobrazí 
odpovídající zpráva. A.3

✧ Klepnutím na tlaèítko OK ukonèíte proces instalace a zavøete 
dialogové okno.

➭ Pokud je k dokonèení instalace nutné restartovat systém, 
bude restartován automaticky po kliknutí na tlaèítko OK. 
Systém je pak možné zaèít ihned používat.
A.3–10 Návod k použití pro uživatele systému syngo

 0.0



Základy Antivirová ochrana Siemens (volitelný doplnìk)
Selhání instalace A.3 ➭ Pokud se instalace opravy hotfix z nìjakého dùvodu nezdaøila, 
zobrazí se odpovídající zpráva. V takovém pøípadì budou 
informace o nepodaøené instalaci automaticky pøedány 
servisnímu støedisku Siemens UPTIME, které provede 
pøislušnou akci.

➭ Kliknutím na tlaèítko OK zavøete dialogové okno. 

!0

A.3 A.3

V pøípadì, že instalace opravy hotfix selže, nepokraèujte v 
práci se systémem a obra¤e se na servisní støedisko UPTIME, 
které vám poskytne další informace a zajistí podporu. A.3
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Antivirová ochrana Siemens (volitelný doplnìk) Základy
Co dìlat v pøípadì napadení virem A.3

Pokud program pro provìøování virù zjistil v systému Siemens 
virus, zobrazí se následující zprávy s podobným textem. A.3
A.3–12 Návod k použití pro uživatele systému syngo
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Základy Antivirová ochrana Siemens (volitelný doplnìk)
Informace o zjištìném viru budou automaticky nahlášeny 
prostøednictvím vzdálené služby servisnímu støedisku Siemens 
UPTIME, které provede nápravnou akci. A.3

!0

A.3 A.3

Pokud je systém napaden virem, nelze zajistit jeho øádné 
fungování. Je tøeba dokonèit veškeré právì provádìné 
postupy, protože je možné, že systém pozdìji nebude možné 
používat. Než systém znovu zaènete používat, obra¤te se na 
servisní støedisko UPTIME, kde získáte všechny potøebné 
informace, jak postupovat. A.3
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Antivirová ochrana Siemens (volitelný doplnìk) Základy
A.3–14 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

A.4

Konfigurace 
uživatelského rozhraní A.4
Mùžete konfigurovat karty úloh, okna i jednotlivé funkce 
programu, a tak je pøizpùsobovat svým požadavkùm. A.4

A.4

Pokud chcete konfigurovat okna a karty úloh, zobrazte nejprve 
položku syngo - Configuration Panel, kde najdete ikony 
zastupující rùzné aplikace. Poklepáním na zvoleno ikonu poté 
otevøete pøíslušné konfiguraèní okno. A.4

Mùžete napøíklad urèit, která tlaèítka bude obsahovat panel 
nástrojù v oknì Patient Browser. 

A.4

A.4

UPOZORNÌNÍ

Pøi spuštìní záøení okno vlastní konfigurace Windows nezmizí. 
Okno zùstane otevøené, protože je to dialog zobrazený 
systémem Windows a nikoli dialog programu syngo. A.4

Mùže tak dojít k nedorozumìní. A.4

✧ Tento dialog neotvírejte, mùže-li být aplikováno záøení. V 
každém pøípadì by nemìl být poèítaè a systém syngo nikdy 
konfigurován bìhem poøizování dat. 
Verze VE31D A.4–1 
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Konfigurace uživatelského rozhraní Základy
Otevøení okna Configuration 
Panel (Konfiguraèní panel) A.4

✧ Spuštìním funkce Options > Configuration... otevøete okno 
syngo - Configuration Panel.

 

A.4–2 Návod k použití pro uživatele systému syngo
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Základy Konfigurace uživatelského rozhraní
Vyvolávání konfiguraèních oken A.4

Nakonfigurované souèásti programu jsou zastoupeny ikonami v 
oknì syngo - Configuration Panel. 

A.4

A.4 ✧ Dvojitým kliknutím na tuto ikonu zobrazíte konfiguraèní 
okno pro Patient Browser. 
→ Kapitola C.8, Konfigurace prohlížeèe Patient Browser 
 
 

A.4 ✧ Dvojitým kliknutím na tuto ikonu zobrazíte okno, v nìmž lze 
nakonfigurovat funkce pro archivaci a práci v síti. 
→ Kapitola F.6, Konfigurace pøenosu dat 
 
 

A.4 ✧ Dvojitým kliknutím na tuto ikonu zobrazíte konfiguraèní 
okno pro pøiøazení rozvržení filmù pøíslušné studie. 
→ Kapitola G.6, Konfigurace exponování na film 
 
 

A.4 ✧ Po dvojitém kliknutí na tuto ikonu budete moci 
nakonfigurovat rozvržení filmù nebo vytvoøit nové rozvržení 
filmù. 
→ Kapitola G.6, Konfigurace exponování na film 
 
 

Verze VE31D A.4–3 
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Konfigurace uživatelského rozhraní Základy
A.4 ✧ Po dvojitém kliknutí na tuto ikonu budete moci 
nakonfigurovat položku Patient Registration. 
→ Kapitola B.5, Konfigurace registrace pacienta 
 
 
 

A.4 ✧ Po dvojitém kliknutí na tuto ikonu budete moci 
nakonfigurovat kartu úlohy Viewing. 
→ Kapitola E.7, Konfigurace karty úlohy Viewing 
 
 
 

A.4 ✧ Po dvojitém kliknutí na tuto ikonu v oknì syngo - 
Configuration Panel budete moci nakonfigurovat text 
obrazu. 
→ Strana A.4–8, Konfigurace textu snímkù 
 
 

A.4 ✧ Po dvojitém kliknutí na tuto ikonu budete moci 
nakonfigurovat položku Patient Search. 
→ Strana C.2–41, Konfigurace vyhledávání pacienta 
 
 

A.4–4 Návod k použití pro uživatele systému syngo
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Základy Konfigurace uživatelského rozhraní
A.4 ✧ Po dvojitém kliknutí na tuto ikonu budete moci 
nakonfigurovat aplikaci 3D. 
→ Kapitola J.16, Konfigurace 3D zobrazení 
 
 

A.4 ✧ Po dvojitém kliknutí na tuto ikonu budete moci 
nakonfigurovat spoøiè obrazovky. 
Viz pøíruèka Systém zabezpeèení. 
 

A.4 ✧ Po dvojitém kliknutí na tuto ikonu budete moci 
nakonfigurovat nastavení Audit Trail. 
Viz pøíruèka Systém zabezpeèení.

A.4
Verze VE31D A.4–5 
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Konfigurace uživatelského rozhraní Základy
Definování nastavení Regional 
Settings A.4

V rámci nastavení Regional and Language Options mùžete 
urèit jazyk uživatelského rozhraní i další nastavení, napøíklad 
formát dat. A.4

A.4 ✧ Poklepejte na tuto ikonu.

Objeví se okno pro konfigurací místního a jazykového 
nastavení. A.4

 

➭ Uživatelské rozhraní pro místní nastavení se zobrazí vždy v 
angliètinì bez ohledu na zadaný jazyk.
A.4–6 Návod k použití pro uživatele systému syngo
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Základy Konfigurace uživatelského rozhraní
Nastavení jazyka 
uživatelského rozhraní A.4

✧ Vyberte jazyk, který požadujete pro kartu dílèí úlohy 
Regional Options. Volbu potvrïte tlaèítkem OK. 

Nastavení jazyka 
operaèního systému A.4

Je-li nainstalována pøídavná funkce pro volbu jazyka pro 
operaèní systém, mùžete vybrat jazyk z nabídek a dialogù na 
kartì dílèích úloh Languages. A.4

✧ Vyberte jazyk, který požadujete, v èásti Standards and 
formats. Volbu potvrïte tlaèítkem OK.

Aplikace se restartuje v novém jazyce. 
A.4
Verze VE31D A.4–7 
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Konfigurace uživatelského rozhraní Základy
Konfigurace textu snímkù A.4

Pomocí Image Text Editor mùžete stanovit, které èásti textu 
budou zobrazeny s obrázky. A.4

A.4 ✧ Dvojitì kliknìte na tuto ikonu v oknì syngo - Configuration 
Panel.

Zobrazí se konfiguraèní nástroj Image Text Configuration. A.4

 

A.4–8 Návod k použití pro uživatele systému syngo
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Základy Konfigurace uživatelského rozhraní
Typ snímku A.4 Pro každou modalitu mùžete zadat individuální nastavení. A.4

➭ Výchozí nastavení se použije, pokud pro zobrazený snímek 
není urèeno žádné specifické nastavení.

 
A.4

✧ Ve výbìrovém seznamu View Name zvolte požadovaný typ 
obrazu.

Zobrazí se nastavení pro tento vybraný text. 
A.4

A.4

Textové informace A.4 Výchozí režim textu je možné zmìnit. A.4

✧ Klepnìte na tlaèítko požadované možnosti.

A.4 ❏ All Text 
V obrazech se vypisují všechny dostupné textové informace.

❏ No Text 
V obrazech se nebudou vypisovat žádné texty.

❏ Customized Text 
Z dostupných textù mùžete poøídit výbìr.

!0

A.4 A.4

Jestliže vyberete nastavení No Text, nebudou se zobrazovat 
ani žádné orientaèní znaèky nebo údaje o mìøítku! A.4
Verze VE31D A.4–9 
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Konfigurace uživatelského rozhraní Základy
Výbìr textu A.4 Pokud jste zvolili možnost Customized Text, mùžete k obrazu 
vybrat jakoukoli èást textu. A.4

✧ Oznaète požadovaná políèka nebo u nich oznaèení zrušte.

Nebo A.4

A.4 ✧ klepnìte na tlaèítko Deselect All (pokud chcete zrušit výbìr 
všech položek),

Nebo A.4

A.4 ✧ klepnìte na tlaèítko Select All (pokud chcete vybrat všechny 
položky).

Zobrazí se vybrané textové informace (v závislosti na modalitì).A.4

A.4

➭ V závislosti na konfiguraci systému nemusí být možné 
zobrazit nìkteré textové informace.
A.4–10 Návod k použití pro uživatele systému syngo
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Základy Konfigurace uživatelského rozhraní
Uzavøení konfiguraèního okna A.4

Po zmìnì nastavení v konfiguraèním oknì mùžete toto okno 
zavøít s uložením nebo bez uložení provedených zmìn. 
 

A.4

A.4 ✧ Kliknutím na tlaèítko OK všechna nastavení uložíte a zavøete 
konfiguraèní okno. 
 

A.4 ✧ Když kliknete na tlaèítko Apply, svá nastavení uložíte, ale 
okno zùstane otevøené. 
 

A.4 ✧ Pokud chcete konfiguraci zrušit, zamítnout veškeré nastavení 
a zavøít okno, klepnìte na tlaèítko Cancel.
Verze VE31D A.4–11 
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A.4–12 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

A.5

 
Servisní funkce A.5
Systém poskytuje autorizovaným uživatelùm, tj. správcùm 
systému, øadu servisních funkcí pro údržbu, kontrolu a 
konfiguraci systému. A.5

➭ Z technických dùvodù je uživatelské rozhraní servisních funkcí 
vždy v angliètinì, a to bez ohledu na zvolený jazyk. 

A.5

A.5

UPOZORNÌNÍ

Servisní relace (napø. s omezeným pøístupem) bìžící souèasnì 
s poøizováním dat. A.5

Mohou se zobrazit rozevírací okna a zpùsobit 
nedorozumìní. A.5

✧ Po skonèení práce vždy servisní uživatelské rozhraní zavøete 
a neminimalizujte jej.
Verze VE31D A.5–1 
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Servisní funkce Základy
Zobrazení stavu údržby A.5

Pro zajištìní hladkého chodu je nutné provádìt údržbu systému 
v urèitých intervalech. A.5

Systém obsahuje dialogové okno, které oznamuje, kdy je tøeba 
jej znovu zkontrolovat. A.5

✧ Zvolte položku Options > Maintenance....

Zobrazí se dialogové okno Maintenance Status. A.5

 

➭ Na èernobílých monitorech nemusí být sloupec ukazatele 
stavu dobøe viditelný.
A.5–2 Návod k použití pro uživatele systému syngo
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Základy Servisní funkce
Barevný ukazatel stavu znázoròuje, kdy by mìla provedena 
nová údržba systému. A.5

Dokud je ukazatel v zelené oblasti, mùžete okno opìt zavøít 
klepnutím na tlaèítko OK. Pokud se ukazatel pøesune do èervené 
oblasti, lze toto okno zavøít až po provedení údržby systému. A.5

➭ V takovém pøípadì pøesuòte toto okno na stranu, proveïte 
kontrolu a kontaktujte servisní oddìlení spoleènosti Siemens.

➭ Další informace vám poskytne servisní oddìlení spoleènosti 
Siemens nebo správce systému.
Verze VE31D A.5–3 
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Místní servis A.5

Kromì konfigurace týkající se jednotlivých uživatelù existuje 
ještì heslem zabezpeèená úroveò konfigurace pro autorizované 
uživatele. A.5

✧ Zvolením Options > Service > Local Service... vyvoláte okno 
Authentication.

Podle konfigurace pøístupových práv v systému existuje nìkolik 
servisních úrovní. A.5

➭ Další informace vám poskytne servisní oddìlení spoleènosti 
Siemens nebo správce systému.
A.5–4 Návod k použití pro uživatele systému syngo
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Základy Servisní funkce
Pøístup pro vzdálený servis A.5

Servis systému mùže být rovnìž provádìn servisním oddìlením 
spoleènosti Siemens prostøednictvím routeru. A.5

V oknì Remote Service Access Control mùžete pøidìlit 
pøístupová práva servisním zamìstnancùm, aby mohli provádìt 
údržbu vašeho systému. A.5

✧ Vyvoláním Options > Service > Remote Service... zobrazíte 
dialogové okno Remote Service Access Control.
Verze VE31D A.5–5 
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Servisní funkce Základy
!0

A.5 A.5

➭ Pøi zapnutí systému je pøístup pro vzdálený servis možný jen z 
dùvìryhodných systémù (systémy, se kterými si program 
syngo vymìnil ovìøené certifikáty).

A.5

➭ Další informace vám poskytne servisní oddìlení spoleènosti 
Siemens nebo správce systému.

Dokud jsou servisu pøiøazena úplná pøístupová práva (tzn. 
dokud probíhá údržba systému), nelze se systémem 
pracovat. A.5

✧ Zvolte položku Limited access nebo No access. Pokraèujte 
kliknutím na tlaèítko OK nebo Apply.

A.5

UPOZORNÌNÍ

Ukonèení vzdáleného servisu bez konzultace se servisními 
zamìstnanci. A.5

Pøi ukonèení vzdáleného servisu budou ukonèeny všechny 
servisní procesy a mùže dojít k selhání systému. A.5

✧ Ukonèení vzdáleného servisu vždy koordinujte se servisním 
zamìstnancem.
A.5–6 Návod k použití pro uživatele systému syngo

 0.0



Základy Servisní funkce
Záznamník A.5

Váš systém obsahuje záznamník, do nìhož se zapisují všechny 
významné události, které se vztahují k systému a aplikacím, 
napøíklad chybová hlášení. A.5

✧ Vyvolejte Options > Service > Event Log..., chcete-li zobrazit 
dialogové okno Event Log.

 

Mùžete vybrat druh a datum hlášení, která chcete zobrazit. A.5

➭ Další informace vám poskytne servisní oddìlení spoleènosti 
Siemens nebo správce systému.
Verze VE31D A.5–7 
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B.1

 
Úvod B.1
Pøed vyšetøením pacienta prostøednictvím systému jej musíte 
zaregistrovat. Registrace znamená, že do systému dodáte 
veškeré informace o pacientovi, které jsou pro vyšetøení 
potøebné. B.1

Podle toho, jak je ve vašem zdravotnickém zaøízení registrace 
organizována a kolik èasu na ni máte, si mùžete vybrat mezi 
rùznými postupy registrace pacienta. 

B.1

Nouzová registrace B.1 Jestliže pøijmete pacienta, který je v mimoøádnì kritickém stavu 
a musí být proto neprodlenì vyšetøen a ošetøen, použijte 
nouzovou registraci. Tím zkrátíte dobu pøed vlastním 
vyšetøením pacienta na minimum. 

B.1

Registrace B.1 Pokud však chcete zaregistrovat pacienta k vyšetøení, zadejte 
nejprve údaje o nìm (nebo je naètìte z databáze) a potom jej 
vyšetøete. 

B.1
Verze VE31D B.1–1 
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Úvod Registrace pacienta
Pøedbìžná registrace B.1 Chcete-li systém pøipravit k pozdìjšímu vyšetøení pacienta, 
mùžete provést pøedbìžnou registraci pacienta.  
Napøíklad mùžete dopoledne zadat údaje všech pacientù, kteøí 
mají být v prùbìhu dne vyšetøeni. Chcete-li zaèít s registrací 
pacienta, jednoduše naètìte jeho údaje a v pøípadì potøeby je 
upravte. Tím si ušetøíte pøi vyšetøeních èas. 

B.1

Dotaz HIS/RIS B.1 Jestliže máte systém napojený na HIS/RIS systém (tj. nemocnièní 
a radiologický informaèní systém) a jste v nìm evidováni a 
oprávnìni jej používat, mùžete zobrazit údaje pacienta, který 
má být vyšetøen. 

B.1

Zabezpeèení – oprávnìní B.1 Je-li aktivována funkce Security, mùžete pacienta zaregistrovat 
pouze v pøípadì, že jste k tomu autorizováni. Funkce
InvokeRegistration je privilegium, jež vám dovoluje otevøít 
registraèní formuláø a provést registraci. B.1

B.1
B.1–2 Návod k použití pro uživatele systému syngo
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Registrace pacienta Úvod
Spuštìní registrace pacienta B.1

Registraci pacienta mùžete otevøít v nabídcePatient nebo 
pomocí tlaèítek s ikonou na rùzných kartách úloh v nabídce 
Patient Browser. Mùžete si vybrat mezi nouzovou registrací a 
bìžnou registrací. B.1

Nabídka Patient B.1

B.1 ✧ Otevøete nabídku Patient > Emergency... nebo Patient > 
Register....  

Zobrazí se okno Emergency Registration nebo Patient 
Registration. 

B.1

Nebo B.1

Tlaèítka B.1

B.1 ✧ Kliknìte na tlaèítko s ikonou na kartì úlohy nebo na panelu 
nástojù v Patient Browser. 
 

Nebo B.1

Klávesnice se symboly B.1

B.1 ✧ Stisknìte klávesu Patient Register na klávesnici se symboly.
Verze VE31D B.1–3 
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Úvod Registrace pacienta
Okno Patient Registration B.1

Okno Patient Registration je rozdìleno do ètyø oblastí, do nichž 
mùžete zadávat následující údaje: B.1

(1) osobní údaje pacienta (PATIENT),

(2) údaje o doporuèení k vyšetøení (HOSPITAL),

(3) údaje týkající se dané studie (PROCEDURE),

(4) údaje o instituci (INSTITUTION).
B.1–4 Návod k použití pro uživatele systému syngo
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Registrace pacienta Úvod
(1) B.1 (3) B.1

(4) B.1

(2) B.1
Verze VE31D B.1–5 
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Úvod Registrace pacienta
Osobní údaje pacienta B.1 V oblasti PATIENT mùžete zadat veškeré podrobné osobní údaje 
pacienta a všechny ostatní informace o nìm. B.1

!0

B.1 B.1

Údaje o doporuèení k 
vyšetøení B.1

Do èásti HOSPITAL mùžete zapsat jméno ošetøujícího lékaøe, 
pøedbìžnou diagnózu, pøedbìžné pøíjmové èíslo a nemocnièní 
pokoj, kam byl pacient umístìn. 

B.1

Údaje týkající se studie B.1 Do èásti PROCEDURE mùžete zapisovat informace o 
plánovaném vyšetøení, napø. o poloze pacienta a chystaných 
vyšetøeních. 

B.1

Údaje o instituci B.1 Do vstupních polí v èásti INSTITUTION mùžete zaznamenat 
název svého zdravotnického zaøízení nebo své ordinace a jména 
zamìstnancù, kteøí provádìjí vyšetøení. B.1

Jméno pacienta, identifikaèní èíslo pacienta, datum narození a 
pohlaví se používají pro jeho jedineènou identifikaci v 
databázích a na archivním médiu. B.1
B.1–6 Návod k použití pro uživatele systému syngo
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B.2

Registrace naléhavého 
pøípadu B.2
Pøi pøíjmu naléhavého pøípadu do vašeho zaøízení je nezbytné, 
abyste byli schopni pacienta ihned vyšetøit a ošetøit a neztráceli 
èas zapisováním jeho údajù. B.2

V tìchto pøípadech spus¤te nouzovou registraci a otevøete ihned 
kartu úlohy Examination, B.2

nebo proveïte nouzovou registraci z okna Patient 
Registration, pokud je již otevøené. 
→ Strana B.3–4, Nouzová registrace v oknì Patient RegistrationB.2

Tak zkrátíte dobu, která uplyne od pøijetí naléhavého pøípadu do 
zahájení vlastního vyšetøení, na minimum. B.2

Údaje o tomto pacientovi mùžete do Patient Browser doplnit 
pozdìji. 
→ Strana C.4–2, Oprava údajù pacienta nebo dat z vyšetøení B.2
Verze VE31D B.2–1 
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Registrace naléhavého pøípadu Registrace pacienta
Okno naléhavého pøípadu B.2

Poté, co jste vyvolali funkce Patient > Emergency... v hlavním 
menu nebo v menu aplikace Patient Browser, zobrazí se okno 
Emergency Registration. B.2
B.2–2 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace naléhavého pøípadu
Provedení nouzové registrace B.2

Systém již zadal jednoznaèné kódy pro jméno pacienta a jeho 
identifikaèní èíslo pro pøípad, že by napøíklad nebylo možné s 
pacientem komunikovat. Staèí pøipojit nìkolik položek údajù a 
mùžete zaèít s vyšetøením pacienta. 

B.2

Kódy pro jméno  
a identifikaèní èíslo 
pacienta B.2

Kód pro Last name se skládá z data, èasu a zkratky letního èasu 
(DST) nebo standardního èasu (STD) a (v závislosti na 
konfiguraci) pøednastaveného popisu studie, napøíklad: 
„99.12.31-23:59:00-STD-Thorax-Trauma”. B.2

V poli pro položku Patient ID se nachází kombinace data, èasu, 
zkratky letního nebo standardního èasu a identifikaèního èísla 
vašeho systému (toto èíslo je jedineèné a platí celosvìtovì). B.2

➭ Automaticky vložené identifikaèní èíslo platí pouze místnì, 
nepøenáší se tedy do systému RIS. 
 

Doplnìní potøebných údajùB.2 Kurzor se nachází ve vstupním poli, do nìhož se zadává datum 
narození. B.2

B.2 ✧ Zadejte datum narození pacienta.

Nebo B.2

B.2 ✧ Stisknutím tabulátoru datum narození pøeskoète, napø. 
pokud je neznáte. 
Váš systém pak použije prozatímní datum narození 
(18.11.1858).
Verze VE31D B.2–3 
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Registrace naléhavého pøípadu Registrace pacienta
✧ Zadejte pohlaví pacienta.

Nebo B.2

✧ tyto údaje pøeskoète stisknutím klávesy záložky. 
Systém pak vloží jako pohlaví pacienta Other. 

Registrace B.2

B.2 ✧ Klepnutím na tlaèítkoExam naléhavý pøípad zaregistrujte.

Otevøe se karta úloh Examination a vy mùžete ihned zaèít s 
vyšetøením. 

B.2

!0

B.2 B.2

V závislosti na konfiguraci možná bude nutné pøed registrací 
naléhavého pøípadu zadat napøíklad plánované vyšetøení a 
polohu pacienta do okna Emergency Registration. B.2
B.2–4 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace naléhavého pøípadu
Až budete mít po vyšetøení více èasu, mùžete pomocí prohlížeèe 
Patient Browser údaje o naléhavém pøípadu a souvisejícího 
vyšetøení doplnit. Mùžete také nahradit kódy a provizorní údaje 
správnými údaji (napøíklad celým jménem pacienta). 
→ Strana C.4–2, Oprava údajù pacienta nebo dat z vyšetøení 

B.2

!0

B.2 B.2

B.2

Zrušení nouzové registraceB.2 Nouzovou registraci mùžete kdykoli zrušit (napøíklad pokud jste 
omylem otevøeli okno Emergency Registration namísto okna 
Patient Registration. 

B.2

B.2 ✧ Nouzovou registraci zastavíte klepnutím na tlaèítko Cancel. 
Otevøe se opìt aplikace, z níž jste nouzovou registraci 
spustili.

B.2

Nouzovou registraci nelze provádìt bìhem probíhajícího 
vyšetøení. B.2

✧ Nejprve probíhající vyšetøení dokonèete nebo je pøerušte a 
teprve potom naléhavý pøípad zaregistrujte.
Verze VE31D B.2–5 
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Registrace naléhavého pøípadu Registrace pacienta
B.2–6 Návod k použití pro uživatele systému syngo

 0.0



KAPITOLA 0.0

B.3

Registrace nového 
pacienta B.3
V systému zatím nejsou uloženy údaje o pacientovi, který ještì 
nebyl ve vaší nemocnici nebo ordinaci vyšetøován. 
Pøed vyšetøením musíte proto zadat všechny údaje o tomto 
pacientovi. 

B.3

Registrace B.3 Pokud pacienta po zadání údajù chcete ihned vyšetøit, musíte 
vyplnit alespoò ta vstupní pole, jejichž názvy jsou zobrazeny 
tuèným písmem. B.3

V pøípadì registrace (normální nebo nouzové) se údaje o 
pacientovi uloží do místní databáze. 

B.3

Pøedbìžná registrace B.3 Jestliže chcete pacienta pouze pøedbìžnì zaregistrovat pøed 
pozdìjším vyšetøením, staèí, když vyplníte údaje o jeho jménu, 
pohlaví, identifikaèním èísle a datum jeho narození. B.3

Údaje z pøedbìžných registrací pacientù se ukládají do databáze 
plánu termínù. 

B.3
Verze VE31D B.3–1 
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Registrace nového pacienta Registrace pacienta
Údaje nového pacienta zadejte do prázdného okna Patient 
Registration. B.3

✧ Otevøete okno Patient Registration. 
→ Strana B.1–3, Spuštìní registrace pacienta

➭ Jestliže toto okno otevøete z prohlížeèe Patient Browser, 
ujistìte se, zda jste v nìm nevybrali pacienta nebo studii.

➭ Tlaèítka Exam a Preregister nebudou aktivována, dokud 
nezapíšete veškeré informace požadované pro registraci èi 
pøedbìžnou registraci pacienta. 

Identifikace pacienta B.3 Identifikace pacienta má tøi rùzné atributy: B.3

❏ Admission ID (v èásti HOSPITAL): Identifikaèní èíslo návštìvy 
pøidìlené poskytovatelem zdravotní péèe.

❏ Accession No (v èásti PROCEDURE): Generované èíslo RIS 
oznaèující objednávku pro studii. 

❏ Patient ID (v èásti PATIENT): Primární nemocnièní 
identifikaèní èíslo nebo kód pacienta.
B.3–2 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace nového pacienta
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Registrace nového pacienta Registrace pacienta
Nouzová registrace v oknì Patient 
Registration B.3

Nouzovou registraci mùžete kdykoli provést z okna Patient 
Registration. B.3

B.3 ✧ Kliknutím na tlaèítko Emergency aktivujte kartu úlohy 
Examination a zahajte vyšetøení. 
 

Pøedbìžný kód pacienta a 
èíslo pacienta B.3

Jestliže jste nezadali jméno, systém vytvoøí kód stejným 
zpùsobem jako pøi registraci v oknì Emergency Registration. 
→ Strana B.2–3, Kódy pro jméno a identifikaèní èíslo pacientaB.3

Záznamy v poli Patient ID budou pøepsány automatickou 
identifikací, která obsahuje datum, èas, zkratku letního nebo 
standardního èasu a identifikaèní èíslo vašeho systému (toto 
èíslo je jedineèné a platí celosvìtovì). 
→ Strana B.2–3, Kódy pro jméno a identifikaèní èíslo pacienta 

B.3
B.3–4 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace nového pacienta
Zadané údaje o pacientovi 
a vyšetøení B.3

Všechny ostatní údaje o pacientovi a vyšetøení, které již byly v 
oknì Patient Registration zadány, budou pøevzaty beze 
zmìny. Chybí-li v souvislosti s vyšetøením naléhavého pøípadu 
nìjaký povinný údaj (napøíklad poloha pacienta), zobrazí se 
okno s hlášením. B.3

B.3 ✧ Okno s hlášením zavøete kliknutím na tlaèítko OK. 
 
 

B.3 ✧ Než znovu kliknete na tlaèítko Emergency v oknì Patient 
Registration doplòte chybìjící údaje.

➭ Jestliže tyto údaje nezadáte, systém v závislosti na konfiguraci 
automaticky doplní jako pohlaví Other a jako datum narození 
„11/18/1858". Zadáte-li místo data narození vìk, systém 
vypoèítá datum narození na základì souèasného data.

Po vyšetøení nebo pozdìji mùžete údaje naléhavého pøípadu 
doplnit nebo opravit pomocí Patient Browser. 
→ Strana C.4–2, Oprava údajù pacienta nebo dat z vyšetøení B.3
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Záznamy v èásti PATIENT B.3

Po spuštìní registrace pacienta se kurzor se objeví ve vstupním 
poli pro zadání jména pacienta v èásti PATIENT. B.3

Tlaèítka Exam a Preregister nebudou aktivována, dokud 
nezapíšete veškeré informace požadované pro registraci èi 
pøedbìžnou registraci pacienta. 
 

B.3

Zadávání osobních údajù nového pacienta B.3

Osobní údaje o pacientovi obsahují pøíjmení pacienta, 
identifikaèní èíslo pacienta, datum narození a pohlaví 
pacienta. Tyto údaje jednoznaènì urèují pacienta ve vaší 
databázi. B.3
B.3–6 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace nového pacienta
✧ Zadejte pacientovo pøíjmení, køestní jméno a v závislosti na 
konfiguraci vašeho systému další jména èi tituly.

✧ Zadejte etnickou skupinu, ke které pacient patøí.

✧ Má-li pacient vojenskou hodnost, zadejte ji do pole Military 
Rank.

✧ Zadejte pacientovo identifikaèní èíslo a v závislosti na 
konfiguraci vašeho systému i pøípadná další èísla.

Pokud nezadáte pacientovo identifikaèní èíslo, systém 
automaticky generuje identifikaèní kód skládající se z data, 
èasu, zkratky letního nebo standardního èasu a identifikaèního 
èísla vašeho systému (toto èíslo je jedineèné a platí 
celosvìtovì). 
→ Strana B.2–3, Kódy pro jméno a identifikaèní èíslo pacientaB.3
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Registrace nového pacienta Registrace pacienta
B.3 ✧ Zadejte datum narození pacienta.  

➭ Vstupní formát data narození závisí na místním nastavení 
vašeho operaèního systému. Platný vstupní formát data je 
zobrazen na stavovém øádku.

➭ Dny, mìsíce a roky od sebe mùžete oddìlovat pomocí 
znaménka „-", „." nebo „/" nebo pouze mezerou.  
Mìsíc mùžete zadat v èíselném formátu, nebo jako zkratku 
složenou ze tøí písmen.  
Rok mùžete zadat ve formì dvou nebo ètyø èíslic.  
Pøíklady: Mar/21/55 nebo 3-21-1955 nebo 21 03 55

➭ Pokud je pacient starší než 100 let, zadávejte datum jeho 
 narození pomocí ètyø èíslic. Správnì budou zaznamenána 
pouze data narození pozdìjší než 18.11.1858. 
 

 

✧ Zadejte pohlaví pacienta. 

B.3
B.3–8 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace nového pacienta
B.3 Váš systém již vypoèítal vìk pacienta na základì výše zadaného 
data narození. B.3

✧ Zkontrolujte zobrazený vìk. Jestliže není správný, musíte 
opravit datum narození.

➭ Pokud datum narození neznáte, mùžete zadat odhadovaný 
vìk pacienta. Systém pak vypoèítá z daného vìku datum 
narození. Do vedlejšího výbìrového pole mùžete zapsat, zda 
je vìk uveden v letech, mìsících nebo dnech (napøíklad u 
dìtí). 

!0

B.3 B.3

B.3 ✧ Zadejte výšku pacienta. 

B.3 ✧ Zadejte váhu pacienta.

➭ Jednotky váhy a výšky závisejí na místním nastavení vašeho 
systému.

Zkontrolujte správnost pacientova jména, identifikaèního 
èísla, data narození a pohlaví, aby nemohlo dojít k zámìnì s 
jinými pacienty. B.3
Verze VE31D B.3–9 
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Registrace nového pacienta Registrace pacienta
✧ Zadejte adresu pacienta.

➭ Jestliže je adresa delší než tøi øádky, objeví se na pravém okraji 
vstupního pole posuvník. S jeho pomocí mùžete listovat 
vstupním polem. 
 
 

Zadávání doplòujících informací B.3

Naplánování vyšetøení a jeho další prùbìh lze nìkdy 
zjednodušit zadáním doplòujících informací o pacientovi. B.3

✧ Jakékoli další informace týkající se pacienta (napøíklad 
informace o pøedcházejících vyšetøeních) zadejte do pole 
Additional info.

➭ Jestliže jsou vaše poznámky delší než tøi øádky, objeví se na 
pravém okraji vstupního pole posuvník. S jeho pomocí 
mùžete procházet vstupním polem.
B.3–10 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace nového pacienta
Zobrazení pøehledu B.3 Pro lepší pøehled mùžete zadaný text pøekontrolovat ve vìtším 
formátu. B.3

B.3 ✧ V poli Additional info kliknìte na tlaèítko Blow up. 

➭ V oknì Full Additional Patient Information si mùžete pøeèíst 
text, který jste zapsali do pole Additional info.

B.3 ✧ Chcete-li okno zavøít, kliknìte na tlaèítko Close.
Verze VE31D B.3–11 
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Registrace nového pacienta Registrace pacienta
Zobrazení podrobných informací B.3

V závislosti na modalitì mùže být nutné zobrazit dodateèné 
údaje a informace o pacientovi. B.3

B.3 ✧ Klepnìte na tlaèítko Details....

Zobrazí se okno Additional Patient Attributes. B.3
B.3–12 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace nového pacienta
B.3 ❏ Toto pole obsahuje informace o alergiích, jimž pacient trpí 
(napøíklad na urèité léky). 

B.3 ❏ Zde naleznete informace o alergiích na kontrastní látky, jimiž 
by pacient mohl trpìt. 

B.3 ❏ Pokud je nutné použít kontrastní látku, je tøeba ji zaznamenat 
do tohoto pole. 

B.3 ❏ Toto pole obsahuje informace o lécích, které je pacientovi 
pøed vyšetøením nutno podat. 

B.3 ❏ Toto pole obsahuje informace o tom, zda jsou pro pacienta 
nutná zvláštní opatøení (zda napøíklad pacient nebo 
pacientka potøebuje invalidní vozík nebo služby tlumoèníka). 

B.3 ❏ Toto pole obsahuje informace o celkovém stavu pacienta 
(slabý zrak, nedostateèná orientace a podobnì). 

B.3 ❏ Z pole Smoking status zjistíte, zda pacient kouøí. 

B.3 ❏ Toto pole obsahuje u pacientky informaci o tom, zda je 
tìhotná. 

B.3 ❏ V poli Last menstrual date najdete datum posledního 
menstruaèního cyklu pacientky.
Verze VE31D B.3–13 
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Registrace nového pacienta Registrace pacienta
B.3 ❏ V poli Additional patient history najdete informace o 
anamnéze pacienta. 

➭ Podobnì jako u pole Additional info mùžete zadat nìkolik 
øádkù i do oblasti Additional patient history a zobrazit 
pøíslušný pøehled. 
→ Strana B.3–10, Zadávání doplòujících informací
B.3–14 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace nového pacienta
Zadávání údajù o pøíjmu pacienta B.3

Do èásti HOSPITAL mùžete zadat informace o pøijmu pacienta 
do vaší péèe. B.3

✧ Zadejte jméno lékaøe (napøíklad obvodního lékaøe), který 
pacienta doporuèil, nebo vyberte jeho jméno z výbìrového 
seznamu.

✧ Zadejte jméno lékaøe, který požádal o pøijetí pacienta do 
nemocnice, nebo vyberte jeho jméno z výbìrového 
seznamu.

✧ Zadejte vstupní diagnózu pacienta nebo ji vyberte z 
výbìrového seznamu.
Verze VE31D B.3–15 
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Registrace nového pacienta Registrace pacienta
✧ Zadejte pokoj, v nìmž je pacient umístìn, nebo ho vyberte z 
výbìrového seznamu.

✧ Zadejte pøedbìžné èíslo pacienta. 
 

➭ V nabídce Registration Configuration mùžete definovat 
položky tìchto výbìrových seznamù.  
→ Strana B.5–2, Definování záznamù ve výbìrovém seznamu

B.3
B.3–16 Návod k použití pro uživatele systému syngo
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Zadávání údajù o vyšetøení B.3

V èásti PROCEDURE mùžete zadat informace o vyšetøení, které 
má být provedeno. 

B.3

Jedna nebo více studií 
bìhem relace B.3

V nastavení vašeho systému je urèeno, zda mùžete bìhem 
jedné relace provádìt u jednoho pacienta pouze jednu nebo 
více studií. Èást PROCEDURE vypadá rùznì v závislosti na 
provedeném nastavení. 
 

B.3

 

Bìhem relace je pøípustná jedna studie B.3 Bìhem relace je pøípustných více studií B.3
Verze VE31D B.3–17 
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Registrace nového pacienta Registrace pacienta
Zadání jedné studie B.3

Pokud je bìhem relace pøípustná pouze jedna studie, mùžete ji 
urèit ve vstupním poli Study. B.3

✧ Zadejte nìkolik poèáteèních písmen požadované studie.

Otevøe se seznam studií a první studie, která bude odpovídat 
vašemu zadání, bude zvýraznìna a pøemístìna do vstupního 
pole. B.3

 

✧ Když klepnete na název nìkteré studie z tohoto seznamu, 
pøemístí se ihned do vstupního pole. 

Pak se také okamžitì objeví v poli Requested procedure(s). B.3
B.3–18 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace nového pacienta
Nebo B.3

✧ Pomocí posuvníku procházejte seznamem studií, dokud 
nenajdete požadovanou tìlesnou oblast.

✧ Kliknutím na symbol  pøed tímto záznamem se zobrazí 
všechny studie týkající se této oblasti. 

 se stane symbol .  

✧ Kliknutím na symbol  se studie opìt skryjí.

✧ Klepnìte na požadovanou studii ve výbìrovém seznamu. 

Ta se poté objeví ve vstupním poli Study. B.3

+

+ -

-

Verze VE31D B.3–19 
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Sestavování seznamu studií B.3

Pokud vám systém umožòuje provádìt více studií bìhem jedné 
relace, mùžete si postupným výbìrem jednotlivých studií v poli 
Study sestavit seznam studií. 
→ Strana B.3–18, Zadání jedné studie 

B.3

✧ Vyberte studii ve výbìrovém seznamu v poli Study List. Tato 
studie se pak okamžitì objeví v seznamu studií.

 

✧ Poté vyberte z výbìrového seznamu další studie. Tyto studie 
budou pøipojeny k seznamu studií. 

B.3 ✧ Oznaète studii ve výbìrovém seznamu, a pokud tuto položku 
chcete odstranit, klepnìte na tlaèítko Delete nebo stisknìte 
klávesu Delete.

B.3
B.3–20 Návod k použití pro uživatele systému syngo
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Zadání polohy pacienta B.3

Po zadání požadovaného vyšetøení uveïte polohu, kterou by 
mìl pacient bìhem vyšetøení zaujmout. B.3

➭ Na kartì úlohy Examination mùžete polohu pacienta opìt 
zmìnit.

✧ Zvolte polohu pacienta pro (první) studii z výbìrového 
seznamu Poloha pacienta je urèena kombinací orientace - 
pozice.

Orientace: B.3

❏ Head First 
Pacient leží hlavou smìrem k vyšetøovací jednotce.

❏ Feet First 
Pacient leží nohama smìrem k vyšetøovací jednotce.

Pozice: B.3

❏ Left Lateral 
Pacient leží na levém boku.

❏ Right Lateral 
Pacient leží na pravém boku.

❏ Supine 
Pacient leží naznak.

❏ Prone 
Pacient leží na bøiše.
Verze VE31D B.3–21 
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Administrativní èísla a poznámky B.3

Pokud jste sestavili seznam studií, následující údaje se budou 
týkat všech studií v tomto seznamu. B.3

Vstupní a výstupní pole závislé na konfiguraci z hlediska 
pøístupového èísla studie pøiøazeného systémem RIS 
(radiologickým informaèním systémem). B.3

✧ Na toto místo zadejte interní administrativní èíslo studie 
nebo je potvrïte, pokud bylo pøedem zadáno systémem.

✧ Zadejte poznámky ke studii. 

B.3 ➭ Je-li nakonfigurován režim skenování ISO centra, mùžete jej 
aktivovat nebo deaktivovat pøes zaškrtávací políèko ISO 
center scanning.  
Skenování ISO centra je dostupné pouze v modalitách MR.
B.3–22 Návod k použití pro uživatele systému syngo
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Zadejte údaje o instituci B.3

Do èásti INSTITUTION zadejte informace o ústavu, kde byl 
pacient vyšetøen, a vyšetøujícím personálu. Tyto informace 
vám mohou pomoci, pokud budou výsledky vyšetøení zaslány 
z informativních dùvodù jiné organizaci. B.3

✧ Zadejte název zdravotnického zaøízení nebo tento název 
vyberte ze seznamu.

✧ Zadejte jméno vyšetøujícího lékaøe èi lékaøù nebo je vyberte z 
seznamu.

✧ Zadejte jméno operátora nebo operátorù nebo je vyberte ze 
seznamu.

➭ Položky tìchto výbìrových seznamù mùžete definovat v oknì 
Registration Configuration.  
→ Strana B.5–2, Definování záznamù ve výbìrovém seznamu
Verze VE31D B.3–23 
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Dokonèení zadávání dat B.3

Poté, co jste v oknì Patient Registration zadali všechny 
potøebné údaje o pacientovi, mùžete provést registraci pacienta 
pro následující vyšetøení nebo jeho pøedbìžnou registraci pro 
vyšetøení, které se bude uskuteèòovat pozdìji. 

B.3

Registrace pacienta pøed vyšetøením B.3

Jestliže chcete pacienta zaèít bezprostøednì poté vyšetøovat, 
zaregistrujte ho nyní. Následné vyšetøení probìhne s údaji, 
které jste zadali. B.3

registrace B.3

B.3 ✧ Kliknìte na tlaèítko Exam. 
 

V závislosti na konfiguraci systému se objeví dialogové okno , 
v nìmž musíte potvrdit údaje o pacientovì poloze, váze a 
pøípadnì i jeho datum narození. B.3
B.3–24 Návod k použití pro uživatele systému syngo
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B.3

B.3 ✧ Informace potvrïte klepnutím na tlaèítko Confirm.

➭ Pokud tyto údaje nejsou správné, klepnìte na tlaèítko Cancel. 
Zobrazí se znovu okno Patient Registration. 
Verze VE31D B.3–25 
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Systém již pacienta zná B.3 Po potvrzení osobních údajù pacienta systém ovìøuje, zda 
pacient nebyl již pøedbìžnì registrován nebo není zanesen v 
místní databázi. Je-li tomu tak, zobrazí se dialogové okno 
Patient not unique. B.3

 

B.3 ✧ Oznaète záznam pacienta a potvrïte klepnutím na tlaèítko 
Exam.

Nebo B.3

B.3 ✧ Pokud chcete registraci zrušit a údaje o pacientovi zmìnit, 
kliknìte na tlaèítko Cancel.
B.3–26 Návod k použití pro uživatele systému syngo
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Systém v závislosti na konfiguraci bìhem registrace zkontroluje, 
zda je pomìr vìku a hmotnosti pacienta pravdìpodobný. Pokud 
systém zjistí nesoulad, bude registrace zrušena. V takovém 
pøípadì se znovu zobrazí okno Patient Registration, v nìmž 
mùžete zadané údaje opravit. 
 

B.3

Po úspìšném dokonèení všech kontrolních operací se v zápatí 
okna Patient Registration zobrazí toto hlášení: 
„Transferring patient to examination...". B.3

Pacient je nyní zaregistrován pro vyšetøení. B.3

Okno Patient Registration se zavøe a znovu se zobrazí karta 
úloh Examination. B.3

B.3

B.3

UPOZORNÌNÍ

Interní identifikace údajù pacienta, napø. studií, sérií a 
obrazù, využívá systémový èas pro vytvoøení identifikace 
pacienta. Je-li nutné posunout systémový èas zpìt, mùže 
dojít k vytvoøení dvojí identifikace. B.3

Data mohou být pøiøazena k nesprávnému pacientovi. B.3

✧ Jestliže je nutné kvùli synchronizaci posunout systémový 
èas zpìt, poèkejte, dokud nový systémový èas nebude vìtší 
než ten pøedešlý. 
Verze VE31D B.3–27 
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Pøedbìžná registrace pacienta B.3

Jestliže chcete pacienta vyšetøovat pozdìji, mùžete jej se 
zadanými údaji registrovat pøedbìžnì. Data pacienta mùžete 
zobrazit pøi zahájení vyšetøení, a tak si ušetøit èas bìhem 
rutinních vyšetøení. 
→ Strana B.4–1, Registrace známého pacienta B.3

Pøedbìžná registrace B.3

B.3 ✧ Kliknìte na tlaèítko Preregister.

Systém zkontroluje, zda byl pacient již pøedbìžnì zaregistrován 
nebo zda jsou údaje o nìm uloženy v databázi, a podle potøeby 
zobrazí dialogové okno Patient not unique. 
→ Strana B.3–26, Systém již pacienta zná 

B.3

Poté se v záhlaví okna Patient Registration zobrazí toto hlášení: 
„Preregistering patient...". B.3

Údaje o pacientovi budou zaøazeny do databáze plánu 
termínù. Všechna vstupní pole okna Patient Registration jsou 
teï opìt prázdná. Mùžete do nich zadat údaje o dalším 
pacientovi. B.3
B.3–28 Návod k použití pro uživatele systému syngo
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Zrušení registrace pacienta B.3

Zadané údaje o pacientovi mùžete kdykoli zrušit. Veškeré údaje, 
které byly zadány do okna Patient Registration, budou 
ztraceny.  

B.3

B.3 ✧ Kliknìte na tlaèítko Cancel.

Okno Patient Registration se zavøe a otevøe se znovu 
aplikace, z níž jste registraci pacienta spustili. B.3

B.3

B.3
Verze VE31D B.3–29 
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B.3–30 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

B.4

Registrace známého 
pacienta B.4
Pacienta, který již byl pøedbìžnì zaregistrován nebo již byl v 
nemocnici èi ordinaci vyšetøen, systém zná. B.4

Chcete-li pro vyšetøení zaregistrovat známého pacienta, 
nemusíte jeho údaje znovu zadávat. Pacienta mùžete vyhledat 
v databázích a umístit uložené informace do okna Patient 
Registration, èímž ušetøíte èas bìhem registrace. 

B.4

Dotaz HIS/RIS B.4 Pokud byly údaje pacienta již zadány prostøednictvím systému 
HIS/RIS, mùžete je naèíst z nemocnièní databáze a umístit do 
plánovaèe. Tím je pacient pøedbìžnì registrován. 

B.4

Pøedbìžnì registrovaný 
pacient B.4

Jestliže byl pacient pøedbìžnì zaregistrován, mùžete podle 
potøeby døíve zadaná data zobrazit a doplnit je. Poté 
zaregistrujete pacienta k vyšetøení. 

B.4

Již vyšetøovaný pacient B.4 U pacienta, který již byl vyšetøován, mùžete použít jeho osobní 
údaje z databáze. Zkontrolujte je, v pøípadì potøeby je opravte a 
zadejte údaje pro nové vyšetøení. Pak zaregistrujte pacienta k 
následnému vyšetøení nebo jej pøedbìžnì zaregistrujte, pokud 
nechcete zaèít vyšetøení ihned. B.4
Verze VE31D B.4–1 
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Registrace známého pacienta Registrace pacienta
Dotaz HIS/RIS B.4

Pomocí dotazù HIS/RIS se údaje o pacientech zadané do 
nemocnièní poèítaèové sítì pravidelnì aktualizují. B.4

Automatický dotaz B.4

V závislosti na konfiguraci váš systém zkoumá buï data urèená 
pro vaše pracovištì, nebo data ze systému HIS/RIS urèená pro 
ostatní pracovištì se stejnou modalitou. 
→ Strana B.5–12, Nastavení aktualizace pracovního seznamu B.4

Tento proces se spouští automaticky v pravidelných intervalech, 
pokud ho aktivujete v konfiguraèním oknì Patient 
Registration. 
→ Strana C.2–4, Aktualizace plánovaèe 
→ Strana B.5–12, Automatická aktualizace 

B.4

Manuální dotaz B.4

Do systému HIS/RIS mùžete také kdykoli zadávat dotazy 
manuálnì. B.4

B.4 ✧ Otevøete seznam View > Update Worklist v Patient 
Browser, nebo dvakrát kliknìte na symbol Scheduler. 
→ Strana C.2–4, Aktualizace plánovaèe

➭ Než zaènete prohlížet údaje o pacientech v databázi, ujistìte 
se, že váš plánovaè obsahuje veškeré údaje o pacientech, 
které jsou pro vyšetøení potøebné.
B.4–2 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace známého pacienta
Stanovení èasového rozsahu 
pracovního seznamu B.4

Když zadáte dotaz HIS/RIS, objeví se okno Worklist Time Range, 
pokud je nakonfigurováno. V nìm mùžete urèit poèáteèní a 
koncový èas údajù o pacientech, zadaných do systému HIS/RIS 
pro váš dotaz. 
→ Strana B.5–13, Èasové rozpìtí B.4

Èasový rozsah pracovního seznamu mùžete vymezit podle 
potøeby, napøíklad na veškeré údaje o pacientech zadané v daný 
den. B.4

✧ Zadejte poèáteèní a koneènou dobu (datum a èas) svého 
dotazu. 

➭ Výchozí èasový rozsah je zadán podle èasového rozsahu 
uvedeného v oknì Registration Configuration. 
→ Strana B.5–11, Nastavení èasového rozpìtí

B.4 ✧ Kliknìte na tlaèítko Get Worklist, abyste vyvolali 
aktualizovaný seznam úloh pro definované období. 
→ Strana B.4–7, Vyhledávací seznam

Nebo B.4

B.4 ✧ Klepnìte na tlaèítko Cancel, pokud chcete zavøít okno 
Worklist Time Range bez aktualizace pracovního seznamu.
Verze VE31D B.4–3 
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Registrace známého pacienta Registrace pacienta
Hledání v oknì Patient 
Registration B.4

Údaje o pacientech mùžete v databázích vyhledávat z okna 
Patient Registration a pak je použít k registraci.  
 

B.4

Zadávání informací pro vyhledávání B.4

✧ Otevøete okno Patient Registration.

➭ Po spuštìní registrace z prohlížeèe Patient Browser se 
ujistìte, že není vybrán žádný pacient nebo studie a že tedy 
dialogové okno bude po otevøení prázdné.

✧ Do polí Last name, Patient ID a Accession No. zadejte vám 
známé údaje. 
→ Strana B.3–6, Záznamy v èásti PATIENT

 

➭ Nezáleží na tom, zda pøi zápisu použijete malá èi velká 
písmena.
B.4–4 Návod k použití pro uživatele systému syngo
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Zástupné znaky pro jméno a 
identifikaèní èíslo pacienta B.4

Jestliže znáte jen èást jména nebo identifikaèního èísla pacienta, 
kterého chcete vyhledat, mùžete také jako zástupný znak použít 
hvìzdièku "*". B.4

Zástupný znak zastupuje jakýkoli poèet znakù (písmen a èíslic).B.4

➭ Ve vstupním poli mùžete použít jako zástupné znaky až dvì 
hvìzdièky “*”, a to pøed anebo za známou èástí jména nebo 
identifikaèního èísla.

➭ Pokud ponecháte jedno nebo dvì pole volná, probìhne 
hledání stejnì jako v pøípadì, že jste napsali hvìzdièku "*".

➭ Pokud jste zadali køestní jméno a/nebo pøíjmení pracienta do 
vyhledávání, na konci vyhledávacího øetìzce se automaticky 
vloží hvìzdièka „*" (napø. M* nebo Miller*). 

Pøíklad pacientova jména B.4 Jestliže zadáte „Mil*”, budou nalezena jména „Miller” a „Mil”, 
avšak nikoli „Hamilton”, protože vyhledávání rozlišuje malá a 
velká písmena. 

B.4

Pøíklad pacientova 
identifikaèního èísla B.4

Jestliže zadáte „*SY*”, systém vyhledá identifikaèní èísla 
„GO18ENSY39987” a „SYHODSON40425”. B.4
Verze VE31D B.4–5 
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Zaèátek vyhledávání B.4

Po zadání údajù, které znáte, mùžete spustit vyhledávání. 
B.4

B.4 ✧ Klepnìte na tlaèítko Search.

Tlaèítko Search se zmìní v tlaèítko Abort. B.4

V databázi systému budou nyní vyhledáni pacienti se zadanými 
údaji. B.4

➭ V oknì Registration Configuration mùžete urèit, ve kterých 
databázích se má hledat (napøíklad v místní databázi, sí¤ové 
databázi, archivu). 
→ Strana B.5–5, Konfigurace funkce Patient Search 
 

Zrušení vyhledávání B.4

Vyhledávání mùžete kdykoli zrušit (napøíklad pøi chybném 
zadání jména). B.4

B.4 ✧ Klepnìte na tlaèítko Abort.

Hledání bude zrušeno a zobrazí se opìt okno Patient 
Registration. Nedojde k pøesunu žádných údajù. Tlaèítko Abort
se zmìní opìt v tlaèítko Search. B.4
B.4–6 Návod k použití pro uživatele systému syngo
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Vyhledávací seznam B.4

V oknì Patient Search se vypisuje seznam pacientù nalezených 
v databázích. Seznam vyhledaných pacientù se zobrazí, jakmile 
je nalezen více než jeden pacient. B.4

➭ V oknì Registration Configuration mùžete nastavit, které 
údaje pacientù se mají zobrazit v oknì Patient Search. 
→ Strana B.5–5, Konfigurace funkce Patient Search 

Stavový øádek B.4 Stavový øádek zobrazuje prùbìh hledání v oknì Patient Search. 
Zde mùžete zjistit: B.4

❏ ve které databázi vyhledávání právì probíhá,
❏ v jakém rozsahu je již tato databáze prohledána 

(v %),
❏ kolik pacientù již bylo nalezeno.
Verze VE31D B.4–7 
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Pøijetí údajù o pacientovi B.4

Vyhledávání dalších pacientù v databázích pokraèuje i poté, co 
byl nalezen první pacient. Jakmile je nalezen druhý pacient, 
systém zobrazí v oknì Patient Search výsledný seznam. 
 

B.4

Byl nalezen jeden pacient B.4 Jestliže byl po prohledání databází nalezen pouze jeden pacient, 
jeho osobní údaje budou automaticky umístìny do okna 
Patient Registration. B.4

U pøedbìžnì registrovaných pacientù se pøenesou do okna 
Patient Registration všechny døíve zadané údaje. 
 

B.4

Nalezeno víc pacientù 
B.4

Jestliže bylo nalezeno více pacientù, vyberte si z vyhledávacího 
seznamu toho, kterého potøebujete, a pøeneste jeho údaje. B.4

B.4 ✧ Vyberte pacienta ve vyhledávacím seznamu a klepnìte na 
tlaèítko OK.

Nebo B.4

✧ Poklepejte myší na jméno zvoleného pacienta.

Osobní údaje požadovaného pacienta (u pøedbìžnì 
registrovaných pacientù všechny døíve zadané údaje) budou 
umístìny do okna Patient Registration. B.4

Okno Patient Search se zavøe. B.4
B.4–8 Návod k použití pro uživatele systému syngo
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Pacient nebyl nalezen B.4 Jestliže výsledný seznam jméno požadovaného pacienta 
neobsahuje nebo jestliže nebyl nalezen žádný pacient, mùže to 
být zpùsobeno tím, že jste nesprávnì zadali jméno èi èíslo 
pacienta nebo že jsou údaje pacienta uloženy v databázi, kterou 
jste neprohledávali. B.4

B.4 ✧ Neobsahuje-li zobrazený seznam výsledkù hledání jméno 
požadovaného pacienta, klepnìte na tlaèítko Cancel.

Okno Patient Registration se zavøe a zobrazí se znovu karta 
úloh Patient Registration. B.4

✧ Opakujte hledání se zmìnìným zadáním nebo hledání 
rozšiøte na další databáze.

➭ V oknì Registration Configuration mùžete urèit, v kterých 
databázích má vyhledávání probíhat. 
→ Strana B.5–5, Konfigurace funkce Patient Search
Verze VE31D B.4–9 
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Hledání v prohlížeèi Patient 
Browser B.4

Pro vyhledání pacienta v plánu termínù, v lokální databázi a v 
archivu mùžete používat také Patient Browser. Údaje pak 
mùžete pøesunout do okna Patient Registration. Hledání 
mùžete zjednodušit filtrováním a tøídìním údajù o pacientovi. 
→ Strana C.2–6, Procházení údajù o pacientovi a jejich výbìr 
→ Strana C.2–43, Zobrazení dalších informací o pacientovi B.4

✧ Nejprve si zvolte databázi, z níž chcete údaje o pacientovi 
pøenést.

✧ Vyhledejte a vyberte pacienta v navigaèní nebo obsahové 
oblasti prohlížeèe Patient Browser.

Nebo B.4

✧ Vyberte jednu èi více studií pacienta, které chcete provést 
nebo zopakovat. 

Nebo B.4

✧ Vyberte série pacienta, které chcete provést nebo opakovat. 
 

B.4–10 Návod k použití pro uživatele systému syngo
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Registrace pacienta Registrace známého pacienta
Pøenos dat k registraci B.4

B.4 ✧ Otevøete okno Patient Registration pomocí funkce Patient 
> Register.... 

Nebo B.4

B.4 ✧ Klepnìte na tlaèítko s ikonou na panelu nástrojù.

Nebo B.4

✧ Pøetáhnìte vybrané údaje do okna Patient Registration 
(funkce pøetažení). 
 

Pøímá registrace pacienta B.4 Pøedem zaregistrovaného pacienta lze také zaregistrovat k 
vyšetøení pøímo, pokud byly zadány všechny údaje potøebné pro 
dané vyšetøení. B.4

✧ Dvojitì kliknìte na pacienta, požadovaný postup (RP) nebo 
plánované kroky postupu (SPS) v plánovaèi.

➭ Pokud nìjaká povinná informace z pracovního seznamu 
chybí, automaticky se zobrazí dialog Patient Registration s 
následujícím hlášením na stavovém øádku: „Study 
information missing. Inconsistencies with RIS possible."

➭ Jednotlivé fáze rùzných postupù mùžete vybrat stisknutím 
tlaèítka Ctrl nebo Shift.

Jestliže dvojitì kliknete na pacienta, pacient se zaregistruje se 
všemi RP a SPS; jestliže dvojitì kliknete na RP, zaregistruje se 
vybraný RP vèetnì všech jeho SPS. B.4

Data budou pøenesena pøímo na kartu vyšetøení. 
B.4
Verze VE31D B.4–11 
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Registrace známého pacienta Registrace pacienta
Po zadání všech dat potøebných k registraci se v závislosti na 
konfiguraci objeví okno Registration Confirmation, v nìmž 
musíte potvrdit jméno pacienta, datum narození a podobnì. B.4

 

B.4 ✧ Pokud jsou všechny údaje v poøádku, klepnìte na tlaèítko 
Confirm.

Okno Patient Registration se zavøe a zobrazí se karta 
vyšetøení. B.4

Nebo

B.4 ✧ Klepnìte na položku Register, pokud chcete údaje o 
pacientovi zmìnit.

Objeví se okno Patient Registration, v nìmž mùžete provést 
jakékoli potøebné zmìny. 
→ Strana B.4–13, Dokonèení záznamù B.4

➭ Jestliže nejsou vyplnìna všechna pole potøebná pro registraci, 
otevøe se automaticky okno Patient Registration. 

✧ Klepnutím na tlaèítko Cancel zavøete automaticky okno 
Registration Confirmation bez zaregistrování pacienta.
B.4–12 Návod k použití pro uživatele systému syngo
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Dokonèení záznamù B.4

Po pøenesení údajù pacienta, které jste vyhledali, do okna 
Patient Registration pøekontrolujte jejich správnost a pøípadnì 
pøed registrací pacienta doplòte chybìjící údaje.  
→ Strana B.3–15, Zadávání údajù o pøíjmu pacienta  
→ Strana B.3–17, Zadávání údajù o vyšetøení 
→ Strana B.3–23, Zadejte údaje o instituci 

B.4

➭ V závislosti na konfiguraci systému se mùže stát, že data HIS/
RIS bude možné opravit jen èásteènì.

Registrace B.4

B.4 ✧ Chcete-li pacienta následnì vyšetøit, klepnìte na položku 
Exam.

Pacient bude zaregistrován k vyšetøení. B.4

Údaje vyšetøení budou pøeneseny na kartu úlohy Examination
a vy budete moci zaèít s vyšetøením. 

B.4

Nebo B.4

Pøedbìžná registrace B.4

B.4 ✧ Klepnutím na položku Preregister pacienta pøedbìžnì 
zaregistrujte.
Verze VE31D B.4–13 
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Opravené 
údaje pacienta B.4

Jestliže jste naèetli pacienta z místní databáze nebo jiné 
pøipojené databáze nebo místnì pøipojené jednotky do dialogu 
Patient Registration a zmìnili jste identifikaèní atributy 
pacienta (pøíjmení, identifikaèní èíslo pacienta, datum narození 
a pohlaví pacienta), bude v plánovaèi a místní databázi vytvoøen 
nový pacient, jakmile stisknete Preregister nebo Exam. V tom 
pøípadì vám bude pøipomenuto, abyste opravili údaje pacienta 
také v pùvodní databázi následujícím oknem hlášení. B.4

 

➭ Nezapomeòte pozdìji opravit také údaje o pacientovi v 
pùvodním záznamu. 
→ Strana C.4–2, Oprava údajù pacienta nebo dat z vyšetøení
B.4–14 Návod k použití pro uživatele systému syngo
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Hledání a registrace v systému HIS/
RIS B.4

Jestliže nemùžete urèitého pacienta v databázi najít, pøestože 
jeho údaje již byly zadány do systému HIS/RIS, mùžete prohledat 
celý systém HIS/RIS pomocí dotazu na pracovní seznam. B.4

Pokud to umožòuje konfigurace, lze tuto metodu použít i pro 
pøístup k údajùm o pacientovi urèeným pro jiná pracovištì a 
modality. 

B.4
Verze VE31D B.4–15 
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Provedení dotazu na pracovní seznam 
pacientù B.4

Dotaz na pracovní seznam pacientù umožòuje hledat údaje o 
pacientovi v celém systému HIS/RIS. Hledání se provádí na 
základì následujících záznamù: B.4

❏ jméno a pøíjmení, titul,

❏ identifikaèní èíslo pacienta,

❏ ošetøující lékaø,

❏ pokoj,

❏ pøístupové èíslo,

❏ identifikaèní èíslo požadavku,

❏ naplánovaný vyšetøující lékaø,

❏ poèáteèní a koneèné datum.

➭ Jelikož prázdná pole fungují jako zástupné znaky, mìli byste 
aspoò jedno pole vyplnit, aby byly výsledky dotazu 
pøehlednìjší.  
Informace o „zástupných znacích" pro vyhledávání pacienta 
viz  
→ Strana B.4–5, Zástupné znaky pro jméno a identifikaèní 
èíslo pacienta.

➭ Automaticky zadané èíslo pacienta nelze pøi hledání použít.
B.4–16 Návod k použití pro uživatele systému syngo
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Zaèátek vyhledávání B.4 ✧ V nabídce prohlížeèe Patient Browser zvolte položku View > 
Patientbased Worklist. 

Zobrazí se dialogové okno Patient Worklist Query. B.4

➭ Formát dialogu závisí na konfiguraci dialogu Patient 
Registration.

✧ Zadejte kritéria vyhledávání. Mùžete také použít zástupné 
znaky. 
→ Strana B.4–5, Zástupné znaky pro jméno a identifikaèní 
èíslo pacienta
Verze VE31D B.4–17 
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B.4 ✧ Klepnìte na položku Get Worklist.

Tlaèítko Get Worklist se zmìní v tlaèítko Abort. B.4

➭ V systému HIS/RIS budou nyní vyhledáni pacienti se zadanými 
údaji. 

Zrušení vyhledávání B.4 Hledání mùžete kdykoli zrušit (napøíklad pøi chybném zadání 
jména). B.4

B.4 ✧ V takovém pøípadì klepnìte na tlaèítko Cancel.

Hledání bude zrušeno, aniž by došlo k pøenosu dat. B.4
B.4–18 Návod k použití pro uživatele systému syngo
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Vyhledávací seznam dotazu na pracovní 
seznam B.4

Data pacientù nalezená v HIS/RIS systému se zobrazí v oknì 
Results of the Patient Based Worklist Query. Vyhledávací 
seznam se zobrazí i v pøípadì, že byl nalezen pouze jeden 
pacient. B.4

 

➭ Všechny nalezené údaje, které se týkají urèitého pacienta, 
budou pøedbìžnì automaticky zaregistrovány pro urèenou 
modalitu v plánovaèi Scheduler.
Verze VE31D B.4–19 
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Pøijetí údajù o pacientovi B.4

✧ Ve vyhledávacím seznamu vyberte pacienta.

B.4 ✧ Kliknìte na tlaèítko OK. 

Nebo B.4

✧ Dvojitì kliknìte na pacientùv záznam. 

➭ Okno Results of Patient Based Worklist Query mùžete zavøít 
tlaèítkem Cancel.

Údaje zvoleného pacienta budou pøeneseny do okna Patient 
Registration. B.4

➭ Pokud  pole v oknì Patient Registration obsahují údaje 
jiného pacienta, budou pøepsány údaji nového pacienta. 

Pacient nebyl nalezen B.4 Pokud jste nenašli pacienta, kterého hledáte, opravte v pøípadì 
potøeby zadání a zahajte vyhledávání znovu. B.4
B.4–20 Návod k použití pro uživatele systému syngo
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B.5

Konfigurace registrace 
pacienta B.5
Registraci pacientù mùžete pružnì pøizpùsobovat individuálním 
požadavkùm postupu pøi vyšetøení. 

B.5

Mùžete zmìnit následující výchozí nastavení: B.5

❏ položky ve výbìrových seznamech okna Patient 
Registration.

❏ výbìr databází, které chcete prohledávat pomocí funkce 
vyhledávání, a dále postup vyhledávání a zobrazení výsledkù;

❏ nastavení pracovního seznamu, pokud jste napojeni na 
systém HIS/RIS. 
 

✧ Vyvolejte okno syngo - Configuration Panel  
(Options > Configuration... v hlavní nabídce).

B.5 ✧ Otevøete konfiguraèní okno pro registraci pacientù. 

➭ V této pøíruèce se v èásti Základy mùžete seznámit s 
postupem pøi otevírání a zavírání konfiguraèních oken, 
ukládání zmìn nebo obnovování pùvodního nastavení 
provedeného dodavatelem. 
→ Kapitola A.4, Konfigurace uživatelského rozhraní

Okno Registration Configuration se zobrazí s kartami Entering 
Data, Searching a HIS/RIS. B.5

➭ Karta HIS/RIS se zobrazí jen v pøípadì, že je váš systém 
oficiálnì napojen na systém HIS/RIS a že vlastníte pøíslušné 
licence.
Verze VE31D B.5–1 
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Definování záznamù ve výbìrovém 
seznamu B.5

Seznamy pro výbìr vytváøíte na kartì se záložkou Entering 
Data. V prùbìhu registrace pacientù potom mùžete tìchto 
záznamù využívat. Tak si pøi zadávání dat ušetøíte èas a vyhnete 
se pøeklepùm. B.5

✧ Klepnutím pøesuòte kartu Entering Data do popøedí.
B.5–2 Návod k použití pro uživatele systému syngo
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Možné výbìrové seznamy B.5

Výbìrové seznamy mùžete mìnit a rozšiøovat u následujících 
vstupních polí, pokud jsou tato pole zobrazena v oknì Patient 
Registration: B.5

❏ doporuèující lékaø
❏ vstupní diagnóza
❏ lékaø, který si vyšetøení vyžádal
❏ pokoj
❏ název instituce
❏ jména vyšetøujících lékaøù
❏ jména obsluhujících pracovníkù 

 

Vytvoøení záznamu B.5

Každý výbìrový seznam mùže obsahovat až 100 záznamù, 
kromì seznamu obsluhujících pracovníkù, který je omezen na 
50 záznamù. B.5

✧ V kolonce Entry zvolte výbìrový seznam, který chcete 
upravit.

B.5 ✧ Zadejte nové položky do vstupního textového pole a opravte 
nebo odstraòte stávající položky.

➭ Ujistìte se, že nejèastìji požadované položky jsou v 
rozevíracím seznamu umístìny co nejvýše.
Verze VE31D B.5–3 
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Výchozí položky B.5

U každého seznamu mùžete urèit, zda mají být nìkteré položky 
do vstupního pole zvoleny pøedem pøi spuštìní registrace 
pacienta, a popøípadì tyto položky definovat. B.5

B.5 ✧ Zvolte jednu z tìchto tøí možností:

❏ No default 
Když vyvoláte registraci pacienta, je vstupní pole prázdné.

❏ Use first element as default 
Když vyvoláte registraci pacienta, první položka z výbìrového 
seznamu již bude ve vstupním poli.

❏ Keep selection from previous (pre-)registration as default 
Když vyvoláte registraci pacienta, bude se ve vstupním poli 
nacházet položka, kterou jste použili pøi poslední 
(pøedbìžné) registraci pacienta. 
B.5–4 Návod k použití pro uživatele systému syngo
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Konfigurace funkce Patient Search B.5

Na kartì se záložkou Searching mùžete definovat, které 
databáze mají být prohledávány pøi hledání pacienta, po kolika 
nalezených položkách se má vyhledávání ukonèit a jaké 
informace má seznam získaný vyhledáváním obsahovat. B.5

✧ Klepnutím pøeneste kartu úlohy Searching do popøedí.
Verze VE31D B.5–5 
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Databáze B.5

Pøi hledání pacienta lze prohledávat následující databáze: 
B.5

❏ Scheduler 
(obsahuje všechny pacienty s pøedbìžnou registrací)

❏ Local database 
(obsahuje všechny pacienty, kteøí byli v minulosti vyšetøováni 
a jejichž data nebyla dosud archivována)

❏ Archive 
(obsahuje všechny pacienty uložené na právì vložených 
datových médiích) 

✧ Zvolte databáze, které chcete pøi hledání pacienta 
prohledávat.

➭ Z hledání nelze vypustit plánovaè. 
 

B.5–6 Návod k použití pro uživatele systému syngo
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Omezení poètu nalezených pacientù B.5

Vyhledávání lze zastavit, jakmile bude vyhledán urèitý poèet 
pacientù. B.5

B.5 ✧ Zadejte poèet nalezených pacientù, pøi jehož dosažení se má 
hledání ukonèit.
Verze VE31D B.5–7 
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Zobrazení vyhledávacího seznamu B.5

Zde mùžete urèit, které položky údajù o nalezeném pacientovi 
se zobrazí v oknì Patient Search a jak bude toto zobrazení 
vypadat. 
Mùžete nastavit, aby se vypisovaly následující informace: B.5

❏ Osobní údaje 
Mùžete definovat, aby se v seznamu získaném vyhledáváním 
vypisovaly nìkteré nebo všechny informace, které jste zadali 
do oblasti PATIENT.

❏ Údaje o pøíjmu 
Informace o doporuèujícím lékaøi a oddìlení z oblasti 
HOSPITAL.

❏ Informace o nemocnièním zaøízení/lékaøské praxi 
Název nemocnice/lékaøské praxe, který jste zadali v oblasti 
INSTITUTION.

❏ Location 
Sí¤ový uzel, kde jsou uložena data pacienta, který se vypisuje 
na seznamu výsledkù vyhledávání.  
 

B.5 ✧ Zadejte sloupec seznamu výsledkù vyhledávání, v nìmž mají 
být dané informace uvedeny. 
 

B.5 ✧ Zadejte šíøku sloupce (poèet znakù). 
 

B.5 ✧ Kliknìte na informace, které si pøejete vypisovat. 
 
 

B.5–8 Návod k použití pro uživatele systému syngo
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Konfigurace systému HIS/RIS B.5

Pokud je váš systém napojen na systém HIS/RIS. (nemocnièní a 
radiologický informaèní systém), mùžete zvolit též kartu HIS/
RIS. B.5
Verze VE31D B.5–9 
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Zobrazení data ukonèení platnosti licence B.5

Používání pracovního seznamu pro správu pacientù je 
podmínìno èasovì omezenou licencí, kterou je nutné 
obnovovat v dostateèném pøedstihu pøed vypršením její 
platnosti. B.5

B.5 ✧ Pokud chcete, aby se toto hlášení objevilo 30 dní pøed 
ukonèením platnosti vašeho oprávnìní pracovat s pracovním 
seznamem, kliknìte na zaškrtávací políèko.

 

B.5–10 Návod k použití pro uživatele systému syngo
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Nastavení èasového rozpìtí B.5

Dotazujete-li se systému HIS/RIS ruènì, mùžete omezit rozsah 
pracovního seznamu stanovením èasového rozpìtí. 
→ Strana B.4–3, Stanovení èasového rozsahu pracovního 
seznamu B.5

B.5 ✧ Vyberte se urèité èasové rozpìtí, budete-li si pøát zúžit 
pracovní seznam napøíklad na záznamy pacientù, kteøí mají 
být vyšetøeni pouze v tomto dni. 

B.5
Verze VE31D B.5–11 
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Nastavení aktualizace pracovního seznamu B.5

Plánovaè mùžete pravidelnì aktualizovat údaji o nových 
pacientech tak, že aktivujete položku nabídky View > Update 
Worklist nebo poklepete na symbol plánovaèe. B.5

Oblast hledání B.5 Systém se vás zpravidla dotáže pouze na ty údaje o pacientech, 
které jsou urèeny pro vaše pracovištì, mùžete si však zobrazit i 
údaje, které jsou urèeny pro jiná pracovištì téže modality v 
systému HIS/RIS. B.5

B.5 ✧ Klepnutím na pole Local Site si vyžádáte všechny údaje 
urèené pro vaše pracovištì.

Nebo B.5

✧ Kliknìte na pole Modality of type CT, pokud je 
konfigurováno.

Systém prozkoumá veškeré údaje o pacientovi vašeho ústavu, 
která jsou urèena pro všechna pracovištì dané modality. 

B.5

Automatická aktualizace B.5 Tento proces se bude spouštìt automaticky v pravidelných 
intervalech, pokud jej aktivujete. B.5

B.5 ✧ Když kliknete na zaškrtávací políèko, váš systém bude 
pravidelnì spouštìt dotaz HIS/RIS. 
→ Strana B.1–2, Dotaz HIS/RIS 
→ Strana C.2–4, Aktualizace plánovaèe 

➭ Jestliže je váš systém vybaven hlavní a satelitní konzolou, mìli 
byste dotaz HIS/RIS spouštìt pouze z jednoho z nich. Tato 
konzola pak musí být pøímo napojena na nemocnièní sí¤.
B.5–12 Návod k použití pro uživatele systému syngo
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Èasové rozpìtí B.5 Dotazujete-li se systému HIS/RIS ruènì, mùžete omezit rozsah 
pracovního seznamu stanovením èasového rozpìtí. 
→ Strana B.4–3, Stanovení èasového rozsahu pracovního 
seznamu B.5

B.5 ✧ Kliknutím na zaškrtávací políèko aktivujte konfiguraci 
èasového rozsahu pro ruèní aktualizaci.
Verze VE31D B.5–13 
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Nastavení dotazu na pacienta v systému RISB.5

Plánovaè mùžete dodateènì aktualizovat novými údaji o 
pacientovi pomocí dotazu na pacienta v oknì Patient 
Registration. B.5

Oblast hledání B.5 Kromì údajù o pacientovi urèených pro vaše pracovištì si 
mùžete také zobrazit údaje, které jsou urèeny pro jiná pracovištì 
se stejnou modalitou v systému HIS/RIS. B.5

B.5 ✧ Klepnutím na pole Whole RIS si vyžádáte všechny údaje 
systému RIS.

Nebo B.5

✧ Klepnutím na pole Local Site si vyžádáte všechny údaje 
urèené pro vaše pracovištì.

Nebo B.5

✧ Kliknìte na pole Modality of type CT, pokud je 
konfigurováno.

Systém prozkoumá veškeré údaje o pacientovi vašeho ústavu, 
která jsou urèena pro všechna pracovištì dané modality. 

B.5

B.5
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C.1

 
Úvod C.1
Prohlížeè Patient Browser usnadòuje správu dat týkajících se 
pacienta a vyšetøení, která jsou uložena v databázích systému.C.1

Pomocí Patient Browser mùžete rychle a jednoduše data 
vyhledávat a poté je zpracovávat v prohlížeèi nebo na kartách 
úloh. 

C.1

Kdy vyhledat data pomocí 
prohlížeèe pacientù C.1

❏ když budete vyšetøovat pacienta, který již byl pomocí vašeho 
systému jednou vyšetøován

❏ když si chcete prohlédnout pacientovy snímky z døívìjších 
vyšetøení a porovnat je se souèasnými výsledky

❏ když chcete ke snímkùm po vyšetøení pøipojit komentáø nebo 
je dále zpracovávat

❏ když chcete opravit nesprávné údaje pacienta uložené v 
systému

❏ když chcete údaje o pacientovi a data vyšetøení uložit nebo je 
prostøednictvím sítì zaslat na jiné místo v nemocnici

❏ když chcete snímky pacienta exponovat na film za úèelem 
vytvoøení zprávy nebo dokumentace

Zabezpeèení – oprávnìní C.1 Je-li zabezpeèení aktivováno, mùžete pracovní stav opravit, 
pøeorganizovat a nastavit pouze v pøípadì, že k tomu jste 
autorizováni.  
Viz pøíruèka Systém zabezpeèení. C.1
Verze VE31D C.1–1 
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Úvod Patient Browser
Databáze a jednotky C.1

V prohlížeèi Patient Browser získáte pøístup k datùm pacienta a 
vyšetøení, která jsou uložena v rùzných databázích vašeho 
systému nebo na externích datových médiích, jako jsou disky 
CD nebo MOD. 
 

C.1

Plánovaè C.1

C.1 Plánovaè obsahuje data všech pøedbìžnì zaregistrovaných 
pacientù. Tato databáze poskytuje pøehled všech pacientù, kteøí 
byli pøedbìžnì zaregistrováni k vyšetøení. Zde mùžete vyhledat 
urèitého pacienta a zaregistrovat jej k vyšetøení. C.1

Plánovaè je možné aktualizovat pomocí údajù ze systému HIS/
RIS, a to buï automaticky, nebo manuálnì, je-li systém 
propojen. C.1

Místní databáze C.1

C.1 Místní databáze je oblast systému, v níž jsou uloženy údaje o 
pacientovi a výsledky souèasných vyšetøení. C.1

➭ Jestliže objem dat v místní databázi narùstá, pøístupová doba 
se prodlužuje a vyšetøování se zpomaluje. Proto je vhodné 
data pravidelnì pøesunovat pomocí Patient Browser z místní 
databáze na archivaèní média. Potom data z místní databáze 
vymažte. 
C.1–2 Návod k použití pro uživatele systému syngo
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Pøipojené jednotky C.1

C.1 K vašemu systému je pøipojena jedna nebo více jednotek MOD, 
pøípadnì jednotek CD. Ikony s názvy jednotek umožòují rychlý 
zpùsob pøístupu k tìmto  archivaèním médiím. Jakmile vyšetøení 
dokonèíte a vyhodnotíte, mìli byste data vyšetøení archivovat a 
poté je z místní databáze odstranit. 

C.1
Verze VE31D C.1–3 
únor 2006
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Úrovnì dat C.1

Údaje týkající se pacienta a vyšetøení jsou v databázích a na 
externích datových médiích hierarchicky uspoøádána. Toto 
uspoøádání vám pomùže najít výsledky vyšetøení rychleji. C.1

➭ Zobrazení úrovní dat závisí na konfiguraci.

(1) Databáze
(2) Pacient
(3) Studie
(4) Série
(5) Pøípady 
C.1–4 Návod k použití pro uživatele systému syngo
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Patient Browser Úvod
➭ V závislosti na databázi se stav práce každého databázového 
záznamu zobrazí jako zkratka. Informace o stavu zpracování 
najdete zde: 
→ Strana C.6–2, Definice stavu práce

Pacient C.1 Data vyšetøení, která se vztahují k rùzným pacientùm, se v 
databázi ukládají podle jmen pacientù. 

C.1

Studie/Procedura C.1 Studie je vyšetøení provádìné za úèelem nalezení odpovìdi na 
konkrétní otázku, zpravidla na základì doporuèení. Studie 
sestává z jedné nebo více sérií. V modulu Scheduler se na této 
úrovni ukládá plánovaná procedura Procedure. 

C.1

Série/Krok procedury C.1 Všechny snímky mìøení nebo operace zpracování snímkù jsou 
uspoøádány do sérií. V modulu Scheduler jsou na této úrovni 
uvedeny kroky postupu (Procedure Steps) týkající se vyšetøení.C.1

➭ Procedure Steps se nezobrazují u pacientù, kteøí jsou 
pøedbìžnì zaregistrováni místnì (tj. na této pracovní stanici). 

Pøípady/Akce C.1

C.1 Na nejnižší úrovni (Instance Level) se ukládají jednotlivé 
snímky (obrázek vlevo) a v závislosti na modalitì sady dat, z 
nichž lze snímky generovat (napøíklad nezpracovaná data, 
obrázek uprostøed), a také tvary vln, 3D objekty a snímky s 
vícenásobným rámcem (obrázek vpravo). Všechny záznamy na 
Instance Level jsou obecnì považovány za obrazy. 
Ve Scheduler najdete jednotlivé Action Items pro daný 
Procedure Step v tomto bodì. C.1

➭ Položky èinností (Action Items) se nezobrazí u pacientù, kteøí 
byli pøedbìžnì zaregistrováni místnì (tj. na této pracovní 
stanici).
Verze VE31D C.1–5 
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Spuštìní Patient Browser C.1

Okno Patient Browser mùžete vyvolat buï z hlavní nabídky 
nebo pomocí klávesnice se symboly.  
 

C.1

Hlavní nabídka C.1

C.1 ✧ Z hlavní nabídky spus¤te Patient Browser výbìrem položky 
Patient > Browser.... 
 
 
 
 
 

Nebo C.1

Klávesnice se symboly C.1

C.1 ✧ Stisknìte klávesu Browser na klávesnici se symboly (Num .).
C.1–6 Návod k použití pro uživatele systému syngo
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Okno Patient Browser C.1

Po spuštìní prohlížeèe Patient Browser se okno Patient 
Browser zobrazí v popøedí. C.1

Okno je rozdìleno na rùzné oblasti zpracování, které umožòují 
pøehledný pøístup k datùm. C.1

(1) Øádek nabídek a panel nástrojù
(2) Navigaèní oblast
(3) Informaèní oblast
(4) Obsahová oblast
(5) Stavový øádek
Verze VE31D C.1–7 
únor 2006

 0.0
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Panel nástrojù C.1 S vybranými daty mùžete pracovat pomocí položek nabídky 
nebo tlaèítek s ikonami na panelu nástrojù. C.1

➭ V oknì Browser Configuration mùžete definovat, která 
tlaèítka má panel nástrojù obsahovat.  
→ Strana C.8–2, Obecná nastavení

➭ Panel nástrojù mùžete skrýt odstranìním zaškrtnutí u položky 
View > Toolbar.  

Navigaèní oblast C.1 V navigaèní oblasti se graficky zobrazí nižší úrovnì dat, která se 
vztahují k vybraným databázím, pacientùm, vyšetøením a 
sériím. C.1

Pomocí myši mùžete zvolit pacienta, studii nebo sérii a pøíslušná 
data upravit nebo pøesunout do jiných aplikací. Pro každý výbìr, 
který se provádí v navigaèní oblasti, se nižší úrovnì dat zobrazují 
v obsahové oblasti. 

C.1

Informaèní oblast C.1 V informaèní oblasti se zobrazují struèné informace o pacientovi 
a vybrané studii. Když je navigaèní oblast skrytá, lze také zjistit, 
která databáze je otevøená a která úroveò dat je zobrazena. 
→ Strana C.1–12, Zobrazení a skrytí èástí okna C.1
C.1–8 Návod k použití pro uživatele systému syngo
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Patient Browser Úvod
Obsahová oblast C.1 V obsahové oblasti najdete seznam studií èi postupù týkajících 
se pacienta, jehož jste vybrali v navigaèní oblasti. Vyberete-li 
nìkterou z nižších úrovní dat, zobrazí se uložené série nebo 
kroky postupu pro urèitou studii a uložené snímky nebo položky 
èinností pro urèitou sérii nebo krok postupu. C.1

➭ To, jaké informace se budou zobrazovat u jednotlivých 
záznamù, mùžete urèit v oknì Browser Configuration
(Konfigurace prohlížeèe).  
→ Strana C.8–2, Obecná nastavení

V obsahové oblasti mùžete také vybrat údaje o pacientovi a 
vyšetøení za úèelem dalšího zpracování. C.1

➭ Mùžete pøepínat mezi zobrazením ve formì seznamu a 
zobrazením ve formì miniatur obrazù. 
→ Strana C.1–13, Zobrazení seznamù a miniatur obrazù 
v obsahové oblasti
Verze VE31D C.1–9 
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Individuální nastavení okna Patient BrowserC.1

Zobrazení okna Patient Browser mùžete mìnit, a tak je 
maximálnì pøizpùsobovat svému stylu práce. Mùžete napøíklad 
nìkteré oblasti zvìtšit, aby se v nich mohlo najednou zobrazit 
více údajù. 

C.1

Zmìna velikosti okna C.1 Okno Patient Browser lze na obrazovce libovolnì zvìtšovat, 
zmenšovat nebo mìnit jeho polohu. 
→ Strana A.2–21, Zmìna velikosti a pøesouvání okna 
 

C.1
C.1–10 Návod k použití pro uživatele systému syngo
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Patient Browser Úvod
Zvìtšování a zmenšování 
navigaèní a obsahové 
oblasti C.1

Výšku navigaèní i obsahové oblasti mùžete upravovat pomocí 
myši. Èím více zvìtšíte navigaèní oblast, tím menší bude 
obsahová oblast a naopak. C.1

C.1 ✧ Posuòte kurzor myši k okraji navigaèní oblasti. 
Kurzor se zmìní na malou svislou dvojitou šipku.

✧ Navigaèní oblast zvìtšíte a obsahovou oblast zmenšíte 
pøetažením ohranièení smìrem dolù.

Nebo C.1

✧ Navigaèní oblast zmenšíte a obsahovou oblast zvìtšíte 
pøetažením ohranièení smìrem nahoru.

➭ Pøi zobrazení miniatur obrazù je možné obsahovou oblast 
zvìtšovat nebo zmenšovat pouze v urèitých krocích, aby 
nedocházelo k neúplnému zobrazení miniatur obrazù. 
→ Strana C.1–13, Zobrazení seznamù a miniatur obrazù 
v obsahové oblasti
Verze VE31D C.1–11 
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Zobrazení a skrytí èástí oknaC.1 Abyste získali více prostoru v oknì Patient Browser, mùžete 
skrýt panel nástrojù, navigaèní oblast nebo informaèní oblast. C.1

C.1 ✧ Chcete-li skrýt nebo zobrazit panel nástrojù, klepnìte na 
položku View > Toolbar.

✧ Chcete-li skrýt nebo zobrazit informaèní oblast, klepnìte na 
položku View > Info Area.

✧ Chcete-li skrýt nebo zobrazit datovou strukturu v navigaèní 
oblasti, klepnìte na položku View > Tree.

Jestliže není zobrazena datová struktura, úroveò dat nastavená 
v konfiguraci se zobrazí v obsahové oblasti. V navigaèní oblasti 
se zobrazí informace o tom, ke které databázi tyto záznamy 
patøí. 
→ Strana C.8–17, Jednotlivé pohledy obsahové oblasti C.1

➭ Pøi pøepnutí na strukturované/jednoduché zobrazení bude 
pøedchozí výbìr zrušen.

➭ Chcete-li pøepínat mezi databázemi v navigaèní oblasti, 
musíte je nejprve zobrazit ve stromové struktuøe.
C.1–12 Návod k použití pro uživatele systému syngo
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Zobrazení seznamù a 
miniatur obrazù v obsahové 
oblasti C.1

Jestliže jste v navigaèní oblasti vybrali studii nebo sérii, zobrazí 
se v obsahové oblasti všechny pøíslušné série a snímky. Pomocí 
nabídky View mùžete pøepínat mezi zobrazením seznamu a 
miniatur snímkù. C.1

C.1 ✧ Po klepnutí na položku View > Image Stamps se série a 
snímky zobrazí v obsahové oblasti ve formì miniatur 
(položka nabídky bude zaškrtnutá) nebo ve formì seznamu 
(položka nabídky nebude zaškrtnutá).

➭ Druh informací, které mají obsahovat položky seznamu a 
miniatur obrazù, mùžete urèit v oknì Browser 
Configuration. 
→ Strana C.8–8, Hierarchické zobrazení v navigaèní a 
obsahové oblasti 
 

Verze VE31D C.1–13 
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Zobrazení a skrytí databází a 
jednotek C.1

Jednotlivé databáze a jednotky mùžete v navigaèní oblasti 
zobrazit nebo skrýt podle toho, zda je potøebujete pro svou 
práci. C.1

✧ Dílèí nabídku otevøete aktivací položky View > Source.

✧ Vyberte databáze a jednotky, které chcete zobrazit v 
navigaèní oblasti ve formì ikon.

➭ Názvy položek dílèích nabídek závisí na konfiguraci systému.
C.1–14 Návod k použití pro uživatele systému syngo
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Pøizpùsobení tabulky v 
obsahové oblasti C.1

Zobrazení údajù o pacientovi a vyšetøení v obsahové oblasti ve 
formì seznamu má podobu tabulky. U každého sloupce mùžete 
zmìnit pøedem nastavenou šíøku. C.1

✧ Kurzorem myši klepnìte na záhlaví tabulky v obsahové 
oblasti.

✧ Chcete-li sloupec rozšíøit, pøetáhnìte jeho pravé ohranièení 
doprava.

 

Verze VE31D C.1–15 
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Miniatury C.1

Je-li funkce View > Image Stamps aktivní, všechny datové 
objekty se zobrazí jako miniatury na úrovni obrazu/dat. C.1

Datové objekty zahrnují série nebo obrázky pacienta a sady dat, 
z nichž lze obrázky generovat (napøíklad nezpracovaná data,
trojrozmìrné objekty), i køivky (napøíklad køivky EKG) a texty. C.1

C.1 Když klepnete myší na miniaturu obrázku, bude objekt zvolen.  
Dvojitým kliknutím myší nebo pøetažením se data naètou na 
kartu úlohy, která se nachází v popøedí øady karet, napøíklad na 
kartu Viewing. 

C.1

Datové objekty C.1 Jedná se o výbìr možných datových objektù. (Rozsah možných 
objektù se s každou verzí softwaru neustále rozšiøuje.) C.1

Symbol C.1 Objekt C.1 Popis C.1

Obraz Snímek je zobrazen zmenšený.

Nezpracovaná 
data

Nezpracovaná data, na nichž je 
založen výpoèet obrázkù, jsou 
zastoupena symboly.

Standardní 
zpráva 
DICOM SR

Parametry vyšetøení a 
komentáøe k nìmu jsou uloženy 
ve zprávì o studie.

Zpráva o 
zvláštních 
aplikacích

Parametry vyšetøení a 
komentáøe k nìmu jsou uloženy 
ve zprávì o studie.

Registraèní 
matrice fúze

Obsahuje souøadnice pro 
srovnání dvou sad obrazových 
dat.
C.1–16 Návod k použití pro uživatele systému syngo
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C.1

Dráha letu Obsahuje trojrozmìrné 
souøadnice dráhy letu, 
vytvoøené a uložené bìhem 
relace virtuální endoskopie.

Trojrozmìrný 
objekt editoru

Sada dat trojrozmìrného 
objektu vytvoøené pomocí 
editoru 3D Object Editor.

Objekt 
radioterapie

Data týkající se objektù 
radioterapie jako jsou StructSets 
nebo Plan

Poškozený 
snímek

Obraz byl znièen, napø. když 
došlo k pøerušení naèítání 
obrazu.

Èerný obraz Èerné obrazy jsou zvláštní 
obrázy obsahující grafiku, 
tabulky, histogramy èi zprávy.

Naèítání obrazu Obraz se právì naèítá.

Grafické 
záznamy s 
èasovým 
prùbìhem

Data køivky, napøíklad køivek EKG 
a jiných fyziologických dat.

Náhled 
miniatur pro 
média

Náhled miniatur není k dispozici

Symbol C.1 Objekt C.1 Popis C.1
Verze VE31D C.1–17 
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C.1–18 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

C.2

Vyhledávání a zobrazování 
údajù o pacientovi C.2
V oknì Patient Browser se zobrazí všechny údaje o pacientovi 
a vyšetøeních, které jsou uloženy v databázích systému a na 
externích archivaèních médiích. C.2

Údaje o pacientech mùžete vyhledávat, abyste mohli pacienta 
znovu vyšetøit nebo abyste mohli jeho obrazy revidovat, uložit 
nebo exponovat na film. C.2

Pøi vyhledávání údajù o pacientovi mùžete v oknì Patient 
Browser procházet jednotlivými úrovnìmi údajù v oknì 
klepnutím myši nebo pomocí klávesnice. C.2

Vyhledávání mùžete urychlit seøazením zobrazených dat 
(napøíklad abecedním seøazením pøíjmení pacientù) nebo 
filtrováním zobrazených dat a zobrazením pouze urèité 
podmnožiny. C.2
Verze VE31D C.2–1 
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Vyhledávání a zobrazování údajù o pacientovi Patient Browser
Zobrazování úrovní informací C.2

Pøi vyhledávání údajù o pacientech a vyšetøení se pohybujete v 
navigaèní oblasti pomocí myši; mùžete také v nabídce View
otevírat nižší úrovnì dat výbìrem položky Open Subtree. 

C.2

Zobrazení stromu dat C.2

C.2 ✧ Kliknutím na ikonu pacientova záznamu v navigaèní oblasti 
okna Patient Browser zobrazíte úrovnì dat tohoto pacienta. 

Pouze první dílèí objekt se zobrazí až na nejnižší úroveò. C.2

V obsahové oblasti se zobrazí seznam všech studií, které jsou u 
daného pacienta k dispozici. C.2

✧ Klepnutím na jméno jiného pacienta skryjete stromovou 
strukturu dat prvního pacienta a zobrazíte místo nìj úrovnì 
informací týkajících se druhého pacienta.
C.2–2 Návod k použití pro uživatele systému syngo
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Patient Browser Vyhledávání a zobrazování údajù o pacientovi
Otevøení stromové struktury 
dat C.2

C.2 ✧ V navigaèní oblasti vyberte záznam. 
 

✧ Zvolením položky nabídky View > Open Subtree zobrazíte 
všechny záznamy s nižšími úrovnìmi dat (otevøete celou 
stromovou strukturu dat).

Nebo C.2

C.2 ✧ Na panelu nástrojù kliknìte na toto tlaèítko. 
 

Nebo C.2

C.2 ✧ Pravým tlaèítkem myši (nebo klávesovou zkratkou 
Shift + F10) otevøete místní nabídku a kliknìte na položku 
Open Subtree. 

➭ Funkce Open Subtree je zvláš¤ užiteèná v pøípadì, že jste 
vybrali nìkolik pacientù najednou.

➭ Když vyberete ikonu databáze nebo jednotky, zùstanou 
položka nabídky Open Subtree a tlaèítko neaktivní. Na této 
úrovni není možné strom datových složek otevøít. 
 

Zavøení dílèí stromové 
struktury C.2

✧ Zvolením položky View > Close Subtree v hlavní nabídce 
nebo položky Close Subtree v místní nabídce nižší úrovnì 
informací znovu zavøete.
Verze VE31D C.2–3 
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Vyhledávání a zobrazování údajù o pacientovi Patient Browser
Aktualizace plánovaèe C.2 Pokud je váš systém pøipojen k systému HIS/RIS, je plánovaè v 
pravidelných intervalech (v závislosti na konfiguraci systému) 
automaticky aktualizován informacemi z registrace. Tuto 
aktualizaci mùžete spustit také manuálnì. Tak budete mít 
jistotu, že pracujete s nejnovìjšími daty. C.2

✧ Zvolením položky View > Update Worklist proveïte 
aktualizaci plánovaèe.

Nebo C.2

C.2 ✧ Dvojitým kliknutím na pøíslušnou ikonu plánovaè 
zaktualizujte a následnì otevøete.

➭ V závislosti na konfiguraci se zobrazí okno Worklist Time 
Range, v nìmž mùžete omezit èasový rámec svého dotazu. 
→ Strana B.4–3, Stanovení èasového rozsahu pracovního 
seznamu

V oknì Patient Browser se nyní zobrazí jména všech pacientù, 
kteøí jsou ve vašem systému pøedbìžnì registrováni k vyšetøení. 
 

C.2

Vymazání plánovaèe C.2 Data z plánovaèe mùžete odstranit. C.2

✧ V nabídce prohlížeèe Patient Browser otevøete položku Edit 
> Clear Scheduler.... 
→ Strana C.6–16, Clear Scheduler
C.2–4 Návod k použití pro uživatele systému syngo
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Aktualizace zobrazení 
databází C.2

Zmìny a doplnìní záznamù v databázi, které provedete na své 
pracovní stanici nebo které jsou provedeny prostøednictvím sítì, 
se zobrazují v oknì Patient Browser (Prohlížeè dat) 
automaticky. Pokud je automatický proces opoždìn, mùžete 
tuto aktualizaci zahájit i ruènì. C.2

✧ Zvolením položky View > Refresh aktualizujte zobrazení v 
navigaèní a obsahové oblasti.

Nebo C.2

C.2 ✧ Kliknìte na toto tlaèítko. 
 

C.2
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Procházení údajù o pacientovi a 
jejich výbìr C.2

Data vyšetøení pacienta mùžete v databázích vyhledávat za 
úèelem jejich dalšího zpracování. C.2

Po prvním otevøení okna Patient Browser se otevøe místní 
databáze. Seznam všech pacientù, kteøí v ní jsou uloženi, se 
zobrazí v navigaèní a obsahové oblasti. C.2

V navigaèní oblasti se zobrazí úrovnì dat prvního pacienta. C.2
C.2–6 Návod k použití pro uživatele systému syngo
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Nyní v navigaèní oblasti vyberte databázi a vyhledejte 
požadovaného pacienta. Poté otvírejte nižší úrovnì informací, 
dokud nenajdete hledaná data pøíslušného pacienta. C.2
Verze VE31D C.2–7 
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Režim seznamu C.2 Pokud je v navigaèní oblasti vybrána série s velkým množstvím 
obrazù, všechny atributy se zobrazí ve viditelné èásti obsahové 
oblasti. Pro zbývající obrazy jsou viditelná pouze aktuální kritéria 
tøídìní. C.2

Pokud procházíte obsahovou oblastí, zobrazí se zbývající 
atributy. Jetliže budete procházet rychle, zobrazí se pouze 
aktuální kritéria tøídìní. Zbývající atributy jsou prázdné. Když se 
zastavíte na urèité stránce, tj. když zpomalíte procházení, 
zobrazí se atributy obrazù ve viditelné oblasti. C.2

Režim miniatur C.2 V režimu miniatur se zobrazí miniatury pouze pro viditelné 
obrazy. Jestliže miniatury nebyly vyhledány, pro každou 
miniaturu se zobrazí výchozí miniatura. C.2

➭ I když nejsou pro nìkteré obrazy k dispozici podrobné 
informace, všechny operace, jako je mazání, naètení do 
prohlížeèe, export, jsou možné.

➭ Zapnutí náhledu miniatur mùže zpomalit naèítání média s 
velkým poètem obrazù.
C.2–8 Návod k použití pro uživatele systému syngo
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Pokud chcete napøíklad vybrat urèité snímky pacienta ke 
zpracování, mùžete postupnì otevírat úrovnì informací 
pacient, studie a série, dokud nebudou požadované snímky 
uvedeny nebo zobrazeny (jako miniatury) v obsahové oblasti. C.2

C.2 ✧ V navigaèní oblasti klepnìte na ikonu databáze, v níž je 
pacient uložen.

✧ V pøípadì potøeby procházejte seznamem pacientù pomocí 
posuvníku, dokud nenajdete požadovaného pacienta.

➭ Hledaného pacienta najdete ještì rychleji, pokud na 
klávesnici stisknete klávesu s prvním písmenem pacientova 
jména. Pak se zobrazí záznam prvního pacienta, jehož jméno 
zaèíná poèáteèním písmenem. 

C.2 ✧ Klepnutím na jméno hledaného pacienta v navigaèní oblasti 
zobrazíte úrovnì informací, které jsou u tohoto pacienta 
uloženy jako ikony. Všechny studie tohoto pacienta se 
zobrazí v obsahové oblasti.

C.2 ✧ Kliknutím na studii v navigaèní oblasti ji vyberete a zobrazíte 
všechny pøidružené série. 

C.2 ✧ Kliknutím na sérii v navigaèní oblasti tuto sérii vyberete a v 
obsahové oblasti zobrazíte pøehled všech obrazù v ní 
obsažených. 

C.2 ✧ Klepnutím na snímek v obsahové oblasti jej vyberete.
Verze VE31D C.2–9 
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C.2 ➭ Podle toho, zda jste kliknuli na položku View > Image 
Stamps, se série a obrazy v obsahové oblasti zobrazí jako 
miniatury nebo ve formì seznamu. 
→ Strana C.1–10, Individuální nastavení okna Patient 
Browser 
 

Výbìr dat pomocí klávesniceC.2 Pomocí klávesnice se mùžete velmi rychle pøesouvat k rùzným 
datovým záznamùm v oknì Patient Browser. Pøiøazení kláves 
pro možnosti výbìru v aktivní oblasti (navigaèní nebo 
obsahové) je shrnuto v následující tabulce. C.2

C.2

➭ Pokud souèasnì stisknete klávesu Ctrl, záznam nebude 
vybrán. Pokud ho budete chtít vybrat, stisknìte mezerník. 

Klávesa Výbìr Klávesa Výbìr

Home 
(Domù)

První záznam End (Konec) Poslední 
záznam

Page up 
(Strana 
nahoru)

První viditelný 
záznam

Page down 
(Strana dolù)

Poslední 
viditelný 
záznam

↑ Posun o jeden
øádek nahoru 
(tatáž úroveò)

Posun o jeden
øádek dolù 

(tatáž úroveò)

← Záznam vlevo 
(o úroveò výš 
v navigaèní 

oblasti)

Záznam 
vpravo (o 

úroveò níž v 
navigaèní 
oblasti)

Tab 
nebo

Shift + Tab

Pøepnutí mezi 
navigaèní a 
obsahovou 

oblastí

Písmeno První záznam 
zaèínající 

odpovídajícím 
písmenem
C.2–10 Návod k použití pro uživatele systému syngo
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Vícenásobný výbìr C.2 Mùžete také vybrat nìkolik pacientù najednou, napøíklad pokud 
chcete uložit jejich data, nebo mùžete vybrat nìkolik obrazù 
jednoho pacienta, abyste je mohli revidovat. C.2

✧ Požadované záznamy pacientù nebo data vyšetøení oznaète v 
navigaèní nebo obsahové oblasti myší a podržením klávesy 
Ctrl. 
→ Strana A.2–14, Výbìr nìkolika objektù

Nebo C.2

✧ Vyberte první požadovaný záznam v navigaèní nebo 
obsahové oblasti. Podržte klávesu Shift a rozšiøte výbìr 
pomocí klávesnice. 
→ Strana C.2–10, Výbìr dat pomocí klávesnice

➭ Snímky se pøesunou na kartu úloh ve stejném poøadí, ve 
kterém byly vybrány.

➭ V obsahové oblasti se zobrazí pouze pøípady první vybrané 
série.

➭ Vícenásobný výbìr je možný pouze na jedné úrovni dat ve 
stromové struktuøe. Vybraná data musejí patøit ke stejnému 
záznamu na další nejvyšší úrovni dat (napøíklad nìkolik sérií 
jedné studie, ale ne nìkolik sérií rùzných studií).
Verze VE31D C.2–11 
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Filtrování dat C.2

Pokud je objekt dat v navigaèní a obsahové oblasti velmi 
obsáhlý, mùžete vyhledávání údajù o pacientovi zjednodušit 
filtrováním dat. Tak mùžete zobrazit jen urèitý výbìr pacientù, 
studií, sérií èi snímkù. Specifikovat lze maximálnì 20 uživatelsky 
definovaných filtrù. 
 

C.2

Použití standardních filtrù C.2

Pøi filtrování dat mùžete použít kritéria filtrování standardnì 
nabízená vaším systémem. Tato kritéria jsou dostupná z øádku 
nabídek nebo pomocí tlaèítek na panelu nástrojù. C.2

➭ Standardní filtry mùžete na øádek nabídek nebo nástrojù 
pøidávat nebo je z nich odstraòovat v oknì Browser 
Configuration. 
→ Strana C.1–8, Panel nástrojù

Nabídka Filter C.2

C.2 ✧ V nabídce Filter okna Patient Browser vyberte jedno z 
kritérií filtrování.

Tyto výchozí filtry vyhodnocují stav nebo oznaèení dat na všech 
datových úrovních. 
→ Strana C.6–2, Definice stavu práce 
→ Strana C.6–6, Oznaèení dat z vyšetøení C.2
C.2–12 Návod k použití pro uživatele systému syngo
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Nebo C.2

Filtry na panelu nástrojù C.2

✧ Zvolte standardní filtr pomocí panelu nástrojù.

➭ V oknì Browser Configuration (Options > Configure 
Browser...) mùžete nakonfigurovat obsah panelu nástrojù. 
→ Strana C.8–3, Panel nástrojù

Tato data se nyní zobrazí podle vybraných kritérií filtrování: C.2

C.2 Filter Not Archived  
Zobrazí se pouze data, která dosud nebyla archivována. 

C.2

C.2 Filter Not Printed  
Zobrazí se pouze data, která dosud nebyla vytištìna. 

C.2

C.2 Filter Not Sent 
Zobrazí se pouze data, která ještì nebyla odeslána do sítì. C.2

C.2

C.2 Filter Not Marked 
Zobrazí se pouze data, která nejsou oznaèena. 

C.2

C.2 Filter Marked 
Zobrazí se jen oznaèená data. 

C.2
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Deaktivace filtru C.2 Filtr zùstává aktivní, dokud jej nenahradíte jiným filtrem. C.2

C.2 Na stavovém øádku se zobrazí informace o tom, který filtr se 
právì používá. C.2

➭ Pokud okno Patient Browser zavøete a poté znovu otevøete, 
bude naposledy vybraný filtr stále aktivní. 

C.2 ✧ Zvolením položky Filter > Off nebo kliknutím na tlaèítko s 
pøíslušnou ikonou znovu zobrazíte data (nefiltrovaná). 
 
 

Vytvoøení filtru definovaného uživatelem C.2

V oknì Patient Browser mùžete také vytvoøit vlastní kritéria 
filtrování a filtrovat databázi na základì kombinace cílových 
položek. C.2

Pokud zvolíte obecnìjší definici filtrù, budete je moci èastìji 
používat k rychlému a bezproblémovému zobrazení urèité dílèí 
skupiny dat. C.2

Pokud nadefinujete velmi specifické filtry, budete moci 
vyhledávat údaje o pacientovi a data vyšetøení pøímo a s 
úsporou èasu. C.2
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Vytvoøení filtru C.2 ✧ Zvolte položku Options > Filter Settings....

Zobrazí se dialogové okno Filter Specification se vstupními poli 
pro název filtru a pìt kritérií filtrování. C.2

 

✧ Do pole Filter Name zadejte vhodný název filtru, pod kterým 
bude váš filtr uveden.
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C.2 ✧ Vyberte jedno z kritérií filtrování uvedených ve výbìrovém 
seznamu. 

Podle zvoleného kritéria se zobrazí vstupní pole kombinovaná s 
operátory and, or nebo From ... to, nebo kritérium nebude mít 
žádné dodateèné vstupní pole. 
 
 

C.2

 

✧ Zadejte cílové položky do vstupních polí kombinovaných s 
operátorem „or", z nichž alespoò jedno musí být vyplnìno. 

✧ Zadejte cílové položky do vstupních polí kombinovaných s 
operátorem „and". Zde musejí být vyplnìna všechna pole. 

✧ Do vstupních polí kombinovaných s operátorem „From - to" 
zadejte rozsah, v nìmž musejí být hledaná data obsažena.
C.2–16 Návod k použití pro uživatele systému syngo
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Pøíklad filtru definovaného 
uživatelem C.2

Následující filtr definovaný uživatelem byl vytvoøen pro 
vyhledání urèité série vyšetøení hrudníku v databázi. C.2

 

Na základì tohoto filtru budou vybrány pouze oznaèené série, 
které již byly dokonèeny, nafilmovány a archivovány a které byly 
vytvoøeny s polohou øezu mezi 0 a 100. C.2
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Uložení filtru C.2

C.2 ✧ Filtr uložíte klepnutím na tlaèítko OK. Poté se znovu zobrazí 
okno Patient Browser.

Nebo C.2

C.2 ✧ Kliknutím na tlaèítko Cancel se vrátíte do okna Patient 
Browser bez uložení nového filtru. 
 
 

Použití filtrù definovaných 
uživatelem C.2

Filtry definované uživatelem jsou umístìny v nabídce Filter jako 
dodateèné položky nabídky. C.2

C.2 ✧ Mùžete napøíklad zvolit položku Filter > Thorax-Series-
Marked a pøefiltrovat všechna data podle zadaných kritérií.
C.2–18 Návod k použití pro uživatele systému syngo
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Odstraòování uživatelských 
filtrù C.2

Když už nìkterý filtr definovaný uživatelem nepotøebujete, 
mùžete ho z nabídky Filter odstranit, aby tato nabídka zùstávala 
pøehledná. C.2

✧ Vyvolejte dialogové okno Filter Specification a v seznamu 
vedle názvu Filter Name vyberte filtr, který si pøejete 
vymazat.

 

C.2 ✧ Kliknutím na tlaèítko Delete odstraníte filtr ze seznamu. 

✧ V pøípadì potøeby vyberte z výbìrového seznamu další filtry 
a odstraòte je stejným zpùsobem.

C.2 ✧ Poté klepnutím na tlaèítko OK odstranìní filtru potvrïte. 

Zobrazí se znovu okno Patient Browser. C.2

Nebo C.2

C.2 ✧ Klepnutím na tlaèítko Cancel zachováte všechny filtry v 
nezmìnìné podobì.
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Seøezení dat C.2

Data zobrazená v oknì Patient Browser (Prohlížeè dat) mùžete 
seøadit podle rùzných kritérií. To vám umožní seøadit data v 
urèitém sledu a usnadní nalézt urèité údaje o pacientovi nebo 
vyšetøení. C.2

✧ V navigaèní oblasti zvolte úroveò údajù, abyste mohli 
zobrazit pacienty, studie, série nebo snímky, které chcete 
seøadit, v obsahové oblasti.

➭ V oknì Scheduler mùžete data seøadit pouze podle jména 
pacienta (i v opaèném poøadí).

Nabídka Sort C.2

C.2 ✧ Otevøete nabídku Sort. 

V závislosti na úrovni dat zobrazené v obsahové oblasti budete 
mít k dispozici rùzná kritéria tøídìní. C.2

✧ Klepnìte na jedno z uvedených kritérií.

V závislosti na zvoleném kritériu se data v obsahové oblasti 
seøadí podle abecedy, chronologicky nebo podle toho, zda bylo 
kritérium øazení splnìno úplnì, èásteènì èi vùbec ne. C.2

✧ Zvolením položky Sort > Reverse Order mùžete poøadí 
obrátit. 

➭ Také v navigaèní oblasti se data seøadí podle stejného kritéria 
jako v obsahové oblasti.
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Pøíklad tøídìní dat C.2 Pøedpokládejme, že chcete dokonèit archivaci dat z vyšetøení 
pacienta. Protože si tento úkol chcete zjednodušit, chcete studie 
pacienta v obsahové oblasti zobrazit v tomto poøadí: 
nearchivováno, èásteènì archivováno, archivováno. C.2

✧ V navigaèní oblasti zvolte pacienta.

✧ Zvolte položku Sort > Work Status > Archived.

 

✧ Zvolte položku Sort > Reverse Order.

V obsahové oblasti se studie zobrazí v tomto poøadí: 
nearchivováno, èásteènì archivováno, úplnì archivováno. C.2

➭ Pokud zvolené poøadí øazení nelze uplatnit, použije se 
automaticky následující výchozí poøadí:

❏ jméno pacienta
❏ popis studie
❏ èíslo série
❏ èíslo pøípadu
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Naètení zprávy C.2

Chcete-li další informace o pacientovi nebo vyšetøení, mùžete 
naèíst data standardní nebo zvlášní zprávy o vyhodnocení 
obrazových dat, napø. parametry a poznámky rùzných aplikací.C.2

✧ Zprávu naètete vyvoláním položky Patient > Load Report.

Nebo C.2

C.2 ✧ Kliknìte na ikonu Load Report na panelu nástrojù.

Nebo C.2

✧ Dvojitì kliknìte na zprávu nebo ji pøetáhnìte.

Je-li aktivováno zobrazení miniatur, zprávy se zobrazí jako 
miniatury v obsahové oblasti.  
→ Strana C.1–16, Datové objekty C.2

➭ Vybrat mùžete pouze jeden pøípad zprávy. 
C.2–22 Návod k použití pro uživatele systému syngo

 0.0



Patient Browser Vyhledávání a zobrazování údajù o pacientovi
C.2 ✧ Kliknutím na miniaturu vyberete Latest Version ve 
standardní (DICOM SR) sérii dokumentu zprávy. 

C.2 ✧ Kliknutím tuto miniaturu vyberete Previous Version ve 
standardní (DICOM SR) sérii dokumentu zprávy. 

C.2 ✧ Kliknutím na tuto miniaturu vyberete zprávu pro zvláštní 
aplikace. 

➭ Série dokumentu se zobrazí jako samostatná ikona v 
obsahové oblasti.

➭ Jestliže série obsahuje více nezávislých pøípadù, zobrazí se 
všechny ikony a pouze ikona Latest Version je odlišitelná od 
ostatních.
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Tisk seznamu dat C.2

Pokud je systém pøipojen k tiskárnì, lze data vyšetøení 
vytisknout ve formì seznamu. Pøi tisku se zobrazí informace 
uvedené v obsahové oblasti. C.2

✧ V obsahové oblasti zobrazte požadované údaje o pacientovi 
a vyšetøení. 
→ Strana C.2–6, Procházení údajù o pacientovi a jejich výbìr

➭ Pokud chcete vytisknout obsahovou oblast, mùžete pracovat 
ve stromové struktuøe i v jednoduchém zobrazení. 
→ Strana C.1–12, Zobrazení a skrytí èástí okna 
 

Zobrazení náhledu pro tisk C.2 ✧ Po zvolení položky Patient > Print Preview se výtisk zobrazí 
v náhledu.

C.2 ✧ Náhled tisku zavøete kliknutím na tlaèítko Close window. 

➭ Jestliže je obsahová oblast v režimu miniatur, zobrazení 
náhledu pro tisk není možný.
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Tisk seznamu C.2 ✧ Chcete-li vytisknout seznam dat v obsahové oblasti, zvolte 
položku Patient > Print List.

U seznamu pacientù je v záhlaví výtisku uveden obsah a datum 
vytvoøení seznamu. U všech dalších úrovní dat se rovnìž 
vytiskne obsah informaèní oblasti. C.2

➭ Tento seznam se vždy vytiskne v anglickém jazyce.

Zmìna nastavení tiskárny C.2 Nastavení tiskárny (napøíklad okraje stránky) mùžete zmìnit v 
dialogovém oknì pro tisk v systému Windows XP. C.2

✧ Zvolte položku Patient > Print... a v zobrazeném dialogovém 
oknì proveïte požadovaná nastavení.

C.2 ✧ Nová nastavení potvrïte klepnutím na tlaèítko OK.
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Naèítání dat z archivaèního média C.2

Pokud je jednotka nainstalovaná a øádnì nakonfigurovaná, 
mùžete údaje o pacientech a vyšetøení, které byly archivovány 
nebo exportovány na datové médium ve formátu DICOM, 
importovat do svého systému (do místní databáze). C.2

➭ V aktuální verzi programu mùžete importovat pouze data ve 
formátu DICOM.

➭ Jednotlivé obrazy ve formátu DICOM  mùžete importovat také 
pomocí systému souborù. 
→ Kapitola F.4, Export a import do/ze systému souborù

C.2 ✧ Klepnutím na ikonu datového média v navigaèní oblasti 
zobrazíte všechna zde uložené údaje o pacientovi.  
 

datová média C.2 Podle nastavení jednotky v systému mùžete data naèítat z 
následujících médií: C.2

❏ MOD (magnetooptický disk) 3,5" a 5,25"

❏ CD nebo CD-R

❏ DVD-R

❏ diskety 3,5".

→ Strana F.2–2, Zálohování na místní datová média C.2
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Zmìna datových médií C.2 ✧ Zvolte položku Transfer > Eject from... a vyberte pøíslušnou 
jednotku ze seznamu, který se poté zobrazí.

C.2 ✧ Vyjmìte datové médium z jednotky a vložte do odpovídající 
jednotky nové médium.

Nebo C.2

✧ Vyvolejte Transfer > Eject Finalized from <drive name> a 
zmìòte médium. 
→ Strana F.2–4, Vkládání a vysouvání médií

➭ U médií MOD, na nìž se data zapisují v jiných systémech, se 
doporuèuje vkládat pouze média s ochranou proti pøepsání.  
 
 

Zobrazení/skrytí zdrojù dat C.2 Pomocí položky View > Source mùžete jednotlivá archivaèní 
média v navigaèní oblasti skrývat nebo zobrazovat. 
→ Strana C.1–14, Zobrazení a skrytí databází a jednotek C.2
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Výbìr dat C.2 Údaje o pacientovi a data vyšetøení z archivaèních médií mùžete 
vyhledávat a vybírat klepnutím na jednotlivé úrovnì dat v 
navigaèní oblasti. C.2

➭ Vyhledávání mùžete urychlit filtrováním, pøípadnì tøídìním 
dat. 
→ Strana C.2–12, Filtrování dat 
→ Strana C.2–20, Seøezení dat 
 
 

Import dat C.2 Údaje o pacientech a data vyšetøení vybraná na archivaèním 
médiu mùžete importovat do místní databáze (a poté je 
napøíklad vyhodnotit, odeslat pøes sí¤ nebo uložit na jiné datové 
médium). C.2

✧ Zvolením položky Transfer > Import importujte vybraná data 
z datového média nebo ze sí¤ového uzlu do místní databáze.

Nebo C.2

C.2 ✧ Kliknìte na tlaèítko s ikonou na panelu nástrojù. 
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Vyhledávání a import dat v síti C.2

Pomocí položek Search a Search Selected mùžete vyhledat 
údaje o pacientovi a data vyšetøení z pracovních stanic a 
dlouhodobých archivù, které pracují s jinými systémy programu 
DICOM nebo staršími syngo verzemi programu, a proto nejsou 
zobrazeny v navigaèní oblasti. C.2

Požadovaná data mùžete pøes sí¤ importovat do místní databáze 
a na své pracovní stanici s nimi pracovat obvyklým zpùsobem 
(napøíklad naèíst je na kartu úlohy Viewing a vyhodnotit je). C.2

➭ Údaje o pacientovi a data vyšetøení mùžete vyhledávat pouze 
v tìch pracovních stanicích, které jsou nastaveny jako sí¤ový 
uzel a podporují funkci Search. 

C.2

C.2

C.2

UPOZORNÌNÍ

Jestliže program syngo prijímá obrazy, zatímco studie nebo 
série UID je již k dispozici v místní databázi, data budou 
pøiøazena k tomuto místnì existujícímu pacientovi. To se stane 
bez ohledu na ètyønásobné informace pacienta o pøijímaných 
obrazech. Zmìny informací pacienta na jiných systémech 
automaticky nezmìní informace pacienta v programu syngo.C.2

Data vyhledaná z PACS nebo jiných uzlù se zdají být 
porušena nebo ztracena, avšak jsou uložena nìkde jinde v 
databázi. C.2

✧ Data budou vždy importována do již místì existujícího 
pacienta. Použijte jiná kritéria ze studie nebo série k 
vyhledání importovaných dat nebo k filtrování dat. 
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Spuštìní standardního 
vyhledávání pacientù C.2

Vyhledávání dat mùžete uskuteèòovat v oknì Patient Search. 
Zde zadáte kritéria vyhledávání, spustíte vyhledávání a vyberete 
data pro import. C.2

✧ V hlavní nabídce zvolte položku Patient > Search.

Nebo C.2

C.2 ✧ Kliknutím na tlaèítko Search na panelu nástrojù okna Patient 
Browser zobrazte okno Patient Search. 
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(1) Vstupní pole pro základní kritéria vyhledávání
(2) Pokroèilá oblast vyhledávání
(3) Oblast vyhledávání zpráv
(4) Informací oblast, seznam podrobných údajù o sérii
(5) Ovládací oblast
(6) Stavový øádek

C.2

(1)

(2)

(3)

(4)

(5)
(6)
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Vyhledávání dat C.2

Pacienty, studie nebo série, které chcete importovat do své 
místní databáze, vyhledáte zadáním podrobných údajù o 
pacientovi, studii nebo sérii do vstupních polí dialogového okna 
Patient Search. C.2

Tato vstupní pole jsou rozdìlena na tøi panely, které lze otevírat 
a zavírat jednotlivì kliknutím na šipku v rohu každého pole pro 
zvìtšení oblasti výsledkù: C.2

❏ Základní vyhledávání (podrobné údaje o pacientovi a 
vyšetøení)

❏ Pokroèilé vyhledávání (podrobné údaje o studii a séri)
❏ Vyhledávání zpráv (podrobné údaje o zprávì)

➭ Obsah zavøených panelù se zobrazí na zbývajícím øádku.

Sí¤ový uzel C.2

C.2 ✧ Vyberte sí¤ový uzel, na kterém jsou umístìna hledaná data. 
 
 

C.2

Podrobné údaje o pacientoviC.2

✧ Zadejte pøíjmení, ID a datum narození hledaného pacienta.

✧ Pokud nechcete pøi vyhledávání brát v úvahu pohlaví 
pacienta, zvolte v rozevíracím seznamu možnost Any.
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➭ Následující znaky jsou nepøípustné: ^ = \

➭ Pokud znáte pouze èást pacientova jména nebo ID, mùžete 
použít také * jako zástupný znak.

✧ V rozevíracím seznamu zvolte pohlaví.

Podrobné údaje o vyšetøeníC.2

✧ Zadejte datum nebo èasové rozmezí studie.

C.2 ➭ Když zvolíte v rozevíracím seznamu nìjakou položku, bude 
automaticky vloženo odpovídající èasové rozmezí studie. 
 
 
 
 

✧ V rozevíracím seznamu zvolte modalitu.

➭ Položky v tomto seznamu lze konfigurovat. 
→ Strana C.2–41, Konfigurace vyhledávání pacienta
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Podrobné údaje o studii C.2 C.2

✧ Zadejte podrobné údaje o studii, nebo je zvolte v rozevíracích 
seznamech.

✧ Zadejte Study ID.

➭ Položky v rozevíracím seznamu pro pole Referring Physician
lze konfigurovat. 
→ Strana B.5–2, Definování záznamù ve výbìrovém seznamu 

Podrobné údaje o sérii C.2

✧ Zadejte podrobné údaje o sérii nebo v rozevíracím seznamu 
zvolte pøíslušnou èást tìla a lékaøe, který èinnost provedl.

➭ Použijete-li pouze podrobné údaje o sérii, mùže se 
vyhledávání prodloužit.

➭ Položky v rozevíracích seznamech lze nakonfigurovat. 
→ Strana C.2–41, Konfigurace vyhledávání pacienta 
→ Strana B.5–2, Definování záznamù ve výbìrovém seznamu
C.2–34 Návod k použití pro uživatele systému syngo
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Podrobné údaje o zprávì C.2

 

✧ Zadejte název dokumentu, vyberte nebo zadejte datum 
obsahu nebo èas obsahu z rozevíracího seznamu.

 

✧ Vyberte stav zprávy, datum ovìøení a zadejte èas ovìøení 
nebo jméno pozorovatele.

➭ Rozevírací seznam pro stav zprávy nabídne platné kombinace 
pøíznakù dokonèení a ovìøení:  
- None 
- Partially completed + unverified 
- Partially completed + verified 
- Completed + unverified 
- Completed + verified.
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Spuštìní vyhledávání C.2 Po zadání podrobných údajù o pacientovi, studii, sérii nebo 
zprávì mùžete spustit vyhledávání. C.2

C.2 ✧ Klepnutím na tlaèítko Search spus¤te vyhledávání.

➭ Tlaèítko Search se zmìní v tlaèítko Stop Search, které mùžete 
kdykoli (napøíklad po nalezení požadovaných dat) použít ke 
zrušení požadavku. 

Výsledek vyhledávání C.2 Všichni nalezení pacienti a všechny nalezené studie se zobrazí v 
informaèní oblasti. C.2

✧ Pokud chcete, aby se zobrazila odpovídající série, klepnìte na 
libovolnou studii.

Série se zobrazí v seznamu podrobných údajù o sérii. C.2

!0

C.2 C.2

Pokud ID pacienta není jedineèné, mohou se zobrazit studie, 
které k pacientovi zvolenému a zobrazenému v informaèní 
oblasti nepatøí. C.2
C.2–36 Návod k použití pro uživatele systému syngo
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Seznam snímkù C.2 Pokud chcete explicitnì importovat urèité objekty, pomocí 
položky Image List mùžete zobrazit seznam objektù série. C.2

C.2 ✧ Výbìr série.

✧ Klepnìte na tlaèítko Image List.

Zobrazí se seznam snímkù. C.2

C.2
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Search selected C.2

Položka Search Selected se používá, když je prohlížeè Patient 
Browser nebo jiná aplikace syngo aktivní a pacient, studie, série 
nebo snímky již byly zvoleny, k vyhledání další studie, série nebo 
objektù, které se vztahují k døíve zvolenému pacientovi. C.2

C.2 ✧ Kliknìte na ikonu Search Selected na panelu nástrojù okna 
Patient Browser.

Nebo C.2

✧ V hlavní nabídce zvolte položku Patient > Search 
Selected....

Zobrazí se dialogové okno Patient Search. Okno je stejné jako 
okno standardního vyhledávání. Na rozdíl od standardního 
vyhledávání nemusíte zadávat jméno, ID, datum narození a 
pohlaví pacienta (Patient Name, Patient ID, Date of Birth a 
Sex). Data budou do odpovídajících vstupních polí zadána 
automaticky. C.2

✧ Zadejte další kritéria vyhledávání: podrobné údaje o 
vyšetøení, studii a sérii.

C.2 ✧ Klepnìte na tlaèítko Search. 

Výsledky se zobrazí v oblasti výsledkù. 
→ Strana C.2–36, Výsledek vyhledávání C.2
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Import dat C.2

Když najdete požadovanou studii, sérii nebo snímky, pøeneste je 
na svou pracovní stanici pro další zpracování. C.2

Zahájení importu dat C.2 ✧ Vyberte jednoho nebo nìkolik pacientù, studií èi sérií z 
informaèní oblasti nebo výstupní oblasti vyhledávání v 
dialogovém oknì Patient Search nebo jeden èi nìkolik 
pøípadù z dialogového okna Image Search Result.

C.2 ✧ Klepnìte na tlaèítko Import.

Nebo C.2

✧ Pokud jste zvolili pouze jednoho pacienta (jednu studii, jednu 
sérii), poklepejte na jméno tohoto pacienta (studie, série).

Vybraná data se zkopírují ze sí¤ového uzlu na vaši pracovní 
stanici a zobrazí se v navigaèní a obsahové oblasti Patient 
Browser. C.2

➭ Pokud zvolené objekty pøekroèí urèitý limit, zobrazí se 
varování.

C.2 ✧ Pokud chcete import zrušit, kliknìte na tlaèítko Stop Import. 

Kontrola pøenosu  
dat C.2

Stejnì jako u odesílání mùžete sledovat procesy vyhledávání. C.2

✧ Otevøete dialogové okno Transfer > Network Job Status.... 
→ Kapitola F.5, Kontrola pøenosu dat 
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Nové spuštìní vyhledávání C.2

C.2 ✧ Pokud chcete všechny položky vymazat, klepnìte na tlaèítko 
Clear, zastavte aktuální vyhledávání a spus¤te nové. 

Budou vymazána všechna vstupní pole, informaèní oblast a 
seznam výsledného výstupu. 

C.2

Zavírání položky Patient 
Search C.2

Existují dvì možnosti, jak zavøít okno Patient Search. C.2

C.2 ✧ Klepnìte na tlaèítko Close.

➭ Pokud jste spustili vyhledávání pacienta, nezruší se. 
Parametry a výsledky vyhledávání se neztratí a budou znovu k 
dispozici pøi dalším otevøení dialogového okna. Probíhá-li 
právì import dat, bude pokraèovat na pozadí.

Nebo C.2

C.2 ✧ Klepnìte na tlaèítko Cancel.

➭ Pokud jste spustili vyhledávání pacienta, dojde k jeho zrušení. 
Probíhá-li právì import dat, bude pokraèovat na pozadí.

C.2 ✧ Aktivováním zaškrtávacího políèka Discard search results 
on close se odstraní všechny zadané atributy vyhledávání a 
zobrazené výsledky vyhledávání.

➭ V pøípadì, že toto zaškrtávací políèko není aktivováno a vy 
kliknete na tlaèítko Close, atributy a výsledky vyhledávání 
budou zachovány.
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Konfigurace vyhledávání pacienta C.2

Uživatelské rozhraní dialogového okna Patient Search mùžete 
pøizpùsobit svému zpùsobu práce. Rozevírací seznamy kritérií 
vyhledávání Modality a Body Parts lze konfigurovat. C.2

✧ Zvolte položku syngo - Configuration Panel aktivací položky 
Options > Configuration... v hlavní nabídce.

C.2 ✧ Dvakrát kliknìte na ikonu Patient Search. 

Zobrazí se okno Patient Search Configuration. C.2
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C.2 ✧ Proveïte nebo zrušte volbu požadovaných položek 
klepnutím na pøíslušné zaškrtávací políèko nebo odstranìním 
zaškrtnutí z pøíslušného políèka.

C.2 ✧ Klepnutím na tlaèítko OK nastavení uložte.

Nebo C.2

C.2 ✧ Klepnutím na tlaèítko Cancel zavøete dialogové okno bez 
uložení nastavení.
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Zobrazení dalších informací o 
pacientovi C.2

Má-li vaše nemocnice intranet, mùžete pomocí webového 
prohlížeèe EPR, pro který aplikace syngo poskytuje rozhraní, 
zobrazovat informace o pacientech z jiných oddìlení vaší 
nemocnice. To se týká dat, která byla zadána do systému HIS 
nebo podobného informaèního systému. C.2

Doplòkové informace o pacientovi (napøíklad o alergiích, jimiž 
trpí, implantátech, pøedbìžných vyšetøeních a podobnì) mohou 
být dùležité pro chystané vyšetøení nebo pro vyhodnocení 
novìjších výsledkù vyšetøení. C.2

K zobrazení dat použijte webový prohlížeè EPR (EPR = Electronic 
Patient Record). C.2

➭ Webový prohlížeè zobrazí EPR vždy pouze pro jednoho
pacienta. Údaje o pacientovi mùžete pomocí webového 
prohlížeèe EPR zobrazovat, ale ne importovat.

➭ Pøi prvním spuštìní webového prohlížeèe EPR se musíte 
pøihlásit (postupujte podle pokynù k použití vašeho 
webového prohlížeèe EPR).

➭ Individuální pøizpùsobení rozhraní aplikace syngo webovému 
prohlížeèi EPR musí provést správce systému.
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Spuštìní webového 
prohlížeèe EPR C.2

Pokud chcete zobrazit elektronickou zprávu urèitého pacienta, 
vyberte pacienta (nebo studii, sérii èi pøípad) v oknì Patient 
Browser nebo na jiné kartì úlohy. C.2

C.2 ✧ K zobrazení webového prohlížeèe EPR zvolte v hlavní nabídce 
položku Patient > Retrieve EPR. 
 
 
 
 
 

Nebo C.2

C.2 ✧ Kliknìte na položku Retrieve EPR na panelu nástrojù. 

Spustí se webový prohlížeè EPR a zobrazí se informace, které 
jsou u zvoleného pacienta k dispozici. 

C.2

➭ Pokud klepnete myší mimo webový prohlížeè EPR, pøesune se 
okno do pozadí.
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Umístìní webového 
prohlížeèe EPR do popøedí C.2

Webový prohlížeè lze opìt spustit s údaji o stejném pacientovi. 
C.2

C.2 ✧ V hlavní nabídce zvolte položku Patient > Show EPR. 
 
 
 
 
 
 

Nebo C.2

C.2 ✧ Kliknìte na položku Show EPR na panelu nástrojù. 

Webový prohlížeè EPR se zobrazí opìt se stejným obsahem. 
 

C.2

Zavírání webového 
prohlížeèe EPR C.2

✧ Zvolením položky File > Close zavøete webový prohlížeè EPR.

Webový prohlížeè EPR se zavøe. C.2
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C.2–46 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

C.3

Pøenos dat do 
jiných aplikací C.3
V oknì Patient Browser jste našli požadované údaje týkající se 
urèitého pacienta a vyšetøení a chcete nyní tato data využít v 
jiné aplikaci. C.3

❏ Chcete pacienta vyšetøit znovu.

❏ Chcete si prohlédnout a zkontrolovat uložené obrazy 
pacienta.

❏ Chcete snímky u zvláštních diagnostických problémù 
zpracovat a vyhodnotit trojrozmìrnì.

❏ Chcete zpracovat data týkající se urèitého pacienta a 
vyšetøení v jiných programech, které jste nastavili.
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Pøenos dat do jiných aplikací Patient Browser
Opìtovná registrace pacienta C.3

Než budete moci znovu vyšetøit pacienta, jehož data jsou 
uložena v místní databázi nebo na jednom z archivaèních médií, 
musíte tohoto pacienta nejdøíve zaregistrovat pro nové 
vyšetøení. 

C.3

C.3 ✧ Klepnìte na požadovaný záznam pacienta v navigaèní nebo 
obsahové oblasti okna Patient Browser.

Nebo C.3

C.3 ✧ Vyberte jednu nebo více studií pacienta, které chcete provést 
nebo zopakovat. 

✧ Aktivujte registraci pacienta pomocí položky Patient > 
Register....

Nebo C.3

C.3 ✧ Kliknìte na tlaèítko s ikonou na panelu nástrojù. 

Nebo C.3

C.3 ✧ Na klávesnici se symboly stisknìte klávesu Patient Register 
(Num 0).

Nebo C.3

✧ Pøetáhnìte vybrané údaje do otevøeného okna Patient 
Registration (funkce drag & drop).

V oknì Patient Registration mùžete data pacienta 
pøekontrolovat a v pøípadì potøeby je opravit. Mùžete pøidávat 
data vyšetøení a registrovat pacienta, kterého pak mùžete hned 
vyšetøit. 
→ Kapitola B.4, Registrace známého pacienta C.3
C.3–2 Návod k použití pro uživatele systému syngo
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Patient Browser Pøenos dat do jiných aplikací
Prohlížení a zpracování snímkù C.3

Pomocí Patient Browser mùžete pøevádìt obrazy jednoho nebo 
více pacientù z místní databáze na kartu úlohy Viewing, 
prohlížet je a upravovat. 

C.3

Podle toho, na které úrovni dat se nacházíte, mùžete na kartu 
Viewing pøevést následující snímkový materiál: C.3

❏ všechny snímky jednoho nebo více pacientù,

❏ všechny snímky jedné nebo více studií,

❏ všechny snímky jedné nebo více sérií,

❏ jeden snímek nebo více než jeden snímek.

K pøevádìní snímkù na kartu úlohy Viewing mùžete použít 
øádek nabídek nebo panel nástrojù. Lze také jednoduše 
poklepat na snímky nebo je pøetáhnout na kartu úlohy Viewing
myší. C.3
Verze VE31D C.3–3 
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Pøenos dat do jiných aplikací Patient Browser
Všechny snímky pacienta, 
studie nebo série C.3

✧ V navigaèní nebo obsahové oblasti prohlížeèe Patient 
Browser vyberte pacienta, studii nebo sérii.

C.3 ✧ Vyberte položku Patient > Load to Viewing nebo klepnìte 
na tlaèítko na panelu nástrojù; oznaèené snímky budou 
pøeneseny na kartu úlohy Viewing.

Nebo C.3

✧ Klepnìte na kartu Viewing v horní sadì karet.

✧ Potom poklepejte na požadovaný datový objekt. Mùžete také 
vybrat data pomocí klávesnice a stisknout klávesu Return.

➭ Pomocí vícenásobného výbìru v navigaèní nebo obsahové 
oblasti pøenesete snímky více než jednoho pacienta, studie 
nebo série na kartu úlohy Viewing.  
→ Strana C.2–11, Vícenásobný výbìr 
 

Jeden nebo více snímkù 
pacienta C.3

✧ Klepnìte na kartu Viewing v horní sadì karet.

✧ Poklepejte na ikonu dat snímku, který chcete pøenést do 
obsahové oblasti prohlížeèe Patient Browser. Mùžete také 
snímek vybrat pomocí klávesnice a stisknout klávesu Return.

Nebo C.3

C.3 ✧ Vyberte více než jeden obraz v obsahové oblasti a pomocí 
položky Patient > Load to Viewing nebo tlaèítka Load na 
panelu nástrojù pøeneste tyto obrazy na kartu Viewing. 
→ Strana C.2–11, Vícenásobný výbìr 
C.3–4 Návod k použití pro uživatele systému syngo
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Patient Browser Pøenos dat do jiných aplikací
Pøetažení C.3 Kromì výše popsaných zpùsobù mùžete pøenášet snímky na 
kartu úlohy Viewing také pøetažením myší. Tímto zpùsobem 
mùžete urèit, ve kterém segmentu se má první z vybraných 
snímkù zobrazit. C.3

✧ Zmenšete a pøípadnì pøesuòte okno Patient Browser, abyste 
vidìli oblast snímku karty úlohy Viewing.

✧ Pøetáhnìte vybrané snímky do požadovaného segmentu na 
kartì úlohy Viewing.
Verze VE31D C.3–5 
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Pøenos dat do jiných aplikací Patient Browser
➭ Jestliže karta úlohy není v popøedí, mùžete snímky pøetáhnout 
také z prohlížeèe Browser na odpovídající záložku. Karta 
úlohy se pøesune do popøedí a snímky se naètou do oblasti 
snímkù.

Uzavøení po naètení C.3

C.3 Pokud jste vybrali nastavení Close after Loading v nabídce 
Options, okno Patient Browser se po pøenosu obrazù zavøe. C.3

✧ Tuto funkci lze aktivovat pomocí položky Options > Close 
after Loading. 

Pokud tato volba není opatøena znakem zatržení, okno Patient 
Browser zùstává v popøedí i poté, co jste naèetli obrazy do karty 
Viewing. Chcete-li obrazy zpracovat, mùžete vždy pøejít ruènì 
na kartu úloh Viewing. C.3

C.3 ✧ Kliknìte na tlaèítko Close v pravém horním rohu okna 
Patient Browser. 

Na kartì úloh Viewing mùžete pøenesené obrazy prohlížet a 
upravovat. 
→Oddíl E C.3
C.3–6 Návod k použití pro uživatele systému syngo
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Patient Browser Pøenos dat do jiných aplikací
Trojrozmìrné zpracování snímkù C.3

Po dokonèení vyšetøení získáte urèitý poèet snímkù, které budou 
uloženy v místní databázi. Dvourozmìrné øezy vhodné série 
mùžete kombinovat a vytvoøit tak trojrozmìrné zobrazení 
požadované oblasti, které mùžete zpracovat a vyhodnotit na 
kartì úlohy 3D. C.3

✧ V navigaèní nebo obsahové oblasti Patient Browser vyberte 
pacienta nebo jednu èi nìkolik pøíslušných studií, sérií èi 
obrazù (alespoò 4). 

C.3 ✧ Kliknìte na ikonu tlaèítka, abyste zahájili zpracování obrazu 
metodou multiplanární rekonstrukce (MPR). 
 

Nebo C.3

C.3 ✧ Kliknìte na ikonu tlaèítka, abyste zahájili zpracování obrazu v 
režimu Side by Side (Fusion). 

Pokud jste vybrali více než jednu vhodnou sérii nebo sérii 
mimoøádnì velkou, zobrazí se dialogové okno 3D Series List. 
Jakmile v nìm urèíte sérii, budete moci provést trojrozmìrné 
zpracování obrazu na kartì úloh 3D. 
→ Kapitola J.2, Pøenos obrazù do 3D C.3

Jestliže jsou souèasnì naèteny dva datové soubory od jednoho 
nebo dvou pacientù stejné modality, použije se režim Compare. 
Na každém monitoru se zobrazí jeden datový soubor. 
Datové soubory jsou ve vzájemném vztahu, tj. jakákoli akce 
provedená na jednom datovém souboru bude provedena 
rovnìž na druhém datovém souboru. 

C.3
Verze VE31D C.3–7 
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Pøenos dat do jiných aplikací Patient Browser
Osobní aplikace C.3

Prostøednictvím hlavní nabídky Private Applications prohlížeèe 
Patient Browser mùžete také využít funkce nebo jiné aplikaèní 
programy syngo systému. C.3

V prohlížeèi Patient Browser mùžete vybrat údaje o pacientovi 
a data vyšetøení a pøenést je do programù, které chcete použít 
pro další zpracování. C.3

➭ V oknì Browser Configuration mùžete urèit, se kterými 
aplikaèními programy chcete ve svém syngo systému 
pracovat. 
→ Strana C.8–20, Konfigurace aplikací definovaných 
uživatelem 
 

Pøenášení dat do jiné 
aplikace C.3

✧ V navigaèní nebo obsahové oblasti prohlížeèe Patient 
Browser vyberte data, která chcete zpracovat.

✧ Otevøete nabídku Private Applications a klepnìte na 
požadovanou položku programu.

Data vybraná v oknì Patient Browser budou naètena do apli-
kaèního programu. 

C.3
C.3–8 Návod k použití pro uživatele systému syngo
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Patient Browser Pøenos dat do jiných aplikací
Zobrazení aplikaèního 
programu C.3

✧ Zvolte položku Private Applications > Switch to.... 

Zobrazí se dialogové okno Show Applications se seznamem 
všech nakonfigurovaných aplikaèních programù. C.3

 

✧ Z tohoto seznamu vyberte program, do nìhož jste pøenesli 
údaje o pacientovi a data vyšetøení.

C.3 ✧ Klepnutím na tlaèítko Show aktivujte daný aplikaèní 
program.

Uživatelské rozhraní programu se pøesune do popøedí. Naètené 
údaje o pacientovi a vyšetøení mùžete zpracovávat pomocí 
funkcí, které jsou na nìm k dispozici. C.3

C.3
Verze VE31D C.3–9 
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Pøenos dat do jiných aplikací Patient Browser
C.3–10 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

C.4

 
Oprava dat C.4
Obèas je údaje o pacientovi zapotøebí opravit nebo doplnit o 
informace o datech studií, sériích a pøípadech. C.4

Napøíklad po vyšetøení naléhavého pøípadu budou data tohoto 
pacienta uložena nejdøíve podle provizorní identifikace. 
Pozdìji k tìmto datùm mùžete pøidat pacientovo jméno a 
pøíjmení, jeho správné ID a všechny ostatní osobní údaje a 
informace o provedeném vyšetøení. C.4

K vyhledání tohoto pacienta v databázi a následnému otevøení 
dialogového okna, v nìmž lze s tìmito daty pracovat, mùžete 
využít prohlížeè Patient Browser. C.4

➭ Data servisního pacienta nelze mìnit. To platí i pro data, která 
byla importována pøes systém HIS / RIS nebo která byla s 
takovým systémem propojena.

➭ To, zda lze data propojená s MPPS mìnit, a zmìny, které v 
nich lze provést, závisí na stavu zpracování. 
→ Kapitola C.7, Sledování postupu pomocí systému MPPS

Historie zmìn C.4 Každá zmìna dat pacienta nebo vyšetøení bude zaznamenána 
do historie zmìn v systému. Seznam oprav je veden pro 
každou objektovou úroveò. Historii zmìn pro urèitý záznam v 
místní databázi si mùžete kdykoli prohlédnout a zjistit, jaké 
zmìny v nìm byly provedeny. C.4
Verze VE31D C.4–1 
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Oprava dat Patient Browser
Oprava údajù pacienta nebo dat z 
vyšetøení C.4

Mùžete opravovat nebo pøidávat osobní údaje pacienta nebo 
informace o pacientových studiích v místní databázi. C.4

Chcete-li zmìnit archivovaná data nebo data z jiné pracovní 
stanice, musíte je nejdøíve importovat do místní databáze. Když 
je použito opravování, vytvoøí se nové pøípady DICOM SOP. 
Pùvodní data však zùstanou beze zmìny. 
→ Strana C.2–26, Naèítání dat z archivaèního média C.4

➭ Je-li aktivováno zabezpeèení, mùžete data opravovat pouze v 
pøípadì, že k tomu jste autorizováni.

✧ V navigaèní nebo obsahové oblasti Patient Browser vyberte 
pacienta, studii, sérii nebo obrazy, které chcete opravit. 

✧ Zvolte položku Edit > Correct.

Nebo C.4

C.4 ✧ Klepnutím na tlaèítko s ikonou na panelu nástrojù otevøete 
dialogové okno Correct.
C.4–2 Návod k použití pro uživatele systému syngo
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Patient Browser Oprava dat
Data, která jsou chránìna pøed odstranìním pomocí položky 
Edit > Protect, opravovat nelze. Nejprve musíte zrušit ochranu 
pøed odstranìním pomocí položky Edit > Remove Protection.C.4

➭ Nelze opravovat ani data, která používají jiné aplikace, nebo 
data, která se právì zpracovávají na jiné konzole. 
Verze VE31D C.4–3 
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Patient Browser Oprava dat
Zvolený pacient C.4 V záhlaví okna Correct se zobrazí, kterého pacienta a která 
data jste vybrali. C.4

Zobrazení obsahu C.4 Na prvním øádku okna záhlaví se zobrazí poèet studií, sérií a 
obrazù vybraných k opravì. 

C.4

Zadávání dat C.4 Ve vstupních a výbìrových polích okna Correct se zobrazí 
doposud uložené informace vybraného pacienta, studie èi 
série. C.4

✧ Vybraná data opravte nebo je rozšiøte.

➭ V závislosti na úrovni dat, na níž chcete data opravit, mohou 
být nìkterá pole dialogového okna neaktivní.

➭ Pøi zadávání velmi dlouhého komentáøe do vstupního pole 
Comment se na kartì úlohy Viewing v závislosti na zvoleném 
rozvržení zobrazí pouze první èást textu. Tøetí ani ètvrtý øádek 
komentáøe se také nezobrazí.

➭ Nejednoznaèné hodnoty jsou zastoupeny hvìzdièkou a nelze 
je zmìnit (kromì úrovnì pøípadù).
Verze VE31D C.4–5 
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Oprava dat Patient Browser
Opravy aktuálního 
vyšetøení C.4

Pokud jste okno Correct otevøeli z karty Examination, mùžete 
zmìny zanést do aktuálního vyšetøení. C.4

C.4 ✧ Zvolte zaškrtávací políèko Update data acquisition. 
 
 
 

Podepsání zmìn C.4

✧ Zadejte své jméno do pole Modifier’s Name nebo je vyberte 
z výbìrového seznamu.

Tak bude pro pozdìjší referenci jasné, kdo zmìny údajù o 
pacientovi a vyšetøení provedl. Pokud vaše jméno ve 
výbìrovém seznamu ještì není, bude nyní do seznamu 
zaøazeno automaticky. C.4

➭ Pokud jméno nezadáte, bude jako jméno upravovatele 
uloženo jméno, pod nímž jste se do systému pøihlásili.

➭ Je-li aktivováno zabezpeèení, zobrazí se v tomto poli vaše 
uživatelské jméno a nebudete moci žádné zmìny provést.
C.4–6 Návod k použití pro uživatele systému syngo
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Patient Browser Oprava dat
Uložení zmìn C.4 C.4

C.4 ✧ Klepnutím na tlaèítko OK nová data uložíte a zaznamenáte 
zmìny do historie zmìn.

Systém nejprve zkontroluje, zda jsou pøeddefinovaná data 
správná a zda zadané datum narození souhlasí s uvedeným 
vìkem. Poté systém zmìnìná data pøijme. C.4

Nebo C.4

C.4 ✧ Klepnutím na tlaèítko Cancel opravy zamítnìte. Data 
zùstanou nezmìnìna a žádná položka nebude zaznamenána 
do historie zmìn. 
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Oprava dat Patient Browser
Jeden pacient je uložen v 
databázi dvakrát C.4

Pacient, jehož jméno bylo pøi vyšetøení nesprávnì zapsáno 
nebo který byl jednou zaregistrován jako naléhavý pøípad, je v 
databázi uložen dvakrát. C.4

Jakmile uložíte opravené jméno pacienta, dialogové okno se 
zeptá, zda chcete slouèit data vyšetøení tìchto dvou pacientù.C.4

C.4 ✧ Kliknutím na tlaèítko OK uložíte všechna vybraná data pod 
opravené jméno pacienta. 

C.4 ✧ Klepnutím na tlaèítko Cancel opravu dat zrušíte.  
Nebudou provedeny žádné zmìny. 
C.4–8 Návod k použití pro uživatele systému syngo
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Patient Browser Oprava dat
Varování C.4 Po vyvolání funkce Correct se provede kontrola dat a vy 
budete upozornìni na následky pokraèování v modifikaci. C.4

Pøíslušná varovná hlášení (až ètyøi) jsou shrnuta v dialogovém 
oknì Confirmation for Warning(s). C.4

Dialogové okno mùže obsahovat následující varování: C.4

❏ Non-local data involved 
❏ Radio Therapy data involved 
❏ Structured Reporting data involved 
❏ Modality Performed Procedure Step involved

C.4 ✧ Kliknutím na tlaèítko Details... se zobrazí podrobnìjší 
dialogové okno pro pøíslušné varování.  

C.4 ✧ Abyste mohli pokraèovat, kliknìte na tlaèítko Yes.

Nebo C.4

C.4 ✧ Kliknutím na tlaèítko Cancel proces zrušte.
Verze VE31D C.4–9 
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Oprava dat Patient Browser
Pøeskupování dat C.4

Snímky pacienta jsou hierarchicky seskupeny podle vyšetøení a 
sérií. Pokud zjistíte, že daná struktura není správná, mùžete 
toto seskupení vyšetøení a sérií pøesouváním zmìnit. C.4

C.4

➭ Pokud pøeskupíte externí data importovaná do místní 
databáze a potom je pøenesete zpìt na pùvodní místo, uloží 
se vedle pùvodních dat. 
→ Strana C.4–9, Varování

➭ Je-li aktivováno zabezpeèení, mùžete data pøeskupovat pouze 
v pøípadì, že k tomu jste autorizováni.

C.4

UPOZORNÌNÍ

Pøeskupení sérií/obrazù do jiných sérií mùže vést k chybným 
obrazovým informacím, pokud nejsou vybrané obrazy/série 
kompatibilní. C.4

Nesprávné obrazové informace mohou být pøíèinou 
nesprávné diagnózy C.4

✧ Opravte atributy, které si neodpovídají, a potom zmìòte 
uspoøádání sérií/obrazù.
C.4–10 Návod k použití pro uživatele systému syngo
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Patient Browser Oprava dat
C.4

C.4

C.4

UPOZORNÌNÍ

Oprava/pøeskupování jen nìkterých objektù s odkazy C.4

Odkazy se mohou ztratit. C.4

✧ Pøi úpravách zmìòte celou hierarchickou skupinu obsahující 
všechny objekty s odkazy, aby odkazy zùstaly zachovány. 
Upraveny budou pouze reference nalezené v rámci výbìru.

C.4

UPOZORNÌNÍ

Jestliže je do opravy nebo pøeskupení zahrnut jakýkoli 
radioterapeutický (RT) objekt, odkazy do a z jiných objektù 
nebudou aktualizovány. Funkce Correct a Rearrange 
kontroluje, jestli nejsou zahrnuty nìjaké radioterapeutické 
objekty, a vyzve k potvrzení. C.4

Odkazy mezi obrazy a radioterapeutickými (RT) objekty 
mohou být ztraceny. C.4

✧ Pro správu odkazù používejte aplikaci nebo aplikace, které 
byly použity k vytváøení radioterapeutických objektù. 
Nejdøíve opravte obrazy (napø. demografii pacienta) a pak 
je použijte v radioterapii
Verze VE31D C.4–11 
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Oprava dat Patient Browser
Omezení C.4 Data servisního pacienta nelze pøeskupovat. Totéž platí o 
datech importovaných prostøednictvím systému HIS/RIS nebo 
o datech, která jsou s takovým systémem propojena. C.4

Seskupovat mùžete pouze data vyšetøení, která byla získána 
stejnou vyšetøovací metodou pøi stejné poloze pacienta. C.4

Data, která již byla otevøena v jiné aplikaci (napøíklad na kartì 
Viewing) nebo která jsou chránìna pøed odstranìním položkou 
Edit > Protect, pøeskupovat nelze. C.4

Mùžete pøeskupovat pouze studie do jiných studií nebo 
záznamù pacienta, série do jiných sérií nebo studií a obrazy do 
jiných sérií. C.4

❏ Mùžete napøíklad pøesouvat snímky z jedné série do jiné série 
nebo všechny snímky jedné série do jiné studie. 

❏ Nemùžete napøíklad pøesunout studii se všemi jejími obrazy 
do jiné série.

 

➭ Pokud chcete pøeskupovat propojené externí objekty, vyberte 
tuto funkci s vícenásobnou volbou, protože jinak budou 
odkazy na nevybrané objekty ztraceny.
C.4–12 Návod k použití pro uživatele systému syngo
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Patient Browser Oprava dat
Funkce Drag & drop 
nebo vyjmutí a vložení C.4

Data mùžete pøeskupovat pomocí myši (drag & drop) nebo 
pomocí nabídky Edit (vyjmutí & vložení). C.4

➭ Pokud data vyjmete a pøetažením pøesunete omylem, 
mùžete tuto operaci kdykoli zrušit pomocí klávesy Esc. 

✧ Vyberte studii nebo studie, série, obrazy nebo jediný obraz, 
který chcete pøeskupit. 

✧ Pøetáhnìte vybraná data do cílového místa a uvolnìte 
tlaèítko myši.

Nebo C.4

C.4 ✧ Zvolte položku Edit > Cut nebo na panelu nástrojù klepnìte 
na tlaèítko s ikonou.

✧ Kliknìte na cílové místo.

C.4 ✧ Zvolte položku Edit > Paste nebo na panelu nástrojù kliknìte 
na tlaèítko s ikonou. 
 

Zobrazí se dialogové okno Rearrange. C.4
Verze VE31D C.4–13 
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Oprava dat Patient Browser
Stejnì jako u oprav údajù o pacientovi a vyšetøení bude i 
pøesunutí dat zaznamenáno do historie zmìn. 
→ Strana C.4–15, Zobrazení historie zmìn C.4

✧ Do dialogového okna Modifier's Name zadejte své jméno 
nebo je vyberte z výbìrového seznamu.

➭ Pokud jméno nezadáte, bude jako jméno upravovatele 
uloženo jméno, pod nímž jste se do systému pøihlásili.

➭ Je-li aktivováno zabezpeèení, zobrazí se v tomto poli vaše 
uživatelské jméno a nebudete moci žádné zmìny provést. 

C.4 ✧ Klepnutím na tlaèítko OK zadání potvrïte. Data budou 
pøeskupena a zmìny zaznamenány do historie zmìn spolu s 
vaším jménem.

Nebo C.4

C.4 ✧ Kliknutím na tlaèítko Cancel pøeskupení zrušte. 

!0

C.4 C.4

Pokud je aktivováno zabezpeèení a jestliže existuje alespoò 
jedna studie, k níž nemáte pøístupová práva, zobrazí se 
následující chybová zpráva „Rearranging/Correcting the 
selected objects is not possible due to security restrictions. 
This operation will be canceled". C.4
C.4–14 Návod k použití pro uživatele systému syngo
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Patient Browser Oprava dat
Zobrazení historie zmìn C.4

Seznam oprav je urèitý druh protokolu místní databáze, který se 
vytváøí samostatnì pro každou úroveò dat. Zde vždy zjistíte, jak 
byla data pacienta zmìnìna nebo doplnìna, a naleznete zde 
informace o jeho vyšetøeních.  

C.4

➭ Je-li aktivováno zabezpeèení, mùžete dialogové okno History
otevøít pouze v pøípadì, že k tomu jste autorizováni.

✧ Vyberte pacienta, studii, sérii nebo snímek uložený v místní 
databázi, u nichž chcete zobrazit historii zmìn.

✧ Zvolením položky Edit > History zobrazíte okno Correct & 
Rearrange History s chronologickým seznamem zmìn.

Nebo C.4

C.4 ✧ Kliknìte na tlaèítko s ikonou na panelu nástrojù. 
 

➭ V oknì Correct & Rearrange History sami provádìt zmìny 
nemùžete. Všechny záznamy zde provádí systém.
Verze VE31D C.4–15 
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Oprava dat Patient Browser
V závislosti na úrovni vybraných dat jsou v oknì Correct & 
Rearrange History uvedeny rùzné informace: C.4

❏ Title 
Zde se vypisuje datový záznam, k nìmuž zaznamenané 
zmìny patøí.

❏ Attribute 
V tomto sloupci naleznete opravené položky.

❏ Original Setting a Corrected Setting 
Tyto dva sloupce ukazují opravený záznam pøed zmìnou a po 
ní. 

❏ Date & Time 
V tomto sloupci tabulky naleznete datum a èas provedení 
zmìny.

❏ Modifier’s Name 
V posledním sloupci tabulky budete moci zjistit, kdo úpravy 
provedl.
C.4–16 Návod k použití pro uživatele systému syngo
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Patient Browser Oprava dat
C.4 ➭ Pokud byl nìkterý objekt pøeskupen, bude položka v oknì 
Correct & Rearrange History ve sloupci Attribute  
oznaèena ">".

➭ Podle toho, kolik úrovní bude pøi zmìnì objektu zmìnìno, lze 
do tabulky vložit až ètyøi øádky textu. 
 

C.4 ✧ Klepnutím na tlaèítko OK zobrazení historie opìt zavøete.
Verze VE31D C.4–17 
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Oprava dat Patient Browser
C.4–18 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

C.5

Ukládání, pøedávání dat 
nebo exponování na film C.5
Pro zálohování dat a snížení objemu dat v místní databázi byste 
mìli údaje o pacientovi i data vyšetøení v pravidelných 
intervalech ukládat. Za úèelem ukládání mùžete svùj systém 
vybavit jednotkou MOD èi záznamovým zaøízením CD, nebo 
systém propojit s centrálním archivem pøes sí¤. C.5

Je-li systém pøipojen k síti, mùžete pøenést data z vyšetøení na 
jinou pracovní stanici. Pokud je systém vybaven pøíslušnou 
jednotkou, mùžete data také exportovat na datová média a tato 
média pak pøedat dále. C.5

Chcete-li snímky zpracovat nebo jinak využít prostøednictvím 
jiných aplikací, exportujte je do systému souborù. C.5

Nakonec mùžete obrazy pomocí funkce Patient Browser
exponovat na film pro vytvoøení dokumentace nebo zpráv. 

C.5

V navigaèní nebo obsahové oblasti okna Patient Browser
vyberte požadované údaje o pacientovi nebo data vyšetøení. 
Poté pomocí pøíslušné položky nabídky nebo panelu nástrojù 
spus¤te ukládání, odesílání nebo exponování na film. C.5

C.5

C.5

C.5

UPOZORNÌNÍ

Pøenos zkreslených neètvercových matic/segmentù obrázkù. C.5

Mùže dojít ke ztrátì oblastí snímkù, které jsou dùležité pro 
stanovení diagnózy. C.5

✧ Pokud jsou zpracované obrazy exportovány nebo odeslány 
do jiné stanice, pøíslušné pùvodní obrazy budou odeslány 
rovnìž. Velmi se doporuèuje založit koneènou diagnózu 
vždy na pùvodních obrazech a nikoli na upravených nebo 
zpracovaných obrazech.
Verze VE31D C.5–1 
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Ukládání, pøedávání dat nebo exponování na film Patient Browser
Ukládání dat C.5

Pomocí funkce Archive To... mùžete ukládat údaje o pacientovi 
a vyšetøení na místní vymìnitelná datová média (MOD = 
magnetooptický disk nebo CD-R = zapisovatelný disk CD) nebo 
prostøednictvím sítì do archivu. 
→ Kapitola F.2, Ukládání dat C.5

➭ Je-li aktivována funkce Security, mùžete data ukládat pouze v 
pøípadì, že jste k tomu oprávnìni.

➭ Pøi ukládání dat na vymìnitelný pamì¤ový disk se pacient a 
studie nejdøíve naètou a zobrazí v oknì Patient Browser. 
Potom se naètou a zobrazí série a pøípady, jakmile bude 
umístìní dokonèeno. Bìhem celého procesu ukládání dat na 
médium se aktuální krok zobrazuje ve stavovém øádku okna 
Patient Browser.

Vkládání MOD nebo CD-R C.5 ✧ Vložte požadované médium do pøíslušné jednotky.

✧ Pokud je to zapotøebí, naformátujte a pøejmenujte nové 
médium MOD v automaticky zobrazeném dialogovém oknì. 
→ Strana F.2–9, Pojmenování média MOD

✧ V navigaèní nebo obsahové oblasti Patient Browser vyberte 
data, která chcete uložit. 

Standardní MOD C.5 ✧ Aktivujte položku Transfer > Archive To MOD.

Nebo C.5

C.5 ✧ Klepnìte na tlaèítko s pøíslušnou ikonou.

Data jsou archivována na výchozí jednotce MOD. 
C.5

C.5 ✧ Po archivaci kliknìte na pøíslušnou ikonu jednotky v 
navigaèní oblasti, èímž se ujistíte, zda se všechna data 
zkopírovala na MOD.
C.5–2 Návod k použití pro uživatele systému syngo

 0.0



Patient Browser Ukládání, pøedávání dat nebo exponování na film
Standardní médium CD-R C.5 ✧ Aktivujte položku Transfer > Archive To CD-R.

Nebo C.5

C.5 ✧ Klepnìte na tlaèítko s ikonou.

 
V závislosti na konfiguraci systému probìhne archivace v 
režimu jedné relace nebo v režimu vícenásobné relace. 
→ Strana F.2–17, Archivace na disk CD-R v režimu jedné relace  
→ Strana F.2–24, Archivace na disk CD-R/DVD-R v režimu 
vícenásobné relace 
 

C.5

Výbìr místa urèení  
(MOD, CD-R nebo archiv) C.5

✧ Aktivujte položku Transfer > Archive To....

Nebo C.5

C.5 ✧ Kliknìte na tlaèítko s ikonou. 

✧ V dialogovém oknì Archive To zvolte požadované místo 
urèení pro archivaci.

C.5 ✧ Kliknutím na tlaèítko Archive proveïte archivaci dat na 
zvolené místo urèení. 
 

Vypalování disku CD-R C.5 Vlastní postup ukládání a zapisování na disk CD-R se buï spouští 
automaticky nebo jej lze spustit ruènì. 
→ Strana F.2–20, Automatické spuštìní zápisu 
→ Strana F.2–21, Ruèní spuštìní zápisu C.5
Verze VE31D C.5–3 
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Ukládání, pøedávání dat nebo exponování na film Patient Browser
Pøedávání dat C.5

Pøenos dat vyšetøení (napø. do jiných pracovních stanic kvùli  
vyhodnocení) je možné jak pøes sí¤ nemocnice, tak datovým 
médiem. 

C.5

Odesílání pøes sí¤ C.5

Pokud je systém pøipojen k síti, mùžete odeslat údaje o 
pacientovi i data vyšetøení na jinou pracovní stanici 
prostøednictvím sítì pomocí funkce Send to.... 
→ Strana F.3–2, Odesílání v síti C.5

✧ V navigaèní nebo obsahové oblasti vyberte pacienta, studii, 
sérii nebo obrazy. 

Standardní adresa C.5

C.5 ✧ Na klávesnici se symboly stisknìte klávesu Send to Node 1. 
 
 

Nebo C.5

✧ Pro odeslání dat na jednu z výchozích adres v síti aktivujte 
položku Transfer > Send to Node 1 nebo Transfer > Send 
to Node 2.

Nebo C.5

C.5 ✧ Na panelu nástrojù kliknìte na jedno ze dvou tlaèítek s 
ikonou. 

Data budou odeslána na zvolenou adresu. C.5
C.5–4 Návod k použití pro uživatele systému syngo
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Patient Browser Ukládání, pøedávání dat nebo exponování na film
Výbìr místa urèení C.5 ✧ Aktivujte položku Transfer > Send to....

Nebo C.5

C.5 ✧ Kliknìte na pøíslušné tlaèítko na panelu nástrojù. 

✧ V dialogovém oknì Send To vyberte požadovanou sí¤ovou 
adresu (adresy).

C.5 ✧ Kliknutím na tlaèítko Send odešlete vybraná data na 
požadovanou adresu (adresy). 
 

Export na datové médium C.5

Nemáte-li k dispozici sí¤ové pøipojení, mùžete data zapsat na 
datové médium (MOD nebo CD-R) pomocí funkce Export to... a 
pøedat je dál. 
→ Strana F.3–5, Export na datové médium C.5

✧ V navigaèní nebo obsahové oblasti vyberte požadovaná data.

✧ Aktivujte položku Transfer > Export to....

✧ V dialogovém oknì Export To vyberte požadované datové 
médium.

C.5 ✧ Kliknutím na tlaèítko Export uložte data na zvolené datové 
médium. 
 

Verze VE31D C.5–5 
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Ukládání, pøedávání dat nebo exponování na film Patient Browser
Export snímkù do systému souborùC.5

Chcete-li obrazy zpracovat v jiných programech, mùžete je 
v urèitých formátech exportovat do urèité složky na 
systémovém pevném disku (Export To Off-line). 
→ Strana F.4–2, Export snímkù do systému souborù 

C.5

✧ Vyberte obrazy pro export a aktivujte funkci Transfer >  
Export to Off-line.

✧ V dialogovém oknì Export to Off-line vyberte požadovaný 
adresáø.

✧ Vyberte požadovaný formát obrazu (DICOM nebo bitmap).

C.5 ✧ Kliknutím na tlaèítko OK uložte vybrané obrazy jako 
jednotlivé soubory. 
C.5–6 Návod k použití pro uživatele systému syngo
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Patient Browser Ukládání, pøedávání dat nebo exponování na film
Exponování na film C.5

Prohlížeè Patient Browser mùžete používat k odesílání 
jednotlivých snímkù nebo všech snímkù jednoho nebo nìkolika 
pacientù, studií èi sérií na kartu úloh Filming. 

C.5

Pøenos snímkù na kartu 
Filming C.5

✧ V navigaèní nebo obsahové oblasti vyberte pøíslušná data. 

C.5 ✧ Aktivujte položku Patient > Copy to Film Sheet nebo 
klepnìte na tlaèítko s ikonou.

Nebo C.5

C.5 ✧ Stisknìte klávesu Copy to Film Sheet na klávesnici se 
symboly. 
 

Nebo C.5

✧ Klepnìte na kartu Filming v horní èást sady a poklepejte na 
položky, které chcete v oknì Patient Browser nafilmovat.

Nebo C.5

✧ Pøetáhnìte myší výbìr na kartu úloh Filming (pøetažení). 
Stejnì jako pøi naèítání obrazù na kartu úloh Viewing mùžete 
urèit, ve kterém segmentu filmového listu se mají obrazy 
objevit. 
→ Strana C.3–5, Pøetažení
Verze VE31D C.5–7 
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Ukládání, pøedávání dat nebo exponování na film Patient Browser
Nìkterým z výše uvedených pøíkazù jsou všechny vybrané 
obrazy pøeneseny na kartu úloh Filming. Podle toho, zda tam 
byla aktivována položka Auto Expose se obrazy exponují na 
film okamžitì, jakmile je filmový list plný, nebo se nejdøíve 
shromáždí do filmové úlohy. 
→ Kapitola G.2, Automatické/manuální exponování na film 
 

C.5

Náhled exponování na filmC.5 ✧ Náhled, který znázoròuje zpùsob exponování obrazù na film 
nebo vytisknutí, zobrazíte pomocí položky Patient > Film 
Preview....

Nebo C.5

C.5 ✧ Kliknìte na tlaèítko s ikonou Film Preview na panelu 
nástrojù. 
 
 
 

C.5–8 Návod k použití pro uživatele systému syngo
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Patient Browser Ukládání, pøedávání dat nebo exponování na film
Exponování snímkù na filmC.5 Obrazy pacienta, které jste shromáždili ve filmové úloze, 
mùžete exponovat nebo tisknout z okna Patient Browser. K 
tomu není nutné zobrazovat kartu úloh Filming. C.5

✧ Aktivujte položku Patient > Expose Film Task a pøeneste 
všechny snímky této úlohy zpracování filmu do kamery nebo 
tiskárny.

Nebo C.5

C.5 ✧ Klepnìte na tlaèítko s ikonou na panelu nástrojù.

➭ Pokud jste na kartu úloh Filming pøenesli obrazy nìkolika 
pacientù, takže existuje více než jedna úloha zpracování 
filmu, zobrazí se dialogové okno. V tomto dialogovém oknì 
mùžete vybrat úlohu zpracování filmu, kterou chcete 
exponovat na film nebo vytisknout na papír. 
→ Strana G.2–13, Volba úlohy zpracování filmu

➭ ”Multiframe obrazy” nemùžete exponovat pøímo z okna 
Patient Browser. Nejdøíve je musíte naèíst na kartu úloh 
Viewing. 
→ Strana E.6–12, Exponování obrazù na film/tisk obrazù 
Verze VE31D C.5–9 
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Ukládání, pøedávání dat nebo exponování na film Patient Browser
Stav úlohy zpracování filmuC.5 Je možné zobrazit pøehled všech úloh zpracování filmu, které již 
byly odeslány na kameru nebo tiskárnu, a zmìnit napøíklad 
poøadí, v nìmž mají být zpracovány.  
→ Strana G.5–3, Zobrazení a manipulace s úlohami zpracování 
filmu 

C.5

✧ Pomocí položky Patient > Film Task Status... zobrazte 
dialogové okno Film Task Status se seznamem všech 
nedokonèených úloh zpracování filmu.

Nebo C.5

C.5 ✧ Klepnìte na tlaèítko s ikonou na panelu nástrojù.

C.5
C.5–10 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

C.6

 
Údržba dat C.6
Jestliže shromáždìná data pravidelnì udržujete, mùžete je 
snadno spravovat a zkrátit dobu pøístupu k databázi. To má 
dùležitý vliv na efektivitu každodenních vyšetøení. C.6

❏ Mùžete získat informace o stavu zpracování údajù o 
pacientovi a vyšetøení a upravit je. Tímto zpùsobem mùžete 
zaznamenat fázi zpracování obrazù pacienta. 

❏ Dùležitá data vyšetøení mùžete oznaèit, abyste je pozdìji 
nemuseli složitì vyhledávat.

❏ Archivované údaje o pacientovi nebo vyšetøení mùžete z 
místní databáze odstranit.

C.6
Verze VE31D C.6–1 
únor 2006   
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Údržba dat Patient Browser
Definice stavu práce C.6

Stav zpracování udává fázi zpracování dat pacienta a dat z 
vyšetøení. Tento stav je vyznaèen jako zkratka u každé položky 
seznamu v obsahové oblasti. Všechny stavy zpracování kromì 
stavù ”read” a ”verified” nastavuje systém. C.6

➭ Pomocí stavu práce mùžete napøíklad definovat pøedbìžné 
podmínky archivace a zasílání dat. 
→ Kapitola F.6, Konfigurace pøenosu dat

➭ Je-li aktivováno zabezpeèení, mùžete stav práce definovat 
pouze v pøípadì, že jste k tomu oprávnìni. 

Zkratky 
com/p/a/s/e/r/h C.6

Zkratky se skládají ze sedmi èástí: C.6

❏ com/p/a/s/e/r/H – První èást poskytuje informace o postupu 
zpracování studie a o tom, zda výsledky už byly 
zkontrolovány lékaøem: 
Studie byla completed (dokonèeno) (com/...) 
Obrazy a vyšetøení jsou ve stavu verified (ovìøeno) (ver/...). 
Obrazy jsou ve stavu read (pøeèteno) (rea/...) 

❏ com/p/a/s/e/r/H – Druhá èást uvádí, zda byly  
všechny (.../P/...), 
jen èást (.../p/...), nebo 
žádné (.../ /...) 
obrazy tohoto pacienta, studie nebo série printed (vytištìno) 
nebo exponovány na film. 
C.6–2 Návod k použití pro uživatele systému syngo
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Patient Browser Údržba dat
❏ com/p/a/s/e/r/H – Tøetí složka poskytuje následující stavové 
informace:  
(.../A/...) Data byla kompletnì archivována 
(.../AC/...) Data byla archivována propojena 
(.../AV/...) Data byla archivována a zkontrolována 
(.../A?/...) Èeká se na archivaci a kontrolu dat 
(.../Af/...) Archivace a kontrola dat se nezdaøila 
(.../a/...) Èást dat byla archivována 
(.../ /...) Žádná data nebyla archivována

❏ com/p/a/s/e/r/H – u ètvrté složky mùžete vidìt, s jakým 
rozsahem a stavem byly obrazy pacienta, vyšetøení nebo 
série poslány po síti: 
(.../S/...) Data byla kompletnì poslána  
(.../SC/...) Data byla poslána a propojena 
(.../SV/...) Data byla poslána a zkontrolována 
(.../S?/...) Èeká se na poslání a kontrolu dat 
(.../Sf/...) Poslání a kontrola dat se nezdaøila 
(.../s/...) Èást dat byla poslána 
(.../ /...) Žádná data nebyla poslána

❏ com/p/a/s/e/r/H – Pátá složka uvádí, zda všechny  
(E/...), 
jen èást (e/...) nebo  
žádný (/...) 
z obrazù tohoto pacienta, vyšetøení nebo série byly 
exportovány na datové médium.
Verze VE31D C.6–3 
únor 2006
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Údržba dat Patient Browser
❏ com/p/a/s/e/r/H – Šestá složka poskytuje informace, zda  
všechny (R/...), 
jen èást (r/...) nebo  
žádné (/...) 
obrazy tohoto pacienta, studie nebo série byly importovány 
do Vaší lokální databáze ze sítì (received).

❏ com/p/a/s/e/r/H – Sedmá èást uvádí informace, zda byly v 
tomto záznamu uskuteènìny nìjaké zmìny, tzn. zda byl 
vytvoøen záznam historie zmìn (.../H) 
nebo nebyl (.../).

➭ Velká èi malá písmena oznaèují, že byla zpracována všechna
(velká písmena) nebo pouze nìkterá data (malá písmena). 
C.6–4 Návod k použití pro uživatele systému syngo
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Patient Browser Údržba dat
Zadávání stavu zpracování C.6 Vìtšina hodnot ve zkratkách stavu práce je zadávána 
automaticky v dobì dokonèení zpracování datového záznamu 
(napøíklad v dobì exponování snímku na film). C.6

Jako uživatel mùžete pro studie a série v místní databázi zadat 
následující stavy práce: C.6

❏ com/... (completed) – studie byla dokonèena
❏ ver/... (verified) – obrazy byly verifikovány.
❏ rea/... (read) – obrazy byly prostudovány lékaøem

➭ Oznaèení „completed” se nastavuje automaticky. 

C.6 ✧ Zvolte položku Edit > Set State a vyberte stav práce, který 
chcete pøiøadit. 

Nebo C.6

C.6 ✧ Klepnìte na odpovídající tlaèítko s ikonou na panelu 
nástrojù.

➭ Pøiøazením stavu ”completed” mùžete spustit automatický 
pøenos dat. Pokud byl na úrovni obrazu zadán automatický 
pøenos dat, musíte pøenos dat spustit ruènì. 
→ Strana F.6–2, Automatický pøenos dat

➭ Pøiøazení stavu práce není možné v položce Scheduler.

com rea ver
Verze VE31D C.6–5 
únor 2006
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Údržba dat Patient Browser
Oznaèení dat z vyšetøení C.6

Pomocí prohlížeèe Patient Browser mùžete oznaèit nìkteré 
položky údajù o pacientovi nebo vyšetøení, takže je pozdìji 
nebudete muset zdlouhavì vyhledávat a zpracovávat. C.6

➭ Pomocí nabídky Filter mùžete vyhledávat pouze oznaèená 
data.  
→ Strana C.2–12, Filtrování dat 
 

Oznaèení položek C.6 ✧ V navigaèní nebo obsahové oblasti vyberte jednoho nebo 
více pacientù, studií, sérií nebo obrazù. 

✧ Pro oznaèení vybraných údajù o pacientovi a vyšetøení zvolte 
v hlavní nabídce prohlížeèe Patient Browser položku Edit > 
Mark.

Nebo C.6

C.6 ✧ Pravým tlaèítkem myši otevøete rozevírací nabídku v 
navigaèní oblasti nebo v oblasti s obsahem (nebo klávesou 
Shift + F10) a zvolte Mark. 
 

Nebo C.6

C.6 ✧ Stisknìte klávesu Mark na klávesnici se symboly (Num 3).
C.6–6 Návod k použití pro uživatele systému syngo
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Zobrazení oznaèených dat C.6

C.6 V obsahové oblasti poznáte oznaèené údaje o pacientovi a data 
z vyšetøení podle písmena M zadaného v seznamu ve sloupci 
Mark Status. 
 
 

C.6

Zrušení oznaèení položek C.6 ✧ V navigaèní nebo obsahové oblasti vyberte data, jejichž 
oznaèení chcete zrušit.

✧ Zvolte položku Edit > Unmark.

Nebo C.6

✧ V místní nabídce zrušte oznaèení pomocí Unmark (pravé 
tlaèítko myši nebo Shift + F10).
Verze VE31D C.6–7 
únor 2006
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Odstraòování dat C.6

Po ukonèení vyšetøení, pøehlédnutí všech výsledkù a snímkù a 
napsání komentáøù k nim lze data archivovat a poté je odstranit 
z databáze. C.6

➭ Je-li aktivováno zabezpeèení, mùžete data odstranit pouze v 
pøípadì, že k tomu jste autorizováni.

C.6

C.6

C.6

UPOZORNÌNÍ

Jakmile jsou obrazy úspìšnì pøeneseny do øídícího systému 
tiskárny, nastavuje se pøíznak „vytištìno". Mùže se stát, že 
nìkteré tiskárny (napø. tiskárny na papír) nejsou schopny samy 
vyøešit problémy, které se pøi tisku vyskytnou. C.6

Mùže dojít ke ztrátì výtisku obrazu. C.6

✧ Pøed vymazáním obrazù se proto vždy ujistìte, že výtisky 
jsou v poøádku.  
C.6–8 Návod k použití pro uživatele systému syngo
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Patient Browser Údržba dat
C.6

UPOZORNÌNÍ

Systémy, které nepoužívají potvrzení o uložení nebo zpìtnou 
zprávu do odesílacího systému, když byla data kompletnì 
pøijata (pøíznaky A a S). Uživatel nebo automatický 
mechanismus odstraòování u odesílacího systému by mohl 
následnì smazat odeslaná data. Avšak tato odezva 
neznamená, že data byla již uložena u pøijímacího systému. C.6

V pøípadì, že pøijímací systém nemùže data uložit, mohlo 
by dojít k nevratné ztrátì dat. C.6

✧ Proveïte køížovou kontrolu, zda jsou data skuteènì uložena 
na pøijímacím systému. Použijte potvrzení uložení pokaždé, 
když je podporováno odesílacím a pøijímacím systémem.

Poznámka: → Strana F.1–1, UPOZORNÌNÍ týkající se potvrzení 
uložení. C.6
Verze VE31D C.6–9 
únor 2006
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C.6 ✧ V navigaèní nebo obsahové oblasti vyberte data, která chcete 
odstranit.

✧ Zvolte položku Edit > Delete v hlavní nabídce prohlížeèe 
Patient Browser nebo otevøete místní nabídku a zvolte 
možnost Delete.

Nebo C.6

C.6 ✧ Kliknìte na tlaèítko na panelu nástrojù. 
 
 

➭ Nezapomeòte, že pomocí nabídky Edit > Delete nelze 
odstranit jednotlivé datové objekty uložené na médiích MOD. 
Je pouze možné vymazat celou stranu média MOD
formátováním.
C.6–10 Návod k použití pro uživatele systému syngo
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Patient Browser Údržba dat
Zobrazí se dialogové okno, v nìmž mùžete opìt potvrdit, že 
chcete zvolená data opravdu odstranit. C.6

✧ Zvolené údaje o pacientovi a data vyšetøení odstraníte 
zvolením odpovìdi Yes.

➭ V oknì Browser Configuration mùžete výzvu k potvrzení 
vypnout. Poté budou nechránìná data vždy okamžitì 
odstranìna bez potvrzení. 
→ Strana C.8–2, Obecná nastavení

➭ Jsou-li data zámìrnì nebo v dùsledku aktuálního stavu práce 
chránìna proti odstranìní, zobrazí se pøíslušné dialogové 
okno. 
→ Strana C.6–12, Odstranìní dat s chybìjícím stavem práce
Verze VE31D C.6–11 
únor 2006
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Odstranìní dat s chybìjícím 
stavem práce C.6

Pokud se pokusíte odstranit data, jejichž stav práce neumožòuje 
odstranìní, zobrazí se okno s hlášením. C.6

V tomto oknì s hlášením mùžete zkontrolovat, proè nelze 
zvolená data odstranit. Dùvodem mùže být napøíklad to, že pøed 
povolením jejich odstranìní je nutné provést øadu krokù 
zpracování. C.6

➭ V oknì Browser Configuration mùžete definovat stav práce, 
v nìmž budete moci data odstranit.  
→ Strana C.8–2, Obecná nastavení
C.6–12 Návod k použití pro uživatele systému syngo
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Patient Browser Údržba dat
C.6 ✧ Klepnutím na tlaèítko Yes odstraòte datový záznam uvedený 
v oknì s hlášením bez ohledu na chybìjící stav.

Nebo C.6

C.6 ✧ Klepnìte na tlaèítko Yes to All, pokud jste pro odstranìní 
vybrali více datových záznamù a pøejete si odstranit všechny 
záznamy bez ohledu na jejich stav práce.

Nebo C.6

C.6 ✧ Klepnìte na tlaèítko No; datový záznam uvedený v oknì s 
hlášením odstranìn nebude.

Nebo C.6

C.6 ✧ Kliknutím na tlaèítko Cancel odstranìní zrušte. 
 
 
 

Verze VE31D C.6–13 
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Ochrana dat pøed 
vymazáním C.6

Údaje o pacientovi a data vyšetøení mùžete zabezpeèit proti 
náhodnému odstranìní. C.6

✧ V navigaèní nebo obsahové oblasti vyberte data, která chcete 
zabezpeèit pøed odstranìním.

✧ V hlavní nabídce prohlížeèe Patient Browser zvolte položku 
Edit > Protect.

Nebo C.6

C.6 ✧ Kliknìte na tlaèítko s ikonou na panelu nástrojù. 

Nebo C.6

C.6 ✧ V kontextové nabídce zvolte možnost Protect (pravým 
tlaèítkem myši nebo klávesovou zkratkou Shift + F10).

Nyní již nebude možné data jednoduše odstranit. Ochrana pøed 
odstranìním vždy zahrnuje všechny nižší úrovnì dat a pøíslušné 
záznamy na vyšších úrovních dat. Napøíklad pokud proti 
odstranìní zabezpeèíte položku studie, nebudete již moci 
odstranit jednotlivé snímky této studie ani záznam pacienta. C.6

➭ Data, která jste oznaèili jako chránìná pøed odstranìním, 
budou chránìna také pøed pøesunutím a opravami. 
→ Strana C.4–10, Pøeskupování dat 
→ Strana C.4–2, Oprava údajù pacienta nebo dat z vyšetøení
C.6–14 Návod k použití pro uživatele systému syngo
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Zobrazení dat chránìných 
pøed odstranìním C.6

C.6 To, které údaje o pacientovi a data vyšetøení jsou chránìna pøed 
odstranìním, lze poznat podle oznaèení „prot" ve sloupci Mark 
Status v obsahové oblasti. 

C.6

Zrušení ochrany 
proti vymazání C.6

Chcete-li data opravit, pøesunout nebo odstranit bez zobrazení 
okna s hlášením, musíte zrušit jejich ochranu pøed odstranìním.C.6

✧ Zvolte položku Edit > Remove Protection v hlavní nabídce 
nebo položku Remove Protection v místní nabídce a zrušte 
ochranu pøed odstranìním.

Nebo C.6

C.6 ✧ Klepnìte na tlaèítko s ikonou na panelu nástrojù.

C.6

C.6
Verze VE31D C.6–15 
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Clear Scheduler C.6 Pomocí okna Clear Scheduler mùžete stanovit, které položky 
plánovaèe se mají odstranit. C.6

✧ V nabídce Patient Browser otevøete položku Edit > Clear 
Scheduler....

Zobrazí se dialogové okno Clear Scheduler. C.6

✧ Aktivací pøíslušného zaškrtávacího políèka zvolte druh 
položek, které chcete odstranit:

❏ všechny již provedené kroky postupu,

❏ všechny kroky postupu, které nejsou naplánovány pro danou 
stránku,

❏ všechny kroky postupu, které nejsou naplánovány pro danou 
modalitu,

❏ všechny kroky postupu, které nejsou naplánovány pro daný 
den.
C.6–16 Návod k použití pro uživatele systému syngo

 0.0



Patient Browser Údržba dat
C.6 ✧  Potvrïte výbìr tlaèítkem OK. Nastavení se uloží a pøíslušné 
kroky postupu budou odstranìny.

Kroky procedury vèetnì odpovídajících akcí budou vymazány. 
Pokud neexistují další kroky procedury, související metody a 
pacienti budou vymazáni také. C.6

Nebo C.6

C.6 ✧ Kliknutím na tlaèítko Cancel operaci zrušte. 

➭ Plánovaè lze vymazat také automaticky po aktualizaci 
prostøednictvím systému RIS; v takovém pøípadì budou z 
místní databáze odstranìny všechny položky pracovního 
seznamu, které nebudou zaslány systémem RIS.  
Chcete-li nakonfigurovat tuto funkci, obra¤te se na svého 
servisního technika.
Verze VE31D C.6–17 
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C.6–18 Návod k použití pro uživatele systému syngo
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C.7

Sledování postupu pomocí 
systému MPPS C.7
Po dokonèení registrace pacienta se automaticky vytvoøí objekt 
Modality Performed Procedure Step (MPPS - krok procedury 
provedený modalitou) a uloží se do místní databáze. C.7

Bìhem vyšetøení a následného zpracování se k objektu MPPS 
pøidá pøíslušná informace o úètování. C.7

Objekt MPPS lze poslat do pøipojeného systému HIS nebo RIS po 
dokonèení nebo pøerušení vyšetøení, takže podporuje další 
úètovací èinnosti. C.7
Verze VE31D C.7–1 
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Úprava objektu MPPS C.7

Po registraci se vytvoøí objekt MPPS. Jeho stav je „IN PROGRESS". 
Stav se zmìní na „COMPLETED", jestliže nejsou naplánované 
žádné další kroky vyšetøení a vy objekt MPPS uzavøete, nebo na 
„DISCONTINUED", jestliže jej pøerušíte. C.7

Pøed uzavøením práce na vyšetøení archivací zkonstrolujte a 
doplòte chybìjící záznamy do objektu MPPS. C.7

✧ V prohlížeèi Patient Browser vyberte pacienta, vyšetøení 
nebo jednu z pøíslušných sérií èi jeden z odpovídajících 
snímkù.

✧ Zvolte položku Patient > Show MPPS.

Nebo C.7

C.7 ✧ Kliknìte na tlaèítko na panelu nástrojù. 
 

Zobrazí se okno Modality Performed Procedure Step. C.7
C.7–2 Návod k použití pro uživatele systému syngo
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Patient Browser Sledování postupu pomocí systému MPPS
Verze VE31D C.7–3 
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Stav MPPS C.7 Po zvolení série se v poli Status zobrazí stav MPPS: 
C.7

❏ "IN PROGRESS" znamená, že MPPS právì probíhá,
❏ "COMPLETED" znamená, že MPPS je dokonèeno,
❏ "DISCONTINUED" znamená, že MPPS bylo pøerušeno. 

Kontrola pøenosu C.7 ✧ Zkontrolujte údaje o pacientovi a data vyšetøení v oblastech 
PATIENT, STUDY, a MPPS.

✧ Opravte data, a pokud je to nutné, zadejte komentáø. 

➭ Nemùžete opravit data urèitého pacienta nebo studie, pokud 
jsou data pøipojena k informacím MPPS. Zobrazí se hlášení, 
které vás upozorní, protože data ztratí svùj odkaz na externí 
systém HIS/RIS. 

➭ Nemùžete zadávat údaje do všech polí. 
C.7–4 Návod k použití pro uživatele systému syngo
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Zobrazení èinností, dávky a 
úètování C.7

Údaje jsou uvedeny na tøech kartách dílèích úloh, seøazených 
podle rùzných hledisek ve spodní èásti okna Modality 
Performed Procedure Step. Mùžete je vybrat klepnutím na 
pøíslušné záložky. C.7

Zobrazení èinností C.7

C.7 ✧ Kliknutím na kartu Actions pøesunete kartu do popøedí a 
zobrazíte seznam krokù provedených pøi vyšetøení:

❏ Provedené èinnosti: Je uveden kód protokolu a seznam 
položek protokolu.

❏ Provedené série: Zobrazí se informace o sérii, napø. popis 
série, použitý protokol a jméno lékaøe. 

Zobrazení dávky C.7 Záložka karty Dose je dostupná pouze, je-li nakonfigurována. C.7

C.7 ✧ Kliknutím na kartu Dose zobrazíte seznamy a tabulky dat ve 
spojení s ozáøením (napøíklad podrobnosti o aplikované 
dávce). 
 
 
 
 

✧ Zkontrolujte informace o anatomické struktuøe a dávce 
ozaøování.

✧ Mùžete zadat komentáø k vyšetøení a dávce ozaøování. 

C.7
Verze VE31D C.7–5 
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Zobrazení úètování C.7

C.7 ✧ Kliknutím na kartu Billing zobrazíte výpis nákladù na 
poskytnuté služby a spotøebované materiály (filmové listy). 
Vìtšina informací je již zadána systémem.  
 
 

Na záložce Billing jsou informace rozdìleny do tøí èástí: C.7

❏ Je zobrazen poèet použitých filmových listù.

➭ Poèet zde zobrazených filmù se vždy vztahuje na celkový 
poèet filmù pro všechny série související s vyvolaným 
objektem MPPS, bez ohledu na to, zda aplikace MPPS byla 
vyvolána u studie, série na úrovni obrazù.

➭ Atributy související s exponováním na film mùžete upravit a 
vložit Quantity do èásti Billing supplies and devices, pokud 
byly použity další materiály.

❏ V èásti Billing supplies and devices se zobrazí použití dalšího 
materiálu, napø. kontrastní látky (CM)
C.7–6 Návod k použití pro uživatele systému syngo
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Odeslání a uzavøení objektu MPPS C.7

S objektem MPPS mùžete dále postupovat tìmito zpùsoby: C.7

Uzavøení C.7

C.7 ✧ Kliknìte na tlaèítko Completed, když všechny èinnosti pro 
pøíslušného pacienta byly dokonèeny.

Hlášení oznamuje, že objekt MPPS je odeslán do systému HIS/
RIS, je-li pøipojen. C.7

➭ Nemùžete provádìt žádné další zmìny v objektu MPPS. 

Nebo C.7

Pøerušení C.7

C.7 ✧ Kliknìte na tlaèítko Discontinued, jestliže další kroky 
vyšetøení nebudou provádìny.

Objekt MPPS se nastaví na stav „DISCONTINUED" a hlášení 
oznámí, že objekt MPPS je odeslán do systému HIS/RIS, je-li 
pøipojen. C.7

➭ Nemùžete provádìt žádné další zmìny v objektu MPPS.
Verze VE31D C.7–7 
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Nebo C.7

Odeslání do systému HIS/RISC.7

C.7 ✧ Kliknutím na tlaèítko Send odešlete provedené zmìny pøímo 
do systému HIS/RIS. 

Nebo C.7

Uložení C.7

C.7 ✧ Kliknutím na tlaèítko Save uložíte zmìny objektu MPPS bez 
odeslání do systému HIS/RIS.

Vyšetøení ještì nebylo uzavøeno. 
C.7
C.7–8 Návod k použití pro uživatele systému syngo
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Uzavøení objektu MPPS bez uloženíC.7

Okno Modality Performed Procedure Step se zavøe 
automaticky, když zprávu uzavøete, uložíte nebo odešlete. 
Pokud jste zprávu otevøeli pouze ke ètení, zavøete ji beze zmìn.C.7

C.7 ✧ Kliknìte na tlaèítko Cancel. 

Nebo C.7

C.7 ✧ Klepnutím na tlaèítko Close window zavøete dialogové okno.
Verze VE31D C.7–9 
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C.7–10 Návod k použití pro uživatele systému syngo
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C.8

Konfigurace prohlížeèe 
Patient Browser C.8
Pomocí dialogového okna Browser Configuration mùžete 
pøizpùsobit Patient Browser svému zpùsobu práce. 

C.8

Zmìnit mùžete následující nastavení: C.8

❏ obecná nastavení, jako je rozvržení panelu nástrojù a zpùsob 
zobrazení stavu práce,

❏ hierarchické zobrazení úrovní informací (pacient, studie, 
série, snímek) v navigaèní a obsahové oblasti,

❏ zobrazení jednotlivých úrovní informací (pacient, studie, 
série, snímek) v obsahové oblasti, 

❏ výbìr aplikací definovaných uživatelem v nabídce Private 
Applications (pøíslušné konfiguraèní okno mùžete otevøít 
pøímo z nabídky Private Applications). 
 

C.8 ✧ Na øádku nabídek prohlížeèe Patient Browser aktivujte 
položku Options > Configure Browser....

Zobrazí se okno Browser Configuration se tøemi kartami – 
General, Tree View a Single View. C.8

➭ V této pøíruèce se v èásti Základy mùžete seznámit s 
postupem pøi otevírání a zavírání konfiguraèních oken, 
ukládání zmìn nebo obnovování pùvodního nastavení 
provedeného dodavatelem. 
→ Kapitola A.4, Konfigurace uživatelského rozhraní 
Verze VE31D C.8–1 
únor 2006   
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Konfigurace prohlížeèe Patient Browser Patient Browser
Obecná nastavení C.8

Na kartì General mùžete provést konfiguraci panelu nástrojù 
prohlížeèe Patient Browser, urèit, který stav práce se pro data z 
vyšetøení zobrazí, a nastavit vliv stavu práce na povolení k 
vymazání. C.8

✧ Klepnutím na kartu General kartu pøesunete do popøedí 
obrazovky.
C.8–2 Návod k použití pro uživatele systému syngo
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Patient Browser Konfigurace prohlížeèe Patient Browser
Panel nástrojù C.8

Tlaèítka pro funkce prohlížeèe Patient Browser, které èasto 
používáte, mùžete umístit na panel nástrojù a tlaèítka funkcí, 
které užíváte zøídka, mùžete odstranit. C.8

➭ V novìjší verzi softwaru (nikoli v této verzi) mùžete z panelu 
nástrojù prohlížeèe Patient Browser pomocí seznamu pro 
výbìr aplikací konfigurovat i funkce jiných aplikací.

✧ Z položky Tool Pool zvolte èinnost, pro niž chcete na panel 
nástrojù umístit tlaèítko s ikonou.

C.8 ✧ Klepnutím na šipku dolù umístíte tlaèítko na Panel nástrojù.

✧ Tento krok nìkolikrát opakujte, než bude Panel nástrojù 
obsahovat všechna požadovaná tlaèítka.

✧ Pokud chcete tlaèítko s ikonou z panelu nástrojù odstranit, 
vyberte na Panelu nástrojù odpovídající èinnost.

C.8 ✧ Klepnutím na šipku nahoru tlaèítko z Panelu nástrojù 
odstraníte.
Verze VE31D C.8–3 
únor 2006
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Stav práce C.8

Ve støední èásti karty General mùžete urèit, který stav práce se 
pro data z vyšetøení v obsahové oblasti zobrazí a ve které fázi 
zpracování lze data vymazat. 

C.8

Zobrazení stavu práce C.8

✧ Vyberte zaškrtávací políèko pro stav práce, pokud chcete, aby 
se tento stav práce zobrazil v obsahové oblasti prohlížeèe 
Patient Browser.

➭ Informace o stavu práce viz 
→ Strana C.6–2, Definice stavu práce

Autorizace k vymazání C.8

✧ Zaškrtnìte pole položky stavu práce. Data bez tohoto stavu 
nebude možné vymazat bez výslovného potvrzení v oknì 
hlášení. 
C.8–4 Návod k použití pro uživatele systému syngo
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Patient Browser Konfigurace prohlížeèe Patient Browser
Potvrzení odstranìní C.8

Pøi výchozím nastavení systému se pøed každým vymazáním 
zobrazí okno s výzvou k potvrzení, a to i v pøípadì, že data již 
dosáhla stavu práce požadovaného pro vymazání. Tento zpùsob 
snižuje nebezpeèí nechtìného vymazání dat. Pøi konfiguraci 
mùžete toto potvrzení aktivovat nebo deaktivovat. 

C.8

C.8 ✧ Pokud chcete, aby se vždy pøed vymazáním dat zobrazilo 
okno s výzvou k potvrzení, klepnìte na zaškrtávací políèko u 
položky Confirm Deletion.

Zaškrtnutí v políèku znamená, že výzva k potvrzení souhlasu s 
vymazáním je aktivována. C.8

Nebo C.8

✧ Odstranìním zaškrtnutí výzvu k potvrzení souhlasu s 
vymazáním deaktivujete.
Verze VE31D C.8–5 
únor 2006
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Konfigurace prohlížeèe Patient Browser Patient Browser
C.8

C.8

C.8

UPOZORNÌNÍ

Potvrzení souhlasu s mazáním deaktivováno C.8

Možnost ztráty dat C.8

✧ Volba na záložce General ke konfiguraci „Delete 
Confirmation Dialog" by se nemìla vypínat. Buïte opatrní 
pøi nastavování povolení mazat dokumenty bez kontroly, 
nejsou-li nastaveny pøíznaky.

C.8

UPOZORNÌNÍ

Systémy, které nepoužívají potvrzení o uložení nebo zpìtnou 
zprávu do odesílacího systému, když byla data kompletnì 
pøijata (pøíznaky A a S). Uživatel nebo automatický 
mechanismus odstraòování u odesílacího systému by mohl 
následnì smazat odeslaná data. Avšak tato odezva 
neznamená, že data byla již uložena u pøijímacího systému. C.8

V pøípadì, že pøijímací systém nemùže data uložit, mohlo 
by dojít k nevratné ztrátì dat. C.8

Proveïte køížovou kontrolu, zda jsou data skuteènì uložena na 
pøijímacím systému. Použijte potvrzení uložení pokaždé, když 
je podporováno odesílacím a pøijímacím systémem. 
Poznámka:→ Strana F.1–1, UPOZORNÌNÍ o potvrzení uložení.C.8
C.8–6 Návod k použití pro uživatele systému syngo
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Patient Browser Konfigurace prohlížeèe Patient Browser
Náhled miniatur pro média C.8

Lze zobrazit miniatury pro vybrané médium (napø. CD, DVD), 
jsou-li k dispozici. C.8

Náhled miniatur pro média lze kdykoli zapnout nebo vypnout. 
Nastavení se bude vztahovat na média, která se vloží poté, co se 
tato volba zmìní. 
Napø. jestliže CD1 byl vložen s volbou zapnutou, zobrazí se 
miniatury pro pøípady. Jestliže je volba vypnuta a vloží se CD2, 
miniatury se pro CD2 nezobrazí, ale pro CD1 se zobrazí. Když je 
CD1 vysunuto a znovu vloženo s vypnutou volbou, miniatury se 
nezobrazí. C.8

✧ Kliknutím na zaškrtávací políèko Enable Image Stamp 
Preview for Media se zobrazí dostupné miniatury.

➭ Jestliže jsou miniatury k dispozici a zaškrtnutí políèka Enable 
Image Stamp Preview for Media je zrušeno, ve stavovém 
øádku se zobrazí hlášení „Image stamp preview is switched 
off".

➭ Jestliže nejsou miniatury k dispozici a políèko Enable Image 
Stamp Preview for Media se zaškrtne, ve stavovém øádku se 
zobrazí hlášení „Image stamp preview is not available".

➭ Zapnutím této volby se mùže zpomalit naèítání médií s velkým 
množstvím obrazù.

➭ Je-li tato volba vypnuta, CD-/DVD-R se naèítá rychleji.
Verze VE31D C.8–7 
únor 2006
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Konfigurace prohlížeèe Patient Browser Patient Browser
Hierarchické zobrazení v navigaèní 
a obsahové oblasti C.8

Na kartì Tree View mùžete urèit, které informace mají být 
uvedeny v obsahové oblasti prohlížeèe Patient Browser v 
hierarchických úrovních (napøíklad pacient). Hierarchické 
úrovnì v navigaèní a obsahové oblasti mùžete také skrýt. Lze 
také konfigurovat zobrazení ikon sérií a obrazù. 

C.8

✧ Klepnutím na kartu Tree View kartu pøesunete do popøedí.

Výbìr databáze C.8

C.8 ✧ Výbìrem položky Scheduler mùžete definovat zobrazení 
pøedem zaznamenaných údajù o pacientovi v prohlížeèi 
Patient Browser.

Nebo C.8

C.8 ✧ Chcete-li nakonfigurovat vzhled místní databáze, zvolte ze 
seznamu databází položku Database. 

➭ Názvy a informace zobrazené na kartì Tree View se liší pro 
rùzné úrovnì dat podle databáze, kterou jste otevøeli 
(napøíklad položka Study v místní databázi odpovídá položce 
Procedure v plánovaèi). 
C.8–8 Návod k použití pro uživatele systému syngo
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Patient Browser Konfigurace prohlížeèe Patient Browser
Výbìr úrovnì dat C.8

✧ Vyberte úroveò hierarchie Patient, Procedure, Proc. Step 
nebo Action Item v plánovaèi.

Nebo C.8

✧ V místní databázi zvolte hierarchickou úroveò Patient, 
Study, Series nebo Instance.

➭ Podoba karty Tree View se v závislosti na vybrané 
hierarchické úrovni mírnì liší. Na úrovni Series se zobrazí také 
seznam voleb Modality. Na úrovni Instance se místo toho 
zobrazí seznam voleb Data Type.
Verze VE31D C.8–9 
únor 2006
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Konfigurace prohlížeèe Patient Browser Patient Browser
Pøíklad: Úroveò 
dat Procedure Step/
Scheduler C.8
C.8–10 Návod k použití pro uživatele systému syngo
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Patient Browser Konfigurace prohlížeèe Patient Browser
Pøíklad:  
Datová úroveò série/ 
Místní databáze C.8
Verze VE31D C.8–11 
únor 2006
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Konfigurace prohlížeèe Patient Browser Patient Browser
Položky seznamu C.8

Obsahovou oblast prohlížeèe Patient Browser mùžete 
zpøehlednit pomocí vlastního výbìru zobrazovaných údajù. 

C.8

Pøidání položek seznamu C.8 ✧ V oknì Heading Pool vyberte položky, které chcete v 
obsahové oblasti zobrazit.

➭ Položky vybírejte v poøadí, v jakém se mají zobrazit.

➭ Podrobný popis položek okna Heading Pool naleznete v èásti 
→ Dodatek L.

 

C.8 ✧ Kliknutím na šipku dolù nebo dvojitým kliknutím na položku 
umístíte položku v oknì Heading Settings do tabulky v 
obsahové oblasti.

✧ Tento krok nìkolikrát opakujte, než bude tabulka obsahovat 
všechny požadované položky v obsahové oblasti.

➭ Pokud je položka v oknì Heading Pool neaktivní, znamená to, 
že je již v oknì Heading Settings obsažena, a naopak.
C.8–12 Návod k použití pro uživatele systému syngo
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Patient Browser Konfigurace prohlížeèe Patient Browser
Položky specifické pro 
urèitou modalitu C.8

V sériích (místní databáze) závisí informace zobrazené v 
obsahové oblasti na modalitì. Podle modality lze také definovat 
specifické položky v obsahové oblasti. C.8

✧ Chcete-li v obsahové oblasti vytvoøit položky seznamu, 
vyberte modalitu na úrovni dat Series.

Nebo C.8

✧ Výbìrem možnosti Default definujte informace, které se 
mají zobrazit pøi rùzných modalitách, nebo takové, u nichž 
nelze nastavení specifické pro urèitou modalitu provést. 

C.8 ✧ Odešlete požadované položky seznamu z okna Heading Pool 
do okna Heading Settings. 
 

Verze VE31D C.8–13 
únor 2006
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Konfigurace prohlížeèe Patient Browser Patient Browser
Položky specifické pro urèitý 
typ dat C.8

Zobrazení seznamu snímkù v obsahové oblasti závisí na typu 
dat. Položky seznamu mùžete vybrat speciálnì pro každý typ dat 
z odpovídajícího okna Heading Pool (Seznam záhlaví). C.8

✧ Chcete-li v obsahové oblasti vytvoøit položky seznamu 
speciálnì pro snímky urèitého typu, vyberte na úrovni dat 
Instance pøíslušný typ dat.

Nebo C.8

✧ Výbìrem možnosti Default definujte informace, které se 
mají v obsahové oblasti zobrazit pro obrazy rùzných typù dat, 
nebo takové, u nichž nelze nastavení specifické pro urèitý typ 
dat provést. 

C.8 ✧ Odešlete požadované položky seznamu z okna Heading Pool 
do okna Heading Settings.
C.8–14 Návod k použití pro uživatele systému syngo
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Patient Browser Konfigurace prohlížeèe Patient Browser
Odebrání položek ze 
seznamu C.8

✧ Pokud chcete nìkterou položku z tabulky odebrat, vyberte ji 
v oknì Heading Settings. 

C.8 ✧ Položku z tabulky v obsahové oblasti odstraníte kliknutím na 
šipku nahoru. 
 
 
 

Skrytí úrovní dat C.8

Mùžete urèit, kterou hierarchickou úroveò, studii, sérii nebo 
objekt chcete v navigaèní a obsahové oblasti zobrazit. C.8

C.8 ✧ Tuto úroveò dat skryjete zaškrtnutím políèka u položky Hide. 
Verze VE31D C.8–15 
únor 2006
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Zobrazení seznamu/Zobrazení miniatur 
obrazù C.8

Pro zobrazení sérií a snímkù v obsahové oblasti mùžete zvolit 
buï formu seznamu, nebo formu miniatur. Pro oznaèení 
miniatur snímkù mùžete použít maximálnì dvì položky. Pøi 
pøiøazování tìchto položek postupujte stejnì jako pøi urèování 
položek seznamu v obsahové oblasti. 
→ Strana C.8–12, Položky seznamu C.8

C.8 ✧ Klepnutím zvolte možnost Icon Configuration.

✧ V oknì Heading Pool zvolte položky, jejichž prostøednictvím 
chcete oznaèit položky pro série a snímky, a klepnìte na 
šipku dolù. Položky se nyní zobrazí v oknì Icon Labels.
C.8–16 Návod k použití pro uživatele systému syngo
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Patient Browser Konfigurace prohlížeèe Patient Browser
Jednotlivé pohledy obsahové 
oblasti C.8

Na kartì Single View urèete, na které hierarchické úrovni se 
mají data zobrazit, je-li navigaèní oblast skrytá. Každá datová 
položka se zobrazí na samostatném øádku. C.8

✧ Kliknìte na kartu Single View a pøesuòte ji do popøedí. 
Vyberte databázi, kterou chcete nakonfigurovat. 
→ Strana C.8–8, Výbìr databáze
Verze VE31D C.8–17 
únor 2006
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Nastavení úrovnì dat C.8 V jednotlivém pohledu se v obsahové oblasti zobrazí vždy stejná 
úroveò dat. C.8

 
 
 

C.8

✧ Vyberte úroveò dat, kterou chcete zobrazit v obsahové 
oblasti po pøepnutí z okna Tree View do okna Single View. 

Druh zobrazené informace o položkách seznamu závisí na 
nastavení úrovnì dat pro urèitý pohled v obsahové oblasti. 
Pokud jste napøíklad zvolili, že se má zobrazovat úroveò Series, 
mùžete nastavit, aby se v seznamu sérií vypisovaly informace z 
datových úrovní pacienti, studie a série.  
 

C.8

Kombinování položek 
seznamu C.8

Jednotlivé pohledy v obsahové oblasti mùžete nakonfigurovat 
podobným zpùsobem jako hierarchické zobrazení navigaèní a 
obsahové oblasti.  
→ Strana C.8–8, Hierarchické zobrazení v navigaèní a obsahové 
oblasti C.8

Položky rùzných úrovní informací mùžete kombinovat zmìnou 
úrovnì dat v oknì Heading Pool, z nìhož pak vyberete 
požadované položky. C.8

C.8 ✧ V seznamu voleb urèete úroveò dat, z níž chcete pøevzít 
položky seznamu pro obsahovou oblast v oknì Heading 
Pool.
C.8–18 Návod k použití pro uživatele systému syngo
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Nyní okno Heading Pool obsahuje veškeré položky seznamu ze 
zvolené úrovnì informací. C.8

➭ Podrobný popis položek okna Heading Pool naleznete v èásti 
→ Dodatek L.

 

C.8 ✧ Kliknìte na položku seznamu v oknì Heading Pool a pomocí 
klávesy se šipkou dolù ji pøesuòte do okna Heading Settings 
nebo ji z okna Heading Settings pomocí klávesy se šipkou 
nahoru odstraòte. 

C.8 ✧ V pøípadì potøeby zvolte nyní jinou úroveò (Level) a pøesuòte 
položky seznamu jiné úrovnì dat z okna Heading Pool do 
okna Heading Settings.

➭ Pro úroveò dat Series mùžete v obsahové oblasti nastavit 
položky seznamu specifické pro urèitou modalitu nebo pro 
urèitý typ dat. 
→ Strana C.8–13, Položky specifické pro urèitou modalitu 
→ Strana C.8–14, Položky specifické pro urèitý typ dat 
Verze VE31D C.8–19 
únor 2006
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Konfigurace aplikací definovaných 
uživatelem C.8

Z nabídky Private Applications v prohlížeèi Patient Browser
mùžete ke zpracování údajù o pacientovi a data vyšetøení v 
syngo systému použít i jiné aplikace. V oknì Configure Private 
Applications mùžete tyto aplikace nastavit tak, aby je bylo 
možné použít v systému syngo. 

C.8

✧ V hlavní nabídce prohlížeèe Patient Browser zvolte položku 
Private Applications > Configure....

Zobrazí se dialogové okno Configure Private Applications. C.8

 

C.8–20 Návod k použití pro uživatele systému syngo
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Pøidání programu C.8

✧ Zadejte název, jímž chcete pojmenovat aplikaci v systému 
syngo do budoucna.

✧ Zadejte identifikaèní èíslo programu, pod nímž je aplikace 
registrována na vašem poèítaèi.

✧ Zadejte adresáø na pevném disku vašeho systému, do nìhož 
chcete odeslat data z Patient Browser. 

C.8 ✧ Kliknutím na tlaèítko OK pøidejte aplikaci do nabídky Private 
Applications. 
 

Verze VE31D C.8–21 
únor 2006
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Odebrání programu C.8 Všechny aplikace, které již ze systému syngo spouštìt nechcete, 
mùžete z nabídky Private Applications odebrat. C.8

✧ Zvolte položku Private Applications > Configure....

✧ V dialogovém oknì Configure Private Applications vyberte 
ze seznamu voleb Application Name pøíslušnou aplikaci.

C.8 ✧ Klepnìte na tlaèítko Delete a potvrïte odstranìní položky z 
nabídky Private Applications klepnutím na tlaèítko OK.
C.8–22 Návod k použití pro uživatele systému syngo
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D.1

 
Úvod D.1
Prohlížeè Media Browser vám umožòuje procházet zaøízení s 
výmìnnou pamìtí (napø. CD-ROM, DVD-R nebo MOD) a 
vyhledávat studie, série, obrazy nebo jakýkoli jiný typ dat. D.1

Pomocí Media Browser mùžete procházet data pacienta 
kliknutím na rùzné úrovnì dat. D.1

Mùžete data tøídit (napø. podle popisu studie nebo data studie) 
a filtrovat podle urèitých kritérií. 

D.1

Kdy vyhledat data pomocí 
Media Browser D.1

Media Browser použijte k výbìru jakýchkoli uložených dat na 
výmìnném pamì¤ovém médiu, takže mùžete postupnì: D.1

❏ Vyhledat pøedbìžné studie pacienta  
Údaje o pacientovi, které byly již vyšetøeny a archivovány, lze 
nalézt vyhledáním na archivaèních discích. Mùžete je pak 
buï naèíst na kartu úloh nebo pøenést (zkopírovat) do 
centrální databáze.

❏ Následnì zpracovat obrazy 
Mùžete naèíst obrazy na kartu úloh 3D nebo Viewing a 
prohlížet obrazy z pøedchozích studií pacienta bìhem 
vyšetøení, porovnat obrazy s aktuálními výsledky vyšetøení a 
následnì zpracovat obrazy po vyšetøení a opatøit výsledky 
komentáøem. 

❏ Exponovat obrazy na film nebo je vytisknout 
Obrazy pacienta uložené na výmìnném pamì¤ovém médiu 
mùžete vytisknout kvùli sestavení zprávy nebo 
dokumentace, nebo mùžete tyto obrazy exponovat na film.

❏ Pøenést data 
Data mùžete zkopírovat do centrální databáze nebo je 
odeslat do jiných sí¤ových uzlù (které nejsou pøipojeny k 
centrální databázi).
Verze VE31D D.1–1 
únor 2006   
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Úvod Media Browser
!0

D.1 D.1

Datová struktura D.1 Data na výmìnném pamì¤ovém médiu, napø. na CD-ROM nebo 
DVD-R, jsou uspoøádána do hierarchicky organizovaných skupin 
podle pacientù, studií, sérií a pøípadù (obrazy, nezpracovaná 
data, èasové prùbìhy vln atd.). D.1

Data v centrální databázi jsou uložena podle pacientù, studií, 
sérií a pøípadù. D.1

Obecnì jsou prvky hierarchických úrovní uvádìny jako datové 
objekty. 

D.1

Zabezpeèení v systému syngo zajiš¤uje, že pøístup k funkcím je 
vždy poskytnut v souladu s právy pøidìlenými uživateli. 
Proto v pøípadì, že nemùžete použít funkce na vybraných 
datech (napø. exponování dat), možná nemáte pøíslušná 
pøístupová práva. D.1
D.1–2 Návod k použití pro uživatele systému syngo
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Media Browser Úvod
Jednotky D.1

Media Browser vám pomùže získat pøehled o datech pacienta a 
vyšetøení uložených na výmìnném pamì¤ovém médiu. D.1

Zaøízení pro výmìnnou pamì¤ jsou zobrazeny jako ikony na levé 
stranì navigaèní oblasti.  

D.1

D.1 K vašemu systému je pøipojena jedna nebo více jednotek MOD, 
popøípadì jednotek CD. Ikony s názvy jednotek k nim poskytují 
rychlý pøístup. 
 

D.1

Datová média D.1 Podle nastavení jednotky v systému mùžete data naèítat z 
následujících médií: D.1

❏ MOD (magnetooptický disk) 3,5" a 5,25"

❏ CD nebo CD-R

❏ DVD-R

❏ diskety 3,5".

→ Strana F.2–2, Zálohování na místní datová média D.1

D.1
Verze VE31D D.1–3 
únor 2006
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Úvod Media Browser
Úrovnì dat D.1

Údaje týkající se pacienta a vyšetøení jsou v databázích a na 
externích datových médiích hierarchicky uspoøádána. Toto 
uspoøádání vám pomùže najít výsledky vyšetøení rychleji. D.1

(1) Jednotka
(2) Pacient
(3) Studie
(4) Série
(5) Pøípady 
D.1–4 Návod k použití pro uživatele systému syngo
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Media Browser Úvod
Pacient D.1 Data vyšetøení, která se vztahují k rùzným pacientùm, se v 
databázi ukládají podle jmen pacientù. 

D.1

Studie D.1 Studie je vyšetøení provádìné za úèelem nalezení odpovìdi na 
konkrétní otázku, zpravidla na základì doporuèení. Studie 
sestává z jedné nebo více sérií.  

D.1

Série D.1 Všechny snímky mìøení nebo operace zpracování snímkù jsou 
uspoøádány do sérií. 

D.1

Pøípady D.1

D.1 Na nejnižší úrovni (Instance Level) se ukládají jednotlivé 
snímky (obrázek vlevo) a v závislosti na modalitì sady dat, z 
nichž lze snímky generovat (napøíklad nezpracovaná data, 
obrázek uprostøed), a také tvary vln, 3D objekty a snímky s 
vícenásobným rámcem (obrázek vpravo). Všechny záznamy na 
úrovni Instance Level se obecnì oznaèují jako snímky. D.1
Verze VE31D D.1–5 
únor 2006
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Úvod Media Browser
Spuštìní Media Browser D.1

Okno Media Browser mùžete vyvolat buï z hlavní nabídky 
nebo pomocí klávesnice se symboly. Media Browser mùžete 
snadno spustit z kterékoli karty úloh. 

D.1

✧ Spus¤te Media Browser v hlavní nabídce karty úloh 3D nebo 
Filming volbou položky Patient > Media Browser....

Nebo D.1

D.1 ✧ Stisknìte tlaèítko Browser na èíselné klávesnici.
D.1–6 Návod k použití pro uživatele systému syngo
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Media Browser Úvod
Okno Media Browser D.1

Po spuštìní Media Browser se okno Media Browser zobrazí v 
popøedí. D.1

Okno je rozdìleno na rùzné oblasti zpracování, které umožòují 
pøehledný pøístup k datùm. D.1

(1) Øádek nabídek a panel nástrojù
(2) Navigaèní oblast
(3) Informaèní oblast
(4) Obsahová oblast
(5) Stavový øádek
Verze VE31D D.1–7 
únor 2006
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Úvod Media Browser
Strom a jednotlivé  
zobrazení D.1

Ve stromovém zobrazení Media Browser zobrazuje navigaèní 
oblast nahoøe a pod ní obsahovou oblast. D.1

V jednotlivém zobrazení se skládá z malé navigaèní oblasti a 
jednoho seznamu obsahu. 

D.1

Panel nástrojù D.1 S vybranými daty mùžete pracovat pomocí položek nabídky 
nebo tlaèítek s ikonami na panelu nástrojù. D.1

➭ Panel nástrojù mùžete skrýt odstranìním zaškrtnutí u položky 
View > Toolbar.  

Navigaèní oblast D.1 V navigaèní oblasti se graficky zobrazí nižší úrovnì dat, která se 
vztahují k vybraným databázím, pacientùm, vyšetøením a 
sériím. D.1

Pomocí myši mùžete zvolit pacienta, studii nebo sérii a pøíslušná 
data upravit nebo pøesunout do jiných aplikací. Pro každý výbìr, 
který se provádí v navigaèní oblasti, se nižší úrovnì dat zobrazují 
v obsahové oblasti. 

D.1

Informaèní oblast D.1 V informaèní oblasti se zobrazují struèné informace o pacientovi 
a vybrané studii. Když je navigaèní oblast skrytá, lze také zjistit, 
která databáze je otevøená a která úroveò dat je zobrazena. 
→ Strana D.1–12, Zobrazení a skrytí èástí okna D.1
D.1–8 Návod k použití pro uživatele systému syngo
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Media Browser Úvod
Obsahová oblast D.1 V obsahové oblasti najdete seznam studií èi postupù týkajících 
se pacienta, jehož jste vybrali v navigaèní oblasti. Vyberete-li 
nìkterou z nižších úrovní dat, zobrazí se uložené série nebo 
kroky postupu pro urèitou studii a uložené snímky nebo položky 
èinností pro urèitou sérii nebo krok postupu. D.1

V obsahové oblasti mùžete také vybrat údaje o pacientovi a 
vyšetøení za úèelem dalšího zpracování. D.1

➭ Mùžete pøepínat mezi zobrazením ve formì seznamu a 
zobrazením ve formì miniatur snímku. Miniatury oznaèují typ 
dat. 
→ Strana D.1–13, Zobrazení seznamù a miniatur obrazù 
v obsahové oblasti
Verze VE31D D.1–9 
únor 2006
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Úvod Media Browser
Uživatelské nastavení okna Media Browser D.1

Zobrazení okna Media Browser mùžete upravit a tak je 
maximálnì pøizpùsobit svému stylu práce. Mùžete napøíklad 
nìkteré oblasti zvìtšit, aby se v nich mohlo najednou zobrazit 
více údajù. 

D.1

Zmìna velikosti okna D.1 Okno Media Browser lze na obrazovce libovolnì zvìtšovat, 
zmenšovat nebo mìnit jeho polohu. 
→ Strana A.2–21, Zmìna velikosti a pøesouvání okna 
 

D.1
D.1–10 Návod k použití pro uživatele systému syngo
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Media Browser Úvod
Zvìtšování a zmenšování 
navigaèní a obsahové 
oblasti D.1

Výšku navigaèní i obsahové oblasti mùžete upravovat pomocí 
myši. Èím více zvìtšíte navigaèní oblast, tím menší bude 
obsahová oblast a naopak. D.1

D.1 ✧ Posuòte kurzor myši k okraji navigaèní oblasti. 
Kurzor se zmìní na malou svislou dvojitou šipku.

✧ Navigaèní oblast zvìtšíte a obsahovou oblast zmenšíte 
pøetažením ohranièení smìrem dolù.

Nebo D.1

✧ Navigaèní oblast zmenšíte a obsahovou oblast zvìtšíte 
pøetažením ohranièení smìrem nahoru.

➭ Pøi zobrazení miniatur obrazù je možné obsahovou oblast 
zvìtšovat nebo zmenšovat pouze v urèitých krocích, aby 
nedocházelo k neúplnému zobrazení miniatur obrazù. 
→ Strana D.1–13, Zobrazení seznamù a miniatur obrazù 
v obsahové oblasti
Verze VE31D D.1–11 
únor 2006
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Úvod Media Browser
Zobrazení a skrytí èástí oknaD.1 Abyste získali více prostoru v oknì Media Browser, mùžete 
skrýt panel nástrojù, navigaèní oblast nebo informaèní oblast. D.1

D.1 ✧ Chcete-li skrýt nebo zobrazit panel nástrojù, klepnìte na 
položku View > Toolbar.

✧ Chcete-li skrýt nebo zobrazit informaèní oblast, klepnìte na 
položku View > Info Area.

✧ Chcete-li skrýt nebo zobrazit datovou strukturu v navigaèní 
oblasti, klepnìte na položku View > Tree.

V obsahové oblasti se zobrazí úroveò dat. V navigaèní oblasti se 
zobrazí informace o tom, ke které databázi tyto záznamy patøí. 
→ Strana C.8–17, Jednotlivé pohledy obsahové oblasti D.1

➭ Pøi pøepnutí na strukturované/jednoduché zobrazení bude 
pøedchozí výbìr zrušen.

➭ Chcete-li pøepínat mezi databázemi v navigaèní oblasti, 
musíte je nejprve zobrazit ve stromové struktuøe. 
D.1–12 Návod k použití pro uživatele systému syngo
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Media Browser Úvod
Zobrazení seznamù a 
miniatur obrazù v obsahové 
oblasti D.1

Jestliže jste v navigaèní oblasti vybrali studii nebo sérii, zobrazí 
se v obsahové oblasti všechny pøíslušné série a snímky. Pomocí 
nabídky View mùžete pøepínat mezi zobrazením seznamu a 
miniatur snímkù. D.1

D.1 ✧ Po klepnutí na položku View > Image Stamps se série a 
snímky zobrazí v obsahové oblasti ve formì miniatur 
(položka nabídky bude zaškrtnutá) nebo ve formì seznamu 
(položka nabídky nebude zaškrtnutá).
Verze VE31D D.1–13 
únor 2006
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Úvod Media Browser
Zobrazení a skrytí databází a 
jednotek D.1

Jednotlivé databáze a jednotky mùžete v navigaèní oblasti 
zobrazit nebo skrýt podle toho, zda je potøebujete pro svou 
práci. D.1

✧ Dílèí nabídku otevøete aktivací položky View > Source.

✧ Vyberte databáze a jednotky, které chcete zobrazit v 
navigaèní oblasti ve formì ikon.
D.1–14 Návod k použití pro uživatele systému syngo

 0.0



Media Browser Úvod
Pøizpùsobení tabulky v 
obsahové oblasti D.1

Zobrazení údajù o pacientovi a vyšetøení v obsahové oblasti ve 
formì seznamu má podobu tabulky. U každého sloupce mùžete 
zmìnit pøedem nastavenou šíøku. D.1

✧ Kurzorem myši klepnìte na záhlaví tabulky v obsahové 
oblasti.

✧ Chcete-li sloupec rozšíøit, pøetáhnìte jeho pravé ohranièení 
doprava.

 

Verze VE31D D.1–15 
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Úvod Media Browser
Miniatury D.1

Je-li funkce View > Image Stamps aktivní, všechny datové 
objekty se zobrazí jako miniatury na úrovni obrazu/dat. D.1

Datové objekty zahrnují série nebo obrázky pacienta a sady dat, 
z nichž lze obrázky generovat (napøíklad nezpracovaná data,
trojrozmìrné objekty), i køivky (napøíklad køivky EKG) a texty. D.1

D.1 Když klepnete myší na miniaturu obrázku, bude objekt zvolen.  
Dvojitým kliknutím myší nebo pøetažením se data naètou na 
kartu úlohy, která se nachází v popøedí øady karet, napøíklad na 
kartu Viewing. 

D.1

Datové objekty D.1 Jedná se o výbìr možných datových objektù. (Rozsah možných 
objektù se s každou verzí softwaru neustále rozšiøuje.) D.1

Symbol D.1 Objekt D.1 Popis D.1

Obraz Snímek je zobrazen zmenšený.

Nezpracovaná 
data

Nezpracovaná data, na nichž je 
založen výpoèet obrázkù, jsou 
zastoupena symboly.

Standardní 
zpráva 
DICOM SR

Parametry vyšetøení a 
komentáøe k nìmu jsou uloženy 
ve zprávì o studie.

Zpráva o 
zvláštních 
aplikacích

Parametry vyšetøení a 
komentáøe k nìmu jsou uloženy 
ve zprávì o studie.
D.1–16 Návod k použití pro uživatele systému syngo
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Media Browser Úvod
Registraèní 
matrice fúze

Obsahuje souøadnice pro 
srovnání dvou sad obrazových 
dat.

Dráha letu Obsahuje trojrozmìrné 
souøadnice dráhy letu, 
vytvoøené a uložené bìhem 
relace virtuální endoskopie.

Trojrozmìrný 
objekt editoru

Sada dat trojrozmìrného 
objektu vytvoøené pomocí 
editoru 3D Object Editor.

Objekt 
radioterapie

Data týkající se objektù 
radioterapie jako jsou StructSets 
nebo Plan

Poškozený 
snímek

Obraz byl znièen, napø. když 
došlo k pøerušení naèítání 
obrazu.

Èerný obraz Èerné obrazy jsou zvláštní 
obrázy obsahující grafiku, 
tabulky, histogramy èi zprávy.

Naèítání obrazu Obraz se právì naèítá.

Grafické 
záznamy s 
èasovým 
prùbìhem

Data køivky, napøíklad køivek EKG 
a jiných fyziologických dat.

Náhled 
miniatur pro 
média

Náhled miniatur není k dispozici

Symbol D.1 Objekt D.1 Popis D.1
Verze VE31D D.1–17 
únor 2006
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Úvod Media Browser
Náhled miniatur pro média D.1

Lze zobrazit miniatury pro vybrané médium (napø. CD, DVD), 
jsou-li k dispozici. D.1

Náhled miniatur pro média lze kdykoli zapnout nebo vypnout. 
Nastavení se bude vztahovat na média, která se vloží poté, co se 
tato volba zmìní. 
Napø. jestliže CD1 byl vložen s volbou zapnutou, zobrazí se 
miniatury pro pøípady. Jestliže je volba vypnuta a vloží se CD2, 
miniatury se pro CD2 nezobrazí, ale pro CD1 se zobrazí. Když je 
CD1 vysunuto a znovu vloženo s vypnutou volbou, miniatury se 
nezobrazí. D.1

✧ V hlavní nabídce zvolte Options > Enable Image Stamp 
Preview for Media, aby se zobrazily dostupné miniatury.

➭ Jestliže jsou miniatury k dispozici a položka Enable Image 
Stamp Preview for Media není aktivována, ve stavovém 
øádku se zobrazí hlášení „Image stamp preview is switched 
off".

➭ Jestliže nejsou miniatury k dispozici a políèko Enable Image 
Stamp Preview for Media je aktivováno, ve stavovém øádku 
se zobrazí hlášení „Image stamp preview is not available".

➭ Zapnutím této volby se mùže zpomalit naèítání médií s velkým 
množstvím obrazù.

➭ Je-li tato volba vypnuta, CD-/DVD-R se naèítá rychleji.

D.1
D.1–18 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

D.2

Vyhledávání a zobrazování 
údajù o pacientovi D.2
V oknì Media Browser mùžete zobrazit všechny údaje o 
pacientovi a data vyšetøení uložená na externích archivaèních 
médiích. D.2

Údaje o pacientech mùžete vyhledávat, abyste mohli pacienta 
znovu vyšetøit nebo abyste mohli jeho obrazy revidovat, uložit 
nebo exponovat na film. D.2

Pøi vyhledávání údajù o pacientovi mùžete v oknì Media 
Browser procházet jednotlivými úrovnìmi údajù v oknì 
kliknutím myši nebo pomocí klávesnice. D.2

Vyhledávání mùžete urychlit seøazením zobrazených dat 
(napøíklad abecedním seøazením pøíjmení pacientù) nebo 
filtrováním zobrazených dat a zobrazením pouze urèité 
podmnožiny. D.2

V oknì Media Browser mùžete vyhledávat údaje o pacientovi 
kvùli vyhodnocení, zpracováni, tisku a pøenosu studií, které byly 
uloženy na výmìnných pamì¤ových discích. D.2
Verze VE31D D.2–1 
únor 2006   
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Vyhledávání a zobrazování údajù o pacientovi Media Browser
Zobrazování úrovní informací D.2

Pøi vyhledávání údajù o pacientech a vyšetøení se pohybujete v 
navigaèní oblasti pomocí myši; mùžete také v nabídce View
otevírat nižší úrovnì dat výbìrem položky Open Subtree. 

D.2

Zobrazení stromu dat D.2

D.2 ✧ Kliknutím na ikonu pacientova záznamu v navigaèní oblasti 
okna Media Browser zobrazíte úrovnì dat tohoto pacienta. 

Pouze první dílèí objekt se zobrazí až na nejnižší úroveò. D.2

V obsahové oblasti se zobrazí seznam všech studií, které jsou u 
daného pacienta k dispozici. D.2

✧ Klepnutím na jméno jiného pacienta skryjete stromovou 
strukturu dat prvního pacienta a zobrazíte místo nìj úrovnì 
informací týkajících se druhého pacienta.
D.2–2 Návod k použití pro uživatele systému syngo
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Media Browser Vyhledávání a zobrazování údajù o pacientovi
Otevøení stromové struktury 
dat D.2

D.2 ✧ V navigaèní oblasti vyberte záznam. 
 

✧ Zvolením položky nabídky View > Open Subtree zobrazíte 
všechny záznamy s nižšími úrovnìmi dat (otevøete celou 
stromovou strukturu dat).

Nebo D.2

D.2 ✧ Na panelu nástrojù kliknìte na toto tlaèítko. 
 

Nebo D.2

D.2 ✧ Pravým tlaèítkem myši (nebo klávesovou zkratkou 
Shift + F10) otevøete místní nabídku a kliknìte na položku 
Open Subtree. 

➭ Funkce Open Subtree je zvláš¤ užiteèná v pøípadì, že jste 
vybrali nìkolik pacientù najednou.

➭ Když vyberete ikonu jednotky, zùstanou položka nabídky 
Open Subtree a tlaèítko neaktivní. Na této úrovni není možné 
strom datových složek otevøít. 

Zavøení dílèí stromové 
struktury D.2

✧ Zvolením položky View > Close Subtree v hlavní nabídce 
nebo položky Close Subtree v místní nabídce nižší úrovnì 
informací znovu zavøete.
Verze VE31D D.2–3 
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Vyhledávání a zobrazování údajù o pacientovi Media Browser
Aktualizace zobrazení 
databází D.2

Zmìny a doplnìní záznamù v databázi, které provedete na své 
pracovní stanici nebo které jsou provedeny prostøednictvím sítì, 
se zobrazují v oknì Media Browser automaticky. Pokud je 
automatický proces opoždìn, mùžete tuto aktualizaci zahájit i 
ruènì. D.2

✧ Zvolením položky View > Refresh aktualizujte zobrazení v 
navigaèní a obsahové oblasti.

Nebo D.2

D.2 ✧ Kliknìte na toto tlaèítko. 
 

D.2
D.2–4 Návod k použití pro uživatele systému syngo
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Procházení údajù o pacientovi a 
jejich výbìr D.2

Mùžete vyhledávat data vyšetøení pacienta za úèelem jejich 
dalšího zpracování. D.2

➭ Pokud pozdìji okno Media Browser otevøete znovu, zobrazí 
se s naposledy nastaveným zobrazením.

Nyní v navigaèní oblasti vyberte jednotku a vyhledejte 
požadovaného pacienta. Otevírejte nižší úrovnì informací, 
dokud nenajdete hledaná data pøíslušného pacienta. D.2
Verze VE31D D.2–5 
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Režim seznamu D.2 Pokud je v navigaèní oblasti vybrána série s velkým množstvím 
obrazù, všechny atributy se zobrazí ve viditelné èásti obsahové 
oblasti. Pro zbývající obrazy jsou viditelná pouze aktuální kritéria 
tøídìní. D.2

Pokud procházíte obsahovou oblastí, zobrazí se zbývající 
atributy. Jetliže budete procházet rychle, zobrazí se pouze 
aktuální kritéria tøídìní. Zbývající atributy jsou prázdné. Když se 
zastavíte na urèité stránce, tj. když zpomalíte procházení, 
zobrazí se atributy obrazù ve viditelné oblasti. D.2

Režim miniatur D.2 V režimu miniatur se zobrazí miniatury pouze pro viditelné 
obrazy. Jestliže miniatury nebyly vyhledány, pro každou 
miniaturu se zobrazí výchozí miniatura. D.2

➭ I když nejsou pro nìkteré obrazy k dispozici podrobné 
informace, všechny operace, jako je mazání, naètení do 
prohlížeèe, export, jsou možné.

D.2
D.2–6 Návod k použití pro uživatele systému syngo
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Media Browser Vyhledávání a zobrazování údajù o pacientovi
Pøíklad D.2 Pokud chcete napøíklad vybrat urèité snímky pacienta ke 
zpracování, mùžete postupnì otevírat úrovnì informací 
pacient, studie a série, dokud nebudou požadované snímky 
uvedeny nebo zobrazeny (jako miniatury) v obsahové oblasti. D.2

D.2 ✧ V navigaèní oblasti kliknìte na ikonu jednotky, v níž je 
pacient uložen.

✧ V pøípadì potøeby procházejte seznamem pacientù pomocí 
posuvníku, dokud nenajdete požadovaného pacienta.

➭ Hledaného pacienta najdete ještì rychleji, pokud na 
klávesnici stisknete klávesu s prvním písmenem pacientova 
jména. Pak se zobrazí záznam prvního pacienta, jehož jméno 
zaèíná poèáteèním písmenem. 

D.2 ✧ Klepnutím na jméno hledaného pacienta v navigaèní oblasti 
zobrazíte úrovnì informací, které jsou u tohoto pacienta 
uloženy jako ikony. Všechny studie tohoto pacienta se 
zobrazí v obsahové oblasti.

D.2 ✧ Kliknutím na studii v navigaèní oblasti ji vyberete a zobrazíte 
všechny pøidružené série. 

D.2 ✧ Kliknutím na sérii v navigaèní oblasti tuto sérii vyberete a v 
obsahové oblasti zobrazíte pøehled všech obrazù v ní 
obsažených. 

D.2 ✧ Klepnutím na snímek v obsahové oblasti jej vyberete.
Verze VE31D D.2–7 
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Vyhledávání a zobrazování údajù o pacientovi Media Browser
D.2 ➭ Podle toho, zda jste kliknuli na položku View > Image 
Stamps, se série a obrazy v obsahové oblasti zobrazí jako 
miniatury nebo ve formì seznamu. 
→ Strana D.1–10, Uživatelské nastavení okna Media Browser 
 

Výbìr dat pomocí klávesniceD.2 Pomocí klávesnice mùžete velmi rychle vyhledat rùzné datové 
záznamy v oknì Media Browser. Pøiøazení kláves pro možnosti 
výbìru v aktivní oblasti (navigaèní nebo obsahové) je shrnuto v 
následující tabulce. D.2

D.2

➭ Pokud souèasnì stisknete klávesu Ctrl, záznam nebude 
vybrán. Pokud ho budete chtít vybrat, stisknìte mezerník. 

Klávesa Výbìr Klávesa Výbìr

Home 
(Domù)

První záznam End (Konec) Poslední 
záznam

Page up 
(Strana 
nahoru)

První viditelný 
záznam

Page down 
(Strana dolù)

Poslední 
viditelný 
záznam

↑ Posun o jeden
øádek nahoru 
(tatáž úroveò)

Posun o jeden
øádek dolù 

(tatáž úroveò)

← Záznam vlevo 
(o úroveò výš v 

navigaèní 
oblasti)

Záznam 
vpravo (o 

úroveò níž v 
navigaèní 
oblasti)

Tab 
nebo

Shift + Tab

Pøepnutí mezi 
navigaèní a 
obsahovou 

oblastí

Písmeno První záznam 
zaèínající 

odpovídajícím 
písmenem
D.2–8 Návod k použití pro uživatele systému syngo
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Media Browser Vyhledávání a zobrazování údajù o pacientovi
Vícenásobný výbìr D.2 Mùžete také vybrat nìkolik pacientù najednou (pokud napøíklad 
chcete archivovat jejich data) nebo nìkolik snímkù jednoho 
pacienta (chcete-li je zkontrolovat). D.2

✧ Požadované záznamy pacientù nebo data vyšetøení oznaète v 
navigaèní nebo obsahové oblasti myší a podržením klávesy 
Ctrl. 
→ Strana A.2–14, Výbìr nìkolika objektù

Nebo D.2

✧ Vyberte první požadovaný záznam v navigaèní nebo 
obsahové oblasti. Podržte klávesu Shift a rozšiøte výbìr 
pomocí klávesnice. 
→ Strana D.2–8, Výbìr dat pomocí klávesnice

➭ Snímky se pøesunou na kartu úloh ve stejném poøadí, ve 
kterém byly vybrány.

➭ Vícenásobný výbìr je možný pouze na jedné úrovni dat ve 
stromové struktuøe. Vybraná data musejí patøit ke stejnému 
záznamu na další nejvyšší úrovni dat (napøíklad nìkolik sérií 
jedné studie, ale ne nìkolik sérií rùzných studií).
Verze VE31D D.2–9 
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Oznaèení dat z vyšetøení D.2

Pomocí prohlížeèe Media Browser mùžete oznaèit nìkteré 
položky údajù o pacientovi nebo vyšetøení, takže je pozdìji 
nebudete muset zdlouhavì vyhledávat a zpracovávat. D.2

➭ Pomocí nabídky Filter mùžete vyhledávat pouze oznaèená 
data.  
→ Strana D.2–11, Filtrování dat 

Oznaèení položek D.2 ✧ V navigaèní nebo obsahové oblasti vyberte jednoho nebo 
více pacientù, studií, sérií nebo obrazù. 

✧ Abyste oznaèili vybrané údaje o pacientovi a data vyšetøení, 
zvolte v hlavní nabídce okna Media Browser položku Edit > 
Mark.

Nebo D.2

D.2 ✧ Stisknìte klávesu Mark na klávesnici se symboly (Num 3). 
 
 
 

Zobrazení oznaèených dat D.2

D.2 V obsahové oblasti poznáte oznaèené údaje o pacientovi a data 
z vyšetøení podle písmena M zadaného v seznamu ve sloupci 
Mark Status. 

D.2

Zrušení oznaèení položek D.2 ✧ V navigaèní nebo obsahové oblasti vyberte data, jejichž 
oznaèení chcete zrušit.

✧ Zvolte položku Edit > Unmark.
D.2–10 Návod k použití pro uživatele systému syngo
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Filtrování dat D.2

Pokud je objekt dat v navigaèní a obsahové oblasti velmi 
obsáhlý, mùžete vyhledávání údajù o pacientovi zjednodušit 
filtrováním dat. Tak mùžete zobrazit jen urèitý výbìr pacientù, 
studií, sérií èi snímkù. D.2

Pro prohlížeè Media Browser nejsou k dispozici pøedem urèené 
filtry, kromì Marked a Not Marked. Musíte definovat svoje 
vlastní filtry. Potom budou k dispozici v nabídce Filter. 

D.2

Použití standardních filtrù D.2

Pøi filtrování dat mùžete použít kritéria filtrování standardnì 
nabízená vaším systémem. Tato kritéria jsou dostupná z øádku 
nabídek nebo pomocí tlaèítek na panelu nástrojù. D.2

✧ V nabídce Filter okna Media Browser vyberte jedno z kritérií 
filtrování.

Tyto výchozí filtry vyhodnocují stav nebo oznaèení dat na všech 
datových úrovních. D.2

Nebo D.2

✧ Zvolte standardní filtr pomocí panelu nástrojù.

D.2 Filter Not Marked 
Zobrazí se pouze data, která nejsou oznaèena. 

D.2

D.2 Filter Marked 
Zobrazí se jen oznaèená data. 

D.2
Verze VE31D D.2–11 
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Vyhledávání a zobrazování údajù o pacientovi Media Browser
Vytvoøení filtru definovaného uživatelem D.2

V oknì Media Browser mùžete také vytvoøit vlastní kritéria 
filtrování a filtrovat databázi na základì kombinace cílových 
položek. D.2

Pokud zvolíte obecnìjší definici filtrù, budete je moci èastìji 
používat k rychlému a bezproblémovému zobrazení urèité dílèí 
skupiny dat. D.2

Pokud nadefinujete velmi specifické filtry, budete moci 
vyhledávat údaje o pacientovi a data vyšetøení pøímo a s 
úsporou èasu. D.2
D.2–12 Návod k použití pro uživatele systému syngo
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Vytvoøení filtru D.2 ✧ Zvolte položku Options > Filter Settings....

Zobrazí se dialogové okno Filter Specification se vstupními poli 
pro název filtru a pìt kritérií filtrování. D.2

 

✧ Do pole Filter Name zadejte vhodný název filtru, pod kterým 
bude váš filtr uveden.
Verze VE31D D.2–13 
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Vyhledávání a zobrazování údajù o pacientovi Media Browser
D.2 ✧ Vyberte jedno z kritérií filtrování uvedených ve výbìrovém 
seznamu. 

Podle zvoleného kritéria se zobrazí vstupní pole kombinovaná s 
operátory and, or nebo From ... to, nebo kritérium nebude mít 
žádné dodateèné vstupní pole. 
 
 

D.2

 

✧ Zadejte cílové položky do vstupního pole spolu s operátorem 
„or", z nichž alespoò jedna musí být splnìna. 

✧ Zadejte cílové položky do vstupních polí spolu s operátorem 
„and". Zde musejí být všechny splnìny. 

✧ Do vstupních polí kombinovaných s operátorem „From - to" 
zadejte rozsah, v nìmž musejí být hledaná data obsažena.
D.2–14 Návod k použití pro uživatele systému syngo
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Pøíklad filtru definovaného 
uživatelem D.2

Následující filtr definovaný uživatelem byl vytvoøen pro 
vyhledání urèité série vyšetøení hrudníku v databázi. D.2

 

Na základì tohoto filtru budou vybrány pouze oznaèené série, 
které již byly dokonèeny, nafilmovány a archivovány a které byly 
vytvoøeny s polohou øezu mezi 0 a 100. D.2
Verze VE31D D.2–15 
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Uložení filtru D.2

D.2 ✧ Filtr uložíte klepnutím na tlaèítko OK. Poté se znovu zobrazí 
okno Media Browser.

Nebo D.2

D.2 ✧ Kliknutím na tlaèítko Cancel se vrátíte do okna Media 
Browser bez uložení nového filtru. 
 
 

Použití filtrù definovaných 
uživatelem D.2

Filtry definované uživatelem jsou umístìny v nabídce Filter jako 
dodateèné položky nabídky. D.2

D.2 ✧ Mùžete napøíklad zvolit položku Filter > Marked 1 a 
pøefiltrovat všechna data podle zadaných kritérií.
D.2–16 Návod k použití pro uživatele systému syngo
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Odstraòování uživatelských 
filtrù D.2

Když už nìkterý filtr definovaný uživatelem nepotøebujete, 
mùžete ho z nabídky Filter odstranit, aby tato nabídka zùstávala 
pøehledná. D.2

✧ Otevøete dialogové okno Filter a ve výbìrovém seznamu 
vedle položky Filter Name vyberte filtr, který chcete smazat.

 

D.2 ✧ Kliknutím na tlaèítko Delete odstraníte filtr ze seznamu. 

✧ V pøípadì potøeby vyberte z výbìrového seznamu další filtry 
a odstraòte je stejným zpùsobem.

D.2 ✧ Poté klepnutím na tlaèítko OK odstranìní filtru potvrïte. 

Poté se znovu zobrazí okno Media Browser. D.2

Nebo D.2

D.2 ✧ Klepnutím na tlaèítko Cancel zachováte všechny filtry v 
nezmìnìné podobì.
Verze VE31D D.2–17 
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Deaktivace filtru D.2

Filtr zùstává aktivní, dokud jej nenahradíte jiným filtrem. D.2

D.2 Na stavovém øádku se zobrazí informace o tom, který filtr se 
právì používá. D.2

➭ Pokud okno Media Browser zavøete a poté znovu otevøete, 
bude naposledy vybraný filtr stále aktivní. 

D.2 ✧ Zvolením položky Filter > Off nebo kliknutím na tlaèítko s 
pøíslušnou ikonou znovu zobrazíte data (nefiltrovaná). 
 
 

D.2
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Seøezení dat D.2

Data zobrazená v oknì Media Browser mùžete seøadit podle 
rùzných kritérií. To vám umožní seøadit data v urèitém sledu a 
usnadní nalézt urèité údaje o pacientovi nebo vyšetøení. D.2

✧ V navigaèní oblasti zvolte úroveò údajù, abyste mohli 
zobrazit pacienty, studie, série nebo snímky, které chcete 
seøadit, v obsahové oblasti.

Nabídka Sort D.2

D.2 ✧ Otevøete nabídku Sort. 

V závislosti na úrovni dat zobrazené v obsahové oblasti budete 
mít k dispozici rùzná kritéria tøídìní. D.2

✧ Klepnìte na jedno z uvedených kritérií.

V závislosti na zvoleném kritériu se data v obsahové oblasti 
seøadí podle abecedy, chronologicky nebo podle toho, zda bylo 
kritérium øazení splnìno úplnì, èásteènì èi vùbec ne. D.2

✧ Zvolením položky Sort > Reverse Order mùžete poøadí 
obrátit. 

➭ Také v navigaèní oblasti se data seøadí podle stejného kritéria 
jako v obsahové oblasti.

➭ Pokud zvolené poøadí øazení nelze uplatnit, použije se 
automaticky následující výchozí poøadí:

❏ jméno pacienta
❏ popis studie
❏ èíslo série
❏ èíslo pøípadu
Verze VE31D D.2–19 
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Tisk seznamu dat D.2

Pokud je systém pøipojen k tiskárnì, lze data vyšetøení 
vytisknout ve formì seznamu. Pøi tisku se zobrazí informace 
uvedené v obsahové oblasti. D.2

✧ V obsahové oblasti zobrazte požadované údaje o pacientovi 
a vyšetøení. 
→ Strana D.2–5, Procházení údajù o pacientovi a jejich výbìr

➭ Pokud chcete vytisknout obsahovou oblast, mùžete pracovat 
ve stromové struktuøe i v jednoduchém zobrazení. 
→ Strana D.1–12, Zobrazení a skrytí èástí okna 
 

Zobrazení  
náhledu pro tisk D.2

✧ Po zvolení položky Patient > Print Preview se výtisk zobrazí 
v náhledu.

D.2 ✧ Náhled tisku zavøete kliknutím na tlaèítko Close window. 

➭ Jestliže je obsahová oblast v režimu miniatur, zobrazení 
náhledu pro tisk není možný.
D.2–20 Návod k použití pro uživatele systému syngo
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Tisk seznamu D.2 ✧ Chcete-li vytisknout seznam dat v obsahové oblasti, zvolte 
položku Patient > Print List.

U seznamu pacientù je v záhlaví výtisku uveden obsah a datum 
vytvoøení seznamu. U všech dalších úrovní dat se rovnìž 
vytiskne obsah informaèní oblasti. D.2

➭ Tento seznam se vždy vytiskne v anglickém jazyce.

Zmìna nastavení tiskárny D.2 Nastavení tiskárny (napøíklad okraje stránky) mùžete zmìnit v 
dialogovém oknì pro tisk v systému Windows XP. D.2

✧ Zvolte položku Patient > Print... a v zobrazeném dialogovém 
oknì proveïte požadovaná nastavení.

D.2 ✧ Nová nastavení potvrïte klepnutím na tlaèítko OK.

D.2
Verze VE31D D.2–21 
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D.2–22 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

D.3

Pøenos dat do 
jiných aplikací D.3
V oknì Media Browser jste našli požadované údaje týkající se 
urèitého pacienta a vyšetøení a chcete nyní tato data využít v 
jiné aplikaci. D.3

❏ Chcete pacienta vyšetøit znovu.

❏ Chcete si prohlédnout a zkontrolovat uložené obrazy 
pacienta.

❏ Chcete snímky u zvláštních diagnostických problémù 
zpracovat a vyhodnotit trojrozmìrnì.

❏ Chcete zpracovat data týkající se urèitého pacienta a 
vyšetøení v jiných programech, které jste nastavili.

❏ Mùžete obrazy pomocí Media Browser exponovat na film 
pro vytvoøení dokumentace nebo zpráv. 
Verze VE31D D.3–1 
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Pøenos dat do jiných aplikací Media Browser
Prohlížení a zpracování snímkù D.3

Pomocí Media Browser mùžete pøenášet obrazy jednoho nebo 
více pacientù na kartu úloh Viewing, prohlížet je a upravovat. 

D.3

Podle toho, na které úrovni dat se nacházíte, mùžete na kartu 
Viewing pøevést následující snímkový materiál: D.3

❏ všechny snímky jednoho nebo více pacientù,

❏ všechny snímky jedné nebo více studií,

❏ všechny snímky jedné nebo více sérií,

❏ jeden snímek nebo více než jeden snímek.

K pøevádìní snímkù na kartu úlohy Viewing mùžete použít 
øádek nabídek nebo panel nástrojù. Lze také jednoduše 
poklepat na snímky nebo je pøetáhnout na kartu úlohy Viewing
myší. D.3
D.3–2 Návod k použití pro uživatele systému syngo
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Media Browser Pøenos dat do jiných aplikací
Všechny snímky pacienta, 
studie nebo série D.3

✧ V navigaèní nebo obsahové oblasti prohlížeèe Media 
Browser vyberte pacienta, studii nebo sérii.

D.3 ✧ Vyberte položku Patient > Load to Viewing nebo kliknìte na 
tlaèítko na panelu nástrojù; pøíslušné obrazy budou 
pøeneseny na kartu úloh Viewing SCR.

Nebo D.3

✧ Aktivujte položku Patient > Copy to Film Sheet nebo 
kliknìte na ikonu.

Nebo D.3

✧ Aktivujte položky 3D z nabídky Applications nebo kliknìte 
na ikonu.

Kvùli lepší identifikaci je jméno pacienta zobrazeno tuènì. D.3

Chcete-li naèíst druhou sérii obrazù na kartu 3D Fusion, vyberte 
ji a zvolte položku nabídky Applications > 3D > Fusion nebo 
kliknìte na ikonu. D.3

✧ Kliknìte na kartu Viewing SCR v horní sadì karet.

✧ Potom poklepejte na požadovaný datový objekt. Mùžete také 
vybrat data pomocí klávesnice a stisknout klávesu Return.

➭ Pomocí vícenásobného výbìru v navigaèní nebo obsahové 
oblasti pøenesete obrazy více než jednoho pacienta, studie 
nebo série na kartu úloh Viewing SCR.  
→ Strana D.2–9, Vícenásobný výbìr 
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Pøenos dat do jiných aplikací Media Browser
Pøetažení D.3 Kromì výše popsaných zpùsobù mùžete pøenášet obrazy na 
kartu úloh Viewing SCR také pøetažením myší. Tímto 
zpùsobem mùžete urèit, ve kterém segmentu se má první z 
vybraných snímkù zobrazit. D.3

✧ Zmenšete a pøípadnì pøesuòte okno Media Browser, abyste 
vidìli obrazovou oblast karty úloh Viewing SCR.

✧ Pøetáhnìte vybrané obrazy do požadovaného segmentu na 
kartì úloh Viewing SCR.

➭ Jestliže karta úlohy není v popøedí, mùžete snímky pøetáhnout 
též z prohlížeèe Browser na odpovídající záložku. Karta úlohy 
se pøesune do popøedí a snímky se naètou do oblasti snímkù.

Zavøení po naètení D.3

D.3 Pokud jste vybrali nastavení Close after Loading v nabídce 
Options, okno Media Browser se po pøenosu obrazù zavøe. D.3

✧ Tuto funkci lze aktivovat pomocí položky Options > Close 
after Loading. 

Pokud tato volba není zatržena, okno Media Browser zùstává v 
popøedí i poté, co jste naèetli obrazy do karty Viewing. Chcete-
li obrazy zpracovat, mùžete vždy pøejít ruènì na kartu úloh 
Viewing. D.3

D.3 ✧ Kliknìte na tlaèítko Close v pravém horním rohu okna Media 
Browser. 

Na kartì úlohy Viewing mùžete pøenesené snímky prohlížet a 
upravovat. D.3
D.3–4 Návod k použití pro uživatele systému syngo
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Media Browser Pøenos dat do jiných aplikací
Trojrozmìrné zpracování snímkù D.3

Jako výsledek vyšetøení získáte obrazy urèitého objemu. 
Dvourozmìrné øezy vhodné série mùžete kombinovat a vytvoøit 
tak trojrozmìrné zobrazení požadované oblasti, které mùžete 
zpracovat a vyhodnotit na kartì úlohy 3D. D.3

✧ V navigaèní nebo obsahové oblasti Media Browser vyberte 
pacienta nebo jednu èi nìkolik pøíslušných studií, sérií èi 
obrazù (alespoò 4). 

D.3 ✧ Kliknìte na ikonu tlaèítka, abyste zahájili zpracování obrazu 
metodou multiplanární rekonstrukce (MPR). 

Nebo D.3

D.3 ✧ Kliknìte na ikonu tlaèítka, abyste zahájili zpracování obrazu v 
režimu Side by Side (Fusion). 

D.3

Pokud jste vybrali více než jednu vhodnou sérii nebo sérii 
mimoøádnì velkou, zobrazí se dialogové okno 3D Series List. 
Jakmile v nìm urèíte sérii, budete moci provést trojrozmìrné 
zpracování obrazu na kartì úloh 3D. 
→ Kapitola J.2, Pøenos obrazù do 3D D.3

Jestliže jsou souèasnì naèteny dva datové soubory od jednoho 
nebo dvou pacientù stejné modality, použije se režim Compare. 
Na každém monitoru se zobrazí jeden datový soubor. 
Datové soubory jsou ve vzájemném vztahu, tj. jakákoli akce 
provedená na jednom datovém souboru bude provedena 
rovnìž na druhém datovém souboru. 

D.3
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Pøenos dat do jiných aplikací Media Browser
Osobní aplikace D.3

Prostøednictvím hlavní nabídky Private Applications prohlížeèe 
Media Browser mùžete také využít funkce nebo jiné aplikaèní 
programy systému syngo. D.3

V prohlížeèi Media Browser mùžete vybrat údaje o pacientovi a 
data vyšetøení a pøenést je do programù, které chcete použít pro 
další zpracování. 

D.3

Pøenášení dat do jiné 
aplikace D.3

✧ V navigaèní nebo obsahové oblasti Media Browser vyberte 
data, která chcete zpracovat.

✧ Otevøete nabídku Private Applications a klepnìte na 
požadovanou položku programu.

Data vybraná v oknì Media Browser budou naètena do apli-
kaèního programu. 

D.3
D.3–6 Návod k použití pro uživatele systému syngo
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Media Browser Pøenos dat do jiných aplikací
Zobrazení aplikaèního 
programu D.3

✧ Zvolte položku Private Applications > Switch to.... 

Zobrazí se dialogové okno Show Applications se seznamem 
všech nakonfigurovaných aplikaèních programù. D.3

 

✧ Z tohoto seznamu vyberte program, do nìhož jste pøenesli 
údaje o pacientovi a data vyšetøení.

D.3 ✧ Klepnutím na tlaèítko Show aktivujte daný aplikaèní 
program.

Uživatelské rozhraní programu se pøesune do popøedí. Naètené 
údaje o pacientovi a vyšetøení mùžete zpracovávat pomocí 
funkcí, které jsou na nìm k dispozici. D.3
Verze VE31D D.3–7 
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Pøenos dat do jiných aplikací Media Browser
Odesílání dat pomocí sítì D.3

Pokud je systém pøipojen k síti, mùžete odeslat údaje o 
pacientovi i data vyšetøení na jinou pracovní stanici 
prostøednictvím sítì pomocí funkce Send to.... D.3

✧ V navigaèní nebo obsahové oblasti prohlížeèe Media 
Browser vyberte pacienta, studii, sérii nebo obrazy. 

D.3 ✧ Stisknìte klávesu Send to na klávesnici se symboly. 
 
 

Nebo D.3

✧ Vyvoláním položky Transfer > Send to... exportujte data na 
pøedem nakonfigurované adresy v síti.

Nebo D.3

D.3 ✧ Kliknìte na tlaèítko s ikonou na panelu nástrojù. 

Otevøe se dialogové okno Send To. D.3

✧ Zde vyberte požadovanou sí¤ovou adresu (adresy).

D.3 ✧ Klepnutím na tlaèítko Send odešlete vybraná data na 
požadovanou adresu (adresy).

Data budou odeslána na zvolenou adresu. D.3
D.3–8 Návod k použití pro uživatele systému syngo
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Media Browser Pøenos dat do jiných aplikací
Exponování na film D.3

Media Browser mùžete používat k odesílání jednotlivých nebo 
všech obrazù jednoho nebo nìkolika pacientù, studií èi sérií na 
kartu úloh Filming. 

D.3

Pøenos snímkù na kartu 
Filming D.3

✧ V navigaèní nebo obsahové oblasti vyberte pøíslušná data. 

D.3 ✧ Aktivujte položku Patient > Copy to Film Sheet nebo 
klepnìte na tlaèítko s ikonou.

Nebo D.3

D.3 ✧ Stisknìte klávesu Copy to Film Sheet na klávesnici se 
symboly. 
 

Nebo D.3

✧ Kliknìte na kartu Filming v horní èást sady a dvojitì kliknìte 
na položky, které chcete v oknì Media Browser exponovat 
na film.

Nebo D.3

✧ Pøetáhnìte myší výbìr na kartu úloh Filming. 
Stejnì jako pøi naèítání obrazù na kartu úloh Viewing mùžete 
urèit, ve kterém segmentu filmového listu se mají obrazy 
objevit. 
→ Strana D.3–4, Pøetažení
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Pøenos dat do jiných aplikací Media Browser
Nìkterým z výše uvedených pøíkazù jsou všechny vybrané 
obrazy pøeneseny na kartu úloh Filming. Podle toho, zda tam 
byla aktivována položka Auto Expose se obrazy exponují na 
film okamžitì, jakmile je filmový list plný, nebo se nejdøíve 
shromáždí do filmové úlohy. 
→ Kapitola G.2, Automatické/manuální exponování na film 
 

D.3

Náhled exponování na filmD.3 ✧ Náhled, který znázoròuje zpùsob exponování obrazù na film 
nebo vytisknutí, zobrazíte pomocí položky Patient > Film 
Preview....

Nebo D.3

D.3 ✧ Kliknìte na tlaèítko s ikonou Film Preview na panelu 
nástrojù. 
 
 
 

D.3–10 Návod k použití pro uživatele systému syngo
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Media Browser Pøenos dat do jiných aplikací
Exponování snímkù na filmD.3 Obrazy pacienta, které jste shromáždili ve filmové úloze, 
mùžete exponovat nebo tisknout z okna Media Browser. K 
tomu není nutné zobrazovat kartu úloh Filming. D.3

✧ Aktivujte položku Patient > Expose Film Task a pøeneste 
všechny snímky této úlohy zpracování filmu do kamery nebo 
tiskárny.

Nebo D.3

D.3 ✧ Klepnìte na tlaèítko s ikonou na panelu nástrojù.

➭ Pokud jste na kartu úloh Filming pøenesli obrazy nìkolika 
pacientù, takže existuje více než jedna úloha zpracování 
filmu, zobrazí se dialogové okno. V tomto dialogovém oknì 
mùžete vybrat úlohu zpracování filmu, kterou chcete 
exponovat na film nebo vytisknout na papír. 
→ Strana G.2–13, Volba úlohy zpracování filmu

➭ „Multiframe obrazy” nemùžete exponovat pøímo z okna 
Media Browser. Nejdøíve je musíte naèíst na kartu úloh 
Viewing. 
→ Strana E.6–12, Exponování obrazù na film/tisk obrazù 
Verze VE31D D.3–11 
únor 2006

 0.0



Pøenos dat do jiných aplikací Media Browser
Stav úlohy zpracování 
filmu D.3

Je možné zobrazit pøehled všech úloh zpracování filmu, které již 
byly odeslány na kameru nebo tiskárnu, a zmìnit napøíklad 
poøadí, v nìmž mají být zpracovány.  
→ Strana G.5–3, Zobrazení a manipulace s úlohami zpracování 
filmu 

D.3

✧ Pomocí položky Patient > Film Task Status... zobrazte 
dialogové okno Film Task Status se seznamem všech 
nedokonèených úloh zpracování filmu.

Nebo D.3

D.3 ✧ Klepnìte na tlaèítko s ikonou na panelu nástrojù.

D.3

D.3

D.3
D.3–12 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

E.1

 
Úvod E.1
Na kartì úlohy Viewing mùžete zobrazovat výsledky vyšetøení a 
hodnotit je nebo je pøipravovat pro diagnostiku. E.1

Pomocí karty úloh Viewing mùžete též porovnávat obrazový 
materiál z rùzných vyšetøení téhož pacienta a pokud to 
umožòuje konfigurace, i materiál rùzných pacientù. 

E.1

Naètení a zobrazení  
obrázkù E.1

Nejdøíve mùžete naèíst obrazy pomocí Patient Browser nebo z 
karty úloh 3D do karty úloh Viewing. Zde mùžete vybrat jeden 
z rùzných zpùsobù, jak uspoøádat obrazový materiál a zobrazit 
jej nejzøetelnìjším zpùsobem z hlediska svého diagnostického 
problému. 

E.1

Zpracovávání a 
vyhodnocování snímkù E.1

Na kartì úlohy Viewing mùžete snímky zpracovávat a 
vyhodnocovat následujícím zpùsobem: E.1

❏ Mùžete mìnit hodnoty vyvážení, zvìtšovat, posunovat, 
otáèet a pøeklápìt snímky.

❏ Mùžete zvýraznit oblasti zájmu (ROI) pomocí kreslicích 
nástrojù (kruhy, obdélníky, èáry), opatøit je textovým 
komentáøem a statisticky je vyhodnotit (pouze CT a MR).

❏ Mùžete zobrazit namìøené hodnoty obrazových bodù nebo 
rozsahù a mìøit na obrazech vzdálenosti a úhly. 

Ukládání, poøizování a 
posílání snímkù E.1

Pak mùžete zpracované a vyhodnocené obrazy uložit, 
vytisknout èi exponovat na film nebo je poslat na jiná místa 
nemocnice. 

E.1
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Úvod Prohlížení
Otevøení karty úlohy Viewing E.1

Jakmile naètete snímky na kartu úlohy Viewing, pøemístí se tato 
karta do popøedí. Mùžete také kdykoli pøepnout do jiné aplikace 
a ve zpracovávání obrazù na kartì úloh Viewing pokraèovat 
pozdìji. 

E.1

E.1 ✧ Pokud není karta úloh Viewing právì v popøedí, mùžete ji 
aktivovat kliknutím na tlaèítko na pravém okraji obrazovky. 
 

Karta úlohy Viewing je rozdìlena do ètyø hlavních oblastí: E.1
E.1–2 Návod k použití pro uživatele systému syngo
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Prohlížení Úvod
(1) Obrazová oblast
(2) Ovládací oblast
(3) Stavový øádek pro systémová hlášení
(4) Øádek nabídek se speciálními položkami pro prohlížení a 

zpracovávání obrazù

(4) E.1

(3) E.1

(2) E.1(1) E.1
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Úvod Prohlížení
Obrazová oblast E.1

V této oblasti se zobrazují snímky, které byly naèteny na kartu 
úlohy Viewing. V závislosti na rozdìlení obrazovky a poètu 
naètených snímkù se mùže stát, že se zobrazí jen nìkteré z nich. 
Zbývající obrazy jsou skryty na pozadí. 
 

E.1

Rozvržení obrazové oblasti E.1 Oblast snímku je dále rozdìlena do segmentù. V každém 
segmentu je zobrazen jeden snímek. E.1

Podle toho, zda chcete mít pøehled o naètených snímcích nebo 
požadujete takové zobrazení, aby jste mohli stanovit diagnozu, 
mùžete zvolit mezi dvìma typy rozvržení: E.1

❏ V malém formátu rozvržení se zobrazí více snímkù najednou.

❏ Ve velkém formátu rozvržení lze zobrazit najednou jen malý 
poèet snímkù, tyto snímky jsou však dostateènì velké, aby na 
nich bylo možno rozeznat detaily.

 

Rozvržení velkého  
formátu

Rozvržení malého  
formátu
E.1–4 Návod k použití pro uživatele systému syngo
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Prohlížení Úvod
Snímek, text a grafické 
objekty E.1

V oblasti snímku se zobrazují lékaøské snímky. Tyto snímky 
mohou obsahovat i textové informace o pacientovi a dané 
studii, které jsou uloženy v systému. E.1

Obrazy mohou být též opatøeny grafickými prvky (oblasti zájmu, 
mìøení a podobnì) a textovými poznámkami, které jsou 
souèástí zpracování na kartì úloh Viewing. 

E.1

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lékaøský obraz s textem a  
grafickými prvky

Lékaøský snímek se 
zobrazenými údaji o studii

Lékaøský snímek bez textu a 
grafických prvkù
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Úvod Prohlížení
Orientace snímku E.1 Na okraji každého snímku jsou patrné orientaèní znaèky. Tyto 
znaèky vždy ukazují aktuální orientaci snímku; po otoèení èi 
zrcadlovém pøevrácení snímku lze tedy ihned zjistit, v jakém 
vztahu jsou strany snímku vùèi tìlu pacienta. E.1

Písmena mají následující význam: E.1

❏ L znamená vlevo,
❏ R znamená vpravo,
❏ A znamená vpøedu,
❏ P znamená vzadu,
❏ H znamená hlavu,
❏ F znamená nohy. 

➭ U obrazù, které nejsou zobrazeny anatomicky standardním 
zpùsobem (napøíklad šikmé øezy), jsou orientaèní znaèky 
složeny ze dvou èi tøí písmen. 
→ Strana J.3–2, Souøadný systém pacienta

A

R
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Prohlížení Úvod
Ovládací oblast E.1

V ovládací oblasti najdete všechny nástroje, které potøebujete 
pro výbìr snímkového materiálu, jeho uspoøádání na obrazovce 
a zpracování snímkù. E.1

Odsud také mùžete øídit výmìnu dat s jinými èástmi programu 
a spouštìt další aplikace. E.1

Tyto funkce mùžete snadno aktivovat pomocí tlaèítek a 
pracovat tak mnohem rychleji, než je to možné prostøednictvím 
øádku nabídek.  
 

E.1

Informace o pacientovi E.1

E.1 V horní èásti øídící oblasti si mùžete zkontrolovat jména 
pacientù, jejichž obrazy jsou v dané chvíli naèteny do karty úloh 
Viewing. Až tøi pacienti (podle konfigurace systému) lze naèíst 
do karty úloh Viewing najednou ve standardním režimu a 
dokonce více v režimu porovnávání studií. E.1

Odsud lze zvolit data snímkù pacienta, která se chystáte 
zpracovávat. E.1

Z otevøené složky pacienta je patrné, ke kterému pacientovi 
patøí snímky zobrazené v oblasti snímku. E.1
Verze VE31D E.1–7 
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Úvod Prohlížení
E.1 ➭ Jestliže se rozhodnete pro porovnání dat z vyšetøení rùzných 
pacientù, bude tato skupinová složka oznaèena jmény 
naètených pacientù (napøíklad "Majer, Novák", pokud skupina 
obsahuje data dvou pacientù, nebo "Majer, Novák, ...", pokud 
obsahuje data tøí èi více pacientù).

➭ U delších jmen se zobrazí pouze jejich zaèátek. 
E.1–8 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení Úvod
Karty dílèích úloh E.1 Na kartách dílèích úloh jsou zobrazena tlaèítka, která slouží k 
aktivaci nástrojù pro zpracování, stanovení režimu zobrazení, 
pøenášení obrazových dat a pøecházení do jiných aplikací. 

E.1

 
 
 
 

E.1

Øada karet ve støedu ovládací oblasti obsahuje karty dílèích úloh 
Tools, Image a View. E.1

❏ Karta v sadì nalevo se jmenuje Tools a obsahuje tlaèítka pro 
vyhodnocování a komentování snímkù. 

❏ Na prostøední kartì Image se nacházejí tlaèítka pro 
zpracovávání snímkù. 

❏ Pravá karta View obsahuje tlaèítka, jimiž se nastavuje 
rozvržení. 
 

 
 
 
 

E.1

Na kartì dílèí úlohy Patient v dolní èásti ovládací oblasti se 
nacházejí tlaèítka, jejichž pomocí lze snímky filmovat a tisknout 
snímky (napøíklad za úèelem zpracování) nebo odesílat na jiné 
pracovní stanice. E.1

Odsud také mùžete pøímo spustit aplikaci Patient Registration
nebo Patient Browser. E.1

V závislosti na konfiguraci systému se zde mùže nacházet jedna 
nebo dvì další karty dílèích úloh, napøíklad karta Scroll s tlaèítky 
pro procházení. E.1
Verze VE31D E.1–9 
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Úvod Prohlížení
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KAPITOLA 0.0

E.2

Naètení a zobrazení 
snímkù E.2
Na kartì úlohy Viewing mùžete prohlížet a zpracovávat snímky, 
které jsou uloženy v místní databázi systému, a archivovat je na 
rùzných médiích nebo na síti. E.2

Tato data jsou pøístupná v oknì Patient Browser. Mùžete 
vyhledávat pacienty, studie, série èi jednotlivé snímky a naèítat 
je na kartu úlohy Viewing. E.2

Snímky a série mùžete také pøesunout na kartu úlohy Viewing
z jiných karet úloh. E.2

E.2
Verze VE31D E.2–1 
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Naètení a zobrazení snímkù Prohlížení
Pøenos snímkù pomocí prohlížeèe 
Patient Browser E.2

Obrazová data, která jste uložili do místní databáze nebo do 
archivu, mùžete vyhledávat pomocí prohlížeèe Patient Browser
a pak je naèítat na kartu úlohy Viewing. E.2

Po naètení snímkového materiálu se rozhodnete, zda budete 
prohlížet èi vyhodnocovat snímky èi série jednoho pacienta, 
nebo porovnávat snímkový materiál rùzných pacientù. Pøeneste 
data pacienta do složky pacienta. Jestliže chcete porovnávat 
výsledky vyšetøení rùzných pacientù, vytvoøte skupinovou 
složku. 

E.2

➭ Na kartu úloh Viewing nelze naèítat nezpracovaná data, 
pacienty s nerekonstruovanými nezpracovanými daty a 
zprávy. 
E.2–2 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení Naètení a zobrazení snímkù
Vytvoøení složky pacienta E.2

Jestliže chcete prohlížet a vyhodnotit obrazy pacienta, pøeneste 
je do složky pacienta na kartì úloh Viewing. 

E.2

✧ Klepnutím na záložku karty úlohy Viewing umístìte tuto 
kartu do popøedí.

V této chvíli je karta úlohy dosud prázdná. E.2

✧ Otevøete okno Patient Browser (Patient > Browser...).

✧ Vyhledejte požadované pacienty, studie èi série nebo jeden èi 
více obrazù v navigaèní nebo obsahové oblasti. 

✧ Poklepejte na jeden èi více záznamù, které jste vyhledali; tyto 
záznamy budou naèteny na kartu úlohy Viewing.

Nebo E.2

E.2 ✧ Vyberte záznamy a aktivujte položku Patient > Load to 
Viewing, nebo klepnìte na tlaèítko Load to Viewing na 
panelu nástrojù.
Verze VE31D E.2–3 
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Naètení a zobrazení snímkù Prohlížení
Nebo E.2

✧ Vybraný objekt na kartu úlohy Viewing pøetáhnìte myší 
(pøetažení).
E.2–4 Návod k použití pro uživatele systému syngo
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Prohlížení Naètení a zobrazení snímkù
E.2 ➭ Pøed naètením dat snímkù pacienta pomocí pøetažení musíte 
nejprve otevøít novou (prázdnou) složku pacienta. Obrazy 
jakékoli složky pacienta, která je již otevøená, jsou jinak 
odstranìny z karty Viewing, pokud není tato složka v režimu 
Multi View. 
Jestliže pøetáhnete obrazy do složky (øežim Multi View), 
pøidají se ke stávajícím obrazùm. 
→ Strana E.2–10, Naètení složky 

➭ Jestliže karta úlohy není v popøedí, mùžete snímky pøetáhnout 
též z prohlížeèe Browser na odpovídající záložku. Karta úlohy 
se pøesune do popøedí a obrazy se naètou do obrazové oblasti. 

Zavøení po naètení E.2 Okno Patient Browser se zavøe, pokud jste aktivovali volbu 
Closed after Loading. 
→ Strana C.3–6, Uzavøení po naètení E.2

➭ Pokud obrazy naèítáte pøetažením, Browser zùstane 
otevøený. 
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Naètení a zobrazení snímkù Prohlížení
Zastavení naèítání E.2 Naèítání rozsáhlé série s velkým poètem snímkù mùže trvat 
velice dlouho. Indikátor prùbìhu akce ukazuje, jak daleko 
naèítání pokroèilo. E.2

 

Naèítání mùžete zastavit. E.2

E.2 ✧ Klepnìte na tlaèítko Cancel.

➭ Obrazy, které se již naèetly, se zobrazí na kartì aplikace 
Viewing. 

Snímky nového pacienta se nyní zobrazí na kartì úlohy Viewing
ve skupinách podle vyšetøení a sérií. E.2

E.2

Naèítání obrazù 
s vícenásobným rámcem E.2

Pøi naèítání snímkù s vícenásobným rámcem program s každým 
vícenásobným rámcem zachází jako se sérií. Pokud naètete sérii 
skládající se z nìkolika obrazù s vícenásobným rámcem, každý 
obraz s vícenásobným rámcem a každý normální obraz bude 
naèten jako samostatná série. 

E.2

Naèítání barevných snímkùE.2 Na kartu úlohy Viewing lze naèítat i barevné snímky (True Color 
a Pseudo Color). Jestliže snímek nelze zobrazit, objeví se 
chybové hlášení. E.2

✧ Obra¤te se na správce systému. 
E.2–6 Návod k použití pro uživatele systému syngo
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Prohlížení Naètení a zobrazení snímkù
Naèítání snímkù dalšího 
pacienta (v závislosti na 
konfiguraci) E.2

Než zaènete první naètené snímky vyhodnocovat, mùžete 
nejprve pøenést data všech vyšetøení a pacientù, která chcete na 
kartì úlohy Viewing prohlížet a upravovat v rámci jedné relace.E.2

✧ Klepnutím na zavøenou složku pacienta horní èásti ovládací 
oblasti karty úlohy Viewing tuto složku otevøete.

✧ V prohlížeèi Patient Browser vyberte snímky dalšího 
pacienta a pøesuòte je na kartu úlohy Viewing (pøetažením).

Nové snímky se pøenesou do otevøené složky. Vedle otevøené 
složky se zobrazí jméno pacienta. 
 

E.2
Verze VE31D E.2–7 
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Naètení a zobrazení snímkù Prohlížení
Na kartì úlohy Viewing mùžete spravovat snímky až tøí 
pacientù (nastavení lze konfigurovat). Jestliže naètete snímky 
ètvrtého pacienta, složka pacienta, kterou jste otevøeli jako 
první, se opìt zavøe. Pokud chcete snímky tohoto pacienta opìt 
zpracovávat, musíte je znovu naèíst. E.2

 

Pacient A 
10:05

Pacient B 
10:20

Pacient C 
10:50

Pacient D

Pacient B

Pacient C

Naèíst  
pacienta D

Otevøen jako 
první 
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Prohlížení Naètení a zobrazení snímkù
Naèítání dalších  
snímkù/sérií E.2

Do složky urèitého pacienta mùžete kdykoli pøidat další snímky, 
série a vyšetøení. E.2

✧ Na kartì úlohy Viewing otevøete složku pacienta, do níž 
chcete naèíst dodateèný snímkový materiál.

✧ Otevøete prohlížeè Patient Browser a vyberte dodateèný 
snímkový materiál pacienta, jehož data již byla naètena.

E.2 ✧ Tyto obrazy pøetáhnìte dvojitým kliknutím myší nebo 
pomocí položky Patient > Load to Viewing. Mùžete také 
kliknout na tlaèítko Load to Viewing na panelu nástrojù 
nebo obrazy pøetáhnout myší. 

Program snímky umístí do požadovaných složek pacienta a 
pøipojí je ke snímkovému materiálu, který již obsahují (studie ke 
studiím, série k sériím a snímky ke snímkùm). E.2

➭ Snímky ze sérií èi studií, které se již na kartì Viewing
nacházejí, se již podruhé nenaètou. Místo toho se zobrazí 
hlášení, že tyto snímky byly pøi naèítání vynechány: “Already 
loaded images skipped”.
Verze VE31D E.2–9 
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Naètení a zobrazení snímkù Prohlížení
Vytvoøení skupinové složky E.2

Jestliže chcete porovnat na kartì úlohy Viewing výsledky 
rùzných pacientù, vytvoøte nejprve skupinovou složku. E.2

Název této skupinové složky je tvoøen jmény pacientù, jejichž 
data obsahuje (Majer, Novák, ...). 

E.2

Naètení složky E.2 ✧ Spus¤te prohlížeè Patient Browser.

✧ V prohlížeèi vyberte všechny pacienty, série a vyšetøení, které 
chcete na kartì úlohy Viewing porovnávat.

✧ Tato data pak pøetáhnìte myší na kartu Viewing.

Nebo E.2

E.2 ✧ Dvojitì kliknìte na obrazy myší. Mùžete je také pøenést 
pomocí funkce Patient > Load to Viewing nebo kliknout na 
tlaèítko Load to Viewing na panelu nástrojù. 

Program automaticky vytvoøí skupinovou složku a pøepne se do 
režimu Multi View, v nìmž je možné porovnávat rùzné studie.E.2

Rovnìž mùžete naèíst údaje o pacientech do již existující složky 
pacienta. E.2

✧ Pøepnìte složku do režimu pohledu multi view.

✧ Pomocí pøetažení myší naètìte údaje o dalším pacientovi.

Tyto údaje o pacientovi budou pøipojeny k existujícím údajùm a 
z existující složky se tak stane skupinová složka. E.2
E.2–10 Návod k použití pro uživatele systému syngo
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Prohlížení Naètení a zobrazení snímkù
Zobrazování snímkù a sérií E.2

Po naètení snímkù na kartu úlohy Viewing si mùžete vybrat 
mezi dvìma typy pohledu. E.2

Tak mùžete uspoøádat obrazový materiál zpùsobem, jenž bude 
nejlépe vyhovovat danému diagnostickému problému. 
 
 

E.2

Normální režim a režim porovnávání studií E.2

Pokud jste naèetli nìkolik vyšetøení pacienta na kartu úlohy 
Viewing, snímky tìchto studií a sérií se nejprve zobrazí 
postupnì, poèínaje snímky studie, která byla naètena jako první. 
Jestliže si chcete prohlédnout obrazy z dalších vyšetøení, musíte 
se na nì pøesunout. 
→ Strana E.3–2, Procházení E.2

Jestliže chcete porovnávat výsledky rùzných vyšetøení, která se 
naèetla pøímo, mùžete pøepnout z bìžného režimu do režimu 
porovnávání studií. E.2

E.2 ✧ Zvolením položky View > Multi View aktivujte režim 
porovnávání studií.

V tomto pohledu se obrazovka rozdìlí na oblasti, v nichž se 
budou pod sebou zobrazovat výsledky rùzných vyšetøení. E.2
Verze VE31D E.2–11 
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Naètení a zobrazení snímkù Prohlížení
✧ Do bìžného režimu se vrátíte zrušením výbìru položky View 
> Multi View nebo opìtovným kliknutím na pøíslušné 
tlaèítko. 

➭ Pokud jste pøi naèítání snímkù vytvoøili skupinovou složku (tj. 
pokud jste do jedné složky naèetli data vyšetøení více 
pacientù), je již aktivován režim porovnávání studií. V 
takovém pøípadì k bìžnému režimu pøejít nelze.

S1A1 S1A2

S1A5

PozadíObrazová oblast

S1B1

S1A3 S1A4

S1B2 S2A1

S2A2 S2B1

S3A1 S3A2

S2B2 S2B3

S3A3 S3B1

S3B2 S3B3

S4A1 S4A2

S3C1 S3C2

S4A3 S4B1

S4B2 S4B3

S4C2 S4C3

S4B4 S4C1

S4C4 S4C5

View > Multi View

S1A1 S1A2

S2A1 S2A2

S1A3 S1A4

S2B1 S2B2

S3A1 S3A2

S4A1 S4A2

S3A3 S3B1

S4A3 S4B1

S1A5 S1B1

S2B3

S1B2

S3B2 S3B3

S4B2 S4B3

S3C1 S3C2

S4B4 S4C1 ...

Studie 1

Studie 2

Studie 3

Studie 4
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Prohlížení Naètení a zobrazení snímkù
Zobrazení pásu a sad snímkù E.2

Lékaøské snímky se vždy zobrazují v oblasti snímku na kartì 
úlohy Viewing ve skupinách podle studií èi sérií. E.2

Podle toho, zda chcete prohlížet èi vyhodnocovat jednotlivé 
snímky série nebo porovnávat rùzné série mezi sebou, si mùžete 
vybrat mezi pohledem pásu a pohledem sad snímkù. E.2

Mùžete pøepínat z jednoho pohledu do druhého. 
 

E.2

Zobrazení pásu obrazù E.2 Pokud vyberete pás snímkù, budete si moci naètenou sérii 
studie prohlížet snímek po snímku. E.2

✧ Tento režim zobrazení lze aktivovat pomocí funkce View > 
Stripe.

Nebo E.2

E.2 ✧ Kliknìte na tlaèítko Stripe na kartì dílèí úlohy View. 
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Naètení a zobrazení snímkù Prohlížení
E.2 V bìžném režimu se nyní obrazy série, která byla naètena jako 
první, zobrazí v obrazové oblasti (první obraz se zobrazí vlevo 
nahoøe, poslední vpravo dole). 

E.2

Pokud se naète více než jedna série pacienta, zobrazí se jako 
první obrazy série A. Budete-li si chtít prohlédnout obrazy 
ostatních sérií, musíte je posunout a zobrazit. 

E.2

 

V režimu porovnávání studií se v první øadì zobrazí snímky z 
vyšetøení, jehož data byla naètena jako první (jako první se 
zobrazí první snímek první série). V druhé øadì se zobrazí 
snímky z druhého vyšetøení atd. E.2

Všechny snímky i série z vyšetøení, které se již nemohou v 
oblasti snímku zobrazit zleva doprava, budou umístìny na 
pozadí. Pokud chcete tyto snímky zobrazit, musíte se na nì 
pøesunout. E.2

 

A4

A1

A1 A2

A3

PozadíObrazová  
oblast

A4

A5 A6

B1 B2

C4 C5

C6

B3 C1

C2 C3

S1A1 S1A2

S2A1

PozadíObrazová  
oblast

S2A2

S1A3 S1A4

S2A3 S2B1

S1B3 S1B4

S2B4

S1B1 S1B2

S2B2 S2B3

Studie 1

Studie 2
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Prohlížení Naètení a zobrazení snímkù
Zobrazení sad E.2 Pokud chcete porovnávat snímky z rùzných sérií jedné studie, je 
nejlepší zobrazení sad. E.2

✧ Tento režim zobrazení lze aktivovat pomocí funkce View > 
Stack.

Nebo E.2

E.2 ✧ Kliknìte na tlaèítko Stack na kartì dílèí úlohy View. 
 
 

E.2 Všechny snímky urèité série jsou nyní uloženy v sadì jeden na 
druhém. Zobrazí se vždy první snímek z každé série. E.2

Jestliže se v bìžném režimu naète více než jedna série pacienta, 
snímky tìchto sérií budou uspoøádány do sad, které budou 
zaèínat vlevo nahoøe a konèit vpravo dole. Každá sada má 
záložky pro procházení. E.2

✧ Klepnutím na horní nebo spodní èást (vnitøní nebo vnìjší 
trojúhelník) záložky zobrazíte následující nebo pøedchozí 
snímek. 

Takto mùžete porovnávat kterýkoli snímek urèité série s 
libovolným snímkem jiné naètené série. E.2
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Naètení a zobrazení snímkù Prohlížení
E.2  

V režimu srovnávání studií se naètené série rùzných vyšetøení 
opìt ukládají do sad. Také zde mùžete pomocí záložek 
procházet sériemi a porovnávat rùzné snímky. E.2

 

A1 B1

C1

Obrazová oblast

A1 B3

C6

Zobrazení pøi prvním 
naètení

Možné druhy zobrazení 
pro úèely srovnávání

Obrazová oblast

Procházení 
sériemi B a C

Studie 1

Studie 2

S1A1 S1B1

S2A1

S1A1 S1B3

S2A4

Procházení vyšetøením 
1, série B

Procházení vyšetøením 
2, série A
E.2–16 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení Naètení a zobrazení snímkù
Rozèlenìní obrazové oblasti E.2

Rozdìlením oblasti snímku stanovíte poèet a velikost segmentù 
v oblasti snímku. E.2

Chcete-li prostudovat diagnostické detaily, zvolte velký formát 
zobrazení, kdy je na obrazovce jen nìkolik snímkù. Chcete-li 
získat celkový pøehled, vyberte zobrazení malého formátu. 

E.2

E.2 ✧ Vyberte uspoøádání v nabídce View. 
Aktuální zobrazení se nyní oznaèí zaškrtnutím. 
 
 
 

Nebo E.2

✧ Vyberte rozvržení pomocí tlaèítek na kartì dílèí úlohy View.
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Naètení a zobrazení snímkù Prohlížení
Když vyberete nové rozvržení, rozdìlení oblasti snímku se 
zmìní, ale sled zobrazených snímkù zùstane stejný. E.2

Jestliže vyberete obrazy døíve než nové rozvržení, uvidíte 
naètené obrazy v novém pohledu (poèínaje prvním vybraným 
obrazem). 
→ Strana E.3–32, Výbìr snímkù E.2

➭ V režimu porovnávání studií se používají rùzná rozvržení. 
Rozvržení bez porovnání jsou neaktivní. 
 

Zmìna rozvržení pro  
zobrazení pruhu obrazù E.2

 

A1 A2 A3

A4 A5 A6

B1 B2 B3

A1 A2

A3 A4

Zmìna rozvržení v bìžném režimu bez explicitnì vybraného 
obrazu (se zamìøením vstupu)

A1 A2 A3

A4 A5 A6

B1 B2 B3

A3 A4

A5 A6

Zmìna rozvržení v normálním režimu s explicitnì vybraným 
obrazem  
Poslední výbìr A3 (bez zamìøení vstupu)
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Prohlížení Naètení a zobrazení snímkù
 S1A1  S1A2  S1A3

 S2A1  S2A2  S2A3

 S3A1  S3A2  S3B1

S1A2 S1A3

S2A1 S2A2

Zmìna rozvržení v režimu porovnávání studií bez explicitnì vybraného obrazu  
(se zamìøením vstupu)

Studie 1

Studie 2

Studie 3

Studie 1

Studie 2

 S1A1  S1A2  S1A3

 S2A1  S2A2  S2A3

 S3A1  S3A2  S3B1

S1A3 S1A4

S2A2 S2A3

Zmìna rozvržení v režimu porovnávání studií po explicitním výbìru obrazù  
(bez zamìøení vstupu)

Studie 1

Studie 2

Studie 3

Studie 1

Studie 2
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Zmìna rozvržení u zobrazení 
sad E.2

 

A1 B1

C1 D1

A1 B1 C1 D1

E1 F1

Zmìna rozvržení v bìžném režimu bez explicitnì vybraného 
obrazu (se zamìøením vstupu)

G1

G1

Zmìna rozvržení v bìžném režimu s explicitnì vybraným 
snímkem (bez zamìøení vstupu)

A1 B1

C1 D1

C1 D1 E1 F1
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S1A1 S1B1

S2A1 S2B1

S1A1 S1B1 S1C1 S1D1

S2A1 S2B1

Zmìna rozvržení v režimu srovnávání studií se zamìøením vstupu

S2C1Studie 1

Studie 2

Studie 1

Studie 2

S3A1 S3B1 S3C1

S4A1 S4B1

S3D1Studie 3

Studie 4

Zmìna rozvržení v režimu srovnávání studií s explicitnì vybranými sériemi

S1A1 S1B1

S2A1 S2B1

Studie 1

Studie 2

S2C1 S2D1

S3B1 S3C1

S4A1 S4B1

S3D1

Studie 2

Studie 3

Studie 4

Studie 5

S2B1

S3A1

S5A1 S5A1
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Zobrazení a skrytí textu snímku E.2

Informace a nastavení snímkù specifická pro daného pacienta a 
danou studii mohou též být zobrazena na snímcích, aby bylo 
jednodušší každý snímek urèit. Text k obrazu lze též exponovat 
na film/vytisknout, takže tyto informace lze použít pro 
dokumentaci. 

E.2

Textové bloky E.2 Zobrazené informace jsou uspoøádány do blokù kolem okraje 
snímku podle svého obsahu. E.2

 

(1) Údaje o pacientovi a koeficient zvìtšení
(2) Orientaèní znaèky 

→ Strana E.1–6, Orientace snímku
(3) Informace o nemocnici/systému
(4) Nastavení specifická pro poøizování snímku, napøíklad sklon 

gantry
(5) Poznámky ke snímku
(6) Hodnoty vyvážení a orientaèní krychle (u prostorových 

snímkù)
(7) Mìøítko (pouze u snímkù typu CT a MR)

(2)

(2)

(1)

(4) (6)

(3)

(5)

(7)
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Prohlížení Naètení a zobrazení snímkù
Skrytí textu obrazu E.2 Zejména pøi rozvržení s malým dìlením mùže text ke snímkùm 
pùsobit rušivì. Mùžete se rozhodnout, zda text snímku 
ponecháte zobrazený nebo zda jej skryjete. E.2

✧ Vyvolejte v hlavní nabídce View > All Text, jestliže chcete 
zobrazit všechny texty k obrazùm.

Nebo E.2

✧ Zvolením položky View > No Text skryjte všechny texty k 
obrazùm, mìøítko, orientaèní znaèky a indikátor pro obrazy 
se ztrátovou kompresí.

Nebo E.2

✧ Vyvolejte View > Customized Text, pokud chcete zobrazit 
jen nejpodstatnìjší informace k obrazùm.

Pomocí funkce Image Text Editor lze na konfiguraèním panelu 
vybrat text, který se má zobrazit spolu s volbou Customized 
Text. 
→ Strana A.4–8, Konfigurace textu snímkù 

E.2

Volba „No Text" také skryje indikátor pro obrazy se ztrátovou 
kompresí. Ztrátovì komprimované obrazy nemají 
diagnostickou kvalitu. Mohou chybìt diagnostické informace. E.2

E.2
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únor 2006

 0.0



Naètení a zobrazení snímkù Prohlížení
E.2–24 Návod k použití pro uživatele systému syngo

 0.0



KAPITOLA 0.0

E.3

Procházení a výbìr 
obrázkù E.3
Zpravidla budete mít na kartì úlohy Viewing naèteno více 
snímkù a sérií urèitého pacienta, než je možné v oblasti snímku 
najednou zobrazit. Všechny snímky, které nebude možné kvùli 
nedostatku prostoru zobrazit, zùstanou v pozadí. E.3

Naètené obrazy pacienta mùžete procházet; získáte tak celkový 
pøehled a budete si moci vybrat ty obrazy, které chcete 
zpracovávat a vyhodnocovat. 

E.3

Karta úlohy Viewing nabízí nejen možnost ruèního procházení, 
ale také funkci automatického rychlého procházení. Vzniká tak 
dojem pøehrávaného filmu. Funkce Movie nabízí zvláštní 
výhody pøi prohlížení dynamických sérií, protože je takto možné 
zvláštì jasnì zobrazit procesy, které se mìní v prùbìhu èasu. E.3
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Procházení a výbìr obrázkù Prohlížení
Procházení E.3

Karta úlohy Viewing nabízí nìkolik alternativních zpùsobù 
procházení naètenými obrazy rùzných pacientù, studií èi sérií: 

E.3

(1) Nabídka Scroll

(2) Posuvník na pravé nebo levé stranì oblasti snímku  
(v závislosti na konfiguraci)

(3) Tlaèítka na kartì dílèí úlohy View v ovládací oblasti  
(v závislosti na konfiguraci)

(4) Záložky v pravém horním rohu obrazù 
(pokud máte zvoleno zobrazení sad)

(5) Klávesnice a klávesnice se symboly

Zvolte jednu z výše uvedených metod procházení snímkù podle 
toho, v jakém kroku zpracování se nacházíte a na jaké metody 
práce jste zvyklí. E.3
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(1)E.3

(2) E.3

(3) E.3

(4) E.3
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Procházení a výbìr obrázkù Prohlížení
Postupné procházení jednotlivými snímky E.3

V rámci jedné studie mùžete postupnì procházet naètenými 
obrazy a sériemi. 
 

E.3

Postupné procházení 
jednotlivými snímky pøi 
zobrazení pásu snímkù E.3

✧ Chcete-li procházet jednotlivými snímky dopøedu nebo 
dozadu, aktivujte funkci Scroll > Image Next nebo Scroll > 
Image Previous.

Nebo E.3

E.3 ✧ Procházejte snímky pomocí klávesy Image+ (Num 2) nebo 
klávesy Image- (Num 1) na klávesnici se symboly.

➭ Explicitnì zvolené snímky zùstanou souèástí výbìru i po 
pøesunutí do pozadí.

Provedete-li funkci Image+, snímek z levého horního segmentu 
se pøesune do pozadí. Všechny následující snímky se pøesunou 
o jeden segment. Jeden snímek z pozadí se pøesune do pravého 
spodního segmentu. Jestliže není v pozadí již žádný snímek, 
segment zùstane prázdný. E.3

Pøi aktivaci funkce Image- bude tento proces probíhat 
obrácenì; snímek z pozadí pøesune do levého horního 
segmentu. E.3
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Postupné procházení 
jednotlivými snímky v sadì 
snímkù E.3

Jestliže jste vybrali zobrazení sad, mùžete buï sadami 
procházet pomocí všech výše uvedených metod, nebo mùžete 
použít záložky, které se nacházejí v rohu jednotlivých sad. E.3

✧ Klepnìte myší na sadu, kterou chcete procházet.

✧ Procházejte jednotlivými snímky v sadách pomocí klávesy 
Image+ a Image- (stejným zpùsobem jako pøi zobrazení pásu 
snímkù).

Nebo E.3

✧ Klepnutím na horní nebo dolní èást záložky lze procházet 
jednotlivými snímky dopøedu nebo dozadu.

 

➭ Když chcete sadou obrázkù procházet rychle, klepnìte na 
záložku a podržte tlaèítko myši stisknuté.

➭ Explicitnì vybrané snímky zùstanou souèástí výbìru.

Image+

Image-
Verze VE31D E.3–5 
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Postupné procházení 
jednotlivými snímky v 
nìkolika sadách E.3

Pøejete-li si porovnávat obrazy rùzných sérií, mùžete simultánnì 
procházet jednotlivými obrazy v nìkolika sadách. 

E.3

✧ Stisknìte klávesu Ctrl a klepnìte na sady, jimiž chcete 
procházet. Pøi opakovaném klepnutí na sadu dojde ke zrušení 
jejího výbìru.

✧ Pomocí nabídky Scroll nebo tlaèítek na klávesnici se symboly 
procházejte jednotlivými snímky ve vybraných sadách 
dopøedu (Image+) nebo dozadu (Image-).

➭ Jestliže jste žádnou sadu nevybrali, budete procházet pouze 
tou sadou, která byla doposud aktuální.

➭ Pomocí záložek mùžete procházet vždy pouze jednou sadou 
najednou.

 

A1 B1

C1

A2 B1

C2

Image+
E.3–6 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení Procházení a výbìr obrázkù
Procházení po stránkách E.3

Stránka popisuje obsah oblasti snímku v urèitém okamžiku. 
Mùže obsahovat rùzný poèet segmentù podle toho, jaké 
rozvržení je zvoleno, a mùže obsahovat pouze snímky jedné 
série nebo snímky více sérií podle toho, v jakém režimu jsou 
snímky zobrazeny. E.3

K procházení sérií èi studií mùžete použít nabídku, klávesnici 
nebo posuvník. 
 

E.3

Procházení pomocí nabídkyE.3 ✧ Chcete-li postoupit o jednu stránku dopøedu, zvolte funkci 
Scroll > Page Down.

✧ Chcete-li postoupit o jednu stránku zpìt, zvolte funkci Scroll 
> Page Up.

✧ Chcete-li postoupit na poslední stránku složky aktuálního 
pacienta, zvolte funkci Scroll > Last Page.

✧ Chcete-li pøejít zpìt na první stránku aktuální složky pacienta, 
zvolte funkci Scroll > First Page. 
První obraz série se zobrazí v levém horním segmentu 
obrazové oblasti.
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Listování pomocí 
klávesnice E.3

Alternativou k pøíkazùm z nabídky je procházení pomocí 
klávesnice. E.3

✧ Chcete-li postoupit o jednu položku dopøedu, stisknìte 
klávesu Page Down.

✧ Chcete-li postoupit o jednu položku zpìt, stisknìte klávesu 
Page Up.

✧ Chcete-li zobrazit poslední stránku všech naètených obrazù, 
stisknìte klávesu End.

✧ Chcete-li pøejít na první stránku všech naètených obrazù, 
stisknìte klávesu Home. Obrazová oblast je vyplnìna obrazy. 
První obraz série se zobrazí v levém horním rohu obrazové 
oblasti. 
 

Procházení po stránkách pøi 
zobrazení pásu snímkù E.3

Pøi procházení po stránkách se do pozadí pøesouvá pouze 
veškerý obsah oblasti snímku. Napøíklad pøi rozvržení 4x4 se do 
pozadí pøesunou ètyøi snímky najednou a ètyøi snímky s vyššími 
èísly se pøesunou z pozadí do oblasti snímku. E.3

➭ Když dosáhnete poslední stránky všech naètených obrazù, 
objeví se hlášení „At Last Page”. Obrazy poslední stránky 
zùstanou zobrazeny, takže obrazová oblast nezùstane 
prázdná. 
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Procházení pøi zobrazení  
sad E.3

Pøi zobrazení sad snímkù se do pozadí vždy pøesouvají nejvýše 
umístìné snímky zobrazených sérií (sad snímkù). V oblasti 
snímku se pak zobrazí ty snímky série, které v sadì snímkù 
následují. E.3

Jestliže nalistujete jednu stránku zpìt, objeví se pøedchozí 
snímky v sadách snímkù znovu. E.3
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Listování pomocí  
posuvníku E.3

Tøetí metodou procházení snímkù a sérií urèité studie je použití 
posuvníku. E.3

(1) Šipka posuvníku pro pøechod na první stránku 
→ Strana E.3–7, Procházení po stránkách

(2) Šipka posuvníku pro pøechod na pøedchozí stránku
(3) Jezdec
(4) Šipka posuvníku pro pøechod na následující stránku
(5) Šipka posuvníku pro pøechod na poslední stránku
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Prohlížení Procházení a výbìr obrázkù
E.3 ✧ Chcete-li pøejít na zaèátek nebo konec naètené série, kliknìte 
na šipku posuvníku pro pøechod na první nebo poslední 
stránku. 

E.3 ✧ Chcete-li pøejít na následující nebo pøedchozí stránku, 
klepnìte na šipku posuvníku. 

Pøi zobrazení pásu snímkù se pohled pøesune o jednu sadu 
dopøedu nebo zpìt. E.3

Pøi zobrazení sad se zobrazí následující nebo pøedchozí stránka. 
E.3

E.3 ✧ Pøetáhnìte jezdce myší nahoru nebo dolù tak, aby se 
zobrazila požadovaná stránka (zobrazí se také èíslo stránky).

➭ Jestliže klepnete na posuvník pod jezdcem nebo nad ním, 
postoupíte o jednu stránku zpìt nebo dopøedu.

A1 A2

A3

A3 A4

A5 A6A4

A1 B1

C1

A2 B2

C2
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Listování sériemi E.3

Jestliže jste na kartu úlohy Viewing naèetli více než jednu sérii 
nebo studii, mùžete zobrazeným materiálem procházet obraz 
po obrazu, stránku po stránce a také po celých sériích. 

E.3

✧ Po aktivaci funkce Scroll > Series Previous nebo Scroll > 
Series Next v hlavní nabídce se budete pohybovat vždy 
dopøedu nebo zpìt o jednu sérii.

Nebo E.3

E.3 ✧ Chcete-li pøejít k další nebo pøedchozí sérii, stisknìte klávesu 
Series+ (Num 5) nebo klávesuSeries- (Num 4) na klávesnici 
se symboly. 

To, které obrazy se nakonec zobrazí v obrazové oblasti, závisí na 
zvoleném zobrazení (bìžný režim, režim studie, pás obrazù 
nebo zobrazení sady). 

E.3
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Bìžný režim E.3 Pøi zobrazení pásu snímkù se do pozadí pøesouvá celá série, do 
níž náleží snímek zaplòující levý horní segment zobrazení 
snímkù. V levém horním segmentu se poté zobrazí první snímek 
následující série a oblast snímku se zaplní snímky dané série. E.3

Pøi zobrazení øad snímkù se do pozadí pøesune sada snímkù té 
série, která zaplòuje levý horní segment. Sada obrazù 
následující série se posune nahoru o jeden segment a vyplní 
prostor. 
Jsou-li sady obrazù v pozadí s vyššími èísly sérií, první sada 
obrazù v pozadí se posune do pravého dolního segmentu. 

E.3

Režim porovnávání studií E.3 V režimu porovnávání studií mùžete procházet sériemi dopøedu 
nebo dozadu v rámci jednoho vyšetøení pouze pomocí klávesy 
Series+/Series-. E.3

Pøi zobrazení pásu snímkù mùžete sériemi v rámci vyšetøení, v 
nìmž jsou snímky explicitnì zobrazeny, procházet pomocí 
klávesy Series+. To znamená, že série, do níž náleží snímek 
zaplòující levý segment, se pøesune do pozadí. Uvedený snímek 
bude nahrazen prvním snímkem následující série. Segmenty 
série vyšetøení se zaplní snímky následující série. E.3

Pøi zobrazení sad snímkù se sada ze série v øádku vyšetøení 
pøesune doleva do pozadí pomocí klávesy Series+. Zprava pak 
bude nahrazena další sérií z pozadí. E.3
Verze VE31D E.3–13 
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Listování mezi jednotlivými studiemi E.3

Na kartì úlohy Viewing se zobrazí tolik snímkù naètených 
vyšetøení a sérií, kolik se jich vejde na jednu obrazovku. E.3

Jakmile se obrazy naètou, zobrazí se vlevo nahoøe obrazy z 
prvního vyšetøení. 

E.3

✧ V hlavní nabídce aktivujte funkci Scroll > Study Next nebo 
Scroll > Study Previous. Zobrazí se série a snímky následující 
èi pøedchozí studie.

nebo E.3

E.3 ✧ Kliknìte na tlaèítko Study+ nebo Study- na kartì dílèí úlohy 
Scroll. 

nebo E.3

E.3 ✧ Pomocí kláves Study+ (Num 8) nebo Study- (Num 7) 
klávesnice se symboly mùžete pøejít k jiné studii.

Snímky z prvního vyšetøení se pøesunou do pozadí. E.3

Pohled v oblasti snímku se bude lišit podle toho, zda pro 
zobrazení zvolili bìžný režim nebo režim porovnávání studií.E.3
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Bìžný režim E.3

 

S1 A1 = série A1 studie 1 
S1 A2 = série A2 studie 1  
atd. E.3

S1A1 S1A2 S1A3

S1A4 S1A5 S1A6

S1B1 S2A1 S2A2

S2A3 S2A3 S2B1

S2B2 S2B3 S2B4

S3A1 S3A2 S3A3

S2A1 S2A2 S2A3

S2A4 S2B1 S2B2

S2B3 S2B4 S3A1

S2A2 S3A3S1A1

S1A2 S1A3 S1A4

S1A5 S1A6 S1B1

Study +
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Režim porovnávání studií E.3

 

S1 A1 = série A1 studie 1 
S1 A2 = série A2 studie 1  
atd. E.3

S1A1 S1A2 S1A3

S2A1 S2A2 S2A3

S3A1 S3A2 S3A3

S1B1 S1B2 S1B3

S2A4 S2B1 S2B2

S1A1 S1A2 S1A3 S1B1 S1B2 S1B3

Study +

S2A1 S2A2 S2A3

S3A1 S3A2 S3A3

S2A4 S2B1 S2B2

Studie 1

Studie 2

Studie 3

...

...

Studie 1 ...

Studie 2

Studie 3

...
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Listování na dalšího pacienta E.3

Až tøi pacienty lze naèíst do karty úloh Viewing najednou ve 
standardním režimu a dokonce více v režimu porovnávání 
studií. Jméno pacienta, jehož snímky se právì zobrazují, lze 
zjistit v oblasti snímku podle otevøené složky pacienta v poli 
pacienta v ovládací oblasti.  

E.3

E.3 ✧ Klepnìte na tlaèítko Patient+ nebo Patient- na kartì dílèí 
úlohy Scroll.

Nebo E.3

✧ Pøejdìte k požadovanému pacientovi klepnutím na jeho 
složku.

 

Patient- Patient+
Verze VE31D E.3–17 
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Animované snímky (Movie) E.3

Rozpoznání anomálií v procesech (dynamické série) bývá 
zpravidla jednodušší, mùžete-li vidìt snímky v rychlém sledu 
(podobnì jako pøi promítání filmu). E.3

Volba Movie umožòuje automatické a rychlé procházení snímky 
série nebo celé studie. E.3

!0

E.3 E.3

!0

E.3 E.3

Pøi bìhu filmové sekvence se nedoporuèuje aktivovat žádné 
èinnosti týkající se opravy nebo zmìny uspoøádání E.3

Systém syngo není založen na reálném èase. Nelze tedy 
zajistit, aby zobrazení typu movie bìželo v podmínkách 
reálného èasu. Mùže docházet ke zpoždìním zpùsobeným 
procesy, které soubìžnì probíhají na pozadí. E.3
E.3–18 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení Procházení a výbìr obrázkù
Výbìr rozvržení a režimu 
zobrazení E.3

✧ Chcete-li zobrazit jako filmovou sekvenci pouze jednu sérii, 
vyberte zobrazení sady (View > Stack).

Nebo E.3

✧ Chcete-li vidìt všechny série urèité studie jednu po druhé 
jako filmovou sekvenci, vyberte zobrazení pásu obrazù (View 
> Stripe). 

✧ Poté vyberte dostateènì velké rozvržení tak, abyste 
rozpoznali všechny detaily.

Doporuèujeme: E.3

❏ 1 : 1 
Filmová sekvence pokryje celou obrazovku.

❏ 4 : 1 
Filmovou sekvenci mùžete porovnávat až se tøemi 
"nehybnými obrázky".
Verze VE31D E.3–19 
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Interaktivní pøehrávání filmové sekvence E.3

Protože levé tlaèítko myši se za bìžných okolností používá k 
výbìru obrazù a grafických prvkù, musíte pro interaktivní 
pøehrávání filmové sekvence pøepnout jeho funkci na Movie. 

E.3

E.3 ✧ Aktivujte funkci Scroll > Interactive Movie nebo kliknìte na 
pøíslušné tlaèítko na kartì dílèí úlohy Scroll. 
 

E.3 Kurzor myši zmìní tvar. 
 
 

E.3

Pøehrávání filmové 
sekvence s pomocí myši E.3

Myš použijte ke spuštìní filmové sekvence a k ovládání rychlosti 
pøehrávání. Èím rychleji bude myší pohybovat, tím rychleji se 
bude filmová sekvence pøehrávat. E.3

Než zaènete, musíte vybrat segmenty filmové sekvence. E.3

✧ Pøesuòte kurzor myši na snímek, kterým chcete zaèít.

✧ Stisknìte levé tlaèítko myši a nepouštìjte jej. Posuòte myší 
nahoru a spustíte tak pøehrávání filmové sekvence dopøedu.

Nebo E.3

✧ Stisknìte levé tlaèítko myši a nepouštìjte jej. Posuòte myší 
dolù a spustíte tak zpìtné pøehrávání filmové sekvence.
E.3–20 Návod k použití pro uživatele systému syngo
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E.3

➭ Když filmová sekvence dospìje k poslednímu obrazu série èi 
studie, vrátí se zpìt na první obraz dané série èi studie a zaène 
se znovu pøehrávat (smyèka). 
 

Filmovou sekvenci mùžete kdykoli pøerušit (napøíklad když se 
chcete lépe podívat na nìkterý snímek). E.3

✧ Staèí pustit levé tlaèítko myši.

Aktuální snímek se zobrazí v segmentu filmové sekvence vèetnì 
veškerých textových informací, kreslících prvkù a 
vyhodnocování. E.3

Pøi zobrazení pásu obrazù se ve zbývajících segmentech zobrazí 
obraz pøedcházející a následující po obrazu aktuálním. 

E.3

✧ Opìt klepnìte do oblasti pro obrázky, podržte stisknuté levé 
tlaèítko myši a popojeïte myší v oblasti pro obrázky. Filmová 
sekvence se opìt rozbìhne.

Dopøedu

Dozadu
Verze VE31D E.3–21 
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Ukonèení filmové sekvenceE.3 ✧ Pus¤te levé tlaèítko myši a filmová sekvence se pøeruší.

✧ Opìt vyvolejte Scroll > Interactive Movie, èímž ukonèíte 
práci v režimu Movie. Pøepnìte funkci levého tlaèítka myši 
opìt na režim výbìr. 
 
 

Automatické pøehrávání filmové sekvence E.3

Alternativou k interaktivnímu pøehrávání filmové sekvence s 
pomocí myši je automatické pøehrávání filmové sekvence. To se 
doporuèuje napøíklad tam, kde jde o vyšetøení èi série s velkým 
poètem snímkù, nebo tam, kde chcete zajistit rovnomìrnou 
rychlost pøehrávání (napøíklad u sérií snímkù srdce). E.3

V tomto režimu mùžete mìnit celou øadu nastavení pro 
pøehrávání filmové sekvence. 

E.3

➭ Kvùli zvýšení výkonu se nìkteré výsledky vyhodnocování u 
sérií snímkù požadovaných oblastí ROI pøi automatickém 
pøehrávání filmové sekvence zobrazují jako "???". Chcete-li v 
režimu automatického pøehrávání filmové sekvence získat 
správné hodnoty, musíte sekvenci zastavit a procházet 
dopøedu èi dozadu po jednotlivých krocích. Znovu spus¤te 
pøehrávání filmové sekvence.  
→ Strana E.3–26, Zastavení filmové sekvence, krokové 
procházení dopøedu/dozadu

➭ Informace o zpùsobu definování a vyhodnocování oblastí 
zájmu (ROI) najdete v èásti 
→ Strana E.5–13, Vyhodnocení ROI

E.3
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Spuštìní filmové sekvence E.3

E.3 ✧ Aktivujte funkci Scroll > Automatic Movie nebo kliknìte na 
tlaèítko Automatic Movie na kartì dílèí úlohy Scroll.

V závislosti na výchozím nastavení se okamžitì spustí 
pøehrávání filmové sekvence nebo se zobrazí dialogové okno 
Movie Properties. Odsud mùžete zmìnit celou øadu nastavení 
pøehrávání filmové sekvence a poté pøehrávání ovládat. E.3

E.3 ✧ Nakonec kliknutím na toto tlaèítko v oknì Movie Properties 
spus¤te pøehrávání filmové sekvence. 
 

Zmìna nastavení 
pøehrávání filmové 
sekvence E.3

✧ Bìhem pøehrávání filmové sekvence kliknìte do segmentu 
pøehrávání pravým tlaèítkem myši; zobrazí se místní nabídka.

✧ Zvolíte-li položku Play Backward nebo Play Forward, 
mùžete mìnit smìr pøehrávání.

Nebo E.3

✧ Volbou funkce Scroll > Movie Properties otevøete dialogové 
okno Movie Properties. Stisknìte tlaèítko forward/
backward nebo posuòte jezdce pro úpravu rychlosti 
pøehrávání.
Verze VE31D E.3–23 
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Procházení a výbìr obrázkù Prohlížení
V dialogovém oknì Movie Properties mùžete: E.3

❏ zmìnit smìr a rychlost pøehrávání,

❏ zastavit a znovu spustit pøehrávání filmové sekvence,

❏ vylouèit poèáteèní a koncové snímky, které vás nezajímají.
E.3–24 Návod k použití pro uživatele systému syngo
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Rychlost a smìr pøehráváníE.3 ✧ Ze seznamu vyberte rychlost.

Nebo E.3

E.3 ✧ Zadejte rychlost pøehrávání do èíselníku v poli Frame Rate. 

Nebo E.3

E.3 ✧ Vyberte rychlost a smìr pøehrávání za pomoci jezdce:

❏ zcela vpravo – velmi rychle dopøedu,
❏ spíše vpravo – pomalu dopøedu,
❏ uprostøed – obraz je zastaven,
❏ spíše vlevo – pomalu dozadu,
❏ zcela nalevo – rychle dozadu. 

 

Nebo E.3

E.3 ✧ Zmìòte smìr pøehrávání kliknutím na nìkteré z tlaèítek 
forward/backward. 
 
 

Verze VE31D E.3–25 
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E.3 ✧ Klepnìte na možnost Yoyo.

Jakmile filmová sekvence dosáhne posledního políèka, spustí se 
pozpátku k prvnímu snímku, odtud opìt dopøedu až po poslední 
snímek atd. E.3

Nebo E.3

E.3 ✧ Po zrušení zaškrtnutí u položky Yoyo se bude filmová 
sekvence pøehrávat ve smyèce. 

Až filmová sekvence dospìje k poslednímu obrazu, spustí se 
znovu od zaèátku (smyèka). 
 

E.3

Zastavení filmové sekvence, 
krokové procházení 
dopøedu/dozadu E.3

E.3 ✧ Filmovou sekvenci zastavíte kliknutím na tlaèítko Stop. 

✧ Øadou snímkù procházejte manuálnì pomocí posuvníku 
nebo záložek.

Vylouèení poèáteèních/
koncových snímkù E.3

E.3 ✧ Pomocí èíselníkù From a To zadejte, které obrazy chcete 
zahrnout do pøehrávání filmové sekvence. Tímto zpùsobem 
mùžete vylouèit snímky na zaèátku èi na konci, které vás 
nezajímají.

➭ Toto nastavení není možné zmìnit bìhem pøehrávání filmové 
sekvence.
E.3–26 Návod k použití pro uživatele systému syngo
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Vždy zobrazovat dialogové 
okno E.3

E.3 ✧ Když zvolíte funkci Pop up this dialog..., dialogové okno 
Movie Properties se zobrazí pøi každé aktivaci funkce 
Automatic Movie.

Pak mùžete z tohoto okna filmovou sekvenci neustále ovládat. 
 
 
 

E.3

Ukonèení automatického 
pøehrávání filmové 
sekvence E.3

Pøehrávání filmové sekvence mùžete kdykoli automaticky 
zastavit. Tím se ukonèí i režim Automatic Movie, ale mùžete jej 
kdykoli bez problémù znovu spustit. E.3

✧ Stisknìte na klávesnici klávesu Esc nebo klepnìte levým 
tlaèítkem myši do segmentu pøehrávání (jedno klepnutí). 
Automatic Movie se tak ukonèí.

Nebo E.3

E.3 ✧ Zrušte zaškrtnutí položky Scroll > Automatic Movie v hlavní 
nabídce nebo znovu kliknìte na pøíslušné tlaèítko. 

Nebo E.3

E.3 ✧ V dialogovém oknì Movie Properties zastavte pøehrávání 
filmové sekvence a dialogové okno zavøete tlaèítkem Close.
Verze VE31D E.3–27 
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Pøehrávání nìkolika filmových sekvencí E.3

Pracujete-li v režimu porovnávání studií, mùžete pomocí funkce 
Automatic Movie pøehrávat všechna naètená vyšetøení a 
všechny série simultánnì jako filmové sekvence. E.3

Pøehrávání tìchto filmových sekvencí mùžete synchronizovat. E.3

✧ Aktivujte funkci Scroll > Link > Acquisition Time.

Nyní se ve všech segmentech pøehrávání zobrazí snímky 
seøazené chronologicky podle stejného èasového poøadí. E.3

Nebo E.3

✧ Vyvolejte Scroll > Link > Slice Position.

Nyní se ve všech segmentech pøehrávání zobrazí snímky stejné 
polohy øezu. E.3

Nebo E.3

✧ Aktivujte funkci Scroll > Link > Current Order; filmové 
sekvence se budou pøehrávat synchronizovanì v poøadí, jak 
se objevují v sériích.

➭ Smìr pøehrávání nastavený pro synchronizaci je rozhodující i 
v pøípadì, že se pøehrává pouze jeden film. Jestliže jste snímky 
seøadili v sestupném chronologickém poøadí a pøehráváte je 
zpìtnì v aktuálním poøadí, filmový záznam vypadá, jako by se 
pøehrával dozadu.

E.3

✧ Než zaènete, vyberte si segmenty filmové sekvence. 
→ Strana E.3–32, Výbìr snímkù
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Pás obrazù u  
vícenásobné studie E.3

Je vybrán jeden segment. 
Filmová sekvence sestává ze všech obrazù náležejících ke studii 
S1. E.3

Jsou vybrány dva segmenty (explicitnì). 
Filmová sekvence sestává ze všech obrazù náležejících ke studii 
S1 a S2. E.3

Porovnání pásu snímkù u 
vícenásobné studie E.3

Je vybrán jeden segment. 
Filmová sekvence sestává ze všech obrazù náležejících ke studii 
S1. E.3

Jsou vybrány dva segmenty explicitnì, vždy jedna filmová 
sekvence na segment. Všechny filmové sekvence obsahují 
všechny obrazy pøíslušné studie. 

E.3

 AS11  AS12

 AS21  AS22

AS12

AS21 AS22

 AS11

 AS11  AS12

 BS21  BS22

 AS11  AS12

 BS21  BS22
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Øada sérií vícenásobné 
studie E.3

Je vybrána jedna sada, jedna filmová sekvence v sérii 1. 
E.3

Jsou vybrány dvì sady explicitnì, v každém pøípadì jde o jednu 
filmovou sekvenci ve vybraném segmentu. 

E.3

S11 S12

S11 S21
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Sada sérií srovnávací 
vícenásobné studie E.3

Je vybrána jedna sada, jedna filmová sekvence v sérii 1. 
E.3

Jsou vybrány dvì sady, v každém pøípadì jedna filmová 
sekvence pro každou vybranou sadu. E.3

S11 S21

S31 S41

S11 S21

S31 S41
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Výbìr snímkù E.3

Na kartì úlohy Viewing mùžete snímky nejen prohlížet, ale také 
zpracovávat a vyhodnocovat. E.3

Nejprve musíte vybrat obrazy, které chcete zpracovávat. 
E.3

Zpùsoby výbìru snímkù E.3 Snímky mùžete vybrat jedním ze dvou zpùsobù: E.3

❏ explicitnì podržením klávesy Ctrl (explicitnì vybrané 
snímky se zobrazí s nepøerušovaným ohranièením)

❏ implicitnì použitím vstupního fokusu 
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Použití fokusu E.3

Fokus oznaèuje aktivní segment v oblasti snímku. Je vyznaèen 
pøerušovanou èarou, jde tedy o implicitní výbìr. E.3

Provedené kroky zpracování budou vždy aplikovány na snímek, 
který je zobrazen v segmentu, na nìmž je umístìn fokus. E.3

Teprve po provedení explicitního výbìru obrazù se fokus vypne 
a žádný segment nebude ohranièen pøerušovanou èarou. 

E.3

Výchozí fokus E.3 Když naètete snímky na kartu úlohy Viewing, fokus bude ve 
výchozí poloze na levém horním segmentu oblasti snímku. E.3

 

A1 A2

A3 A4
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Umístìní fokusu pomocí 
myši E.3

E.3

E.3 ✧ Klepnìte levým tlaèítkem myši na segment v oblasti pro 
obrázky, na nìjž chcete fokus umístit.

 

Jestliže umístíte na nìjaký segment fokus, zruší se explicitní 
výbìr snímkù èi grafických prvkù, a to i tehdy, když klepnete na 
takto explicitnì vybraný segment. E.3

Pøíklady: E.3

 

E.3–34 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení Procházení a výbìr obrázkù
Zmìna fokusu pomocí 
klávesnice E.3

Fokusem mùžete pohybovat také pomocí klávesnice.  
Používejte šipky na klávesnici. 

E.3

E.3 ✧ Stisknutím klávesy se šipkou vlevo nebo vpravo pøesuòte 
fokus do vedlejšího sloupce v obrazové oblasti. 

Nebo E.3

E.3 ✧ Stisknutím klávesy se šipkou nahoru nebo dolù pøesuòte 
fokus do dalšího øádku v obrazové oblasti. 

➭ Jestliže je snímek nebo grafický prvek vybrán explicitnì, 
nejsou klávesy se šipkami aktivní.
Verze VE31D E.3–35 
únor 2006

 0.0



Procházení a výbìr obrázkù Prohlížení
Zpracování snímku E.3 Pokud jste žádné snímky nevybrali explicitnì, budou kroky 
zpracování aplikovány na snímek nacházející se v segmentu, na 
nìmž je umístìn fokus, tedy na snímek ohranièený 
pøerušovanou èarou. E.3

✧ Umístìte fokus na snímek, který chcete zpracovávat.

V oblasti snímku se na 
žádném snímku nenachází 
fokus E.3

Jestliže se ve snímkové oblasti nenachází na žádném snímku 
fokus, znamená to, že se v pozadí nachází jeden èi více snímkù 
vybraných explicitnì. E.3

 

Pokud nenastavíte fokus, kroky zpracování snímkù budou 
aplikovány pouze na explicitnì vybrané snímky. E.3

A5 A6

B1

B3 C1A1 A2

A3 A4 B2 C2 C3

Vybraný snímek

V obrazové oblasti 
se na žádném obrazu 
nenachází fokus
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Prohlížení Procházení a výbìr obrázkù
Explicitní výbìr snímkù E.3

Explicitní výbìr snímkù znamená, že vybíráte specifické snímky 
èi série jeden po druhém. Na rozdíl od fokusu se explicitní výbìr 
pøidružuje k obsahu segmentu. Explicitnì vybrané snímky 
zùstávají souèástí výbìru i poté, co se pøesunou do pozadí. E.3

Veškeré explicitnì vybrané snímky jsou ohranièeny 
nepøerušovanou èárou. E.3

 

 

Snímek není vybrán Snímek je vybrán explicitnì
Verze VE31D E.3–37 
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Procházení a výbìr obrázkù Prohlížení
Individuální výbìr snímkù E.3 Explicitnì mùžete vybrat jeden èi více snímkù po sobì. E.3

E.3 ✧ Stisknìte klávesu Ctrl a kliknìte levým tlaèítkem myši na 
obraz. Tím jej vyberete explicitnì. 

✧ Podržte klávesu Ctrl a kliknìte na další obrazy, kterými 
chcete svùj výbìr rozšíøit. 
 

Explicitní výbìr snímkù až 
do konce série E.3

Chcete-li explicitnì vybrat zobrazený obraz a s ním i všechny 
následující obrazy dané série. 

E.3

E.3 ✧ Klepnìte na snímek, který chcete vybrat explicitnì, a podržte 
klávesu Ctrl, nebo klepnutím na snímek umístìte fokus.

✧ V hlavní nabídce zvolte položku Edit > Select On Succeeding 
nebo v místní nabídce aktivujte položku Select On 
Succeeding (pravým tlaèítkem myši).

nebo E.3

E.3 ✧ Kliknìte na tlaèítko Select On Succeeding. 

Nyní je vybrán snímek a všechny po nìm následující snímky. E.3

➭ Jestliže jste explicitnì vybrali snímky z rùzných sérií, budou 
vybrány zbývající snímky tìchto sérií poèínaje vybranými 
snímky.
E.3–38 Návod k použití pro uživatele systému syngo
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Prohlížení Procházení a výbìr obrázkù
Explicitní výbìr celé série E.3 Nejjednodušší zpùsob, jak vybrat kompletní sérii (tj. všechny 
snímky obsažené v sérii), je použít funkci Select Series. E.3

➭ Pøi použití funkce Select On Succeeding musíte zvolit první 
obraz z požadované série. 

✧ Nejprve explicitnì vyberte snímek požadované série 
(klepnutím pøi souèasném stisknutí klávesy Ctrl). Mùžete 
výbìr provést také umístìním fokusu klepnutím na snímek.

✧ V hlavní nabídce zvolte položku Edit > Select Series nebo v 
místní nabídce aktivujte položku Select Series (pravým 
tlaèítkem myši).

Celá série bude explicitnì vybrána. E.3
Verze VE31D E.3–39 
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Procházení a výbìr obrázkù Prohlížení
Explicitní výbìr více než 
jedné série E.3

Chcete-li vybrat nìkolik úplných sérií, vyberte nejprve první 
obraz z každé požadované série a poté rozšiøte výbìr na úplné 
série. 

E.3

E.3 ✧ Podržte klávesu Ctrl a klikejte na jednotlivé obrazy 
požadovaných sérií. 

✧ Vyvolejte položku Edit > Select Series v hlavní nabídce nebo 
zvolte Select Series v místní nabídce. 
 

Explicitní výbìr celé studie E.3 Nejjednodušší zpùsob, jak vybrat kompletní studii (tj. všechny 
snímky obsažené ve studii), je použít funkci Select Study. E.3

✧ Nejprve explicitnì vyberte snímek požadované studie 
(klepnutím na snímek pøi souèasném stisknutím klávesy Ctrl. 
Výbìr mùžete provést také umístìním fokusu, a to klepnutím 
na snímek.

✧ V hlavní nabídce aktivujte položku Edit > Select > Study.

Nyní je explicitnì vybrána celá studie. 
 

E.3

Explicitní výbìr  
pacienta E.3

Vyberte pacienta (tj. všechny jeho snímky) pomocí funkce 
Select Patient. E.3

✧ Nejprve explicitnì vyberte snímek požadovaného pacienta 
(klepnutím na snímek pøi souèasném stisknutí klávesy Ctrl). 
Výbìr mùžete provést také umístìním fokusu, a to klepnutím 
na snímek.

✧ V hlavní nabídce aktivujte položku Edit > Select > Patient.

Nyní je celý pacient vybrán explicitnì. E.3

E.3
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Prohlížení Procházení a výbìr obrázkù
Oznaèení snímkù a explicitní 
výbìr oznaèených snímkù E.3

Pokud jste na kartu Viewing naèetli velké množství snímkù, 
bude pro vás možná užiteèné prohlédnout si nejprve snímky 
podrobnìji a rozhodnout, které snímky jsou pro následné kroky 
zpracování skuteènì dùležité. E.3

Oznaète snímek, který chcete zahrnout do zpracování. Poté 
projdìte i všemi ostatními dùležitými snímky a jeden po druhém 
oznaète. E.3

E.3 ✧ Stisknìte klávesu Ctrl a klepnutím vyberte snímek, který 
chcete oznaèit.

✧ V hlavní nabídce zvolte položku Edit > Mark nebo v místní 
nabídce aktivujte (pravé tlaèítko myši) položku Mark.
Verze VE31D E.3–41 
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Procházení a výbìr obrázkù Prohlížení
Nebo E.3

E.3 ✧ Stisknìte na klávesnici se symboly klávesu Mark (Num 3). 
 

✧ Chcete-li zrušit výbìr urèitého snímku, zvolte v hlavní 
nabídce položku Edit > Unmark nebo v místní nabídce 
aktivujte položku Unmark.

Nebo E.3

✧ Znovu kliknìte na tlaèítko s ikonou nebo stisknìte klávesu 
Mark/Unmark na klávesnici se symboly. 
 

Až si postupnì prohlédnete všechny naètené snímky, vyberte 
všechny oznaèené (nebo všechny neoznaèené) snímky 
najednou. E.3

✧ Všechny oznaèené snímky nebo série vyberete explicitnì 
aktivací položky Edit > Select > Marked.

Nebo E.3

✧ Všechny neoznaèené snímky nebo série najednou vyberete 
aktivací  položky Edit > Select >Unmarked nebo klepnutím 
na pøíslušné tlaèítko.

Nyní mùžete všechny explicitnì vybrané obrazy buï upravit, 
nebo je z karty úlohy Viewing odstranit. 
→ Kapitola E.4, Zpracování snímkù 
→ Strana E.6–16, Zavøení vybraných snímkù nebo sérií E.3
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Prohlížení Procházení a výbìr obrázkù
Zrušení výbìru obrázkù E.3 Jestliže explicitní výbìr snímkù neobsahuje soubor snímkù, 
který požadujete, mùžete zrušit výbìr jednotlivých snímkù nebo 
výbìr všech snímkù. E.3

✧ Na nevybraný segment umístìte manuálnì (klepnutím 
tlaèítka myši) fokus.

Nebo E.3

✧ V hlavní nabídce zvolte položku Edit > Deselect All nebo v 
místní nabídce aktivujte položku Deselect All a zrušte výbìr 
všech zvolených snímkù.

➭ Standardní fokus bude poté nastaven automaticky; aktivní 
tedy bude segment vlevo nahoøe. 

Nebo E.3

E.3 ✧ Podržte klávesu Ctrl a znovu klepnìte na explicitnì vybrané 
snímky (individuální zrušení výbìru snímkù).
Verze VE31D E.3–43 
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Procházení a výbìr obrázkù Prohlížení
Pøímé zpracování snímkù E.3

Pøímé zpracování obrazù (výchozí volba) myší je automaticky 
aplikováno na segment obrazu, v nìmž je umístìn kurzor myši. 

E.3

Nastavení fokusu E.3 Nejsou-li žádné snímky explicitnì vybrány, nachází se fokus v 
oblasti snímku. Fokus se nachází v segmentu, na nìjž umístíte 
kurzor myši a v nìmž provádíte výchozí zpracování snímku. E.3

✧ Umístìte kurzor myši na nevybraný obraz a zpracujte jej, 
napøíklad úpravou okna.

 

➭ Jestliže byly pøedtím explicitnì vybrány grafické prvky uvnitø 
fokusu, zùstanou explicitnì vybrány i nadále.

A1 A2

A3 A4

A1 A2

A3 A4

Uspoøádání oken 
snímku pomocí myši
E.3–44 Návod k použití pro uživatele systému syngo
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Prohlížení Procházení a výbìr obrázkù
Snímky jsou vybrány 
explicitnì E.3

Jestliže jsou obrazy vybrány explicitnì, zpracuje se pouze ten 
obraz, na nìmž je umístìn kurzor myši (není-li ovšem explicitnì 
vybrán spolu s ostatními obrazy). 

E.3

Pøíklad: 
Obrazy A1 a A4 jsou vybrány explicitnì. Poloha kurzoru myši 
definuje výbìr. E.3

 

E.3

A2

A3

A1

A4

A1

A3 A4

A2

Zpracuje se pouze snímek A2 
(implicitní výbìr).

Zpracují se snímky A1 a A4 
(explicitní výbìr).
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únor 2006

 0.0



Procházení a výbìr obrázkù Prohlížení
E.3–46 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

E.4

 
Zpracování snímkù E.4
Jakmile jste na kartu úlohy Viewing naèetli všechny série anebo 
snímky, které chcete zobrazit a zpracovat, mùžete parametry 
zobrazení jednotlivých obrázkù mìnit. Tak mùžete docílit 
zdùraznìní oblastí a obsahu snímku pro následné zpracování 
nebo pro vypracování obzvláštì srozumitelné zprávy. E.4

Pøiøazením vyhledávací tabulky (LUT) mùžete zmìnit zpracování 
snímku nebo pøizpùsobit hodnoty okna naètených snímkù. 
Snímky lze pøiblížit nebo na nich lze vyznaèit oblast zájmu ROI. 
U nìkterých diagnostických problémù mùžete využít otáèení, 
pøevracení èi inverze obrazù. 
 

E.4

➭ U snímkù s vícenásobným rámcem bude funkce zpracování 
snímku použita u všech snímkù v sérii.

!0

E.4 E.4

Extrémní hodnoty vyvážení mohou snížit kvalitu snímku. E.4
Verze VE31D E.4–1 
únor 2006   

 0.0



Zpracování snímkù Prohlížení
Vyvážení snímkù E.4

Metody zpracování obrazu poskytují diagnostické informace ve 
tvaru snímkù se stupnicí šedi s množstvím rozdílných hodnot 
stupnice šedi sahajícím až do øádù nìkolika tisíc. Vyvážit obraz 
znamená specificky se zamìøit na rozsah stupnic šedi u 
diagnosticky relevantní oblasti a typu tkánì. E.4

Prvním krokem pøi vyvážení je tudíž urèení støedu okna, tj. 
hodnoty stupnice šedi u toho typu tkánì, který je pro daný 
diagnostický problém klíèový. Èím menší je støed okna, tím 
jasnìjší je obraz. 
Pomocí šíøky okna urèíte, kolik hodnot šedé stupnice nad a pod 
støedovou hodnotou chcete zobrazit. Èím menší bude šíøka 
okna, tím vìtší bude kontrast. 

E.4
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Prohlížení Zpracování snímkù
Zobrazení parametrù okna E.4 Nastavené hodnoty vyvážení se zobrazují v pravém dolním rohu 
snímkù. E.4

❏ W = šíøka (kontrast)
❏ C = støed (jas)

Na snímcích NM a PET se zobrazí hodnota B (% spodní èásti 
okna) a hodnota T (% horní èásti okna). E.4

➭ U barevných snímkù se hodnoty vyvážení nezobrazují.

Hodnoty vyvážení
Verze VE31D E.4–3 
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Zpracování snímkù Prohlížení
Nastavení rozsahu E.4

Èasto bude muset provést vyvážení snímkù nìkolikrát, než 
naleznete optimální nastavení odpovídající vašim požadavkùm. 
Definicí rozsahu mùžete zjednodušit svou èinnost tak, že v 
jednom kroku automaticky pøiøadíte nové hodnoty vyvážení k 
nìkolika snímkùm. E.4

Vyvážení s použitím rozsahu se vztahuje pouze na snímky, které 
nejsou vybrány explicitnì. E.4

Vyvážení snímkù až do 
konce série E.4

Pomocí volby Windowing On Succeeding mùžete definovat 
použití vyvážení u obrazu s fokusem (vèetnì) nebo u implicitnì 
zvoleného obrazu a všech následujících obrazù až do konce 
série. E.4

✧ Zvolte pøíkaz Image > Windowing On Succeeding, abyste 
mohli zpracovávat všechny obrazy do konce série. 
E.4–4 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
E.4 ✧ Pomocí klávesnice nebo hlavní nabídky nastavte požadované 
hodnoty okna.

Novì zadané hodnoty okna budou pøiøazeny ke všem obrazùm 
(od obrazu s fokusem až po poslední obraz série). 

E.4

Nebo 
E.4

✧ Kurzor myši umístìte do fokusu nebo do snímku, který není 
vybrán.

✧ Stisknutím prostøedního tlaèítka myši a následným pohybem 
myši nastavte okno všech obrázkù až do konce série.

Nebo E.4

✧ Pro pøiøazení hodnot spoètených v Auto Windowing všem 
obrazùm až do konce série dvojitì kliknìte na obraz 
prostøedním tlaèítkem myši. 
Verze VE31D E.4–5 
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Zpracování snímkù Prohlížení
Pøepínání mezi rozsahy E.4 Mezi rozsahy mùžete pøepínat dle potøeby. 
E.4

✧ Stisknutím klávesy Ctrl se pøepnete doèasnì z Windowing 
On Succeeding nebo Windowing On Series do Windowing 
On Selection.

➭ Když stisknete klávesu Ctrl, rozsah vyvážení je vždy On 
Selection.

✧ Nastavte okno v obrazu klepnutím na nìj prostøedním 
tlaèítkem myši a následným pohybem kurzoru myši s 
pøidržením stisknutého tlaèítka.

Nebo E.4

✧ Pøiøaïte k obrazu nové hodnoty okna pomocí fokusu. 
Použijte hlavní nabídku, klávesnici nebo zaškrtávací políèko. 

Až skonèíte operaci a uvolníte klávesu Ctrl, bude opìt platný 
pøedchozí režim, který byl platný pøed vyvážením. E.4

➭ Jestliže uvolníte klávesu Ctrl bìhem vyvážení, nebude to mít 
žádný vliv na režim.
E.4–6 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Vyvážení explicitnì 
vybraných snímkù E.4

Pomocí funkce Windowing On Selection mùžete vyvážit 
explicitnì nebo implicitnì pouze vybrané obrazy. E.4

✧ Chcete-li vyvážit vybrané obrazy, zvolte Image > Windowing 
On Selection.

Nebo E.4

✧ Explicitnì zvolte jeden nebo více obrazù a nastavte 
požadované hodnoty okna pomocí hlavní nabídky, 
klávesnice nebo zaškrtávacího políèka. 

Nebo E.4

✧ Kurzor myši umístìte na explicitnì zvolený snímek.

✧ Veškeré explicitnì zvolené obrazy vyvážíte pomocí stisku 
prostøedního tlaèítka myši a jejího následného pohybu. 

Nebo E.4

✧ Pro automatické pøiøazení pøednastavených parametrù okna 
dvojitì kliknìte prostøedním tlaèítkem myši. 
Verze VE31D E.4–7 
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Zpracování snímkù Prohlížení
Pøíklady: E.4

Windowing On Succeeding je aktivní. E.4

A1 A2 A3

A4 A5 A6

B1 B2 B3

A1 A2 A3

A4 A5 A6

B1 B2 B3

Vyvažování myší 
pomocí fokusu

A1 A2 A3

A4 A5 A6

B1 B2 B3

Vyvažování v 
explicitnì vybraných 
snímcích

A1 A2 A3

A4 A5 A6

B1 B2 B3

A1 A2 A3

A4 A5 A6

B1 B2 B3

A1 A2 A3

A4 A5 A6

B1 B2 B3

Výchozí vyvažování 
pomocí myši

A1 A1

Hodnoty vyvážení 
zùstaly nezmìnìny

Hodnoty vyvážení 
byly zmìnìny
E.4–8 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Vyvažování série E.4 Pomocí funkce Windowing On Series mùžete vyvážit sérii. 
Jestliže je vybrán alespoò jeden obraz série, celá série bude 
vyvážena. Jestliže jsou vybrány obrazy z více sérií, všechny 
dotèené série budou vyváženy. E.4

✧ Chcete-li vyvážit celou sérii, zvolte Image > Windowing On 
Series.

E.4
Verze VE31D E.4–9 
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Zpracování snímkù Prohlížení
Automatické vyvážení E.4

Pomocí funkce Auto Windowing mùžete k obrazùm 
automaticky pøiøadit optimalizované hodnoty vyvážení. 

E.4

Funkce Auto Windowing pøi 
naèítání E.4

Pøed naètením snímkù na kartu úlohy Viewing mùžete urèit, s 
jakými hodnotami vyvážení chcete dané snímky zobrazit: E.4

❏ s hodnotami vyvážení, s nimiž byly uloženy.

❏ s automaticky optimalizovanými hodnotami vyvážení (Auto-
Window). 

✧ Vyberte pøíkaz Image > Auto Windowing.

Pøi každém dalším naètení obrazù na kartu úlohy Viewing
budou obrazy okamžitì naèteny s optimálními hodnotami 
vyvážení, které náležejí k dané studii. 

E.4
E.4–10 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Použití funkce Auto 
Windowing u jednotlivých 
snímkù E.4

Funkci Auto Windowing mùžete také aplikovat na jednotlivé 
nebo vybrané obrazy. E.4

Vìnujte pozornost volbì rozsahu. 
→ Strana E.4–4, Nastavení rozsahu 

E.4

✧ Pøed naètením obrazù se ujistìte, že volba Image > Auto 
Windowing je deaktivována.

Obrazy budou nyní naèteny spolu s hodnotami vyvážení, s nimiž 
byly uloženy. 

E.4

E.4 ✧ Prostøedním tlaèítkem myši dvojitì kliknìte na ten obraz, 
kterému si pøejete optimalizované parametry okna 
automaticky pøiøadit pro danou studii èi èást tìla. 

Nebo E.4

E.4 ✧ Kliknìte na tlaèítko Auto Windowing. 
 

Nebo E.4

✧ Zvolte položku Image > Auto Windowing.
Verze VE31D E.4–11 
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Zpracování snímkù Prohlížení
Pøepínání mezi rozsahy 
bìhem Auto Windowing E.4

Když je použita funkce Auto Windowing, mùžete doèasnì 
pøepínat z Windowing On Succeeding nebo Windowing On 
Series na Windowing On Selection. 

E.4

Chcete vyvážit doèasnì explicitnì nebo implicitnì vybrané 
obrazy. E.4

E.4 ✧ Stisknìte klávesu Ctrl na klávesnici. 
 

Rozsah vyvážení je na Windowing On Selection. E.4

Po skonèení operace uvolnìte klávesu Ctrl a pøedchozí režim 
bude opìt platný. E.4
E.4–12 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Pøiøazení pøeddefinovaných nastavení okna E.4

Øada specifických nastavení okna pro orgán, studii a uživatele je 
uložena na kartì úlohy Viewing. E.4

Nìkterá z tìchto nastavení byla provedena servisní službou 
spoleènosti Siemens. Mùžete je zmìnit v oknì Viewing 
Configuration, pøípadnì definovat nìkolik nových, vlastních 
nastavení okna. 
→ Strana E.7–8, Hodnoty vyvážení specifické pro daného 
uživatele a daný orgán 
 

E.4

✧ Vyberte obrazy, u kterých chcete provést vyvážení, a vìnujte 
pøitom pozornost rozsahu. 
→ Strana E.4–4, Nastavení rozsahu 

✧ Volbou pøíkazu Image > Windowing zvolíte dílèí nabídku s 
veškerými uloženými nastaveními okna.

✧ Zvolte jednu z položek tìchto nastavení okna, která bude 
aplikována na vaše snímky.
Verze VE31D E.4–13 
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Zpracování snímkù Prohlížení
Zobrazení nastavení okna 1 a 2 E.4

Nìkteré metody zobrazení (napøíklad CT) umožòují uložit se 
snímky dvì alternativní nastavení okna. Napøíklad vyšetøení CT 
budou uložena se dvìma hodnotami okna.To mùže být užiteèné 
v pøípadì, že chcete pomocí jedné série vyøešit dva diagnostické 
problémy (napøíklad Window 1 - tkánì, Window 2 - kosti). E.4

Pro jakýkoli obraz, pro který byla uložena dvì nastavení okna, 
zobrazení hodnoty okna v pravém dolním rohu obrazu 
oznaèuje, které okno je právì aktivní 
(W1.../C1... pro okno 1; W2.../C2... pro okno 2). 

E.4

Pomocí tlaèítek Window 1 a Window 2 mùžete pøepínat mezi 
tìmito dvìma sadami hodnot vyvážení. E.4

✧ Zvolte snímky, které chcete vyvážit.

E.4 ✧ Kliknìte na tlaèítko Window 1 nebo Window 2 na kartì dílèí 
úlohy Image. 
 
 
 
 

E.4–14 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Vyvážení pomocí myši E.4

Pomocí myši mùžete pøiøadit nové hodnoty vyvážení k 
pøíslušným snímkùm. E.4

➭ Vìnujte pozornost volbì rozsahu. 
→ Strana E.4–4, Nastavení rozsahu 

E.4 ✧ Klepnìte na obrázkový segment pomocí prostøedního 
tlaèítka myši a s pøidržením stisknutého tlaèítka myší 
posuòte.

Kurzor myši zmizí. E.4

✧ Støed okna lze zmìnit posunutím myši nahoru nebo dolù.

Nebo E.4

✧ Šíøku okna lze zmìnit posunutím myši vpravo nebo vlevo.

 

U snímku, ve kterém právì provádíte vyvážení, budou zmìnìné 
hodnoty vyvážení ihned zobrazeny (interaktivní vyvážení). E.4

Jakmile tlaèítko myši uvolníte, budou nové hodnoty okna 
použity také pro ostatní zvolené obrázky nebo zvolený rozsah 
akce. E.4

Kontrast - 
(šíøka +)

Jas - 
(støed +)

Jas + 
(støed -)

Kontrast + 
(šíøka -) x

y

Verze VE31D E.4–15 
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Zpracování snímkù Prohlížení
Vyvážení pomocí klávesnice E.4

Pro jemné doladìní hodnot vyvážení mùžete také použít klávesy 
na klávesnici se symboly. E.4

➭ Vìnujte pozornost volbì rozsahu. 
→ Strana E.4–4, Nastavení rozsahu

Nastavení kontrastu 
E.4

E.4

✧ Stisknutím klávesy Width+ (Num -) nebo Width- (Num *) 
mùžete kontrast zvìtšit nebo zmenšit. 
 
 

Nastavení jasu 
E.4

E.4

✧ Stisknutím klávesy Center+ (Num /) nebo Center- (Num 
Num) mùžete jas zvýšit nebo snížit. 
E.4–16 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Obnovení hodnot vyvážení E.4

Zmìny, které jste provedli u hodnot vyvážení, mùžete kdykoliv 
vrátit zpìt a obnovit tak pùvodní nastavení, s nímž byly obrazy 
pùvodnì naèteny z databáze. 

E.4

✧ Aktivujte položku Image > Home Window nebo v místní 
nabídce zvolte položku Home Window (pravým tlaèítkem 
myši).

Nebo E.4

E.4 ✧ Klepnìte na tlaèítko Home Window na kartì dílèí úlohy 
Image.

Zvolený snímek (snímky) se zobrazí s pùvodními hodnotami 
vyvážení. E.4
Verze VE31D E.4–17 
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Zpracování snímkù Prohlížení
Zmìna zobrazení obrazu pomocí tabulek LUT 
stupnice šedi E.4

Pøi nìkterých modalitách (napøíklad AX, SP) vznikají snímky se 
stupnicí šedi, které nelze pomocí vyvážení optimálnì zobrazit.E.4

Tyto snímky jsou pøi poøízení uloženy se specifickou tabulkou 
rozložení stupnice šedi, která se nazývá vyhledávací tabulka 
(LUT). V závislosti na výchozím nastavení modality pro snímky 
urèitých vyšetøení lze uložit více tabulek LUT. Tyto obrazy pak lze 
ukládat s rùznými tabulkami LUT v závislosti na diagnostickém 
problému. 
 

E.4

Tabulka LUT místo hodnot 
vyvážení E.4

Jestliže je obraz uložen s LUT, je automaticky zobrazen na 
základì LUT, když je naèten do karty Viewing. To je indikováno 
tím, že žádné hodnoty okna (W / C) nejsou zobrazeny v pravém 
dolním rohu obrazu. E.4

Tento obraz však lze normálnì vyvažovat (napøíklad pomocí 
myši); v takovém pøípadì tabulku LUT deaktivujte. 
 

E.4
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Prohlížení Zpracování snímkù
Pøepnutí tabulky LUT E.4 Jestliže snímek naètený s tabulkou LUT vyvážíte, tabulka LUT 
pøestane být aktivní. Tabulku LUT však lze kdykoli opìt 
aktivovat. E.4

Pokud u snímku nebyla uložena jedna tabulka LUT, ale nìkolik 
tabulek, mùžete zmìnit nastavení snímku volbou jedné z 
dalších tabulek LUT. E.4

✧ Vyberte snímek nebo snímky, které chcete zobrazit s 
tabulkou LUT nebo jejichž tabulky LUT chcete zmìnit.

✧ Aktivujte funkci Image > Color Lookup Table... a vyberte 
jednu z tabulek LUT uvedených v dílèí nabídce.

➭ Jestliže jste naèetli a vybrali obrazy, u kterých není uložena 
žádná tabulka LUT, dílèí nabídka Image > Color Lookup 
Table... bude prázdná a toto tlaèítko nebude neaktivní.
Verze VE31D E.4–19 
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Zpracování snímkù Prohlížení
Zmìna zobrazení snímku pomocí barevných 
tabulek LUT E.4

Jestliže chcete optimalizovat snímek pro diagnostické úèely, k 
jejich zobrazení lze použít funkci pro zobrazení stupnice šedi v 
barvách. Intenzita barev pak odpovídá hodnotám stupnice šedi.E.4

Dialogové okno Color Lookup Table umožòuje urèit, která z 
nìkolika pøeddefinovaných tabulek pro vyhledávání barev (LUT) 
je nejvhodnìjší, a použít ji pro vybrané obrazy ve stupnicí šedi. 
V pøípadì potøeby lze také zmìnit barvy výsledných 
“pseudobarevných snímkù” použitím odlišných barevných 
tabulek LUT pro snímky. Po uložení obrazù s pøíslušnými 
tabulkami LUT budete moci zobrazit nìkolik rùzných verzí 
obrazù. 
 

E.4

Otevøení tabulka 
vyhledávání barev E.4

✧ Vyberte jeden nebo více snímkù, u kterých chcete použít 
barevnou tabulku LUT (buï pro zobrazení snímkù se stupnicí 
šedi, nebo pro zmìny barvy u pseudobarevných snímkù).

✧ V hlavní nabídce vyberte položku Image > Color Lookup 
Table....

E.4
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Prohlížení Zpracování snímkù
 
Otevøe se dialogové okno Color Lookup Table. 

E.4

➭ Toto dialogové okno se otevøe pouze v pøípadì, že jeden nebo 
více obrazù je obrazem se stupnicí šedi nebo 
pseudobarevným obrazem. 
 

Použití tabulky barev E.4 První položkou v seznamu je název barevné tabulky, která je již 
u snímku použita. E.4

✧ Ve výbìrovém seznamu Color Lookup Table vyberte 
barevnou tabulku.

✧ Chcete-li použít barevnou tabulku zobrazenou pro vybrané 
snímky, klepnìte na tlaèítko Apply.

✧ Jestliže nechcete provést žádné zmìny, kliknìte na tlaèítko 
Cancel. 

Zavøení tabulky vyhledávání 
barev E.4

✧ Jestliže chcete pro vybrané snímky použít zobrazenou 
tabulku barev a zavøít dialogové okno, klepnìte na tlaèítko 
OK.
Verze VE31D E.4–21 
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Zpracování snímkù Prohlížení
Zvìtšování a posun snímkù E.4

Èásti obrazù, které vás obzvláštì zajímají, mùžete zvìtšit. Pokud 
je zvìtšený obraz pøíliš velký na to, aby mohl být zobrazen v 
segmentu, mùžete jej pomocí techniky posunu pøesunout tak, 
aby se oblast zájmu ocitla opìt v centrální èásti obrazu. 
 
 

E.4

Zobrazení zvìtšených/zmenšených obrazù E.4

Karta úlohy Viewing nabízí nìkolik zpùsobù, jak zobrazit 
zvìtšené nebo zmenšené snímky. E.4

Dvojitá velikost/ 
polovièní velikost E.4

✧ Vyberte snímky, jejichž velikost chcete zmìnit.

E.4 ✧ Dvojnásobné zvìtšení nebo polovièní zmenšení se provádí na 
kartì dílèí úlohy Image kliknutím na tlaèítko Magnify by 0.5 
nebo Minify by 2.0. 

 
0.5 2.0

0.5 1 E.411 2
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Prohlížení Zpracování snímkù
Pøizpùsobení obrazu 
segmentu E.4

✧ Vyberte snímky, které chcete zpracovat.

✧ Pro zvìtšení/zmenšení obrazu na velikost segmentu zvolte 
pøíkaz Image > Fit to Segment.

Nebo E.4

E.4 ✧ Kliknìte na tlaèítko Fit to Segment na kartì dílèí úlohy 
Image.

Nebo E.4

✧ Vyberte položku Fit to Segment v místní nabídce (pravým 
tlaèítkem myši).

Snímek se zobrazí tak, aby jeho rozmìry pøesnì odpovídaly 
velikosti segmentu. E.4
Verze VE31D E.4–23 
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Zpracování snímkù Prohlížení
Vložení faktoru pøiblížení/
oddálení E.4

✧ Vyberte snímky, jejichž velikost chcete zmìnit.

E.4 ✧ Zvolením funkce Image > Zoom Factor... nebo kliknutím na 
tlaèítko Zoom Factor otevøete dialogové okno Zoom Factor.

 

✧ Zadejte faktor zvìtšení a zadání potvrïte tlaèítkem OK.

Obraz(y) se zvìtší nebo zmenší podle tohoto faktoru. 
E.4

Poøizovaná velikost E.4 ✧ V hlavní nabídce aktivujte položku Image > Acquisition Size.

Snímky se zobrazí s faktorem zvìtšení, s nímž byly snímky 
pùvodnì poøízeny. E.4
E.4–24 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Nastavování pøiblížení/
oddálení pomocí myši E.4

E.4 Levým tlaèítkem myši obvykle oznaèujete, pøípadnì rušíte 
oznaèení obrázkù a objektù. E.4

Nicménì levému tlaèítku myši mùžete namísto funkce výbìru 
pøiøadit také funkci pro zvìtšování a pøecentrování. E.4

✧ Zvolte Image > Zoom/Pan.

nebo E.4

E.4 ✧ Kliknìte na tlaèítko Zoom/Pan na kartì dílèí úlohy Image. 
 
 
 

E.4 ✧ Nyní umístìte kurzor myši do blízkosti okraje snímku. 

Kurzor myši zmìní tvar. E.4

✧ Pro zvìtšení obrázku táhnìte kurzorem myši nahoru s 
pøidržením stisknutého levého tlaèítka myši.

Nebo E.4

✧ Pro zmenšení obrazu táhnìte kurzorem myši dolù s 
pøidržením stisknutého levého tlaèítka myši. 
Verze VE31D E.4–25 
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Zpracování snímkù Prohlížení
 

+

-

Zmìna mìøítka

Zvìtšování Zmenšování
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Prohlížení Zpracování snímkù
Po uvolnìní tlaèítka myši bude nový faktor zvìtšení aplikován na 
všechny vybrané obrázky, pøípadnì na vybraný rámec èinnosti.E.4

!0

E.4 E.4

✧ Znovu zrušte volbu možnosti Image > Zoom/Pan nebo 
opìtovným kliknutím na tlaèítko zajistìte, aby levé tlaèítko 
myši bylo opìt k dispozici pro volbu obrazù. 
 

Pøi zvìtšování nebo zmenšování se snažte vyhnout 
náhodnému klepnutí na grafický prvek. Jinak dojde k pøesunutí 
grafického prvku a ne obsahu obrazu. E.4
Verze VE31D E.4–27 
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Zpracování snímkù Prohlížení
Obnovení mìøítka zvìtšení E.4 Pùvodní faktor pøiblížení/oddálení, které bylo s obrazy 
naposledy uloženo do databáze, lze kdykoliv obnovit. 

E.4

✧ Aktivujte položku Image > Home Zoom/Pan nebo v místní 
nabídce zvolte položku Home Zoom/Pan (pravým tlaèítkem 
myši).

Nebo E.4

E.4 ✧ Klepnìte na tlaèítko.
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Prohlížení Zpracování snímkù
Posun obrazù E.4

V dùsledku zmìnìné velikosti snímkù se mohly nìkteré èásti 
snímkù ocitnout mimo hranice segmentù snímku. E.4

Proto vždy daný obraz posuòte tak, aby se pøed uložením ocitla 
požadovaná diagnostická oblast opìt ve støedu segmentu. 
 

E.4

E.4 ✧ Nejprve zvolte funkci Image > Zoom/Pan, jako kdybyste 
chtìli provést pøiblížení/oddálení pomocí myši. Nebo 
kliknutím na tlaèítko Zoom/Pan na kartì dílèí úlohy Image 
pøepnìte funkci levého tlaèítka myši z výbìru na zmìnu 
pøiblížení/oddálení/posun. 

E.4 ✧ Nyní kurzor myši umístìte do centrální èásti snímku.

Kurzor myši zmìní tvar. E.4

✧ Pro pøecentrování obrázku táhnìte myší nahoru, dolù, 
doprava anebo doleva, s pøidržením stisknutého levého 
tlaèítka myši.
Verze VE31D E.4–29 
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Zpracování snímkù Prohlížení
 

 

Nahoru Dolù

posun

nahoru

dolù

posun

dopravadoleva

Doleva Doprava
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Prohlížení Zpracování snímkù
Výsledek pohybù myší se ihned zobrazí na snímku, na nìmž je 
kurzor myši umístìn. E.4

Ihned po uvolnìní tlaèítka myši bude obrázkový obsah všech 
vybraných obrázkù, pøípadnì obrázkù ve vybraném rámci 
èinnosti, posunut. E.4

!0

E.4 E.4

E.4

Obnovení zobrazení snímkuE.4 Podobnì jako v pøípadì zvìtšování a zmenšování mùžete i po 
pøesunutí snímkù snímky obnovit do stavu, v nìmž byly 
naposledy uloženy do databáze. E.4

✧ Pravým tlaèítkem myši otevøete místní nabídku a zvolte 
položku Home Zoom/Pan.

Nebo E.4

E.4 ✧ Klepnìte na tlaèítko.

Pøi pøesunování se snažte vyhnout náhodnému klepnutí na 
grafický prvek. Jinak dojde k pøesunutí grafického prvku a ne 
obsahu snímku. E.4
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Zpracování snímkù Prohlížení
Zvìtšení èásti snímku E.4

K posunutí obrazu tak, aby se jeho pøíslušná èást dostala opìt do 
støedu obrazovky (posun), mùžete místo zvìtšení velikosti 
obrazu (pomocí pøiblížení/oddálení), vybrat explicitní èásti 
obrazu a zobrazit je v rámci segmentu v maximální velikosti. 

E.4

✧ Zvolte snímky, v nichž chcete zobrazit zvìtšenou èást 
snímku.

✧ Zvolte položku Tools > Capture Area.

✧ Levým tlaèítkem myši klepnìte do jednoho ze zvolených 
obrázkù a myší vytáhnìte ètverec nebo obdélník.

Ihned po uvolnìní tlaèítka myši bude výøez zobrazen zvìtšený 
na celkovou velikost segmentu ve všech vybraných obrázcích. 
Pomìry velikostí se nezmìní. Výbìr nástroje pro zvìtšení bude 
nyní opìt zrušen. E.4

 

E.4–32 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení Zpracování snímkù
Otáèení, pøeklápìní a inverze E.4

Vedle výše popsaných metod urèených k zamìøování se na 
požadované diagnostické oblasti na lékaøských snímcích 
poskytuje karta úlohy Viewing celou øadu nástrojù, s jejichž 
pomocí mùžete tyto snímky mìnit. E.4

Mùžete napøíklad otoèit snímkem o libovolný úhel kolem osy z. 
Také mùžete snímky horizontálnì i vertikálnì pøeklápìt nebo 
pøevrátit hodnoty stupnice šedi snímkù. E.4

Tyto funkce se uplatní pøi porovnávání sérií získaných pøi 
rùzných polohách pacienta, rùzném sklonu gantry nebo 
rùzných smìrech vyšetøení. 

E.4
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Zpracování snímkù Prohlížení
Otáèení snímkù (Rotate) E.4

A¤ obrazy otáèíte o 90° nebo volnì, bude bodem otáèení vždy 
støed segmentu. 

E.4

Otoèení o 90° E.4 ✧ Vyberte snímky, které chcete otoèit.

E.4 ✧ Zvolte položku Image > Rotate 90 nebo klepnìte na tlaèítko 
Rotate 90 na kartì dílèí úlohy Image.

Snímek se otoèí o 90° ve smìru hodinových ruèièek. E.4
E.4–34 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Volnì definovaný úhel E.4 ✧ Zvolte položku Image > Rotate....

Zobrazí se dialogové okno, ve kterém mùžete zadat úhel 
otoèení. E.4

 

✧ Pro rotaci snímku (snímkù) ve smìru hodinových ruèièek 
zadejte kladnou hodnotu.

Nebo E.4

✧ Pro rotaci snímku (snímkù) proti smìru hodinových ruèièek 
zadejte zápornou hodnotu.

➭ Zadávat mùžete pouze celoèíselné hodnoty. 
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Zpracování snímkù Prohlížení
E.4

 

!0

E.4 E.4

Pùvodní snímek Otoèení o 120°

Pøi otoèení snímkù budou odstranìny veškeré grafické prvky a 
komentáøe, které jste vytvoøili. E.4

Orientaèní znaèka se otoèí spoleènì s obrazem (platí pouze pro 
obrazy CT, MR a NM). E.4
E.4–36 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Pøeklápìní snímkù (Flip) E.4

Pomocí funkce pøeklápìní mùžete jednodušeji porovnávat 
obrazy sérií, které byly poøízeny v rùzných polohách pacienta 
nebo pøi rùzných smìrech vyšetøení. 
 

E.4

Vertikální pøeklápìní 
snímkù E.4

✧ Zvolte snímky, které chcete pøeklopit.

E.4 ✧ Zvolte položku Image > Flip Vertically nebo klepnìte na 
tlaèítko Flip Vertically na kartì dílèí úlohy Image.

Obraz se pøeklopí kolem svislé osy. 
E.4

 

Jestliže obraz obsahuje informaci o orientaci, pøi pøeklopení 
obrazu se orientaèní znaèky zobrazí správnì. E.4
Verze VE31D E.4–37 
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Zpracování snímkù Prohlížení
Horizontální pøeklápìní 
obrazù E.4

E.4 ✧ Zvolte položku Image > Flip Horizontally nebo klepnìte na 
tlaèítko Flip Horizontally na kartì dílèí úlohy Image.

Obraz se pøeklopí kolem vodorovné osy. 
E.4

 

Oznaèení orientace se odpovídajícím zpùsobem zmìní. E.4

!0

E.4 E.4

Podobnì jako v pøípadì otáèení snímkù budou i po jejich 
pøeklopení odstranìny veškeré poznámky a grafické prvky. E.4
E.4–38 Návod k použití pro uživatele systému syngo
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Prohlížení Zpracování snímkù
Invertování obrazù (funkce Invert) E.4

Po inverzi snímku se svìtlé oblasti zobrazí tmavì a tmavé oblasti 
svìtle. Pøiøazení stupnice šedi v tabulce LUT (Look Up Table) se 
invertuje. 

E.4

✧ Zvolte snímky, které chcete upravit.

✧ Zvolte položku Image > Invert.

nebo E.4

E.4 ✧ Kliknìte na tlaèítko Invert na kartì dílèí úlohy Image. 

➭ Pùvodní pohled obnovíte opìtovným zvolením položky 
Image > Invert.
Verze VE31D E.4–39 
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Zpracování snímkù Prohlížení
E.4–40 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

E.5

 
2D vyhodnocení E.5
Na kartì úlohy Viewing máte k dispozici nástroje k 
vyhodnocování oblasti, mìøení vzdáleností, délek a úhlù, a dále 
nástroje k vyhodnocování obrazových bodù. E.5

Ve zvolených snímcích si také mùžete zobrazit møížku, která 
vám umožní pøesnìji odhadnout velikosti, vzdálenosti a úhly. E.5

Pomocí clony mùžete omezit požadovanou oblast na to, co je 
absolutnì nezbytné, a vylouèit tak veškeré nepodstatné 
oblasti. E.5

Na obrazy mùžete zadat text dokumentující vyhodnocení. E.5

Texty komentáøe mùžete k obrazùm v databázi zadávat a 
stávající texty komentáøe mùžete upravovat. 

E.5

➭ Nelze hodnotit snímky s atributem uložení SC. 
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2D vyhodnocení Prohlížení
Aktivace grafického 
nástroje E.5

Nástroje pro vytváøení grafiky a urèování hodnot obrazových 
bodù naleznete v nabídce Tools nebo na kartì dílèí úlohy Tools
v ovládací oblasti. E.5

E.5 ✧ Grafický nástroj aktivujete jeho vybráním v nabídce nebo 
kliknutím na pøíslušné tlaèítko. 
 
 

E.5 Kurzor myši se zmìní do podoby grafického kurzoru. E.5

Nyní mùžete nástroj používat až do doby, kdy ho opìt 
deaktivujete. Mùžete napøíklad do obrazu zakreslit nìkolik 
oblastí nebo vzdáleností jednu po druhé. 
 
 

E.5

Vypnutí grafického 
nástroje E.5

✧ Zrušte výbìr nástroje v nabídce.

Nebo E.5

E.5 ✧ Klepnìte opìt na pøíslušné tlaèítko.

Nebo E.5

✧ Stisknìte klávesu Esc na klávesnici.

Nebo E.5

✧ Zvolte jiný grafický nástroj.

Neaktivní Aktivní

NeaktivníAktivní
E.5–2 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Vìnujte pozornosti výbìru E.5 Grafické nástroje na kartì úlohy Viewing pracují implicitnì; 
nemusíte tedy explicitnì vybírat snímky, do nichž si pøejete 
zakreslovat grafiku. Staèí jednoduše umístit kurzor na pøíslušný 
snímek. Fokus se umístí na tento snímek. E.5

Pokud chcete vytvoøit grafický prvek ve více obrazech najednou, 
musíte nejprve tyto obrazy explicitnì oznaèit. 
→ Strana E.3–32, Výbìr snímkù E.5

➭ Upravit grafiku, tj. mìnit její velikost, mùžete pouze v jednom 
obrazu. 

Snímky s vícenásobným 
rámcem E.5

Grafické zpracování je stejné u obyèejných snímkù i snímkù s 
vícenásobným rámcem. E.5
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2D vyhodnocení Prohlížení
Vyhodnocení oblastí E.5

Na snímcích mùžete vyznaèit anomálie a následnì tyto oblasti 
vyhodnotit. Toho docílíte zakreslením grafiky ROI kolem oblasti, 
která vás zvláštì zajímá. Nyní mùžete statisticky vyhodnotit 
stupnice šedi v rámci dané oblasti zájmu (pouze CT, MR). 
 

E.5

Oblasti zájmu ROI mohou být následující: E.5

 

 
 

Obdélníkové a kruhové ROI E.5

Zvláštì dùležité oblasti mùžete vymezit pomocí kruhu nebo 
obdélníku a následnì je vyhodnotit. Nejprve zvolte nástroj. 

E.5

✧ Zvolte položku Tools > Circle nebo Tools > Rectangle.

Nebo E.5

E.5 ✧ Klepnìte na tlaèítko Circle nebo Rectangle na kartì dílèí 
úlohy Tools.

Kurzor myši zmìní tvar. E.5

Kruhová Obdélníková Volnì zakreslené 
oblasti nebo 

polygony
E.5–4 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
E.5 ✧ Kliknìte na obrázek a vyznaète ROI (obdélníkovou nebo 
kruhovou) se stisknutým tlaèítkem myši.

✧ Jakmile dosáhnete požadované velikosti ROI, tlaèítko myši 
uvolnìte.
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2D vyhodnocení Prohlížení
Zmìna velikosti a 
pøesouvání oblastí E.5

Pokud je obdélník nebo kruh pøíliš malý nebo naopak pøíliš velký 
nebo nebyl umístìn do správné polohy, mùžete ROI zmìnit. 
Jakmile umístíte kurzor do oblasti ROI, kurzor zmìní tvar a 
mùžete upravovat grafiku. E.5

E.5 ✧ Klepnutím na hranici oblasti ROI vyberte danou oblast.

Nebo E.5

✧ Umístìte kurzor myši na hranici oblasti ROI. 
 
 

E.5 ✧ Pomocí úchytù pro úpravu zvìtšete nebo zmenšete oblast 
tak, aby vyhovovala vašim požadavkùm

Nebo E.5

✧ Pøesuòte oblast na snímku umístìním kurzoru na hranièní 
èáru mezi úchyty pro úpravu.

E.5 ➭ Malou oblast zájmu pøesunete jednodušeji stisknutím klávesy 
Alt. Tím se kurzor automaticky pøepne do režimu pøesunu.

➭ U kruhových oblastí se nezobrazuje støed kružnice.
E.5–6 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Kreslení oblastí zájmu od ruky E.5

Pokud tvar kruhu nebo obdélníku nepøesnì popisuje 
pozorovanou oblast, mùžete namísto kruhu nebo obdélníku 
zakreslit mnohoúhelník nebo oblast od ruky. Tak pøesnìji 
vymezíte oblast zájmu oblast. 

E.5

✧ Zvolte položku Tools > Freehand ROI.

Nebo E.5

E.5 ✧ Kliknìte na tlaèítko Freehand ROI na kartì dílèí úlohy Tools. 
Vzhled kurzoru se zmìní. 
 

Pro volné zakreslování oblastí zájmu máte k dispozici dva 
zpùsoby: E.5

Kreslení bod po bodu 
(polygon) E.5

E.5 ✧ Klepnutím na snímek urèete poèáteèní bod a pøetažením 
myši zakreslete èáru k prvnímu vrcholu (bod zlomu).

✧ Zakreslete oblast bod po bodu klepnutím tlaèítkem myši pøi 
každé zmìnì smìru (definice polygonu).

✧ Jakmile poklepete na poslední vrchol, systém grafiku uzavøe.
Verze VE31D E.5–7 
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2D vyhodnocení Prohlížení
Volnì vykreslená oblast E.5

E.5 ✧ Klepnìte na snímek k urèení poèáteèního bodu.

✧ Podržte tlaèítko myši stisknuté a myší ohraniète vaši oblast 
zájmu.

✧ Poklepáním na koncový bod uzavøete oblast.

Program spojí poèáteèní a koncový bod a zobrazí od ruky 
zakreslenou oblast ROI. E.5

 

E.5–8 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení 2D vyhodnocení
Zvìtšování/zmenšování 
oblasti E.5

Podobnì jako u obdélníkù a kruhù mùžete také volnì zakreslené 
požadované oblasti snímku zvìtšovat, zmenšovat nebo 
pøesunovat. E.5

✧ Vyberte oblast tak, že na ni kliknete. 
Nyní se zobrazí úchyty.

✧ Velikost oblasti lze zmìnit tažením nìkterého z úchytù. 
 

Zmìna tvaru grafického 
objektu E.5

Mùžete také zmìnit tvar volnì zakreslené oblasti nebo 
polygonu. To provedete tak, že aktivujete režim úprav, v nìmž 
se u každého bodu zmìny smìru volnì zakreslené èáry zobrazí 
uzly. Tyto uzly mùžete pøesouvat, a tak mìnit tvar grafiky. E.5

✧ Nejprve zvolte oblast (levé tlaèítko myši).

✧ Poté zvolte Edit v kontextové nabídce (pravé tlaèítko myši).

Namísto úchytù se zobrazí uzly. E.5
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2D vyhodnocení Prohlížení
Vložení nového uzlu E.5 Vkládáním uzlù mùžete zvìtšit volnì zakreslené oblasti èi 
polygon, pøípadnì pøesnìji vymezit tvar grafiky. E.5

✧ Levým tlaèítkem myši kliknìte na èáru polygonu, t.j. na 
hranici zvolené oblasti mezi dvìma uzly.

✧ S pøidržením stisknutého tlaèítka myši pøetáhnìte èáru na 
jinou pozici v segmentu.

Bude pøidán nový uzel a oblast zùstane v režimu úprav. E.5
E.5–10 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Pøesouvání uzlu E.5 Tvar oblasti mùžete zmìnit pøesunutím jednotlivých uzlù. E.5

✧ Levým tlaèítkem myši kliknìte na jeden z uzlù.

✧ S pøidržením stisknutého tlaèítka myši pøetáhnìte uzel do 
nové pozice.

Uzel se pøesune a oblast zùstane v režimu úprav. E.5
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2D vyhodnocení Prohlížení
Zaoblení polygonu E.5 Hranu volnì zakreslené oblasti lze zaoblit. E.5

✧ Zvolte oblast a poté pøíkaz Edit.

E.5 ✧ Kurzorem myši klepnìte na danou oblast, ale ne na èáru 
nebo na uzel polygonu, a podržte tlaèítko myši. Tvar kurzoru 
myši se zmìní v kruh.

✧ Pøesuòte kruhový kurzor myši na hranici.

Když se kurzor myši dotkne èáry, všechny uzly se pøesunou ve 
smìru pohybu myši. E.5

 
 
 
 
 
 
 
 
 
 
 

➭ Velikost kurzoru myši závisí na tom, jak blízko k okraji 
polygonu klepnete. Pro pøesnìjší urèení kliknìte do tìsné 
blízkosti hranice, abyste napøíklad získali velmi malou 
kružnici. 

Ukonèení režimu úprav E.5 ✧ Levým tlaèítkem myši kliknìte na libovolný bod obrázku, 
vyjma hranice oblasti ROI.

Režim úprav bude ukonèen a výbìr oblasti zrušen. E.5
E.5–12 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Vyhodnocení ROI E.5

Po zakreslení hranice okolo oblastí pomocí kružnice, obdélníku 
nebo èáry od ruky bude zobrazeno statistické vyhodnocení 
oblasti ROI. E.5

Oblasti ROI jsou nyní oèíslovány. Pøed každým výsledkem 
vyhodnocení je zobrazeno èíslo oblasti ROI. Tím pøedejdete 
nedorozumìní E.5

 

(1) Limits 
Vyhodnocený rozsah stupnice šedi. Meze jsou 
zohledòovány v pøípadì následujících vyhodnocení.

(2) Min/Max  
Nejvyšší a nejnižší hodnota stupnice šedi

(3) Mean/SD  
Støední hodnota a smìrodatná odchylka stupnic šedi

(4) Number of pixels 
Poèet pixelù v oblasti zájmu

(5) Area (pouze CT, MR) 
Plocha oblasti zájmu v cm2
Verze VE31D E.5–13 
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2D vyhodnocení Prohlížení
Textový blok obsahující výsledky vyhodnocení mùžete 
pøesunout na libovolné místo ve snímku. E.5

✧ Kliknìte na textový blok a pøesuòte jej myší. 
 
 

Zobrazení/skrytí 
statistických vyhodnocení E.5

Zobrazení výsledkù vyhodnocení bylo nastaveno službou 
spoleènosti Siemens bìhem konfigurace systému. V oknì 
Viewing Configuration mùžete tato výchozí nastavení zmìnit. 
→ Strana E.7–2, Zobrazení výsledkù vyhodnocení E.5

Pokud chcete zmìnit nebo skrýt zobrazení výsledkù 
vyhodnocení pouze pro urèité požadované oblasti, otevøete 
dialogové okno Properties pro pøíslušnou oblast zájmu. 

E.5

✧ Vyberte oblast zájmu.

✧ Zvolte pøíkaz Edit > Properties... nebo vyvolejte Properties... 
z kontextové nabídky (pravé tlaèítko myši).

➭ Pokud oblast není zcela souèástí snímku (tj. pokud èerná 
hranièní oblast pøesahuje hranici snímku), není možné danou 
oblast vyhodnotit. Jako hodnota plochy se tedy zobrazí ”???”.
E.5–14 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Zobrazí se dialogové okno, ve kterém mùžete zmìnit zobrazení 
výsledkù vyhodnocení pro vybranou požadovanou oblast. E.5

 

✧ Klepnutím na zaškrtávací políèko pøíslušných výsledkù 
vyhodnocení daného øádku výsledkù zobrazíte nebo skryjete.

E.5 ✧ Chcete-li vyhodnocovat pouze ty pixely v dané oblasti zájmu, 
které se nacházejí v rozsahu stupnice šedi, který nyní mùžete 
definovat, zaškrtnìte políèko Limit. 
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2D vyhodnocení Prohlížení
Výpoèet histogramu E.5

V rámci plochy zakreslené oblasti zájmu mùžete zadat výpoèet 
rozdìlení a frekvenci stupnic šedi (nebo hodnoty 
Hounsfieldových jednotek). 
 

E.5

E.5 ✧ Zvolte položku Tools > Histogram.

Histogram bude umístìn pøes snímek. Pod popisem osy x bude 
vyznaèeno, ke které oblasti zájmu histogram náleží (napøíklad 
Pixel Values of Region 1). E.5

 

➭ Snímek se vždy uloží a nafilmuje nebo vytiskne se 
zobrazeným histogramem.
E.5–16 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Mìøení vzdáleností a úhlù E.5

Mùžete mìøit a vyhodnocovat nejen oblasti, ale také vzdálenosti 
a úhly na snímcích. E.5

E.5

E.5

UPOZORNÌNÍ

Mìøení v promítnutých obrazech E.5

Možná nesprávná diagnóza E.5

✧ V pøípadì promítnutých obrazù nepoužívejte mìøení k 
diagnostickým úèelùm.
Verze VE31D E.5–17 
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2D vyhodnocení Prohlížení
Kreslení mìøicí úseèky, mìøení vzdálenosti E.5

S použitím distanèní èáry mùžete zmìøit vzdálenost mezi dvìma 
body na snímku. Pro tuto èáru si také mùžete zobrazit statistické 
vyhodnocení stupnic šedi. 
 

E.5

Kreslení distanèní èáry E.5 ✧ Zvolte pøíkaz Tools > Distance.

Nebo E.5

E.5 ✧ Klepnìte na tlaèítko Distance na kartì dílèí úlohy Tools.

Kurzor myši zmìní tvar. 
E.5

✧ Umístìte kurzor myši do poèáteèního bodu distanèní èáry.

✧ Levé tlaèítko myši podržte stisknuté a natáhnìte èáru.

Jakmile pohnete myší, bude zobrazena délka doposud 
zakreslené pøímky. E.5

✧ Uvolnìním tlaèítka myši èáru zakonèíte.
E.5–18 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
 

(1) Støed 
Støed èáry

(2) Vzdálenost 
Vzdálenost mezi poèáteèním a koncovým bodem

(3) Min/Max 
Minimální/maximální hodnota stupnice šedi na pøímce
Verze VE31D E.5–19 
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2D vyhodnocení Prohlížení
Zmìna distanèní èáry E.5 ✧ Levým tlaèítkem myši kliknìte na distanèní èáru.

Nebo E.5

✧ Na èáru umístìte kurzor myši. 

V upravovatelných místech èáry zmìní kurzor myši tvar. 
E.5

E.5 ✧ Pøetáhnìte poèáteèní nebo koncový bod èáry do jiné polohy.

Pøi pøesouvání kurzoru myši je vzdálenost prùbìžnì 
aktualizována. 
 

E.5

Nebo E.5

E.5 ✧ Pøesuòte celou distanèní èáru na jiné místo. 
 
 
 

E.5–20 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení 2D vyhodnocení
Zobrazení/skrytí 
statistických vyhodnocení E.5

Podobnì jako u oblastí mùžete i v pøípadì vzdáleností jednotlivì 
zobrazovat èi skrývat statistické údaje. E.5

✧ Zvolte distanèní èáru (levé tlaèítko myši).

✧ Pravým tlaèítkem myši kliknìte na zvolenou distanèní èáru a 
v kontextové nabídce zvolte položku Properties....

Nebo E.5

E.5 ✧ Pravým tlaèítkem myši kliknìte na tlaèítko Distance a v 
kontextové nabídce zvolte položku Properties....

Zobrazí se dialogové okno Distance Properties. E.5

 

✧ Vyberte výsledky vyhodnocení, které chcete pro svou 
distanèní èáru zobrazit.
Verze VE31D E.5–21 
únor 2006

 0.0



2D vyhodnocení Prohlížení
Volné zakreslení èáry, mìøení vzdálenosti E.5

Mìøit mùžete nejen pøímou vzdálenost mezi dvìma body, ale s 
pomocí zakreslení tvaru od ruky také délku struktury, napø. 
cévy. 

E.5

✧ Zvolte pøíkaz Tools > Freehand Distance.

nebo E.5

E.5 ✧ Na kartì dílèí úlohy Tools kliknìte na tlaèítko Freehand 
Distance. 
 
 
 

Bod po bodu E.5

E.5 ✧ Kurzor myši umístìte do segmentu a levým tlaèítkem myši 
kliknìte na výchozí bod vaší èáry. 
Tvar kurzoru myši se zmìní. 

✧ Klepnìte na první bod, ve kterém má èára zmìnit smìr.

✧ Poté klepnìte na další bod atd., dokud bod po bodu 
nezakreslíte celou èáru od ruky.

✧ Poklepejte na koncový bod.
E.5–22 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Kreslení èáry od ruky E.5

E.5 ✧ Levým tlaèítkem myši kliknìte na výchozí bod vaší èáry od 
ruky.

✧ S pøidržením stisknutého levého tlaèítka myši zakreslete 
pøíslušnou strukturu.

✧ Dvojitì kliknìte na koncový bod. 

➭ Podobnì jako u volnì zakreslené požadované oblasti mùžete 
tvar volnì zakreslené distanèní èáry následnì zmìnit úpravou 
jejích uzlù. 
 

E.5 U nìkterých aplikací mùže být nezbytné volnì zakreslit èáru 
skládající se z definice polygonu a volnì zakreslené èáry. E.5

Dokud nepoklepete na koncový bod, mùžete obì metody, 
zadání polygonu a volné zakreslení èáry, kombinovat. E.5
Verze VE31D E.5–23 
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2D vyhodnocení Prohlížení
Po dokonèení èáry zakreslené od ruky budou zobrazeny 
následující hodnoty. E.5

 

(1) Délka 
Délka èáry

(2) Min/Max  
Minimální/maximální hodnota stupnice šedi na èáøe
E.5–24 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Zobrazení/skrytí 
statistických vyhodnocení E.5

Pokud si nepøejete zobrazit jednu nebo více hodnot týkajících se 
vaší èáry od ruky, vyvolejte dialogové okno Freehand Distance 
Properties. E.5

✧ Zvolte èáru od ruky (levé tlaèítko myši).

✧ Pravým tlaèítkem myši kliknìte na zvolenou èáru a v 
kontextové nabídce zvolte položku Properties....

Nebo E.5

E.5 ✧ Pravým tlaèítkem myši klepnìte na tlaèítko Freehand 
Distance a zvolte položku Properties... v místní nabídce.

 

✧ Zvolte nebo zrušte volbu výsledkù vyhodnocení, které chcete 
(nebo nechcete) zobrazit.
Verze VE31D E.5–25 
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Výpoèet profilu E.5

Profil rozdìlení a frekvence stupnic šedi (nebo HU hodnot) 
mùžete vypoèítat souèasnì s mìøením vzdálenosti nebo volnì 
zakreslenou èárou. 
 

E.5

✧ Zvolte pøíkaz Tools > Profile.

Profil bude umístìn na daný snímek. Pod popisem osy x je 
vyznaèeno, ke které èáøe profil náleží (napøíklad Pixel Values 
of 1). E.5

 

➭ V pøípadì volby se snímek vždy uloží a nafilmuje/vytiskne se 
zobrazenými profily.
E.5–26 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Mìøení úhlu E.5

Úhel mùžete definovat pomocí dvou èar – ramen úhlu –, které 
zakreslíte do snímku. Systém poté vypoèítá úhel, který svírají 
tato dvì ramena zakreslená ve smìru hodinových ruèièek. 
Pokud je úhel vìtší než 180°, program odeète hodnotu 180°. E.5

 

Smìr šipky oznaèuje smìr, ve kterém jste zakreslili ramena 
úhlu. E.5

(1) Obì ramena byla zakreslena ve smìru prùseèíku. Bude 
zobrazen úhel A mezi rameny.

(2) Obì ramena byla zakreslena smìrem od prùseèíku. Bude 
zobrazen úhel A mezi rameny.

(3) Jinak bude zobrazen úhel B (A - 180).

(1) (2) (3)

A

A

A

B

Verze VE31D E.5–27 
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2D vyhodnocení Prohlížení
E.5 ✧ Zvolte položku Tools > Angle.

Nebo E.5

E.5 ✧ Klepnìte na tlaèítko Angle na kartì dílèí úlohy Tools.

✧ Umístìte kurzor myši do poèáteèního bodu prvního ramene. 
Tvar kurzoru myši se zmìní. 

✧ S pøidržením stisknutého levého tlaèítka myši vytáhnìte èáru 
ke koncovému bodu prvního ramene.

✧ Stejným zpùsobem zakreslete druhé rameno. 

Jakmile zaènete zakreslovat druhé rameno, bude vypoètena 
velikost úhlu. 
 

E.5

➭ Mìøit úhel mùžete i mezi èarami ve snímku, které se 
neprotínají. Program automaticky spoète bod prùseèíku i v 
pøípadì, že tento prùseèík není zakreslen nebo se nachází za 
hranicí snímku.
E.5–28 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
 

Obìma ramenùm úhlu je pøiøazeno stejné èíslo, proto lze rùzné 
úhly jednoznaènì rozlišit. 

E.5
Verze VE31D E.5–29 
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2D vyhodnocení Prohlížení
Zmìna úhlu E.5 Ramena úhlu mùžete nezávisle mìnit. E.5

✧ Pøesuòte kurzor myši do snímku.

V místech, kde lze zmìnit rameno úhlu, se tvar kurzoru myši 
zmìní. E.5

✧ Pøesuòte celou èáru nebo pøetáhnìte koncový bod na jiné 
místo.

Velikost úhlu je prùbìžnì aktualizována. 
E.5
E.5–30 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Zmìna smìru úhlu E.5 Mùžete také zobrazit doplòkový úhel (180° – zmìøený úhel). E.5

✧ Zvolte úhel.

✧ Pravým tlaèítkem myši vyvolejte kontextovou nabídku a 
zvolte položku Other Angle.

Úhel se nyní zmìøí proti smìru hodinových ruèièek a zobrazí se 
nová hodnota. E.5

!0

E.5 E.5

Úhel mezi rameny Doplòkový úhel

Pokud se velikost úhlu blíží 90°, 180° èi 270°, není zøejmé, zda 
byl zadán úhel mezi rameny, nebo úhel doplòkový. E.5

➭ Pøi zobrazení doplòkového úhlu tento úhel popište.
Verze VE31D E.5–31 
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2D vyhodnocení Prohlížení
Úhel pøes 2 snímky E.5 ✧ Zvolte snímky.

✧ Zakreslete úhel do jednoho snímku.

Úhel se zakreslí také do snímku 2. E.5

✧ Upravte úhel na druhém snímku.

➭ Oprava bude viditelná pouze na snímku 2 a neprovede se na 
snímku 1.

Úhel na snímku 1 Úhel na snímku 2
E.5–32 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Mìøení pixelù pomocí nitkového køíže E.5

Pøi pøípravì radiaèní terapie zobrazujete nitkový køíž za úèelem 
mìøení obrazových bodù. Pomocí nitkového køíže mùžete u 
nìkolika obrazù souèasnì urèit polohu obrazových bodù a úhlù 
vzhledem k poèáteènímu bodu a dvìma osám svírajícím pravý 
úhel. 
 

E.5

Zobrazení nitkového køíže E.5 ✧ Zvolte obraz nebo obrazy, ve kterých si pøejete nitkový køíž 
zobrazit.

✧ Aktivujte položkuTools > Crosshair.

Nebo E.5

 E.5

✧ Klepnìte na ikonu Crosshair na kartì dílèí úlohy Tools v 
ovládací oblasti.

✧ Umístìte nitkový køíž do jednoho ze zvolených obrazù 
kliknutím na požadovanou pozici.

Nebo E.5

✧ Kliknìte na jeden ze zvolených obrazù a podržte tlaèítko 
myši.

✧ Pøetáhnìte nitkový køíž na požadovanou pozici a uvolnìte 
tlaèítko myši.

Nitkový køíž se zobrazí na zvolených obrazech. E.5
Verze VE31D E.5–33 
únor 2006

 0.0



2D vyhodnocení Prohlížení
Mìøení pomocí nitkového 
køíže E.5

✧ Po umístìní nitkového køíže kliknìte na ty body obrazu, 
jejichž polohu chcete urèit.

Všechny body mìøení, které nastavíte na jednom obrazu, se 
souèasnì zobrazí na všech ostatních zvolených obrazech. První 
nastavený bod mìøení se stane støedovým bodem nitkového 
køíže pro zvolené obrazy, u nichž ještì nitkový køíž zobrazen 
není. E.5

V závislosti na nastavení se zobrazí souøadnice daného bodu 
nebo jeho vzdálenost od pùvodního místa a úhlu k ose x. E.5

✧ Klepnìte postupnì na všechny obrazové body, které chcete 
zmìøit.

Nitkový køíž a body mìøení budou uloženy zároveò s obrazem, 
bude je tedy možné spoleènì s tímto obrazem exponovat na 
film, pøípadnì vytisknout. 
 

E.5

Nesprávná pozice nitkového 
køíže E.5

Pøesunout nitkový køíž nelze. Nesprávnì umístìné nitkové køíže 
je nutné odstranit a vytvoøit znovu. 
 

E.5

Zmìna zpùsobu mìøení E.5 ✧ Kliknutím na jednu z os nitkového køíže danou osu zvolte.

✧ Aktivujte položku Edit > Properties... nebo v místní nabídce 
zvolte položku Properties....

Zobrazí se dialogové okno Crosshair Properties. E.5

E.5 ✧ Pro výpoèet souøadnic obrazových bodù zvolte pod položkou 
Coordinate System možnost Carthesian.

Nebo E.5

✧ Po kliknutí na možnost Polar se zobrazí vzdálenost mezi 
bodem mìøení a pùvodním bodem a úhel mezi danou 
distanèní èárou a osou X. 

E.5
E.5–34 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
E.5

✧ Klepnutím na tlaèítko OK volbu potvrïte a zavøete dialogové 
okno.

✧ Nyní klepnìte na ostatní obrazové body a zmìøte je pomocí 
nové metody.
Verze VE31D E.5–35 
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2D vyhodnocení Prohlížení
Vyhodnocení obrazových bodù, 
èoèka obrazového bodu E.5

Pomocí èoèky obrazových bodù mùžete zobrazit prùmìrnou 
hodnotu šedé škály (napø. Hounsfieldovy hodnoty pro obrazy 
CT) v malé oblasti 5 x 5 obrazových bodù. E.5

✧ Zvolte položku Tools > Pixel Lens.

Nebo E.5

E.5 ✧ Kliknìte na tlaèítko Pixel Lens na kartì dílèí úlohy Tools. 
 
 

E.5 Kurzor zmìní tvar. Zobrazí se hodnota obrazového bodu v 
poloze kurzoru na obrazu. 
 

E.5

Prùbìžné zobrazování 
hodnot pixelù E.5

Hodnoty obrazových bodù, které pro vás mají zvláštní význam, 
mùžete ve snímku prùbìžnì zobrazovat. E.5

✧ Kliknìte na obrázek levým tlaèítkem myši.
E.5–36 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Tím je obrazový bod oznaèen; hodnota obrazového bodu se 
zobrazí vedle znaèky. E.5

Oznaèením je malý kroužek nemìnné velikosti. E.5

➭ Mùžete pøesunout i trvale zobrazenou znaèku obrazových 
bodù tohoto typu; hodnota bude poté aktualizována.

!0

E.5 E.5

Oznaèení obrazového bodu neodpovídá aktuálnì zmìøené 
ploše o velikosti 5 x 5 obrazových bodù. Oznaèení má 
nemìnnou velikost a nezávisí na faktoru zvìtšení/zmenšení 
snímku. E.5
Verze VE31D E.5–37 
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2D vyhodnocení Prohlížení
E.5

E.5

E.5

UPOZORNÌNÍ

Použití èoèky obrazových bodù u obrazù NM E.5

Èoèka obrazových bodù mùže zobrazit nesprávné 
hodnoty. E.5

✧ Nepoužívejte èoèku obrazového bodu u snímkù NM (MPR) 
založených na poètu událostí (nebo aktivitì). Èoèka 
obrazových bodù zobrazí u tìchto obrazù nesprávné 
hodnoty, protože slouží pouze k mìøení denzit.

E.5

UPOZORNÌNÍ

Používejte èoèku obrazových bodù na kartì Viewer a 3D E.5

Èoèka obrazových bodù mùže zobrazovat odlišné 
hodnoty. E.5

✧ Uvìdomte si, že v mìøení pixelových èoèek existují rozdíly. 
Mìøení èoèek obrazových bodù na kartì Viewer uvažuje 
obdélník okolo bodu, na který kliknete, zatímco mìøení na 
kartì 3D uvažuje krychli okolo bodu, na který kliknete.
E.5–38 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Minimální støední hodnota E.5 V závislosti na konfiguraci systému se prùmìrná hodnota 
stupnice šedi èoèky obrazového bodu zobrazí v pravém dolním 
rohu snímku vedle hodnot vyvážení, i když je èoèka obrazového 
bodu deaktivována. Tvoøí ji hodnoty (5 ξ 5 obrazových bodù) 
èoèky obrazového bodu. Pøed støední hodnotou se zobrazí 
písmeno M. Tato hodnota je urèena pro aktuální pozici kurzoru 
myši. 

E.5

 

(1) Hodnota obrazového bodu 
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Nastavení clony E.5

Nepodstatné oblasti snímku mùžete skrýt. To provedete tak, že 
pøes snímek umístíte clonu. E.5

Poté se zobrazí pouze oblast uvnitø clony a veškeré okolní oblasti 
se zobrazí èernì. E.5

➭ Na jeden snímek nebo snímek s vícenásobným rámcem lze 
nastavit pouze jednu clonu. Pøi nastavování rùzných clon u 
rùzných rámcù snímku s vícenásobným rámcem program 
vezme v úvahu clonu v prvním rámci.

Nastavení clony E.5 ✧ Zvolte pøíkaz Tools > Shutter.

nebo E.5

E.5 ✧ Kliknìte na tlaèítko Shutter na kartì dílèí úlohy Tools. 
 

E.5 ✧ Umístìte kurzor myši do rohu oblasti obrazu, kterou chcete 
zobrazit. 
Tvar kurzoru myši se zmìní.

✧ S pøidržením stisknutého levého tlaèítka myši vytáhnìte 
obdélník vyznaèující oblast clony.

➭ Klepnutím na hranici snímku mùžete vybrat urèitou clonu a 
poté ji pøesunout nebo zmìnit její velikost.
E.5–40 Návod k použití pro uživatele systému syngo
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Po uvolnìní tlaèítka myši se oblast mimo clonu zobrazí èernì. E.5

 

Odstranìní clony E.5 ✧ Klepnutím na hranici clony danou clonu vyberte.

Nebo E.5

✧ Pokud jste v rámci série nastavili nìkolik clon, zvolte pøíkaz 
Edit > Select > All Shutters in Series.

Nebo E.5

✧ Zvolte položku Edit > Select > All Shutters. 

Budou zvolena všechna nastavení clon. 
E.5

✧ Zvolte položku Edit > Delete Graphics nebo z místní nabídky 
zvolte položku Delete.

Nebo E.5

✧ Celou sérii v pùvodním pohledu zobrazíte stisknutím klávesy 
Del na klávesnici.

➭ Snímky s vícenásobným rámcem mají vždy stejnou clonu. 
Pokud byly snímky pøesunuty nebo pokud byla jejich velikost 
zmìnìna, provedená zmìna bude aplikována na všechny 
snímky.
Verze VE31D E.5–41 
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Práce s møížkami E.5

Orientaci a odhad velikostí a úhlù na snímcích si mùžete 
usnadnit zobrazením møížky na zvolených snímcích. E.5

Møížka se skládá z rovnobìžných horizontálních a vertikálních 
èar. Vzdálenost mezi èarami møížky (šíøku møížky) lze podle 
potøeby upravit. E.5

Møížka a její nastavení se uloží spoleènì s pøíslušnými obrazy. 
 

E.5

Zobrazení møížky E.5 ✧ Zvolte snímek nebo snímky, na nichž si pøejete møížku 
zobrazit.

✧ Pro zobrazení møížky zvolte pøíkaz View > Scalegrid.

E.5
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Zmìna nastavení møížky E.5 ✧ Klepnutím na jednu z èar møížek møížku oznaète.

✧ Zvolte pøíkaz Edit > Properties... v hlavní nabídce nebo 
zvolte Properties... v kontextové nabídce (pravé tlaèítko 
myši).

Zobrazí se dialogové okno Scalegrid Properties. E.5

 

✧ Pomocí èíselníku Distance zvolte novou vzdálenost møížky. 
Šíøka møížky se zmìní.

✧ Klepnutím na tlaèítko OK potvrïte zmìny v nastavení møížky; 
dialogové okno se zavøe.

Pøi zvìtšování nebo zmenšování snímkù se šíøka møížky 
pøizpùsobí novým rozmìrùm. Když pøesunete støed snímku 
(posun), pøesune se také møížka. E.5
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Odstranìní møížky E.5 ✧ Klepnutím na jednu z èar møížek møížku znovu oznaète.

✧ Zvolte položku Edit > Delete Graphics nebo z místní nabídky 
zvolte položku Delete.

Nebo E.5

✧ Stisknìte klávesu Del na klávesnici.

Møížka bude ze všech oznaèených snímkù opìt odstranìna. E.5
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Text na snímcích E.5

Zajímavé èi anomální oblasti na snímku mùžete opatøit 
poznámkami. Také mùžete kdykoliv upravit døíve vytvoøené 
poznámky. E.5

U nìkterých modalit mùžete s poøízenou sérií ukládat také texty 
komentáøù. Tyto texty komentáøe se zobrazí i na obrazech a lze 
je zmìnit. 
 

E.5

Zadávání komentáøù E.5

Již zadané popisy obrazù mùžete kdykoli zmìnit. 
E.5

✧ Zvolte položku Tools > Annotate.

Nebo E.5

E.5 ✧ Kliknìte na tlaèítko Annotate na kartì dílèí úlohy Tools. 
Tvar kurzoru myši se zmìní. 

✧ Levým tlaèítkem myši kliknìte na pozici na obrázku, kam si 
pøejete vložit textový komentáø.

Kurzor myši se zmìní na textový kurzor (malý obdélník). 
E.5
Verze VE31D E.5–45 
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2D vyhodnocení Prohlížení
E.5 ✧ Nyní zadejte text.

Znak ukonèení øádku mùžete vložit stisknutím Shift + Return.E.5

✧ Stisknutím klávesy Return ukonèíte zadávání textu.

Nebo E.5

✧ Klepnìte do oblasti snímku mimo zadaný text.

E.5 Text bude zobrazen bíle a vystínován. E.5

Velikost písma ani zarovnání textu není možné mìnit. 
E.5

Pøesunutí textu E.5 ✧ Levým tlaèítkem myši kliknìte na text, avšak nikoliv na 
úchyty pro úpravu.

E.5 ✧ Pøetáhnìte text do nové polohy. 
 
 

E.5–46 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Zmìna textu E.5 ✧ Dvojitì kliknìte na text levým tlaèítkem myši a zmìòte jej. 
Kurzor myši se zmìní na textový kurzor (obdélník) a umístí se 
na první pozici textu.

✧ Nyní lze text zmìnit nebo rozšíøit.

✧ Režim úprav zavøete klepnutím na libovolnou oblast snímku 
mimo rámec textu nebo stisknutím klávesy Return.

Text se opìt zobrazí bez pozadí a rámce. 
E.5

Ukotvený text poznámky E.5 Pokud si pøejete vytvoøit text opatøený šipkou, nakreslete šipku 
s pøidržením stisknutého levého tlaèítka myši a poté vložte váš 
text do vstupního textového pole (na koncové pozici šipky).  

E.5

Úprava komentáøù k obrazu E.5

Pokud se u nìkterých (pøípadnì u všech) snímkù zobrazují texty 
komentáøù, mùžete je upravit. Ke snímkùm neobsahujícím 
žádný komentáø mùžete texty komentáøe pøidat. E.5

➭ Texty komentáøe se zobrazí pouze v pøípadì, že byly 
nakonfigurovány v oknì Editor. 
→ Strana A.4–8, Konfigurace textu snímkù 

✧ Umístìte fokus na obraz, jehož komentáø chcete upravit, 
nebo obraz oznaète explicitnì. 
→ Strana E.3–32, Výbìr snímkù

✧ Zvolte položku Edit > Comment v hlavní nabídce nebo 
aktivujte položku Edit Comment v místní nabídce.
Verze VE31D E.5–47 
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2D vyhodnocení Prohlížení
Nyní se textový kurzor zobrazí na zaèátku prvního øádku 
komentáøe. E.5

✧ Pøepište, vymažte nebo rozšiøte text komentáøe.

Znak ukonèení øádku mùžete vložit stisknutím Shift + Return.E.5

✧ Stisknutím klávesy Return ukonèíte zadávání textu.

Nebo E.5

✧ Klepnìte do oblasti snímku mimo zadaný text.

➭ Dva øádky textu jsou považovány za oddìlené objekty. Øádek 
není automaticky ukonèován.
E.5–48 Návod k použití pro uživatele systému syngo
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Prohlížení 2D vyhodnocení
Úprava grafiky a jejích textových 
prvkù E.5

Chcete-li grafiku a texty poznámek vymazat, vyjmout, kopírovat 
nebo vložit na novou pozici, mùžete veškerou grafiku a všechny 
poznámky (kromì clon) vytvoøené pøi vyhodnocování obrazù 
vybrat jednotlivì nebo spoleènì. 
 

E.5

Výbìr/Zrušení výbìru 
veškeré grafiky a textù E.5

✧ Pro oznaèení všech grafických prvkù a textù k obrazu u všech 
explicitnì vybraných obrazù zvolte pøíkaz Edit > Select > All 
Graphics.

Nebo E.5

✧ Pro oznaèení grafických prvkù a textù k obrazu u všech 
implicitnì (vèetnì vstupního fokusu) nebo explicitnì 
vybraných obrazù zvolte Select All Graphics v místní 
nabídce (pravé tlaèítko myši kdekoliv na obrazu). 
 
 

✧ Výbìr oznaèené grafiky a oznaèených textù u všech snímkù 
zrušíte klepnutím na segment (nikoli však na pøíslušnou 
grafiku èi text).

Standardní fokus je nastaven. E.5

➭ Snímky a grafiku nelze vybrat dohromady. Pokud vyberete 
grafický objekt, zruší se výbìr všech snímkù a fokus se umístí 
na snímek související s daným grafickým objektem.
Verze VE31D E.5–49 
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2D vyhodnocení Prohlížení
Kopírování, vyjímání a 
vkládání grafických 
objektù E.5

Vybrané grafické a textové prvky mùžete jednotlivì nebo 
hromadnì kopírovat èi vyjímat z obrazu a vkládat je do jiného 
obrazu stejného pacienta. 

E.5

✧ Vyberte jeden, nìkolik nebo všechny grafické a textové prvky 
na obrazu. 

✧ Zvolené grafické a textové prvky zkopírujete do schránky 
zvolením položky Edit > Copy nebo zvolením položky Copy v 
místní nabídce, nebo pomocí klávesové zkratky Ctrl + C.

Nebo E.5

✧ Zvolené grafické a textové prvky zkopírujete do schránky 
zvolením položky Edit > Cut nebo zvolením položky Cut v 
místní nabídce, nebo pomocí klávesové zkratky Ctrl + X.

→ Strana A.2–15, Pøesouvání a kopírování objektù E.5
E.5–50 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení 2D vyhodnocení
Nyní mùžete grafické a textové prvky pøesunout ze schránky do 
jiného snímku. E.5

✧ Explicitnì snímek oznaète nebo na snímek umístìte fokus.

✧ Zvolte položku Edit > Paste.

Nebo E.5

✧ Kurzor myši umístìte na snímek, do kterého chcete grafiku 
vložit.

✧ Kliknutím pravého tlaèítka v místní nabídce zvolte položku 
Paste. 

➭ Pokud jsou faktory pøiblížení/oddálení pùvodního a cílového 
obrazu rozdílné, pøizpùsobí se velikost grafiky novému 
obrazu. 
 

Vymazání grafiky E.5 Pokud již zvolené grafické a textové prvky nepoužíváte, mùžete 
je odstranit. E.5

✧ Zvolte jeden, nìkolik nebo všechny grafické a textové prvky.

✧ V místní nabídce zvolte položku Edit > Delete Graphics nebo 
položku Delete.

Nebo E.5

✧ Stisknìte klávesu Del na klávesnici.

Vybrané grafické prvky a poznámky budou odstranìny. 
E.5

E.5
Verze VE31D E.5–51 
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2D vyhodnocení Prohlížení
E.5–52 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

E.6

Uložení a dokumentace 
obrazù E.6
Po zpracování snímkù, jsou-li všechny snímky optimálnì 
zobrazeny a vyhodnoceny, mùžete snímky uložit, archivovat 
nebo pøevést k dalšímu vyhodnocování a dokumentaci, 
popøípadì k dodateènému trojrozmìrnému zpracování. E.6

Poté mùžete snímky daného pacienta zavøít a uvolnit tak na 
kartì úlohy Viewing místo pro snímky dalšího pacienta. E.6
Verze VE31D E.6–1 
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Uložení a dokumentace obrazù Prohlížení
Uložení snímkù E.6

Po dokonèení zpracování a vyhodnocení snímkù výsledky 
uložte. E.6

Snímky lze ukládat dvìma rùznými zpùsoby: E.6

❏ zpracované obrazy mùžete umístit do nové série nebo
❏ mùžete obrazy pøidat ke stávající sérii. 

Pøed každým uložením systém zkontroluje, zda je kapacita 
pevného disku pro uložení tìchto snímkù dostaèující. E.6

Jestliže není k dispozici dostateèná pamì¤ová kapacita, objeví se 
okno s hlášením. E.6

✧ V tomto pøípadì pøed uložením obrazù odstraòte z pevného 
disku veškerá data, která již nepotøebujete a která jsou již 
archivována. 
→ Strana C.6–8, Odstraòování dat

➭ Když uložíte snímky s vícenásobným rámcem znovu, nebude 
s nimi systém zacházet jako se snímky s vícenásobným 
rámcem, ale jako s bìžnými snímky.

E.6

E.6

UPOZORNÌNÍ

Modifikace v lékaøských obrazech nejsou automaticky 
ukládány stejným zpùsobem jako obrazové komentáøe. 
Kromì toho v pøípadì, že dojde ke zmìnì uživatele, když nový 
uživatel nemá náležitá pøístupová oprávnìní, mohou být 
ztraceny i zmìny obrazových textù. E.6

Úpravy obrazù se mohou ztratit. E.6

✧ Pomocí Patient > Save as... uložíte obraz s úpravami jako 
nový obraz. 
E.6–2 Návod k použití pro uživatele systému syngo
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Prohlížení Uložení a dokumentace obrazù
Otevøení dialogového okna 
Save As E.6

Do jedné série lze spoleènì uložit pouze snímky stejné studie. E.6

✧ Nejprve zvolte snímky nebo série, které chcete uložit.

✧ Zvolte pøíkaz Patient > Save As....

Nebo E.6

E.6 ✧ Klepnìte na tlaèítko Save As ve spodní èásti ovládací oblasti.

Zobrazí se dialogové okno Save As. E.6

 

Verze VE31D E.6–3 
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Uložení a dokumentace obrazù Prohlížení
Uložení obrazù jako nové 
série E.6

Všechny vybrané snímky mùžete uložit jako novou sérii. 
Pùvodní série zùstane nezmìnìna. Zpracované a vyhodnocené 
obrazy pak mùžete snadno porovnat s obrazy pùvodní studie. 

E.6

 

✧ V dialogovém oknì Save As klepnìte na možnost Save 
images in new series. 

✧ Do vstupního textového pole zadejte popis nové série. Ve 
výchozím nastavení bude automaticky vygenerováno èíslo 
série.

✧ Potvrïte operaci tlaèítkem OK a obrazy budou uloženy jako 
nová série. 

➭ Pokud již pùvodní sérii nebudete potøebovat, mùžete ji v 
Patient Browser odstranit. 
→ Strana C.6–8, Odstraòování dat
E.6–4 Návod k použití pro uživatele systému syngo
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Prohlížení Uložení a dokumentace obrazù
Pøipojení obrazù ke stávající 
sérii E.6

Jestliže nechcete pro zpracované a vyhodnocené snímky 
vytváøet novou sérii, mùžete je pøipojit k již existující sérii. E.6

 

✧ V dialogovém oknì Save As klepnìte na možnost Append 
images to series.

✧ Ve výbìrovém seznamu vyberte pomocí èísla a popisu série 
danou sérii. 

✧ Potvrïte tlaèítkem OK. 

➭ Ve výchozím nastavení najdete sérii ve výbìrovém seznamu, 
který byl naposledy použit s funkcí Save As. 
Pokud používáte Save As poprvé a vybrali jste obrazy rùzných 
sérií, série, která je zadána jako výchozí, je ta, která obsahuje 
obraz naposledy vybraný v obrazové oblasti. 
Verze VE31D E.6–5 
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Uložení a dokumentace obrazù Prohlížení
Uložení hodnot okna E.6

Jestliže jste bìhem zpracování obrazù zmìnili hodnoty okna, 
mùžete uložit pouze nové hodnoty okna. 

E.6

✧ Zvolte položku Image > Save Window Values.

Nebo E.6

✧ Otevøete místní nabídku (pravým tlaèítkem myši) a zvolte 
položku Save Window Values.

nebo E.6

E.6 ✧ Kliknìte na tlaèítko Save Window Values na kartì dílèí úlohy 
Report. 

Nové hodnoty vyvážení budou uloženy pro zvolené snímky. E.6

➭ Hodnoty vyvážení budou uloženy pouze v pøípadì, že má 
uživatel aktuální povolení.

➭ Uložení hodnot vyvážení mùže být zrušeno u nìkterých 
modalit.
E.6–6 Návod k použití pro uživatele systému syngo
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Prohlížení Uložení a dokumentace obrazù
Ukládání, pøedávání a exponování 
obrazù na film E.6

Po vyšetøení èi dodateèném zpracování budou snímky uloženy 
do místní databáze, odkud je lze naèíst napøíklad pro úèely 
vytváøení zpráv nebo dokumentace. E.6

➭ Podrobný popis naleznete zde:  
→Oddíl F. 
 

Uložení snímkù E.6

Pomocí funkce Archive To... mùžete ukládat údaje o pacientovi 
a vyšetøení na místní vymìnitelná datová média (MOD = 
magnetooptický disk, DVD-R = zapisovatelný disk DVD nebo CD-
R = zapisovatelný disk CD) nebo prostøednictvím sítì do archivu. 
→ Kapitola F.2, Ukládání dat 

E.6

Vkládání MOD, DVD-R nebo 
CD-R E.6

✧ Vložte požadované médium do pøíslušné jednotky. 
→ Strana F.2–4, Vkládání a vysouvání médií

✧ Je-li tøeba, naformátujte a pøejmenujte nové médium MOD. 
→ Strana F.2–8, Formátování MOD

✧ Zvolte obrazy, které chcete archivovat. 
Verze VE31D E.6–7 
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Uložení a dokumentace obrazù Prohlížení
Standardní MOD E.6 ✧ Aktivujte položku Transfer > Archive To MOD.

Nebo E.6

E.6 ✧ Klepnìte na tlaèítko s ikonou.

Data jsou archivována na výchozí jednotce MOD. 
→ Strana F.2–12, Archivace na médium MOD 

E.6

Standardní médium CD-R E.6 ✧ Aktivujte položku Transfer > Archive to CD-R.

Nebo E.6

E.6 ✧ Klepnìte na tlaèítko s ikonou.

Data jsou vybrána k archivaci na médium CD-R. 
→ Strana F.2–17, Archivace na disk CD-R v režimu jedné relace 
→ Strana F.2–24, Archivace na disk CD-R/DVD-R v režimu 
vícenásobné relace 

E.6

Nebo E.6

Výbìr místa urèení  
(MOD, CD-R nebo archiv) E.6

✧ Proveïte pøíkaz Transfer > Archive to....

Nebo E.6

E.6 ✧ Kliknìte na tlaèítko s ikonou. 

✧ V dialogovém oknì Archive To zvolte místo urèení pro 
archivaci.

E.6 ✧ Kliknutím na tlaèítko Archive proveïte archivaci dat na 
zvolené místo urèení. 
→ Strana F.2–30, Výbìr místa urèení a archivace 
→ Strana F.2–32, Archivace v síti 
E.6–8 Návod k použití pro uživatele systému syngo
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Prohlížení Uložení a dokumentace obrazù
Vypalování disku CD-R E.6 Vlastní proces ukládání (vypalování) na médium CD-R se buï 
spouští automaticky, nebo jej lze spustit ruènì. 
→ Strana F.2–20, Automatické spuštìní zápisu 
→ Strana F.2–21, Ruèní spuštìní zápisu 
 
 

E.6

Pøedávání dat E.6

Je-li váš systém pøipojen k síti, mùžete údaje o pacientovi a 
vyšetøení odeslat na jinou pracovní stanici pøes sí¤ 
prostøednictvím funkce Send to.... E.6

Není-li váš systém k síti pøipojen, mùžete data zapsat na datové 
médium (MOD/DVD-R nebo CD-R) pomocí funkce Export to... a 
pøedat je dál. 
→ Kapitola F.3, Výmìna dat 

E.6

Odesílání dat E.6 ✧ Vyberte data, která chcete odeslat.

E.6 ✧ Stisknìte klávesu Send to Node 1 na klávesnici se symboly.

Nebo E.6

✧ Zvolte položku Transfer > Send to Node 1 nebo Transfer > 
Send to Node 2. 

Nebo E.6

E.6 ✧ Kliknìte na tlaèítko s pøíslušnou ikonou. 

Data budou odeslána na zvolenou adresu. 
→ Strana F.3–2, Odesílání dat na standardní adresu E.6
Verze VE31D E.6–9 
únor 2006
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Uložení a dokumentace obrazù Prohlížení
Nebo E.6

✧ Proveïte pøíkaz Transfer > Send to....

Nebo E.6

E.6 ✧ Klepnìte na tlaèítko s ikonou.

✧ V dialogovém oknì Send To vyberte požadovanou sí¤ovou 
adresu (adresy).

E.6 ✧ Kliknutím na tlaèítko Send odešlete vybraná data na 
požadovanou adresu (adresy). 
→ Strana F.3–3, Odesílání dat na jinou adresu v síti 
 
 

Export E.6 ✧ Proveïte pøíkaz Transfer > Export to....

✧ V dialogovém oknì Export To vyberte požadované datové 
médium.

E.6 ✧ Kliknutím na tlaèítko Export archivujte data na zvolené 
datové médium. 
→ Strana F.3–5, Export na datové médium 
E.6–10 Návod k použití pro uživatele systému syngo
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Prohlížení Uložení a dokumentace obrazù
Export snímkù do systému souborù E.6

Pokud chcete obrazy zpracovat nebo je jiným zpùsobem použít 
v jiných programech, mùžete je v nìkolika formátech 
exportovat do urèité složky na systémovém pevném disku 
(Export To Off-line). 
→ Kapitola F.4, Export a import do/ze systému souborù 

E.6

✧ Proveïte pøíkaz Transfer > Export to Off-line....

✧ V dialogovém oknì Export to Off-line vyberte požadovaný 
adresáø.

✧ Vyberte požadovaný formát obrazu (DICOM nebo bitmap).

E.6 ✧ Kliknutím na tlaèítko OK uložte vybrané obrazy jako 
jednotlivé soubory. 
→ Strana F.4–2, Export snímkù do systému souborù 
Verze VE31D E.6–11 
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Uložení a dokumentace obrazù Prohlížení
Exponování obrazù na film/tisk obrazù E.6

Kartu úlohy Viewing mùžete používat také pro výbìr a 
kopírování snímkù do položky Filming nebo Film Preview.  
 

E.6

Pøenos snímkù pro 
filmování/tisk E.6

✧ V obrazové oblasti na kartì úlohy Viewing vyberte 
požadované obrazy. 

✧ Použijte funkci Patient > Copy to Film Sheet.

Nebo E.6

E.6 ✧ Kliknìte na toto tlaèítko na kartì dílèí úlohy Patient. 
 

Nebo E.6

E.6 ✧ Stisknìte klávesu Copy to Film Sheet na klávesnici se 
symboly. 
 

Všechny vybrané obrázky jsou pøeneseny na "virtuální filmový 
list" (karta úlohy Filming nebo okno Film Preview). Zde 
aktivujte možnost Auto Expose. Obrazy se poté exponují na 
film nebo vytisknou na papír, jakmile se list filmu vyplní, nebo 
se shromáždí v úloze zpracování filmu. 
→ Kapitola G.2, Automatické/manuální exponování na film E.6
E.6–12 Návod k použití pro uživatele systému syngo
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Prohlížení Uložení a dokumentace obrazù
Náhled exponování na film E.6 ✧ Náhled znázoròující zpùsob, jímž budou pøevedené obrazy 
exponovány na film nebo vytištìny, zobrazíte pomocí 
položky Patient > Film Preview... v hlavní nabídce. 
→ Strana G.3–2, Náhled exponování na film

Nebo E.6

E.6 ✧ Kliknìte na toto tlaèítko na kartì dílèí úlohy Patient. 
 
 
 

Tisk snímkù/exponování 
snímkù na film E.6

Obrazy pacientù, které máte z karty funkcí Viewing
soustøedìny ve filmové úloze, mùžete vytisknout/exponovat na 
film. K tomu není nutné zobrazovat nejdøíve kartu úloh 
Filming. E.6

✧ Volbou položky Patient > Expose Film Task pøevedete 
všechny snímky dané úlohy zpracování filmu do kamery nebo 
tiskárny.

Nebo E.6

E.6 ✧ Kliknìte na toto tlaèítko v ovládací oblasti. 
 

➭ Jestliže jste na kartu úlohy Filming pøevedli obrazy více 
pacientù, takže zde existuje nìkolik úloh zpracování filmu, 
zobrazí se dialogové okno, v nìmž budete moci vybrat 
požadovanou úlohu zpracování filmu. 
→ Strana G.2–13, Volba úlohy zpracování filmu 

Filmování snímkù s 
vícenásobným rámcem E.6

Snímky s vícenásobným rámcem mùžete filmovat a tisknout 
pouze z karty úlohy Viewing. E.6
Verze VE31D E.6–13 
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Uložení a dokumentace obrazù Prohlížení
Pøenos snímkù do trojrozmìrného 
zobrazení E.6

Na kartì úlohy Viewing mùžete provést pøenos obrazù na kartu 
úlohy 3D pro trojrozmìrné zpracování. 

E.6

✧ Na kartì úlohy Viewing vyberte snímky nebo série, které 
chcete zpracovat trojrozmìrnì.

Nebo E.6

✧ Pokud chcete pøenést celý obsah otevøené složky pacienta 
(všechny obrazy zobrazeného pacienta), nevybírejte žádné 
obrazy. 

✧ V závislosti na zpùsobu trojrozmìrného zpracování, který 
chcete pro snímky použít, zvolte položku Applications > 3D 
> MPR, Applications > 3D > MIP nebo Applications > 3D > 
SSD.

Program zkontroluje obrazy z hlediska jejich vhodnosti pro 
trojrozmìrnou rekonstrukci a pøenese je do dialogového okna 
3D Series List. 
→ Strana J.2–6, Seznam sérií pro 3D E.6

➭ Jestliže vyberete pouze jeden nebo dva obrazy, okno s 
hlášením vás informuje, že pøenos do 3D není možný, protože 
3D vyžaduje minimální poèet obrazù pro zpracování. 
Vyberete-li ètyøi nebo více snímkù, budou pøeneseny pouze 
vybrané snímky.
E.6–14 Návod k použití pro uživatele systému syngo
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Prohlížení Uložení a dokumentace obrazù
Pøenesení snímkù do aplikací 
systému Windows E.6

Z karty úlohy Viewing mùžete pøenášet obrazy do aplikací 
systému Windows pøes schránku systému Windows XP. E.6

Zvolené obrazy mùžete kopírovat jednotlivì nebo hromadnì. 
Mùžete je také vložit do souboru programu dodateèného 
zpracování obrazù. 

E.6

✧ V hlavní nabídce Aktivujte položku Edit > Copy.

Nebo E.6

✧ Vybraný snímek zkopírujte do schránky zvolením položky 
Copy v místní nabídce.

Poslední vybraný viditelný snímek se zkopíruje jako rastrový 
obrázek (.bmp). Sem patøí všechny grafické prvky, text ke 
snímku a parametry snímku, které jsou viditelné v oblasti 
snímku. E.6

Je-li zvoleno nìkolik snímkù, do schránky systému Windows XP 
bude zkopírován pouze poslední vybraný snímek. E.6

✧ V odpovídající aplikaci systému Windows zvolte položku 
Paste a vložte zkopírované snímky.
Verze VE31D E.6–15 
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Uložení a dokumentace obrazù Prohlížení
Zavøení snímkù, sérií, studií a 
pacientù E.6

Zpracování snímkù na kartì úlohy Viewing mùžete ukonèit 
zavøením snímkù související série nebo pacienta. Snímky budou 
odstranìny z karty úlohy Viewing. E.6

I poté zùstanou obrazy uloženy v místní databázi. 
 
 

E.6

Zavøení vybraných snímkù 
nebo sérií E.6

Nìkdy je vhodné zavøít nìkteré jednotlivé snímky série 
napøíklad proto, že pro stanovení diagnózy nemají význam. 
Jestliže pak zbývající snímky uložíte jako novou sérii, bude 
obsahovat pouze skuteènì relevantní snímky. Mùžete také 
zavøít sérii studie, kterou již nechcete zpracovávat. 

E.6

✧ Zvolte snímky nebo série, které chcete zavøít.

✧ Aktivujte položku Edit > Clear Document(s).

nebo E.6

E.6 ✧ Kliknìte na tlaèítko Clear Document(s) na kartì dílèí úlohy 
Report. 
 

E.6–16 Návod k použití pro uživatele systému syngo
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Prohlížení Uložení a dokumentace obrazù
Pøíklad: Chcete zavøít snímky A5 a B1 - B5. E.6

 

Ostatní snímky se posunou nahoru a mezera se vyplní. E.6

➭ Jednotlivé obrazy obrazu s vícenásobným rámcem mùžete 
odstranit z karty úlohy Viewing pomocí položky Clear 
Document(s). 

Zavøení snímkù pacienta E.6 Mùžete zavøít také všechny snímky, série a studie pacienta, 
jehož snímky jsou právì zobrazeny. E.6

✧ Zvolte položku Patient > Close Patient.

nebo E.6

E.6 ✧ Klepnìte na tlaèítko Close Patient na kartì dílèí úlohy 
Patient.

Všechny snímky pøíslušného pacienta se zavøou a budou 
odstranìny z karty úlohy Viewing. Složka pacienta bude 
vymazána z ovládací oblasti. E.6

➭ Kromì hodnot okna, komentáøù k obrazùm a symbolù pro 
oznaèení/zrušení oznaèení se zmìny na obrazech neuloží.

A1 A2 A3 A4

A5 B1 B2 B3

B5 B6 B7 C1

C2 C3 C4 C5

A1 A2 A3 A4

B6 B7 C1 C2

C3 C4 C5

Uklidit dokumenty
Verze VE31D E.6–17 
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Uložení a dokumentace obrazù Prohlížení
E.6–18 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

E.7

Konfigurace karty úlohy 
Viewing E.7
V oknì Viewing Configuration mùžete uživatelské rozhraní a 
programové operace karty úlohy Viewing pøizpùsobit vaší 
pracovní metodì. 

E.7

Mùžete zmìnit nebo vytvoøit následující nastavení: E.7

❏ Zobrazení statistického vyhodnocení výsledkù

❏ To, zda série/studie zùstanou na kartì úlohy Viewing po 
naètení nových sérií/studií

❏ Hodnoty okna specifické pro daného uživatele a daný orgán 
 

✧ Vyvolejte okno syngo - Configuration Panel  
(Options > Configuration... v hlavní nabídce).

E.7 ✧ Vyberte konfiguraèní okno karty úlohy Viewing.

Okno Viewing Configuration se zobrazí spolu s kartami 
Graphic Tools, Administration a Evaluation General. 
 

E.7

➭ V této pøíruèce se v èásti Základy mùžete seznámit s 
postupem pøi otevírání a zavírání konfiguraèních oken, 
ukládání zmìn nebo obnovování pùvodního nastavení 
provedeného dodavatelem. 
→ Kapitola A.4, Konfigurace uživatelského rozhraní
Verze VE31D E.7–1 
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Konfigurace karty úlohy Viewing Prohlížení
Zobrazení výsledkù vyhodnocení E.7

Pøi zakreslování oblastí zájmu (ROI) a distanèních èar program 
tyto oblasti a èáry statisticky vyhodnocuje. 
→ Strana E.5–4, Vyhodnocení oblastí, 
→ Strana E.5–17, Mìøení vzdáleností a úhlù E.7

Na kartì Graphic Tools mùžete nastavit, jak mají být na 
snímcích zobrazeny výsledky vyhodnocování pro každou ROI 
nebo pro každý typ èáry. E.7

Také mùžete vytvoøit nastavení pro vyhodnocovací nástroje 
Scalegrid a Crosshair na kartì Graphic Tools. E.7

✧ Klepnutím kartu Graphic Tools pøesuòte do popøedí.

 

E.7–2 Návod k použití pro uživatele systému syngo
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Prohlížení Konfigurace karty úlohy Viewing
Výbìr grafických nástrojù E.7

E.7 ✧ Nejprve vyberte, pro kterou oblast zájmu nebo pro který typ 
èáry chcete zobrazení výsledkù vyhodnocení zmìnit. 
 

Zobrazení výsledkù 
vyhodnocení E.7

E.7 ✧ Vyberte nebo zrušte zobrazení výsledkù vyhodnocení 
klepnutím nebo odstranìním zaškrtnutí z pøíslušného 
políèka. 
 
 
 
 
 
 

Rozsah stupnice šedi E.7

E.7 ✧ Chcete-li vyhodnotit celý rozsah stupnice šedi v pøíslušné 
oblasti ROI, odstraòte zaškrtnutí z políèka Limit.

Nebo E.7

✧ Chcete-li vyhodnocovat pouze ty obrazové body v dané 
oblasti zájmu, které se nacházejí v rozsahu stupnice šedi, 
který nyní mùžete definovat, zaškrtnìte políèko Limit. 
Verze VE31D E.7–3 
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Konfigurace karty úlohy Viewing Prohlížení
Zmìna nastavení na kartì 
úlohy E.7

Všechna nastavení pro dané grafické nástroje lze zmìnit nejen 
na konfiguraèním panelu, ale také pøímo na kartì úlohy 
Viewing. 

E.7

✧ Umístìte kurzor na tlaèítko ikony grafického nástroje, jehož 
nastavení chcete v sadì karet úloh zmìnit.

✧ Vyvolejte Properties... v místní nabídce (pravé tlaèítko myši). 
 

Zobrazí se dialogové okno pro urèování vlastností tohoto 
grafického nástroje. Nyní mùžete u tohoto grafického nástroje 
zmìnit nastavení. Toto nastavení bude v budoucnu použito pøi 
každé aktivaci daného grafického nástroje. E.7
E.7–4 Návod k použití pro uživatele systému syngo
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Prohlížení Konfigurace karty úlohy Viewing
E.7

!0

E.7 E.7

Jestliže však zvolíte kreslení prvku v obrazu a potom vyvoláte 
Edit > Properties... (nebo Properties... v místní nabídce), 
nastavení, která mùžete provést v právì zobrazeném 
dialogovém oknì, platí pouze pro vybraný prvek kreslení. E.7
Verze VE31D E.7–5 
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Konfigurace karty úlohy Viewing Prohlížení
Zavøení série/studie na kartì úlohy 
Viewing E.7

Z karty Administration je patrné, zda bude pøi naètení nové 
série/studie pacienta na kartu úlohy Viewing odstranìna série 
èi studie daného pacienta, které se na kartì úlohy Viewing
nacházely již pøedtím. E.7

➭ Tato nastavení stanoví váš správce systému nebo servis 
spoleènosti Siemens.

✧ Klepnutím pøesuòte kartu Administration do popøedí.

 

E.7–6 Návod k použití pro uživatele systému syngo
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Prohlížení Konfigurace karty úlohy Viewing
Jestliže jste vybrali tuto volbu, všechny studie pacienta naètené 
na kartu úlohy Viewing budou po naètení nové studie tohoto 
pacienta odstranìny. 

E.7

 

Jestliže jste vybrali tuto volbu, všechny série aktuálnì naètené 
studie budou odstranìny z karty úlohy Viewing po naètení nové 
série této studie. E.7
Verze VE31D E.7–7 
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Konfigurace karty úlohy Viewing Prohlížení
Hodnoty vyvážení specifické pro 
daného uživatele a daný orgán E.7

Na kartì úlohy Viewing mùžete uspoøádat okna obrazù tak, že 
k nim pøiøadíte pøeddefinované hodnoty vyvážení oken, které 
jsou specifické pro daný orgán èi daného uživatele. 
→ Strana E.4–13, Pøiøazení pøeddefinovaných nastavení okna E.7

Na kartì Evaluation General mùžete vytvoøit hodnoty vyvážení 
tohoto typu, pøiøadit k nim název (napøíklad oznaèení orgánu 
nebo jméno uživatele) a zmìnit nebo odstranit již vytvoøené 
parametry okna. E.7

➭ Zmìny hodnot vyvážení jsou platné rovnìž pro trojrozmìrné 
obrazy.

✧ Kliknutím na záložku karty Evaluation General kartu 
pøesuòte do popøedí.

 

E.7–8 Návod k použití pro uživatele systému syngo

 0.0



Prohlížení Konfigurace karty úlohy Viewing
Výbìr jména E.7

✧ Zadáním jména do kombinovaného pole vytvoøte nové 
hodnoty vyvážení specifické pro orgán nebo uživatele.

Nebo E.7

✧ Vyberte jméno ze seznamu, u nìhož chcete zmìnit nebo 
odstranit hodnoty vyvážení. 
 

Odstraòování hodnot 
vyvážení E.7

Výbìrový seznam mùže obsahovat až 30 položek. Jestliže 
chcete urèit nové hodnoty vyvážení a seznam je plný, musíte 
nejprve odstranit existující záznam. 

E.7

✧ Vyberte záznam

E.7 ✧ Záznam odstraòte kliknutím na tlaèítko Delete. 

➭ Ze seznamu Default window obèas odstraòte položky, které 
již nepotøebujete. Tak bude dílèí nabídka Windowing
pøehlednìjší
Verze VE31D E.7–9 
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Konfigurace karty úlohy Viewing Prohlížení
Zadání èi zmìna hodnoty 
vyvážení E.7

Pokud jste do pole Default window zadali nové jméno, vstupní 
pole pro hodnoty vyvážení budou zpoèátku prázdná. E.7

E.7 ✧ Do èíselníkù zadejte nové hodnoty vyvážení.

Jestliže jste již v poli Default window vybrali jméno, mùžete 
nyní zmìnit hodnoty vyvážení, které jsou pod tímto názvem 
uloženy. E.7

E.7
E.7–10 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

F.1

 
Úvod F.1
Po vyšetøení nebo dodateèném zpracování se obrazy uloží do 
místní databáze, odkud je lze naèíst pøi pøípravì zprávy nebo 
exponovat na film pøi pøípravì dokumentace. F.1

V této èásti je vysvìtleno, jak se snímky a údaje o pacientovi 
uložené v místní databázi ukládají na jiná média, odesílají v 
rámci sítì a pøenášejí na datová média nebo prostøednictvím 
sítì. F.1

Na rozdíl od funkce archivování funkce exportu neprovádí 
kontrolu pøedchozích archivaèních úkonù, oznaèení nebo 
stavu zpracování. F.1

F.1

!0

F.1 F.1

F.1

UPOZORNÌNÍ

Nesprávné zavedení/nesprávné vyhodnocení pøíznakù 
potvrzení uložení AC/SC. Potvrzení uložení znamená uložení 
na pevný disk, ale toto nemusí splòovat nebo zaruèit 
regulaèní požadavky týkající se dlouhodobé archivace. 
Potvrzené objekty mohou odstranit uživatelé. F.1

Dùsledkem toho mùže dojít ke ztrátì dat v požadované 
dobì uchování. F.1

✧ Dodržujte pøedepsané požadavky týkající dlouhodobé 
archivace.

Existují (zákonné) pøedpisy upravující dobu archivace, 
dostupnost dat a jejich zabezpeèení (integritu a 
neporušitelnost) i doporuèení týkající se ochrany 
archivovaných dat snímkù pøed požárem a poškozením 
vodou. Za dodržování tìchto požadavkù zodpovídá obsluha 
archivu. F.1
Verze VE31D F.1–1 
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Úvod Uložení a výmìna dat
!0

F.1 F.1

Zabezpeèení – oprávnìní F.1 Funkce Archive umožòuje archivaci dat na archivaèních discích 
nebo v centrálním sí¤ovém archivaèním serveru. Funkce Export
umožòuje exportovat data na disky nebo do systému souborù. 
Funkce Send umožòuje odesílat data do jiných sí¤ových uzlù.  

F.1

F.1

Vzhledem k trvale postupujícímu technickému rozvoji by 
nebylo možné provádìt ukládání dat a zajistit pøístup k nim v 
celém požadovaném archivaèním období pouze s jedinou 
technikou ukládání a jediným typem média. Proto bude ve 
vìtší èi menší míøe nezbytné zajistit možnost migrace dat, za 
níž ponese odpovìdnost obsluha digitálního archivu. F.1
F.1–2 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Úvod
K dispozici jsou následující možnosti: F.1

Archivace F.1 Pomocí funkce Archive to... mùžete ukládat údaje o pacientovi 
a vyšetøení na místní vymìnitelná datová média (MOD = 
magnetooptický disk, DVD-R = zapisovatelný disk DVD nebo CD-
R = zapisovatelný disk CD) nebo prostøednictvím sítì do archivu. 
→ Kapitola F.2, Ukládání dat F.1

Archivace zamezuje ztrátì dat a používá se k dlouhodobému 
uložení údajù o pacientovi a vyšetøení. F.1

➭ Archivace údajù o pacientovi a vyšetøení by mìla být bìžným 
postupem, provádìným v pravidelných intervalech.

Jakmile budete mít jistotu, že data byla uložena do archivu, 
mùžete je odstranit z místní databáze, aby její rozsah 
nepøekraèoval pøijatelnou velikost. 
→ Strana C.6–8, Odstraòování dat 

F.1

Odesílání a export  
dat F.1

Data z vyšetøení tak mùžete pøedat jinému lékaøi k 
dodateènému zpracování nebo k pøípravì zprávy. F.1

Je-li váš systém pøipojen k síti, mùžete odesílat údaje o 
pacientovi a vyšetøení na jiné pracovní stanice prostøednictvím 
funkce Send to.... F.1

Nebo mùžete data zapisovat na datová média (MOD nebo CD-R/
DVD-R) pomocí funkce Export to... a takto je pøedávat. 
→ Kapitola F.3, Výmìna dat F.1
Verze VE31D F.1–3 
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Úvod Uložení a výmìna dat
Import F.1 Budete-li uložená data pozdìji opìt potøebovat, mùžete provést 
jejich import pomocí Patient Browser. 
→ Strana C.2–26, Naèítání dat z archivaèního média 

F.1

Automatické ukládání a 
odesílání F.1

Ke zvýšení efektivity své rutinní práce mùžete také použít 
automatické zapisování údajù o pacientovi a vyšetøení na 
urèená datová média nebo jejich automatické odesílání na 
konkrétní adresy v síti. F.1

Mùžete definovat pravidla stanovením stavu práce pro archivaci 
a doby, kdy bude automatický pøenos dat probíhat. 
→ Strana F.6–2, Automatický pøenos dat 
→ Strana F.6–20, Nastavení opakování pokusù 

F.1

Export a import snímkù F.1 Chcete-li obrazy zpracovávat nebo používat v jiných 
programech, mùžete je exportovat v nìkolika obrazových 
formátech do urèitého adresáøe na systémovém pevném disku 
(Export to Off-line). F.1

Stejným zpùsobem mùžete do aplikace importovat obrazy 
generované nebo zpracované v jiných programech (Import 
from Off-line). 
→ Kapitola F.4, Export a import do/ze systému souborù 
 

F.1
F.1–4 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Úvod
Možnosti pøenosu F.1

Níže jsou znázornìny dostupné možnosti zálohování a 
pøenosu dat. F.1

 

Archiv

Jiná pracovní stanice

MOD

CD-R/DVD-R
(CD/DVD)

Pevný disk

Vaše pracovní stanice
Verze VE31D F.1–5 
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Úvod Uložení a výmìna dat
F.1 (1) Uložení na CD-R/DVD-R, MOD nebo do archivu  
(Archive to...)

(2) Export na CD-R/DVD-R, MOD  
(Export to...)

(3) Import z CD-R/DVD-R, MOD

(4) Odeslání do jiných pracovních stanic  
(Send To...)

(5) Pøíjem z jiných pracovních stanic

(6) Export do adresáøe na místním pevném disku  
(Export to Off-line)

(7) Import z adresáøe na místním pevném disku  
(Import from Off-line)

(8) Automatický zápis souborù 
(Record Off-line Files)

➭ Ve vašem systému nemusejí být dostupné všechny možnosti 
pøenosu. Dostupnost jednotek a sí¤ových pøipojení závisí na 
individuální konfiguraci systému a nainstalovaných 
doplòkových zaøízeních a programech.
F.1–6 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Úvod
Výbìr dat pro pøenos F.1

Pøed spuštìním pøenosu vyberte pøíslušné datové objekty. F.1

➭ Archivovat, exportovat nebo odesílat mùžete pouze ty 
objekty, které jsou uloženy v místní databázi. Mají-li být data 
pøenesena z jednoho datového média na jiné, je nutno je 
nejprve importovat do hlavní databáze. 

Patient Browser F.1 Chcete-li archivovat nebo pøenášet údaje o pacientovi èi 
vyšetøení, obvykle je z místní databáze vyberete pomocí Patient 
Browser. 
→ Kapitola C.2, Vyhledávání a zobrazování údajù o pacientovi 

F.1

Karty úloh F.1 Pøenos mùžete spustit také po vybrání jednotlivých objektù na 
nìkolika kartách úloh. F.1

❏ Karta úloh Viewing: 
→ Strana E.3–32, Výbìr snímkù

❏ Karta úloh 3D: 
→ Strana J.8–2, Volba snímkù a trojrozmìrné grafiky
Verze VE31D F.1–7 
únor 2006
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Úvod Uložení a výmìna dat
Spuštìní pøenosu F.1

Archivaci, pøenos dat v síti a export nebo import dat mùžete 
spustit buï z nabídky, nebo pomocí tlaèítek s ikonami. 

F.1

Nabídka Transfer F.1 Archivaci a pøenos dat mùžete spustit z nabídky Transfer na 
nìkolika kartách úloh a v oknì prohlížeèe Patient Browser. F.1

➭ Názvy jako MOD a Node 1 jsou pouze pøíkladem názvu 
jednotky nebo sí¤ového uzlu. Skuteèné názvy budou záviset 
na konfiguraci vašeho systému.
F.1–8 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Úvod
Tlaèítka s ikonami F.1 V závislosti na konfiguraci systému se zobrazí rùzná tlaèítka s 
ikonami, která vám umožní rychlé a snadné spouštìní pøenosu 
v ovládací oblasti karty úloh. F.1

Øadu tlaèítek s ikonami, jejichž prostøednictvím lze spouštìt 
pøenos, naleznete také na panelu nástrojù Patient Browser. F.1

 

Tlaèítka s ikonami mají následující funkce (zleva doprava): F.1

(1) Importování dat

(2) Archivovat data na pøedem urèený implicitní MOD

(3) Archivovat data na urèený implicitní CD-R/DVD-R

(4) Archivovat data na volitelné archivaèní médium  
(MOD nebo CD-R/DVD-R) nebo na sí¤ový uzel

(5) Odeslat data na první výchozí sí¤ovou stanici

(6) Odeslat data na druhou výchozí sí¤ovou stanici

(7) Odeslat data na volitelnou sí¤ovou stanici 

Klávesa F.1

F.1 Pøenos dat na první výchozí sí¤ovou stanici mùžete spustit také 
pomocí klávesy Send to default Node 1 na klávesnici se 
symboly nebo pomocí klávesy + na numerické klávesnici, která 
je souèástí klávesnice poèítaèe. F.1

F.1

(1) (2) (3) (4) (5) (6) (7)
Verze VE31D F.1–9 
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Úvod Uložení a výmìna dat
Pøenos zkreslených snímkù F.1

Za urèitých okolností se mohou snímky (obdélníkové matice 
nebo obdélníkové pohledové segmenty), které byly zpìtnì 
importovány po zpracování v režimu offline, zobrazit s 
omezenou maticí obrazových bodù. F.1

F.1

F.1

 UPOZORNÌNÍ

Pøenos zkreslených neètvercových matic/segmentù obrázkù. F.1

Mùže dojít ke ztrátì oblastí snímkù, které jsou dùležité 
pro stanovení diagnózy. F.1

✧ Pøi exportu/poslání zpracovaných obrazù na jinou pracovní 
stanici by mìly být poslány také odpovídající originální 
obrazy.  
Je nutno zdùraznit, že koneèná diagnóza by mìla být 
založena vždy na pùvodních obrazech, nikoli pouze na 
upravených nebo zpracovaných obrazech.
F.1–10 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Úvod
Výskyt tohoto chování F.1 ➭ K tomuto chování dochází na kartì úloh Viewing vždy, když 
dojde k nesouladu mezi rozmìry obrazové matice a 
zobrazeného segmentu (napøíklad pøi zobrazení obdélníkové 
obrazové matice ve ètvercovém pohledovém segmentu nebo 
pøi zobrazení ètvercové obrazové matice v obdélníkovém 
pohledovém segmentu).

➭ Po zpracování snímkù v prohlížeèi pomocí nástrojù Zoom/Pan 
nebo Rotation se upravený snímek zobrazí správnì (napøíklad 
s vyplnìným úplným pohledovým segmentem).

➭ Pokud je snímek poté

❏ exportován ke zpracování v režimu offline a zpìtnì 
importován nebo

❏ pøekopírován na výmìnná média (napøíklad disk CD nebo 
MOD) a pak z tìchto médií zkopírován zpìt nebo

❏ odeslán na kterékoli jiné pracovištì,

viditelná matice obrazových bodù se zmenší a pùvodní 
obrazový obsah na okrajích novì zobrazeného obrazu bude 
nahrazen èernými okraji. F.1

➭ Rovnìž v pøípadì, že snímek obsahuje požadovanou oblast, 
která je nyní tìmito èernými okraji èásteènì zakryta, se budou 
statistické informace vztahovat k celé oblasti zájmu, nikoli 
pouze k té její èásti, která je viditelná.

➭ Šíøka tìchto èerných okrajù závisí na pomìru stran pùvodního 
snímku nebo pohledového segmentu. Napøíklad snímek s 
obrazovými body uspoøádanými v 512 øádcích a 384 
sloupcích se ve výchozím nastavení zobrazí s èernými okraji o 
šíøce 64 obrazových bodù na obou stranách. Èerné okraje o 
stejné šíøce na obou stranách pøekrývají obrazový obsah 
pøijatého nebo importovaného snímku obdélníkového tvaru. 
Èím vìtší je pomìr stran, tím více informací bude zakryto.
Verze VE31D F.1–11 
únor 2006
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Úvod Uložení a výmìna dat
Vysvìtlení tohoto chování F.1 Toto chování je následkem skuteènosti, že ve všech pøípadech 
musí být vytvoøen nový snímek, který odpovídá maticovému 
formátu pùvodního snímku. Obdobný efekt lze pozorovat, 
jestliže jsou snímky se ètvercovou maticí zobrazeny v 
obdélníkovém pohledovém segmentu. Pùvodní snímek však 
vždy zùstane zachován. F.1

➭ Aby toto chování bylo možno lépe pochopit, jsou na 
následujících vyobrazeních znázornìny rùzné situace.

Pøípad 1: Zvìtšení nebo posunutí obdélníkových snímkù F.1

Pøípad 2: Otoèení obdélníkových snímkù F.1

Pøípad 3: Zobrazení ètvercových matic v obdélníkových 
pohledových segmentech F.1
F.1–12 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Úvod
Pøedcházejte možným 
rizikùm nebo je 
minimalizujte F.1

Pøi exportu/odeslání zpracovaných obrazù na jinou pracovní 
stanici by mìly být odeslány také pøíslušné pùvodní obrazy. 
Dùraznì se doporuèuje stanovovat koneènou diagnózu 
vždy na základì originálních snímkù, a nikoli pouze na 
základì snímkù upravených nebo zkreslených. F.1

➭ Dodržujte tyto bezpeènostní pokyny a odpovídajícím 
zpùsobem zaškolte také personál. 

F.1
Verze VE31D F.1–13 
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Úvod Uložení a výmìna dat
F.1–14 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

F.2

 
Ukládání dat F.2
Pøi ukládání kopírujete vybrané údaje o pacientovi a vyšetøení 
na externí datové médium nebo do centrálního archivu. 
Uložená data mùžete v pøípadì potøeby kdykoli pøenést zpìt do 
místní databáze. F.2

Archivace/zálohování dat F.2 V závislosti na rutinì, kterou používáte, bude k vašemu 
systému pøipojena jedna nebo nìkolik jednotek pro externí 
datová média (napø. MOD nebo CD-R/DVD-R) jako archivaèní 
jednotky pro zálohování dat. Alternativnì mùže být použit 
archivaèní server pøístupný v rámci sí¤ového pøipojení. F.2

F.2

➭ Exportování se naproti tomu používá pouze pro výmìnu dat. 
Vlastní postup pøi exportu se provádí obdobným zpùsobem. 
→ Strana F.3–5, Export na datové médium

➭ Je-li aktivována funkce Security, mùžete data ukládat pouze v 
pøípadì, že jste k tomu oprávnìni. 

V této kapitole se dozvíte, jak ukládat data na rùzná datová 
média nebo na archivaèní server. F.2

F.2

UPOZORNÌNÍ

Médium DVD-R používané pro export/archivaci se mùže 
poškodit nebo nemusí být èitelné jinými zaøízeními DVD. F.2

 Ztráta dat nebo dojem uživatele, že jsou data ztracena F.2

✧ Nakonfigurujte a používejte místní média pouze jako 
„archivaèní" média, pokud jsou dostateènì splnìny 
požadavky na uchování a èitelnost, napø. média jsou 
schválena výrobcem pro archivaci. Pøed odstranìním dat z 
databáze ovìøte èitelnost dat na médiu.
Verze VE31D F.2–1 
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Ukládání dat Uložení a výmìna dat
Zálohování na místní datová 
média F.2

Pøed zahájením archivace nebo exportu dat byste si mìli zjistit, 
jaká archivaèní metoda se používá ve vašem systému a zda máte 
vhodná datová média. 

F.2

Datové médium F.2 Systém pro archivaci podporuje následující typy datových 
médií: F.2

❏ MOD (magnetooptický disk) 5,25 a 3,5"

❏ CD-R (zapisovatelný disk CD)

❏ DVD-R (zapisovatelný disk DVD) 

➭ Do centrálního archivu se data ukládají prostøednictvím sítì. 
Tento archiv mùže používat další datová média.

Manipulace s datovými 
médii F.2

✧ Pøi manipulaci s disky MOD a CD-R/DVD-R a pøi jejich 
skladování se øiïte pokyny jednotlivých výrobcù. 
F.2–2 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Jednotky F.2 K systému pro archivaci lze pøipojit kteroukoli z následujících 
jednotek: F.2

❏ Jednu nebo nìkolik jednotek MOD

❏ Jednu jednotku CD-R/DVD-R nebo zaøízení pro zápis na CD/
DVD

!0

F.2 F.2

F.2

Jednotky Pioneer se mají používat pouze ke ètení F.2

F.2

UPOZORNÌNÍ

Pøi souèasném exportu dat na zaøízení (napø. jednotka CD-R 
nebo DVD-R) a pokusu èíst data ze stejného zaøízení pomocí 
externích aplikací (nikoli založených na programu syngo 
mùže jedna úloha, pøípadnì obì úlohy selhat (podle 
naèasování). F.2

Mùže dojít ke ztrátì dat. Když jsou data zapisována na 
jednotku, jakýkoli externí pøístup v této dobì znièí 
aktuálnì zapisovanou úlohu a mùže dokonce poškodit 
pamì¤ový disk. Data již uložená na disk s vícenásobnou 
relací se mohou také stát neèitelnými. F.2

✧ Nesnažte se pøistupovat na zaøízení pomocí aplikací 
nezaložených na systému syngo bìhem zápisu nebo ètení 
dat. Aby se zajistil úspìšný zápis nebo ètení, zkontrolujte 
Local Job Control, zda neprobíhají nìjaké úlohy zápisu nebo 
importu.
Verze VE31D F.2–3 
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Ukládání dat Uložení a výmìna dat
Vkládání a vysouvání médií F.2

Abyste mohli provést uložení nebo export dat, musíte vložit 
vhodné médium MOD nebo CD-R/DVD-R do správné jednotky. F.2

➭ V Patient Browser mùžete zjistit, jaké médium bylo vloženo. 
→ Strana C.2–26, Naèítání dat z archivaèního média

➭ V dialogovém oknì Transfer Configuration mùžete urèit, jak 
mají být údaje o pacientovi na médium zapsány (využití 
pamìti a komprese). 
→ Strana F.6–10, Archivace a export 

Vkládání disku MOD F.2 Na média MOD lze zapisovat z obou stran (strana A a B). F.2

✧ Ujistìte se, že strana, na niž chcete data ukládat nebo z niž 
chcete data èíst, smìøuje nahoru.

✧ Vložte MOD do pøíslušné jednotky.

Médium MOD se zasune dovnitø. 
F.2

Vložení CD/DVD-R F.2 Na disky CD/DVD-R lze zapisovat data pouze z jedné strany. F.2

✧ Stisknìte tlaèítko pro vysunutí na jednotce.

✧ Vložte do zásuvky disk CD tak, aby strana urèená k oznaèení 
smìøovala nahoru.

✧ Stisknìte znovu tlaèítko pro vysunutí na jednotce.

Zásuvka s diskem CD se zasune. 
F.2
F.2–4 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Ochrana proti zápisu F.2 Disky MOD mohou být chránìny proti zápisu posunutím 
malého štítku. F.2

Podle toho, zda chcete chránit data, která již byla na médium 
MOD zapsána, nebo zda naopak chcete na to èi ono médium 
provést zápis, ochranu proti zápisu buï aktivujte, nebo zrušte.F.2

✧ Pøesuòte jezdce pøíslušným smìrem.
Verze VE31D F.2–5 
únor 2006
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Ukládání dat Uložení a výmìna dat
Vysunutí média F.2 Aby bylo možné médium (MOD nebo CD-R/DVD-R) vyjmout, je 
nutno je vysunout z jednotky. F.2

✧ Otevøete nabídku Transfer.

V závislosti na konfiguraci jednotek zde naleznete jednu nebo 
nìkolik položek Eject from <drive name>. F.2

✧ Vyberte položku odpovídající požadované jednotce.

Nebo F.2

✧ Vyberte položku Eject from....

Zobrazí se dialogové okno Eject From. F.2
F.2–6 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
F.2 ✧ Vyberte požadovanou jednotku a výbìr potvrïte stisknutím 
tlaèítka Eject.

➭ Mùžete vybrat nìkolik jednotek tak, aby média byla ze všech 
jednotek vysunuta souèasnì.

➭ Pokud systém nìkteré z datových médií právì používá (tzn. 
pokud probíhá ètení nebo zápis), nelze je vysunout.

➭ Tlaèítko Eject je bìhem exportu (je vybrána jedna úloha) a 
zápisu neaktivní.

Médium nebo média se vysune/vysunou z jednotky/jednotek. 
Nyní je mùžete nahradit jinými médii. 

F.2

Finalizace média F.2 Aby se mohlo ukonèit ne zcela zaplnìné médium s 
vícenásobnou relací, mùžete jej finalizovat pomocí nabídky 
nebo tlaèítka. Z dùvodu úplné kompatibility s jinými systémy 
mùže být finalizované médium použito v režimu pouze pro 
ètení. F.2

F.2

F.2

UPOZORNÌNÍ

Médium není finalizováno. F.2

Jiný systém/zaøízení mùže ukazovat, že médium je 
prázdné, poškozené nebo data z poslední relace chybìjí. F.2

✧ K dokonèení práce na tomto médiu a k zajištìní, že médium 
bude èitelné na jiných systémech/zaøízeních použijte funkci 
„Eject with finalize". 
Pokud naleznete médium, kde oèekáváte data a které se zdá 
být prázdné nebo vadné nebo kde poslední data chybí, 
zkuste použít pùvodní nebo jiný systém syngo k finalizaci 
média pro další pøístup pouze pro ètení.
Verze VE31D F.2–7 
únor 2006
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Ukládání dat Uložení a výmìna dat
Formátování MOD F.2

Chcete-li archivovat nebo exportovat data na nový MOD, 
musíte jej nejprve zformátovat. F.2

Jestliže médium MOD obsahuje data, z nichž již žádná
nebudete potøebovat, mùžete toto médium MOD zformátovat 
znovu, abyste mohli opìt využít jeho plné pamì¤ové kapacity.F.2

➭ Pøi formátování média MOD lze smazat pouze celou stranu, 
nikoli jednotlivé datové objekty (obrazy nebo série).

F.2

✧ Vložte MOD, které má být formátováno, do jedné z jednotek 
MOD.

✧ Jestliže médium MOD již bylo použito k zápisu a vy zápis 
chcete smazat, otevøete nabídku Transfer > Format 
Medium.

F.2

UPOZORNÌNÍ

Opìtovné použití/reformátování diskù MOD. F.2

Nevratné smazání všech dat uložených na médiu. F.2

✧ Pøed opìtovným použitím/reformátováním MOD se 
ujistìte, že na pøíslušném MOD nejsou uložena žádná 
dùležitá data.
F.2–8 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Pojmenování média MOD F.2 Zobrazí se dialogové okno Format Medium. Po vložení 
nového média MOD se toto dialogové okno zobrazí 
automaticky. F.2

 

➭ Má-li váš systém nìkolik jednotek MOD, mùžete požadovanou 
jednotku vybrat ze seznamu Archive device.

✧ Ve vstupním poli Label on medium zadejte jednoznaèný 
nový název nebo potvrïte navržený název.

➭ Název mùže být tvoøen písmeny A až Z, èíslicemi 0 až 9 a 
podtržítky (malá písmena budou automaticky pøevedena na 
velká). Název smí obsahovat tøi až jedenáct znakù.

Tento název je pøiøazen disku MOD do pøíštího formátování. 
Aby se zamezilo zámìnì, vždy se ujistìte, zda použitý název 
MOD již nebyl pøiøazen jinému médiu. F.2
Verze VE31D F.2–9 
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Ukládání dat Uložení a výmìna dat
Formátování MOD F.2

F.2 ✧ Kliknutím na pøíkaz Format spustíte formátování MOD.

Pokud jste do jednotky vložili médium MOD, na kterém jsou již 
uložena data, zobrazí se dialogové okno. F.2

 

✧ Spuštìní formátování potvrïte kliknutím na tlaèítko OK. 

F.2 ➭ Jestliže vyberete tlaèítko Cancel, formátování se neuskuteèní.
F.2–10 Návod k použití pro uživatele systému syngo

 0.0



Uložení a výmìna dat Ukládání dat
Poznámky k ukládání na disky MOD F.2

Data mùžete na disky MOD nìkolikrát zapisovat a kopírovat, 
než se MOD zaplní. Stará média MOD obsahující data, která již 
nepotøebujete, lze znovu zformátovat a poté použít. F.2

Ukládání na MOD probíhá na pozadí, takže mùžete souèasnì 
pokraèovat v práci na svém poèítaèi. F.2

F.2

!0

F.2 F.2

F.2

UPOZORNÌNÍ

Vypnutí jednotky, když ještì probíhá zápis na disk. F.2

Hrozí ztráta všech dat a poškození média F.2

✧ Nikdy nevypínejte zaøízení, probíhá-li zápis.

Aby se minimalizovalo nebezpeèí ztráty dat, používejte k 
archivování pouze média schválená spoleèností Siemens a 
klasifikovaná jako „lékaøská". F.2

Média vhodná pro lékaøské úèely lze zajistit prostøednictvím 
vašeho zástupce spoleènosti Siemens. F.2
Verze VE31D F.2–11 
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Ukládání dat Uložení a výmìna dat
Archivace na médium MOD F.2

Po vložení média MOD s volnou pamì¤ovou kapacitou do 
jednotky vyberte data, která chcete archivovat (napøíklad v 
Patient Browser). Poté proveïte archivaci dat na médium 
MOD. F.2

➭ Mùžete také uložit údaje o pacientovi a data jeho vyšetøení, 
která jste pøedtím z média MOD importovali a zpracovali. Pøi 
opìtovném ukládání dat se v dialogovém oknì mùžete 
rozhodnout, zda chcete nebo nechcete pøepsat starou verzi.  

Archivace na standardní 
jednotku F.2

✧ Vyberte data, která chcete uložit. 

✧ Aktivujte položku Transfer > Archive to MOD.

Nebo F.2

F.2 ✧ Kliknìte na toto tlaèítko. 

Vybraná data se pøenesou do standardní jednotky MOD, kde 
budou uložena. F.2

➭ Nejsou-li údaje o pacientovi úplné, zobrazí se pøíslušné 
hlášení. Chybìjící data zadejte v dialogovém oknì Correct.  
→ Kapitola C.4, Oprava dat 
F.2–12 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Médium MOD není 
naformátováno F.2

Pøi vložení nového nenaformátovaného média MOD váš systém 
automaticky zobrazí dialogové okno Format Medium. 
→ Strana F.2–8, Formátování MOD F.2

F.2

➭ Jestliže jste vložili MOD systému NTFS, musíte jeji 
naformátovat. Jinak již nebude po vyjmutí jednotka MOD 
pøístupná a systém bude nutné restartovat. 

F.2

UPOZORNÌNÍ

Systém nerozeznává formát MOD F.2

Možnost ztráty dat F.2

✧ Stisknìte tlaèítko Cancel v dialogovém oknì Format 
Medium, které se zobrazí, pokud by disk MOD mohl 
obsahovat dùležitá data. U diskù MOD se záznamy z jiných 
systémù používejte ochranu proti pøepsání.
Verze VE31D F.2–13 
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Ukládání dat Uložení a výmìna dat
Disk MOD je plný F.2 Je-li vložené médium MOD plné, zobrazí se dialogové okno. F.2

 

✧ Kliknìte na tlaèítko Eject a vložte do jednotky nové médium 
MOD, nebo vložené médium MOD obra¤te, pokud je na jeho 
druhé stranì ještì dostatek místa.

✧ Jestliže vložíte nové médium MOD, chvíli vyèkejte a poté 
kliknìte na tlaèítko Continue.

Je-li vložené médium MOD nové nebo chcete-li zápis na nìm 
smazat, musíte je nejprve zformátovat: F.2

✧ Chcete-li pokraèovat v archivaci, kliknìte na tlaèítko Format 
& Continue. 

➭ Chcete-li celý postup zrušit, klepnìte na tlaèítko Cancel.
F.2–14 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Poznámky k ukládání na disky CD-R/DVD-R F.2

Jedna nebo vícenásobná 
relace F.2

Na disky CD-R lze zapisovat v jednom kroku (jedna relace). Na 
disky CD-R/DVD lze zapisovat v nìkolika krocích (vícenásobná 
relace). F.2

Zvolená metoda závisí na konfiguraci systému. F.2

Sbìr a archivace dat F.2 V režimu jedné relace musíte pøed zápisem na disk CD-R 
provést nejprve sbìr dat. F.2

Vyberete napøíklad data z vyšetøení pacienta a oznaèíte je jako 
data vybraná k archivaci na disk CD-R. Poté mùžete pøidat data 
z vyšetøení dalšího pacienta, nebo mùžete k vybraným datùm 
pøidat další snímky téhož pacienta. F.2

V režimu vícenásobné relace mùžete zapisovat data na CD-R/
DVD-R ve více krocích. F.2

➭ Po zmìnì režimu relace musíte systém restartovat.

!0

F.2 F.2

F.2

Aby se minimalizovalo nebezpeèí ztráty dat, používejte k 
archivování pouze disky CD-R/DVD-R schválené spoleèností 
Siemens a klasifikované jako „lékaøské". F.2

Disky CD-R/DVD-R vhodné k lékaøským úèelùm vám zajistí 
zástupce spoleènosti Siemens. F.2
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Ukládání dat Uložení a výmìna dat
Prohlížecí nástroj F.2 Pøi exportu obrazù na disk CD-R/DVD-R je na tentýž disk možno 
uložit také pøíslušný prohlížecí nástroj. F.2

V dialogovém oknì Enter Label je zaškrtávací políèko, které 
uživateli umožòuje zvolit, zda má být prohlížecí nástroj uložen 
na médium èi nikoli. F.2

Prohlížeè DICOM umožòuje prohlížet exportované obrazy na 
vìtšinì standardních PC. F.2
F.2–16 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Archivace na disk CD-R v režimu jedné relaceF.2

Je-li váš systém nakonfigurován pro režim jedné relace, 
mùžete data ukládat pouze na nové, nepoužité disky CD-R. Po 
provedení zápisu dat na CD-R zápis již nelze zmìnit. Po 
dokonèení zápisu bìhem první relace již nebude možné pøidat 
další data, i kdyby pro nì teoreticky byl dostatek místa. F.2

Proto musíte nejdøíve provést sbìr všech dat, která chcete na 
disk CD-R umístit, abyste je poté mohli na disk CD-R zapsat v 
jednom kroku. Jakmile shromáždíte dostatek dat k zaplnìní 
disku CD-R, systém vás o této skuteènosti informuje. 

F.2

Výbìr dat pro uložení na 
disk CD-R F.2

✧ Vyberte data, která chcete uložit.

✧ Vyberte nabídku Transfer > Archive to CD-R.

Nebo F.2

F.2 ✧ Klepnìte na tlaèítko s ikonou.

Nebo F.2

✧ Otevøete nabídku Transfer > Archive to... a vyberte volbu CD 
Recorder. 
→ Strana F.2–30, Výbìr místa urèení a archivace

➭ Pokud údaje o pacientovi dosud nejsou úplné, systém vás o 
tom informuje prostøednictvím pøíslušného hlášení. Chybìjící 
údaje zadejte do dialogového okna Correct. 
→ Kapitola C.4, Oprava dat
Verze VE31D F.2–17 
únor 2006

 0.0



Ukládání dat Uložení a výmìna dat
Pojmenování disku CD-R F.2 Pokud vybíráte data pro nový disk CD-R poprvé, zobrazí se 
dialogové okno Enter Label. F.2

 

✧ Zadejte jednoznaèný název disku CD-R (napøíklad sériové 
èíslo a datum), nebo potvrïte navržený název.

➭ Název mùže být tvoøen písmeny A až Z, èíslicemi 0 až 9 a 
podtržítky (malá písmena budou automaticky pøevedena na 
velká). Název smí obsahovat tøi až jedenáct znakù.

✧ Chcete-li, aby byl uložen také pøíslušný prohlížecí nástroj, 
zaškrtnìte políèko Viewing tool.

✧ Volbu potvrïte kliknutím na tlaèítko OK.

➭ V závislosti na konfiguraci systému mùže být dialog Enter 
label vynechán a použita místo toho funkce automatického 
pojmenování.
F.2–18 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Výbìr dalších dat F.2 ✧ Vyberte další data, která chcete uložit.

✧ Proveïte funkci Transfer > Archive to CD-R.

Nebo F.2

F.2 ✧ Kliknìte na tlaèítko s ikonou. 

✧ Tímto zpùsobem postupnì vyberte všechny datové záznamy, 
které chcete uložit.

➭ Seznam všech dat vybraných k uložení na disk CD-R se zobrazí 
v oknì Local Job Status. 
→ Strana F.5–4, Øízení místních úloh
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Ukládání dat Uložení a výmìna dat
Automatické spuštìní 
zápisu F.2

Jakmile shromáždíte dostatek dat k zaplnìní disku CD-R, 
zobrazí se pøíslušné dialogové okno. F.2

 

✧ Ujistìte se, že jste do jednotky pro zápis vložili nový disk CD-
R. 
→ Strana F.2–4, Vkládání a vysouvání médií

✧ Zvolením možnosti Yes spustíte zápis. 

➭ Vyberete-li možnost No, zápis se zastaví a archivace bude 
zrušena. Pokud budete chtít pozdìji pokraèovat, budete 
muset tento postup spustit ruènì. 
→ Kapitola F.5, Kontrola pøenosu dat 

Není vložen disk CD-R F.2 Pokud jste vybrali volbu Yes, avšak v jednotce pro zápis není 
disk CD-R, zobrazí se jiné dialogové okno. F.2

✧ Vložte nový disk CD, chvíli poèkejte a poté potvrïte 
stisknutím tlaèítka OK.
F.2–20 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Ruèní spuštìní zápisu F.2 Všechna dosud vybraná data mùžete exportovat na CD-R. F.2

✧ Zvolte Transfer > Record to CD-R.

Nebo F.2

F.2 ✧ Kliknìte na tlaèítko s ikonou. 

➭ U nìkterých systémù mùže být zápis na CD doèasnì omezen, 
napøíklad není možné vypalování bìhem poøizování dat. 

Zobrazí se dialogové okno s informací o využití pamì¤ové 
kapacity disku CD-R. F.2

 

✧ Potvrzením pomocí tlaèítka Yes spustíte zápis. 
→ Strana F.2–20, Není vložen disk CD-R

➭ Tlaèítkem No operaci odložíte (napøíklad na dobu, kdy bude 
shromáždìno více dat).
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Ukládání dat Uložení a výmìna dat
Zápis F.2 Zobrazí se dialogové okno s informacemi o prùbìhu zápisu. F.2

 

Ukazatel stavu zobrazuje zbývající dobu procesu archivace. F.2

Vypalování na pozadí F.2 Skuteèná operace vypalování probíhá na pozadí. Dialogové 
okno mùžete zavøít a poté mùžete obrazy napøíklad dodateènì 
zpracovat. Aktivní operace vypalování je signalizována 
symbolem na stavovém øádku. 
→ Strana F.5–2, Zobrazení ve stavovém øádku F.2

Po vypálení mùžete disk CD-R vyjmout, oznaèit jej na horní 
stranì nesmazatelným popisovaèem s mìkkou plstìnou 
špièkou a poté jej uložit nebo pøedat dále. F.2
F.2–22 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Chybný disk CD/DVD F.2 Pokud do jednotky nedopatøením vložíte popsaný nebo 
poškozený disk CD, zobrazí se následující dialogové okno. F.2

 

✧ Potvrïte operaci tlaèítkem OK.

✧ Disk CD-R vymìòte. 
→ Strana F.2–4, Vkládání a vysouvání médií
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Ukládání dat Uložení a výmìna dat
Archivace na disk CD-R/DVD-R v režimu 
vícenásobné relace F.2

Je-li váš systém nakonfigurován pro režim vícenásobné relace, 
mùžete data ukládat na nové, nepoužité disky CD nebo na 
neukonèené disky CD, na které již byl jednou nebo nìkolikrát 
proveden zápis. Ostatní data uložená na CD-R/DVD-R se 
neztratí, nová data budou jednoduše pøidána. F.2

F.2

➭ Soubory prohlížecího nástroje je nutno zaznamenat na disk v 
první relaci.

F.2

UPOZORNÌNÍ

Chyba ètení mùže zpùsobit, že médium bude nepoužitelné. F.2

V režimu vícenásobné relace by mohlo také dojít ke ztrátì 
døíve uložených dat. Potom budou všechny archivaèní 
pøíznaky nastavené k tìmto datùm v databázi neplatné. F.2

✧ Z místní databáze smažte pouze data, která jste uložili na 
médium, po úspìšném uzavøení a ovìøení média.
F.2–24 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Vložení CD-R/DVD-R F.2 Než systém vybere data pro archivaci, musí být známa 
pamì¤ová kapacita. F.2

✧ Proto se ujistìte, že pøíslušný disk CD-R/DVD-R byl vložen do 
jednotky pro zápis na CD. 
→ Strana F.2–4, Vkládání a vysouvání médií

➭ V dialogovém oknì Transfer Configuration mùžete urèit, jak 
mají být údaje o pacientovi na disk CD-R/DVD-R zapsány 
(využití pamìti a komprese). 
→ Strana F.6–10, Archivace a export 

Výbìr dat pro záznam na 
CD-R/DVD-R F.2

✧ Postupujte stejnì jako pøi režimu jedné relace.

→ Strana F.2–17, Výbìr dat pro uložení na disk CD-R 
→ Strana F.2–18, Pojmenování disku CD-R 
→ Strana F.2–19, Výbìr dalších dat F.2

Systém zkontroluje velikost pamìti, která je potøebná pro 
vybraná data, a data, která jsou již na disku CD-R/DVD-R uložena. 

F.2
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Ukládání dat Uložení a výmìna dat
Nedostatek pamìti F.2 Pokud na disku CD-R/DVD-R není dostatek volné pamìti, 
zobrazí se dialogové okno. F.2

✧ Chcete-li, aby údaje o pacientovi byly rozdìleny na více 
médií, kliknìte na Continue. 

Jestliže je nakonfigurována funkce Keep all objects... a nebylo 
možné vytvoøit virtuální objem, protože médium je plné nebo 
ne všechny pøípady úlohy by mohly být zapsány do virtuálního 
objemu, zobrazí se okno s hlášením. F.2

Zaškrtávací políèko Finalize before eject... je aktivováno. F.2

F.2 ✧ Kliknutím na Eject vysunete a uzavøete právì vložené 
médium.

✧ Vložte nové médium, abyste uložili všechny objekty náležející 
tomuto pacientovi. 

Využití pamì¤ové kapacity mùžete nakonfigurovat v oknì 
Transfer Configuration. 
→ Strana F.6–12, Stanovení využití pamì¤ové kapacity 

F.2
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Uložení a výmìna dat Ukládání dat
Chybný disk CD/DVD F.2 Pokud jste do jednotky nedopatøením vložili chybný nebo 
poškozený disk CD/DVD, zobrazí se následující dialogové okno.F.2

 

✧ Kliknìte na tlaèítko Eject. 
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Ukládání dat Uložení a výmìna dat
Pokraèování s jiným diskem 
CD-R/DVD-R F.2

✧ Jestliže do jednotky vkládáte jiný disk CD-R/DVD-R, chvíli 
vyèkejte a poté kliknìte na tlaèítko Retry.

Systém nyní zkontroluje, zda je na vloženém CD-R/DVD-R 
dostatek volné pamìti, a je-li tomu tak, pokraèuje v zápisu. F.2

➭ Celý postup mùžete zrušit kliknutím na tlaèítko Cancel. 

Zápis F.2 ✧ Postupujte stejnì jako pøi režimu jedné relace. 
→ Strana F.2–21, Ruèní spuštìní zápisu 
→ Strana F.2–22, Vypalování na pozadí 

Záznamová rychlost F.2 Záznamová rychlost je buï polovièní maximální, nebo 
maximální rychlost. F.2
F.2–28 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Obnovení døíve uložených relací  
na CD-R s vícenásobnou relací F.2

Vyskytne-li se bìhem zápisu na disk CD-R v režimu 
vícenásobné relace chyba (napøíklad výpadek napájení), 
mohou se ztratit i všechna data, která již na pøíslušný disk CD-
R byla uložena døíve. Sada programù proto obsahuje servisní 
nástroj, který umožòuje obnovení pøedchozích relací. F.2

✧ Vložte poškozený disk CD-R do jednotky pro zápis.

✧ Otevøete nabídku Local Service a zadejte servisní klíè. 
→ Strana A.5–4, Místní servis

✧ Vyberte možnost Utilities.

✧ Ze seznamu vyberte funkci Recover CD

✧ Vyberte jednotku CD, v níž se nachází pøíslušný disk CD.

✧ Klepnìte na tlaèítko Go.

Probìhne-li obnovení úspìšnì, zobrazí se hlášení “CD-R 
restored successfully”. F.2

✧ Vložte disk CD-R do jednotky a zkontrolujte jeho obsah v 
Patient Browser.

➭ Není-li médium možno obnovit, zobrazí se hlášení “Writing to 
CD-R failed: Cannot restore CD” nebo jiné chybové hlášení.
Verze VE31D F.2–29 
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Ukládání dat Uložení a výmìna dat
Výbìr místa urèení a archivace F.2

Chcete-li vybrat místo urèení a požadujete pøitom více 
informací o vloženém datovém médiu nebo o cílovém místì 
informace, mùžete použít tento postup. F.2

✧ Vložte požadovaná datová média. 
→ Strana F.2–4, Vkládání a vysouvání médií

✧ Vyberte data, která chcete uložit.

✧ Vyberte položku Transfer > Archive to....

Nebo F.2

F.2 ✧ Kliknìte na tlaèítko s ikonou. 

Zobrazí se dialogové okno Archive To. F.2

 

➭ Budou se vypisovat pouze ty jednotky, které obsahují nìjaké 
médium. Jednotky s CD-R s jednou relací se nebudou 
vypisovat
F.2–30 Návod k použití pro uživatele systému syngo

 0.0



Uložení a výmìna dat Ukládání dat
Tento seznam obsahuje následující informace: F.2

❏ Destination 
Název jednotky, která obsahuje médium MOD nebo CD.

❏ Compression 
Metoda komprese dat, která mají být v této jednotce uložena. 
→ Strana F.6–14, Nastavení komprese dat

❏ Quality Factor 
Faktor kvality, se kterým jsou data komprimována.

➭ V dialogovém oknì Transfer Configuration mùžete pro 
každou jednotku urèit, zda a jakou metodou má být pøi 
archivaci provedena komprese dat. 
→ Strana F.6–10, Archivace a export

❏ Label on medium 
Pøidìlený název datového média.

❏ Medium Capacity 
Zbývající volná pamì¤ na datovém médiu.

❏ Total Capacity 
Celková pamì¤ová kapacita datového média. 

✧ Vyberte ze seznamu požadovanou jednotku. Vezmìte v 
úvahu velikost volné pamìti a nastavený stupeò komprese. 

F.2 ✧ Kliknutím na tlaèítko Archive uložte data na vybrané 
jednotce.

Nebo F.2

F.2 ✧ Klepnutím na tlaèítko Cancel operaci zrušte.
Verze VE31D F.2–31 
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Ukládání dat Uložení a výmìna dat
Archivace v síti F.2

Je-li váš systém pøipojen k centrálnímu archivu, použijte k 
archivaci údajù o pacientech a jejich vyšetøení tento archiv. F.2

✧ Vyberte data, která chcete archivovat.

✧ Vyberte položku Transfer > Archive to....

Zobrazí se dialogové okno Archive To. Zobrazí se sí¤ové uzly a 
jednotky, které jsou k dispozici pro archivaci. F.2

 

F.2–32 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
V pøípadì archivaèních uzlù mají význam následující 
informace: F.2

❏ Destination 
Název archivu

❏ Compression 
Metoda, pomocí které jsou data komprimována.

❏ Quality Factor 
Faktor kvality, se kterým jsou data komprimována.

➭ V dialogovém oknì Transfer Configuration mùžete urèit, zda 
a jakou metodou má být pøi archivaci provedena komprese 
dat. 
→ Strana F.6–19, Nastavení komprese dat 

✧ Vyberte ze seznamu požadovaný archiv.

F.2 ✧ Kliknutím na tlaèítko Archive pøeneste data do vybraného 
archivu. 

Nebo F.2

F.2 ✧ Klepnutím na tlaèítko Cancel postup zrušte.

F.2
Verze VE31D F.2–33 
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Ukládání dat Uložení a výmìna dat
Informace o pøenosu F.2

Jakmile spustíte archivaci nebo export, systém zkontroluje, zda 
byly splnìny urèité podmínky. F.2

Objekty, které jsou již uloženy na datovém 
médiu F.2

Jestliže se na datovém médiu (MOD nebo obrazový soubor pro 
CD-R/DVD-R) již nachází objekt, zobrazí se okno s hlášením. F.2

 

✧ Chcete-li tyto stávající objekty pøepsat, klepnìte na tlaèítko 
Yes.

✧ Chcete-li objekty na médiu zachovat a pøidat k nim chybìjící 
objekty, kliknìte na tlaèítko No. 

✧ Chcete-li postup zrušit, kliknìte na tlaèítko Cancel. 
V tom pøípadì se žádná data neexportují/neuloží.
F.2–34 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Ukládání dat
Objekty, které již byly uloženy do archivu F.2

Pokud jste již jeden èi nìkolik vybraných objektù uložili do 
archivu, zobrazí se jiné okno s hlášením. F.2

➭ Systém nekontroluje, zda objekty nebyly zaøazeny do fronty 
pro pøenos opakovanì.

 

✧ Chcete-li znovu archivovat objekty, které již byly archivovány 
døíve, kliknìte na tlaèítko Yes.

✧ Chcete-li pøeskoèit již archivované objekty a souèasnì pøidat 
chybìjící objekty, kliknìte na tlaèítko No. 

✧ Chcete-li postup zrušit, kliknìte na tlaèítko Cancel. 
V tom pøípadì se žádná data neexportují/neuloží.

F.2
Verze VE31D F.2–35 
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Ukládání dat Uložení a výmìna dat
F.2–36 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

F.3

 
Výmìna dat F.3
Údaje o pacientovi a vyšetøení si mùžete vymìòovat s dalšími 
osobami dvìma zpùsoby: prostøednictvím sítì nebo fyzickým 
pøedáním datových médií. F.3

Formát DICOM F.3 V lékaøském prostøedí se k výmìnì dat používá jednotný 
formát, jímž je formát DICOM (Digital Imaging and 
Communications in Medicine, tj. digitální snímkování a 
komunikace v lékaøství). F.3

➭ Tento systém je formátu DICOM pøizpùsoben. Prohlášení o 
shodì si mùžete vyžádat od svého servisního partnera. 

Odesílání/archivace F.3 Je-li váš systém pøipojen k poèítaèové síti (DICOM), mùžete 
údaje o pacientovi a jeho vyšetøení odesílat na jiné pracovní 
stanice nebo je uložit v dlouhodobém archivu. 

F.3

Pøíjem F.3 Jiné pracovní stanice naopak mohou odesílat údaje o 
pacientech a jejich vyšetøení vám. Pøíjem dat se uskuteèòuje 
automaticky na pozadí. Po dokonèení postupu jsou data 
pøístupná prostøednictvím Patient Browser. 

F.3

Export/archivace F.3 Jsou-li ve vašem systému nainstalovány potøebné jednotky, 
mùžete data uložit také na datové médium (disk MOD nebo CD-
R/DVD-R). 

F.3

Import F.3 Uložená data lze z kteréhokoli média importovat pomocí 
Patient Browser. 
→ Strana C.2–26, Naèítání dat z archivaèního média F.3
Verze VE31D F.3–1 
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Výmìna dat Uložení a výmìna dat
Odesílání v síti F.3

Je-li váš systém pøipojen k síti a odpovídajícím zpùsobem 
nakonfigurován, mùžete údaje o pacientech a jejich vyšetøení 
vybrat ze své místní databáze a v pøípadì potøeby je kdykoli 
odeslat dalším uživatelùm pøipojeným k síti DICOM. F.3

Jedna nebo nìkolik pracovních stanic jsou v síti nastaveny jako 
standardní sí¤ové adresy. Data mùžete odesílat buï pøímo na 
jednu z tìchto standardních adres, nebo si mùžete vybrat 
vlastní sí¤ové pøipojení. F.3

➭ Je-li aktivována funkce Security, mùžete data odesílat pouze v 
pøípadì, že k tomu jste autorizováni.

Odesílání dat na standardní adresu F.3

Bìhem instalace servisní pracovníci spoleènosti Siemens 
Service nastaví rùzná sí¤ová pøipojení (napøíklad Node 1 a 
Node 2) jako standardní adresy v síti. F.3

✧ Vyberte data, která chcete odeslat.

F.3 ✧ Na klávesnici se symboly stisknìte klávesu Send to Node 1. 

nebo F.3

✧ Aktivujte funkci Transfer > Send to Node 1 nebo Transfer > 
Send to Node 2.

Nebo F.3

F.3 ✧ Kliknìte na pøíslušné tlaèítko. 

Data budou odeslána na vybranou adresu. F.3
F.3–2 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Výmìna dat
Odesílání dat na jinou adresu v síti F.3

Chcete-li odeslat data na jiné než výchozí adresy nebo chcete-
li je odeslat dvìma nebo více uživatelùm sítì souèasnì, 
vyberte sí¤ové (sí¤ová) pøipojení ze seznamu. F.3

✧ Nejdøíve vyberte data, která chcete odeslat. 

✧ Aktivujte funkci Transfer > Send to....

Nebo F.3

F.3 ✧ Kliknìte na toto tlaèítko. 
 

Zobrazí se dialogové okno Send To se seznamem všech 
dostupných sí¤ových adres. F.3

 

Verze VE31D F.3–3 
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Výmìna dat Uložení a výmìna dat
Tento seznam obsahuje následující informace: F.3

❏ Network Node 
Název sí¤ového pøipojení (název pøíjemce).

❏ Compression 
Metoda komprese, pomocí které jsou data pøipravena pro 
rychlejší pøenos. 
V oknì Transfer Configuration definujete, zda a jakou 
metodou mají být data komprimována pro odeslání. 
→ Strana F.6–18, Nastavení sí¤ových uzlù

❏ Quality Factor 
Faktor kvality udává kvalitu obrazu s komprimovanými daty v 
porovnání s pùvodními daty. 
→ Strana F.6–19, Nastavení komprese dat 
 

✧ Vyberte jedno nebo nìkolik sí¤ových pøipojení. 

F.3 ✧ Klepnutím na tlaèítko Send na tuto adresu (adresy) odešlete 
vybraná data.

Nebo F.3

F.3 ✧ Kliknutím na tlaèítko Cancel operaci zrušte. 
 

F.3–4 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Výmìna dat
Export na datové médium F.3

Pokud ukládáte údaje o pacientovi a jeho vyšetøení ve formátu 
DICOM na datové médium za úèelem výmìny dat nebo k 
soukromým úèelùm, vždy k tomu použijte funkci Export to... . 
Tato funkce se používá pøesnì stejným zpùsobem jako funkce 
Archive to.... 
→ Strana F.2–30, Výbìr místa urèení a archivace F.3

Na rozdíl od funkce archivování však funkce exportu neprovádí 
kontrolu pøedchozích archivaèních úkonù, znaèení nebo stavu 
práce. F.3

➭ Je-li aktivována funkce Security, mùžete data exportovat 
pouze v pøípadì, že jste k tomu oprávnìni. 

Export F.3 ✧ Vložte správné médium. 
→ Strana F.2–4, Vkládání a vysouvání médií

✧ Vyberte data, která chcete exportovat.

✧ Aktivujte funkci Transfer > Export to....
Verze VE31D F.3–5 
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Výmìna dat Uložení a výmìna dat
Zobrazí se dialogové okno Export To. 
Vypíšou se dostupné jednotky. F.3

 

➭ U jednotek MOD jsou v seznamu uvedeny pouze ty z nich, 
které obsahují zformátované a pojmenované soubory. 

✧ Vyberte ze seznamu požadovanou jednotku. Zkontrolujte 
zbývající pamì¤ovou kapacitu a nastavenou kompresi dat.

F.3 ✧ Kliknutím na tlaèítko Export uložte data z vybrané jednotky.

Nebo F.3

F.3 ✧ Kliknutím na tlaèítko Cancel postup zrušte. 

➭ Viz také: 
→ Strana F.2–30, Výbìr místa urèení a archivace 
→ Strana F.2–34, Informace o pøenosu

F.3
F.3–6 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

F.4

Export a import do/ze 
systému souborù F.4
Chcete-li snímky používat a zpracovávat také v jiných 
aplikacích, mùžete je zkopírovat z místní databáze do adresáøe 
na vašem pevném disku nebo do vzdáleného poèítaèe. Naopak 
snímky uložené v adresáøi na pevném disku lze naèítat do 
systému. F.4

Formáty snímkù F.4 Podporovány jsou následující formáty: F.4

❏ formát DICOM (*.ima),

❏ rastrový obrázek systému Windows (*.bmp),

❏ formát AVI (*.avi) (nástroj CamTasia).

!0

F.4 F.4

Snímky se ukládají jako jednotlivé soubory do adresáøe na 
systémovém pevném disku. Pro tento úèel jsou povoleny 
adresáøe podle modality. F.4

Snímky ve formátech rastrového obrázku a souboru AVI 
systému Windows je možno exportovat, nikoli však 
importovat. F.4
Verze VE31D F.4–1 
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Export a import do/ze systému souborù Uložení a výmìna dat
Export snímkù do systému souborùF.4

Jeden nebo nìkolik snímkù mùžete zkopírovat do specifických 
aktivovaných adresáøù na systémovém pevném disku nebo v 
síti. F.4

➭ Do sí¤ové jednotky mùžete data exportovat pouze tehdy, 
jestliže bylo nakonfigurováno sí¤ové spojení a jestliže je toto 
spojení aktivní.

➭ Je-li aktivována funkce Security, mùžete data exportovat 
pouze v pøípadì, že jste k tomu oprávnìni. 

Export F.4 ✧ Vyberte snímky, které chcete exportovat.

✧ Aktivujte funkci Transfer > Export to Off-line....

Zobrazí se dialogové okno Export to Off-line. F.4

 

F.4–2 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Export a import do/ze systému souborù
Cesta F.4

✧ Požadovanou jednotku a adresáø vyberte z výbìrového 
seznamu Path.

✧ V pøípadì potøeby cestu doplòte.

➭ Chcete-li vybrat nebo vytvoøit nový podadresáø, pøidejte k této 
cestì cestu k podadresáøi oddìlenou znakem "\" (v hlavním 
adresáøi lze vytvoøit až 8 úrovní podadresáøù).

➭ Mùžete vybrat také adresáø na jiném poèítaèi pøipojeném k 
síti.  
Umožòuje-li to konfigurace, zadejte 
"\\RemoteNode\RemoteDir".

!0

F.4 F.4

Zajistìte, aby názvy nových adresáøù a podadresáøù 
neobsahovaly mezery. 
Nepoužívejte žádný z tìchto znakù: = \  ^. F.4
Verze VE31D F.4–3 
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Export a import do/ze systému souborù Uložení a výmìna dat
Formát snímku F.4

✧ Požadovaný formát obrazu vyberte z výbìrového seznamu 
Select format (výchozí nastavení: DICOM).

➭ V závislosti na tom, o jaký typ snímkù se jedná, jsou snímky 
exportovány v režimu 8 bitù/256 stupòù šedé nebo 24 bitù/
RGB.

➭ Pokud jste v prohlížeèi Patient Browser vybrali snímek s 
vícenásobným rámcem, bude exportován pouze 
charakteristický snímek ve formátu rastrového obrázku.

➭ Buïte si vìdomi, že soubory z výchozího adresáøe podle 
modality pøesahující pamì¤ovou kapacitu disku CD-R/DVD-R 
budou po úspìšném provedení funkce Record Off-line Files 
odstranìny. 

Text snímku F.4

✧ Rozhodnìte se, zda mají být do obrazu „vypáleny" a spoleènì 
s ním exportovány také text a/nebo grafika obrazu.

➭ Jestliže jste vybrali formát DICOM, budou text a grafika 
exportovány souèasnì s obrazem, ponìvadž jsou do formátu 
DICOM zahrnuty, tj. v dialogovém oknì jsou aktivovány 
funkce Export. 
F.4–4 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Export a import do/ze systému souborù
Export provádìný 
anonymnì F.4

Data je možno ukládat také anonymnì. F.4

✧ Kliknìte na zaškrtávací políèko anonymously a do pole 
Dummy Name zadejte jméno, pod nímž nají být obrazy 
uloženy. 

Spuštìní exportu F.4

F.4 ✧ Potvrïte operaci tlaèítkem OK. 

Vybraná data snímkù budou uložena jako samostatné soubory.F.4
Verze VE31D F.4–5 
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Export a import do/ze systému souborù Uložení a výmìna dat
Názvy souborù F.4 Názvy souborù se øídí následujícím schématem: F.4

Køestní, prostøední jméno pacienta, pøíjmení 
pacienta.Modalita.Popis studie.SeriesNo.ImageNo.time_stamp.
lp-LOID.ima F.4

Èasový øetìzec se øídí následujícím formátem: 
yyyy.MM.DD.hh.mm.ss.dddddd F.4

yyyy: rok, napøíklad 2000 
MM: mìsíc, napøíklad 09 
DD: den, napøíklad 10 
hh: hodina, napøíklad 15 
mm: minuta, napøíklad 35 
ss: sekunda, napøíklad 13 
dddddd: desetinná místa, napøíklad 123456 F.4

→ Strana F.4–1, Formáty snímkù 
F.4

Pøíklad: 
Miller.CT.Liver.2.13.2000.04.10.15.35.13.123456.ima F.4

➭ V japonské verzi je v názvu souboru vynecháno jméno 
pacienta a název vyšetøení.
F.4–6 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Export a import do/ze systému souborù
Import obrazù ze systému souborùF.4

Jednotlivé snímky mùžete naèítat z konkrétních povolených 
adresáøù na systémovém pevném disku nebo je pøenášet do 
místní databáze prostøednictvím sítì. F.4

➭ Import dat ze sí¤ového adresáøe mùžete provádìt pouze 
tehdy, pokud bylo nakonfigurováno sí¤ové spojení, pokud je 
toto spojení aktivní a pøíslušný adresáø je povolen.

➭ Data nelze naèítat pøímo z disku CD.  
Verze VE31D F.4–7 
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Export a import do/ze systému souborù Uložení a výmìna dat
Import F.4 ✧ Aktivujte funkci Transfer > Import from Off-line.... 

Zobrazí se dialogové okno Import from Off-line. Výchozí 
adresáø podle modality je již vybrán. F.4

 

Výbìr souboru (souborù) F.4

 

✧ Vyberte požadovanou jednotku a adresáø z výbìrového 
seznamu Path nebo zadejte požadovanou cestu a (je-li tøeba) 
název souboru.

➭ Pomocí standardního zástupného znaku "*" systému 
Windows mùžete vybrat nìkolik souborù najednou.
F.4–8 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Export a import do/ze systému souborù
Nebo F.4

✧ Vyberte požadovaný soubor (požadované soubory) z 
adresáøe.

➭ Pomocí levého tlaèítka myši a kláves Shift a Ctrl mùžete 
vybrat nìkolik souborù najednou.

F.4 ✧ V pøípadì potøeby mùžete procházet stromovou strukturou 
adresáøù poklepáním na složku a klepnutím na tlaèítko 
"nahoru".

➭ Pøístupné jsou všechny adresáøe vycházející z koøenového 
adresáøe urèeného pøi konfiguraci. 

F.4 ✧ Naètení vybraných souborù snímkù do vaší místní databáze 
potvrïte tlaèítkem OK.

Nebo 
F.4

✧ Poklepejte na název pøíslušného souboru.

!0

F.4 F.4

Zajistìte, aby názvy nových adresáøù a podadresáøù 
neobsahovaly mezery. 
Nepoužívejte žádný z tìchto znakù: = \  ^. F.4
Verze VE31D F.4–9 
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Export a import do/ze systému souborù Uložení a výmìna dat
Record Off-line Files F.4

Všechny soubory, napøíklad obrazy ve formátu BMP a sekvence 
obrazù ve formátu AVI, které byly již døíve exportovány do 
specifického adresáøe, mohou být automaticky zaznamenány 
na disk CD-R/DVD-R. Výchozí cestu k tomuto adresáøi podle 
modality musí nakonfigurovat servisní pracovník. 
→ Strana F.4–2, Export snímkù do systému souborù 

F.4

✧ V hlavní nabídce aktivujte funkci Transfer > Record Off-line 
Files.

Spustí se zápis v režimu jedné relace. 
F.4

➭ Mìjte na pamìti, že disk CD-RDVD-R a okno Local Job Status
musejí být prázdné.

➭ Bìhem zápisu nelze do uvedeného adresáøe kopírovat 
soubory. 

✧ Po dokonèení zápisu na disk CD-R/DVD-R budou z tohoto 
adresáøe všechny zapsané obrazy odstranìny.

F.4

F.4

F.4

UPOZORNÌNÍ

Použití jiného než nakonfigurovaného adresáøe pro datové 
soubory CamTasia. F.4

Datový disk je plný a nelze provádìt další vyšetøení. 
Uživatel už nemùže soubory smazat. F.4

✧ Pro ukládání datových souborù CamTasia používejte pouze 
adresáø urèený pøi konfiguraci.
F.4–10 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

F.5

 
Kontrola pøenosu dat F.5
Všechny úlohy archivace, odesílání nebo exportu jsou 
provádìny postupnì. F.5

Pøitom mùžete kdykoli zjistit, které úlohy byly dokonèeny, 
která z nich právì probíhá a které dosud èekají ve frontì na 
zpracování. F.5

Jednu sí¤ovou úlohu pøitom mùžete oznaèit jako urgentní; úlohy 
také mùžete pozastavovat, opakovat nebo odstraòovat a 
ovlivòovat tak jejich poøadí ve frontì. 
 

F.5

Kontrola  
pøenosu dat F.5

Ve stavovém øádku je zobrazena informace, zda systém 
provádí archivaci, import, odesílání, pøíjem nebo zápis na 
pozadí. F.5

Informace o úlohách archivace a exportu nebo importu dat do 
jednotek nebo z jednotek MOD a CD-R/DVD-R naleznete v 
dialogovém oknì Local Job Status. F.5

V dialogovém oknì Network Job Status naleznete informace 
o úlohách výmìny dat v síti. F.5
Verze VE31D F.5–1 
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Kontrola pøenosu dat Uložení a výmìna dat
Zobrazení ve stavovém øádku F.5

Bìhem pøenosu dat jsou ve stavovém øádku zobrazeny ikony, 
které vás informují o tom, jaká operace právì probíhá nebo zda 
pøi provádìní nìkteré úlohy nedošlo k chybì. F.5

Tak mùžete sledovat prùbìh pøenosu, aniž byste museli 
pøerušovat práci, a v pøípadì chyby mùžete zasáhnout. F.5

F.5

Tyto ikony poskytují informace o tom, zda aktuální úlohy 
probíhají bez chyb nebo zda se pøi provádìní nìkteré z nich 
vyskytla chyba. 

F.5

Chybová hlášení F.5 Vyskytne-li se bìhem pøenosu dat chyba, zobrazí se ve 
stavovém øádku spoleènì s pøíslušnou ikonou také chybové 
hlášení. F.5

Akce F.5 Neaktivní  Aktivní Interakce Nezdaøilo se Pozastaveno

Archivace/export/
import na datové 
médium

žádná 
ikona

Odesílání/archivace/
pøíjem po síti

žádná 
ikona

Zápis 
 

žádná 
ikona

žádná ikona žádná ikona
F.5–2 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Kontrola pøenosu dat
Prohlížení a øízení úloh pøenosu 
dat F.5

Zobrazení ve stavovém øádku poskytuje struèné informace o 
prùbìhu pøenosu dat. Podrobnìjší informace než ve stavovém 
seznamu naleznete v dialogových oknech Local Job Status a 
Network Job Status. Zde mùžete pozastavovat provádìní 
jednotlivých úloh nebo opravovat chyby. F.5

Bez ohledu na to, zda váš systém odesílá èi pøijímá údaje o 
pacientovi a jeho vyšetøení, mùžete tato dialogová okna stavu 
úloh kdykoli otevøít z nabídky Transfer, a tak získat informace 
o úlohách zaøazených do fronty. F.5

Jakmile se spustí pøenos dat na pozadí, mùžete tato dialogová 
okna otevøít pomocí ikon ve stavovém øádku. To je dobré 
øešení napøíklad v pøípadì, že se pøi pøenosu vyskytnou chyby. 
V takovém pøípadì mùžete okamžitì zjistit, kterých dat a 
operací se chyba týká, a odpovídajícím zpùsobem zasáhnout. F.5
Verze VE31D F.5–3 
únor 2006

 0.0



Kontrola pøenosu dat Uložení a výmìna dat
Øízení místních úloh F.5

Chcete-li vìdìt, která data jsou právì zapisována na místní 
datová média nebo jsou z tìchto médií importována, 
popøípadì èekají na archivaci èi export, mùžete otevøít 
dialogové okno Local Job Status. F.5

✧ Otevøete dialogové okno Transfer > Local Job Status....

Nebo F.5

F.5 ✧ Kliknìte na ikonu místního pøenosu dat na stavovém øádku. 
 

Zobrazí se dialogové okno Local Job Status. 
F.5
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Uložení a výmìna dat Kontrola pøenosu dat
Øízení sí¤ových úloh F.5

V dialogovém oknì Network Job Status mùžete získat 
informace o datech, která jsou pøenášena do sítì nebo 
odesílána ze sítì do vašeho systému. F.5

✧ Otevøete dialogové okno Transfer > Network Job Status....

Nebo F.5

F.5 ✧ Kliknìte na ikonu pro pøenos dat v síti umístìnou ve 
stavovém øádku. 

Zobrazí se dialogové okno Network Job Status. 
F.5

 

Øízení úloh v režimu Auto 
Transfer F.5

Vyskytnou-li se chyby bìhem automaticky spuštìného 
pøenosu dat, oznaèí se sí¤ová úloha uvedená v seznamu v 
dialogovém oknì Network Job Status. F.5
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Kontrola pøenosu dat Uložení a výmìna dat
Informace v dialogových oknech Job Status F.5

Dialogová okna Local Job Status nebo Network Job Status
obsahují seznamy úloh s následujícími informacemi: F.5

❏ Status 
Stav zpracování úloh. 
→ Strana F.5–8, Stavové informace o pøenosu dat

❏ Patient 
Jméno pacienta, jehož data jsou pøenášena.

❏ Object 
Typ a rozsah pøenášených dat.

❏ No. of images 
Poèet obrazù, které mají být v rámci úlohy pøeneseny.

➭ Pokud bude bìhem provádìní úlohy archivace systémový 
program ukonèen, nemusí se v dialogových oknech Job Status
po opìtovném spuštìní systému zobrazit správný poèet 
snímkù.

❏ Source 
Zdrojová adresa, tj. název datového média nebo sí¤ová 
adresa nebo vaše místní databáze

❏ Destination 
Cílová adresa, tj. název pamì¤ového média nebo sí¤ová 
adresa nebo vaše místní databáze
F.5–6 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Kontrola pøenosu dat
❏ Posted 
Okamžik, kdy byl datový pøenos iniciován (v pøípadì dat 
pøijímaných po síti je èas uveden v závorkách)

❏ Try (pouze v dialogovém oknì Network Job Status) 
Poèet pokusù k dosažení cílové adresy pøed úspìšným 
zpracováním úlohy.

❏ Remain 
Poèet obrazù, které ještì musí být pøeneseny

➭ Pokud bude bìhem provádìní úlohy archivace systémový 
program ukonèen, nemusí se v dialogových oknech Job 
Status po opìtovném spuštìní systému zobrazit správný 
poèet zbývajících snímkù.

❏ Urg (pouze v dialogovém oknì Network Job Status) 
Klasifikace jako urgentní

❏ Failed Objects 
Poèet objektù, které nebylo možné pøenést. Hlášení, které o 
této skuteènosti informuje, se zobrazí ve stavovém øádku.
Verze VE31D F.5–7 
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Kontrola pøenosu dat Uložení a výmìna dat
Stavové informace o pøenosu dat F.5

Stav pøenosu dat udává, do jaké míry již byla pøíslušná úloha 
provedena: F.5

❏ Queued 
Úloha stále ještì èeká na zpracování.

❏ Active 
Úloha je právì zpracovávána.

❏ Waiting 
Sí¤ová úloha èeká na potvrzení, že data byla pøijata.

❏ Stopping 
Právì probíhá pozastavování úlohy.

❏ Stopped 
Zpracování úlohy bylo pozastaveno uživatelem.

❏ Completed 
Celá úloha byla zpracována. Všechna data byla bezchybnì 
pøenesena.

❏ Failed 
Pøi zpracovávání úlohy se vyskytla chyba. Provádìní úlohy 
proto nebylo možno dokonèit.

❏ Recordable 
Tato úloha obsahuje data, která byla pøedem vybrána pro 
zápis na disku CD-R. Dosud však nebyla na disk CD-R zapsána. 
→ Strana F.2–2, Zálohování na místní datová média

❏ Recording 
Data jsou právì zapisována na CD-R/DVD-R.

❏ Rec. Failed 
Bìhem zápisu na CD-R/DVD-R se vyskytla chyba.

❏ Retrying 
Pøi odesílání do sí¤ového uzlu se vyskytla chyba. Po uplynutí 
doby stanovené pøi konfiguraci bude pokus o odeslání 
zopakován.
F.5–8 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Kontrola pøenosu dat
❏ Receiving 
Data tvoøící souèást této úlohy jsou právì pøijímána pomocí 
sítì.

❏ Received 
Pøijímání dat z poèítaèové sítì bylo dokonèeno.

❏ Spooling 
Úloha je právì pøipravována k pøenosu.

❏ Error 
Nebylo možné pøipravit úlohu k pøenosu (chyba bìhem 
sestavování).

❏ Deleting 
Právì probíhá mazání úlohy.

➭ Úlohy se stavem „Error" (Chyba), „Receiving" (Pøijímání) (nebo 
aktivní úlohy importu) a „Spooling" (Sestavování) se již po 
opakovaném spuštìní nezobrazí.
Verze VE31D F.5–9 
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Kontrola pøenosu dat Uložení a výmìna dat
Øízení pøenosu dat F.5

Úlohy pøenosu dat mùžete vybírat v dialogových oknech Local 
Job Status nebo Network Job Status. Zpracovávat je mùžete 
pomocí tlaèítek. F.5

Úkony, které mùžete provádìt, a tedy i tlaèítka, která jsou 
aktivní, závisejí na stavu úlohy. 
 

F.5

Pozastavování úloh F.5 Úlohy se stavem „Active“, „Retrying" a „Queued“ mùžete 
pozastavit kdykoli (napøíklad pokud pøed zpracováním chcete 
vymìnit archivaèní médium MOD nebo disk CD-R/DVD-R). F.5

F.5 ✧ Vyberte jednu nebo nìkolik položek “Queued“ a klepnìte na 
tlaèítko Stop.

Vybrané úlohy a všechny další úlohy zaøazené ve frontì se 
stejnou cílovou adresou se již nebudou spouštìt automaticky. 
Tyto úlohy mají nejprve v prùbìhu pozastavování stav 
„Stopping" a po úplném pozastavení stav „Stopped“. 

F.5

Obnovování úloh F.5 Úlohu se stavem „Stopped“ mùžete obnovit v místì, v nìmž 
byla pozastavena (pouze pøi archivaci a importu, které se 
provádìjí v oknì Local Job Status). F.5

F.5 ✧ Vyberte jednu nebo nìkolik položek „Stopped“ a kliknìte na 
tlaèítko Continue.

Obnoví se také úlohy se stejnou cílovou adresou a vybrané 
úlohy. Pøíslušné úlohy budou mít nyní stav „Active“ nebo 
„Queued“. 
 

F.5
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Uložení a výmìna dat Kontrola pøenosu dat
Opìtovné spouštìní úloh F.5 Pokud jste úlohy pozastavili nebo pokud se v nich vyskytly 
chyby, mùžete je spustit opìt od zaèátku. Mùžete rovnìž 
zopakovat úlohu, která již byla provedena. F.5

F.5 ✧ Vyberte jednu nebo více úloh nacházejících se ve stavu 
„Stopped", „Failed" nebo „Completed" a kliknìte na tlaèítko 
Restart.

➭ Jestliže se nezdaøí provést úlohu zápisu na disk CD-R/DVD-R v 
režimu jedné relace, nespouštìjte tuto úlohu znovu, ani v ní 
nepokraèujte. Uložte ji nebo ji exportujte znovu.
Verze VE31D F.5–11 
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Kontrola pøenosu dat Uložení a výmìna dat
Spuštìní zápisu  
na CD-R 
(platí pouze pro zápis s 
jednou relací) F.5

Úlohy se stavem „Recordable“ jsou položky, které jste pøedem 
vybrali k archivaci na disku CD-R. 

F.5

F.5 ✧ Kliknìte na tlaèítko Record CD or DVD.

Všechny položky, které jste dosud vybrali k archivaci na disku 
CD-R a které mají stav “Recordable“, se nyní zapíší na vložený 
disk CD-R. F.5

Bìhem zápisu dat na disk CD-R je zobrazeno dialogové okno 
Recording CD. 
→ Strana F.2–22, Zápis 

F.5

Odstranìní úloh F.5 Úlohy, které jsou uvedeny v seznamech v oknech stavu úloh, 
mùžete odstranit v pøípadì, že jejich stav není “Receiving“, 
“Recording“, ”Spooling” nebo "Waiting". F.5

F.5 ✧ Vyberte jednu nebo nìkolik úloh a klepnìte na tlaèítko 
Delete.

Tyto úlohy již nebudou provedeny. Budou odstranìny ze 
seznamu úloh a jejich stav se zmìní na „Deleting". 

F.5

➭ Z technických dùvodù zùstávají vìtší úlohy zobrazeny v 
seznamu úloh ve stavu "Deleting" ještì chvíli po vymazání. 
Takovou úlohu nespouštìjte ani neobnovujte.
F.5–12 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Kontrola pøenosu dat
Zmìna priority úloh 
odesílání dat F.5

Úlohy odeslání, které by mìly být zpracovány nejdøíve, jsou v 
dialogovém oknì Network Job Status zaøazeny jako 
“urgentní“. F.5

F.5 ✧ Vyberte jednu úlohu odeslání, kterou chcete provést jako 
první, a klepnìte na tlaèítko Urgent.

Pro každou cílovou adresu lze jako “urgentní” oznaèit pouze 
jednu z úloh odeslání zaøazených ve frontì. Tato úloha se pak 
spustí bezprostøednì po aktivních úlohách. 

F.5

✧ Chcete-li zaøazení „urgentní“ zrušit, vyberte pøíslušnou úlohu 
(úlohy) a opìt kliknìte na tlaèítko Urgent. 

Vymazání seznamu úloh F.5 Ze seznamu úloh mùžete odstranit ty položky, které mají stav 
"completed", "received", nebo "error". F.5

F.5 ✧ Klepnìte na tlaèítko Clear.

Tyto úlohy budou odstranìny ze seznamu úloh. 
F.5

Zavøení okna F.5

F.5 ✧ Klepnìte na tlaèítko Close.

F.5
Verze VE31D F.5–13 
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Kontrola pøenosu dat Uložení a výmìna dat
F.5–14 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

F.6

 
Konfigurace pøenosu dat F.6
V oknì Transfer Configuration mùžete urèit, jak má systém 
provádìt ukládání, export a odesílání úloh. 

F.6

Mùžete zde provádìt nebo mìnit následující nastavení: F.6

❏ automatickou archivaci a odesílání dat vyšetøení,

❏ kompresi dat bìhem archivace, exportu a odesílání,

❏ stav práce požadovaný pro archivaci dat a požadavek na 
optimální využití pamì¤ové kapacity na datovém médiu 
 

✧ Vyvolejte okno syngo - Configuration Panel 
(Options > Configuration... v hlavní nabídce).

➭ V této pøíruèce se v èásti Základy mùžete seznámit s 
postupem pøi otevírání a zavírání konfiguraèních oken, 
ukládání zmìn nebo obnovování pùvodního nastavení 
provedeného dodavatelem. 
→ Kapitola A.4, Konfigurace uživatelského rozhraní 

F.6 ✧ Vyberte konfiguraèní okno Transfer. 

Okno Transfer Configuration je zobrazeno s kartami Auto 
Transfer, Local Devices a Network Nodes. F.6
Verze VE31D F.6–1 
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Konfigurace pøenosu dat Uložení a výmìna dat
Automatický pøenos dat F.6

Na kartì Auto Transfer mùžete urèit, zda a podle jakých 
pravidel mají být údaje o pacientovi a vyšetøení automaticky 
archivovány nebo odesílány prostøednictvím sítì. F.6

➭ V pøípadì, že se provádí nouzová registrace, je automatický 
pøenos dat deaktivován (tento stav je signalizován ve 
stavovém øádku). Po provedení normální registrace dojde k 
opìtovné aktivaci automatického pøenosu dat.

➭ Automaticky spouštìné úlohy pøenosu dat mùžete 
kontrolovat a mìnit v dialogových oknech Job Status zcela 
stejným zpùsobem jako u ruènì spouštìných úloh archivace a 
odesílání. 
→ Strana F.5–3, Prohlížení a øízení úloh pøenosu dat

✧ Kliknìte na záložku karty Auto Transfer, aby se pøesunula do 
popøedí.
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Uložení a výmìna dat Konfigurace pøenosu dat
Pravidla pro automatický pøenos dat F.6

Seznam na záložce karty Auto Transfer vás informuje, jaká 
data, s jakým stavem zpracování a do jakého místa urèení budou 
automaticky pøenesena. F.6

Každý øádek tohoto seznamu obsahuje pravidlo pro 
automatický pøenos dat. Pravidla obsahují následující 
podmínky: F.6

❏ Active 
Znak zatržení v prvním sloupci znamená, že toto pravidlo je v 
dané chvíli aktivní.

❏ Workstate 
Data vybraná pro pøenos, která dosáhla zde specifikovaného 
stavu práce, jsou automaticky archivována nebo odesílána 
do sítì.

➭ Informace o stavu zpracování údajù o pacientovi a vyšetøení 
naleznete v èásti Patient Browser. 
→ Strana C.6–2, Definice stavu práce

❏ Processing Status 
Data, která dosáhla zde uvedeného stavu zpracování, budou 
automaticky archivována nebo poslána po síti.

❏ Objects 
Zde budete moci zjistit, na jaký druh dat se pravidlo vztahuje 
(napø. obrazy, série, ...). 
Verze VE31D F.6–3 
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Konfigurace pøenosu dat Uložení a výmìna dat
❏ Destination 
V tomto sloupci budete moci zjistit, na jakou archivaèní 
jednotku nebo na kterou sí¤ovou adresu jsou data 
automaticky pøenášena.

❏ Marked 
Znak zatržení v tomto sloupci znamená, že se automaticky 
budou pøenášet pouze oznaèená data.

❏ Printed 
Znak zatržení v tomto sloupci znamená, že se automaticky 
budou pøenášet pouze dokumentovaná (vytištìná) data.

➭ Informace o oznaèování údajù o pacientovi a vyšetøení 
naleznete v èásti Patient Browser. 
→ Strana C.6–6, Oznaèení dat z vyšetøení 
F.6–4 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Konfigurace pøenosu dat
Vytváøení, úpravy a odstraòování pravidel F.6

Pod seznamem se nacházejí vstupní pole, ve kterých mùžete 
upravovat stávající pravidla pro automatický pøenos dat nebo 
vytváøet pravidla nová. 

F.6

Vytváøení nových pravidel a 
úpravy pravidel F.6

Mùžete vytvoøit až deset pravidel. F.6

✧ Vyberte ze seznamu pravidlo, které má být upraveno.

Nebo F.6

F.6 ✧ Kliknìte na tlaèítko New pro vytvoøení nového pravidla. 
Verze VE31D F.6–5 
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Konfigurace pøenosu dat Uložení a výmìna dat
Pravidla F.6

F.6 ✧ Pravidlo mùžete aktivovat nebo deaktivovat pomocí prvního 
políèka pro znak zatržení. 

F.6 ✧ Pomocí políèek pro zatržení Marked nebo Printed mùžete 
definovat, že se mají používat pouze oznaèené a/nebo pouze 
vytištìné obrazy/obrazy exponované na film. 

F.6 ✧ V prvním výbìrovém seznamu mùžete urèit podmínky pro 
stav práce. Pøi automatickém pøenosu pak budou brána v 
úvahu pouze ta data, která mají uvedený stav zpracování. 
 
 

F.6 ➭ Ve druhém výbìrovém seznamu mùžete urèit podmínky pro 
stav zpracování pøenosu.  
 
 
 

Speciální položky: F.6

❏ Výbìr položky None v tìchto výbìrových seznamech 
znamená, že trasa automatického pøenosu je platná v 
pøípadì, že je pøíslušný atribut prázdný.

❏ Výbìr položky Don’t care znamená, že stav s pravidlem 
nesouvisí a zmìny nebudou brány v úvahu.

❏ Výbìr položky * znamená, že jakákoli zmìna pøíslušného 
atributu spustí úlohu automatického pøenosu.

➭ Mìjte na pamìti, že stav „completed” mùžete pøiøadit také 
ruènì v Patient Browser a v pøípadì potøeby tak spustit 
automatický pøenos dat. 
→ Strana C.6–2, Definice stavu práce 
F.6–6 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Konfigurace pøenosu dat
F.6 ✧ Ve tøetím výbìrovém seznamu urèíte, zda má být pøíslušný 
stav práce pøiøazen ke každému jednotlivému obrazu, ke 
kompletním sériím nebo pouze k úplným studiím, které 
budou pøenášeny. 
 
 

F.6 ✧ Ve ètvrtém vstupním poli vyberete cílovou adresu.

➭ Vyberete-li napøíklad jako cílovou adresu, na niž mají být 
automaticky pøenášena data pacienta a vyšetøení, položku 
„Ward”, budou data odesílána na oddìlení, kde je pacient 
umístìn a které jste zadali pøi registraci pacienta. To je 
samozøejmì možné pouze tehdy, pokud je název tohoto 
oddìlení nastaven jako adresa v datové síti nemocnice. 
Verze VE31D F.6–7 
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Konfigurace pøenosu dat Uložení a výmìna dat
Nekoneèné smyèky F.6 Ujistìte se, že pøi vytváøení pravidel nevytváøíte jakékoli 
nekoneèné smyèky! F.6

Pøíklad nevhodné konfigurace s nekoneènou smyèkou: F.6

(1) Poèítaè 1 odešle data poèítaèi 2.

(2) Pravidlo v poèítaèi 2: Všechna pøijatá data odesílat poèítaèi 
3.

(3) Pravidlo v poèítaèi 3: Všechna pøijatá data odesílat poèítaèi 
2.

Jakmile poèítaè 2 poprvé pøijme data, budou tato data neustále 
odesílána tam a zpìt ve smyèce mezi poèítaèi 2 a 3. F.6
F.6–8 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Konfigurace pøenosu dat
Odstraòování pravidel F.6 Pravidla pro pøenos dat, která již v budoucnu nebudete 
potøebovat, mùžete namísto deaktivace odstranit. F.6

✧ V seznamu vyberte pravidlo, které chcete odstranit. 

F.6 ✧ Klepnìte na tlaèítko Delete.  
Pravidlo bude ze seznamu odstranìno.
Verze VE31D F.6–9 
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Konfigurace pøenosu dat Uložení a výmìna dat
Archivace a export F.6

Na kartì Local Devices mùžete provést výchozí nastavení pro 
archivaci a export dat na datová média. F.6

Pro jednotlivé jednotky mùžete stanovit, jak má být využita 
pamì¤ová kapacita použitého datového média a zda mají být 
data pøi ukládání na toto médium komprimována. Mùžete také 
definovat pravidla pro stav práce. F.6

✧ Klepnutím pøemístìte kartu Local Devices do popøedí.
F.6–10 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Konfigurace pøenosu dat
Definování režimu zápisu F.6

V režimu jedné relace mùžete uložit data na nové prázdné 
médium pouze jednou. Pøidávat další data není možné. F.6

V režimu vícenásobné relace mùže ukládat data na nová, 
prázdná média nebo na média, na která se již jednou nebo 
nìkolikrát zapisovalo. F.6

F.6 ✧ Kliknutím na pøepínaè Single session zvolíte režim jedné 
relace.

Nebo F.6

✧ Kliknutím na pøepínaè Multi session zvolíte režim 
vícenásobné relace.

Po zmìnì režimu relace musíte restartovat systém, aby se volba 
aktivovala. F.6
Verze VE31D F.6–11 
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Konfigurace pøenosu dat Uložení a výmìna dat
Stanovení využití pamì¤ové kapacity F.6

Požadujete-li pro archivaci nebo export nìkolik datových médií, 
mùžete urèit, zda data jednoho pacienta mohou být rozdìlena 
na dvì datová média èi nikoli (pokud je to technicky možné). F.6

F.6 ✧ Pokud mají být data jednoho pacienta ukládána vždy 
pohromadì na jedno médium, kliknìte na pøepínaè Keep all 
objects.... 
 

Pokud není na médiu zapisovaném v režimu vícenásobné relace 
dostatek místa, zobrazí se okno s hlášením. F.6

✧ Kliknutím na Eject vysunete médium s jeho uzavøením nebo 
bez uzavøení podle toho, zda jste zatrhli políèko Finalize 
before eject.

!0

F.6 F.6

Ukládání všech objektù pøiøazených k jednomu pacientovi na 
jedno médium je platné pouze pro jednu úlohu. F.6
F.6–12 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Konfigurace pøenosu dat
F.6 ✧ Klepnutím na výbìrové tlaèítko Maximize media usage 
povolíte rozdìlení dat jednoho pacienta na dvì nebo nìkolik 
datových médií. Tím se zajistí optimální využití pamì¤ové 
kapacity datového média. 

F.6
Verze VE31D F.6–13 
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Konfigurace pøenosu dat Uložení a výmìna dat
Nastavení komprese dat F.6

Údaje o pacientovi a jeho vyšetøení lze uložit nebo exportovat ve 
zkomprimovaném nebo nezkomprimovaném formátu. F.6

Data, která byla pøed pøenosem zkomprimována, zabírají ménì 
pamì¤ového prostoru a jejich pøenos je rychlejší.  

F.6

✧ Vyberte jednotku, pro kterou chcete definovat kompresi dat.

✧ V poli Compression type vyberte, zda a jak mají být data 
komprimována.

Možná jsou následující nastavení: F.6

❏ None 
Obrazy nejsou komprimovány.

❏ Lossless JPEG 
Obrazy nejsou komprimovány pøíliš (kompresní faktor 2 až 
3), ale jsou komprimovány bez ztrát informací a mohou být 
importovány v pùvodní kvalitì (faktor kvality 100 %). 

❏ Lossy JPEG 
Komprese obrazù je znaèná, ale za cenu ztráty obrazových 
informací. Kvalita snímkù se tak zhorší (faktor kvality < 100 
%).

➭ Obrazy, které byly uloženy v databázi v komprimovaném 
formátu se ztrátou kvality, je možno uložit pouze se stejným 
faktorem kvality. 
F.6–14 Návod k použití pro uživatele systému syngo

 0.0



Uložení a výmìna dat Konfigurace pøenosu dat
F.6 Quality Factor udává stupeò komprese snímku. F.6

Hodnota 100 % znamená, že kvalita snímku nebyla snížena. 
Hodnoty nižší než 100 % znamenají, že snímek bude mít trvale 
sníženou kvalitu. F.6

Faktor kvality mùžete nastavovat pouze pøi nastavení Lossy 
JPEG. To, jaký faktor kvality je pro vás ještì pøijatelný, závisí na 
vašich požadavcích. F.6

✧ Pokud jste vybrali metodu komprese Lossy JPEG, mìli byste 
v poli Quality Factor (1-100 %) zadat zbývající kvalitu snímku 
v procentech jako výsledek porovnání s originálním 
materiálem.

F.6

➭ Informace o kompresi JPEG je uvedena v segmentu snímku 
(není tomu tak, pokud je vybrána volba No Text).

F.6

UPOZORNÌNÍ

Pro pøenos dat je zvolena ztrátová komprese.  F.6

Kvalita obrazù pøi ztrátové kompresi nemusí být již 
vhodná pro diagnostické úèely. F.6

✧ Nepoužívejte ztrátovou kompresi JPEG pro odesílání dat k 
vytvoøení zprávy nebo do primární diagnostické stanice. 
Nepoužívejte ztrátovou kompresy JPEG pro archivaci. 
Poznámka: Použití ztrátové komprese bude indikováno v 
textu k obrazu kromì pøípadu, kdy je zapnuta volba „No 
Text".
Verze VE31D F.6–15 
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Konfigurace pøenosu dat Uložení a výmìna dat
Standardní nastavení 
komprese pøi výmìnì dat F.6

Data uložená na datových médiích mùžete vymìòovat s jinými 
systémy. Pøi archivaci je nutno dodržovat normy týkající se 
výbìru pamì¤ových médií a komprese a závisející na modalitì a 
typu dat (profily aplikací DICOM). 

F.6

F.6

Modalita/typ dat F.6 Compression 
(Komprese)

Pamì¤ové 
médium
(výchozí)

Všeobecnì Bez komprese CD-R/DVD-R

Angiografické snímky Bezztrátový 
formát JPEG

a 
nekomprimovan

á data

CD-R/DVD-R

Angiografické snímky 
(1024 x 1024 x 12 bitù)

Lossless JPEG CD-R/DVD-R

Sekundární 
angiografické snímky

Bez komprese CD-R/DVD-R

Snímky z CT a MR a 
sekundární snímky

Bezztrátový 
formát JPEG

a 
nekomprimovan

á data

MOD 
a CD-R/DVD-R

Èasové prùbìhy vlny 
(napø. EKG a tlakové 
køivky)

Bez komprese CD-R/DVD-R

Ultrazvukové snímky a 
ultrazvukové snímky s 
vícenásobným rámcem

Bez komprese MOD 
a CD-R/DVD-R
F.6–16 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Konfigurace pøenosu dat
Urèení nezbytného stavu práce F.6

Zde mùžete vybrat, jakého stavu práce musí údaje o pacientovi 
a jeho vyšetøení pøed archivací dosáhnout. Pokud tohoto stavu 
práce není dosaženo, zobrazí se pøed uložením varování. F.6

F.6 ✧ Pomocí výbìrových tlaèítek urèete požadovaný stav práce 
jako podmínku pro archivaci.

➭ Možnosti Verified a Read se týkají pouze úrovní Examination 
a Series.

➭ Pokud vyberete výbìrové tlaèítko Unspecific, je archivace 
možná pøi jakémkoli stavu práce a bez potvrzování.

✧ Chcete-li se ujistit, že obrazy byly pøed povolením archivace 
exponovány na film nebo vytisknuty, kliknìte také na 
zaškrtávací políèko Printed.
Verze VE31D F.6–17 
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Konfigurace pøenosu dat Uložení a výmìna dat
Nastavení sí¤ových uzlù F.6

Na kartì Network Nodes mùžete provést výchozí nastavení pro 
odesílání dat do sítì. Pro sí¤ovou adresu mùžete specifikovat 
stupeò komprese, faktor kvality, pravidla pro opakování pokusù 
o odeslání a stav práce. F.6

✧ Klepnutím pøeneste kartu Network Nodes do popøedí.
F.6–18 Návod k použití pro uživatele systému syngo
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Uložení a výmìna dat Konfigurace pøenosu dat
Nastavení komprese dat F.6

Pøi odesílání údajù o pacientovi a vyšetøení prostøednictvím sítì 
mùžete aktivovat kompresi dat stejnì jako pøi archivaci nebo 
exportu dat na externí datová média (v závislosti na konfiguraci 
systému). F.6

✧ Vyberte sí¤ovou adresu, na kterou chcete odesílat data v 
komprimovaném formátu nebo pro kterou chcete kompresi 
dat zrušit.

✧ Vyberte, zda a jak mají být data komprimována. 
→ Strana F.6–14, Nastavení komprese dat

Mùžete volit mezi následujícími možnostmi: F.6

❏ No (bez komprese)
❏ Lossless JPEG
❏ Lossy JPEG

✧ Stanovte také faktor kvality. 
→ Strana F.6–14, Nastavení komprese dat

F.6

➭ Informace o kompresi JPEG je uvedena v segmentu snímku 
(není tomu tak, pokud je vybrána volba No Text ).
Verze VE31D F.6–19 
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Konfigurace pøenosu dat Uložení a výmìna dat
Nastavení opakování pokusù F.6

Vyskytnou-li se bìhem pøenosu dat do sí¤ového uzlu chyby, lze 
je èasto odstranit zopakováním pokusu o pøenos. Mùžete urèit, 
kolikrát a v jakém intervalu se pokusy mají opakovat. F.6

F.6 ✧ Zadejte, kolikrát se pokus má opakovat, nebo klepnìte na 
šipky (možné hodnoty: 0 až 5; výchozí nastavení: 0)

✧ Zadejte èasový interval mezi pokusy nebo klepnìte na šipky  
(možné hodnoty: 5 až 60 min; výchozí nastavení: 10 min.)

➭ Poèet nových pokusù se zobrazí v oknì Network Job Status. 
→ Strana F.5–6, Informace v dialogových oknech Job Status 

Urèení nezbytného stavu práce F.6

Zde mùžete vybrat, jakého stavu práce musí údaje o pacientovi 
a jeho vyšetøení v pøípadì archivace dosáhnout. Pokud tohoto 
stavu práce není dosaženo, zobrazí se pøed uložením varování. 

F.6

F.6 ✧ Stav práce požadovaný pøi odesílání lze urèit pomocí 
výbìrových tlaèítek.

➭ Pokut vyberete výbìrové tlaèítko Unspecific, je archivace 
možná pøi jakémkoli stavu práce a bez potvrzení.

✧ Pokud mají být snímky pøed odesláním alespoò jednou 
nafilmovány nebo vytisknuty, vyberte také zaškrtávací 
políèko Printed.

F.6
F.6–20 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

G.1

 
Úvod G.1
Snímky z vyšetøení mùžete exponovat na film nebo vytisknout 
na papír pro použití v dokumentaci a zprávách. G.1

V závislosti na harmonogramu vyšetøení a aktuální situaci 
vyšetøení mùžete snímkový materiál exponovat na film nebo jej 
automaticky vytisknout. Snímky jsou pak odesílány bìhem 
vyšetøení do pøednastavené kamery nebo tiskárny. G.1

Jinak mùžete filmování spustit ruènì a zvolit, které snímky 
chcete vytisknout nebo exponovat na film. G.1

G.1

Zabezpeèení – oprávnìní G.1 Funkce Expose umožòuje na tiskárnì vytisknout nebo v kameøe 
exponovat úlohy zpracování filmu nebo jednotlivé listy filmu. G.1

G.1

UPOZORNÌNÍ

Kvalita obrazù na výtiscích by se mohla snížit, takže výtisky 
nemusí být dostatateèné pro stanovení diagnózy. G.1

Možná chybná diagnóza G.1

✧ Pro diagnostické úèely používejte pouze obrazy na filmu. 
Výtisky mùžete používat pro diagnostické úèely, pokud je 
tiskárna hodnocena a uvolnìna pro tento úèel výrobcem. 
Pro stanovení diagnózy však mùžete používat obrazy na 
filmu.
Verze VE31D G.1–1 
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Úvod Exponování na film
Postup pøi exponování na film G.1

Obrazový materiál lze exponovat na film nebo vytisknout ve 
dvou krocích: 

G.1

❏ Nejdøíve na kartách úloh  nebo v prohlížeèi Patient Browser 
zadejte, které snímky nebo série chcete vytisknout nebo 
exponovat na film. Potom pøeneste tuto volbu na kartu úlohy 
Filming (virtuální list filmu).

❏ Z virtuálního listu filmu zašlete zvolené snímky pøímo do 
kamery nebo tiskárny nebo nejdøíve proveïte zpracování. 
Vybrané snímky lze zobrazit pomocí dialogového okna Film 
Preview nebo karty úlohy Filming (virtuální list filmu); 
snímky lze do urèité míry následnì zpracovat, výbìr lze 
upøesnit, urèit rozvržení listu filmu a znovu vybrat kameru 
nebo tiskárnu.
G.1–2 Návod k použití pro uživatele systému syngo
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Exponování na film Úvod
Plnì automatické 
exponování na film G.1

V závislosti na harmonogramu vyšetøení mùže být užiteèné 
vytvoøit snímkový materiál pro zprávy, který bude k dispozici na 
filmu nebo na papíru, a to co nejrychleji a bez nutnosti ruèního 
zásahu. G.1

Aktivací položek Auto Filming a Auto Expose budou oba kroky 
filmování probíhat úplnì automaticky. G.1

Všechny generované snímky se bìhem vyšetøení automaticky 
pøenesou na virtuální list filmu, odkud jsou ihned dále pøedány 
na pøedem nastavenou kameru nebo tiskárnu. G.1

 

Vyšetøení Exponování na film 
(virtuální filmový list)

Kamera nebo 
tiskárna

Automatické
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Úvod Exponování na film
Poloautomatické 
exponování na film G.1

V nìkterých situacích je výhodné automatické a ruèní 
exponování na film kombinovat. 
 

G.1

Jestliže napøíklad chcete snímky pøed filmováním èi tiskem 
nejprve zkontrolovat na kartì úlohy Filming a podle potøeby je 
zpracovat, aktivujte funkci Auto Filming a deaktivujte funkci 
Auto Expose. G.1

 

Vyšetøení Exponování na film 
(virtuální filmový list)

Kamera nebo 
tiskárna

Automatické K systému
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Exponování na film Úvod
Ruèní filmování G.1 Pøenos snímkù na virtuální list filmu a do kamery nebo tiskárny 
mùžete zahájit ruènì. Tímto zpùsobem si mùžete práci 
optimalizovat tím, že budete filmovat nebo tisknout pouze ty 
snímky, které skuteènì pro stanovení diagnózy. G.1

 

Prohlížení

Patient Browser

Exponování na film 
(virtuální filmový list)

Kamera nebo 
tiskárna

Vyšetøení

3D

Ruèní Ruèní
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Úvod Exponování na film
Terminologie G.1

V následujících kapitolách se setkáte s nìkolika termíny, které se 
týkají exponování na film a se kterými byste se mìli dostateènì 
seznámit. 

G.1

Úloha zpracování filmu G.1 Vybrané obrazy, série a studie, které jste odeslali pro 
exponování na film, systém spravuje a vykonává jako úlohy 
zpracování filmu. 

G.1

Úloha zpracování více filmùG.1 Obvykle jsou snímky rùzných pacientù zpracovávány v rùzných 
úlohách zpracování filmu. Mùžete však povolit seskupení 
snímkù rùzných pacientù, a tím vytvoøit vícenásobnou úlohu 
zpracování filmu. Snímky lze pak napøíklad zpracovat 
následujícím zpùsobem: G.1

 

A1 A2 A3

A4 A5 A6

A7 A8 A9

A10 A11 A12

A13 B1 B2

B3 B4 B5

B6 B7 B8

B9 B10 B11

B12

List filmu 1 List filmu 2 List filmu 3

Vícenásobná úloha 
zpracování filmu

Pacient 1 Pacient 2
G.1–6 Návod k použití pro uživatele systému syngo
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Exponování na film Úvod
Stav úlohy zpracování filmuG.1 V dialogovém oknì Film Task Status mùžete získat informace o 
úloze zpracování filmu ve frontì kamery nebo tiskárny; do 
prùbìhu úlohy lze i zasáhnout. 

G.1

Virtuální list filmu G.1 Všechny obrazy v úlohách zpracování filmu nemusí být nutnì 
vytištìny nebo exponovány na film ihned, ale jsou nejdøíve 
uchovány na virtuálním listu filmu (karta úloh Filming nebo 
dialogové okno Film Preview). 
Na virtuálním listu filmu mùžete vidìt, jak budou obrazy pozdìji 
uspoøádány na exponovaném filmu nebo na výtisku. 

G.1
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Úvod Exponování na film
Rozvržení a nastavení G.1

Všechna nastavení pro exponování na film, jako je rozvržení 
listu filmu nebo zvolená kamera èi tiskárna, jsou definována v 
takzvaném rozvržení filmu. 
 

G.1

Standardní rozvržení G.1 Jestliže neprovedete žádné zmìny výchozího nastavení pro 
exponování na film, budete vždy používat takzvané standardní 
výchozí rozvržení definované servisem spoleènosti Siemens 
bìhem instalace systému. 

G.1

Zmìna nastavení 
exponování na film pro 
aktuální filmovou úlohu G.1

Nejste-li s výchozím nastavením pro filmování (standardním 
rozvržením) spokojeni, zmìòte jednotlivá nastavení pro 
filmování na kartì úlohy Filming. Aktuální úloha zpracování 
filmu se poté provede podle nového nastavení. Pro další úlohu 
zpracování filmu systém znovu použije výchozí hodnoty. 

G.1

Specifická rozvržení pro 
studie G.1

V oknì Filming Study Layout mùžete pro jednotlivé studie a 
série definovat zvláštní nastavení filmování. Kdykoli budete 
chtít obrazy urèité studie nebo série stejného typu exponovat 
nebo vytisknout, systém automaticky použije rozvržení 
specifické pro danou studii. 

G.1
G.1–8 Návod k použití pro uživatele systému syngo
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Exponování na film Úvod
Režimy tisku G.1 K dispozici jsou rùzné režimy tisku. Skuteènì používaný režim je 
nastaven bìhem instalace modality na místì instalace. G.1

Stránkový režim: Výchozím režimem tisku je bìžný stránkový 
režim. V tomto režimu funkce Filming sestaví celý filmový list a 
odešle pøesnou tisknutelnou matrici do kamery. G.1

Obrazový režim: Zpùsob odeslání dat do kamer, kde kamera 
sestaví celý filmový list na základì rozvržení a odeslaných 
obrazù. G.1

Stránkový režim se zmìnou mìøítka: Jedná se o nastavitelnou 
možnost tisku. Funkce Filming sestaví celý filmový list, ale 
odešle zmenšenou matrici do kamery. Stránkový režim se 
zmìnou mìøítka poskytuje obrazy ve snížené kvalitì. G.1

➭ Obrazový režim a stránkový režim se zmìnou mìøítka 
nepodporují pùvodní velikost. Místo toho bude automaticky 
použita funkce pøizpùsobit segmentu.

G.1

G.1

UPOZORNÌNÍ

Použití stránkového režimu se zmìnou mìøítka mùže snížit 
kvalitu obrazù. Výsledná kvalita obrazù by již nemusela být 
dostaèující. Režim tisku, ve kterém je možná zmìna mìøítka, 
nepodporuje skuteènou velikost. G.1

Možná chybná diagnóza G.1

✧ Pøi konfiguraci režimu tisku, kde je možná zmìna mìøítka, si 
pamatujte, že dojde ke snížení kvality snímku.
Verze VE31D G.1–9 
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Úvod Exponování na film
G.1–10 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

G.2

Automatické/manuální 
exponování na film G.2
Jak již bylo vysvìtleno v úvodu, filmování a tisk snímkù z 
vyšetøení se provádí ve dvou krocích: G.2

❏ Pøenos snímkù na virtuální list filmu.

❏ Odeslání obrazù z virtuálního listu filmu do kamery nebo 
tiskárny, kde budou exponovány na film nebo vytištìny na 
papír. 

Provedení obou krokù lze spustit automaticky. To se 
doporuèuje, pokud je tøeba pracovat s velkými objemy dat (z 
dùvodu velkého poètu pacientù), a proto je nutno mít k 
dispozici co nejrychleji velké množství snímkù pro pøípravu 
zpráv. G.2

Filmování lze také provádìt èásteènì nebo zcela ruènì. Tímto 
zpùsobem mùžete zajistit, aby byly vytištìny nebo exponovány 
na film pouze ty snímky, které skuteènì potøebujete pro 
diagnózu nebo dokumentaci. G.2

!0

G.2 G.2

Pøi èásteèném nebo zcela ruèním filmování si uvìdomte 
následující skuteènost: G.2

Na virtuálním listu filmu lze soubìžnì spravovat maximálnì tøi 
úlohy zpracování filmu. Pokud tento poèet pøekroèíte, objeví 
se hlášení. 
→ Strana G.2–15, Virtuální list filmu je plný G.2
Verze VE31D G.2–1 
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Automatické/manuální exponování na film Exponování na film
Pøenos snímkù na virtuální list 
filmu G.2

Nejdøíve na kartách úlohy Viewing a 3D nebo v oknì Patient 
Browser vyberte obrazy, které chcete pøenést na virtuální list 
filmu. 
 

G.2

Karta úlohy Examination G.2

Z karty úlohy Examination mùžete odeslat snímky na virtuální 
list filmu jednotlivì a ruènì. Pøípadnì lze zvolit možnost Auto 
Filming a zahájit automatické exponování na film všech snímkù 
soubìžnì s vyšetøením. G.2

 

Vyšetøení

Kopie na list filmu

Automatické exponování na film

Exponování na film 
(virtuální filmový list)

Kamera nebo 
tiskárna
G.2–2 Návod k použití pro uživatele systému syngo

 0.0



Exponování na film Automatické/manuální exponování na film
Aktivace automatického 
exponování na film G.2

Obvykle doporuèujeme aktivovat funkci Auto Filming. Ušetøíte 
tak èas, protože nebudete muset snímky volit a pøenášet 
jednotlivì. G.2

G.2 ✧ Klepnìte na tlaèítko Auto Filming. Barva na pozadí tlaèítka 
se zmìní.

Pokud bìhem vyšetøení vytvoøíte nové obrazy, pøenesou se 
automaticky na virtuální list filmu. 
 
 

G.2

Pøerušení automatického 
filmování G.2

Nechcete-li již, aby se nasnímané a rekonstruované snímky 
zkopírovaly na virtuální list filmu automaticky, mùžete funkci 
Auto Filming pøerušit. G.2

G.2 ✧ Klepnìte znovu na tlaèítko Auto Filming na kartì úlohy 
Examination.

Skenované snímky se po rekonstrukci již na virtuální list filmu 
nepøenesou. G.2

Vypnuto Zapnuto

VypnutoZapnuto
Verze VE31D G.2–3 
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Automatické/manuální exponování na film Exponování na film
Ruèní filmování G.2 Pokud chcete na filmy nebo na papír exponovat pouze 
jednotlivé snímky, mùžete je pøenést na virtuální list filmu 
ruènì. G.2

✧ V segmentu zobrazení snímku na kartì úlohy Examination 
zvolte jeden snímek po druhém.

✧ Pro každý vyvolejte okno Patient > Copy to Film Sheet.

Nebo G.2

G.2 ✧ Kliknìte na tlaèítko Copy to Film Sheet. 

Nebo G.2

G.2 ✧ Stisknìte klávesu Copy to Film Sheet na klávesnici symbolù 
(Num Enter).

Snímky se pøenesou na virtuální list filmu. G.2
G.2–4 Návod k použití pro uživatele systému syngo
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Exponování na film Automatické/manuální exponování na film
Karty úloh Viewing a 3D a prohlížeè Patient 
Browser G.2

Z prohlížeèe Patient Browser nebo z karet úloh 3D a Viewing
lze vytváøet filmy nebo tisknout snímky uložené v místní 
databázi. Tímto zpùsobem mùžete také odesílat obrazy pro 
exponování na film, které jste vyhodnotili na kartì Viewing
nebo generovali na kartì 3D. 

G.2

 

Exponování na film 
(virtuální filmový list)

3D

Prohlížení

Patient Browser
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Automatické/manuální exponování na film Exponování na film
Z karet Viewing a 3D nebo z okna Patient Browser se snímky 
nebo série pøenáší na virtuální list filmu vždy ruènì. G.2

✧ Nejdøíve zvolte snímky, které chcete filmovat nebo tisknout v 
prohlížeèi Patient Browser, na kartì úlohy Viewing nebo 
3D.

✧ Použijte funkci Patient > Copy to Film Sheet.

Nebo G.2

G.2 ✧ Kliknìte na tlaèítko Copy to Film Sheet. 
 

Nebo G.2

G.2 ✧ Stisknìte klávesu Copy to Film Sheet na klávesnici se 
symboly. 

Všechny vybrané obrazy se pøenesou na virtuální list filmu na 
kartì úlohy Filming. 
 
 
 

G.2
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Exponování na film Automatické/manuální exponování na film
Pomocí funkce myši 
“pøetažení” G.2

Snímky mùžete z prohlížeèe Patient Browser pøenášet také 
pøímo na kartu úlohy Filming pomocí funkce myši pøetažení. G.2

✧ Zvolte jeden nebo více snímkù.

✧ Pøetáhnìte obrázky na kartu úloh Filming pøi stlaèeném 
levém tlaèítku myši.

Vytvoøí se nová úloha zpracování filmu nebo nová úloha 
zpracování filmu typu “multiple” a snímky se zobrazí na 
virtuálním listu filmu. G.2

➭ Jestliže karta úlohy není v popøedí, mùžete snímky pøetáhnout 
též z prohlížeèe Browser na odpovídající záložku. Karta úlohy 
se pøesune do popøedí a obrazy se naètou do obrazové oblasti. 

Poklepáním na tlaèítko G.2 Snímky mùžete z prohlížeèe Patient Browser pøenášet také 
pøímo na kartu úlohy Filming poklepáním na tlaèítko myši. G.2

✧ V prohlížeèi Patient Browser zvolte studii, sérii nebo 
pacienta a potom na požadovanou položku poklepejte.

Vytvoøí se nová úloha zpracování filmu a snímky se zobrazí na 
virtuálním listu filmu. G.2

G.2
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Automatické/manuální exponování na film Exponování na film
Pøenos obrazù z virtuálního listu 
filmu do kamery nebo tiskárny G.2

Obecnì lze øíci, že kdykoli chcete pøenášet snímky, série nebo 
celé studie na virtuální list filmu automaticky nebo ruènì, 
vytvoøí se úloha zpracování filmu. Z virtuálního listu filmu je 
možné pøenášet jednotlivé úlohy zpracování filmu do kamery 
nebo tiskárny automaticky nebo ruènì. G.2

 

Vyšetøení

3D Prohlížení
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Exponování na film 
(virtuální filmový list)
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Exponování na film Automatické/manuální exponování na film
Automatická expozice G.2

Po úplném dokonèení pøenosu úlohy zpracování filmu na 
virtuální list filmu lze danou úlohu okamžitì a automaticky 
pøenést do kamery nebo tiskárny. G.2

Toto nastavení mùžete definovat kdykoliv na kartách úloh nebo 
v oknì Film Preview. Nastavení se poté použije na otevøené 
úlohy zpracování filmu a na všechny následující úlohy 
zpracování filmu. 
→ Strana G.3–2, Náhled exponování na film 

G.2

Aktivace automatické 
expozice G.2

✧ Zvolte položku Options > Auto Expose.

Nebo G.2

G.2 ✧ Aktivujte volbu pomocí tlaèítka Auto Expose na kartì úlohy 
Filming nebo v oknì Film Preview. 

Listy filmu otevøených úloh zpracování filmu a všechny 
následující vyplnìné úlohy zpracování filmu budou automaticky 
zaslány na kameru nebo tiskárnu a exponovány nebo 
vytištìny. G.2

➭ Je-li poslední list filmu vyplnìn jen èásteènì, bude pro 
filmování zaslán pouze v pøípadì, že byl nový pacient 
zaregistrován nebo že byla nová úloha zpracování filmu 
pøenesena na virtuální list filmu.
Verze VE31D G.2–9 
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Automatické/manuální exponování na film Exponování na film
Deaktivace automatické 
expozice G.2

Pokud byla funkce Auto Expose aktivována na kartì úlohy nebo 
v náhledu filmu, mùžete ji kdykoliv deaktivovat. G.2

✧ Zrušte volbu Options > Auto Expose.

Nebo G.2

G.2 ✧ Klepnìte znovu na tlaèítko na kartì úlohy Filming nebo v 
náhledu filmu.
G.2–10 Návod k použití pro uživatele systému syngo
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Exponování na film Automatické/manuální exponování na film
Pøerušení 
automatická expozice G.2

Pokud bìhem automatického filmování nastanou chyby nebo 
pokud zaznamenáte, že byly nafilmovány nebo vytištìny vadné 
snímky, automatické filmování mùžete kdykoliv pøerušit. G.2

✧ Zrušte volbu Options > Auto Expose.

Nebo G.2

G.2 ✧ Klepnìte znovu na tlaèítko na kartì úlohy Filming nebo v 
náhledu filmu Film Preview.

Film, který se právì zpracovává, bude dokonèen. Všechny 
ostatní listy filmu se poté zachovají na virtuálním listu filmu. G.2

✧ Odstraòte chybu nebo vymažte vadné snímky z virtuálního 
listu filmu.

✧ Funkci Auto Expose znovu aktivujte nebo pøeneste zbývající 
listy do kamery nebo tiskárny ruènì.
Verze VE31D G.2–11 
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Automatické/manuální exponování na film Exponování na film
Ruèní pøenos snímkù G.2

Pokud si sami chcete urèit moment, ve kterém jsou úlohy 
filmovány nebo tištìny, nebo pokud chcete snímky ještì jednou 
pøed filmováním prohlédnout, deaktivujte volbu Auto 
Expose. G.2

Všechny úlohy zpracování filmu pøenesené z karet úloh nebo z 
prohlížeèe Patient Browser se nejdøíve shromáždí na virtuálním 
listu filmu na kartì úlohy Filming. G.2

➭ Je-li aktivována položka Security, mùžete úlohy zpracování 
filmu exponovat pouze v pøípadì, že jste k tomu oprávnìni. 

Exponování aktuálního 
pacienta G.2

✧ Zvolte položku Film > Expose Film Task a pøeneste všechny 
snímky této úlohy zpracování filmu do kamery nebo tiskárny.

Nebo G.2

G.2 ✧ Klepnìte na tlaèítko Expose Film Task v ovládací oblasti 
karty úlohy nebo v prohlížeèi Patient Browser.

Všechny snímky dané úlohy zpracování filmu se pøenesou do 
kamery. G.2

G.2
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Exponování na film Automatické/manuální exponování na film
Volba úlohy zpracování 
filmu G.2

Jestliže je nahoøe jiná karta úloh než Filming a na kartu úloh 
Filming je naèteno více pacientù, mùžete vybrat úlohu, kterou 
chcete exponovat, ze seznamu zobrazeném v dialogu Select 
Film Job. G.2

✧ Zvolte položku Film > Expose Film Task nebo použijte 
klávesovou zkratku Ctrl + P.

Otevøe se dialogové okno Select Film Job, kde mùžete vybrat 
úlohu, kterou chcete pøenést do pøedem zvolené kamery nebo 
tiskárny. G.2

G.2 ✧ Zvolte úlohu a kliknìte na tlaèítko Expose. 
 

Nebo G.2

G.2 ✧ Kliknìte na tlaèítko Cancel a aktivujte kartu úlohy Filming 
nebo zvolte položku Film Preview.

✧ Zvolte úlohu zpracování filmu. 
→ Strana G.3–15, Výbìr listù filmu a snímkù 
Verze VE31D G.2–13 
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Automatické/manuální exponování na film Exponování na film
Exponování/tisk filmového 
listu G.2

✧ Aktivujte kartu úloh Filming nebo zvolte položku Film 
Preview (Patient > Film Preview...).

✧ Zvolte jeden list filmu. 
→ Strana G.3–15, Výbìr listù filmu a snímkù 
→ Strana G.3–3, Okno Film Preview

✧ Zvolte položku Film > Expose Film Sheet.

Zpracuje se pouze zvolený list filmu. 
 

G.2

Incorrect film size 
(Nesprávná velikost filmu) G.2

Pokud je nastavena velikost filmu, kterou kamera nepodporuje, 
a èeká na expozici, zobrazí se dialogové okno Incorrect Film 
Size. G.2

➭ Ádné odpovídající chybové hlášení se nezobrazí, pokud je 
použita tiskárna.

 

✧ Chcete-li ve filmování pokraèovat, vyberte jinou velikost 
filmu a volbu potvrïte tlaèítkem OK.
G.2–14 Návod k použití pro uživatele systému syngo
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Exponování na film Automatické/manuální exponování na film
Virtuální list filmu je plný G.2

Na virtuálním listu filmu lze souèasnì provést maximálnì tøi 
úlohy zpracování filmu. Pøi pøenosu ètvrté úlohy zpracování 
filmu se zobrazí hlášení. Aby nová úloha zpracování filmu mohla 
být pøijata, nejdøíve exponujte nebo vytisknìte jednu úlohu 
zpracování filmu ve frontì nebo ji zrušte. G.2

➭ K této situaci obvykle dojde pouze v pøípadì, že se pro dané 
úlohy zpracování filmu deaktivuje možnost Auto Expose. 
Úlohy zpracování filmu zùstanou na virtuálním listu filmu 
uchovány, dokud je k filmování neodešlete ruènì, a tudíž 
nedokonèíte.

Pøi pøenosu ètvrté úlohy zpracování filmu systém nejdøíve 
zkontroluje, zda ji lze kombinovat s nìkterou z ostatních úloh, a 
vytvoøit tak úlohu zpracování filmu obsahující snímky více než 
jednoho pacienta.  
→ Strana G.1–6, Úloha zpracování více filmù G.2

V opaèném pøípadì se zobrazí dialogové okno No More Film 
Jobs Available. Potom situaci vyøešte pøíslušným zpùsobem. G.2
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Automatické/manuální exponování na film Exponování na film
Žádné další úlohy 
zpracování filmu nejsou k 
dispozici G.2

V dialogovém oknì No More Film Jobs Available urèete, jaké 
úlohy zpracování filmu mají být exponovány, slouèeny nebo 
vymazány, aby se vytvoøilo místo pro nové úlohy. G.2

 

✧ Vyberte jednu z filmových úloh na seznamu. 

G.2 ✧ Klepnutím na tlaèítko Expose pøenesete zvolenou úlohu do 
pøedem zvolené kamery nebo tiskárny.

Zvolená úloha se nafilmuje a na její místo se na virtuálním listu 
filmu umístí nová úloha. G.2
G.2–16 Návod k použití pro uživatele systému syngo
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Exponování na film Automatické/manuální exponování na film
Nebo 
G.2

G.2 ✧ Kliknutím na tlaèítko Delete se zvolená úloha odstraní a na 
její místo se umístí nová úloha zpracování filmu. 

Nebo G.2

G.2 ✧ Klepnutím na tlaèítko Merge pøipojíte snímky nové úlohy 
zpracování filmu na konec dané pøedchozí úlohy.

Daná úloha zpracování filmu zùstane na virtuálním listu filmu 
jako úloha typu multiple, dokud ji nepøenesete do kamery nebo 
tiskárny. 
→ Strana G.1–6, Úloha zpracování více filmù 

G.2

Nebo G.2

G.2 ✧ Klepnutím na tlaèítko Cancel operaci zrušte.

✧ Nyní aktivujte kartu úlohy Filming nebo otevøete okno Film 
Preview a pøed naètením nové úlohy exponujte nebo 
vymažte úlohy zpracování filmu.
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Automatické/manuální exponování na film Exponování na film
G.2–18 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

G.3

Prohlížení a zpracování 
listù filmu a obrázkù G.3
Bìhem ruèního exponování na film, pokud jste deaktivovali 
volbu Auto Expose, mùžete listy filmu prohlížet a zpracovávat 
znovu pøed jejich tiskem nebo expozicí na film. 
→ Strana G.2–9, Automatická expozice 
 

G.3

Náhled exponování na filmG.3 Pokud chcete získat rychlý pøehled o úlohách zpracování filmu 
ve frontì, které ještì nebyly odeslány do kamery nebo tiskárny, 
použijte okno Film Preview. 
 

G.3

Karta úlohy Filming G.3 Pokud chcete s jednotlivými listy filmu ve frontì pracovat 
efektivnìji a pøehlednìji nebo pokud chcete snímky pøed 
filmováním znovu zpracovat, aktivujte kartu úlohy Filming. G.3
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Náhled exponování na film G.3

V oknì Film Preview mùžete získat informace o zpùsobu, jakým 
budou snímky aktuální úlohy zpracování filmu na listech filmu 
uspoøádány. Zde lze také spouštìt nìkteré dùležité funkce 
filmování bez nutnosti opìtovného zobrazení karty úlohy 
Filming. G.3

G.3

Vyvolání náhledu 
exponování na film G.3

✧ Spuštìním pøíkazu Patient > Film Preview... otevøete okno 
Film Preview.

Nebo G.3

G.3 ✧ Kliknìte na tlaèítko Film Preview na kartì úlohy Viewing 
nebo v Patient Browser. 
 
 

Uzavøení náhledu filmu G.3

G.3 ✧ Klepnutím na tlaèítko Close znovu zavøete okno Film 
Preview.

G.3
G.3–2 Návod k použití pro uživatele systému syngo
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Okno Film Preview G.3

Po zvolení položky Film Preview se v popøedí aplikace, se kterou 
právì pracujete, zobrazí okno Film Preview. G.3

(1) Maximalizovat na kartu úloh Filming
(2) Úlohy zpracování filmu
(3) Zobrazení listù filmu
(4) Èíselník pro výbìr poètu kopií
(5) Tlaèítko pro vymazání
(6) Tlaèítka pro manipulaci s filmem
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Úlohy zpracování filmu G.3 Zde se zobrazí všechny úlohy zpracování filmu, které jsou na 
virtuálním listu filmu pøipraveny pro odeslání do kamery nebo 
tiskárny. Chcete-li zpracovat jednu úlohu zpracování filmu nebo 
zkontrolovat uspoøádání snímkù, nejprve otevøete 
požadovanou úlohu zpracování filmu. G.3

G.3 ✧ Úlohu zpracování filmu otevøete kliknutím. 
 
 
 

Listy filmu G.3 V oblasti zobrazení listù filmu je první list filmu nebo otevøená 
úloha zpracování filmu. G.3

Pomocí záložek v pravém horním rohu lze procházet všemi listy 
filmu úlohy zpracování filmu. List filmu je rozdìlen na segmenty 
zobrazující série a èísla obrazù, které mají být exponovány nebo 
vytištìny. 
 

G.3

G.3 ✧ Kliknìte na horní èást záložky, budete-li se chtít posunout o 
jeden filmový list dopøedu. 
 
 

Nebo G.3

G.3 ✧ Kliknìte na dolní èást záložky, budete-li se chtít posunout 
jeden filmový list dozadu. 
 
 
 
 

Dopøedu

Dozadu
G.3–4 Návod k použití pro uživatele systému syngo
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Ovládací oblast G.3 V ovládací oblasti mùžete spustit nìkolik dùležitých funkcí 
exponování na film. 

G.3

G.3 ✧ Kliknutím na toto tlaèítko otevøete dialogové okno Film Task 
Status nebo zvolte položku Patient > Film Task Status....

Zde se zobrazí fronta s úlohami zpracování filmu, které èekají na 
odeslání do kamery nebo tiskárny. 
→ Strana G.5–1, Kontrola úloh zpracování filmu 
 

G.3

G.3 ✧ Kliknutím na tlaèítko Auto Expose nebo zvolením položky 
Options > Auto Expose tuto možnost zvolte nebo ji zrušte. 
→ Strana G.2–9, Automatická expozice 
 

G.3 ✧ Kliknutím na tlaèítko Expose nebo zvolením položky Film > 
Expose Film Task odešlete otevøenou úlohu zpracování 
filmu do kamery nebo tiskárny. 
→ Strana G.2–12, Exponování aktuálního pacienta

➭ Pokud nechcete exponovat celou úlohu zpracování filmu, ale 
pouze zobrazený list filmu, zvolte položku Film > Expose Film 
Sheet. 
→ Strana G.2–14, Exponování/tisk filmového listu 
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Zmìna výchozího nastavení G.3

Standardnì bylo již definováno rozvržení pro všechny úlohy 
zpracování filmu na virtuálním listu filmu a také byla vybrána 
kamera nebo tiskárna. G.3

Toto výchozí nastavení mùžete zmìnit v dialogovém oknì Film 
Preview nebo na kartì úlohy Filming. G.3

Chcete-li nastavení zmìnit v oknì Film Preview, postupujte 
následujícím zpùsobem: 
 

G.3

Volba kamery nebo 
tiskárny G.3

✧ Pokud zobrazenou úlohu zpracování filmu nebo list filmu 
chcete exponovat na jiné kameøe nebo vytisknout na jiné 
tiskárnì, spus¤te pøíkaz Film > Change Camera....

Otevøe se dialogové okno, ve kterém mùžete vybrat novou 
kameru nebo tiskárnu. 
→ Strana G.4–2, Volba kamery nebo tiskárny 
 

G.3

Zmìna vlastností  
exponování na film G.3

✧ Klepnìte na segment nebo na okraj listu filmu. Tímto 
zpùsobem mùžete vybrat jeden snímek nebo celý list filmu.

Nebo G.3

✧ Vyberte filmovou úlohu, pokud budete chtít zmìnit 
parametry filmu pro celou filmovou úlohu. 

✧ Spuštìním pøíkazu Film > Properties... zmìníte nastavení 
filmu.

Otevøe se dialogové okno Film Properties, ve kterém mùžete 
zmìnit øadu nastavení rozvržení pro exponování na film. 
→ Strana G.4–4, Rozvržení listu filmu 

G.3
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Zpracování listu filmu G.3

V oknì Film Preview je k dispozici øada funkcí pro zmìnu 
uspoøádání listù filmu. 
 

G.3

Odstraòování snímkù G.3 Pokud vidíte, že jeden ze snímkù na kartì úlohy  je nepoužitelný 
(napø. snímek s pohybovými artefakty), klepnìte na daný 
snímek v oknì Film Preview (snímek poznáte podle èísla). G.3

G.3 ✧ Zvolený snímek odstraníte klepnutím na tlaèítko pro 
vymazání umístìné v ovládací oblasti.

Následující obrazy se posunou nahoru tak, aby místo 
smazaného obrazu nezùstaly žádné prázdné segmenty. 

G.3

Nebo G.3

✧ Spus¤te pøíkaz Film > Clear Document(s).

Snímek bude odstranìn. Následující snímky se neposunou 
nahoru. G.3

Pokud jste odstranili tímto zpùsobem nìkolik obrazù, vaše 
filmové listy budou obsahovat mnoho prázdných segmentù. G.3

✧ Pro efektivnìjší využití filmového materiálu spus¤te pøíkaz 
Film > Repack.
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Pøidání snímkù G.3 Pokud jste otevøeli okno Film Preview z okna Patient Browser, 
mùžete k úloze zpracování filmu pøidat další snímky. G.3

Tímto zpùsobem mùžete napøíklad pro porovnání uložit na film 
snímky z døívìjších studií pacienta. G.3

✧ Spuštìním pøíkazu Film > New Film Sheet mùžete na konec 
úlohy zpracování filmu pøidat prázdný list filmu.

✧ Nyní pøetažením myší naplòte tento list filmu vybranými 
obrazy z okna Patient Browser. 

Nebo G.3

✧ Odešlete další snímky na kartu Filming pomocí funkce Copy 
to Film Sheet. 

Tyto snímky se také pøipojí na konec úlohy zpracování filmu. G.3
G.3–8 Návod k použití pro uživatele systému syngo
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Práce s úlohami zpracování filmu a 
s listy filmu G.3

Kromì jednoduchých krokù zpracování v oknì Film Preview
mùžete také provádìt komplexní a rozsáhlé zmìny úloh 
zpracování filmu na kartì Filming. Tímto zpùsobem zajistíte, 
aby se vždy vytiskly nebo exponovaly na film pouze ty snímky, 
které potøebujete pro zprávy. G.3

Kromì toho mùžete zpracovávat snímky, série jednotlivých 
snímkù nebo celé série tak, abyste dosáhli optimálního výstupu 
na film. G.3

Mùžete napøíklad vymazat jednotlivé snímky nebo nìkolik 
snímkù nebo zmìnit uspoøádání listu filmu. G.3
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únor 2006

 0.0



Prohlížení a zpracování listù filmu a obrazù Exponování na film
Vyvolání karty úloh Filming G.3

Na kartì úlohy Filming mùžete zpracovat listy filmu aktuální 
úlohy zpracování filmu. G.3

G.3 ✧ Kliknìte na záložku karty Filming. 

Nebo G.3

✧ Maximalizujte okno Film Preview. 
 
 

Karta úlohy Filming se umístí do popøedí. 
G.3

!0

G.3 G.3

Bìhem vyšetøení nemùžete spustit kartu úlohy Filming.  
Nejdøíve ukonèete aktuální vyšetøení nebo použijte funkci Film 
Preview pro ménì rozsáhlé zpracování filmových úloh. G.3
G.3–10 Návod k použití pro uživatele systému syngo
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Karta funkcí Filming je rozèlenìna do následujících oblastí: G.3

 

(1) Øádek nabídek s položkami pro filmování
(2) Ovládací oblast pro snadné spouštìní funkcí zpracování
(3) Zobrazení listu filmu (virtuální list filmu)
(4) Stavový øádek pro systémová hlášení
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Výbìr úlohy zpracování filmu G.3

Vedle složek pacientù v horní èásti ovládací oblasti vidíte, které 
úlohy zpracování filmu právì èekají na odeslání do kamery nebo 
tiskárny. 
 

G.3

Oznaèení G.3 Tyto úlohy mají jedno z následujících oznaèení: G.3

❏ Patient name 
Filmová úloha, která obsahuje obrazy pacienta.

❏ Multiple 
Filmová úloha, která obsahuje obrazy nìkolika pacientù. 
→ Strana G.1–7, Virtuální list filmu

➭ Pokud na virtuálním listu filmu není žádná úloha zpracování 
filmu, zobrazí se složka pacienta s oznaèením New. 
 

Otevøení úlohy zpracování 
filmu G.3

G.3 ✧ Úlohu zpracování filmu otevøete klepnutím. 

Složka pacienta se otevøe a barva složky zùstane nezmìnìna. G.3

Snímky otevøených úloh zpracování filmu se zobrazí na listu 
filmu v levé èástí karty úloh. G.3

Nyní mùžete listy filmu této úlohy procházet; dále mùžete 
vybrat a zpracovat jeden nebo více listù filmu nebo obrazù. 
→ Strana G.3–15, Výbìr listù filmu a snímkù G.3
G.3–12 Návod k použití pro uživatele systému syngo
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Volba celé úlohy zpracování 
filmu G.3

Pokud chcete zpracovat všechny listy filmu a všechny snímky 
úlohy zpracování filmu, musíte tuto úlohu nejen otevøít, ale také 
ji explicitnì vybrat. G.3

✧ Klepnìte na otevøenou úlohu zpracování filmu znovu a 
vyberte všechny listy filmu se všemi snímky této úlohy.

Ikona složky se nyní zvýrazní (modøe) a všechny snímky této 
úlohy se zobrazí s tuèným okrajem v oblasti pro zobrazení listu 
filmu. G.3
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Poèet kopií úlohy zpracování filmu G.3

Na kartì úlohy Filming nebo v oknì Film Preview mùžete také 
nastavit, kolikrát se má úloha exponovat nebo tisknout. 

G.3

G.3 ✧ Zvolte poèet kopií pomocí èíselníku nebo zadejte požadovaný 
poèet pomocí klávesnice.
G.3–14 Návod k použití pro uživatele systému syngo
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Výbìr listù filmu a snímkù G.3

Po otevøení úlohy zpracování filmu se pøíslušné obrazy zobrazí v 
levé èásti karty úlohy Filming. 

G.3

Nìkolik listù filmu G.3 Pokud úloha obsahuje tolik snímkù, že zaplní nìkolik listù filmu, 
zobrazí se u každého listu nahoøe vpravo èíslo listu a celkový 
poèet listù filmu. V pravém horním rohu naleznete záložky 
dalších listù. G.3

 

Úloha vyplòuje pouze jeden list filmu Úloha zaplòuje více než jeden list filmu
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Procházení G.3 ✧ Další listy filmu lze zobrazit pomocí záložek. 
→ Strana G.3–4, Listy filmu

Nebo G.3

G.3 ✧ Dvojitì kliknìte na èíslo aktuálního listu filmu. 

Zobrazovací pole se stane vstupním polem. G.3

G.3 ✧ Pøepište zobrazené èíslo èíslem listu, který chcete zobrazit, a 
stisknìte klávesu Return.

Zobrazí se zadaný list filmu. G.3

➭ Pokud chcete listovat sadou obrázkù velmi rychle, kliknìte na 
záložku a podržte tlaèítko myši.
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Volba listu filmu G.3 ✧ Klepnìte na okraj listu filmu a vyberte všechny snímky, které 
obsahuje.

Všechny segmenty listu filmu se nyní zobrazí s tuèným 
okrajem. G.3

Zrušení výbìru filmového 
listu G.3

✧ Kliknìte mimo filmový list se stisknutým levým tlaèítkem 
myši.

Nebo G.3

✧ Zvolením jednoho obrazu, dalšího listu filmu nebo jiné úlohy 
zpracování filmu zrušte volbu. 
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Vícenásobný výbìr G.3 Mùžete také vybrat více listù filmu najednou. G.3

✧ Pøidržte klávesu Ctrl a klepnìte na okraj prvního listu filmu.

✧ Pøejdìte na další list filmu.

G.3 ✧ Pøidržením klávesy Ctrl mùžete rozšíøit volbu o jednotlivé listy 
filmu.

Nebo G.3

G.3 ✧ Pøidržením klávesy Shift mùžete vybrat všechny listy filmu 
mezi danými dvìma listy filmu, a to vèetnì všech pøíslušných 
obrazù. 

➭ Pokud zvolíte list filmu, budou mít všechny obrazy okraj. 
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Výbìr segmentù G.3 Mùžete vybrat nejen celý list filmu, ale také jednotlivé obrazy 
úlohy zpracování filmu. G.3

Input Focus oznaèuje aktivní segment oblasti snímku. Je 
oznaèen okrajem s pøerušovanou èarou a zobrazen tak, aby bylo 
vždy jasné, který snímek se právì zpracovává. G.3
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
 

G.3
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Provádìné kroky zpracování se vždy aplikují na segment, na 
kterém je fokus. G.3

Fokus se deaktivuje a žádný segment nebude mít okraj pouze v 
pøípadì, že jste explicitnì zvolili urèité snímky, listy filmu nebo 
úlohy zpracování filmu. G.3

✧ Kliknìte na další obrázek levým tlaèítkem myši pro umístìní 
vstupního fokusu na další segment.

Nebo G.3

✧ Pøesuòte fokus pomocí kurzorových kláves na klávesnici. 
→ Strana E.3–33, Použití fokusu

Snímek je ohranièen pøerušovanou èarou. G.3
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Explicitní volba jednoho 
nebo více snímkù G.3

Snímky lze vybírat explicitnì stejnì jako listy filmu. G.3

✧ Pøidržte klávesu Ctrl a klepnìte na segment.

Segment bude ohranièen. G.3

➭ Stejnì jako u listù filmu mùžete také výbìr segmentù rozšíøit 
pøidržením klávesy Ctrl nebo Shift a kliknutím na další 
segmenty. 
→ Strana G.3–18, Vícenásobný výbìr 
 

Explicitní volba snímkù až 
do konce série G.3

Chcete explicitnì vybrat zobrazený snímek a všechny 
následující snímky. G.3

✧ Pøidržte klávesu Ctrl a klepnìte na snímek, který chcete 
vybrat explicitnì, nebo použijte fokus.

✧ V hlavní nabídce zvolte položku Edit > Select On Succeeding 
nebo v místní nabídce položku Select On Succeeding.

Nyní je vybrán snímek a všechny po nìm následující snímky. G.3

➭ Pokud jste explicitnì vybrali snímky z rùzných sérií, jsou 
vybrány všechny zbývající snímky v sérii, poèínaje tìmito 
snímky.
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Explicitní volba celé série G.3 Celé série (tj. všechny snímky v nich obsažené) lze nejsnadnìji 
vybrat pomocí funkce Select Series. G.3

✧ Pøidržte klávesu Ctrl a klepnìte na snímek v sérii, kterou 
chcete vybrat, nebo použijte fokus.

✧ V hlavní nabídce zvolte položku Edit > Select Series nebo v 
místní nabídce položku Select Series.

Nyní je explicitnì vybrána celá série. G.3

➭ Pokud jste vybrali obrazy z rùzných sérií, jsou vybrány všechny 
obrazy z tìchto sérií. 
 

Zrušení výbìru obrázkù G.3 Pokud explicitní volba neobsahuje požadovanou skupinu 
snímkù, mùžete volbu snímkù zrušit jednotlivì nebo 
hromadnì. G.3

✧ Pøidržte klávesu Ctrl a klepnìte znovu na explicitnì zvolený 
snímek. Výbìr je nyní zrušen.

Nebo G.3

✧ Vyvolejte Edit > Deselect All v hlavní nabídce pro opìtovné 
zrušení všech vybraných obrazù.

Poté se automaticky nastaví výchozí fokus, tj. cílem další akce 
bude levý horní segment. G.3
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Zmìna uspoøádání listù filmu G.3

Pomocí karty úlohy Filming mùžete zmìnit uspoøádání úloh 
zpracování filmu takovým zpùsobem, aby se exponovaly nebo 
vytiskly pouze ty obrazy, které pro diagnózu skuteènì 
potøebujete. 
 

G.3

Mazání obrazù nebo 
filmových listù G.3

Z úlohy zpracování filmu mùžete odstranit snímkový materiál, 
který je pro zprávu nepoužitelný. G.3

✧ Zvolte jeden nebo více obrazù èi listù filmu nebo použijte 
fokus. 

✧ V hlavní nabídce vyvolejte Edit > Delete.

Nebo G.3

G.3 ✧ Odstraòte snímky nebo listy filmu pomocí tohoto tlaèítka 
nebo pomocí klávesy Del na klávesnici.

Snímky nebo listy filmu budou z úlohy zpracování filmu zcela 
odstranìny. Prázdné segmenty budou také odstranìny. 

G.3

Nebo G.3

✧ V hlavní nabídce zvolte položku Film > Clear Document(s) 
nebo v místní nabídce položku Clear Document(s).

Snímky jsou odstranìny a segmenty v úloze zpracování filmu 
zùstanou prázdné. G.3

➭ Místní nabídka je kontextovì závislá, tj. obsah nabídky závisí 
na tom, zda jste vybrali snímek, list filmu, úlohu zpracování 
filmu nebo zda jste nevybrali nic.
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Zaplòování prázdných 
segmentù G.3

Pokud jste odstranili nìkolik snímkù v úloze zpracování filmu 
pomocí funkce Clear Document(s), úloha bude obsahovat 
nìkolik listù filmu s prázdnými segmenty. Pøed zasláním úlohy 
zpracování filmu do kamery nebo tiskárny doporuèujeme 
upravit uspoøádání listù filmu, aby mohl být filmový materiál 
využit co nejefektivnìji. G.3

✧ Zvolte celou úlohu zpracování filmu. 
→ Strana G.3–13, Volba celé úlohy zpracování filmu

✧ Zvolte Film > Repack z hlavní nabídky pro opìtovné zaplnìní 
prázdných míst (pouze úlohy zpracování filmu).
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Funkci Repack mùžete použít také bìhem zpracování pro 
úpravu uspoøádání jednoho listu filmu. V takovémto pøípadì 
vyberte pouze jeden list filmu. Uspoøádají se pouze snímky na 
tomto listu filmu. G.3
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Kopírování obrazù nebo 
filmových listù G.3

Pokud chcete, aby úloha zpracování filmu obsahovala snímky 
nebo celé listy filmu vícekrát, musíte nejprve tyto snímky nebo 
listy filmu zkopírovat. G.3

✧ Zvolte požadovaný snímek nebo list filmu urèený ke 
zkopírování nebo zkopírujte snímek, na nìmž je umístìn 
fokus.

✧ V hlavní nabídce zvolte položku Edit > Copy nebo v místní 
nabídce položku Copy.

Nebo G.3

✧ Objekty filmu zkopírujte pomocí klávesové zkratky systému 
Windows Ctrl + C. 
 

Nyní zvolte snímek, pøed který chcete kopie vložit, nebo použijte 
fokus. G.3

✧ V hlavní nabídce zvolte položku Edit > Paste nebo v místní 
nabídce položku Paste.

Nebo G.3

✧ Snímky vložte pomocí klávesové zkratky systému Windows 
Ctrl + V.

Všechny zkopírované snímky se vloží pøed zvolený segment. 
Snímek z tohoto segmentu se pøesune v úloze zpracování filmu 
ke konci úlohy. G.3

➭ V oknì Filming Layout mùžete definovat zvláštní rozvržení 
tak, aby se kopie pøi pøesunu obrazù na virtuální list filmu 
vytváøely automaticky. 
→ Strana G.6–12, Série s kopií na listu filmu
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Pøesun snímkù nebo listù 
filmu G.3

Snímky mùžete pøesunovat v rámci úlohy zpracování filmu nebo 
z jedné úlohy do druhé tak, že je nejprve vyjmete a poté vložíte 
na novou pozici. G.3

✧ Zvolte snímek nebo snímky, které chcete pøesunout, nebo 
použijte fokus.

✧ V hlavní nabídce zvolte položku Edit > Cut nebo v místní 
nabídce položku Cut.

Nebo G.3

✧ Obrazy vyjmìte pomocí klávesové zkratky systému Windows 
Ctrl + X. 
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
G.3 ✧ Vyberte segment, pøed který chcete pøesunout vyjmuté 
snímky.

✧ Vložte obrazy pøed daný segment pomocí pøíkazù Edit > 
Paste, Paste nebo klávesové zkratky Ctrl + V. 

G.3 ➭ Pokud chcete pøesunout snímky pouze v rámci listu filmu, 
mùžete to také provést pøetažením myší. Výsledkem mohou 
být prázdné segmenty, které lze vyplnit pomocí funkce 
Repack. 
 
 
 
 

Pøipojení nového listu 
filmu G.3

Pokud je poslední list filmu úlohy zpracování filmu již plný a vy 
chcete kopírovat nebo pøesunout snímky na konec dané úlohy, 
musíte nejprve pøipojit nový list filmu. G.3

✧ V libovolné fázi úlohy zpracování filmu zvolte položku 
Film > New Film Sheet.

Nový (prázdný) list filmu se pøipojí na konec úlohy zpracování 
filmu. G.3

✧ Poté vložte zkopírované nebo vyjmuté snímky na list.
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Pøidávání obrazù z Patient 
Browser G.3

Pokud chcete k úloze zpracování filmu pøidat snímky z okna 
Patient Browser, mùžete tak uèinit velmi snadno, a to 
pøetažením myší. G.3

✧ Otevøete okno Patient Browser (Patient > Browser...).

Okno Patient Browser se zobrazí na popøedí karty úlohy 
Filming. G.3

✧ Vyberte snímek, snímky nebo celou sérii èi studii.

✧ Pøetáhnìte tyto snímky do segmentu listu filmu.

Snímky se vloží do úlohy zpracování filmu pøed tento segment. 
Pokud úloha zpracování filmu nyní obsahuje obrazy nìkolika 
pacientù, nazývá se vícenásobná úloha. 
 

G.3

Pøidávání snímkù z karet 
úloh G.3

Z karet úloh mùžete pøenášet snímky na kartu Filming pouze 
pomocí funkce Patient > Copy to Film Sheet. G.3

Pokud pøenášíte snímky stejného pacienta na virtuální list filmu, 
pøipojí se vždy ke stejné úloze zpracování filmu. Pokud na 
virtuální list filmu kopírujete obrazy rùzných pacientù, vytvoøí se 
pro každého pacienta nová úloha zpracování filmu v pøípadì, že 
systém nebyl nakonfigurován pro povolení úloh zpracování 
filmu obsahujících obrazy více pacientù. 
→ Strana G.6–7, Jeden pacient nebo více pacientù na jednu 
úlohu zpracování filmu G.3
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Zpracování obrázkù G.3

Kromì uspoøádání listù filmu mùžete na kartì úlohy Filming
také mìnit parametry zobrazení obrazù, a tím získat optimální 
výstup. 
→ Kapitola E.4, Zpracování snímkù 

G.3

Vyvažování G.3 Na kartì úloh Filming se snímky naètou s hodnotami vyvážení, 
se kterými byly naposledy uloženy. Pokud jste snímky pøenesli z 
karty úlohy Viewing, zobrazí se s hodnotami vyvážení, které 
byly naposledy použity na kartì Viewing. G.3

Na kartì Filming mùžete tyto hodnoty vyvážení pøed expozicí 
zmìnit. G.3

➭ Pro barevné snímky se hodnoty vyvážení v segmentu 
nezobrazí. Vyvažování barevných snímkù není možné.

K dispozici máte následující možnosti: G.3

Okno 1 nebo okno 2 G.3

G.3 ✧ Zvolte jeden nebo více snímkù nebo použijte fokus.

✧ Kliknìte na okno 1 nebo okno 2 a pøiøaïte obrazùm hodnoty 
prvního nebo druhého okna. 
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Automatické vyvažování G.3 Pomocí funkce Auto Windowing mùžete obrazùm automaticky 
pøiøadit optimální hodnoty vyvážení, a to buï pøi naèítání, nebo 
po naètení jednotlivých obrazù. 

G.3

G.3 ✧ Kliknìte na tlaèítko Auto Windowing. 
 

Nebo G.3

✧ Zvolte položku Image > Auto Windowing. 
→ Strana E.4–10, Automatické vyvážení 

Vyvážení pomocí 
klávesnice G.3

Pro jemné upravení hodnot vyvážení mùžete použít také klávesy 
na klávesnici se symboly. G.3

❏ Nastavení kontrastu

G.3 ✧ Stisknutím klávesy Width+ (èíselná klávesa -) nebo Width- 
(èíselná klávesa *) mùžete zvýšit nebo snížit kontrast. 
 
 

❏ Nastavení jasu

G.3 ✧ Stisknutím klávesy Center+ (èíselná klávesa /) nebo Center- 
(èíselná klávesa Num) mùžete zvýšit nebo snížit jas. 
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Vyvážení 
pomocí myši

G.3

✧ Umístìte kurzor myši na obrázek a posouvejte myší za 
stisknutého støedního tlaèítka myši.

 

 

Další informací o vyvažování obrazù viz 
→ Strana E.4–2, Vyvážení snímkù G.3

Kontrast - 
(šíøka +)

Jas - 
(støed +)

Jas + 
(støed -)

Kontrast + 
(šíøka -) x

y
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Prohlížení a zpracování listù filmu a obrazù Exponování na film
Zvìtšování a zmenšování 
snímkù G.3

Snímek mùžete zvìtšit a zobrazit tak oblast, která vás nejvíce 
zajímá. Pokud zvìtšený snímek pøesáhne velikost segmentu, 
posunutím snímku zobrazte pøíslušnou oblast. G.3

Pro zmìnu mìøítka a posunování obrazu mùžete použít 
následující funkce. 

G.3

Image > Zoom in/out G.3 ✧ Zvolte jeden nebo více snímkù.

✧ Zvolením položky Image > Zoom Factor v nabídce otevøete 
dialogové okno Zoom Factor. Zadejte hodnotu pro velikost 
segmentu nebo faktor pøiblížení/oddálení pro vybrané 
obrazy. 
 

Zmìna mìøítka a posun 
pomocí myši G.3

G.3 ✧ Kliknìte na tlaèítko Zoom/Pan nebo zvolte položku Image > 
Zoom/Pan v nabídce.

Funkce levého tlaèítka myší se zmìní z funkce Select na Zoom/
Pan. G.3

✧ Umístìte kurzor myši na snímek (nemusí být pøedtím 
vybrán).

✧ Nyní kliknìte blízko okraje obrázku a pøidržte stisknuté levé 
tlaèítko myši. Posouváním kurzoru myši smìrem nahoru se 
bude obrázek zvìtšovat.
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Exponování na film Prohlížení a zpracování listù filmu a obrazù
Nebo G.3

✧ Kliknìte na støed obrázku a posouvejte obrázkem se 
stisknutým levým tlaèítkem myši.

✧ Deaktivujte volby Images > Zoom/Pan nebo kliknìte na toto 
tlaèítko ještì jednou, aby se funkce levého tlaèítka myši 
pøepnula zpìt na vybírání filmových objektù.

Další informace o zmìnì mìøítka a posunování obrazu viz 
→ Strana E.4–22, Zvìtšování a posun snímkù. 
 

G.3

Obnovení mìøítka  
pøiblížení/oddálení G.3

Pùvodní faktor pøiblížení/oddálení, které bylo s obrazy 
naposledy uloženo do databáze, lze kdykoliv obnovit. 

G.3

✧ V hlavní nabídce zvolte položku Image > Home Zoom/Pan.

Nebo G.3

G.3 ✧ Klepnìte na tlaèítko.

G.3

G.3
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KAPITOLA 0.0

G.4

Zmìna nastavení filmu pro 
úlohu zpracování filmu G.4
Standardní rozvržení filmu bylo definováno bìhem konfigurace 
systému. Toto rozvržení obsahuje všechna nastavení 
požadovaná pro zpracování filmù. Pro jednotlivé studie lze 
uložit zvláštní nastavení filmování. Taková nastavení se nazývají 
rozvržení pro urèité studie. G.4

Všechna potøebná nastavení proto již byla provedena pro 
každou novou úlohu zpracování filmu. Pokud jste s tìmito 
nastaveními spokojeni, mùžete zahájit filmování snímkù bez 
jakéhokoliv dalšího zásahu. G.4

Pokud tyto pøedvolby nejsou vhodné, mùžete zmìnit následující 
nastavení na kartì úlohy Filming nebo v náhledu filmu: G.4

❏ Výbìr jiné kamery nebo tiskárny

❏ Zmìna poètu kopií

❏ Zmìna uspoøádání listù filmu

❏ Zmìna zobrazení obrazu, textu a grafiky 

Všechna tato nastavení se týkají pouze aktuální úlohy 
zpracování filmu. U další úlohy zpracování filmu se obnoví 
standardní rozvržení nebo výchozí rozvržení pro urèitou studii.G.4
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Zmìna nastavení filmu pro úlohu zpracování filmu Exponování na film
Volba kamery nebo tiskárny G.4

Pokud nechcete exponovat nebo tisknout aktuální úlohu 
zpracování filmu pomocí výchozí kamery nebo tiskárny, vyberte 
pro tuto úlohu jinou kameru nebo tiskárnu. 

G.4

✧ Klepnutím umístìte kartu dílèí úlohy Camera na kartì úloh 
Filming na popøedí.
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Exponování na film Zmìna nastavení filmu pro úlohu zpracování filmu
Nebo G.4

✧ Zvolením položky Film > Change Camera... otevøete 
dialogové okno Change Camera and Film Size.

 

✧ Vyberte kameru nebo tiskárnu ze seznamu. Tento výbìrový 
seznam obsahuje všechny kamery a tiskárny pøipojené k 
systému.

➭ Novì vybraná kamera nebo tiskárna se použije jako výchozí 
kamera nebo tiskárna, která se použije vždy, pokud 
nevyberete jiné zaøízení.

V oblasti Status uvidíte, zda je vybraná kamera nebo tiskárna 
zapnutá, a tedy k dispozici. G.4

✧ V nabídce Film Size zvolte formát filmu. 

➭ Formát filmu obrazù, které jste poprvé poslali do virtuálního 
filmového listu, závisí na rozvržení filmového listu. Velikost 
filmu nelze zmìnit v dialogovém oknì Change Camera and 
Film Size.
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Zmìna nastavení filmu pro úlohu zpracování filmu Exponování na film
Rozvržení listu filmu G.4

Rozvržení listu filmu slouží k urèení velikosti každého snímku. G.4

Pokud napøíklad chcete na exponovaných/vytištìných obrazech 
zobrazit diagnostické detaily, zvolte vìtší velikost (ménì obrazù 
na listu filmu). 
 

G.4

Volba snímkù a listù filmu G.4 Nastavte rozvržení listu filmu pro zvolené snímky úlohy 
zpracování filmu. G.4

✧ Zvolením celé úlohy zpracování filmu mùžete zmìnit 
rozvržení pro všechny listy této úlohy.

Nebo G.4

✧ Zvolením jednoho listu filmu mùžete zmìnit rozvržení pouze 
tohoto listu.

Nebo G.4

✧ Zvolte jednotlivé obrazy nebo použitím fokusu zobrazte na 
tomtéž listu filmu pouze obrazy ve vìtší nebo menší velikosti. 
 

G.4–4 Návod k použití pro uživatele systému syngo
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Exponování na film Zmìna nastavení filmu pro úlohu zpracování filmu
Zmìna rozvržení G.4 ✧ Klepnutím umístìte kartu dílèí úlohy Layout na kartì úlohy 
Filming do popøedí.

 

✧ Kliknutím na tlaèítko pro rozvržení filmu zobrazíte vybrané 
obrazy v tomto formátu. 
 

Verze VE31D G.4–5 
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Zmìna nastavení filmu pro úlohu zpracování filmu Exponování na film
Nebo G.4

✧ Zvolte položku Film > Properties... v hlavní nabídce nebo 
položku Properties... v místní nabídce.

Otevøe se dialogové okno Film Properties. G.4

✧ Ve výbìrovém seznamu Division zvolte rozdìlení.

➭ Pokud se rozdìlení listu filmu pro vybrané snímky nebo listy 
filmu liší, bude výbìrový seznam Division prázdný.
G.4–6 Návod k použití pro uživatele systému syngo
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Exponování na film Zmìna nastavení filmu pro úlohu zpracování filmu
Pøíklad G.4 Zvolené snímky nebo listy filmu se zobrazí v nové velikosti. 
Zbývající snímky úlohy zpracování filmu budou zobrazeny s 
pùvodním rozvržením. G.4
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Zmìna nastavení filmu pro úlohu zpracování filmu Exponování na film
Zobrazení obrazu, textu a grafiky G.4

Rozvržení listu filmu urèuje poèet a velikost segmentù na listu 
filmu. Pomocí okna Film Preview a karty úlohy Filming mùžete 
mìnit pomìr velikosti jednotlivých snímkù v segmentech a 
definovat, jestli a jak mají být na filmu exponovány nebo 
vytištìny text a grafika. G.4

✧ Klepnutím umístìte kartu dílèí úlohy Images na kartì úlohy 
Filming do popøedí.

 

Nebo G.4

✧ Otevøete dialogové okno Film Properties.

➭ Zobrazí se nastavení aktuálnì vybraných snímkù. Pokud se 
nastavení snímkù liší, pøepínaèe nebudou aktivní.
G.4–8 Návod k použití pro uživatele systému syngo
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Exponování na film Zmìna nastavení filmu pro úlohu zpracování filmu
Fit to segment G.4 ✧ Vyberte snímky, jejichž pomìr velikosti chcete zmìnit.

Nebo G.4

✧ Pokud chcete zmìnit pomìr velikosti všech obrazù, vyberte 
celou úlohu zpracování filmu. 

G.4 ✧ Klepnìte na tlaèítko Fit to segment na kartì dílèí úlohy 
Images.

Nebo G.4

G.4 ✧ Zvolte volbu Fit to segment v dialogovém oknì Film 
Properties.

Obrazy se zobrazí v segmentu s maximální velikostí, aniž by byly 
jakékoliv èásti obrazu oøezány. 
 
 

G.4

Oøezání dokumentu G.4 ✧ Vyberte snímek, nìkolik snímkù nebo celou úlohu zpracování 
filmu.

G.4 ✧ Kliknìte na tlaèítko Clip Document na kartì dílèí úlohy 
Images.

Nebo G.4

G.4 ✧ V dialogovém oknì Film Properties zvolte možnost Clip 
document. 
 
 

Nejvìtší viditelný rozmìr pravoúhlého obrazu bude vyøezán a 
pøizpùsoben segmentu. G.4
Verze VE31D G.4–9 
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Zmìna nastavení filmu pro úlohu zpracování filmu Exponování na film
Pùvodní snímek G.4

G.4 ✧ Vyberte obraz, nìkolik obrazù nebo celou filmovou úlohu. 

✧ Kliknìte na tlaèítko Original Image na kartì dílèí úlohy 
Images. 

Nebo G.4

G.4 ✧ Zvolte volbu Original Image (100%) v dialogovém oknì Film 
Properties. 
 

Snímky se v segmentu zobrazí v pùvodní velikosti; rozmìry na 
obrazovce a na výtisku jsou pùvodní. G.4

➭ Odchylka závisí na typu kamery. Pro orientaci použijte 
mìøítko. 

➭ Mùžete nastavit faktor mìøítka, abyste definovali velikost 
obrazu na filmovém listu ve srovnání s pùvodní velikostí. 
→ Strana G.6–13, Velikost zobrazení

Pokud není možné zobrazit obrazy v pomìru šíøky a délky stran 
pùvodní velikosti (1:1) v oknì Original Image, zobrazí se 
hlášení a místo toho je zvolena volba Fit to segment. G.4
G.4–10 Návod k použití pro uživatele systému syngo
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Exponování na film Zmìna nastavení filmu pro úlohu zpracování filmu
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Zmìna nastavení filmu pro úlohu zpracování filmu Exponování na film
Zobrazení textu k obrazùm G.4 V nastavení pro filmování mùžete zvolit, zda se má textová 
informace o snímcích také vytisknout èi exponovat na film nebo 
ne. G.4

➭ Nastavení pro text k obrazu se vždy aplikují na celou úlohu 
zpracování filmu, a ne pouze na vybrané obrazy. 

G.4 ✧ Kliknìte na tlaèítko All Text na kartì dílèí úlohy Images, aby 
se v segmentech zobrazily všechny textové informace o 
obrazech a pozdìji se exponovaly na film nebo vytiskly 
spoleènì s obrazy.

Nebo G.4

G.4 ✧ Zvolte volbu All text v dialogovém oknì Film Properties. 
 
 
 

G.4 ✧ Kliknutím na tlaèítko No Text na kartì dílèí úlohy Images 
skryjete všechny textové informace v segmentech.

Nebo G.4

G.4 ✧ Zvolte volbu No text v dialogovém oknì Film Properties.
G.4–12 Návod k použití pro uživatele systému syngo
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Exponování na film Zmìna nastavení filmu pro úlohu zpracování filmu
G.4 ✧ Kliknìte na tlaèítko Customized Text na kartì dílèí úlohy 
Images, aby se zobrazila a exponovala na film nebo vytiskla 
pouze èást textové informace.

➭ Pokud zvolíte možnost Customized Text tlaèítkem na kartì 
dílèí úlohy Images, systém použije nastavení, která jste 
provedli bìhem konfigurace. 
→ Strana A.4–8, Konfigurace textu snímkù

Nebo G.4

G.4 ✧ V dialogovém oknì Film Properties zvolte možnost 
Customized text. 
 

V dialogovém oknì Film Properties nyní mùžete zvolit, jaká 
textová informace má být zobrazena, pokud byla zvolena volba 
Customized text. G.4

✧ Pro zobrazení nebo skrytí každého údaje kliknìte myší na 
zaškrtávací políèko pøíslušné položky. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Žádný textUpravený textVeškerý text
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Zmìna nastavení filmu pro úlohu zpracování filmu Exponování na film
Zobrazení/skrytí  
grafických prvkù a 
poznámek G.4

Grafiku (napø. ROI) a poznámky lze zobrazit nebo skrýt stejným 
zpùsobem jako textové informace. 
 

G.4

G.4 ✧ Klepnutím na tlaèítko Show Graphics na kartì dílèí úlohy 
Images se zobrazí grafika (napø. ROI) a poznámky.

Nebo G.4

G.4 ✧ V dialogovém oknì Film Properties zvolte možnost Show. 
 
 

G.4 ✧ Klepnutím na tlaèítko Hide Graphics na kartì dílèí úlohy 
Images skryjete grafiku (napø. ROI) a poznámky.

Nebo G.4

G.4 ✧ Zvolte volbu Hide v dialogovém oknì Film Properties. 
 

 

Zobrazení grafiky Skrytí grafiky
G.4–14 Návod k použití pro uživatele systému syngo
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Exponování na film Zmìna nastavení filmu pro úlohu zpracování filmu
Zobrazení referenèního 
obrazu G.4

V obrazu mùžete zobrazit referenèní obraz pøidružený k tomuto 
obrazu (napø. topogram v CT). G.4

G.4 ✧ Aktivací možnosti Reference image zobrazíte referenèní 
obaz Top right nebo Bottom right. 
Verze VE31D G.4–15 
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Zmìna nastavení filmu pro úlohu zpracování filmu Exponování na film
Velikost referenèního snímku je pøibližnì ètvrtina délky užší 
strany snímku. Všechny zobrazené textové informace pro 
snímek se pøesunou vlevo, aby nezakrývaly žádnou èást 
referenèního snímku. G.4

V závislosti na typu snímkù se zobrazí pøednastavený referenèní 
snímek. V pøípadì, že se žádný referenèní snímek nezobrazí 
nebo že budete chtít zvolit jiný referenèní snímek, mùžete tak 
uèinit myší, a to pøetažením na virtuálním listu filmu. G.4

➭ Jestliže se pokusíte vybrat obraz, který není pøípustný jako 
referenèní obraz, je vám to sdìleno v oknì s hlášením.
G.4–16 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

G.5

Kontrola úloh zpracování 
filmu G.5
Pokud pøenášíte úlohy zpracování filmu z virtuálního listu filmu 
do kamery nebo tiskárny, bude pro každou kameru a tiskárnu 
vytvoøena fronta úloh, které èekají na zpracování. G.5

Mùžete získat informaci o aktuálnì provádìných, èekajících a 
dokonèených úlohách zpracování filmu. Mùžete pozastavit 
celou frontu nebo opakovat nebo mazat jednotlivé úlohy a tím 
zasahovat do provedení úloh ve frontì. 
 

G.5

V dialogovém oknì Film Task Status získáte informace o 
úlohách zpracování filmu, které èekají na provedení ve frontách 
pro každou kameru a tiskárnu. G.5

Na stavovém øádku pod ovládací oblastí vidíte, jestli systém 
aktuálnì provádí expozici snímkù na film na pozadí a jestli 
expozice probíhá správnì. G.5
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Kontrola úloh zpracování filmu Exponování na film
Informace na stavovém øádku G.5

Bìhem expozice filmu jsou na stavovém øádku zobrazeny ikony, 
které informují o prùbìhu procesu a pøípadných chybách, které 
bìhem expozice nastaly. G.5

➭ Stav tiskárny není na stavovém øádku zobrazen.

Prùbìh exponování na film mùžete sledovat bez pøerušení práce 
a v pøípadì chyby mùžete okamžitì zasáhnout. 
 

G.5

Kamera v provozu G.5

G.5 Dokud kamera pracuje, tzn. provádí expozici listù filmu, na 
stavovém øádku je zobrazena ikona kamery. 
 

G.5

Exponování filmu  
pøerušeno G.5

G.5 Pokud bìhem exponování filmu nastane chyba, ikona kamery 
na stavovém øádku bude pøeškrtnuta. G.5

✧ Poklepáním na tuto ikonu kamery otevøete dialogové okno 
Film Task Status.

Zde se zobrazí pøíèina poruchy. G.5

Varovné hlášení G.5

G.5 Tento symbol oznaèuje, že kamera generovala varování. G.5
G.5–2 Návod k použití pro uživatele systému syngo
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Exponování na film Kontrola úloh zpracování filmu
Zobrazení a manipulace s úlohami 
zpracování filmu G.5

Na stavovém øádku se zobrazují struèné informace o prùbìhu 
exponování filmu. G.5

➭ Pro tiskové úlohy není na stavovém øádku zobrazena žádná 
informace.

Podrobné informace mùžete získat v dialogovém oknì Film 
Task Status. Zde mùžete pozastavit celou frontu, znovu ji 
spustit a zopakovat nebo zrušit jednotlivé úlohy zpracování 
filmu. 
 
 

G.5

Vyvolání stavu úlohy zpracování filmu G.5

Bez ohledu na to, zda váš systém v dané chvíli provádí tisk èi 
exponování na filmy, mùžete okno Film Task Status vyvolat 
pøes hlavní nabídku nebo tlaèítkem, a to kdykoli a z kterékoli 
karty funkcí. Zde mùžete získat informace o filmových úlohách 
ve frontách. G.5

Jakmile se zahájí expozice filmu na pozadí, dialogové okno 
mùžete zobrazit také klepnutím na ikony na stavovém øádku. To 
je užiteèné, jestliže nastane chyba pøi pøenosu. Mùžete potom 
okamžitì zjistit, u které úlohy zpracování filmu a u které kamery 
došlo k problému, a podniknout pøíslušné opatøení. 

G.5
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Kontrola úloh zpracování filmu Exponování na film
G.5 ✧ Klepnìte na tlaèítko Film Task Status na kartách úloh nebo v 
prohlížeèi Patient Browser.

Nebo G.5

✧ Otevøete okno Patient > Film Task Status....

Nebo G.5

✧ Poklepejte na ikonu kamery na stavovém øádku.

Zobrazí se dialogové okno Film Task Status. G.5
G.5–4 Návod k použití pro uživatele systému syngo
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Exponování na film Kontrola úloh zpracování filmu
Kamera G.5 V horní èásti dialogového okna se zobrazí všechny kamery a 
tiskárny, které jsou pøipojeny k systému. 

G.5

G.5 Kamera, jejíž fronta se právì zobrazuje, je zvýraznìna odlišnou 
barvou. 
 

G.5

G.5 ✧ Pokud chcete prohlížet frontu jiné kamery, kliknìte na jinou 
ikonu kamery. 
 

Tiskárna G.5

G.5 ✧ Klepnìte na jednu z ikon tiskáren, pokud chcete zobrazit 
frontu pøíslušné tiskárny.

Zobrazí se dialogové okno tiskových úloh v systému Windows 
XP. Zde mùžete manipulovat s tiskovými úlohami zvolené 
tiskárny pomocí položek nabídky operaèního systému Windows 
XP. 

G.5
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Kontrola úloh zpracování filmu Exponování na film
G.5 ✧ Po zavøení dialogového okna pro správu tiskových úloh v 
systému Windows XP se znovu zobrazí dialogové okno Film 
Task Status.

➭ Jméno pacienta lze vidìt po celou dobu, kdy je úloha 
zpracování filmu ve frontì tiskárny systému Windows XP. Pro 
zajištìní požadované ochrany dat musí uživatel postupovat 
následujícím zpùsobem:

❏ smazat tiskovou úlohu nebo

❏ poèkat, dokud se tisková úloha nedokonèí, a potom výtisky 
bezpeènì uložit.
G.5–6 Návod k použití pro uživatele systému syngo
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Exponování na film Kontrola úloh zpracování filmu
Informace v oknì Film Task Status G.5

Dialogové okno Film Task Status obsahuje seznam úloh s 
následujícími údaji: G.5

Název úlohy zpracování 
filmu G.5

Název úlohy zpracování filmu (jméno pacienta, jestliže úloha 
zpracování filmu obsahuje snímky pouze jednoho pacienta, 
nebo multiple, jestliže úloha obsahuje snímky nìkolika 
pacientù) G.5

Stav G.5 Stav zpracování úlohy: G.5

❏ Printed 
Úloha je dokonèena, všechny obrazy byly zaslány do kamery.

❏ Printing 
Úloha je aktuálnì odesílána do kamery.

❏ Queued 
Úloha je ve frontì a bude zaslána do kamery, jakmile bude 
volná.

❏ Stopped 
Úloha byla pozastavena.

❏ Aborted 
Úloha byla zrušena a je považována za dokonèenou. Tento 
stav se shoduje se stavem práce Printed.

Poèet listù G.5 Poèet listù filmu, které úloha zpracování filmu obsahuje. G.5

➭ Na výtisku se zobrazí èíslo listu a celkový poèet listù filmu, 
které úloha zpracování filmu obsahuje.

Poèet kopií G.5 Poèet kopií G.5

Urgentní G.5 Úloha je klasifikována jako naléhavá. G.5
Verze VE31D G.5–7 
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Kontrola úloh zpracování filmu Exponování na film
Pokud seznam obsahuje více úloh zpracování filmu, než kolik lze 
v pøíslušném oknì zobrazit, mùžete frontu úloh procházet 
pomocí posuvníku. Pokud okno otevøete, v seznamu se zobrazí 
první úloha se stavem Printing (nebo Queued). G.5

✧ Pokud se posunete smìrem nahoru, zobrazí se úlohy, které 
již byly exponovány na film (Printed). 
 
 
 

Manipulace s úlohami zpracování filmu G.5

V dialogovém oknì Film Task Status mùžete tlaèítky vybírat 
úlohy zpracování filmu a ovlivòovat jejich provádìní. G.5

Stav úlohy urèuje zpùsob, jak lze provádìní úlohy ovlivnit, a také 
která tlaèítka budou k dispozici. G.5

➭ V dialogovém oknì Film Task Status lze upravit jen ty úlohy 
zpracování filmu, které byly odeslány do kamery.
G.5–8 Návod k použití pro uživatele systému syngo
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Exponování na film Kontrola úloh zpracování filmu
Pozastavování úloh G.5 Úlohy se stavem „Queued” nebo „Printing” mùžete ukonèit 
kdykoli, napøíklad chcete-li vložit nový film. G.5

G.5 ✧ Klepnìte na tlaèítko Stop.

Ukonèí se všechny úlohy zpracování filmu v této frontì (stav 
“Stopped”). V úloze, která je exponována, se nejprve dokonèí 
list, jehož zpracování již bylo zahájeno. Všechny následující listy 
filmu se již nezpracují. 
 

G.5

Obnovování úloh G.5 Jakmile bude kamera opìt pøipravena, mùžete pokraèovat ve 
zpracování fronty. G.5

G.5 ✧ Klepnìte na tlaèítko Continue.

Všechny úlohy ve frontì se vrátí do pùvodního stavu. 
Exponování filmu bude pokraèovat. Úloha, která byla 
exponována v okamžiku, kdy jste kliknuli na tlaèítko Stop, bude 
pokraèovat od místa, ve kterém jste kameru pozastavili. 
 

G.5

Opakování úloh G.5 Je-li úloha zpracování filmu, která již byla exponována, a tudíž 
dokonèena, stále ve frontì, její zpracování lze opakovat. G.5

✧ Zvolte úlohu zpracování filmu, která již byla exponována na 
film (stav “Printed”).

G.5 ✧ Klepnìte na tlaèítko Repeat.

Úloze bude pøiøazen stav “Queued” a zkopíruje se na konec 
fronty. G.5

➭ Pokud už byly obrazy úlohy vymazány z databáze, zobrazí se 
chybové hlášení. 
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Kontrola úloh zpracování filmu Exponování na film
Odstranìní úloh G.5 Lze vymazat úlohy zpracování filmu, které jsou uvedeny ve 
frontì, a to bez ohledu na jejich stav. G.5

✧ Zvolte úlohy, které chcete vymazat (více voleb najednou 
použitím klávesy Ctrl nebo Shift).

Nebo G.5

G.5 ✧ Kliknìte na tlaèítko Select All, jestliže si pøejete vybrat 
všechny úlohy ve frontì. 

G.5 ✧ Klepnutím na tlaèítko Delete vymažete vybrané úlohy.

➭ Pokud vymažete úlohu, která se právì exponuje, bude 
dokonèen list, který byl zahájen. Všechny následující listy 
nebudou na film exponovány. 
 

Zmìna priority filmových  
úloh G.5

Oznaète úlohy zpracování filmu, které chcete zpracovat 
nejdøíve, jako “urgent”. G.5

G.5 ✧ Zvolte jednu nebo nìkolik úloh zpracování filmu se stavem 
”Queued” a kliknìte na položku Urgent.

Daná úloha se pøesune na první pozici mezi úlohy se stavem 
“Queued”. G.5

Je-li více úloh ohodnocených jako „urgent”, budou provedeny v 
takovém poøadí, v jakém se zobrazí v seznamu. 
 

G.5
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Exponování na film Kontrola úloh zpracování filmu
Volba jiné kamery 
G.5

Pro jednu nebo více úloh zpracování filmu mùžete zvolit novou 
kameru. G.5

➭ Pøesmìrování úloh zpracování filmu z kamery na tiskárnu není 
možné.

✧ Zvolte jednu nebo více úloh zpracování filmu.

G.5 ✧ Klepnutím na tlaèítko Change Camera otevøete dialogové 
okno Change Camera.

 

✧ Z výbìrového seznamu vyberte novou kameru.

➭ Pøesmìrovat úlohy zpracování filmu, které se právì 
zpracovávají (stav „Printing”), na jinou kameru nelze.
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Kontrola úloh zpracování filmu Exponování na film
Pøesmìrování úloh z 
nedostupné kamery G.5

Pokud je jedna z kamer vadná nebo vypnuta, bude oznaèena 
ikonou pøeškrtnuté kamery v záhlaví dialogového okna Film 
Task Status. G.5

Do jiné kamery lze pøesmìrovat frontu nebo dokonce jednotlivé 
úlohy zpracování filmu pro tuto kameru. 

G.5

G.5 ✧ Klepnìte na ikonu kamery.

Zobrazí se fronta kamery. 
 

G.5

G.5 ✧ Klepnutím na tlaèítko Change Camera otevøete dialogové 
okno Change Camera.

✧ V seznamu vyberte jinou kameru.

✧ Zavøete okno Change Camera.

Fronta kamery je pøesmìrována do jiné kamery. Pøesmìrovaná 
fronta bude oznaèena údajem „redirect” v záhlaví dialogového 
okna. 

G.5

Všechny úlohy zpracování filmu, jejichž velikost filmu cílová 
kamera nepodporuje, zùstanou ve frontì pùvodní kamery. 
Tìmto úlohám je pøiøazen stav „queued”, avšak neblokují 
následující filmové úlohy, takže tyto úlohy lze pøesmìrovat do 
jiné kamery. 
Tyto filmové úlohy mùžete odeslat znovu po opravì chyby nebo 
je mùžete pøesmìrovat do kamery, která podporuje požadované 
formáty filmu. G.5
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Exponování na film Kontrola úloh zpracování filmu
Jakmile bude vadná kamera znovu opravena, mùžete 
pøesmìrování na jinou kameru zrušit. G.5

G.5 ✧ Kliknìte na ikonu kamery s údajem „redirect”. Zobrazí se 
pøesmìrovaná fronta. 
 
 

G.5 ✧ Kliknìte na tlaèítko Change Camera, abyste znovu vyvolali 
dialogové okno Change Camera. 
 
 

G.5 ✧ V oknì Change Camera klepnìte na tlaèítko Default.

Fronta je nyní znovu pøiøazena pùvodní kameøe. Oznaèení 
pùvodního zaøízení se znovu zobrazí v záhlaví dialogového okna 
Film Task Status. 
 
 

G.5

Opìtovné aktivování fronty 
po restartu systému G.5

Nìkdy je nutné vypnout systém døíve, než se provedou všechny 
úlohy zpracování filmu ve frontì. G.5

Tento zásah frontu nevymaže. Po restartování systému se úlohy 
zpracování filmu zobrazí znovu v pùvodním stavu. G.5

Úlohy se potom zahájí automaticky. G.5
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Kontrola úloh zpracování filmu Exponování na film
G.5–14 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

G.6

Konfigurace exponování 
na film G.6
Filmování a tisk snímkù mùžete zcela pøizpùsobit vašim 
požadavkùm. G.6

 syngo - Configuration Panel obsahuje dvì konfiguraèní okna 
pro nastavení funkce exponování na film: G.6

G.6 V konfiguraèním oknì Filming Layout mùžete pøizpùsobit 
standardní rozvržení a vytvoøit nová rozvržení, která budou 
pøizpùsobena jednotlivým studiím. 
 
 

G.6

G.6 V konfiguraèním oknì Filming Study Layout mùžete pøiøazovat 
specifická rozvržení jednotlivým studiím. 
 
 

G.6

✧ Vyvolejte okno syngo - Configuration Panel 
(Options > Configuration... v hlavní nabídce).

✧ Otevøete konfiguraèní okno, ve kterém chcete provádìt 
nastavení. 

➭ V èásti Základy v této pøíruèce si mùžete pøeèíst informace o 
tom, jak otevírat a zavírat konfiguraèní okna, ukládat zmìny 
nebo obnovovat nastavení od výrobce. 
→ Kapitola A.4, Konfigurace uživatelského rozhraní
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Konfigurace exponování na film Exponování na film
Konfigurace rozvržení filmu G.6

Mùžete mìnit a vytváøet rozvržení filmu použitím záložek úloh 
Film Task a Series v oknì Filming Layout. G.6
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Exponování na film Konfigurace exponování na film
Volba rozvržení, které chcete zmìnit G.6

V konfiguraèním oknì Filming Layout mùžete definovat 
rozvržení pro jednotlivé studie. G.6

Ve výbìrovém seznamu Layout name mùžete urèit, které 
rozvržení chcete zmìnit. 
 

G.6

Zmìna standardního 
rozvržení G.6

Standardní rozvržení se používá pro filmování a tisk, pokud 
není snímkùm pøiøazeno žádné rozvržení pro danou studii a 
pokud jste rozvržení ve virtuálním listu filmu nemìnili ruènì. G.6
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Konfigurace exponování na film Exponování na film
Definování rozvržení 
specifického pro danou 
studii G.6

Bìhem instalace systému se nainstalují i nìkterá rozvržení pro 
jednotlivé studie, která jsou pak pøiøazena jednotlivým studiím 
nebo sériím. G.6

Pro snímky se díky této funkci vždy použije vhodné rozvržení 
filmu. G.6

Vytvoøením nového rozvržení specifického pro urèitou studii a 
jeho pøiøazením k dané studii nebo zmìnou stávajícího 
rozvržení lze výchozí nastavení pøizpùsobit vlastním 
požadavkùm. 

G.6

 

✧ Zvolte rozvržení, které chcete mìnit.

Nebo G.6

✧ Zadejte nové rozvržení.

!0

G.6 G.6

Systém mùže spravovat až 100 rozvržení. Pokud se pokusíte 
vytvoøit 101. rozvržení, vypíše se chybové hlášení. 
Pak budete muset nìkteré ze stávajících rozvržení vymazat. 
→ Strana G.6–18, Vymazání rozvržení G.6
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Exponování na film Konfigurace exponování na film
Standardní rozvržení jako 
poèáteèní nastavení G.6

Pøi vytváøení nového rozvržení mùžete použít standardní 
rozvržení na kartách Film Task nebo Series a zmìnit je tak, aby 
splòovalo vaše požadavky. Takový postup se doporuèuje 
napøíklad v pøípadì, že se nové rozvržení liší pouze málo od 
standardního rozvržení na jedné nebo více kartách. G.6

G.6

G.6 ✧ Na kartì Film Task nebo Series kliknìte na tlaèítko General 
Default. 

Standardní nastavení jsou u pøepínaèù a zaškrtávacích políèek 
pøíslušných karet šedá (nedostupná). Nastavení, která jste 
zmìnili, jsou zobrazena èernì, abyste je mohli od výchozího 
nastavení odlišit. G.6
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Konfigurace exponování na film Exponování na film
Nastavení úlohy zpracování filmu G.6

Na kartì Film Task mùžete definovat všechna nastavení, která 
urèují strukturu a spouštìní úlohy zpracování filmu. G.6

✧ Je-li to nutné, klepnìte na kartu Film Task.
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Exponování na film Konfigurace exponování na film
Jeden pacient nebo více 
pacientù na jednu úlohu 
zpracování filmu G.6

G.6 ✧ Pokud chcete, aby úloha zpracování filmu obsahovala pouze 
snímky jednoho pacienta, klepnìte na možnost New film job 
by patient.

Nebo G.6

G.6 ✧ Zrušením volby New film job by patient povolíte úlohu 
zpracování filmu typu vícenásobné filmové úlohy. 
→ Strana G.1–6, Úloha zpracování více filmù 
 

Nový list filmu G.6

G.6 ✧ Pokud chcete na listech filmu povolit prázdné øádky, klepnìte 
na možnost New film sheet by.

✧ Zde zadejte, zda chcete vytvoøit nový list filmu pro každou 
studii nebo sérii.

Nebo G.6

✧ Pokud zrušíte volbu New film sheet by, prázdné øádky se na 
listu filmu nevytvoøí. 

Nový øádek na listu filmu G.6

G.6 ✧ Chcete-li na listu filmu povolit prázdná pole, klepnìte na 
možnost New row of images by.

✧ Zde zadejte, zda bude nový øádek na listu filmu zaèínat pro 
každého pacienta, každou studii nebo každou sérii.

Nebo G.6

✧ Pokud zrušíte volbu New row of images by, prázdná pole se 
na listu filmu nevytvoøí.
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Konfigurace exponování na film Exponování na film
Filmování èásteèného 
výbìru G.6

G.6 ✧ Použijte nastavovací tlaèítka pro nastavení údaje, jestli má 
být každý n–tý obraz nebo mají být všechny obrazy (n = 1) 
úlohy zpracování filmu zkopírovány na virtuální filmový list a 
tím exponovány/vytištìny. 

Poèet kopií G.6

G.6 ✧ Zadejte poèet kopií. 
 

Velikost filmu G.6

G.6 ✧ Zvolte velikost filmu ve výbìrovém seznamu Film size.

➭ Dostupné položky závisí na použitých kamerách a tiskárnách. 
 

Oddìlovací èáry mezi 
segmenty G.6

G.6 ✧ Nastavením položky Segment lines se oddìlí obrazy na 
listech filmu èarami. 
 
 

Èíslo stránky G.6 G.6

G.6 ✧ Chcete-li na výtisk pøidat èíslo stránky, zvolte možnost Page 
number on print out.
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Exponování na film Konfigurace exponování na film
Konfigurace listù filmu G.6

Na kartì Series definujete, s jakými nastaveními je filmový list 
exponován nebo vytištìn. G.6

➭ Listy filmu mùžete tisknout nebo exponovat pouze s orientací 
na výšku.

✧ Klepnìte na kartu Series.
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Konfigurace exponování na film Exponování na film
Rozdìlení listu filmu G.6

G.6 ✧ Ve výbìrovém seznamu Layout divisions definujte, kolik 
sloupcù a øádkù má filmový list mít.

Rozdìlení se zobrazí v oknì. 
 

G.6

G.6

Na výšku/na šíøku G.6

G.6 ✧ Pro exponování na film nebo tisk zvolte režim portrait nebo 
landscape.
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Exponování na film Konfigurace exponování na film
Vyplnìní listu filmu G.6

G.6 ✧ Urèete, zda mají být obrazy na listu filmu uspoøádány zleva 
doprava (horizontálnì) nebo shora dolù (vertikálnì). 
 
 

Referenèní snímek G.6

G.6 ✧ Aktivací položky Reference image zobrazíte referenèní 
obraz spojený s tímto obrazem (napø. topogram v CT) na 
požadovaném místì (Top right nebo Bottom right). 

V závislosti na modularitì snímkù se zobrazí pøedem nastavený 
referenèní snímek. Pokud se žádný referenèní obraz nezobrazí 
nebo pokud chcete zvolit jiný referenèní obraz, mùžete tak 
uèinit pøetažením myší. G.6
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Konfigurace exponování na film Exponování na film
Série s kopií na listu filmu G.6 Pøi pøenosu série na virtuální list filmu mùžete automaticky 
generovat kopii a následnì tuto kopii pøed filmováním nebo 
tiskem zpracovat. G.6

G.6 ✧ Chcete-li vytvoøit kopie série, klepnìte na položku Copy 
series.

✧ Nastavte zpùsob, jakým mají být pùvodní snímky a jejich 
kopie uspoøádány na listu filmu (možnost Interleaved nebo 
Appended).

Nebo G.6

✧ Zrušením volby Copy series deaktivujte automatické 
kopírování snímkù.

Série A: pùvodní série  
Série S: zkopírovaná série G.6

➭ Jestliže vytvoøíte úlohu zpracování filmu pøetažením myší, 
kopie série se nevytvoøí.

A1 A2 A3 A4

A5 A6 A7 A8

S1 S2 S3 S4

S5 S6 S7 S8

A1 A2 A3 A4

A5 A6 A7 A8

A1 A2

A3 A4

A5 A6

A7 S8

S1 S2

S3 S4

S5 S6

A8S7

Zkopírovaná série je pøipojena 
na konec (možnost Appended)

Zkopírovaná série je vložena  
(volba Interleaved)

Série je naètena bez kopie
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Exponování na film Konfigurace exponování na film
Velikost zobrazení G.6

G.6 ✧ Zadejte velikost pro zobrazení snímkù v segmentech:

❏ Keep visible part: Snímek se v segmentu zobrazí v 
maximální velikosti bez oøezání. Toto je výchozí nastavení. 
→ Strana G.4–9, Fit to segment

❏ Original Image : Snímek se zobrazí v pùvodní velikosti. V 
závislosti na pùvodní velikosti mùže být snímek oøezán nebo 
se v segmentu mùže zobrazit v pøíliš malé velikosti.

✧ Zadejte faktor mìøítka mezi 10 % a 1000 %, abyste definovali 
velikost obrazu ve vztahu ke skuteèné velikosti na filmovém 
listu.  
→ Strana G.4–10, Pùvodní snímek

❏ Clip document : Snímek se zvìtší tak, aby zaplnil celý 
segment. Pøekrývající se okraje jsou pøíslušnì oøezány. 
→ Strana G.4–9, Oøezání dokumentu
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Konfigurace exponování na film Exponování na film
Pøiøazení rozvržení studii nebo sériiG.6

V oknì Filming Study Layout mùžete studii pøiøadit urèité 
rozvržení. Mùže se jednat buï o rozvržení, které jste vytvoøili 
sami, nebo o rozvržení, které bylo vytvoøeno servisem 
spoleènosti Siemens bìhem konfigurace systému. G.6
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Exponování na film Konfigurace exponování na film
Pøiøazení rozvržení filmu G.6

Mùžete pøiøazovat pouze jedno specifické rozvržení každé studii 
nebo sérii. Toto rozvržení se poté automaticky použije pro 
filmování snímkù. G.6

Pokud chcete pøiøadit rozvržení, zvolte studii nebo sérii 
uloženou v systému a požadované rozvržení a potom tyto 
položky propojte. G.6

➭ Pokud studii nebo sérii bylo již pøiøazeno rozvržení jiné než 
standardní, musíte nejprve toto spojení zrušit a poté pøiøadit 
nové rozvržení specifické pro danou studii. 
→ Strana G.6–18, Zrušení pøiøazeného rozvržení

Dostupná rozvržení najdete ve výbìrovém seznamu Film 
layouts. G.6

Volba rozvržení filmu G.6 G.6

G.6 ✧ Vyberte požadované rozvržení filmu. 
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Konfigurace exponování na film Exponování na film
Volba studie nebo série G.6 V oblasti Available Studies se zobrazí seznam studií s 
pøíslušnými sériemi. G.6

G.6 ✧ Klepnìte na symbo l  - pøed názvem studie. Zobrazí se série, 
která je s ní spojena.

➭ Celé studie mùžete vybírat pouze v pøípadì, že nejsou 
rozdìleny na série. V takových pøípadech symbol  - nebo  
- pøed položkou nebude. 
 

✧ Sérii nebo studii zvolíte kliknutím na požadovanou položku. 
 

Propojení rozvržení G.6

G.6 ✧ Kliknìte na tlaèítko se šipkou dolù a pøiøaïte rozvržení 
zvolené studii nebo sérii. 
 

+

+ -
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Exponování na film Konfigurace exponování na film
Zobrazení pøiøazeného 
rozvržení G.6

Jakmile budete mít pøiøazeno specifické schéma pro urèitou 
studii, je odpovídající studie nebo série vložena do seznamu 
Studies/Series linked to selected layout. 
Zde mùžete zjistit, pro které studie nebo série je zobrazované 
schéma nastaveno. G.6

 

 

Ve sloupci Currently linked layout v oblasti Available Studies
se zobrazí informace o tom, které rozvržení je propojeno s 
danou studií. G.6
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Konfigurace exponování na film Exponování na film
Zrušení pøiøazeného rozvržení G.6

Pokud chcete pøiøadit studii nebo sérii jiné rozvržení filmu 
specifické pro danou studii, musíte nejprve zrušit staré pøiøazení 
rozvržení. G.6

✧ V seznamu Studies/Series linked to selected layout (Studie/
série náležící do vybraného schématu) vyberte pøíslušnou 
studii nebo sérii.

G.6 ✧ Kliknìte na tlaèítko se šipkou nahoru. 

Dané studii nebo sérii je nyní znovu pøiøazeno standardní 
rozvržení. Nyní mùžete pøiøadit nové rozvržení pro danou studii. 
 

G.6

Vymazání rozvržení G.6

Váš systém mùže uložit a spravovat až 100 rozvržení. Z toho 
dùvodu doporuèujeme pravidelnì mazat nepotøebná filmová 
rozvržení, abyste uvolnili místo pro nová rozvržení pro urèitou 
studii, která vytvoøíte na kartách Filming Layout. 

G.6

✧ Ve výbìrovém seznamu Film layouts zvolte rozvržení, které 
již nepoužíváte.

G.6 ✧ Klepnìte na tlaèítko Delete Layout.

Položka bude ze seznamu odstranìna. G.6

➭ Standardní rozvržení nelze vymazat.

G.6
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Camtasia
H.1 Úvod
Vytvoøení souboru AVI pomocí zaøízení pro  
záznam Camtasia ...................................................... H.1–2

Pøíklad pracovního postupu: Vytvoøte soubor AVI 
 na kartì úloh 3D ...................................................... H.1–9
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Obsah Camtasia
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KAPITOLA 0.0

H.1

 
Úvod H.1
Camtasia je samostatný softwarový nástroj, který umožòuje 
uživateli vytváøet soubory AVI z prostøedí syngo. Výsledné 
soubory AVI lze pøehrávat v systému syngo a na jiných stanicích 
se systémem Windows, pokud je nainstalován správný kodek 
TSCC (souèást softwaru Camtasia). Kodek (tscc.exe) je volnì 
distribuován spoleèností TechSmith prostøednictvím internetu 
(www.techsmith.com). H.1

Nástroj se dodává s obecnou licencí, není potøeba speciální 
uživatelská licence. H.1

Hlavní nabídka uživatelského rozhraní a nabídka prohlížeèe 
Patient Browser jsou rozšíøeny. Po aktivaci se aplikace umístí 
jako nejvrchnìjší okno. H.1

Protože Camtasia je nástroj na snímání obrazovky, neexistuje 
žádná synchronizace mezi záznamem a zobrazením syngo. 
Kvalita obrazu mùže být nedostateèná, neexistuje skuteèná 
velikost, ani operace spouštìní. H.1

H.1
Verze VE31D H.1–1 
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Úvod Camtasia
Vytvoøení souboru AVI pomocí zaøízení pro 
záznam Camtasia H.1

V hlavní nabídce otevøete Applications > Desktop > Camtasia
Recorder nebo kliknìte na ikonu na stavovém øádku. H.1

Otevøe se uživatelské rozhraní Camtasia Recorder. H.1
H.1–2 Návod k použití pro uživatele systému syngo
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Camtasia Úvod
Spuštìní záznamu H.1 Jsou tøi zpùsoby spuštìní záznamu. H.1

✧ Stisknìte èervené tlaèítko záznamu na panelu nástrojù.

Nebo H.1

✧ Zvolte Capture > Record.

Nebo H.1

✧ Stisknìte Ctrl + Shift + F9.

Bìhem záznamu je uživatelské rozhraní Camtasia skryto. H.1

H.1

Pozastavení záznamu H.1 Jsou tøi zpùsoby pozastavení záznamu. H.1

✧ Stisknìte tlaèítko pozastavení na panelu nástrojù.

Nebo H.1

✧ Zvolte Capture > Pause.

Nebo H.1

✧ Stisknìte Ctrl + Shift + F9.

H.1

Zastavení záznamu H.1 Jsou tøi zpùsoby zastavení záznamu. H.1

✧ Stisknìte èerné tlaèítko na panelu nástrojù.

Nebo H.1

✧ Zvolte Capture > Stop.

Nebo H.1

✧ Stisknìte Ctrl + Shift + F10.

H.1
Verze VE31D H.1–3 
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Úvod Camtasia
Výbìrový záznamu H.1 Záznam pouze oblasti obrazovky provedete následovnì: H.1

✧ Pomocí volby Capture > Input mùžete vybrat pøesnì oblast 
obrazovky, kterou chcete zahrnout do videa.

✧ Zvolte Capture > Input > Screen.

 

H.1–4 Návod k použití pro uživatele systému syngo
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Camtasia Úvod
Ukládání videosouboru H.1 Video se bìhem záznamu ukládá jako soubor AVI. H.1

✧ Zvolte Capture > Output > File. 

Vytvoøený soubor AVI se automaticky uloží ve vašem offline 
systému souborù. H.1
Verze VE31D H.1–5 
únor 2006
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Úvod Camtasia
Pøehrávání videosouboru H.1 Výsleky zobrazíte pomocí pøehrávaèe Camtasia Player: H.1

➭ Zastavíte-li funkci záznamu, automaticky se otevøe Camtasia 
Player.
H.1–6 Návod k použití pro uživatele systému syngo
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Camtasia Úvod
Soubory AVI mùžete otevøít pomocí Camtasia Player takto: H.1

✧ Zvolte File > Open a vyberte soubor AVI ze všech uložených 
souborù AVI.
Verze VE31D H.1–7 
únor 2006
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Úvod Camtasia
Pøidání poznámek bìhem 
záznamu H.1

Bìhem záznamù AVI mùžete k souboru, jenž zaznamenáváte, 
pøidávat rùzné poznámky. Napøíklad: H.1

❏ Pøidat datum a èas: 

Vloží èas a datum pro pøeddefinovanou dobu. H.1

❏ Pøidat popisek: 

Vytvoøí textový popisek, napø. název, a upraví jeho vzhled a 
polohu na obrazovce. H.1

❏ Vodoznaky: 

Mùže vám pomoci oznaèit vlastnictví na videosouborech, které 
zaznamenáte pomocí softwaru Camtasia. H.1

❏ Zvýraznit: 

Umožòuje vybrat statickou oblast okna nebo celé okno se 
zvýraznìným obdélníkem okolo nìj. H.1

❏ Automaticky zvýraznit: 

Tuto funkci mùžete zapnout pøed snímáním, potom bìhem 
záznamu se aplikuje zvýraznìní na oblasti oken nebo celá okna, 
pøes které projde kurzor. Zvýraznìná oblast se dynamicky mìní 
s polohou kurzoru. H.1

➭ Další informace o nástroji Camtasia lze získat kliknutím na 
tlaèítko Help.
H.1–8 Návod k použití pro uživatele systému syngo
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Camtasia Úvod
Pøíklad pracovního postupu: Vytvoøte soubor 
AVI na kartì úloh 3D H.1

Naètìte napø. datový soubor CT angiografie hlavy na kartu úloh 
3D. Potom na soubor dat použijte pøednastavení VRT. Nyní 
mùžete zaznamenat nìkteré uživatelské akce, napø. otoèení, 
zmìnu mìøítka/posun atd. H.1

✧ Otevøete Patient Browser > Applications > Desktop > 
Camtasia Recorder.

Záznamové zaøízení Camtasia je nahoøe. H.1

✧ Stisknìte Ctrl + Shift + F9. 

✧ Kliknutím myši vyberte segment zájmu na kartì 3D, který 
chcete zaznamenat.

Segment je nyní uvnitø zelených rámcù a záznam se spustí. H.1
Verze VE31D H.1–9 
únor 2006
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Úvod Camtasia
Možné akce bìhem záznamu: H.1

❏ Otoèit objekt

❏ Paralelní posun objektu

❏ Pøiblížení/oddálení/posun

✧ Po skonèení stisknìte Ctrl + Shift + F10 a záznam se zastaví.

➭ Soubor AVI najdete ve výchozím adresáøi. Cesta k tomuto 
adresáøi je podle modality a lze servisní pracovník ji mùže 
nakonfigurovat.

H.1

H.1

UPOZORNÌNÍ

Použití jiného než nakonfigurovaného adresáøe pro datové 
soubory Camtasia. H.1

Datový disk je plný a nelze provádìt další vyšetøení. 
Uživatel už nemùže soubory smazat. H.1

✧ Pro ukládání datových souborù Camtasia používejte pouze 
adresáø urèený pøi konfiguraci.
H.1–10 Návod k použití pro uživatele systému syngo
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Camtasia Úvod
H.1

H.1

H.1

H.1

H.1

UPOZORNÌNÍ

Z dùvodu snímání obrazovek nástrojem Camtasia se datový 
disk zaplní. H.1

Vyšetøení již není možné nebo vyšetøení mùže být 
pøerušeno. H.1

✧ Nástroj Camtasia používejte pouze pro krátké záznamové 
sekvence. Nepoužívejte nástroj Camtasia pro záznam 
souèasnì s poøizováním.

H.1

H.1

UPOZORNÌNÍ

Použití výsledkù ze systému Camtasia pro diagnózu nebo 
ètení. H.1

Chybná diagnóza z dùvodu nedostateèné kvality obrazu. H.1

✧ Výsledky ze systému Camtasia jsou urèeny pouze pro 
školení a komunikaci.
Verze VE31D H.1–11 
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Úvod Camtasia
H.1–12 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.1

 
Úvod J.1
Výsledkem tomografického vyšetøení je posloupnost obrazù 
pevného datového objemu. 
Zkombinováním dvourozmìrných obrazù je možné získat 
trojrozmìrné zobrazení oblasti, která je pøedmìtem zájmu. J.1

(1) Dvourozmìrné tomografické snímky
(2) Sada dat objektu

S tímto trojrozmìrným zobrazením mùžete pracovat jako s 
trojrozmìrným modelem. Mùžete napøíklad generovat nové 
snímky, vyjímat jednotlivé oblasti a použít celou øadu 
vyhodnocovacích funkcí pro urèité diagnostické problémy. J.1

Systém vám nabízí nìkolik alternativních postupù pro práci 
trojrozmìrnými obrazy. 
Po naètení obrazù na kartu úlohy 3D se rozhodnete, kterou 
metodou chcete zaèít. J.1

Na kartì úlohy 3D si pak zvolenou metodou obrazy pøipravíte 
nebo je zaènete zpracovávat jiným zpùsobem. 

J.1

(1) (2)
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Úvod 3D Evaluation
Zpùsob trojrozmìrného 
vyhodnocení J.1

Systém nabízí následující metody, jak kombinací 
dvourozmìrných snímkù dosáhnout trojrozmìrného pohledu:J.1

❏ Multiplanární rekonstrukce (MPR) se používá k umístìní øezù 
v požadované oblasti v rùzných smìrech. Výsledkem jsou 
dvourozmìrné snímky.

❏ U vyšetøení pomocí kontrastní látky a zejména u angiografie 
mùžete použít projekci maximální intenzity (MIP).

❏ Projekci minimální intenzity (MinIP) mùžete použít zejména k 
zobrazení plicní tkánì.

❏ K vyhodnocení kostního a cévního vyšetøení, které chcete 
virtuálnì trojrozmìrnì zobrazit, mùžete napøíklad použít 
metodu zobrazení se stínovaným povrchem (SSD).

❏ Technika zobrazování objektu (VRT) se používá napøíklad k 
rozlišení mezi strukturou orgánù a tkání a k barevnému 
trojrozmìrnému zobrazení kostí, tkání a orgánù.

J.1
J.1–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Úvod
Multiplanární rekonstrukce (MPR) J.1

Pomocí multiplanární rekonstrukce mùžete vypoèítat 
sekundární snímky libovolných rovin z objektu, napøíklad 
sagitální, koronální nebo jakýkoliv zakøivený pohled. J.1

Rekonstruovat mùžete jak jednotlivé snímky, tak sérii snímkù. J.1

 

(1) Transversální/axiální
(2) Koronální
(3) Paraxiální
(4) Sagitální
(5) Paraxiální
(6) Sagitální
Verze VE31D J.1–3 
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Úvod 3D Evaluation
U multiplanární rekonstrukce se dvojrozmìrné snímky vždy 
vypoèítávají z "objektu". Napøíè znázornìním se však mùžete 
rychle pohybovat pomocí trojrozmìrného nitkového køíže nebo 
myši. Tak získáte dojem, že obraz je trojrozmìrný. J.1

Minimální tlouš¤ka øezu snímku MPR je jeden voxel. Mùžete však 
vygenerovat i silnìjší øezy (MPR Thick). Støední hodnoty 
stupnice šedi jsou vypoèítány pro voxely umístìné za sebou. J.1

 

(1) Øez MPR (tlouš¤ka øezu 1 voxel)
(2) MPR Thick (tlouš¤ku øezu lze nastavit)
J.1–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Úvod
Projekce maximální intenzity (MIP) a projekce 
minimální intenzity (MinIP) J.1

Ve zvoleném pohledu pøes objekt jsou urèeny a promítnuty na 
povrch prvky objektu (tzv. voxely) s nejvyšší/nejnižší intenzitou 
bez ohledu na to, zda se v sadì nacházejí vpøedu nebo vzadu. 
Tato metoda vytváøí projekci maximální/minimální intenzity. J.1

MIP J.1 Pøi použití této metody mùžete napøíklad využít skuteènosti, že 
cévy naplnìné kopntrastní látkou se v objektu vždy zobrazují 
jako struktury s hodnotami stupnice šedi maximální intenzity. J.1

(1) Voxely na snímcích MIP
(2) Hodnota stupnice šedi maximální intenzity

Voxel s maximální intenzitou je zobrazen na snímku MIP. J.1
Verze VE31D J.1–5 
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Úvod 3D Evaluation
Nìkteré struktury, zejména kosti, zpùsobují rušení projekce. V 
místì pøekrývání kostí s cévami v projekci MIP mohou voxely 
(hustších) kostí pøekrýt voxely cév. V tomto pøípadì zredukujte 
cílový objekt pomocí objektù zájmu (VOI), až bude obsahovat k 
projekci pouze cévy. 

J.1

MinIP J.1 Pøi této metodì mùžete napøíklad využít skuteènosti, že plíce se 
v objektu vždy zobrazují jako struktury s nejménì intenzivními 
hodnotami stupnice šedi. J.1

V obrazu MinIP budou zobrazeny voxely s minimální intenzitou. 
J.1

Jestliže chcete generovat trojrozmìrný obraz, vytvoøte nìkolik 
snímkù MIP/MinIP z rùzných smìrù pohledu nebo otoète 
projekci pomocí myši èi trojrozmìrného nitkového køíže. J.1
J.1–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Úvod
MIP Thin/MinIP Thin J.1 Pøi projekci mùžete omezit objekt na dílèí oblast pøíslušné sady 
dat objektu. V typu výstupu MIP Thin a MinIP Thin urèete, jaké 
šíøky objektu použitého pro projekci by mìlo být použito. J.1

 

(1) Normální MIP nebo MinIP Thin, celý objekt
(2) MIP Thin nebo MinIP Thin, pro projekci se používá pouze 

dílèí objekt (øez)
(3) Používaná èást
Verze VE31D J.1–7 
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Úvod 3D Evaluation
Zobrazení se stínovaným povrchem (SSD) J.1

Pomocí této metody rekonstruujete povrch objektù. Tyto 
objekty se skládají z voxelù (objektových voxelù), jejichž 
stupnice šedi mají rozsah urèený dvìma mezními hodnotami, a 
sice horní a dolní mezní hodnotou stupnice šedi. Tato metoda je 
obzvláštì vhodná k zobrazování struktur kostí nebo cév po 
aplikaci kontrastní látky. J.1

 

(1) Voxely na snímku SSD
(2) Sada dat objektu nejpøednìjšího voxelu na povrchu

Nejpøednìjší voxel daného objektu, který je v urèeném rozsahu 
stupnice šedi, je zobrazen na snímku SSD. J.1
J.1–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Úvod
Smìr pohledu v reálném èase mùžete zmìnit myší nebo 
trojrozmìrným nitkovým køížem. Mùžete také generovat sérii 
pohledù z rùzných zorných úhlù. J.1

Mùžete napøíklad vyøíznout libovolné struktury, abyste 
zdùraznili zvláštì dùležité oblasti. J.1

Stupnice šedi, které se zobrazí na displeji, už nejsou mìøenými 
hodnotami. Mají pouze poskytnout dojem prostoru. J.1

Jemné rozlišení hustoty tkánì už není možné; napøíklad 
kalcifikaci cév a kontrastní látku v cévách už nelze v SSD rozlišit 
podle jejich hustoty. J.1
Verze VE31D J.1–9 
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Úvod 3D Evaluation
Technika zobrazování objektu (VRT) J.1

Technika zobrazování objektu (VRT) je zpùsob, jak vytvoøit 
barevné snímky, u nichž se dosáhne trojrozmìrného efektu 
takovými parametry jako je prùhlednost, stínování a barevný 
pøechod. J.1

Na snímku je obsažena celá sada dat objektu. Požadované 
oblasti (napøíklad kost a cévy) lze interaktivnì zdùraznit 
pøiøazením vhodných hodnot barvy a prùhlednosti. J.1

Metoda VRT vychází z myšlenky, že urèené vlastnosti zobrazení 
(barva, jas, kontrast a prùhlednost) jsou pøiøazeny k voxelùm 
sady dat objektu v závislosti na výchozí hodnotì obrazového 
bodu (hodnota HU nebo hodnota signálu MR). V praxi je rozsah 
vstupních hodnot obrazových bodù pøiøazen ke specifickým 
druhùm tkánì. J.1
J.1–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Úvod
Karta úlohy 3D J.1

Své prostorové obrazy zpracováváte na kartì úlohy 3D. J.1

Karta úlohy je dále rozdìlena do tìchto hlavních èástí: J.1

 

(1) Hlavní nabídka rozšíøená o položky pro trojrozmìrné 
zpracování

(2) Ovládací oblast pro snadné spouštìní funkcí
(3) Oblast snímku rozdìlená do ètyø segmentù
(4) Stavový øádek pro zpìtnou vazbu a chybová hlášení
Verze VE31D J.1–11 
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Úvod 3D Evaluation
3D na dvou monitorech J.1

Pro trojrozmìrné vyhodnocování nabízí možnost 3D Multi 
Monitor více informací zobrazených na dvou monitorech 
souèasnì. J.1

Na každém monitoru je zobrazena karta úlohy 3D. Primární 
monitor je hlavní monitor, který zobrazuje výchozí rozvržení, tj. 
referenèní režim s tøemi obrazy MPR. Sekundární monitor je 
interakèní monitor, který zobrazuje rùzná rozvržení podle 
operace. 
→ Kapitola J.15, Práce se dvìma monitory J.1

J.1
J.1–12 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.2

 
Pøenos obrazù do 3D J.2
K trojrozmìrnému zpracování snímkù se používají snímky z 
vyšetøení, které jsou uloženy v místní databázi systému nebo v 
archivu. J.2

Pokud je systém integrován do nemocnièní sítì, mùžete pøijímat 
data snímkù z ostatních oddìlení a pak je v systému 
vyhodnocovat. J.2

Tato data jsou pøístupná v oknì Patient Browser. V tomto oknì 
mùžete vyhledávat pacienty, studie, série nebo jednotlivé 
snímky a pøesouvat je na kartu úlohy 3D. J.2

Také mùžete pøesouvat snímky z karty úlohy Viewing na kartu 
úlohy 3D. J.2
Verze VE31D J.2–1 
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Pøenos obrazù do 3D 3D Evaluation
Zahájení vyhodnocení v 
trojrozmìrném zobrazení J.2

Trojrozmìrné zobrazení spustíte a trojrozmìrný model naètete 
ve tøech krocích: 
 

J.2

Výbìr obrazù/sérií pro 
zpracování J.2

Nejprve vyberte snímky nebo série, které chcete zobrazit 
trojrozmìrnì v prohlížeèi Patient Browser nebo na kartì úlohy 
Viewing. J.2

V tomto kroku mùžete pro trojrozmìrné zpracování zvolit více 
sérií jednoho pacienta. 
 
 

J.2

Výbìr metody 
trojrozmìrného zobrazení J.2

Poté zvolte metodu trojrozmìrného zobrazení a pøesuòte 
vybrané obrazy/série na kartu úlohy 3D. 
→ Strana E.6–14, Pøenos snímkù do trojrozmìrného zobrazení 
→ Strana C.3–7, Trojrozmìrné zpracování snímkù J.2

nebo J.2

Pøetažení snímkù myší z 
prohlížeèe Patient Browser J.2

✧ Snímky vybrané v prohlížeèi Patient Browser jako typ MPR 
pøetáhnìte myší na kartu úlohy 3D.

➭ Jestliže karta úlohy není v popøedí, mùžete snímky pøetáhnout 
též z prohlížeèe Browser na odpovídající záložku. Karta úlohy 
se pøesune do popøedí a snímky se naètou do oblasti snímkù.

Bìhem pøesunu systém zkontroluje, zda jsou zvolené snímky a 
série vhodné pro trojrozmìrné zpracování. V pøípadì potøeby 
systém zobrazí okno s hlášením upozoròujícím na 
nekonzistentnost série. J.2
J.2–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Pøenos obrazù do 3D
Výbìr obrazù pro trojrozmìrné zobrazení musí minimálnì 
splòovat následující kritéria: J.2

❏ Jestliže nejsou splnìny podmínky pro dva monitory a není k 
dispozici licence pro funkci Multi Monitor, všechny obrazy 
musí pocházet od jednoho pacienta a z jedné studie. 
→ Kapitola J.15, Práce se dvìma monitory

❏ K trojrozmìrnému zpracování musejí být naèteny alespoò 3 
snímky.

❏ Všechny obrazy musí být rovnobìžné a musí se nacházet v 
jedné ose. 

Pokud jste zvolili pouze jednu sérii, která také splòuje výše 
uvedená kritéria, snímky se pøesunou na kartu úlohy 3D a vy je 
budete moci ihned zaèít zpracovávat. J.2

Jestliže jsou podmínky pro dva monitory splnìny a jsou 
souèasnì naèteny dvì série od jednoho nebo dvou pacientù 
stejné modality, automaticky se spustí režim Compare. 
→ Strana J.15–10, Spuštìní režimu Compare J.2

V takovém pøípadì pøejdìte pøímo na 
→ Strana J.4–1, Multiplanární rekonstrukce (MPR) 
→ Strana J.5–1, Projekce maximální a minimální intenzity 
→ Strana J.6–1, Rekonstrukce povrchù (SSD) 
→ Strana J.7–1, Technika vykreslování objemu (VRT) J.2
Verze VE31D J.2–3 
únor 2006

 0.0



Pøenos obrazù do 3D 3D Evaluation
Maska viditelnosti J.2 Když je naèten datový soubor a jsou vytvoøeny masky v režimu 
VOI Punch Mode, existuje 3D Editor nebo Bone Removal, tyto 
„vedlejší masky" se automaticky slouèí do masky viditelnosti. 
Podrobné informace o nastavení maky viditelnosti viz →

StranaJ.3–47 
Další informace týkající se vedlejších masek viz  
→ Kapitola J.5, Projekce maximální a minimální intenzity 
→ Kapitola J.9, 3D Editor 
→ Kapitola J.10, 3D – odstranìní kosti 
→ StranaJ.3–47 

J.2

Pokud vyberete nìkolik sérií nebo nevhodné série, zobrazí se 
okno 3D Series List. 
→ Strana J.2–6, Seznam sérií pro 3D 
→ Strana J.15–6, Seznam sérií pro 3D J.2

J.2

Trojrozmìrné zobrazení sérií 
z okna 3D Series List J.2

Posledním krokem je volba série z okna 3D Series List a její 
pøenesení do karty úloh 3D. J.2

Na kartì úlohy 3D se zvolená série zobrazí trojrozmìrnì pomocí 
zvolené metody. Nyní mùžete zobrazení vyhodnotit. 

J.2

Kritický objem dat J.2 Když množství voxelù odeslaných do 3D pøekroèí kritický objem, 
následující režimy nejsou pøístupné: J.2

❏ Odstranìní kosti
❏ 3D Editor
❏ Virtuální endoskopie

Tlaèítka a položky nabídky pro aktivaci tìchto režimù jsou 
neaktivní a ve stavovém øádku se zobrazí hlášení „Memory 
intensive features not accessible". J.2
J.2–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Pøenos obrazù do 3D
Otevøení karty úlohy 3D J.2

Po naètení obrazù na kartu úlohy 3D se mùžete pøepnout do 
jiných úloh a poté se na kartu úlohy 3D vrátit a pokraèovat ve 
zpracovávání obrazù. 

J.2

J.2 ✧ Kliknutím na záložku karty se vrátíte na kartu úlohy 3D. 

Karta úlohy 3D se pøesune do popøedí ve stejném stavu, v jakém 
jste ji opustili. 

J.2
Verze VE31D J.2–5 
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Pøenos obrazù do 3D 3D Evaluation
Seznam sérií pro 3D J.2

Výsledky vašeho výbìru jsou zobrazeny v dialogovém oknì 3D 
Series List. J.2

Otevøení okna 3D Series 
List J.2

Okno 3D Series List mùžete otevøít také explicitnì, napøíklad 
abyste do karty funkcí 3D naèetli jinou sérii. 
→ Strana J.2–15, Další série ze seznamu sérií 3D 

J.2

✧ Zvolte položku Patient > Open Series List... v hlavní nabídce 
karty úlohy 3D.

V dialogovém oknì Progress se zobrazí tøídìní obrazù. Tøídìní 
mùžete zrušit stisknutím tlaèítka Cancel. J.2

J.2
J.2–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Pøenos obrazù do 3D
Zobrazí se dialogové okno 3D Series List. Toto okno je 
rozdìleno na následující pole: J.2

 

(1) Údaje o pacientovi
(2) Série vhodné pro trojrozmìrné zobrazení (platný seznam - 

valid)
(3) Série nevhodné pro trojrozmìrné zobrazení (neplatný 

seznam- invalid)

➭ V pøípadì práce se dvìma monitory a pokud je k dispozici 
licence, je možné naèíst dvì série z okna 3D Series List. 
→ Strana J.1–12, 3D na dvou monitorech 
→ Strana J.15–6, Seznam sérií pro 3D
Verze VE31D J.2–7 
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Pøenos obrazù do 3D 3D Evaluation
Seznam pacientù J.2 Zobrazen je pouze jeden záznam pacienta s šedým pozadím. 
Všechny položky seznamu platných a neplatných sérií, které 
patøí k tomuto pacientovi jsou také šedé.  
V pøípadì práce se dvìma monitory a je-li k dispozici licence 
Multi Monitor - viz → Strana J.15–7, Seznam pacientù. J.2

Platný seznam J.2 Podle toho, kolik sérií jste vybrali v oknì Patient Browser, mùže 
se zobrazit nìkolik položek seznamu. Vybrána a pøenesena 
mùže být pouze jedna série najednou.  
V pøípadì práce se dvìma monitory a je-li k dispozici licence 
Multi Monitor - viz → Strana J.15–7, Platný seznam. J.2

Neplatný seznam J.2 Všechny série nevhodné pro trojrozmìrnou rekonstrukci se 
zobrazí ve spodním seznamu (Invalid Series). Vedle dat série 
uvidíte také komentáø, který vám poskytne podrobnìjší dùvod 
odmítnutí. 
Práce se dvìma monitory viz → Strana J.15–7, Neplatný 
seznam. J.2

➭ Váš poèítaèový systém má pouze omezenou kapacitu pro 
uložení. Poèet snímkù pro trojrozmìrné zobrazení je tedy také 
omezen. V oknì 3D Series List najdete obrazy, které nelze 
naèíst do seznamu Invalid Series.

➭ Jestliže bylo vybráno více sérií, tlaèítko Select je 
deaktivováno. Naètení do 3D není možné. 
J.2–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Pøenos obrazù do 3D
Skrytí seznamu neplatných 
sérií J.2

Seznam Invalid Series mùžete pro zachování pøehlednosti 
dialogového okna 3D Series List skrýt. J.2

J.2 ✧ Klepnìte na zaškrtávací políèko Show invalid series list, 
odstraòte zaškrtnutí a tím danou volbu zrušte.

Obrazovka se okamžitì aktualizuje, zobrazení seznamu Valid 
Series bude vìtší. Seznam Invalid Series se již nezobrazuje. J.2

➭ Pokud žádná ze zvolených sérií není vhodná pro trojrozmìrné 
zobrazení, takže seznam Valid Series je prázdný, nelze 
seznam Invalid Series skrýt.
Verze VE31D J.2–9 
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Pøenos obrazù do 3D 3D Evaluation
Sluèování sérií J.2

Pokud jste pro trojrozmìrné zobrazení zvolili série, jejichž 
rozsahy vyšetøení se pøekrývají, mùžete v oknì 3D Series List
rozhodnout, zda chcete tyto série slouèit a vytvoøit tak pro svùj 
trojrozmìrný model jedinou sérii. Tímto zpùsobem je možné 
zvìtšit zobrazovaný objekt nebo zvýšit kvalitu zobrazení. J.2

➭ Série, které chcete slouèit, musí být poøízeny s maximálním 
odstupem 30 minut. 
 

J.2 ✧ Pokud chcete slouèit vhodné série, zvolte možnost Merge 
when possible.

Obrazovka se okamžitì aktualizuje. J.2

➭ Jestliže byl snímek CT poøízen dvakrát ve stejné poloze, 
použije se vždy poslední snímek. Jestliže byly série poøízeny 
rozdílnými snímacími metodami (sekvenèní nebo spirálovou), 
použije se vždy spirálovì poøízený snímek.

➭ Pokud byly série získány pomocí MR, systém použije v první 
polovinì rozsahu, který se pøekrývá, obrazy z první série a ve 
druhé polovinì rozsahu, který se pøekrývá, obrazy z druhé 
série. 

J.2 ✧ Pokud chcete slouèené série znovu oddìlit, zrušte volbu 
možnosti Merge when possible.
J.2–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Pøenos obrazù do 3D
Pøevzorkování J.2

Je-li naèteno velké množství dat, použije se pøevzorkování, je-li 
nakonfigurováno. Pùvodní objem se zmenší, rozlišení se sníží. J.2

V levém dolním rohu se zobrazí jako text u pøevzorkovaného 
obrazu pøíznak pro „ztrátovou kompresi" (QC). 
→ Strana J.3–9, Informace o obrazu J.2

J.2

J.2

UPOZORNÌNÍ

Jestliže jsou naèítány velké soubory dat, data obrazových bodù 
budou zredukována. J.2

Kvalita obrazu mùže být nedostateèná. J.2

✧  Buïte si vìdomi snížené kvality obrazu, je-li to oznaèeno na 
zobrazení obrazu.
Verze VE31D J.2–11 
únor 2006
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Pøenos obrazù do 3D 3D Evaluation
Pøevod sérií na kartu 3D J.2

Pokud seznam Valid Series obsahuje více sérií vhodných pro 
trojrozmìrné zobrazení, musíte rozhodnout, kterou sérii chcete 
zobrazit a vyhodnotit v trojrozmìrném zobrazení. J.2

➭ Obecnì na kartì úlohy 3D mùžete vždy vybrat a zpracovávat 
pouze jednu sérii platnou najednou. Jestliže jsou splnìny 
podmínky pro rozvržení Compare, lze vybrat a pøenést 
najednou dvì série.

✧ V seznamu Valid Series dvojitì kliknìte na sérii, kterou 
chcete zpracovat jako první.

Nebo J.2

J.2 ✧ V seznamu vyberte sérii a kliknìte na tlaèítko. 

Nebo J.2

✧ Stisknìte klávesu Return.

Série bude pøenesena na kartu úlohy 3D a dialogové okno 3D 
Series List se zavøe. 

J.2

Zavøít bez pøesunu J.2 Po pøesunu obrazù do seznamu 3D Series List mùžete zastavit 
zpracování obrazù. J.2

J.2 ✧ Kliknutím na tlaèítko Cancel zavøete dialogové okno 3D 
Series List.

Vrátíte se na kartu úlohy Viewing nebo do prohlížeèe Patient 
Browser. J.2

J.2
J.2–12 Návod k použití pro uživatele systému syngo
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3D Evaluation Pøenos obrazù do 3D
Neuložená data na kartì 
úloh 3D J.2

Chcete-li naèíst sérii do 3D a na kartì úloh 3D jsou neuložená 
data, zobrazí se dialogové okno Confirm. J.2

 

J.2 ✧ Tlaèítkem Yes potvrïte naètení nové série na kartu úlohy 3D 
bez uložení a stará série se zavøe. 
 

Nebo J.2

J.2 ✧ Pokud chcete pokraèovat ve zpracování staré série na kartì 
úlohy 3D, klepnìte na tlaèítko No.

Nový seznam se nepøesune. Zobrazí se dialogové okno 3D 
Series List, ze kterého mùžete napøíklad vybrat jiný seznam. J.2

Nebo J.2

J.2 ✧ Pøesun nové série zrušte klepnutím na tlaèítko Cancel.

Vrátíte se do prohlížeèe Patient Browser nebo na kartu úlohy 
Viewing. J.2
Verze VE31D J.2–13 
únor 2006
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Pøenos obrazù do 3D 3D Evaluation
Dlouhý výpoèet na kartì 
úloh 3D J.2

Chcete-li naèíst sérii do 3D a na kartì úloh 3D bìží dlouhý 
výpoèet, zobrazí se dialogové okno Confirm. J.2

 

J.2 ✧ Tlaèítkem Yes potvrïte zastavení výpoètu a naètení nové 
série na kartu úlohy 3D a zavøete starou sérii. 
 

Nebo J.2

J.2 ✧ Pokud chcete pokraèovat ve zpracování staré série na kartì 
úlohy 3D, klepnìte na tlaèítko No.

Nový seznam se nepøesune. Zobrazí se dialogové okno 3D 
Series List, ze kterého mùžete napøíklad vybrat jiný seznam. J.2

Nebo J.2

J.2 ✧ Pøesun nové série zrušte klepnutím na tlaèítko Cancel.

Vrátíte se do prohlížeèe Patient Browser nebo na kartu úlohy 
Viewing. J.2
J.2–14 Návod k použití pro uživatele systému syngo
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3D Evaluation Pøenos obrazù do 3D
Další série ze seznamu sérií 3D J.2

Z karty úlohy 3D se mùžete kdykoliv dostat také k dalším sériím, 
které jste pøedem vybrali ke zpracování v oknì 3D Series List. J.2

✧ Otevøete dialogové okno 3D Series List pomocí položky 
Patient > Open Series List....

✧ Klepnutím na tlaèítko Select vyberte jinou sérii a pøesuòte ji.

Po potvrzení dialogového okna se døíve naètená série zavøe. J.2

J.2
Verze VE31D J.2–15 
únor 2006

 0.0



Pøenos obrazù do 3D 3D Evaluation
J.2–16 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.3

Práce v trojrozmìrném 
zobrazení J.3
Data existují ve formì sady dat objektu. Ke generování a 
zpracovávání dvourozmìrných a trojrozmìrných obrazù máte k 
dispozici širokou øadu možností. J.3

Rùzné orientaèní pomùcky, jako napøíklad orientaèní krychle, 
vám usnadòují orientaci v objektu. Tyto pomùcky se vztahují k 
souøadnému systému pacienta a tento systém zobrazuje smìr 
pohledu nebo orientaci snímku. J.3

V objektu se mùžete pohybovat tak, abyste našli snímky 
relevantní pro diagnózu. K tomuto úèelu použijte volný pohled, 
trojrozmìrný nitkový køíž, záložky nebo natoète sadu dat 
snímku pomocí myši. J.3

Jsou vám k dispozici nástroje k vyhodnocení oblastí, mìøení 
vzdáleností, délek, úhlù a pro vyhodnocení obrazových bodù. J.3

Po vygenerování referenèního snímku mùžete rekonstruovat 
celou sérii v libovolném pohledu pomocí nastavených typù 
výstupu. J.3
Verze VE31D J.3–1 
únor 2006   
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Práce v trojrozmìrném zobrazení 3D Evaluation
Souøadný systém pacienta J.3

Orientace snímkù je urèena souøadným systémem vztaženým k 
pacientovi. Tato data urèují u každého snímku smìr, ze kterého 
se díváte na pacienta (trojrozmìrnì) a polohu øezu v oblasti 
zájmu (dvourozmìrnì). J.3
J.3–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Smìry J.3 Smìry jsou v souøadném systému pacienta popsány 
následujícím zpùsobem: J.3

 

(1) F znamená smìr od nohou k hlavì
(2) R znamená smìr zprava doleva
(3) A znamená smìr zepøedu dozadu
(4) H znamená smìr od hlavy k nohám
(5) L znamená smìr zleva doprava
(6) P znamená smìr zezadu dopøedu

Smìry se zobrazují na obrazech jako orientaèní znaèky. 
→ Strana J.3–6, Orientaèní znaèky J.3
Verze VE31D J.3–3 
únor 2006
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Práce v trojrozmìrném zobrazení 3D Evaluation
Standardní anatomické  
pohledy J.3

Pohledy podél nìkteré z os souøadného systému pacienta se 
nazývají standardní anatomické pohledy. Øezy sledované v 
tìchto pohledech vypadají takto: J.3

 

(1) Sagitální øez
(2) Transverzální øez
(3) Koronální øez

(1) (2) (3)
J.3–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Orientaèní pomùcky na snímku J.3

Pro orientaci jsou na snímku zobrazeny rùzné pomùcky. Tyto 
pomùcky ukazují smìr, ze kterého pozorujete daný snímek. J.3

Popis orientace J.3

J.3 U snímkù MR jsou zobrazeny údaje o úhlech standardních 
pohledù (sagitálního, transverzálního a koronálního). Pokud 
napøíklad nakloníte snímek z roviny transverzálního pohledu 
smìrem ke koronální rovinì, zjistíte tak úhel, o jaký jste rovinu 
natoèili. Mùžete natoèit i znázornìní v jedné rovinì. Pokud 
natoèíte snímek ve smìru jiné roviny pohledu (v tomto pøípadì 
sagitální), zobrazuje se i tento úhel natoèení vzhledem ke 
standardnímu pohledu. J.3

J.3 U obrazù CT se zobrazí úhel natoèení a náklonu ve vztahu ke 
standardním pohledùm. Tím je popsána orientace stejným 
zpùsobem jako u obrazù MR. J.3

Popis orientace je také exponován na film a ukládán. 
J.3

Orientaèní krychle 
J.3

Orientaèní krychle je zobrazována na všech snímcích. Oznaèuje 
polohu zobrazené vrstvy vzhledem k souøadnému systému 
pacienta. 
→ Strana J.3–2, Souøadný systém pacienta J.3

Tato krychle je spolu se snímky také filmována a ukládána. J.3
Verze VE31D J.3–5 
únor 2006
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Práce v trojrozmìrném zobrazení 3D Evaluation
Orientaèní znaèky J.3 Orientaèní znaèky ukazují orientaci pacienta na snímku. Jsou 
shodné se smìry v souøadném systému pacienta a nejde o 
poznámky, které byste mohli upravovat. Tento text se vždy 
zobrazuje uprostøed horního a levého okraje snímku. J.3

❏ L, R – vlevo, vpravo 
Smìr pozorování sagitální zleva nebo zprava

❏ A, P - anteriorní, posteriorní 
Smìr pozorování koronální zepøedu nebo zezadu

❏ H, F – hlava, nohy 
Smìr pozorování transverzální od hlavy nebo nohou

→ Strana J.3–28, Nastavení standardních pohledù J.3

➭ Bìhem vytváøení zakøivených øezù nebo oblastí se orientaèní 
znaèka zobrazuje v závorkách „< >”. 
→ Strana J.4–10, Zobrazování snímkù

H

R

J.3–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Trojrozmìrné zobrazení snímku J.3

Oblast snímku je na kartì úlohy 3D rozdìlena do ètyø segmentù. 
Jednotlivé segmenty mají rozdílnou funkci v závislosti na tom, v 
jakém režimu právì pracujete. J.3

Oblast snímku v referenèním režimu J.3

První tøi segmenty jsou segmenty referenèní, ètvrtý segment je 
výstupním segmentem. J.3

Referenèní segmenty J.3 Ve tøech referenèních segmentech jsou snímky nejprve 
zobrazeny v pohledech, které jsou paralelní a kolmé ke smìru 
snímání J.3

Natáèením a pøesouváním pohledù mùžete urèit polohu a 
orientaci roviny, která bude použita jako referenèní snímek k 
rekonstrukci snímkù nebo sérií. J.3

Výstupní segment J.3 Ve výstupním segmentu jsou zobrazovány snímky a série 
generované za použití rùzných nástrojù na základì referenèního 
snímku. J.3
Verze VE31D J.3–7 
únor 2006
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Práce v trojrozmìrném zobrazení 3D Evaluation
 

(1) Referenèní segment (sagitální pohled)
(2) Referenèní segment (koronální pohled)
(3) Referenèní segment (transverzální pohled)
(4) výstupní segment

J.3
J.3–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Informace o obrazu J.3

Na snímcích jsou zobrazeny údaje o pacientovi, vyšetøení a 
datech snímku. J.3

➭ Mùžete nastavit, které údaje budou na obrazu zobrazeny. 
→ Strana A.4–8, Konfigurace textu snímkù

Zobrazené údaje se na snímku vždy umís¤ují na stejné místo 
podle následujícího obrázku: J.3

 

(1) Údaje o pacientovi
(2) Orientaèní znaèky 

→ Strana J.3–6, Orientaèní znaèky
(3) Kompresní pomìr
(4) Tlouš¤ka øezu (pouze u MPR, MPR Thick, MIP Thin, 

MinIP Thin)
(5) Poznámky ke snímku
(6) Automaticky nastavené hodnoty èoèky obrazových bodù
(7) Hodnoty vyvážení
(8) Orientaèní krychle 

→ Strana J.3–5, Orientaèní krychle
(9) Popis orientace 

→ Strana J.3–5, Popis orientace
(10)Informace o nemocnici/systému

(2)

(2)

(1)

(8)

(9)

(5) (7)(6)

(10)

(3)
(4) J.3
Verze VE31D J.3–9 
únor 2006
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Práce v trojrozmìrném zobrazení 3D Evaluation
Na snímku nejsou zobrazeny následující standardní textové 
prvky: J.3

❏ Specifické parametry skenu (napø. naklonìní gantry) 
(za normálních okolností v levém dolním rohu)

❏ Mìøítko 
(u pravého okraje)

➭ To, zda budou v popisu orientace zobrazeny èi nikoli, závisí na 
konfiguraèním nastavení. 
→ Strana J.16–2, Konfigurace informací o snímku
J.3–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Nastavení pohledù v sadì dat 
objektu J.3

Trojrozmìrné zpracování snímkù umožòuje vytváøet snímky v 
libovolné orientaci a poloze v rámci sady dat objektu. 
"Pohybujete" se v objektu a mùžete jej natoèit libovolným 
smìrem. V závislosti na používané metodì máte k dispozici 
rùzné pomùcky. J.3

Nastavení referenèního snímku J.3

Po naètení snímkù na kartu úlohy 3D se mùžete pohybovat v 
trojrozmìrném modelu pomocí pomùcek na této kartì úlohy. J.3

J.3
Verze VE31D J.3–11 
únor 2006
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Práce v trojrozmìrném zobrazení 3D Evaluation
Výbìr referenèního 
obrazu J.3

V jednom ze tøí referenèních segmentù nastavte pohled, ve 
kterém chcete následnì provést trojrozmìrné vyhodnocení. 
Tento pohled se stává referenèním snímkem. J.3

✧ Klepnutím na tento segment vyberte snímek

Snímek je ohranièen tlustou èarou. V následujícím pøíkladì jde o 
levý horní segment. J.3

 

J.3–12 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Použití trojrozmìrného nitkového køíže J.3

Èáry nitkového køíže (referenèní èáry) ve standardním pohledu 
oznaèují polohu dvou rovin øezù, které jsou na sebe kolmé (èáry 
znázoròují èáry øezu). Tyto dvì roviny jsou zobrazeny v dalších 
dvou referenèních segmentech. J.3

Snímek øezu odpovídající èáøe øezu poznáte podle toho, že 
ohranièení segmentu se snímkem øezu má stejnou barvu jako 
pøíslušná èára øezu. J.3

Levý horní segment je ohranièen èervenou èarou. Poloha 
odpovídajícího snímku v sadì dat objektu je ve zbývajících dvou 
referenèních segmentech oznaèena èervenou èarou. Obdobnì 
je poloha snímku v modrém rámci oznaèena modrými èarami a 
poloha snímku v zeleném rámci je oznaèena zelenými èarami. J.3

 
 
 
 
 
 
 
 
 
 

Šipky ukazují smìr pohledu, ze kterého rovinu sledujete. J.3

Pøerušované èáry oznaèují roviny, které nejsou kolmé k 
zobrazovanému pohledu. 

J.3
Verze VE31D J.3–13 
únor 2006
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Práce v trojrozmìrném zobrazení 3D Evaluation
Pøesunutí referenèních èar J.3 Pomocí èar se mùžete pohledem v referenèních segmentech 
pohybovat libovolným smìrem. J.3

J.3 ✧ Kliknìte na referenèní linku a s pøidržením levého tlaèítka 
myši ji pøesuòte.

Nebo J.3

✧ Kliknìte na prùseèík èar a pøesuòte tak obì referenèní èáry 
souèasnì. 

Kromì toho mùžete referenèní èáry do cílové polohy pøesouvat 
skokem klepnutím myší. J.3

✧ Kliknìte na linku a potom kliknìte na cílovou pozici levým 
tlaèítkem myši.

Referenèní èára se tam okamžitì pøesune. J.3

 

J.3–14 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Nebo J.3

✧ Vyberte celý referenèní obrázek a kliknìte na cílovou pozici 
levým tlaèítkem myši (bez vybrané referenèní linky).

Obì èáry se pøesunou tak, že v místì klepnutí je nyní jejich 
prùseèík. J.3

 

Verze VE31D J.3–15 
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Práce v trojrozmìrném zobrazení 3D Evaluation
Natoèení pomocí nitkového 
køíže J.3

Natoèením pøíslušné èáry nitkového køíže v nìkterém ze dvou 
ostatních segmentù zmìníte pohled v referenèním segmentu.J.3

Nejprve umožnìte natoèení zrušením režimu Fixed Mode a 
umožnìním režimu Free Mode. J.3

J.3 ✧ Výbìrem režimu Free Mode aktivujte volný režim. 
 
 

J.3 ✧ Nyní natoète referenèní èáry kolem zobrazeného bodu 
otáèení.

Takto vytvoøíte natoèené roviny (pouze jedna referenèní èára je 
naklonìná) nebo dvojnásobnì natoèené roviny (obì referenèní 
èáry jsou naklonìné) J.3

Pokud chcete zastavit pohyb v urèitém úhlu, mùžete zrušit 
oznaèení volby Free Mode. J.3

J.3 ✧ Klepnìte na aktivní tlaèítko.
J.3–16 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Listování pomocí záložek J.3

Pokud zvolíte typ výstupu MPR, MPR Thick, MIP Thin nebo MinIP 
Thin, budou v pravých horních rozích referenèních segmentù 
zobrazeny záložky. J.3

Pomocí záložek se mùžete v objektu pøesouvat øez po øezu 
dopøedu nebo dozadu. Soubìžnì se pøesouvá i pøíslušná èára 
nitkového køíže v dalším segmentu. J.3

 

(1) Listování dozadu
(2) Listování dopøedu
Verze VE31D J.3–17 
únor 2006
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Práce v trojrozmìrném zobrazení 3D Evaluation
Posun J.3

Interaktivní obdobou záložek je posun. Objektem se mùžete 
pøesouvat øez po øezu dopøedu nebo dozadu. Souèasnì jsou 
aktualizovány i ostatní segmenty. J.3

Posun pomocí myši J.3 ✧ Klepnìte na segment, kterým chcete procházet.

✧ V hlavní nabídce spus¤te položku Orientation > Shift.

Nebo J.3

J.3 ✧ Aktivujte možnost parallel shift pomocí funkce SmartSelect 
(kliknutí pravým tlaèítkem myši). 
→ Strana J.3–39, SmartSelect  
 
 
 
 

J.3 Kurzor myši zmìní tvar. 
J.3

✧ Stisknutím tlaèítka myši a táhnutím mírnì nahoru se budete 
posunovat pomalu skrz objem. 

Kurzor myši se zmìní.  
J.3

✧ Táhnutím kurzoru myši dále nahoru se budete posunovat 
rychleji skrz objem.

Rovina obrazu se posune hloubìji do objemu a zobrazí øezy „za" 
aktuálním øezem. J.3
J.3–18 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
J.3 ✧ Táhnìte myší dolù.

Kurzor myši se zmìní. 
J.3

Rovina obrazu se posune ven z objemu a zobrazí øezy „pøed" 
aktuálním øezem. J.3

Posun pomocí klávesnice J.3 ✧ Procházejte jednotlivými snímky v sadì pomocí kláves 
Image+ nebo Image- na klávesnici.

J.3
Verze VE31D J.3–19 
únor 2006
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Práce v trojrozmìrném zobrazení 3D Evaluation
Natoèení objektu pomocí myši J.3

Natoèením zobrazení snímku v segmentu pomocí myši mùžete 
vytvoøit i natoèené nebo dvojnásobnì natoèené snímky. J.3

✧ Zvolte položku Orientation > Rotate Images.

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko v horní èásti ovládací oblasti. 
 

Nebo J.3

✧ Spus¤te funkci rotate object pomocí funkce SmartSelect.

Když umístíte kurzor myši na segment, kurzor zmìní tvar. J.3

J.3 ✧ Pohybujte kurzorem myši se stisknutým levým tlaèítkem 
myši.

❏ Pohybem myší ze støedu segmentu nahoru, dolù, doleva 
nebo doprava nakloníte snímek pøíslušným smìrem.

Když umístíte kurzor myši na hranici segmentu, kurzor zmìní 
tvar. J.3

J.3 ✧ Pohybujte kurzorem myši se stisknutým levým tlaèítkem 
myši. 

❏ Pohybem myší podél hranice segmentu otoèíte objektem v 
rovinì pøíslušným smìrem.
J.3–20 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Natoèení kolem jedné osy (naklonìné roviny 
øezu) J.3

Jestliže chcete vytvoøit naklonìné øezy, natoète øez okolo jedné
z os souøadného systému pacienta. Zaènìte u standardního 
pohledu. Abyste to mohli provést, otoète referenèní èáru. 
Pøíslušný výstupní obraz se otoèí okolo støedu. J.3

Orientace je zobrazována na snímku jako kombinace dvou 
orientaèních znaèek. Toto oznaèení je srovnatelné s oznaèením 
používaným u kompasu, napøíklad SZ jako oznaèení 
severozápadu. J.3

Jedna ze dvou referenèních èar na snímku je nyní teèkovaná. 
Odpovídající rovina je tedy vzhledem k zobrazovanému snímku 
naklonìná. J.3

Pro každý standardní pohled existují dva rùzné smìry natoèení 
(kolem osy), každý z nich je vysvìtlen graficky na následujících 
pøíkladech. J.3

➭ Na následujících pøíkladech je pacient uložen hlavou napøed 
na zádech.
Verze VE31D J.3–21 
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Práce v trojrozmìrném zobrazení 3D Evaluation
Transverzální øez J.3 Transverzální øez mùžete natoèit smìrem ke koronální nebo 
sagitální rovinì. J.3

❏ Natoèení transverzálního øezu smìrem k sagitálnímu øezu 
(vlevo)

❏ Natoèení transverzálního øezu smìrem ke koronálnímu øezu 
(vpravo)

 

V závislosti na smìru natoèení se zobrazují další kombinace 
orientaèních znaèek, napøíklad RH, LF, AH, PF. J.3

R

H

RH

Sag Tra

Kor

Sag Tra

Kor

R

F L J.3
F L J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
Sagitální øez J.3 Sagitální øez mùžete natoèit smìrem k transverzální nebo 
koronální rovinì. J.3

❏ Natoèení sagitálního øezu smìrem k transverzálnímu øezu 
(vlevo)

❏ Natoèení sagitálního øezu smìrem ke koronálnímu øezu 
(vpravo)

 

V závislosti na smìru natoèení mohou být výsledkem jiné 
kombinace orientaèních znaèek jako napøíklad AL, PR, HR nebo 
PL. J.3

ASag Tra

Kor

Sag Tra

Kor

L

H

A
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Práce v trojrozmìrném zobrazení 3D Evaluation
Koronální øez J.3 Koronální øez mùžete natoèit smìrem k transverzální nebo 
sagitální rovinì. J.3

❏ Natoèení koronálního øezu smìrem k transverzálnímu øezu 
(vlevo)

❏ Natoèení koronálního øezu smìrem k sagitálnímu øezu 
(vpravo)

 

V závislosti na smìru natoèení mohou být výsledkem jiné 
kombinace orientaèních znaèek jako napøíklad RH, HP, FA nebo 
LF. J.3

Sag Tra

Kor

Sag Tra

Kor

H
R

A

R

A

H
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3D Evaluation Práce v trojrozmìrném zobrazení
Otáèení okolo dvou os (šikmé a zkosené 
roviny øezù) J.3

Natoèením jednoho øezu postupnì okolo dvou rùzných os 
souøadného systému pacienta získáte roviny øezu naklonìné ve 
dvou osách. Rovina již potom není kolmá k žádné ose 
souøadného systému. Orientace snímku je zobrazována jako 
kombinace tøí orientaèních znaèek. J.3

 

(1) Natoèení sagitálního øezu smìrem k transverzálnímu øezu
(2) Natoèení øezu Sag/Tra smìrem ke koronálnímu
(3) Výsledný pohled

Tra

Kor

Sag
A

H

Sag Tra

Kor

A

H

(1) (2)

(3)
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Práce v trojrozmìrném zobrazení 3D Evaluation
Ovládání orientace snímku J.3

Natoèením snímku v referenèním segmentu zmìníte zorný 
úhel. Pro snadnou orientaci jsou na tìchto obrazech zobrazeny 
orientaèní znaèky. 
→ Strana J.3–6, Orientaèní znaèky J.3

Preferované smìry J.3 Pro orientaci a pøi otáèení snímku ve vybrané rovinì øezu 
používá program také následující preferované smìry: J.3

 

(1) Vsagitálním pohledu jsou snímky zobrazeny takto: pøední 
èást-hlava (pøední èást pacienta vlevo a hlava nahoøe). 
Orientaèní znaèka H je nahoøe.

(2) V transverzálním pohledu jsou snímky zobrazeny takto: 
pravá èást-pøední èást (pøední èást nahoøe, smìr pohledu 
míøí k hlavì). Orientaèní znaèka A je nahoøe.

(3) V koronálním pohledu jsou snímky zobrazeny takto: pravá 
èást-pøední èást (pøední èást, hlava nahoøe). Orientaèní 
znaèka H je nahoøe.

H

RA

A

R

H

(1) (2) (3)
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3D Evaluation Práce v trojrozmìrném zobrazení
Automatické ovládání 
orientace J.3

Pokud natáèíte a nakláníte snímek ze sagitální roviny napøíklad 
smìrem k transverzální rovinì, mùžete se nakonec dostat do 
transverzálního pohledu. Program poté natoèí obrázek o dalších 
90° tak, aby se opìt zobrazil v preferovaném smìru, 
napø.pøední èást-hlava na pravá èást-pøední èást. J.3

 

✧ V hlavní nabídce zvolte položku Orientation > Orientation 
Control a aktivujte tak ovládání orientace.

Nebo J.3

✧ Kliknìte na tlaèítko v horní èásti ovládací oblasti. 
Verze VE31D J.3–27 
únor 2006

 0.0



Práce v trojrozmìrném zobrazení 3D Evaluation
Nastavení standardních pohledù J.3

Standardní pohledy se používají jako poèáteèní bod pro 
zpracování snímkù pomocí karty úlohy 3D. J.3

Pohledy mùžete pro jednotlivé segmenty nastavit nezávisle. Pro 
každý segment mùžete urèit jiný pohled nebo pro všechny 
segmenty mùžete urèit stejný pohled. 
 

J.3

Transversální pohled J.3

J.3 V transverzálním pohledu pozorujete tomografické obrazy 
pacienta, které jsou kolmé na jeho osu (osa, která probíhá od 
hlavy k nohám pacienta). 
Váš smìr pozorování tedy je shora nebo zdola, tzn. kranio-
kaudální nebo kaudo-kraniální. 
 
 
 
 
 

J.3

J.3 ✧ Zvolte položku Orientation > Head to Feet nebo kliknìte na 
tlaèítko na kartì dílèí úlohy Orientation.

Smìr pohledu se zmìní na transverzální, kranio> kaudální, tj. 
od hlavy k nohám. J.3

Nebo J.3

J.3 ✧ Zvolte položku Orientation > Feet to Head nebo kliknìte na 
tlaèítko na kartì dílèí úlohy Orientation.

Smìr pohledu se zmìní na transverzální, kaudo > kraniální, tj. 
od nohou k hlavì. 

J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
Sagitální pohled J.3 J.3

J.3 V sagitálním pohledu vidíte pacienta ze strany (zleva nebo 
zprava). 
 
 
 
 
 
 
 
 

J.3

J.3 ✧ Zvolte položku Orientation > Left to Right nebo kliknìte na 
toto tlaèítko na kartì dílèí úlohy Orientation.

Smìr pohledu se zmìní na sagitální zleva. Vidíte pacienta z levé 
strany. J.3

Nebo J.3

J.3 ✧ Zvolte položku Orientation > Right to Left nebo kliknìte na 
toto tlaèítko na kartì dílèí úlohy Orientation.

Smìr pohledu se zmìní na sagitální zprava. Vidíte pacienta z 
pravé strany. 
 

J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
Koronální pohled J.3 J.3

J.3 V koronálním pohledu vidíte pacienta zepøedu nebo zezadu. 
 
 
 
 
 
 
 
 
 

J.3

J.3 ✧ Zvolte položku Orientation > Front to Back nebo kliknìte na 
tlaèítko na kartì dílèí úlohy Orientation.

Zorný úhel se zmìní na pøední koronální. Vidíte pacienta 
zepøedu. J.3

Nebo J.3

J.3 ✧ Zvolte položku Orientation > Back to Front nebo kliknìte na 
tlaèítko na kartì dílèí úlohy Orientation.

Zorný úhel se zmìní na zadní koronální. Vidíte pacienta zezadu. 
 
 

J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
Obnova 
standardního pohledu J.3

Standardní pohledy slouží jako orientaèní pomùcky. Z 
libovolného pohledu se mùžete vrátit ke standardnímu pohledu 
a zaèít zpracování znovu.  

J.3

✧ Pohled nastavený pøi zahájení zpracování obnovte spuštìním 
položky Orientation > Default Orientation

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko Default Orientation na kartì dílèí úlohy 
Orientation.
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Práce v trojrozmìrném zobrazení 3D Evaluation
Zafixování úhlu J.3

Jakmile jste nastavili zobrazení na urèitý zorný úhel, mùžete 
tento úhel pohledu nastavit. Po nastavení úhlu již nemùžete 
referenèní èáry natoèit, mùžete je pouze pøesouvat. J.3

✧ Zvolením položky Orientation > Free Mode (symbol 
zaškrtnutí zmizí) mùžete pøesouvat referenèní èáry pouze 
paralelnì.

Nebo J.3

J.3 ✧ Kliknutím na aktivní tlaèítko Free Mode v horní èásti ovládací 
oblasti zrušíte tuto možnost. 
 
 
 Aktivní Neaktivní
J.3–32 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Úhel mezi referenèními èarami zùstává stejný. Referenèní èáry 
nyní zobrazují standardní pohled. J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
Zobrazení kolmé na 
referenèní snímek (Ortho 
Sync) J.3

Pro zobrazení øezù podél hlavních os orgánù, napø. srdce, 
vìtšinou aktivujete ortogonální pohled. Proto tento pohled 
nejdøíve nastavte v referenèním snímku. J.3

✧ Zvolte položku Orientation > Ortho Sync.

Nebo J.3

J.3 ✧ klepnìte na tlaèítko Ortho Sync v horní èásti ovládací oblasti.
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3D Evaluation Práce v trojrozmìrném zobrazení
V ostatních referenèních segmentech jsou nyní zobrazeny 
pohledy kolmé k referenènímu obrazu. V následujícím pøíkladì 
jde o levý horní obraz. J.3

➭ Tyto snímky nemusí být kolmé k souøadnému systému 
pacienta.
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Práce v trojrozmìrném zobrazení 3D Evaluation
Výbìr objektu J.3

Chcete-li získat bližší pohled na strukturu pod viditelnýmm 
povrchem, mùžete použít výbìr objemu. 
Napøíklad, jestliže kliknete na cévu v pohledech SSD, VRT a MIP, 
ostatní segmenty zobrazí èásti této cévy. J.3

➭ Výbìr objektu je vždy aktivní.

✧ Vyberte segment a klepnìte na strukturu, kterou chcete 
vyšetøit.

Do vybraného trojrozmìrného bodu se pøesune trojrozmìrný 
nitkový køíž. J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
Zvìtšení segmentu J.3

Referenèní segmenty mùžete zvìtšit, a tak je vyhodnotit 
podrobnìji. Místo ètyø segmentù snímku se zobrazí pouze jeden 
segment pøes celou oblast snímku. J.3

Aktivace zvìtšení J.3 ✧ Zvolte položku View > Blow Up Segment

Nebo J.3

✧ poklepejte na zvolený segment.

Nyní je zobrazen jediný pohled zvoleného segmentu. J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
Na zvìtšený obraz mùžete použít tytéž funkce jako na dìlení 
2:2. 

J.3

Zrušení zvìtšení J.3 Pokud chcete obnovit normální pohled, zrušte možnost Blow 
Up. J.3

✧ Otevøete znovu položku View > Blow Up Segment v hlavní 
nabídce.

Nebo J.3

✧ Poklepejte na jediný zobrazený pohled.

➭ Zvìtšení bude automaticky zrušeno, pokud zvìtšený segment 
vyprázdníte (napø. pøi zrušení režimu VOI) nebo pokud 
zmìníte režim zobrazení, napø. pomocí funkce Fusion.
J.3–38 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
SmartSelect J.3

Funkce SmartSelect slouží k pøepínání funkcí pøímo v segmentu 
obrazu bez otevøení pøíslušných nabídek. J.3

Explicitní režim J.3 ✧ Umístìte kurzor myši do pøíslušného segmentu a pøidržte 
pravé tlaèítko myši.

J.3 Zobrazí se grafická místní nabídka J.3

✧ Pøetáhnìte kurzor myši na jednu ze ètyø položek nabídky a 
potom tlaèítko myši uvolnìte.

Nyní mùžete vybranou možnost použít obvyklým zpùsobem 
pomocí levého tlaèítka myši. 
 
 

J.3

J.3 ✧ Pøesuòte myš do støedového snímku a uvolnìte tlaèítko myši.

Rámec se zvýrazní modøe a všechny ètyøi možnosti budou 
vypnuty. 
 
 
 
 
 

J.3

Implicitní režim J.3 Pokud již ovládáte funkci SmartSelect, nemusíte otvírat místní 
nabídku. Staèí pohybovat myší požadovaným smìrem se 
stisknutým pravým tlaèítkem a tím vybrat urèitou možnost. J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
Urèení typù výstupù J.3

Typ výstupu segmentu mùžete kdykoli zmìnit, tzn. 
multiplanární rekonstrukci (MPR) na projekci maximální 
intenzity (MIP) a minimální intenzity (MinIP), na zobrazení se 
stínovaným povrchem (SSD) nebo na techniku zobrazování 
objektu (VRT). J.3

V závislosti na zpùsobu práce nejprve vygenerujete referenèní 
obraz, napøíklad v režimu MPR v požadovaném pohledu, a 
potom pøepnete do zobrazení MIP, MinIP, SSD nebo VRT. 
 

J.3

✧ Klepnìte na segment, pro který chcete zmìnit typ výstupu.

➭ Pokud chcete pøepnout všechny segmenty, musíte je vybrat a 
pøepnout samostatnì jeden po druhém.
J.3–40 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Práce v trojrozmìrném zobrazení
Nastavení MPR J.3

Multiplanární rekonstrukcí mùžete vygenerovat tomografické 
snímky v pohledu a poloze urèené v sadì dat objektu. J.3

J.3 ✧ Zvolte položku Type > MPR nebo klepnìte na tlaèítko MPR na 
kartì dílèí úlohy Type.

Nebo J.3

Pøeveïte obrazy do režimu MPR pøímo z okna Patient Browser
nebo z karty úlohy Viewing. J.3

J.3 ✧ Zvolte položku Applications > 3D > MPR nebo klepnìte na 
tlaèítko MPR.
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Práce v trojrozmìrném zobrazení 3D Evaluation
Nastavení MIP J.3

Projekce maximální intenzity (MIP) používá k rekonstrukci 
nejintenzivnìjší hodnoty stupnice šedi ze snímkù. Napøíklad pøi 
vyšetøení pomocí kontrastní látky jsou cévy struktury s 
hodnotami maximální intenzity. Tyto voxely vezme systém v 
úvahu. Zobrazení MIP je tedy velmi vhodné pro vyšetøení cév. J.3

J.3 ✧ Zvolte položku Type > MIP nebo klepnìte na tlaèítko MIP na 
kartì dílèí úlohy Type.

Typ výstupu ve zvoleném segmentu se pøepne. J.3

Nebo J.3

pøeveïte snímky do režimu MIP pøímo na kartì úlohy Patient 
Browser nebo Viewing. J.3

✧ Zvolte položku Applications > 3D > MIP.
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3D Evaluation Práce v trojrozmìrném zobrazení
Nastavení MinIP J.3

Projekce minimální intenzity (MIP) používá k rekonstrukci 
nejménì intenzivní hodnoty stupnice šedi ze snímkù. Zobrazení 
MinIP je tedy velmi vhodné pro vyšetøení plic. J.3

✧ Zvolte položku Type > MinIP.

Typ výstupu ve zvoleném segmentu se pøepne. J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
Nastavení SSD J.3

Po vygenerování referenèního obrazu mùžete vygenerovat i 
strukturu povrchu v tomto pohledu. 
→ Strana J.3–11, Nastavení referenèního snímku J.3

✧ Zvolte položku Type > SSD.

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko SSD na kartì dílèí úlohy Type.

Ve zvoleném segmentu se vygeneruje pohled na povrch. Jako 
prahové hodnoty pro extrakci povrchù systém používá výchozí 
hodnoty stupnice šedi závislé na modalitì. J.3

Nebo J.3

pøeveïte snímky do režimu SSD pøímo na kartì úlohy Patient 
Browser nebo Viewing. J.3

✧ Zvolte položku Applications > 3D > SSD.
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3D Evaluation Práce v trojrozmìrném zobrazení
Jak zmìnit parametry pro SSD viz 
→ Kapitola J.6, Rekonstrukce povrchù (SSD). J.3

V tomto oknì mùžete zadat prahové hodnoty a spustit extrakci 
SSD. J.3

→ Strana J.6–3, Rekonstrukce SSD se zmìnìnými prahovými 
hodnotami J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
Nastavení VRT J.3

Pomocí techniky zobrazování objektu (VRT) mùžete 
vygenerovat snímky v barvách, ve kterých je zobrazena celá 
sada dat objektu. Zobrazení VRT poskytuje mnoho informací o 
vyšetøované sadì dat objektu. J.3

Na kartì 3D J.3

J.3 ✧ Zvolte položku Type > VRT nebo klepnìte na tlaèítko VRT na 
kartì dílèí úlohy Type.

Ve zvoleném segmentu bude vygenerován trojrozmìrný 
snímek. Systém používá pøeddefinované sady parametrù pro 
zobrazení. J.3

➭ 3D: VRT Gallery je dodávána spolu se sérií pøednastavených 
sad parametrù. Tyto sady pøednastavených parametrù 
mùžete mìnit. 
→ Strana J.7–6, Manuální pøiøazení sady parametrù 
→ Strana J.7–13, Pokroèilý režim

Na kartì Viewing nebo 
Patient Browser J.3

Pøeveïte snímky do režimu VRT pøímo na kartì úlohy Patient 
Browser nebo Viewing. J.3

✧ Vyberte vyšetøení nebo sérii, kterou chcete upravit v 
trojrozmìrném zobrazení.

✧ Zvolte položku Applications > 3D > VRT. 
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Nastavení masky viditelnosti J.3

Jestliže byly masky již vytvoøeny pro datový soubor pomocí 
režimu VOI Punch, 3D Editor nebo Bone Removal, všechny tyto 
vedlejší masky spoleènì tvoøí masku viditelnosti. Masku 
viditelnosti lze zapnout nebo vypnout.  
→ Kapitola J.5, Projekce maximální a minimální intenzity 
→ Kapitola J.9, 3D Editor 
→ Kapitola J.10, 3D – odstranìní kosti 

J.3

✧ Zvolte položku Type > Visibility Mask.

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko Visibility Mask na kartì dílèí úlohy Type. 
 
 

Maska viditelnosti se použije, tj. obrazy se zobrazí s 
maskovanými strukturami. Text obrazu to oznaèuje klíèovým 
slovem „Manip." (manipulovaný) v levé horní èásti. J.3

➭ Neexistují-li žádné vedlejší masky, tlaèítko Visibility Mask je 
neaktivní.
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Karta úlohy 3D se smíšenými typy výstupu J.3

Pro referenèní segmenty mùžete nezávisle na sobì zvolit tøi typy 
výstupu. J.3

 

(1) Snímek MPR
(2) Obraz VRT
(3) Snímek MIP
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Volný pohled J.3

Ve volném pohledu mùžete pomocí rovin zábìru a 
trojrozmìrného výøezu oddìlit èást sady dat objektu a tak skrýt 
oblast, kterou nepotøebujete zobrazit. Je možné pøepínat mezi 
filtry VRT, MIP, (MinIP), SSD. J.3

Otevøení volného pohledu J.3 Volný pohled mùžete otevøít z hlavní nabídky nebo klepnutím 
na ikonu na kartì dílèí úlohy. J.3

✧ Z hlavní nabídky zvolte položku Settings > Free View.

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko Free View na kartì dílèí úlohy Settings. 
 

Nebo J.3

✧ Vyberte obrazy v oknì Patient Browser a otevøete 
Applications > 3D > VRT, abyste je naèetli do volného 
pohledu.

V pravém dolním segmentu se zobrazí objekt ve volném 
pohledu. J.3
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(1) Referenèní segmenty (MPR)

(2) Segment volného pohledu (VRT)
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Grafika J.3 Jako orientaèní pomùcku pøi natáèení objektu a zmìnì roviny 
zábìru mùžete použít pomocné èáry. J.3

Trojrozmìrný výøez pokrývá celý zobrazený objekt, roviny 
zábìru oznaèují polohu urèených protnutých rovin. J.3

(1) Trojrozmìrný výøez
(2) Rovina zábìru
(3) Tlaèítko roviny zábìru desky

J.3
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Bìžné operace v segmentu volného pohleduJ.3

Objekt zobrazený v segmentu volného pohledu mùžete natáèet, 
posouvat a zvìtšovat. J.3

Natoèení objektu J.3 J.3

J.3 ✧ V ovládací oblasti na kartì 3D kliknìte na tlaèítko Rotate 
Images. 

Nebo J.3

J.3 ✧ Aktivujte možnost rotate object pomocí funkce SmartSelect. 
 
 
 
 
 

Nebo J.3

✧ Z hlavní nabídky zvolte položku Orientation > Rotate 
Images.

Zvìtšení a posun J.3

J.3 ✧ Kliknìte na tlaèítko Zoom/Pan v ovládací oblasti na kartì 3D. 
 

Nebo J.3

✧ Aktivujte možnost zoom/pan pomocí funkce SmartSelect.

Nebo J.3

✧ V hlavní nabídce zvolte položku Image > Zoom/Pan.
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Operace s rovinami zábìru J.3

Mùžete mìnit polohu a vzájemnou vzdálenost rovin zábìru. J.3

Natoèení roviny zábìru J.3 ✧ V hlavní nabídce zvolte položku Orientation > Rotate Clip 
Plane.

Nebo J.3

✧ Aktivujte možnost rotate clip plane pomocí funkce 
SmartSelect. 

Posunutí roviny zábìru/
kombinovaná operace J.3

✧ V hlavní nabídce zvolte položku Orientation > Push/Pull Clip 
Plane.

Nebo J.3

✧ Aktivujte možnost push/pull clip plane pomocí funkce 
SmartSelect.

Tím budete moci provést kombinovanou operaci. Pøesunutím 
kurzoru myši zvolíte aktivní režim. J.3

✧ Pohybujte kurzorem myši se stisknutým levým tlaèítkem 
myši.

❏ Posouváním myši na vnitøní ploše roviny øezu mùžete tlaèit/
táhnout rovinu øezu.

❏ Pøesunutím myši v rovinì zábìru poblíž její hranice mùžete 
rovinný výøez natoèit.

❏ Pøesunutím myši mimo rovinu zábìru mùžete natoèit objekt.
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Definice roviny zábìru J.3 Zadáním hodnoty pro vzdálenost roviny zábìru urèíte tlouš¤ku 
zobrazeného objektu. J.3

J.3 ✧ Kliknìte na tlaèítko Free View na kartì dílèí úlohy Settings 
pravým tlaèítkem myši.

Nebo J.3

✧ Vyberte položku Settings > Clip Plane Definition....

 

✧ Zadejte vzdálenost v mm.

J.3 ✧ Zadanou vzdálenost potvrïte stisknutím tlaèítka OK. 

Nebo J.3

J.3 ✧ Kliknutím na položku Default zvolte výchozí hodnotu. 

J.3 ✧ Jestliže chcete zobrazené nastavení uložit jako novou výchozí 
hodnotu, klepnìte na položku Set as default. 

➭ Pøi naètení nové sady dat bude použita výchozí hodnota.  
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Zobrazení jedné nebo dvou 
rovin zábìru J.3

✧ Roviny zábìru aktivujete nebo deaktivujete volbou položky 
Settings > Clip Plane.

✧ Volbou položky Settings > Clip Plane Slab Mode zobrazte 
jednu nebo dvì paralelní roviny zábìru

Nebo J.3

J.3 ✧ Stiskem tlaèítka Clip Plane Slab Mode v segmentu volného 
pohledu lze pøepínat mezi jednou èi dvìmi rovinami zábìru.

 
J.3

Skrytí grafiky J.3 ✧ V hlavní nabídce zvolte položku Edit.

✧ Jestliže chcete rovinu zábìru skrýt, zvolte možnost Hide Clip 
Plane Graphics.

J.3
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Operace s clipboxem J.3

Mùžete zmìnit polohu a velikost clipboxu. 
J.3

Otevøení okna VOI Clipbox J.3 ✧ Pøístup do režimu VOI získáte zvolením položky Settings > 
VOI Clipbox.

Nebo J.3

J.3 ✧ Klepnìte na tlaèítko VOI Clipbox na kartì dílèí úlohy 
Settings.

Grafika okna zábìru se zobrazí ve výstupním segmentu. J.3

Pokud jste spustili volný pohled døíve, grafika okna zábìru se 
zobrazí jako kvádr pøekrytý pøes obraz ve volném pohledu. Jinak 
bude okno zábìru zobrazeno ve výstupním segmentu jako 
obdélník. 

J.3

Zmìna velikosti:  
Okno zábìru VOI J.3

Grafika okna zábìru je obdélník. J.3

✧ Posuòte kurzor myši nad:

(1) støed jedné hranice okna zábìru
(2) roh okna zábìru
(3) jinou oblast grafiky okna zábìru.

Tvar kurzoru se zmìní. J.3

✧ Pohybujte kurzorem myši se stisknutým levým tlaèítkem 
myši, abyste:

(1) zmìnili velikost okna zábìru v jednom smìru
(2) zmìnili velikost okna zábìru ve dvou smìrech
(3) posunuli celé okno zábìru.
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Zmìna velikosti:  
Okno zábìr VOI ve Free 
View J.3

Grafika okna zábìru je kvádr, který lze prohlížet ze všech úhlù.J.3

✧ Pøesuòte kurzor myši nad støed boèní strany okna zábìru, 
dokud nebude rám hranice okna zábìru zvýraznìn modøe. 

Tvar kurzoru se zmìní. J.3

✧ Táhnìte kurzorem myši se stisknutým levým tlaèítkem pro 
posunutí strany okna zábìru.

➭ Nelze souèasnì používat rovinu zábìru a okno zábìru.

➭ Okno zábìru nelze pøesouvat celé. 
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Mìøení v trojrozmìrném prostoru J.3

Na kartì úlohy 3D máte k dispozici nástroje k vyhodnocování 
oblasti, mìøení vzdáleností, délek a úhlù, a dále nástroje pro 
vyhodnocování obrazových bodù. J.3

Obrazy mùžete opatøit poznámkami popisujícími vyhodnocení.J.3

J.3

➭ Nìkdy se zobrazí „???", napø. pro min./max. šedé hodnoty na 
barevných obrazech VRT nebo hodnoty délky na 
perspektivních obrazech (Fly).

J.3

UPOZORNÌNÍ

Mìøení v promítnutých obrazech J.3

Možná nesprávná diagnóza J.3

✧ V pøípadì promítnutých obrazù nepoužívejte mìøení k 
diagnostickým úèelùm.
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Mìøení vzdáleností J.3

Ve snímcích mùžete mìøit vzdálenosti a úhly. J.3

S použitím distanèní èáry mùžete zmìøit vzdálenost mezi dvìma 
body na snímku. J.3

J.3

Kreslení distanèní èáry J.3 ✧ Zvolte položku Tools > 2D Distance.

Nebo J.3

J.3 ✧ kliknìte na tlaèítko 2D Distance na kartì dílèí úlohy Image. 
 
 

J.3 Kurzor myši zmìní tvar. 
J.3

✧ Umístìte kurzor myši do poèáteèního bodu distanèní èáry.

✧ Levé tlaèítko myši podržte stisknuté a natáhnìte èáru.

Jakmile pohnete myší, bude zobrazena délka doposud 
zakreslené pøímky. J.3

✧ Uvolnìním tlaèítka myši èáru zakonèíte.

Zobrazí se vzdálenost a minimální a maximální hodnota ze 
stupnice šedi. J.3
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(1) Støed 
Støed èáry

(2) Vzdálenost 
Vzdálenost mezi poèáteèním a koncovým bodem

(3) Min/Max 
Minimální/maximální hodnota stupnice šedi na pøímce

J.3
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Zmìna distanèní èáry J.3 ✧ Levým tlaèítkem myši kliknìte na distanèní èáru.

Nebo J.3

✧ Na èáru umístìte kurzor myši. 

V upravovatelných místech èáry zmìní kurzor myši tvar. 
J.3

J.3 ✧ Pøetáhnìte poèáteèní nebo koncový bod èáry do jiné polohy.

Pøi pøesouvání kurzoru myši je vzdálenost prùbìžnì 
aktualizována. 
 

J.3

Nebo J.3

J.3 ✧ Pøesuòte celou distanèní èáru na jiné místo. 
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Volnì zakreslená èára J.3 Mìøit mùžete nejen pøímou vzdálenost mezi dvìma body, ale s 
pomocí zakreslení tvaru od ruky také délku struktury, napø. 
cévy. 

J.3

✧ Zvolte položku Tools > 2D Freehand Distance. 

J.3 ✧ Kurzor myši umístìte do segmentu a levým tlaèítkem myši 
kliknìte na výchozí bod vaší èáry. 
Tvar kurzoru myši se zmìní. 

✧ Klepnìte na první bod, ve kterém má èára zmìnit smìr.

✧ Poté klepnìte na další bod atd., dokud bod po bodu 
nezakreslíte celou èáru od ruky.

✧ Poklepejte na koncový bod.

Zobrazí se délka èáry a minimální a maximální hodnota ze 
stupnice šedi. J.3

Nebo J.3

J.3 ✧ Levým tlaèítkem myši kliknìte na výchozí bod vaší èáry od 
ruky.

✧ S pøidržením stisknutého levého tlaèítka myši zakreslete 
pøíslušnou strukturu.

✧ Dvojitì kliknìte na koncový bod. 
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Po dokonèení èáry zakreslené od ruky budou zobrazeny 
následující hodnoty. J.3

 

(1) Length 
Délka èáry

(2) Min/Max  
Minimální/maximální hodnota stupnice šedi na èáøe
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Mìøení úhlù J.3

Úhel mùžete urèit pomocí dvou èar zakreslených na snímek. 
Systém poté vypoète úhel, který svírají tyto dvì zakreslené èáry, 
a to ve smìru hodinových ruèièek. Pokud je úhel vìtší než 180°, 
program odeète hodnotu 180°. J.3

 

Smìr šipky oznaèuje smìr, ve kterém jste zakreslili ramena 
úhlu. J.3

(1) Obì ramena byla zakreslena ve smìru prùseèíku. Bude 
zobrazen úhel A mezi rameny.

(2) Obì ramena byla zakreslena smìrem od prùseèíku. Bude 
zobrazen úhel A mezi rameny.

(3) Jinak bude zobrazen úhel B (A - 180).

(1) (2) (3)

A

A

A

B
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J.3 ✧ Zvolte položku Tools > Angle.

✧ Umístìte kurzor myši do poèáteèního bodu prvního ramene. 
Tvar kurzoru myši se zmìní.

✧ S pøidržením stisknutého levého tlaèítka myši vytáhnìte èáru 
ke koncovému bodu prvního ramene.

✧ Stejným zpùsobem zakreslete druhou èáru. 

Jakmile zaènete zakreslovat druhé rameno, bude vypoètena 
velikost úhlu. J.3

➭ Mìøit úhel mùžete i mezi èarami ve snímku, které se 
neprotínají. Program automaticky spoète bod prùseèíku i v 
pøípadì, že tento prùseèík není zakreslen nebo se nachází za 
hranicí snímku.
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Obìma ramenùm úhlu je pøiøazeno stejné èíslo, proto lze rùzné 
úhly jednoznaènì rozlišit. J.3
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Zmìna úhlu J.3 Ramena úhlu mùžete nezávisle mìnit. J.3

✧ Pøesuòte kurzor myši do snímku.

V místech, kde lze zmìnit rameno úhlu, se tvar kurzoru myši 
zmìní. J.3

✧ Pøesuòte celou èáru nebo pøetáhnìte koncový bod na jiné 
místo.

Velikost úhlu je prùbìžnì aktualizována. 
J.3

!0

J.3 J.3

Pokud se velikost úhlu blíží 90°, 180° èi 270°, není zøejmé, zda 
byl zadán úhel mezi rameny, nebo úhel doplòkový. J.3

➭ Pøi zobrazení doplòkového úhlu tento úhel popište.
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Zakreslení oblastí ROI J.3

Na snímcích mùžete vyznaèit anomálie a následnì tyto oblasti 
vyhodnotit. Toho docílíte zakreslením grafiky ROI kolem oblasti, 
která vás zvláštì zajímá. Nyní mùžete uvnitø této požadované 
oblasti statisticky vyhodnotit hodnoty stupnice šedi. J.3

Obdélníkové a kruhové ROI J.3 Zvláštì dùležité oblasti mùžete vymezit pomocí kruhu nebo 
obdélníku a následnì je vyhodnotit. Nejprve zvolte nástroj. J.3

✧ Zvolte položku Tools > Circle nebo Tools > Rectangle.

Kurzor myši zmìní tvar. J.3

✧ Kliknìte na obrázek a vyznaète ROI (obdélníkovou nebo 
kruhovou) se stisknutým tlaèítkem myši.

✧ Jakmile dosáhnete požadované velikosti ROI, tlaèítko myši 
uvolnìte.
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Zmìna velikosti a 
pøesouvání oblastí J.3

Pokud je obdélník nebo kruh pøíliš malý nebo naopak pøíliš velký 
nebo nebyl umístìn do správné polohy, mùžete ROI zmìnit. 
Jakmile umístíte kurzor do oblasti ROI, kurzor zmìní tvar a 
mùžete upravovat grafiku. J.3

J.3 ✧ Klepnutím na hranici oblasti ROI vyberte danou oblast.

Nebo J.3

✧ Umístìte kurzor myši na hranici oblasti ROI. 
 
 

J.3 ✧ Pomocí úchytù pro úpravu zvìtšete nebo zmenšete oblast 
tak, aby vyhovovala vašim požadavkùm.

Nebo J.3

✧ Pøesuòte oblast na snímku umístìním kurzoru na hranièní 
èáru mezi úchyty pro úpravu.

J.3 ➭ Malou kruhovou oblast ROI mùžete pøemístit jednodušeji 
stisknutím klávesy Alt.  

Tím se kurzor automaticky pøepne do režimu pøesunu. J.3

➭ U kruhových oblastí se nezobrazuje støed kružnice.

✧ Obdélník pøesunete kliknutím na jeden z jeho rohù a 
stisknutím klávesy Alt.

Nebo J.3

✧ Umístìním kurzoru na hranièní èáru.
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Kreslení oblastí zájmu od 
ruky J.3

Pokud tvar kruhu nebo obdélníku nepøesnì popisuje 
pozorovanou oblast, mùžete namísto kruhu nebo obdélníku 
zakreslit mnohoúhelník nebo oblast od ruky. Tak pøesnìji 
vymezíte oblast zájmu oblast. 

J.3

✧ Zvolte položku Tools > Freehand ROI.

Kurzor myši zmìní tvar. 
J.3

J.3 ✧ Klepnutím na snímek urèete poèáteèní bod a pøetažením 
myši zakreslete èáru k prvnímu vrcholu (bod zlomu).

✧ Zakreslete oblast bod po bodu klepnutím tlaèítkem myši pøi 
každé zmìnì smìru (definice polygonu).

✧ Jakmile poklepete na poslední vrchol, systém grafiku uzavøe. 

Nebo J.3

J.3 ✧ Klepnìte na snímek k urèení poèáteèního bodu.

✧ Podržte tlaèítko myši stisknuté a myší ohraniète vaši oblast 
zájmu.

✧ Poklepáním na koncový bod uzavøete oblast.
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Program spojí poèáteèní a koncový bod a zobrazí od ruky 
zakreslenou oblast ROI. J.3

➭ Oba druhy mùžete také kombinovat.
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Vyhodnocení ROI J.3 Po zakreslení hranice okolo oblastí pomocí kružnice, obdélníku 
nebo èáry od ruky bude zobrazeno statistické vyhodnocení 
oblasti ROI. J.3

Oblasti ROI jsou nyní oèíslovány. Pøed každým výsledkem 
vyhodnocení je zobrazeno èíslo oblasti ROI. Tím pøedejdete 
nedorozumìní. J.3

(1) Limits 
Vyhodnocený rozsah stupnice šedi. Meze jsou 
zohledòovány v pøípadì následujících vyhodnocení.

(2) Min/Max  
Nejvyšší a nejnižší hodnota stupnice šedi

(3) Mean/SD  
Støední hodnota a smìrodatná odchylka stupnic šedi

(4) Area  
Plocha oblast zájmu v cm2

(5) Pixels 
Poèet obrazových bodù v oblasti zájmu

Textový blok obsahující výsledky vyhodnocení mùžete 
pøesunout na libovolné místo ve snímku. J.3

✧ Klepnìte na textový blok a pøesuòte jej myší.

➭ Pro vyhodnocení obrazù PET nebo fúzovaných obrazù s 
podílem PET budou zobrazeny hodnoty SUV kvantitativního 
mìøení (je-li to možné).
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Vyhodnocení obrazových bodù, èoèka 
obrazových bodù J.3

Pomocí èoèky obrazových bodù mùžete zobrazit prùmìrnou 
hodnotu šedé škály (napø. Hounsfieldovy hodnoty pro snímky 
CT) v malé oblasti 5 ξ 5 obrazových bodù. J.3

✧ Zvolte položku Tools > Pixel Lens.

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko Pixel Lens na kartì dílèí úlohy Image. 
 
 

J.3 Kurzor zmìní tvar. Zobrazí se hodnota obrazového bodu v 
poloze kurzoru na obrazu. 
 
 
 

J.3

Prùbìžné zobrazování 
hodnot pixelù J.3

Hodnoty obrazových bodù, které pro vás mají zvláštní význam, 
mùžete ve snímku prùbìžnì zobrazovat. J.3

✧ Kliknìte na obrázek levým tlaèítkem myši.
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Tím je obrazový bod oznaèen; hodnota obrazového bodu se 
zobrazí vedle znaèky. J.3

➭ Mùžete pøesunout i trvale zobrazenou znaèku obrazových 
bodù tohoto typu; hodnota bude poté aktualizována.

➭ Zobrazená hodnota se vztahuje na objem 5 x 5 x 5 pixelù 
okolo vybraného bodu.
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!0

J.3 J.3

➭ Na obrazech PET èoèka obrazových bodù zobrazuje hodnoty 
SUV (je-li to možné).

J.3

Tento obrazový bod má konstantní velikost, a ta je nezávislá na 
faktoru zvìtšení snímku. J.3

J.3

UPOZORNÌNÍ

Používejte èoèku obrazových bodù na kartì Viewer a 3D. J.3

Èoèka obrazových bodù mùže zobrazovat odlišné hodnoty.J.3

✧ Uvìdomte si, že v mìøení pixelových èoèek existují rozdíly. 
Mìøení èoèek obrazových bodù na kartì Viewer uvažuje 
obdélník okolo bodu, na který kliknete, zatímco mìøení na 
kartì 3D uvažuje krychli okolo bodu, na který kliknete.
Verze VE31D J.3–75 
únor 2006

 0.0



Práce v trojrozmìrném zobrazení 3D Evaluation
Text na snímcích J.3

Zajímavé èi anomální oblasti na snímku mùžete opatøit 
poznámkami. Zadané poznámky mùžete kdykoli upravovat. J.3

Ukotvený text poznámky J.3 Mùžete zapsat text oznaèený šipkou. Se stisknutým levým 
tlaèítkem myši nakreslete šipku a poté zadejte text do vstupního 
textového pole (v koncové poloze šipky).  

J.3

✧ Zvolte položku Tools > Annotate.

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko Annotation Text na kartì dílèí úlohy 
Image. 
 

J.3 Kurzor myši zmìní tvar. 
J.3

Nebo J.3

✧ Klepnìte na požadované místo ve snímku, pøetáhnìte myš a 
uvolnìte tlaèítko myši.

Kurzor myši se zmìní na textový kurzor. 
J.3
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J.3 ✧ Nyní zadejte text.

Znak ukonèení øádku mùžete vložit stisknutím Shift + Return. J.3

✧ Potvrïte zadaný text klávesou Return.

Nebo J.3

✧ Klepnìte do oblasti snímku mimo zadaný text.

J.3 Text bude zobrazen bíle a vystínován. J.3

Velikost písma ani zarovnání textu není možné mìnit. 
J.3

Pøesunutí textu J.3 J.3

✧ Kliknìte levým tlaèítkem myši na text.

J.3 ✧ Pøetáhnìte text do nové polohy. 
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Generování série z trojrozmìrných 
snímkù J.3

Ve vìtšinì pøípadù bude výsledkem vyhodnocení v 
trojrozmìrném zobrazení rekonstrukce celé série snímkù. Toto 
provedete zvolením požadovaného pohledu v referenèním 
obrazu. 
→ Strana J.3–12, Výbìr referenèního obrazu J.3

V závislosti na používaném výstupním typu budete mít k 
dispozici tyto možnosti: J.3

❏ Series of parallel tomographic images

❏ Series of the curved ranges

❏ Radial series

❏ Expanded series
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Series of parallel 
tomographic images J.3

Pomocí této volby vygenerujete série øezù snímkù, které jsou 
navzájem rovnobìžné a pøitom kolmé k referenènímu snímku 
pro typy výstupu MPR, MPR Thick a MIP Thin, MinIP Thin, VRT 
Thin. J.3

 

(1) Sada dat objektu
(2) Referenèní snímek
(3) Paralelní tomografické snímky
(4) Objekt použitý pro projekci (MIP Thin, MinIP Thin, VRT Thin, 

MPR Thick)
(5) Smìr projekce (MIP Thin, MinIP Thin, VRT Thin, MPR Thick)
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Curved ranges J.3 Pomocí této volby vygenerujete sérii øezù snímku, které jsou 
navzájem rovnobìžné a pøitom kolmé k referenènímu snímku 
pro typy výstupu MPR, MPR Thick a MPR Thin. J.3

 

(1) Sada dat objektu
(2) Referenèní snímek
(3) Paralelní tomografické snímky

J.3
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Radial series J.3 Pro typ výstupu MPR, MPR Thick, MIP Thin, MinIP Thin a VRT Thin 
vygenerujete sérii øezù snímku uspoøádaných do tvaru hvìzdy. 
Pro výstup typu MIP, MinIP, SSD a VRT vygenerujete sérii 
projekcí a pohledù na objekt, z nichž každý je natoèen o daný 
úhel. J.3

 

(1) Sada dat objektu
(2) Referenèní snímek
(3) Radiální tomografické obrazy
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Expanded ranges J.3 Pomocí této volby vygenerujete tomografické snímky, které leží 
pøed nebo za referenèním snímkem. Také tato volba je 
dostupná pouze pro typ výstupu MPR, MPR Thick nebo MIP Thin, 
MinIP Thin, VRT Thin. J.3

 

(1) Sada dat objektu
(2) Rozsah pøed referenèním obrazem
(3) Referenèní snímek
(4) Rozsah za referenèním obrazem
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Vygenerování paralelních snímkù J.3

V sériích paralelních tomografických obrazù vygenerujete 
obrazy, které jsou navzájem rovnobìžné, mají mezi sebou 
danou vzdálenost a jsou kolmé na referenèní obraz. Toto je 
ekvivalent vyvážení referenèní èáry v trojrozmìrném nitkovém 
køíži krok za krokem. 

J.3

✧ Zvolte nepøerušovanou referenèní èáru, pomocí níž urèíte 
polohu rekonstruovaných snímkù.

➭ Zvolená referenèní èára znázoròuje obraz v jednom ze dvou 
dalších segmentù. Tento obraz musí být požadovaného 
výstupního typu, tj. MPR, MPR Thick, MIP Thin nebo MinIP 
Thin. 
→ Strana J.3–13, Použití trojrozmìrného nitkového køíže

➭ Pokud jste nezvolili žádnou nepøerušovanou referenèní èáru, 
budou použity pøednastavené hodnoty nebo naposledy 
použité nastavení. 

Otevøení 3D: Paralelní 
oblasti J.3

✧ Zvolte položku Settings > Parallel Ranges....

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko Parallel Ranges na kartì podúlohy 
Settings.

V referenèním segmentu se graficky zobrazí poloha paralelních 
tomografických snímkù. Tomografický snímek odpovídající 
zvolené referenèní èáøe (ukázka) je zobrazen ve výstupním 
segmentu. J.3
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Grafické zobrazení nové 
série J.3

Èáry ve výstupním segmentu ukazují polohu jednotlivých 
snímkù. Šipky oznaèují smìr pohledu. J.3

(1) Poèáteèní èára (oznaèená èíslem 1)
(2) Referenèní linka
(3) Koncová èára
(4) Šipky oznaèují smìr pohledu
(5) Poèet snímkù v jedné sérii
(6) Vzdálenost a tlouš¤ka

➭ Pokud série obsahuje velké množství snímkù, nebudou 
graficky znázornìny všechny èáry. Vnitøní èáry se v takovém 
pøípadì zobrazí zelenì.
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3D: Dialogové okno Parallel 
Ranges J.3

Dialogové okno 3D: Parallel Ranges se zobrazí po otevøení 
položky Settings > Parallel Ranges.... J.3

 

Naètení výchozího 
nastavení J.3

Ve vašem systému je uloženo výchozí nastavení jednotlivých 
možností generování paralelních sérií. Pøístup k tìmto 
parametrùm získáte pomocí tlaèítka výbìru Presets a spuštìním 
nastavení parametrù, které odpovídá vašim požadavkùm. J.3

➭ Pokud neexistuje nastavení parametrù použitelné pro váš 
diagnostický problém, naètìte podobné nastavení a upravte 
jej.

J.3 ✧ Z výbìrového seznamu vyberte sadu parametrù.
Verze VE31D J.3–85 
únor 2006

 0.0



Práce v trojrozmìrném zobrazení 3D Evaluation
Zmìna oblasti èíselnì J.3

J.3 ✧ Pomocí èíselníku nebo vstupního pole zadejte požadovaný 
poèet paralelních tomografických snímkù.

➭ Zadejte nejménì tøi snímky.

✧ Do vstupního pole zadejte vzdálenost mezi jednotlivými 
obrazy a volbu potvrïte klávesou Return. 

J.3 ✧ Zadejte tlouš¤ku øezu výsledného obrazu a volbu potvrïte 
klávesou Return. 
→ Strana J.4–3, Zmìna tlouš¤ky øezu (MPR Thick)

J.3 ✧ Stisknìte tlaèítko Horizontal Ranges.

Tímto zpùsobem generujete série, jejichž roviny prùseènic jsou 
vodorovné a leží ve støedu referenèního snímku. J.3

Nebo J.3

J.3 ✧ klepnìte na tlaèítko Vertical Ranges.

Tímto zpùsobem generujete série, jejichž roviny prùseènic jsou 
svislé a leží ve støedu referenèního snímku. J.3

J.3 ✧ Již vytvoøené èíslování snímkù v sérii pøevrátíte klepnutím na 
tlaèítko Swap Range Order.

Podle nastavení bude zmìnìno grafické zobrazení série v 
referenèním segmentu. Ve výstupním segmentu bude 
rekonstruován nový ukázkový snímek. J.3
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Úpravy oblasti pomocí  
myši J.3

Pøesunem poèáteèní èáry nebo koncové èáry myší mùžete také 
zvìtšit nebo zmenšit plochu pokrytou sérií snímkù. Obraz 
odpovídající èáøe, se kterou jste právì pracovali, se zobrazí ve 
výstupním segmentu. 
→ Strana J.3–84, Grafické zobrazení nové série J.3

✧ Klepnìte na poèáteèní nebo koncovou linku a pohybujte s ní, 
zatímco držíte stisknuté levé tlaèítko myši.

Poèet snímkù se zmìní pøíslušným zpùsobem (zvýší se nebo se 
sníží). Vzdálenost mezi snímky øezù zùstane stejná. J.3

Nebo J.3

J.3 ✧ Kliknìte na ikonu Constant Number of Images a posuòte 
poèáteèní nebo koncovou linku, zatímco držíte stisknuté levé 
tlaèítko myši.

Vzdálenost mezi snímky øezù se zmìní pøíslušným zpùsobem 
(zvýší se, nebo se sníží). Poèet snímkù zùstane stejný. J.3

➭ Hodnoty v dialogové okno 3D: Parallel Ranges se zmìní 
podle zmìn v grafickém zobrazení. 

J.3 ✧ Pøesuòte celý rozsah kliknutím na støed otáèení referenèní 
linky a pohybem myši se stisknutým levým tlaèítkem. 
 

J.3 ✧ Celou oblastí lze otáèet tak, že kliknete na referenèní èáru a 
pohybujete kurzorem myši se stisknutým levým tlaèítkem 
kolem bodu otáèení. 
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Start rekonstrukce J.3 Pokud všechna nastavení odpovídají vašim požadavkùm, 
mùžete spustit rekonstrukci. J.3

J.3 ✧ Klepnutím na tlaèítko Start vytvoøte sérii paralelních 
tomografických snímkù.

Zobrazí se okno s hlášením, v nìmž najdete informace o 
prùbìhu rekonstrukce. Každý snímek se okamžitì po vypoètení 
zobrazí ve výstupním segmentu. J.3

 

 

Zrušení rekonstrukce J.3 Rekonstrukci mùžete kdykoliv zrušit. J.3

J.3 ✧ Klepnìte na tlaèítko Cancel v oknì prùbìhu.

Ve výstupním segmentu budou zobrazeny všechny již 
zrekonstruované snímky. J.3

➭ Pokud je aktivní funkce auto-store, budou uloženy všechny 
dosud zrekonstruované obrazy, a to i v pøípadì, že jste kliknuli 
na tlaèítko Cancel. 
→ Strana J.16–5, Aktivace automatického ukládání
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Ukonèení 
rekonstrukce J.3

Po dokonèení rekonstrukce se ve výstupním segmentu zobrazí 
poslední snímek oblasti, tj. snímek odpovídající koncové èáøe. J.3

 

➭ Ke každému snímku v sérii bude automaticky pøiøazeno èíslo.

✧ Jestliže chcete zobrazit jiný snímek z nové série klepnìte na 
záložku v pravém horním rohu výstupního segmentu a 
listujte balíkem snímkù.
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Uložení série J.3 Pokud série odpovídá vašim požadavkùm: J.3

✧ Uložte novou sérii. 
→ Strana J.13–2, Ruèní ukládání trojrozmìrných snímkù

➭ Pokud jste bìhem konfigurace aktivovali možnost Enable 
auto-save, bude série automaticky uložena. 
→ Strana J.16–5, Aktivace automatického ukládání

➭ Jestliže jste aktivovali možnost Include the reference image 
when saving ranges or curved cuts, bude uložen i 
referenèní obraz.

Uložení sady parametrù J.3 Pokud chcete sadu parametrù v budoucnu znovu použít, 
doporuèujeme uložit ji do systému. J.3

J.3 ✧ Zadejte vhodný název a potvrïte jej stisknutím klávesy 
Return. 

J.3 ✧ Tlaèítkem Save Preset sadu parametrù uložte. 
→ Strana J.3–120, Uložení sady parametrù jako 
pøednastavených hodnot

Pøi pøíštím naètení budou pøednastavené hodnoty pøiøazeny 
sériím, které v názvu obsahují zadaný název na zaèátku. J.3

Vymazání sady parametrù J.3 Sady parametrù ve výbìrovém seznamu Presets, které již 
nepotøebujete k úpravì paralelních sérií, mùžete vymazat. J.3

J.3 ✧ Vyberte z výbìrového seznamu stávající sadu parametrù. 

J.3 ✧ Kliknutím na tlaèítko Delete Preset vymažete sadu 
parametrù.
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J.3 ✧ Pokud jste s úpravami skonèili, klepnutím na toto tlaèítko 
obnovte pùvodní režim.

Pokud jste rekonstruovanou sérii neuložili, zobrazí se následující 
dialogové okno: J.3

 

J.3 ✧ Klepnutím na tlaèítko Yes uložte sérii.

Dialogové okno 3D: Parallel Ranges se zavøe a obrazy se uloží. 
→ Strana J.13–2, Ruèní ukládání trojrozmìrných snímkù J.3

Nebo J.3

J.3 ✧ klepnutím na tlaèítko No zrušte sérii.

Dialogové okno se zavøe. J.3

Nebo J.3

J.3 ✧ klepnutím na tlaèítko Cancel pokraèujte ve zpracovávání 
série.

Dialogové okno 3D: Parallel Ranges zùstane otevøené. 
J.3
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Následné zpracování série paralelních 
snímkù J.3

Pokud obrazy rekonstruované série neodpovídají vašim 
požadavkùm, mùžete je pøizpùsobit buï graficky nebo v 
dialogovém oknì 3D: Parallel Ranges. J.3

➭ Pokud zmìnou hodnot vygenerujete novou sérii, budete 
dotázáni na uložení nebo zrušení staré série.
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Generování zakøivených oblastí J.3

V sérii paralelních tomografických obrazù vygenerujete obrazy, 
které jsou navzájem rovnobìžné a mají mezi sebou danou 
vzdálenost. 

J.3

➭ Zakreslovaná referenèní èára znázoròuje snímek v jednom ze 
dvou zbývajících referenèních segmentù. Tento snímek musí 
být požadovaného výstupního typu, tj. MPR, MPR Thick, MIP 
Thin nebo MinIP Thin.

➭ Pokud jste nezvolili žádnou nepøerušovanou referenèní èáru, 
budou použity pøednastavené hodnoty nebo naposledy 
použité nastavení.

✧ Vyberte segment. 

Otevøení 3D: Curved 
Ranges J.3

✧ Zvolte položku Settings > Curved Ranges....

Nebo J.3

J.3 ✧ Klepnìte na tlaèítko Curved Ranges na kartì dílèí úlohy 
Settings.

Kurzor myši zmìní tvar. J.3

✧ Se stisknutým levým tlaèítkem myši nakreslete referenèní 
èáru a poté dvakrát kliknìte.

Ve zvoleném referenèním segmentu se graficky zobrazí poloha 
paralelních zakøivených tomografických snímkù. Tomografický 
snímek odpovídající nakreslené referenèní èáøe je zobrazen ve 
výstupním segmentu. J.3
Verze VE31D J.3–93 
únor 2006

 0.0



Práce v trojrozmìrném zobrazení 3D Evaluation
Grafické zobrazení nové 
série J.3

Èáry oznaèují polohu jednotlivých snímkù ve vytvoøené sérii. J.3

(1) Poèáteèní èára (oznaèená èíslem 1)
(2) Referenèní linka
(3) Koncová èára
(4) Poèet snímkù v jedné sérii
(5) Vzdálenost a tlouš¤ka

➭ Pokud série obsahuje velké množství snímkù, nebudou 
graficky znázornìny všechny èáry. Vnitøní èáry se v takovém 
pøípadì zobrazí zelenì.
J.3–94 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
3D: Dialogové okno Curved 
Ranges J.3

Dialogové okno 3D: Curved Ranges se zobrazí po otevøení 
položky Settings > Curved Ranges.... J.3

 

Naètení výchozího 
nastavení J.3

Ve vašem systému je uloženo výchozí nastavení jednotlivých 
možností generování paralelních sérií. Pøístup k tìmto 
parametrùm získáte pomocí tlaèítka výbìru Presets a spuštìním 
nastavení parametrù, které odpovídá vašim požadavkùm. J.3

➭ Pokud neexistuje nastavení parametrù použitelné pro váš 
diagnostický problém, naètìte podobné nastavení a upravte 
jej.

J.3 ✧ Z výbìrového seznamu vyberte sadu parametrù.
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Práce v trojrozmìrném zobrazení 3D Evaluation
Zmìna oblasti èíselnì J.3

J.3 ✧ Pomocí èíselníku nebo vstupního pole zadejte požadovaný 
poèet paralelních tomografických snímkù.

➭ Zadejte nejménì tøi snímky.

✧ Do vstupního pole zadejte vzdálenost mezi jednotlivými 
obrazy a volbu potvrïte klávesou Return. 

J.3 ✧ Zadejte tlouš¤ku øezu výsledného obrazu a volbu potvrïte 
klávesou Return. 
→ Strana J.4–3, Zmìna tlouš¤ky øezu (MPR Thick)

J.3 ✧ Již vytvoøené èíslování snímkù v sérii pøevrátíte klepnutím na 
tlaèítko Swap Range Order.

Podle nastavení bude zmìnìno grafické zobrazení série v 
referenèním segmentu. Ve výstupním segmentu bude 
rekonstruován nový ukázkový snímek. J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
Zmìna oblasti pomocí  
myši J.3

Pøesunem poèáteèní èáry nebo koncové èáry myší mùžete také 
zvìtšit nebo zmenšit plochu pokrytou sérií snímkù. Obraz 
odpovídající èáøe, se kterou jste právì pracovali, se zobrazí ve 
výstupním segmentu. 
→ Strana J.3–84, Grafické zobrazení nové série J.3

✧ Klepnìte na poèáteèní nebo koncovou linku a pohybujte s ní, 
zatímco držíte stisknuté levé tlaèítko myši.

Poèet snímkù se zmìní pøíslušným zpùsobem (zvýší se nebo se 
sníží). Vzdálenost mezi snímky øezù zùstane stejná. J.3

Nebo J.3

J.3 ✧ Kliknìte na ikonu Constant Number of Images a posuòte 
poèáteèní nebo koncovou linku, zatímco držíte stisknuté levé 
tlaèítko myši.

Vzdálenost mezi snímky øezù se zmìní pøíslušným zpùsobem 
(zvýší se, nebo se sníží). Poèet snímkù zùstane stejný. J.3

➭ Hodnoty v dialogové okno 3D: Curved Ranges se zmìní 
podle zmìn v grafickém zobrazení. 

J.3 ✧ Pøesuòte celý rozsah kliknutím na støed otáèení referenèní 
linky a pohybem myši se stisknutým levým tlaèítkem. 
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Práce v trojrozmìrném zobrazení 3D Evaluation
Start rekonstrukce J.3 Pokud všechna nastavení odpovídají vašim požadavkùm, 
mùžete spustit rekonstrukci. J.3

J.3 ✧ Klepnutím na tlaèítko Start vytvoøte sérii paralelních 
tomografických snímkù.

Zobrazí se okno s hlášením, v nìmž najdete informace o 
prùbìhu rekonstrukce. Každý snímek se okamžitì po vypoètení 
zobrazí ve výstupním segmentu. J.3

 

 

Zrušení rekonstrukce J.3 Rekonstrukci mùžete kdykoliv zrušit. J.3

J.3 ✧ Klepnìte na tlaèítko Cancel v oknì prùbìhu.

Ve výstupním segmentu budou zobrazeny všechny již 
zrekonstruované snímky. J.3

➭ Pokud je aktivní funkce auto-save, budou uloženy všechny 
dosud zrekonstruované obrazy, a to i v pøípadì, že jste kliknuli 
na tlaèítko Cancel. 
→ Strana J.16–5, Aktivace automatického ukládání
J.3–98 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Ukonèení 
rekonstrukce J.3

Po dokonèení rekonstrukce se ve výstupním segmentu zobrazí 
poslední snímek oblasti, tj. snímek odpovídající koncové èáøe. J.3

 

➭ Ke každému snímku v sérii bude automaticky pøiøazeno èíslo.

✧ Jestliže chcete zobrazit jiný snímek z nové série klepnìte na 
záložku v pravém horním rohu výstupního segmentu a 
listujte balíkem snímkù.
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Práce v trojrozmìrném zobrazení 3D Evaluation
Uložení série J.3 Pokud série odpovídá vašim požadavkùm: J.3

✧ Uložte novou sérii. 
→ Strana J.13–2, Ruèní ukládání trojrozmìrných snímkù

➭ Pokud jste bìhem konfigurace aktivovali možnost Enable 
auto-save, bude série automaticky uložena. 
→ Strana J.16–5, Aktivace automatického ukládání

➭ Jestliže jste aktivovali možnost Include the reference image 
when saving ranges or curved cuts, bude uložen i 
referenèní obraz.

Uložení sady parametrù J.3 Pokud chcete sadu parametrù používat i v budoucnu, 
doporuèujeme uložit ji do systému. J.3

J.3 ✧ Zadejte vhodný název a potvrïte jej stisknutím klávesy 
Return. 

J.3 ✧ Kliknutím na tlaèítko Save Preset sadu parametrù uložte. 
→ Strana J.3–120, Uložení sady parametrù jako 
pøednastavených hodnot

Pøi pøíštím naètení budou pøednastavené hodnoty pøiøazeny 
sériím, které v názvu obsahují zadaný název na zaèátku. J.3

Vymazání sady parametrù J.3 Sady parametrù ve výbìrovém seznamu Presets, které již 
nepotøebujete k úpravì paralelních sérií, mùžete vymazat. J.3

J.3 ✧ Vyberte z výbìrového seznamu stávající sadu parametrù. 

J.3 ✧ Kliknutím na tlaèítko Delete Preset vymažete sadu 
parametrù.
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3D Evaluation Práce v trojrozmìrném zobrazení
J.3 ✧ Pokud jste s úpravami skonèili, klepnutím na toto tlaèítko 
obnovte pùvodní režim.

Pokud jste rekonstruovanou sérii neuložili, zobrazí se následující 
dialogové okno: J.3

 

J.3 ✧ Klepnutím na tlaèítko Yes uložte sérii.

Dialogové okno 3D: Curved Ranges se zavøe a obrazy se uloží. 
→ Strana J.13–2, Ruèní ukládání trojrozmìrných snímkù J.3

Nebo J.3

J.3 ✧ klepnutím na tlaèítko No zrušte sérii.

Dialogové okno se zavøe. J.3

Nebo J.3

J.3 ✧ klepnutím na tlaèítko Cancel pokraèujte ve zpracovávání 
série.

Dialogové okno 3D: Curved Ranges zùstane otevøené. 
J.3
Verze VE31D J.3–101 
únor 2006

 0.0



Práce v trojrozmìrném zobrazení 3D Evaluation
Následné zpracování série zakøivených 
snímkù J.3

Pokud obrazy rekonstruované série neodpovídají vašim 
požadavkùm, mùžete je pøizpùsobit buï graficky nebo v 
dialogovém oknì 3D: Curved Ranges. J.3

Sérii zakøivených obrazù mùžete následnì zpracovat stejnì jako 
sérii zakøivených øezù. 
→ Strana J.4–10, Zobrazování snímkù J.3

➭ Pokud zmìnou hodnot vygenerujete novou sérii, budete 
dotázáni na uložení nebo zrušení staré série.
J.3–102 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce v trojrozmìrném zobrazení
Generování rozšíøené oblasti J.3

Pokud chcete vygenerovat sérii snímkù umístìných pøed nebo 
za referenèním snímkem, použijte rozšíøenou oblast. Tímto 
zpùsobem simulujete listování balíkem snímkù pomocí 
záložek. J.3

Rozšíøenou oblast nemùžete urèit pomocí myši. Definovat ji 
mùžete pouze pomocí standardních hodnot v dialolgovém oknì 
3D: Expand Ranges. J.3

✧ Nejprve zvolte referenèní obraz, který obsahuje požadovaný 
pohled. 
→ Strana J.3–12, Výbìr referenèního obrazu

V tomto referenèním segmentu musí být zvolen typ výstupu 
MPR, MPR Thick, MIP Thin nebo MinIP Thin. 

J.3

✧ Spus¤te Settings > Expand Ranges.... 

Ve výstupním segmentu se zobrazí ukázka rozšíøené oblasti. V 
referenèních segmentech již nejsou zobrazeny trojrozmìrné 
nitkové køíže. J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
3D: Expand Ranges 
dialogové okno J.3

Zobrazí se dialogové okno 3D: Expand Ranges. J.3

 

J.3 ✧ Do vstupního pole zadejte tlouš¤ku øezu (to je možné pouze 
u typu MPR Thick, MIP Thin, MinIP Thin a VRT Thin) a 
potvrïte ji stisknutím klávesy Return.

✧ Ve vstupním poli zadejte vzdálenost mezi obrazy. 

J.3 ✧ Ve vstupním poli zadejte poèet obrazù, které chcete 
zrekonstruovat. 

Ve výstupním segmentu se nyní zobrazí nový referenèní obraz. 
J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
J.3 ✧ Kliknutím na tlaèítko Start zahájíte rekonstrukci. 

Ve výstupním segmentu se zobrazí snímky rozšíøené série. Tyto 
snímky jsou paralelní s referenèním snímkem. Bude zobrazen 
poslední snímek série. J.3

✧ K listování jednotlivými snímky série použijte záložky v 
pravém horním rohu výstupního segmentu.

Chcete-li zmìnit rozsah, musíte zadat nové hodnoty do 
dialogového okna 3D: Expand Ranges. 

J.3

Pokud nová série odpovídá vašim požadavkùm: J.3

✧ uložte novou sérii. 
→ Strana J.13–2, Ruèní ukládání trojrozmìrných snímkù

➭ Pokud jste bìhem konfigurace aktivovali možnost Enable 
auto-save, série bude uložena automaticky. 
→ Strana J.16–5, Aktivace automatického ukládání 
 

J.3 ✧ Klepnutím na tlaèítko Close obnovíte pùvodní režim.

Pokud série dosud neobsahuje požadované pohledy, zmìòte 
nastavení oblasti v dialogovém oknì 3D: Expand Ranges a 
proveïte rekonstrukci znovu. 
→ Strana J.3–104, 3D: Expand Ranges dialogové okno J.3
Verze VE31D J.3–105 
únor 2006

 0.0



Práce v trojrozmìrném zobrazení 3D Evaluation
Generování radiálních snímkù J.3

Generováním radiálních tomografických obrazù budete moci 
sledovat celou oblast z rùzných úhlù. Tímto zpùsobem 
simulujete natoèení referenèní èáry krok za krokem. Ze sady dat 
objektu bude podle nastaveného úhlu vygenerován urèitý poèet 
tomografických snímkù. J.3

✧ Zvolením pøerušované referenèní èáry nebo referenèního 
obrazu vygenerujte sérii, jejíž protnuté roviny pokrývají 
kvadrant v referenèním obrazu a jsou kolmé na referenèní 
obraz. 
→ Strana J.3–12, Výbìr referenèního obrazu

➭ Zvolená referenèní èára znázoròuje snímek v jednom ze dvou 
zbývajících referenèních segmentù. Tento snímek musí být v 
požadovaném výstupním typu, tj MPR, MPR Thick, MIP Thin, 
MinIP Thin or VRT Thin. Postup pøi generování série radiálních 
projekcí (MIP, MinIP, SSD, VRT) najdete v èásti: 
→ Strana J.3–116, Série radiálních projekcí a pohledù

Nebo J.3

✧ Vyberte nepøerušovanou referenèní èáru, podle níž urèíte 
polohu rekonstruovaných obrazù s referenèní èárou. 

Otevøení 3D: Radiální 
oblasti J.3

✧ Zvolte položku Settings > Radial Ranges....

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko Radial Ranges na kartì dílèí úlohy 
Settings.
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3D Evaluation Práce v trojrozmìrném zobrazení
Grafické zobrazení  
radiální série J.3

Radiální segmenty budou zobrazeny jako èáry v referenèním 
segmentu. Èáry mají spoleèný prùseèík a jsou rozmístìny s 
konstantním úhlem mezi nimi (výchozí hodnota 22,5°). J.3

Snímek odpovídající referenèní èáøe je rekonstruován a 
zobrazen ve výstupním segmentu. Podle šipek v referenèním 
segmentu mùžete zjistit smìr pohledu výsledného snímku. J.3

(1) Koncová èára
(2) Referenèní linka
(3) Poèáteèní èára (vyznaèená šipkami)
(4) Šipka udávající smìr pohledu
(5) Úhel a tlouš¤ka
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Práce v trojrozmìrném zobrazení 3D Evaluation
3D: Dialogové okno Radial 
Ranges J.3

Zobrazí se dialogové okno 3D: Radial Ranges. J.3

 

Naètení výchozího 
nastavení J.3

V systému jsou uložena výchozí nastavení paramentrù pro 
jednotlivé možnosti generování radiální série. Pøístup k tìmto 
parametrùm získáte pomocí tlaèítka výbìru Presets a spuštìním 
nastavení parametrù, které odpovídá vašim požadavkùm. J.3

➭ Pokud neexistuje nastavení parametrù použitelné pro váš 
diagnostický problém, naètìte podobné nastavení a upravte 
jej.

J.3 ✧ Z výbìrového seznamu vyberte sadu parametrù.

J.3

J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
✧ Ve vstupním poli zadejte požadovaný úhel mezi snímky a 
volbu potvrïte klávesou Return.

Poèet snímkù zùstane stejný. Pokud zadáte jiný úhel mezi 
snímky, zmìní se pøíslušným zpùsobem i poloha poèáteèní a 
koncové èáry. J.3

J.3 ✧ Pomocí èíselníku nebo vstupního pole zadejte nový poèet 
snímkù, které mají být rekonstruovány.

Poloha poèáteèní a koncové èáry se pøíslušným zpùsobem 
zmìní. J.3

J.3 ✧ Do vstupního pole zadejte tlouš¤ku øezu (to je možné pouze 
u typu MPR Thick, MIP Thin, MinIP Thin a VRT Thin) a 
potvrïte ji stisknutím klávesy Return. 

J.3 ✧ Již vytvoøené èíslování snímkù v sérii pøevrátíte klepnutím na 
tlaèítko Swap Range Order.

Podle nastavení bude zmìnìno grafické zobrazení série v 
referenèním segmentu. Ve výstupním segmentu bude 
rekonstruován nový ukázkový snímek. J.3

J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
Úpravy oblasti pomocí myšiJ.3 ✧ Klepnìte na poèáteèní nebo koncovou linku a pohybujte s ní, 
zatímco držíte stisknuté levé tlaèítko myši.

Poèet snímkù se zmìní pøíslušným zpùsobem (zvýší se nebo se 
sníží). Úhel mezi snímky øezù se zmìní, poèet snímkù zùstane 
stejný. J.3

Nebo J.3

J.3 ✧ Kliknìte na ikonu Keep Number of Images a posuòte 
poèáteèní nebo koncovou linku, zatímco držíte stisknuté levé 
tlaèítko myši.

Vzdálenost mezi snímky øezù se zmìní pøíslušným zpùsobem 
(zvýší se, nebo se sníží). Úhel mezi snímky øezù se zmìní, poèet 
snímkù zùstane stejný. J.3

➭ Hodnoty v dialogové okno 3D: Radial Ranges se zmìní podle 
zmìn v grafickém zobrazení. 

J.3 ✧ Natoète zvolenou èáru okolo bodu otáèení se stisknutým 
tlaèítkem myši.

Natoèením støední èáry natoèíte také všechny ostatní èáry 
kolem bodu otáèení. Natoèením první a poslední èáry zmìníte 
úhel výøezu. J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
Nebo J.3

J.3 ✧ Pøesuòte celý rozsah posunutím støedu otáèení se stisknutým 
tlaèítkem myši.

Snímek odpovídající èáøe, se kterou právì pracujete, se zobrazí 
ve výstupním segmentu. Hodnoty v dialogové okno 3D: Radial 
Ranges se zmìní podle zmìn provedených v grafickém 
zobrazení. J.3

➭ Pokud zmìníte rozsah natoèením poèáteèní nebo koncové 
èáry, poèet snímkù zùstane stejný. Zmìní se pouze úhel mezi 
obrazy. 
 

J.3
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Start rekonstrukce J.3 Pokud všechna nastavení odpovídají vašim požadavkùm, 
mùžete spustit rekonstrukci. J.3

J.3 ✧ Klepnutím na tlaèítko Start zahajte rekonstrukci dané oblasti.

Zobrazí se okno s hlášením, v nìmž je zobrazen prùbìh 
rekonstrukce, a umožòuje rekonstrukci zrušit. J.3

Rekonstruované snímky se zobrazí ve výstupním segmentu jako 
balík snímkù. Vrchní snímek odpovídá koncové èáøe v grafickém 
zobrazení. J.3

Pomocí záložek v pravém horním rohu obrazù mùžete listovat 
balíkem. 

J.3

Pokud radiální série odpovídá vašim požadavkùm: J.3

✧ Uložte novou sérii. 
→ Strana J.13–2, Ruèní ukládání trojrozmìrných snímkù

➭ Pokud jste bìhem konfigurace aktivovali možnost Enable 
auto-save, série bude uložena automaticky. 
→ Strana J.16–5, Aktivace automatického ukládání 
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3D Evaluation Práce v trojrozmìrném zobrazení
Uložení série J.3 Pokud série odpovídá vašim požadavkùm: J.3

✧ Uložte novou sérii. 
→ Strana J.13–2, Ruèní ukládání trojrozmìrných snímkù

➭ Pokud jste bìhem konfigurace aktivovali možnost Enable 
auto-save, bude série automaticky uložena. 
→ Strana J.16–5, Aktivace automatického ukládání

➭ Jestliže jste aktivovali možnost Include the reference image 
when saving ranges or curved cuts, bude uložen i 
referenèní obraz.

Uložení sady parametrù J.3 Pokud chcete sadu parametrù používat i v budoucnu, 
doporuèujeme uložit ji do systému. J.3

J.3 ✧ Zadejte vhodný název a potvrïte jej stisknutím klávesy 
Return. 

J.3 ✧ Tlaèítkem Save Preset sadu parametrù uložte. 
→ Strana J.3–120, Uložení sady parametrù jako 
pøednastavených hodnot

Pøi pøíštím naètení budou pøednastavené hodnoty pøiøazeny 
sériím, které v názvu obsahují zadaný název na zaèátku. J.3

Vymazání sady parametrù J.3 Sady parametrù ve výbìrovém seznamu Presets, které již 
nepotøebujete k úpravì radiálních sérií, mùžete vymazat. J.3

J.3 ✧ Vyberte z výbìrového seznamu stávající sadu parametrù. 

J.3 ✧ Kliknutím na tlaèítko Delete Preset vymažete sadu 
parametrù.

J.3

J.3
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Práce v trojrozmìrném zobrazení 3D Evaluation
J.3 ✧ Kliknutím na tlaèítko Close obnovíte pùvodní režim. 

Pokud jste rekonstruovanou sérii neuložili, zobrazí se následující 
dialogové okno: J.3

 

J.3 ✧ Klepnutím na tlaèítko Yes uložte sérii.

Dialogové okno 3D: Radial Ranges se zavøe. J.3

Nebo J.3

J.3 ✧ Klepnutím na tlaèítko No zrušte sérii.

Dialogové okno se zavøe. J.3

Nebo J.3

J.3 ✧ Klepnutím na tlaèítko Cancel pokraèujte ve zpracovávání 
série.

Dialogové okno 3D: Radial Ranges zùstane otevøené. 
J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
Následné zpracování radiálního rozsahu J.3

Natoèením poèáteèní a koncové èáry oblasti mùžete zmìnit 
rozsah a úhel mezi výslednými snímky. J.3

➭ Pokud zmìnou hodnot vygenerujete novou sérii, budete 
dotázáni na uložení nebo zrušení staré série. 
Verze VE31D J.3–115 
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Práce v trojrozmìrném zobrazení 3D Evaluation
Série radiálních projekcí a pohledù J.3

Nerekonstruujete tomografické obrazy výstupního typu MIP, 
MinIP, SSD a VRT, ale série projekcí a pohledù. 

J.3

Urèení smìru pohledu J.3 Poloha budoucích projekcí/pohledù je graficky znázornìna 
projekèními šipkami na referenèním snímku. Rekonstruované 
snímky svírají s tìmito šipkami pravý úhel. Tyto šipky tedy 
ukazují smìr, ve kterém je generována projekce. Orientaci 
tìchto šipek mùžete urèit následujícími zpùsoby: 

J.3

✧ Vyberte pøerušovanou referenèní èáru nebo referenèní 
snímek.

➭ Snímek v tomto segmentu musí být stejného výstupního 
typu.

Projekce série popisuje kvadrant v referenèním snímku. J.3
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3D Evaluation Práce v trojrozmìrném zobrazení
Nebo J.3

✧ Zvolením nepøerušované referenèní èáry v referenèním 
snímku urèíte smìr pohledu graficky.

➭ Zvolená referenèní èára znázoròuje snímek v jednom nebo v 
obou zbývajících referenèních segmentech. Tento snímek 
musí být požadovaného výstupního typu, tj MIP, MinIP, SSD 
nebo VRT.

Zvolená referenèní èára svírá pravý úhel se støední projekèní 
šipkou série trojrozmìrných snímkù. Všechny ostatní projekce 
získáte natoèením této referenèní èáry ve smìru hodinových 
ruèièek nebo proti smìru hodinových ruèièek. J.3

Nastavení radiálních 
projekcí a pohledù J.3

Mùžete vygenerovat radiální projekce v režimu radiálních 
oblastí stejným zpùsobem jako snímky radiálních øezù ve 
výstupním typu MPR, MPR Thick, MIP Thin nebo MinIP Thin. 
Snímky v této sérii simulují natoèení referenèní èáry krok za 
krokem. J.3

✧ Zvolte položku Settings > Radial Ranges....

Nebo J.3

J.3 ✧ Kliknìte na tlaèítko Radial Ranges na kartì dílèí úlohy 
Settings. 

Rozsah nové série je vyznaèen v referenèním snímku. J.3
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Šipky oznaèují smìry projekcí. J.3

(1) Bod otáèení
(2) Poèáteèní èára
(3) Úhel
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3D Evaluation Práce v trojrozmìrném zobrazení
Zobrazí se dialogové okno 3D: Radial Ranges. J.3

 

S výjimkou tlouš¤ky øezu nyní vybíráte všechna ostatní 
nastavení pro radiální série v dialogovém oknì 3D: Radial 
Ranges nebo myší v referenèním obrazu stejnì jako u 
rekonstrukce radiálních øezù. 
→ Strana J.3–106, Generování radiálních snímkù J.3
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Uložení sady parametrù jako 
pøednastavených hodnot J.3

Pro mnoho funkcí nabízí systém pøednastavené hodnoty, které 
lze upravovat. Tak uložíte èasto používané sady hodnot pod 
urèitým názvem a pozdìji je opìt mùžete snadno použít. 

J.3

Propojení pøednastavených 
hodnot J.3

Pomocí této funkce systém nabídne název na základì položky 
Series Description. J.3

J.3 ✧ Kliknutím na tlaèítko Link Preset získáte vhodný návrh 
názvu. 

Vygenerovaný název bude zvolen v upravovatelném poli. J.3

J.3 ✧ Z navrženého názvu odstraòte všechny èásti odpovídající 
pacientovi, napø. èísla sledování.

J.3 ✧ Kliknutím na tlaèítko Save Preset uložte hodnoty jako 
pøednastavené. 

Vygenerovaný název bude automaticky uložen. J.3

Od této chvíle budou všechny série stejného druhu, tzn. série se 
stejným popisem, automaticky propojeny s tìmito 
pøednastavenými hodnotami. J.3

J.3
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KAPITOLA 0.0

J.4

Multiplanární 
rekonstrukce (MPR) J.4
V multiplanární rekonstrukci mùžete vytvoøit paralelní, radiální 
a rozšíøené série nebo jednotlivé zakøivené øezy ze zvoleného 
pohledu. J.4

Multiplanární rekonstrukce se nejdøíve zobrazí v pohledech, 
které jsou rovnobìžné a kolmé ke smìru snímání. J.4

Chcete-li generovat pohledy, které jsou pro vás dùležité, 
mùžete procházet objektem pomocí funkcí karty úlohy 3D, jako 
je napø. trojrozmìrný nitkový køíž nebo myš. J.4
Verze VE31D J.4–1 
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Pøevod MPR do trojrozmìrného 
zobrazení J.4

V oknì Patient Browser nebo na kartì úlohy Viewing (nebo z 
dialogového okna 3D Series List) jste vybrali sérii obrazù k 
zobrazení v režimu MPR a potom ji pøevedli na kartu úlohy 3D. 
→ Strana J.3–41, Nastavení MPR J.4

Tato série se naète a zobrazí v režimu MPR. J.4

➭ Pokud jste již provedli naètení obrazù na kartu úlohy 3D a 
pouze jste se doèasnì pøepnuli do jiné aplikace, pøepnìte se 
zpìt na kartu 3D kliknutím na záložku karty. 
→ Strana J.2–5, Otevøení karty úlohy 3D

➭ Pokud jste dokonèili zpracování prvních trojrozmìrných sérií a 
uložili jste je, mùžete naèíst další oznaèenou sérii pøímo z okna 
Series List (Patient > Open Series List...). Pokud je poslední 
pacient ještì naètený na kartì 3D, zobrazí se dialogové okno, 
ve kterém mùžete specifikovat, zda chcete pokraèovat ve 
zpracování nebo naèíst novou sérii. 
→ Strana J.2–15, Další série ze seznamu sérií 3D
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Zmìna tlouš¤ky øezu (MPR Thick) J.4

Pomocí MPR pro tlusté øezy mùžete definovat tlouš¤ku 
pùvodního øezu, z nìhož se má snímek rekonstruovat. Program 
vypoèítá prùmìr z nìkolika hodnot stupnice šedi a použije tyto 
prùmìry pro vytvoøení obrazu. 
 

J.4

✧ Pro nastavení typu výstupu MPR Thick zvolte položku Type > 
MPR Thick.

Nebo J.4

J.4 ✧ Kliknìte na tlaèítko MPR Thick na kartì dílèí úlohy Type. 
 

✧ Zvolením Type > MPR Thickness... zobrazíte dialogové okno 
3D: MPR Thick pro nastavení tlouš¤ky øezu.

Nebo J.4

J.4 ✧ Pravým tlaèítkem myši stisknìte tlaèítko MPR Thick na kartì 
dílèí úlohy Type. 
 

Verze VE31D J.4–3 
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Multiplanární rekonstrukce (MPR) 3D Evaluation
J.4

 

✧ Zadejte tlouš¤ku obrazu (v mm). 

J.4 ✧ Zadání potvrïte stisknutím tlaèítka OK. 

Nebo J.4

J.4 ✧ Klepnutím na položku Default zvolte pøedem nastavenou 
tlouš¤ku snímku.

Zvolené nastavení se použije pro všechny rekonstrukce MPR 
Thick. J.4

➭ Hodnota pro MPR image thickness se zobrazí na snímku. 
Vždy je také pøenesena na film a uložena.

Zmìna výchozího 
nastavení J.4

J.4 ✧ Klepnutím na položku Set as default uložte novou 
pøednastavenou hodnotu tlouš¤ky snímku. 

➭ Pøi naèítání nové sady dat se použije uložená pøednastavená 
hodnota. 
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Generování sérií snímkù J.4

Pomocí funkce pro generování snímkù v libovolném intervalu a 
smìru mùžete demonstrovat vyšetøení nezávisle na smìru 
snímání. J.4

Tímto zpùsobem rekonstruované snímky mùžete uložit jako 
nové série a pøevést je napøíklad za úèelem dvourozmìrného 
vyhodnocení na kartu úlohy Viewing. J.4

J.4

J.4

UPOZORNÌNÍ

Faktor zvìtšení pro zobrazení referenèního obrázku je zvolen 
tak, aby mohl být zobrazen celý objem. Tento pøedem zvolený 
faktor zvìtšení má vliv na prostorové rozlišení pro 
rekonstrukci. Prostorové rozlišení mùže být menší, než 
prostorové rozlišení pùvodních obrázkù. J.4

Snížená kvalita obrázku (menší rozlišení) vzhledem k 
výchozí úrovni zvìtšení. J.4

✧ Pøed spuštìním výpoètu rozsahù nebo pøevzorkováním 
vycentrujte pøíslušnou oblast a zvolte vhodný faktor 
zvìtšení.
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Paralelní oblasti J.4 V tomto režimu se generují paralelní tomografické snímky ve 
vzájemnì definované vzdálenosti. Snímky jsou pak kolmé k 
referenènímu snímku. J.4

✧ Série paralelních tomografických snímkù generujte a 
zpracujte tak, jak je popsáno v následujících kapitolách:

→ Strana J.3–83, Vygenerování paralelních snímkù 
→ Strana J.3–92, Následné zpracování série paralelních snímkù 

J.4

Radiální oblasti J.4 Snímky jsou vždy uspoøádány do hvìzdice a jsou od sebe 
vzdáleny o definovaný úhel. Jsou kolmé k referenènímu 
snímku. J.4

✧ Série radiálních tomografických snímkù generujte a zpracujte 
tak, jak je popsáno v následujících kapitolách:

→ Strana J.3–106, Generování radiálních snímkù 
→ Strana J.3–115, Následné zpracování radiálního rozsahu 

J.4

Expanded ranges J.4 Rozšíøená oblast je tvoøena sérií paralelních øezù, které mají 
mezi sebou urèitou vzdálenost a jsou rovnobìžné s referenèním 
snímkem. Obvykle se tento režim používá, když chcete získat 
oblast pøed a za cílovým (referenèním) snímkem jako sérii. J.4

✧ Série rozšíøené oblasti generujte a zpracujte tak, jak je 
popsáno v následujících kapitolách:

→ Strana J.3–103, Generování rozšíøené oblasti J.4
J.4–6 Návod k použití pro uživatele systému syngo
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Generování zakøivených øezù J.4

Chcete-li si prohlížet dílèí oblasti, které nelze získat rovinnými, 
tj. plochými, snímky, mùžete volnì zakreslit øez jakéhokoli 
tvaru. Tento øez mùžete poté zobrazit ve výstupním segmentu 
jako snímek. J.4

 

(1) Pracovní segment
(2) Výstupní segment
Verze VE31D J.4–7 
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Kreslení køivek J.4

V referenèním režimu jste již generovali pohled, který je pro vás 
dùležitý. J.4

✧ Zvolte segment, který obsahuje váš referenèní snímek.

✧ Zvolte položku Settings > Curved Mode.

Nebo J.4

J.4 ✧ Aktivujte režim køivek kliknutím na tlaèítko Curved Mode na 
kartì dílèí úlohy Settings. 

Program je v režimu kreslení a kurzor zmìní tvar. J.4
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Definice mnohoúhelníku 
jako hranice øezu J.4

Zadáním nìkolika vrcholù mùžete nakreslit linii øezu. J.4

J.4 ✧ Kliknìte levým tlaèítkem myši na pracovní segment (zvolený 
segment) pro urèení poèátku hranice øezu.

✧ Další body hranice øezu definujete klepnutím levého tlaèítka 
myši v každém místì, ve kterém požadujete zmìnu smìru 
hranice øezu.

✧ Hranici øezu ukonèíte dvojitým kliknutím levým tlaèítkem 
myši. 
 

Kreslení èáry od ruky J.4 Další možností je volné kreslení tvarù. J.4

J.4 ✧ Kreslení køivky zahájíte posunutím kurzoru myši v obrázku pøi 
stisknutém levém tlaèítku myši.

✧ Ruènì zakreslenou èáru ukonèíte dvojitým kliknutím levého 
tlaèítka myši. 

J.4 U nìkterých aplikací bude možná nezbytné zkombinovat zadání 
polygonu s volným zakreslením èáry a naopak. J.4

Dokud nepoklepete na koncový bod, mùžete obì metody, 
zadání polygonu a volné zakreslení èáry, kombinovat. J.4

➭ Zpùsob rekonstrukce snímku závisí na smìru nákresu dané 
èáry. Když napøíklad zakreslujete páteøní kanál smìrem shora 
dolù, vytvoøený snímek se bude lišit od snímku, který 
vytvoøíte, když èáru zakreslíte zdola nahoru (opaèným 
zpùsobem).
Verze VE31D J.4–9 
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Zobrazování snímkù J.4

Když linii øezu dokonèíte, nový snímek se zrekonstruuje ve 
výstupním segmentu. V referenèním snímku (pracovní 
segment) je poèáteèní bod tohoto snímku oznaèen šipkou. J.4

➭ Pro lepší orientaci se zobrazí orientaèní znaèka a øez.

➭ Orientaèní znaèka v závorkách “< >” se zobrazí na pravé stranì 
obrazového segmentu.

J.4

J.4

UPOZORNÌNÍ

Použití nerovinných obrazù øezu k diagnostickým úèelùm J.4

Nesprávná diagnóza J.4

✧ Pøi interpretaci orientaèních znaèek buïte opatrní. Mìjte na 
pamìti tvar zakøiveného øezu a jeho orientaci v daném 
objektu.
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Dlouhé èáry øezu J.4 Pokud jste zakreslili velmi dlouhou linii øezu, mùže se stát, že 
nebude možné ve výstupním segmentu zobrazit celý snímek. V 
takovém pøípadì se pro generování snímku použije pouze první 
èást linie. V pracovním segmentu je potom vyznaèena tato 
èást. J.4

Poèáteèní bod zobrazení je oznaèen šipkou. J.4
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Multiplanární rekonstrukce (MPR) 3D Evaluation
Posouvání zobrazované  
èásti èáry J.4

✧ Posunováním šipky podél linie øezu pomocí myši posuòte 
poèáteèní bod v pracovním segmentu, aby se zobrazily další 
èásti linie øezu.

Generuje se nový snímek. Tímto zpùsobem mùžete postupnì 
zakreslit tvary v celém rozsahu. J.4

 

J.4–12 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Multiplanární rekonstrukce (MPR)
Posunutí celé linie J.4 Mùže se stát, že budete chtít posunout zakøivenou linii øezu v 
pracovním segmentu na jiné místo. J.4

✧ Na èáru umístìte kurzor myši.

Kurzor myši zmìní tvar. J.4

J.4 ✧ Celou èáru pøesunete pomocí myši se stisknutým levým 
tlaèítkem.

Nový snímek se zobrazí ve výstupním segmentu. J.4

 

➭ Linii vymažete stisknutím klávesy Del.

➭ Smìr, ve kterém jste zakreslili køivku na pracovním obrazu, je 
na výsledném obrazu vyznaèen šipkou
Verze VE31D J.4–13 
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Pøesouvání køivky v rámci 
objektu pomocí záložky J.4

Pøi kreslení mùžete linii øezu v rámci sady dat objektu také 
posunovat vrstvu po vrstvì pomocí záložky pracovního 
segmentu. J.4

✧ Klepnutím na vnìjší pole záložky se posunete dopøedu.

Nebo J.4

✧ Klepnutím na vnitøní pole záložky se posunete dozadu.
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Otáèení obrázkù J.4 ✧ Chcete-li obraz otoèit ve smìru hodinových ruèièek, zvolte 
položku Image > Rotate Curved 90° +. 
→ Strana E.4–34, Otáèení snímkù (Rotate)

Nebo J.4

✧ Chcete-li obraz otoèit proti smìru hodinových ruèièek, zvolte 
položku Image > Rotate Curved 90° –. 

Pøeklápìní snímkù J.4 ✧ Chcete-li obraz pøeklopit kolem svislé osy, zvolte položku 
Image > Flip Curved Vertically. 
→ Strana E.4–37, Pøeklápìní snímkù (Flip)

Nebo J.4

✧ Chcete-li snímek pøeklopit kolem vodorovné osy, zvolte 
položku Image > Flip Curved Horizontally.

➭ Pro zakøivené øezy mùžete nastavit typ výstupu MIP thin, 
MinIP thin, MPR thick a MPR thin. 
→ Strana J.3–40, Urèení typù výstupù

J.4
Verze VE31D J.4–15 
únor 2006
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Multiplanární rekonstrukce (MPR) 3D Evaluation
J.4–16 Návod k použití pro uživatele systému syngo

 0.0



KAPITOLA 0.0

J.5

Projekce maximální a 
minimální intenzity J.5
Projekce maximální intenzity (MIP) používá k rekonstrukci 
nejintenzivnìjší hodnoty stupnice šedi ze snímkù. Napøíklad u 
vyšetøení pomocí kontrastní látky jsou cévy strukturami o 
maximální intenzitì. Zobrazení MIP je tedy velmi vhodné pro 
vyšetøení cév. J.5

Projekce minimální intenzity (MIP) používá k rekonstrukci 
nejménì intenzivní hodnoty stupnice šedi ze snímkù. Nejménì 
intenzivní hodnoty mají struktury vyplnìné vzduchem, proto je 
zobrazení MinIP vhodné zejména pro vyšetøení plic. J.5

Jestliže je pozorovaný objekt rušen jinými strukturami, je 
vhodné extrahovat požadovaný objekt (VOI). J.5

V referenèním režimu mùžete také vytvoøit radiální série z 
projekce maximální intenzity (MIP) a projekce minimální 
intenzity (MinIP). J.5

Funkce Rotating MIP poskytuje dodateènou prostorovou 
orientaci pro zjiš¤ování akutních míst nádorové tkánì. J.5
Verze VE31D J.5–1 
únor 2006   

 0.0



Projekce maximální a minimální intenzity 3D Evaluation
MIP J.5 Projekce maximální intenzity (MIP) se èasto používá v 
angiografii, napø. k zobrazení prùbìhu cévy nebo aplikované 
kontrastní látky. Používá se také pro výøez (extrahování) objektù 
zájmu objektù (VOI). J.5

J.5
J.5–2 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Projekce maximální a minimální intenzity 
MinIP J.5 Projekci minimální intenzity (MinIP) mùžete použít zejména k 
zobrazení plicní tkánì. J.5

J.5

J.5
Verze VE31D J.5–3 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Pøenos MIP do 3D J.5

Zvolili jste sérii snímkù pro zobrazení v MIP a pøenesli jste je na 
kartu úloh 3D. J.5

Série se zobrazí v režimu zobrazení MIP. 
→ Strana J.3–42, Nastavení MIP J.5

➭ Pokud jste již provedli naètení obrazù na kartu úlohy 3D a 
pouze jste se doèasnì pøepnuli do jiné aplikace, pøepnìte se 
zpìt na kartu 3D kliknutím na záložku karty. 
→ Strana J.2–5, Otevøení karty úlohy 3D

➭ Pokud jste dokonèili zpracování prvních trojrozmìrných sérií a 
uložili jste je, mùžete naèíst další oznaèenou sérii pøímo z okna 
Series List (Patient > Open Series List...). Pokud je poslední 
pacient ještì naètený na kartì 3D, zobrazí se dialogové okno, 
ve kterém mùžete specifikovat, zda chcete pokraèovat ve 
zpracování nebo naèíst novou sérii. 
→ Strana J.2–15, Další série ze seznamu sérií 3D
J.5–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
 

(1) Sagitální pohled
(2) Transversální pohled
(3) Koronální pohled
Verze VE31D J.5–5 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Extrahování objektu zájmu (VOI) J.5

Pomocí požadovaného objektu (VOI) mùžete extrahovat 
diagnosticky zajímavý objekt a tím jej vymezit pro rekonstrukci 
jako dílèí objekt. J.5

Extrahovat požadovaný objekt (VOI) mùžete jedním z tìchto 
zpùsobù: J.5

❏ Umístit a vymezit pravoúhlý požadovaný objekt VOI (VOI 
Clipbox)

❏ Volné zakreslení objektu zájmu (3D: VOI Punch Mode) 
J.5–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Použití clipboxu VOI J.5

Pokud jste v referenèním režimu, musíte aktivovat režim 
trojrozmìrného výøezu VOI. J.5

J.5 ✧ Pøístup do režimu VOI získáte zvolením položky Settings > 
VOI Clipbox.

Nebo J.5

J.5 ✧ Klepnìte na tlaèítko VOI Clipbox na kartì dílèí úlohy 
Settings.

Celá sada dat s výchozím vymezením VOI se zobrazí ve 
výstupním segmentu. Obdélník zobrazuje pøednastavené 
vymezení požadovaného objektu (VOI). J.5

(1) Sada dat objektu
(2) Obdélníkový požadovaný objekt (VOI)

➭ Pokud aktivujete Free View pøed vyvoláním VOI Clipbox, 
okno zábìru zmìní vlastnosti. 
 → Strana J.3–56, Operace s clipboxem
Verze VE31D J.5–7 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Zmìna velikosti J.5 V pravém dolním segmentu se zobrazí pøedem definovaný 
pravoúhlý požadovaný objekt (VOI). Daný objekt mùžete podle 
potøeby použít pro zpracování nebo zmìnu velikosti a umístìní. 

J.5

 

J.5 ✧ Velikost zmìníte kliknutím na nìkterou hranièní èáru a 
tažením úchytù se stisknutým tlaèítkem myši. 
 

Obnovení velikosti J.5 ✧ Jestliže chcete obnovit velikost okna zábìru na pùvodní 
hodnoty, vyberte v hlavní nabídce položku Settings > VOI 
Reset Clipbox.

K obnovení dojde u všech segmentù souèasnì. J.5
J.5–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Pøesouvání požadovaného 
objektu (VOI) 

J.5

✧ Polohu požadovaného objektu zmìníte pøesunutím kurzoru 
myši na okraj kolem zvoleného požadovaného objektu, ne na 
symbol pro úpravu.

✧ Se stisknutým levým tlaèítkem myši objem zájmu pøesuòte. 
 

Nastavení standardních 
pohledù J.5

Výchozí nastavení pohledu mùžete ve všech tøech segmentech 
libovolnì mìnit. Z tohoto dùvodu máte plnou kontrolu nad 
umístìním požadovaného objektu v soustavì všech tøí os. J.5

✧ Vyberte výsledný segment.

✧ Pomocí tlaèítek na kartì dílèích úloh Orientation nebo v 
nabídce Orientation vyberte požadovaný standardní pohled. 
→ Strana J.3–28, Nastavení standardních pohledù

➭ Pohledy jsou kolmé nebo rovnobìžné ke smìru snímání dat, 
ale nemusí být kolmé vùèi souøadnicovému systému pacienta.
Verze VE31D J.5–9 
únor 2006

 0.0



Projekce maximální a minimální intenzity 3D Evaluation
Otáèení požadovaného 
objektu (VOI) J.5

J.5 ✧ Klepnutím na tlaèítko Rotate Images v horní èásti ovládací 
oblasti aktivujte režim otáèení.

✧ Umístìte kurzor myši na pravý dolní segment.

J.5 Tvar kurzoru myši se zmìní. 
J.5

✧ Pohybem kurzoru myši se stisknutým levým tlaèítkem nyní 
mùžete otáèet objemem zájmu VOI.

❏ Pohybem myši nahoru a dolù sklápíte objekt v 90° krocích.

❏ Pohybem myši doleva a doprava otáèíte objekt v 90° krocích.

➭ Mùžete se také pøepnout do SSD nebo VRT.
J.5–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Aktivace režimu výøezu VOI J.5

Jakmile umístíte a vymezíte požadovaný objekt (VOI) pomocí 
položky VOI Clipbox, pøepnìte se do režimu VOI Punch Mode. 

J.5

✧ Vyvoláním položky Settings > VOI Punch Mode... získáte 
pøístup k režimu výøezu požadovaného objektu.

Nebo J.5

J.5 ✧ Kliknìte na tlaèítko VOI Punch Mode na kartì dílèích úloh 
Settings. 
Verze VE31D J.5–11 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Zobrazí se dialogové okno 3D: VOI Punch Mode ve výstupním 
segmentu. J.5

 

V tomto dialogovém oknì najdete nìkolik tlaèítek, která mùžete 
využít k extrakci a zpracování volnì nakreslených požadovaných 
objektù (VOI). J.5

Jednotlivá tlaèítka mají následující funkce (zleva doprava): J.5

❏ Volné zakreslení požadovaného objektu (VOI) 
→ Strana J.5–15, Volnì zakreslená èára

❏ Výøez volnì zakresleného požadované objektu (VOI) 
→ Strana J.5–16, Oøezání volnì zakresleného požadovaného 
objektu (VOI)

❏ Vyjmutí volnì zakresleného požadovaného objektu (VOI) 
→ Strana J.5–18, Vyjmutí volnì zakresleného požadovaného 
objektu (VOI)

❏ Zrušení posledního pøíkazu 
→ Strana J.5–21, Vrátit poslední

❏ Zrušení všech zadaných pøíkazù 
→ Strana J.5–21, Vrátit vše
J.5–12 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Po provedení režimu výøezu VOI se automaticky uloží maska 
výøezu. Název uloženého objektu je „3D VOI Punch" v rámci série 
„3D Application Data". J.5

➭ Není-li uložení možné, zkuste znovu otevøít a zavøít režim VOI 
Punch.

➭ Stávající masky výøezu se naètou a lze je použít 
prostøednictvím masky viditelnosti.  
→ Strana J.3–47, Nastavení masky viditelnosti 
→ Kapitola J.9, 3D Editor 
→ Kapitola J.10, 3D – odstranìní kosti 

➭ Obrazy s maskovanými strukturami mají text obrazu „Manip." 
(manipulovaný) v levé horní èásti.
Verze VE31D J.5–13 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Vymezení volnì zakresleného požadovaného 
objektu (VOI) J.5

Když jste obdélníkový požadovaný objekt (VOI) pøizpùsobili 
svým požadavkùm, mùžete do nìj volnì zakreslit nepravidelnou 
oblast (polygon). Tímto nepravidelným požadovaným objektem 
mùžete urèit obrysy, podle nichž mùžete pozdìji vyjmout nebo 
zobrazit èásti snímkù. J.5

✧ Zvolte segment, v nìmž chcete vymezit volnì zakreslený 
požadovaný objekt.
J.5–14 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Volnì zakreslená èára J.5

J.5 ✧ Kliknutím na Draw Contour v dialogovém oknì 3D: VOI 
Punch Mode se aktivuje režim kreslení. 

✧ V místì, kde chcete zaèít kreslit, kliknìte levým tlaèítkem 
myši. 

✧ Klepnutím na další místo na snímku oznaèíte bod, v nìmž se 
zmìní smìr èáry.

Nebo J.5

✧ Souvislou èáru zakreslíte tažením kurzoru myši po obrazu pøi 
stisknutém levém tlaèítku myši. 

✧ Kreslení èáry ukonèíte poklepáním.

J.5 Poèáteèní a koncový bod èáry se spojí. Z èáry se stane uzavøený 
polygon, který vymezuje urèitou oblast. Nyní mùžete køivku 
vybrat a zmìnit její polohu a velikost. J.5
Verze VE31D J.5–15 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Oøezání volnì zakresleného 
požadovaného objektu 
(VOI) J.5

V angiografii se èasto vyskytuje potøeba zobrazit na snímku 
pouze cévní systém, protože ostatní podrobnosti projekci 
komplikují. J.5

✧ Volnì zakreslete oblast kolem požadovaného objektu (VOI).

J.5 ✧ Klepnìte na tlaèítko Keep Inside.

Vše, co leží mimo kresbou vyznaèenou oblast, se vymaže. J.5
J.5–16 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Zpracuje se pouze vnitøní oblast obdélníku VOI, ne sada dat 
objektu, která požadovaný objekt obklopuje. Požadovaný objekt 
(VOI) se používá jako urèitý druh ochrany zbývajícího objektu, 
protože vy nyní mùžete pracovat pouze v rámci zobrazené 
oblasti. J.5

➭ Jakmile vyjmete obrys objektu, program se automaticky 
pøepne do režimu kreslení. 
→ Strana J.5–14, Vymezení volnì zakresleného 
požadovaného objektu (VOI)
Verze VE31D J.5–17 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Vyjmutí volnì zakresleného 
požadovaného objektu 
(VOI) J.5

Mùžete postupovat také opaèným zpùsobem a zpracovat 
požadovaný objekt vyjmutím nepodstatných èástí objektu. J.5

Pøi tomto zpùsobu zpracování se obvykle postupuje po malých 
krocích, jimiž se postupnì vyøezávají malé oblasti, až zùstanou 
zobrazeny pouze ty struktury, které vás zajímají. J.5

✧ Zakreslete oblast, kterou chcete odstranit.

J.5 ✧ Klepnìte na tlaèítko Remove Inside.
J.5–18 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Oblast uvnitø polygonu se vyøízne a odstraní. J.5

 

(1) Výøez volnì zakreslené oblasti obdélníkového VOI ve smìru 
pohledu
Verze VE31D J.5–19 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Vymazání volnì zakreslené 
èáry J.5

Nevydaøené èáry mùžete vymazat. J.5

✧ Klepnutím na èáru danou èáru vyberte.

✧ Vymažte ji stisknutím klávesy Del na klávesnici.

Program se pøepne zpìt do režimu kreslení. J.5
J.5–20 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Obnovení smazaného objemu zájmu VOI J.5

Pokud pøi práci se požadovaným objektem omylem vyøíznete 
vìtší oblast, než jste chtìli, mùžete to napravit zrušením 
pøedchozích pøíkazù (pouze u Keep Inside a Remove Inside). 

J.5

Vrátit poslední J.5 J.5

J.5 ✧ Kliknìte na tlaèítko Undo Last v dialogovém oknì 3D: VOI 
Punch Mode. 
 
 

Vrátit vše J.5 J.5

J.5 ✧ Kliknìte na tlaèítko Reset All v dialogovém oknì 3D: VOI 
Punch Mode.

Grafika se vrátí do pùvodního stavu pøed zpracováním. J.5

Všechny kroky doposud provedené se zruší. J.5

➭ Když zavøete režim VOI po vrácení všech krokù zpracování, 
vyøezaný objekt „3D VOI Punch" se vymaže. 
Verze VE31D J.5–21 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Kombinování typù výstupu MIP/MinIP a SSD J.5

Pøi extrahování požadovaných objektù mùžete zkombinovat 
typy výstupu MIP/MinIP a SSD (zobrazení se stínovaným 
povrchem) v rùzných segmentech a extrahovat je a zobrazit je 
mnohem pøehlednìji. J.5

Vyberte napøíklad zobrazení MIP/MinIP ve dvou levých 
segmentech, na daných obrazech urèete velikost a polohu 
požadovaného objektu a poté zobrazte výsledek v pravém 
horním segmentu se stínovaným povrchem. 
→ Strana J.3–40, Urèení typù výstupù J.5
J.5–22 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
 

(1) Typ MPR
(2) Typ MIP
(3) Typ SSD
Verze VE31D J.5–23 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Vytváøení komplexního zobrazení VOI J.5

Pokud chcete vyøíznout velmi složité struktury, které se 
rozkládají po celém objektu v nepravidelných tvarech, mùžete 
kombinovat pravoúhlé a volnì zakreslené oblasti VOI v nìkolika 
dílèích krocích. J.5

V každém kroku zvolíte pravoúhlý požadovaný objekt a pak v 
rámci tohoto objektu zvýrazníte relevantní strukturu. Tímto 
zpùsobem budete postupovat celým rekonstruovatelným 
objektem. Nakonec systém seskupí rùzné segmenty této 
komplexní struktury požadovaného objektu dohromady. J.5
J.5–24 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Projekce maximální a minimální intenzity 
J.5 ✧ Nejprve utvoøte pomìrné úzký pravoúhlý požadovaný objekt 
v pravé dolní oblasti snímku.

 

Požadovaný objekt se zobrazí v ostatních segmentech 
obrazovky. J.5
Verze VE31D J.5–25 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
J.5 ✧ U požadovaného objektu v jiném segmentu obrazu 
zvýraznìte struktury, které vás zajímají. 
→ Strana J.5–16, Oøezání volnì zakresleného požadovaného 
objektu (VOI)

 

J.5
J.5–26 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
J.5 ✧ Nyní pøesuòte obdélníky v pravém dolním segmentu snímku.

 

✧ Také ve druhém požadovaném objektu znázornìte technikou 
volného zakreslení požadovanou strukturu.

✧ Pokraèujte stejným zpùsobem, dokud nezpracujete celý 
požadovaný objekt.

✧ Nyní zmìòte velikost obdélníku v pravém dolním segmentu 
snímku tak, aby byl segment opìt vhodný pro daný 
diagnostický problém.
Verze VE31D J.5–27 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Všechny volnì zakreslené požadované objekty se nyní 
zkombinují. J.5

 

J.5–28 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Ukonèení režimu VOI J.5

Po dokonèení zvýrazòování požadovaného objektu se vra¤te do 
referenèního režimu. 

J.5

J.5 ✧ Kliknìte na tlaèítko Close v dialogovém oknì 3D: VOI Punch 
Mode.

Nebo J.5

J.5 ✧ Klepnìte na tlaèítko na kartì dílèích úloh Settings.

J.5 Režim VOI se ukonèí. Uloží se aktuální požadovaný objekt, tj. 
poslední stav vašeho objektu. 

J.5
Verze VE31D J.5–29 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Generování radiální série ze 
zobrazení MIP/MinIP J.5

Pomocí radiální projekce mùžete požadovaný objekt zobrazit z 
rùzných úhlù pohledu. J.5

Po vygenerování dostateèného poètu obrázkù uceleného 
okruhu je mùžete pøehrát jako film na kartì úlohy Viewing, jako 
byste “procházeli kolem” objemu zájmu nebo jeho èástí. 
Stejného úèinku dosáhnete kliknutím na záložku výstupního 
segmentu a pøidržením tlaèítka myši. 
→ Strana E.3–18, Animované snímky (Movie) J.5

Generování radiálních sérií J.5 Postup pøi generování radiálních sérií projekcí MIP/MinIP najdete 
v tìchto kapitolách: J.5

→ Strana J.3–117, Nastavení radiálních projekcí a pohledù 
J.5

➭ Na základì zobrazení MIP/MinIP mùžete vygenerovat i 
paralelní snímky nebo zakøivené èásti. Výsledky se však vždy 
zobrazí jako snímky MPR. Z tohoto dùvodu je generování 
paralelních sérií a zakøivených èástí popsáno v následujících 
kapitolách:

→ Strana J.3–83, Vygenerování paralelních snímkù 
→ Strana J.4–7, Generování zakøivených øezù J.5

➭ K výpoètu radiálního rozsahu mùžete použít filtr s vysokým 
rozlišením. 
→ Strana J.16–8, Konfigurace kvalitativního filtru
J.5–30 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Definování tlouš¤ky øezu MIP (MIP 
Thin) J.5

Obvykle se pro projekci maximální intenzity používá celý objekt 
sady dat. Nìkdy však budete chtít pro projekci použít pouze èást 
objektu. Budete napøíklad chtít vyøíznout rušící struktury. 
 

J.5

Výbìr referenèního 
obrazu J.5

Na referenèním segmentu mùžete definovat pohled 
referenèního snímku. J.5

✧ Nejprve zvolte referenèní segment.

✧ Umístìte obraz tak, aby vyhovoval vašim požadavkùm. 
Verze VE31D J.5–31 
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Projekce maximální a minimální intenzity 3D Evaluation
Spuštìní MIP Thin J.5 Nastavit MIP Thin mùžete v jednom, ve dvou nebo ve tøech 
referenèních segmentech. J.5

✧ Pro nastavení typu výstupu MIP Thin zvolte položku Type > 
MIP Thin.

Nebo J.5

J.5 ✧ Kliknìte na tlaèítko MIP Thin na kartì dílèích úloh Type.

V referenèním segmentu se zobrazí MIP Thin se standardním 
nastavením. J.5

 

J.5–32 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Zmìna tlouš¤ky øezu J.5 ✧ Zvolením Type > MIP Thickness... zobrazíte dialogové okno 
3D: MIP Thin pro nastavení tlouš¤ky øezu.

Nebo J.5

J.5 ✧ Pravým tlaèítkem myši klepnìte na tlaèítko MIP Thin na kartì 
dílèích úloh Type.

 

✧ Zadejte v mm tlouš¤ku poèáteèního øezu, která se má použít 
pro projekci.

J.5 ✧ Zadání potvrïte stisknutím tlaèítka OK. 

Nebo J.5

J.5 ✧ Kliknutím na tlaèítko Default nastavíte výchozí hodnotu (10 
mm) pro MIP image thickness.

➭ Zvolené nastavení se použije pro rekonstrukci všech
zobrazených øezù MIP Thin. 
Verze VE31D J.5–33 
únor 2006
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Projekce maximální a minimální intenzity 3D Evaluation
Hodnota MIP image thickness je vždy zapsána na film a 
uložena se snímkem. J.5

J.5 ✧ Klepnìte na položku Set as default a novou výchozí hodnotu 
uložte.

✧ Pøi naèítání nových dat se použije uložená výchozí hodnota.  

Generování sérií snímkù MIP Thin J.5

Také pro typ výstupu MIP Thin mùžete generovat paralelní, 
radiální a rozšíøené zobrazení série snímkù. Tímto zpùsobem 
mùžete rozdìlit data objektu na dílèí celky s pøedem 
definovanou tlouš¤kou. Obrazy MIP Thin jsou pak 
rekonstruovány z tìchto dílèích celkù. 

J.5

Série paralelních vrstev MIP 
Thin J.5

Struktury (kosti), které mohou být pøekážkou pøi projekci 
maximální intenzity, se obvykle vyskytují na malé èásti sady dat 
objektu. Prostøednictvím paralelních snímkù MIP mùžete 
napøíklad zjistit, kde pøekážející struktury konèí a kde mùžete 
generovat užiteèné snímky MIP v sadì dat objektu. J.5
J.5–34 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
J.5 ✧ Generujte a zpracujte snímky série paralelních vrstev MIP 
Thin tak, jak je popsáno v následujících kapitolách:

→ Strana J.3–83, Vygenerování paralelních snímkù 
→ Strana J.3–92, Následné zpracování série paralelních snímkù 

J.5

Série radiálních vrstev MIP 
Thin J.5

✧ Generujte a zpracujte snímky série radiálních vrstev MIP Thin 
tak, jak je popsáno v následujících kapitolách:

→ Strana J.3–106, Generování radiálních snímkù 
→ Strana J.3–115, Následné zpracování radiálního rozsahu 

J.5

Generování rozšíøeného 
zobrazení vrstev MIP Thin J.5

✧ Generujte a zpracujte snímky paralelních vrstev MIP Thin 
rozšíøeného zobrazení tak, jak je popsáno v následujících 
kapitolách:

→ Strana J.3–103, Generování rozšíøené oblasti 
 

J.5

Generování zakøivených øezù J.5

V režimu MIP Thin mùžete také generovat zakøivené øezy. 
Postup je stejný jako v režimu MPR. 
→ Strana J.4–7, Generování zakøivených øezù J.5
Verze VE31D J.5–35 
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Projekce maximální a minimální intenzity 3D Evaluation
Definování tlouš¤ky øezu MinIP 
(MinIP Thin) J.5

Obvykle se pro projekci minimální intenzity používá celý objekt 
sady dat. Nìkdy však budete chtít pro projekci použít pouze èást 
objektu. Budete napøíklad chtít vyøíznout rušící struktury. 
 

J.5

Výbìr referenèního 
obrazu J.5

Na referenèním segmentu mùžete definovat pohled 
referenèního snímku. J.5

✧ Nejprve zvolte referenèní segment.

✧ Umístìte obraz tak, aby vyhovoval vašim požadavkùm. 
J.5–36 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Projekce maximální a minimální intenzity 
Spuštìní MinIP Thin J.5 MinIP Thin mùžete nastavit v jednom, ve dvou nebo ve všech 
tøech referenèních segmentech. J.5

✧ Zvolením položky Type > MinIP Thin nastavte typ výstupu 
MinIP Thin. 

V referenèním segmentu se zobrazí vrstva MinIP Thin se 
standardním nastavením. J.5

 

Verze VE31D J.5–37 
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Projekce maximální a minimální intenzity 3D Evaluation
Zmìna tlouš¤ky øezu J.5 ✧ Zvolením Type > MinIP Thickness... zobrazíte dialogové 
okno 3D: MinIP Thin pro nastavení tlouš¤ky øezu.

 

✧ Zadejte v mm tlouš¤ku poèáteèního øezu, která se má použít 
pro projekci.

Nebo J.5

J.5 ✧ Pokud chcete pøevzít tlouš¤ku MIP, zaškrtnìte tuto možnost. 

J.5 ✧ Zadání potvrïte stisknutím tlaèítka OK. 

Nebo J.5

J.5 ✧ Kliknutím na tlaèítko Default nastavíte výchozí hodnotu (10 
mm) pro MinIP image thickness.

➭ Zvolené nastavení se použije pro rekonstrukci všech
zobrazených øezù MinIP. 
J.5–38 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Hodnota MinIP image thickness je vždy filmována a uložena se 
snímkem. J.5

J.5 ✧ Klepnìte na položku Set as default a novou výchozí hodnotu 
uložte.

✧ Pøi naèítání nových dat se použije uložená výchozí hodnota.  

Generování sérií obrazù MinIP Thin J.5

Také pro typ výstupu MinIP Thin mùžete generovat paralelní, 
radiální a rozšíøené série snímkù. Tímto zpùsobem mùžete 
rozdìlit data objektu na dílèí celky s pøedem definovanou 
tlouš¤kou. Obrazy MinIP Thin jsou pak rekonstruovány z tìchto 
dílèích objektù. 

J.5

Série paralelních vrstev 
MinIP Thin J.5

Prostøednictvím paralelních snímkù MinIP mùžete napøíklad 
zjistit, kde rušivé struktury konèí a kde mùžete vygenerovat 
užiteèné snímky MinIP v sadì dat objektu. J.5
Verze VE31D J.5–39 
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Projekce maximální a minimální intenzity 3D Evaluation
J.5 ✧ Generujte a zpracujte snímky paralelních vrstev MinIP Thin 
tak, jak je popsáno v následujících kapitolách:

→ Strana J.3–83, Vygenerování paralelních snímkù 
→ Strana J.3–92, Následné zpracování série paralelních snímkù 

J.5

Série radiálních vrstev MinIP 
Thin J.5

✧ Generujte a zpracujte snímky radiálních vrstev MinIP Thin 
tak, jak je popsáno v následujících kapitolách:

→ Strana J.3–106, Generování radiálních snímkù 
→ Strana J.3–115, Následné zpracování radiálního rozsahu 

J.5

Generování rozšíøené 
oblasti MinIP Thin J.5

✧ Generujte a zpracujte snímky paralelních vrstev MinIP Thin 
rozšíøené oblasti tak, jak je popsáno v následujících 
kapitolách:

→ Strana J.3–103, Generování rozšíøené oblasti 
 

J.5

Generování zakøivených øezù J.5

V režimu MinIP Thin mùžete generovat i snímky zakøivených 
øezù. Postup je stejný jako v režimu MPR. 
→ Strana J.4–7, Generování zakøivených øezù J.5

J.5
J.5–40 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Otáèení MIP J.5

U sérií PET a NM mùže být použita funkce Rotating MIP pro 
zjiš¤ování akutních míst nádorové tkánì, která vysílá velké 
dávky pozitronové radiace po aplikování specifické sledovatelné 
látky. J.5

Bìhem této rotace okolo svislé osy mùžete kliknout na aktuální 
místo v oknì 3D: Rotating MIP a vystøedit referenèní segmenty 
na aktuální místo, aby se zobrazily obrazy protínající aktuální 
místo. J.5
Verze VE31D J.5–41 
únor 2006

 0.0



Projekce maximální a minimální intenzity 3D Evaluation
3D: Okno otáèení MIP J.5

Okno 3D: Rotating MIP se otevøe automaticky, když je naètena 
sada dat PET nebo NM. Okno se nejprve zobrazí na pravé stranì 
obrazovky a mùže být volnì pøesunuto. J.5

Výpoèet obrázkù pro filmovou sekvenci se spustí automaticky.J.5

➭ Okno 3D: Rotating MIP se nejprve zobrazí ve stavu Stopped, 
který se zmìní na stav Running, ihned po dokonèení výpoètu. 

Stav pøehrávání J.5 Ve stavu pøehrávání mùžete filmovou sekvenci zastavit, zmìnit 
jeho smìr a upravit jeho rychlost otáèení. J.5

J.5
J.5–42 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
J.5 ✧ Chcete-li filmovou sekvenci zastavit, klepnìte na tlaèítko 
Stop.

Okno  3D: Rotating MIP pøejde do stavu Stopped. J.5

J.5 ✧ Chcete-li zmìnit smìr otáèení, kliknìte na tlaèítko Change 
Direction. 

✧ Chcete-li upravit rychlost otáèení, zadejte hodnotu do pole F/
s (obrázky za sekundu).
Verze VE31D J.5–43 
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Projekce maximální a minimální intenzity 3D Evaluation
Stav Zastaveno J.5 Ve stavu Stopped mùžete filmovou sekvenci znovu spustit a 
obrazy v krocích nebo spojitì otáèet. J.5

J.5

J.5 ✧ Kliknutím na tlaèítko Play videosekvenci znovu spustíte.

Okno  3D: Rotating MIP pøejde do stavu pøehrávání. J.5

J.5 ✧ Chcete-li obrazy pootoèit o jeden krok dozadu nebo dopøedu, 
kliknìte jednou na tlaèítko Step Backward nebo Step 
Forward. 

Nebo J.5

J.5 ✧ Pøesuòte posuvník dopøedu nebo dozadu. 
 

J.5–44 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
J.5 ✧ Toto pole zaškrtnìte, pokud chcete namísto výchozích 
procentuálních hodnot použít hodnoty SUV pro tkáò.

Políèko SUV (standardní hodnota vychytávání) je zaškrtnuto, 
jestliže je datový soubor vhodný pro SUV. 

J.5

Opìtovné otevøení 3D: 
Rotating MIP J.5

Okno mùžete kdykoliv zavøít a znovu vyvolat. J.5

✧ Zvolte položku Type > Rotating MIP z hlavní nabídky.

Okno 3D: Rotating MIP se zobrazí ve stavu pøehrávání. 
J.5

Zobrazení v oknì 
videosekvence J.5

Obrázky MIP se zobrazí ve stupnici inverzních šedých odstínù 
LUT. Skeny celého tìla jsou kompletnì viditelné. Sada dat se 
otáèí kolem svislé osy. J.5

Zobrazí se hodnoty okna. 
J.5

Interakce v oknì 
videosekvence J.5

Jestliže kliknete na aktuální místo v oknì 3D: Rotating MIP, 
všechny segmenty v referenèním režimu (standardní 3D i 
Fusion) a v režimu Fusion Side by Side se upraví pro vybraný 
bod. J.5

Když je aktivován volný pohled a kliknete na akutní místo v oknì 
3D: Rotating MIP: J.5

❏ pokud je jedna rovina zábìru aktivní, bude se rovnobìžnì 
posunovat, dokud neprotne bod roviny zábìru,

❏ pokud jsou aktivní dvì roviny zábìru, bude se rovnobìžnì 
posunovat celá vrstva, dokud její støed neprotne bod roviny 
zábìru.

➭ Pomocí prostøedního tlaèítka myši mùžete provést nastavení 
okna videosekvence, stejným zpùsobem jako u segmentu 
oblasti obrázku.
Verze VE31D J.5–45 
únor 2006

 0.0



Projekce maximální a minimální intenzity 3D Evaluation
Dvì datové sady J.5

Když jsou naèteny dvì datové sady NM nebo PET do 3D 
zobrazení, zobrazí se dvì otáèející se MIP. Okno 3D: Rotating 
MIP zmìní tvar. J.5

J.5
J.5–46 Návod k použití pro uživatele systému syngo
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3D Evaluation Projekce maximální a minimální intenzity 
Toto okno obsahuje následující položky: J.5

❏ Pole popisu pro první sadu dat, obsahující první øádek složky 
pacienta.

❏ Okno videosekvence pro první sadu dat.

❏ Pole popisu pro druhou sadu dat, obsahující druhý øádek 
složky pacienta.

❏ Okno videosekvence pro druhou sadu dat.

❏ Zaškrtávací políèko SUV pro sady dat. Je aktivováno, pokud je 
alespoò jedna sada dat PET a vhodná pro SUV.

❏ Pro kontrolu otáèení obou MIP je použita jedna sada tlaèítek. 
Otáèení je vždy synchronní.

Zobrazené poøadí závisí na poøadí naètení a na èasech akvizice. 
Druhá sada dat bude obvykle ta níže, pokud se nejedná o sadu 
dat pøedbìžné studie. J.5

➭ Zobrazení okna videosekvence, interakcí v oknì 
videosekvence a funkènosti ovládacích tlaèítek jsou stejná 
jako u okna 3D: Rotating MIP jednoho datového souboru.
Verze VE31D J.5–47 
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Projekce maximální a minimální intenzity 3D Evaluation
J.5–48 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.6

Rekonstrukce  
povrchù (SSD) J.6
Zobrazení se stínovaným povrchem (SSD) je založeno na 
extrakci dvou stupòù šedi mezi dvìma prahovými hodnotami. 
Typ výstupu SSD provádí rekonstrukci struktur se stínovaným 
povrchem a zobrazuje je ve trojrozmìrném prostoru. J.6

Snímky SSD jsou obzvláštì vhodné k zobrazování struktury kostí 
nebo cév naplnìných kontrastní látkou. J.6

Jako prahové hodnoty pro extrakci povrchù v SSD se bìžnì 
používají specifické výchozí hodnoty pro urèitou modalitu, které 
jsou uloženy v systému. J.6

Pokud tyto výchozí hodnoty nejsou pro daný diagnostický 
problém vhodné, mùžete je individuálnì pøizpùsobit. Tímto 
zpùsobem mùžete optimálnì zobrazit struktury, které vás 
zajímají. J.6

Stejnì jako u multiplanární rekonstrukce (MPR), projekce 
maximální intenzity (MIP) i projekce minimální intenzity (MinIP) 
mùžete generovat nové radiální série na základì zobrazení SSD, 
nebo tyto snímky uložit pro pozdìjší zpracování. J.6

➭ Snímky SSD mají pouze jednu úroveò vyvážení.
Verze VE31D J.6–1 
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Rekonstrukce povrchù (SSD) 3D Evaluation
Pøenos dat do SSD v 3D J.6

Zvolili jste sérii snímkù pro zobrazení SSD a pøenesli jste je na 
kartu úlohy 3D. J.6

Série budou naèteny a zobrazeny v režimu zobrazení SSD. 
→ Strana J.3–44, Nastavení SSD J.6

➭ Pokud jste již provedli naètení obrazù na kartu úlohy 3D a 
pouze jste se doèasnì pøepnuli do jiné aplikace, pøepnìte se 
zpìt na kartu 3D kliknutím na záložku karty. 
→ Strana J.2–5, Otevøení karty úlohy 3D

➭ Pokud jste dokonèili zpracování prvních trojrozmìrných sérií a 
uložili jste je, mùžete naèíst další oznaèenou sérii pøímo z okna 
Series List (Patient > Open Series List...). Pokud je poslední 
pacient ještì naètený na kartì 3D, zobrazí se dialogové okno, 
ve kterém mùžete specifikovat, zda chcete pokraèovat ve 
zpracování nebo naèíst novou sérii. 
→ Strana J.2–15, Další série ze seznamu sérií 3D
J.6–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Rekonstrukce povrchù (SSD)
Rekonstrukce SSD se zmìnìnými prahovými 
hodnotami J.6

Pokud rekonstrukce SSD vycházející z výchozích prahových 
hodnot není pro daný diagnostický problém vhodná, mùžete 
tyto hodnoty zmìnit. Poté mùžete provést opìtovnou 
rekonstrukci obrazu povrchu. 

J.6

Definice SSD J.6 ✧ Zvolte pøíkazType > SSD Definition, který slouží k pøepnutí 
do režimu prahových hodnot.

Nebo J.6

J.6 ✧ Kliknìte na tlaèítko SSD na kartì dílèí úlohy Type pravým 
tlaèítkem myši.

J.6
Verze VE31D J.6–3 
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Rekonstrukce povrchù (SSD) 3D Evaluation
Oblasti v rozmezí nastavených prahových hodnot jsou 
vyznaèeny ve všech snímcích typu výstupu MPR, MIP nebo 
MinIP. J.6

 

(1) Zvýraznìné obrazové body
(2) Snímek SSD
J.6–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Rekonstrukce povrchù (SSD)
Je zobrazeno dialogové okno 3D: SSD Definition. J.6

 

V dialogovém oknì 3D: SSD Definition jsou pro extrakci SSD
zobrazeny pøedvolené, pøípadnì naposledy použité prahové 
hodnoty. 

J.6

J.6

J.6 ✧ Do vstupních polí zadejte nové prahové hodnoty a potvrïte 
je stisknutím klávesy Return. 
 
 

J.6
Verze VE31D J.6–5 
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Rekonstrukce povrchù (SSD) 3D Evaluation
Zadané prahové hodnoty budou aplikovány na zobrazení v 
referenèních segmentech. 

J.6

Jiný zpùsob zmìny prahových hodnot: J.6

✧ Levým tlaèítkem myši kliknìte na jezdce a pøetáhnìte jej 
vlevo nebo vpravo; prahová hodnota se zvýší nebo sníží. 
→ Strana A.2–29, Jezdec

Nové prahové hodnoty budou okamžitì po zmìnì 
prostøednictvím posuvníku nebo kláves se šipkami použity a 
zobrazeny v polích Low nebo High Value. J.6
J.6–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Rekonstrukce povrchù (SSD)
Pøiøazení prahových 
hodnot J.6

Pøednastavené horní a dolní prahové hodnoty jsou zobrazeny v 
seznamu Presets. J.6

J.6 ✧ Klepnutím na pøíslušnou položku v seznamu zvolte prahovou 
hodnotu, která odpovídá danému diagnostickému 
problému.

Hodnoty pøíslušné položky seznamu jsou zobrazeny v polích 
Low a High Value. Obrazové body nacházející se v rozmezí 
prahových hodnot jsou v referenèních segmentech barevnì 
zvýraznìny. J.6

➭ Informace týkající se zpùsobu generování pøednastavených 
prahových hodnot naleznete zde:  
→ Strana J.6–11, Vytváøení a zpracovávání pøednastavených 
prahových hodnot 

J.6 ✧ Po nalezení požadovaných prahových hodnot kliknìte na 
tlaèítko High Quality. 

Zobrazení SSD ve výstupním segmentu bude znovu spoèteno. 
Indikátor prùbìhu vás informuje u prùbìhu extrakce. J.6

Po ukonèení procedury se ve výstupním segmentu zobrazí 
snímek SSD vycházející z novì nastavených prahových hodnot.J.6

➭ Výsledný obraz lze otáèet a pøesouvat dle potøeby. 
Verze VE31D J.6–7 
únor 2006
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Rekonstrukce povrchù (SSD) 3D Evaluation
Zdroj svìtla J.6 Zdroj svìtla lze nastavit, a tak dosáhnout lepšího stavu 
zobrazení povrchu anatomických struktur. J.6

J.6 ✧ Klepnìte na tlaèítko Light Source.

Zobrazí se dialogové okno 3D: Light Source Definition - SSD. J.6

J.6
J.6–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Rekonstrukce povrchù (SSD)
Zároveò se ve zvoleném segmentu zobrazí šipka oznaèující smìr 
zdroje svìtla. J.6

✧ Smìr zdroje svìtla zmìníte klepnutím na šipku ve vybraném 
segmentu a jejím posunutím.
Verze VE31D J.6–9 
únor 2006
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Rekonstrukce povrchù (SSD) 3D Evaluation
J.6 ✧ Zvolte jedno z pøeddefinovaných nastavení. 

Nebo J.6

✧ Pomocí posuvníkù nastavte požadované okolní svìtlo, 
difúzní odraz, zrcadlový odraz a lesk. 

J.6 ✧ Klepnutím na zaškrtávací políèko vytvoøíte dvoustranný zdroj 
svìtla.

Tyto dva zdroje svìtla jsou ve všech parametrech shodné, pouze 
svítí z opaèných smìrù. 

J.6

J.6 ✧ Kliknutím na tlaèítko Reset Light Source Definition 
obnovíte pùvodní smìr šipky. 

➭ Jestliže snímek otoèíte nebo jej posunete, smìr zdroje svìtla 
se nezmìní.

J.6

J.6 ✧ Nastavení potvrïte klepnutím na tlaèítko OK.

Nebo J.6

✧ Uložte nastavení jako novou pøedvolbu.
J.6–10 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Rekonstrukce povrchù (SSD)
Návrat do referenèního 
režimu J.6

Je-li zobrazení nového povrchu, jak požadujete, zavøete 
dialogové okno 3D: SSD Definition a vra¤te se do referenèního 
režimu. J.6

J.6 ✧ Kliknìte na tlaèítko Close. 
 

Vytváøení a zpracovávání pøednastavených 
prahových hodnot J.6

Pomocí pøednastavené dolní a horní prahové hodnoty mùžete 
ukládat optimalizované prahové hodnoty pro rùzné 
diagnostické problémy. 

J.6
Verze VE31D J.6–11 
únor 2006
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Rekonstrukce povrchù (SSD) 3D Evaluation
Vytváøení nových prahových 
hodnot J.6

Dolní a horní prahové hodnoty jsou uvedeny pod pøíslušným 
oznaèením v seznamu Presets v dialogovém oknì 3D: SSD 
Definition. 

J.6

J.6 Horní pole seznamu Presets je zpoèátku prázdné nebo obsahuje 
naposledy zvolenou položku ze seznamu Presets. J.6

✧ Pøepište pùvodní oznaèení, pøípadnì do prázdného pole 
zadejte oznaèení nové.

✧ Nové oznaèení potvrïte stisknutím klávesy Return.

Pøepsané oznaèení se stále nachází v seznamu Presets. J.6

✧ Nyní upravte hodnoty pro horní nebo dolní prahovou úroveò 
pomocí jezdce èi kurzorových kláves.

Nebo J.6

✧ Zadejte prahové hodnoty do vstupních polí Low a High 
Value.

✧ Potvrïte zadané èíselné hodnoty stiskem klávesy Return na 
klávesnici a ovìøte si, zda zadané hodnoty vyhovují vašim 
požadavkùm. 

J.6 ✧ Uložte prahové hodnoty kliknutím na tlaèítko Save Preset.  
Souèasnì s prahovými hodnotami budou uloženy parametry 
zdroje svìtla. 
→ Strana J.3–120, Uložení sady parametrù jako 
pøednastavených hodnot
J.6–12 Návod k použití pro uživatele systému syngo
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3D Evaluation Rekonstrukce povrchù (SSD)
Zpracování prahových 
hodnot J.6

Pokud dvojice prahových hodnot pøestane splòovat vaše 
požadavky, mùžete tyto dvì hodnoty kdykoliv zmìnit. 

J.6

✧ Nejprve zvolte pøíslušnou dvojici prahových hodnot 
klepnutím na tuto dvojici v seznamu Presets.

Hodnoty jsou zobrazeny v polích Low a High Value. 
J.6

✧ Pomocí jezdcù upravte prahové hodnoty tak, aby vyhovovaly 
vašim požadavkùm.

Nebo J.6

✧ Zadejte hodnoty do vstupních polí Low a High Value. 

✧ Potvrïte nastavení stisknutím klávesy Return. 
 

J.6 ✧ Klepnutím na pøíslušné tlaèítko nové prahové hodnoty 
uložte.
Verze VE31D J.6–13 
únor 2006
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Rekonstrukce povrchù (SSD) 3D Evaluation
Odstranìní dvojice 
prahových hodnot J.6

Pokud nebudete pøíslušné horní a dolní prahové hodnoty v 
budoucnu používat, je vhodné je odstranit. Rozsah seznamu 
prahových hodnot tak nepøekroèí pøijatelnou velikost. J.6

✧ Nejprve zvolte pøíslušnou dvojici prahových hodnot kliknutím 
na tuto dvojici v seznamu Presets v dialogovém oknì 3D: 
SSD Definition.

J.6 ✧ Kliknìte na tlaèítko. 

Vybraná položka bude odstranìna. J.6

➭ Specifické výchozí hodnoty pro urèitou modalitu odstranit 
nelze.
J.6–14 Návod k použití pro uživatele systému syngo
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3D Evaluation Rekonstrukce povrchù (SSD)
Generování radiálních sérií 
zobrazení SSD J.6

Pomocí radiálních projekcí mùžete generovat pohledy na 
strukturu povrchu z rùzných úhlù. J.6

Radiální série mùžete generovat buï na základì celé sady dat 
objektu, nebo na základì èásteèného objektu (VOI, požadovaný 
objekt), které jste extrahovali døíve. 
→ Strana J.5–6, Extrahování objektu zájmu (VOI) J.6

Pokud vygenerujete dostateèný poèet obrazù tvoøících 
kompletní cyklus, mùžete jej pøehrát jako film prostøednictvím 
karty úlohy Viewing. To vám umožní „procházet" strukturou 
povrchu. 
→ Strana E.3–18, Animované snímky (Movie) J.6

Generování radiálních sérií J.6 Popis generování radiálních sérií z projekcí SSD naleznete zde:J.6

→ Strana J.3–116, Série radiálních projekcí a pohledù J.6
Verze VE31D J.6–15 
únor 2006
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Rekonstrukce povrchù (SSD) 3D Evaluation
Paralelní tomografické 
obrazy a 
zakøivené èásti J.6

Na základì zobrazení SSD mùžete též generovat paralelní 
snímky a zakøivené výøezy. Výsledky se však vždy zobrazí jako 
snímky MPR. Z tohoto dùvodu je generování paralelních sérií a 
zakøivených èástí popsáno v následujících kapitolách: 
 
→ Strana J.3–83, Vygenerování paralelních snímkù 
→ Strana J.4–7, Generování zakøivených øezù J.6

J.6
J.6–16 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.7

Technika vykreslování 
objemu (VRT) J.7
Technika zobrazování objektù (VRT) slouží k získání 
pøesnìjšího znázornìní a oddìlení typù tkání. Tak mùžete získat 
trojrozmìrné znázornìní. J.7

Ke zvýraznìní nìkterých aspektù anatomické oblasti mùžete 
mìnit barvu, neprùhlednost nebo prùhlednost rùzných oblastí.J.7

Jako zobrazovací parametry pro pohled VRT jsou ve vašem 
poèítaèi v nabídce VRT Gallery uložena bìžná výchozí 
nastavení. J.7

Pokud výchozí nastavení neodpovídají danému diagnostickému 
problému, mùžete jednotlivá nastavení zmìnit. Tak docílíte 
optimálního zdùraznìní požadovaných struktur. J.7

➭ Techniku zobrazování objektù lze použít pouze za 
pøedpokladu, že barevná hloubka systému èiní alespoò 24 
bitù.
Verze VE31D J.7–1 
únor 2006   
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Technika vykreslování objemu (VRT) 3D Evaluation
Pøenos dat do VRT v 3D J.7

Sérii obrazù mùžete pøenést na kartu úlohy 3D z okna Patient 
Browser, z karty úlohy Viewer nebo z dialogového okna 3D 
Series List v režimu VRT. 
→ Strana J.3–46, Nastavení VRT J.7

Karta úlohy 3D je zobrazena v pohledu VRT. J.7

➭ Pokud jste již provedli naètení obrazù do karty úlohy 3D a 
pouze jste doèasnì pøešli do jiné aplikace, aktivujte opìt kartu 
3D kliknutím na záložku.  
→ Strana J.2–5, Otevøení karty úlohy 3D

➭ Pokud jste ukonèili zpracovávání a ukládání trojrozmìrných 
sérií, mùžete naèíst další pøedbìžnì registrované série pøímo 
z karty úlohy 3D (Patient > Open Series List...). Jestliže je 
poslední pacient ještì v kartì 3D, zobrazí se dialogové okno. 
V nìm mùžete rozhodnout, zda chcete pokraèovat ve 
zpracování nebo naèíst novou sérii. 
→ Strana J.2–15, Další série ze seznamu sérií 3D
J.7–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
(1) Sagitální pohled (MPR)

(2) Koronální pohled (MPR)

(3) Transverzální pohled (MPR)

(4) Volný pohled (VRT)

J.7
Verze VE31D J.7–3 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Pøiøazení sad parametrù J.7

Pøi použití techniky vykreslování objektù je zobrazení sady dat 
objektu definováno vlastnostmi barvy a prùhlednosti. Barva 
urèuje svìtlo vyzaøované objektem. Pomocí prùhlednosti lze 
definovat, jakým zpùsobem bude objekt pohlcovat a odrážet 
svìtelné paprsky. J.7

Zpùsob, jímž objekt pohlcuje, vyzaøuje nebo odráží svìtelné 
paprsky, závisí na vlastnostech sady dat. Ty se mohou v rámci 
trojrozmìrného prostoru lišit. J.7

Informace o barvì a svìtle nejsou v pùvodních sadách dat 
obsaženy. CT hodnota nebo hodnota signálu MR musí proto být 
pøiøazena k hodnotám použitým v režimu VRT. J.7

Znázornìní obrazù je definováno v sadách parametrù, které 
jsou uloženy v VRT Gallery. Tyto sady parametrù jsou 
automaticky nebo manuálnì pøiøazeny k pùvodní množinì dat v 
režimu VRT. J.7
J.7–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
Automatické pøiøazení sady parametrù J.7

Ke každé sadì parametrù je pøiøazen název. J.7

Po naètení snímkù do režimu VRT vyhledá systém sadu 
parametrù se shodným názvem (napøíklad hlava) v VRT Gallery. 
Pokud pøíslušnou sadu parametrù nalezne, pøevede pøedvolené 
tkáòové tøídy do snímku. J.7

Pokud systém v VRT Gallery vhodnou sadu parametrù 
nenalezne, zobrazí snímek VRT s použitím naposledy zvolené 
sady parametrù z VRT Gallery. J.7
Verze VE31D J.7–5 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Manuální pøiøazení sady parametrù J.7

Pokud zobrazení VRT s automaticky pøiøazenou sadou 
parametrù nevyhovuje vašim požadavkùm, zvolte v VRT Gallery 
jinou sadu parametrù. J.7

Otevøení dialogového okna 
VRT Gallery J.7

✧ Zvolením Type > VRT Gallery... zobrazíte dialogové okno 3D: 
VRT Gallery.

Nebo J.7

J.7 ✧ Kliknìte na tlaèítko VRT na kartì dílèí úlohy Type pravým 
tlaèítkem myši.

Nebo 
J.7

J.7 ✧ Kliknutím na tlaèítko VRT Gallery na kartì dílèí úlohy 
Histogram. 
 
 

Zobrazí se dialogové okno 3D: VRT Gallery. V rámci VRT Gallery
jsou sady parametrù øazeny abecednì z levého horního rohu do 
pravého dolního rohu. J.7
J.7–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
J.7

➭ Pokud se nezobrazí celý obsah okna, lze další parametry 
zobrazit pomocí posuvníku podél spodní hranice okna.
Verze VE31D J.7–7 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Pøiøazení sady parametrù J.7 ✧ Kliknìte na sadu parametrù levým tlaèítkem myši, èímž dojde 
k pøenosu pøeddefinovaných tkáòových tøíd do aktuálního 
zobrazení VRT.
J.7–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
Zavøení dialogového okna 
VRT Gallery J.7

J.7 ✧ Dialogové okno uzavøete tlaèítkem OK.

Snímek VRT se zobrazí s vybranou sadou parametrù. J.7

Nebo J.7

J.7 ✧ Stisknìte tlaèítko Close.

VRT Gallery je uzavøena. Je použito poslední vybrané 
pøednastavení. J.7
Verze VE31D J.7–9 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Vytváøení a úprava sad parametrù J.7

VRT Gallery nabízí celou øadu sad parametrù pro rùzné typy sad 
dat snímku. Pomocí funkce VRT Definition mùžete vytváøet 
dodateèné sady parametrù a upravovat stávající sady 
parametrù. Tak mùžete VRT Gallery znaènì rozšíøit a jednoduše 
pøiøadit nastavení parametrù, která budou pøesnì odpovídat 
danému diagnostickému problému. J.7

Sadu parametrù mùžete upravit nastavením následujících 
vlastností: J.7

❏ Prùhlednost
❏ Barva 

Jednoduchý a pokroèilý 
režim J.7

Máte dvì možnosti nastavení parametrù VRT: J.7

❏ jednoduchý režim a

❏ složitìjší pokroèilý režim.
J.7–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
Jednoduchý režim J.7

Jakmile použijete filtr VRT na data pacienta poprvé, zobrazí se 
karta dílèí úlohy Histogram. J.7

(1) Øízení histogramu s jednou køivkou se dvìma body 
vyvážení (nemùžete pøidávat nebo mazat køivky nebo 
body)

(2) Øízení barev zobrazující barevné rozložení (interakce není 
možná)

(3) Jezdec zmìny mìøítka pro øízení histogramu

(4) Pøednastavené tlaèítko pro otevøení galerie VRT

(5) Tlaèítko stínování

(6) Tlaèítko Light Source
Verze VE31D J.7–11 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Interakce J.7 ❏ Výbìr lichobìžníku

✧ Kliknutím na lichobìžník jej oznaète.

❏ Úprava lichobìžníku

✧ Kliknutím na lichobìžník jej posunete nebo upravíte jeho 
tvar, aby se zmìnila prùhlednost. 

❏ Odstranìní lichobìžníku

✧ Stisknutím klávesy Del odstraníte vybrané køivky.

Nebo J.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Delete Curve z místní nabídky

➭ Všechny úpravy se automaticky zobrazí na obrazech. 

Pøepnutí do pokroèilého 
režimu J.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Open Expert Mode... z místní nabídky.

Nebo J.7

✧ Dvojitì kliknìte na pozadí histogramu.

Zobrazí se dialogové okno 3D: VRT Definition. 
→ Strana J.7–13, Pokroèilý režim J.7
J.7–12 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Technika vykreslování objemu (VRT)
Pokroèilý režim J.7

Složitìjší zpùsob nastavení parametrù VRT jednotlivì pro každý 
typ tkánì nabízí dialog 3D: VRT Definition.  

J.7

Otevøení okna VRT 
Definition J.7

✧ Zvolením Type > VRT Definition... zobrazíte dialogové okno 
3D: VRT Definition.

Nebo J.7

✧ Kliknìte pravým tlaèítkem myši na sadu parametrù v oknì 
VRT Gallery.

Nebo J.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu karty dílèí 
úlohy Histogram a zvolte položku Open Expert Mode... z 
místní nabídky.

Nebo J.7

✧ Dvojitì kliknìte na pozadí histogramu karty dílèí úlohy 
Histogram.

Zobrazí se dialogové okno 3D: VRT Definition. 
J.7
Verze VE31D J.7–13 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
J.7

(1) Seznam sad parametrù

(2) Grafické nastavení parametru definice VRT – vizualizace 
histogramu hodnot šedi aktuálnì naèteného souboru dat a 
umožnìní definovat neprùhlednosti

(3) Lišta øízení barev - vizualizace aktuálního barevného 
rozložení a umožnìní jej mìnit

(4) Jezdec pro zvìtšování a zmenšování oblasti histogramu

(5) Tlaèítka stínování a zdroje svìtla

J.7

➭ Zmìny provedené v oknì VRT Definition budou po uložení 
pøednastavených hodnot použity v oknì 3D: VRT Gallery.
J.7–14 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Technika vykreslování objemu (VRT)
Výbìr sady parametrù J.7 Nejprve zvolte sadu parametrù, kterou chcete upravit, nebo jejíž 
nastavení jsou velmi podobná nastavením nové sady 
parametrù, již si pøejete vytvoøit. J.7

J.7 ✧ Zvolte sadu parametrù z výbìrového seznamu.

✧ Jestliže chcete vytvoøit novou sadu parametrù, pøepište daný 
název sady parametrù jiným názvem. 

Øízení histogramu J.7 V rámci øízení histogramu naèteného datového souboru mùžete 
nastavit køivky neprùhlednosti. Každá šedá hodnota v 
obrazových bodech obrazu má pøirazenou neprùhlednost. J.7

J.7 Køivka neprùhlednosti se skládá z nìkolika samostatných 
lichobìžníkù.  
Lichobìžníky se skládají z uživatelem definovaných bodù 
vyvážení (1 a 3, 4 a 6) a normálních bodù (2, 5). J.7

➭ Pøi posunu kurzoru nad bod zobrazí nápovìda hodnotu x a y, 
kde x je hodnota šedi (napø. jednotky Hounsfield pro obrazy 
CT) a y pro neprùhlednost, napø. „150/80%”.

➭ Všechny úpravy obou bodù a køivek se ihned zobrazí na 
obrazech. 

❏ Interakce - body vyvážení

✧ Posunutím bodu vyvážení vlevo nebo vpravo zúžíte nebo 
roztáhnete celou køivku.

➭ Body vyvážení jsou definovány systémem, nemùžete je 
nastavit. 
Verze VE31D J.7–15 
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Technika vykreslování objemu (VRT) 3D Evaluation
❏ Interakce - normální body

✧ Kliknutím na normální bod vyberete celou køivku.

✧ Posuòte normální bod nahoru, dolù, doleva a doprava.

✧ Kliknutím pravým tlaèítkem otevøete místní nabídku a 
vyberte Delete Point, chcete-li odstranit bod, nebo Set Color 
(pouze ve spojeném režimu), chcete-li pøiøadit barvu 
vybranému bodu. 

❏ Interakce - køivky

✧ Kliknutím na køivku mezi dvojicemi bodù vyvážení posunete 
køivku doleva nebo doprava.

✧ Kliknutím na køivku mimo dvojice bodù vyvážení posunete 
køivku nahoru nebo dolù. 

❏ Zmìna mìøítka

V závislosti na modalitì pokrývají data z vyšetøení pacienta 
pouze omezený rozsah obrazových bodù, který je následnì 
vyhodnocen v režimu VRT. V oknì histogramu se nejprve 
zobrazí kompletní rozsah hodnot. Mùžete rozsah dat z vyšetøení 
zvìtšovat èi zmenšovat, pøípadnì jej v histogramu vycentrovat. 
Tímto zpùsobem mùžete graficky zpracovat nastavení 
parametrù snadnìji pomocí zobrazených lichobìžníkù. J.7

J.7 ✧ K rozšíøení nebo zúžení rozsahu histogramu pøetáhnìte 
pomocí myši vnìjší okraj jezdce.

Nebo J.7

✧ Ke zmìnì mìøítka histogramu táhnìte myší svislými smìry 
na pozadí histogramu a držte pøitom stisknuté levé tlaèítko 
myši.

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
Home Zoom/Pan z místní nabídky, abyste nastavili hodnoty 
(zobrazí se opìt celý rozsah). 
J.7–16 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Technika vykreslování objemu (VRT)
❏ Posun

J.7 ✧ Pøesunutím støedového úchytu jezdce provedete zmìnu 
polohy v histogramu.

Nebo J.7

✧ K posunu histogramu táhnìte myší vodorovným smìrem na 
pozadí histogramu a držte pøitom stisknuté levé tlaèítko myši. 

❏ Vložení normálních bodù

✧ Dvojitým kliknutím na køivku mezi dvojicí bodù vyvážení 
vložíte nový bod na místo kliknutí. 

Nebo J.7

✧ Kliknutím na køivku mezi dvojicí bodù vyvážení a kliknutím 
pravým tlaèítkem otevøete místní nápovìdu a vyberte Insert 
Point. 

❏ Vložení ramp a lichobìžníkù

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Add Left Ramp z místní nabídky.

Nebo J.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Add Right Ramp z místní nabídky.

Nebo J.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Add Trapeze z místní nabídky. 
Verze VE31D J.7–17 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
❏ Skrytí køivek

✧ Kliknutím na køivku mezi dvojicí bodù vyvážení vyberte køivku 
a kliknutím pravým tlaèítkem otevøete místní nápovìdu a 
vyberte položku Hide Curve.

➭ Samotná køivka zùstane viditelná (èárkovaná), ale pro výpoèty 
zobrazení obrazu se nebere v úvahu.

✧ Kliknutím na skrytou køivku a kliknutím pravým tlaèítkem 
otevøete místní nabídku a zvolte položku Unhide Curve, 
chcete-li opìt, aby køivka byla brána v úvahu. 

Øízení barev J.7 Mùžete definovat rozložení barev, tj. pøiøadit barvu každé 
hodnotì šedi. J.7

❏ Vložení bodu

✧ Dvojitým kliknutím na pozadí barevné lišty vložíte bod na 
místo kliknutí. 

Nebo J.7

✧ Kliknìte pravým tlaèítkem na pozadí barevné lišty a zvolte 
položku Insert Point z místní nabídky.

➭ Zobrazí se barevná paleta. 

❏ Odstranìní bodu

✧ Kliknìte pravým tlaèítkem a zvolte položku Delete Point z 
místní nabídky.

Nebo J.7

✧ Kliknutím na bod jej vyberte a stisknutím klávesy Del vybraný 
bod odstraòte. 
J.7–18 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
❏ Posunutí bodu

✧ Bod posunete jeho pøetažením se stisknutým levým tlaèítkem 
myši.

➭ Pøi pøetahování zobrazuje nápovìda aktuální hodnotu, napø. 
Hounsfield v pøípadì obrazù CT.

➭ Mùžete také posunout celou barevnou škálu jejím posunutím 
se stisknutým levého tlaèítka myši. 

❏ Zobrazení barevné palety

✧ Dvojitì kliknìte na bod.

Nebo J.7

✧ Kliknìte pravým tlaèítkem na bod a zvolte položku Change 
Curve Color z místní nabídky.

Zobrazí se barevná paleta. J.7

✧ Vyberte požadovanou barvu a výbìr potvrïte stisknutím 
tlaèítka OK.

➭ Øízení barev vypoèítá nové rozložení barev mezi novým 
bodem a pøedchozím/dalším bodem.

Objekt se objeví ve výsledném segmentu s novou barvou. J.7
Verze VE31D J.7–19 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Spojení køivky 
neprùhlednosti a barvy J.7

V závislosti na modalitì mùže být výhodné spojit køivku 
neprùhlednosti s barevnou lištou. J.7

J.7 ✧ Zvolte položku Color Bar Linked, chcete-li spojit body køivky 
neprùhlednosti s barevnou lištou.

Ve spojeném režimu jsou body neprùhlednosti vztaženy k 
bodùm v barevné lištì. To mùže být užiteèné pro obrazy MR, kde 
se hodnoty šedi liší u jednotlivých datových souborù. Pro obrazy 
MR je užiteènìjší mít kombinaci barvy a hodnot neprùhlednosti, 
aby se našly a zvýraznily urèité tkánì. J.7

➭ V tomto režimu je barevná lišta neaktivní, body nelze 
pøidávat, odstraòovat nebo posunovat.

J.7 ✧ Zrušte položku Color Bar Linked, nechcete-li spojit body 
køivky neprùhlednosti s barevnou lištou.

Ve nespojeném režimu jsou body funkce neprùhlednosti 
nezávislé na bodech v barevné lištì. To mùže být výhodné pro 
obrazy CT, kde hodnoty šedi obvykle odpovídají stejné tkáni.  

J.7
J.7–20 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
Nastavení stínování J.7

J.7 ✧ Kliknutím na volbu Shading vytvoøíte stínované zobrazení.

➭ Pokud je volba Shading aktivována, zpracovává se zobrazení 
VRT pomocí stínovacího algoritmu, takže simulovaný zdroj 
svìtla vytváøí na obraze stíny. Tak se dosáhne dokonalejšího 
trojrozmìrného pohledu. 

Zdroj svìtla J.7 Po zaškrtnutí možnosti Shading bude tlaèítko Light Source
aktivní a bude možné vybrat zdroj svìtla. J.7

J.7 ✧ Klepnìte na tlaèítko Light Source.

Zobrazí se dialogové okno 3D: Light Source Definition – VRT.J.7

✧ Vyberte nebo urèete požadovaný zdroj svìtla. 
→ Strana J.6–8, Zdroj svìtla
Verze VE31D J.7–21 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Uložení sady parametrù J.7

Pokud chcete sadu parametrù používat i v budoucnu, 
doporuèujeme uložit ji do systému. J.7

J.7 ✧ Název sady v Preset rozumnì zkra¤te, aby tak byla zachována 
obecnost pøiøazení, a potvrïte stiskem klávesy Return.

J.7 ✧ Tlaèítkem Save Preset sadu parametrù uložte.

Pøi pøíštím naètení budou pøednastavené hodnoty pøiøazeny 
sériím, které v názvu obsahují zadaný název na zaèátku. 
→ Strana J.3–120, Uložení sady parametrù jako 
pøednastavených hodnot J.7
J.7–22 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
Vymazání sady parametrù J.7

Každou ze sad parametrù je možné z dialogového okna VRT 
Gallery odstranit. J.7

J.7 ✧ Chcete-li sadu parametrù odstranit z výbìrového seznamu, 
klepnìte na tlaèítko Delete Preset.

Jakmile bude sada parametrù z výbìrového seznamu 
odstranìna, zmizí také ikona obrazu z dialogového okna 3D: 
VRT Gallery. 
 

J.7

Zavøení okna VRT Definition J.7

Po uložení veškerých požadovaných nastavení v dialogovém 
oknì VRT Definition lze dialogové okno zavøít. J.7

J.7 ✧ Kliknutím na tlaèítko Close zavøete dialogové okno 3D: VRT 
Definition.

Nebo J.7

J.7 ✧ Stisknìte tlaèítko.
Verze VE31D J.7–23 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Urèení tlouš¤ky øezu VRT (VRT Thin)J.7

Bìžnì se k projekci maximální intenzity využívá celá sada dat 
objektu. Nicménì v nìkterých pøípadech je užiteèné použít k 
projekci pouze èást objektových dat. Dílèí oblast je definována 
pomocí dvou paralelních rovin ("separaèní rovina"). Vzdálenost 
tìchto rovin pøedstavuje tlouš¤ku øezu, kterou je potøeba 
definovat. Lze se napøíklad vyhnout vyøezávání interferujících 
struktur. 
 

J.7

Výbìr referenèního 
obrazu J.7

V referenèním segmentu mùžete definovat pohled na 
referenèní snímek. J.7

✧ Nejprve zvolte referenèní segment.

✧ Upravte zobrazení obrazu, aby vyhovovalo vašim 
požadavkùm. 
J.7–24 Návod k použití pro uživatele systému syngo
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3D Evaluation Technika vykreslování objemu (VRT)
Spuštìní funkce VRT Thin J.7 Funkci VRT Thin mùžete nastavit v jednom, dvou nebo všech 
tøech referenèních segmentech. J.7

✧ Typ výstupu VRT Thin nastavíte pomocí položky Type > VRT 
Thin.

Nebo J.7

J.7 ✧ Klepnutím na tlaèítko VRT Thin na kartì dílèí úlohy Type.

Zobrazení VRT Thin se objeví ve zvoleném segmentu se 
standardním nastavením. J.7

 

Verze VE31D J.7–25 
únor 2006
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Technika vykreslování objemu (VRT) 3D Evaluation
Zmìna tlouš¤ky øezu J.7 ✧ Zvolením Type > VRT Thickness... zobrazíte dialogové okno 
3D: VRT Thin pro nastavení tlouš¤ky øezu.

Nebo J.7

J.7 ✧ Kliknìte pravým tlaèítkem myši na tlaèítko VRT Thin na kartì 
dílèí úlohy Type.

 

✧ Zadejte tlouš¤ku v milimetrech, kterou chcete pro projekci 
použít.

J.7 ✧ Zadanou vzdálenost potvrïte stisknutím tlaèítka OK. 

Nebo J.7

J.7 ✧ Kliknutím na položku Default se tlouš¤ka 
obrazu nastaví na implicitní hodnotu (10 mm).

➭ Zvolené nastavení bude použito k rekonstrukci všech vrstev 
VRT Thin.

J.7 ✧ Jestliže chcete zobrazené nastavení uložit jako novou výchozí 
hodnotu, klepnìte na položku Set as default. 

➭ Pøi naètení nové sady dat bude použita výchozí hodnota. 

J.7
J.7–26 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.8

Výbìr a zpracování 
obrazù J.8
Po odeslání sady dat objektu na kartu úlohy 3D mùžete pohled 
snímkù v segmentech optimalizovat. J.8

U naètených snímkù mùžete uzpùsobit hodnoty vyvážení. Èásti 
snímku mùžete zvìtšit. Oblasti, které vás zajímají, mùžete 
umístit doprostøed snímku. J.8
Verze VE31D J.8–1 
únor 2006   
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Výbìr a zpracování obrazù 3D Evaluation
Volba snímkù a trojrozmìrné 
grafiky J.8

Nejprve musíte vybrat snímky nebo trojrozmìrnou grafiku, 
kterou chcete zpracovat. J.8

Na kartì úlohy 3D se rozlišují snímky zobrazené v referenèním 
segmentu a série umístìné ve výstupním segmentu. J.8

Volba referenèního 
segmentu J.8

V referenèním segmentu mùžete vybrat pouze jeden referenèní 
snímek. J.8

✧ Kliknìte na obrázek, který chcete zpracovávat, levým 
tlaèítkem myši.

Segment je nyní ohranièen tlustou èárou. J.8

Volba výstupního segmentuJ.8 Rekonstruovaná série se zobrazí ve výstupním segmentu 
(vpravo dole). J.8

✧ Chcete-li vybrat všechny snímky rekonstruované série, 
klepnìte na výstupní segment. 
J.8–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Výbìr a zpracování obrazù
Volba trojrozmìrné grafiky J.8 Grafické zobrazení, napøíklad paralelní série, se zpravidla 
zobrazuje na snímcích referenèních segmentù. J.8

✧ Zobrazení vyberete tak, že kliknete levým tlaèítkem myši na 
jeho èáru.

V trojrozmìrné grafice se pak zobrazí úchyty a bod otáèení. 
J.8

Pøímé zpracování snímkù a 
trojrozmìrné grafiky J.8

Mnoho krokù zpracování mùžete provádìt, aniž byste museli 
vybrat urèité snímky nebo trojrozmìrnou grafiku. J.8

✧ Pøesuòte kurzor myši na obrázek nebo grafiku a stiskem 
tlaèítka myši okamžitì spus¤te operaci.

Nyní mùžete napøíklad nastavit vyvážení obrazu nebo 
pøesunout referenèní èáru trojrozmìrného nitkového køíže. J.8
Verze VE31D J.8–3 
únor 2006
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Výbìr a zpracování obrazù 3D Evaluation
Zobrazení a skrytí referenèních èar J.8

Chcete-li si prohlédnout detaily obrazu, trojrozmìrný nitkový 
køíž mùže obèas pøekážet. J.8

Tyto grafické prvky mùžete skrýt a dle potøeby opìt zobrazit. 
J.8

J.8 ✧ Chcete-li skrýt referenèní èáry, klepnìte na tlaèítko Hide 
Reference Lines v horní èásti ovládací oblasti.

➭ Chcete-li pohledy obrazù zmìnit, použijte myš. 
 

J.8 ✧ Chcete-li referenèní èáry znovu zobrazit, klepnìte na Hide 
Reference Lines.
J.8–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Výbìr a zpracování obrazù
Vyvážení snímkù J.8

Pøi odesílání sady dat objektu na kartu úlohy 3D se zobrazí 
snímky s naposled uloženými hodnotami vyvážení. J.8

Obèas je z dùvodu vyjasnìní detailù podstatných pro diagnózu 
nutné pøiøadit snímkùm nové hodnoty vyvážení. J.8

➭ Na snímcích SSD mùžete mìnit jas a stíny na povrchu. 

➭ Podrobnosti o vyvažování obsahuje také èást 
→ Strana E.4–2, Vyvážení snímkù

Pøednastavené hodnoty vyvážení J.8

Øada specifických nastavení okna pro orgán, studii a uživatele je 
uložena na kartì úlohy Viewing a je také dostupná na kartì 
úlohy 3D. 
→ Strana E.4–13, Pøiøazení pøeddefinovaných nastavení okna J.8

Nìkterá z tìchto nastavení vyvážení byla provedena servisní 
službou spoleènosti Siemens. Mùžete je zmìnit v oknì Viewing 
Configuration, pøípadnì definovat nìkolik nových, vlastních 
nastavení okna. 
→ Strana E.7–8, Hodnoty vyvážení specifické pro daného 
uživatele a daný orgán J.8

✧ Volbou pøíkazu Image > Windowing zvolíte dílèí nabídku s 
veškerými uloženými nastaveními okna.

✧ Zvolte jednu z položek tìchto nastavení okna, která bude 
aplikována na vaše snímky.

➭ Zmìny v konfiguraèním dialogu Viewer se ihned odrazí v dílèí 
nabídce. 
→ Strana E.7–8, Hodnoty vyvážení specifické pro daného 
uživatele a daný orgán
Verze VE31D J.8–5 
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Výbìr a zpracování obrazù 3D Evaluation
Urèení rozsahu úèinnosti (jednoduché 
vyvažování) J.8

Standardnì se stejné hodnoty vyvážení použijí na všechny 
snímky stejného typu výstupu, napø. MPR. J.8

Chcete-li pøiøadit hodnoty vyvážení pouze urèitým snímkùm, 
aktivujte možnost Single Windowing. J.8

Vyvažování snímku J.8 ✧ Tuto volbu nastavíte zvolením položky Image > Single 
Windowing. U položky nabídky se objeví zaškrtávací znaèka.
J.8–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Výbìr a zpracování obrazù
Zpracování pohledu snímku J.8

Èásti snímku, které vás nejvíce zajímají, mùžete zvìtšovat. Není-
li obraz ve zmìnìném mìøítko již pøizpùsoben segmentu, 
mùžete jej posunout, abyste umístili pøíslušnou èást opìt do 
støedu obrazu (posun). 
Podrobný popis nastavení pohledu obrazu nalezenete zde: 
→ Strana E.4–1, Zpracování snímkù J.8

Kromì možnosti zpracování pohledu obrazu známé z èásti 
Viewing a Filming nabízí 3D novou funkci Roll. 

J.8

Otoèení J.8 ✧ Zvolte položku Orientation > Rotate Images.

Nebo J.8

J.8 ✧ Kliknìte na tlaèítko Rotate Images v horní èásti ovládací 
oblasti. 

Nebo J.8

✧ Kliknutím pravým tlaèítkem myši aktivujte funkci SmartSelect 
a vyberte položku rotate object.

J.8 Rovinu snímku mùžete otoèit kolem støedu snímku pøetažením 
myši podél okraje segmentu. J.8

J.8
Verze VE31D J.8–7 
únor 2006

 0.0



Výbìr a zpracování obrazù 3D Evaluation
Zvìtšení a posun J.8 ✧ Zvolte položku Image > Zoom/Pan.

Nebo J.8

J.8 ✧ Klepnìte na tlaèítko Zoom/Pan v horní èásti ovládací oblasti.

Nebo J.8

✧ Kliknutím pravým tlaèítkem myši aktivujte funkci SmartSelect 
a vyberte položku zoom/pan.
J.8–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Výbìr a zpracování obrazù
Zmìna zobrazení snímku pomocí 
barevných tabulek LUT J.8

Jestliže chcete optimalizovat snímek pro diagnostické úèely, k 
jejich zobrazení lze použít funkci pro zobrazení stupnice šedi v 
barvách. Intenzita barev pak odpovídá hodnotám stupnice šedi. 
Mùžete urèit, která z pøeddefinovaných tabulek pro vyhledávání 
barev (LUT) je nejvhodnìjší, a použít ji pro vybrané snímky ve 
stupnici šedi. Tyto tabulky lze dokonce spoleènì se snímky 
ukládat. J.8

✧ Vyberte jeden nebo více obrazù, u kterých chcete použít 
barevnou tabulku LUT 
(buï pro zobrazení obrazù se stupnicí šedi, nebo pro zmìny 
barvy u pseudobarevných obrazù).

✧ V hlavní nabídce vyberte položku Image > Color Lookup 
Table....

Zobrazí se dialogové okno 3D: Color Lookup Table. J.8

✧ Ve výbìrovém seznamu Color Lookup Table vyberte 
pùvodní hodnoty stupnice šedi nebo tabulku barev.

J.8 ✧ Jestliže nechcete provést žádné zmìny, kliknìte na tlaèítko 
Cancel. 

J.8 ✧ Jestliže chcete pro vybrané snímky použít zobrazenou 
tabulku barev a zavøít dialogové okno, klepnìte na tlaèítko 
OK.
Verze VE31D J.8–9 
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Výbìr a zpracování obrazù 3D Evaluation
J.8–10 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.9

 
3D Editor J.9
Všeobecný problém pøi vyhodnocování lékaøských snímkù 
spoèívá v tom, že vyhodnocované oblasti jsou zakryty jinými 
strukturami, zvláštì kostmi. Potøebné informace o snímku jsou 
obsaženy v sadì dat objektu, ale je tøeba je zviditelnit vhodnými 
úpravami. J.9

V jednodušších pøípadech mùžete problém vyøešit dodateènými 
úpravami v režimu VOI. Struktury urèené ke skrytí mùžete 
ohranièit ruènì a vyjmout je ze sady dat. J.9

Ve složitìjších pøípadech bude tato metoda vyžadovat vìtší úsilí, 
pokud budete chtít èistì oddìlit oblasti relevantní pro diagnózu 
od skrývaných struktur. V tom pøípadì doporuèujeme použít 3D 
Editor, který poskytuje poloautomatické nástroje pro oznaèení 
a oddìlení struktur v trojrozmìrném prostoru, o které máme 
zájem. Tyto struktury jsou oznaèovány jako "objekty". J.9
Verze VE31D J.9–1 
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3D Editor 3D Evaluation
Funkce aplikace 3D Editor J.9

Pomocí programu 3D Editor mùžete provádìt následující 
operace: J.9

❏ vytvoøení objektu pomocí funkce Region Growing

❏ správu objektu v seznamu objektù

❏ úpravu objektu pomocí funkcí Object Punching a 
Morphological Operations 

Region Growing J.9 Normálnì v prvním kroku vygenerujete jeden nebo více 
"objektù" ze sady dat objektu pùvodnì naèteného na kartì 3D. 
Specifikováním omezeného rozsahu voxelù extrahujete pouze 
èást voxelù z pùvodní sady dat. Tímto zpùsobem vygenerujete 
objekt ve výsledném segmentu. J.9

Místo globální extrakce z celé sady dat objektu mùžete také 
postupovat „øez po øezu" (v trojrozmìrných blocích) použitím 
Slab Editor. J.9

V pùvodní sadì dat mùžete také nastavit zdrojové body, èímž 
omezíte vytvoøení objektu v daných oblastech, které jsou také 
navzájem propojeny v urèité voxelové oblasti. J.9
J.9–2 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Object Punching J.9 Podobnì jako pøi úpravì sady dat objektu v režimu VOI mùžete 
také použít 3D Editor. Jsou vám poskytnuty nástroje pro vyjmutí 
struktur z objektu, který jste pøedtím vygenerovali. J.9

Použitím Slab Editor mùžete definovat vlastní hloubku 
vystøižení. J.9

J.9

Morphological Operations J.9 V nìkterých pøípadech nebude snadné oddìlit struktury objektu 
použitím nástrojù pro vystøihování. Zde doporuèujeme 
obrušování, nebo zmenšování oblastí objektu o urèitou tlouš¤ku 
povrchu, dokud objekt nebude bez nejasných struktur. 
Následnì mùžete zbývající oblasti objektu roztáhnout nebo 
zvìtšit o danou tlouš¤ku povrchu. Výsledkem je odstranìní 
nepodstatných oblastí v poèáteèní sadì ze snímku. Pokud 
provedete stejné operace v obráceném poøadí, budou v objektu 
vyplnìny malé dutiny. J.9

!0

J.9 J.9

J.9

Pomocí funkce Morphological Operations mùžete odstranit 
malé struktury a vyplnit dutiny, ale zmìníte tím také struktury 
cílového objektu. J.9
Verze VE31D J.9–3 
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3D Editor 3D Evaluation
Spuštìní aplikace 3D Editor J.9

Datový soubor objektu mùžete upravit pomocí 3D Editor v 
dialogovém oknì 3D: Object Editor, které vyvoláte, jakmile 
pøenesete datový soubor objektu na kartu 3D v jakémkoli 
zobrazení (MPR; MIP; MinIP; SSD atd.). J.9

✧ Zvolte Settings > Editor Region Growing....

Zobrazí se dialogové okno 3D: Object Editor v režimu Region 
Growing. Segmenty karty 3D se pøemístí pro úpravu v 3D 
Editoru. J.9
J.9–4 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
3D karta v režimu editoru J.9

Po spuštìní 3D Editor je oblast snímku 3D karty rozdìlena do 
následujících segmentù: J.9

(1) deskový segment pro definování øezu, který se má upravit 
a pøedstavovat výslednou sérii

(2) okno 3D editoru

(3) pracovní segment (MPR nebo MIP/MinIP Thin)

(4) výsledný segment (SSD)
Verze VE31D J.9–5 
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3D Editor 3D Evaluation
Dialogové okno Object Editor J.9

Zobrazí se dialogové okno 3D: Object Editor se objeví vždy ve 
spodním levém (prázdném) segmentu, a proto nezakrývá žádný 
pracovní ani výsledný segment. J.9

Obsahuje následující oblasti: J.9

(1) panel nástrojù,

(2) seznam objektù,

(3) nástroje specifické pro daný režim,

(4) obecná tlaèítka (ukonèení aplikace 3D Editor).
J.9–6 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Slab Editor J.9

Po spuštìní 3D Editor se naètená série posledního pohledu, 
které se má nastavit, objeví v deskovém segmentu ve zvoleném 
režimu zobrazení. V deskovém segmentu bude obvykle 
zobrazen koronální snímek MIP a v pracovním segmentu 
transverzální snímek MPR, jehož pozice ve vrstevném segmentu 
je oznaèena navigaèní èarou. J.9

(1) Navigaèní èára
Verze VE31D J.9–7 
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3D Editor 3D Evaluation
Zapnutí editoru desek J.9

Z naèteného souboru dat objektu zvolte oblast zájmu jako 
trojrozmìrný blok. Pomocí funkcí editoru z tohoto 
trojrozmìrného bloku vygenerujte a upravte trojrozmìrné 
objekty. J.9

J.9 ✧ Kliknìte na tlaèítko Use Slab v panelu nástrojù dialogového 
okna 3D: Object Editor, abyste aktivovali režim desky.

➭ Režim desky deaktivujete opìtovným klepnutím na tlaèítko 
Use Slab.

V segmentu desky se zobrazí èáry desky. J.9

(1) Horní hranièní èára trojrozmìrné desky
(2) Prostøední èára trojrozmìrné desky
(3) Navigaèní èára
(4) Spodní hranièní èára trojrozmìrné desky
J.9–8 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Zmìn trojrozmìrného bloku J.9

Všechny úpravy provedené v programu 3D Editor ovlivní pouze 
struktury v trojrozmìrném bloku (mezi hranièními èarami). 
Proto budete ještì muset upravit polohu, rozsah a orientaci 
trojrozmìrného bloku. 

J.9

Zvìtšení/zmenšení 3D blokuJ.9 Trojrozmìrný blok mùžete zvìtšit nebo zmenšit posunutím 
hranièních èar myší. J.9

J.9 ✧ Posuòte horní hranièní èáru mimo støední èáru a souèasnì 
držte stisknuté tlaèítko myši pro zvìtšení velikosti 3D bloku.

Nebo J.9

✧ Táhnìte hranièní èáru smìrem ke støední èáøe. Tak zmenšíte 
velikost trojrozmìrného bloku.

➭ Totéž se vztahuje na posuv spodní hranièní èáry.

V každém pøípadì se støední èára pøesune smìrem k novému 
støedu zvìtšeného nebo zmenšeného trojrozmìrného bloku. 
Druhá hranièní èára zùstává nezmìnìna. J.9
Verze VE31D J.9–9 
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3D Editor 3D Evaluation
Pøesun trojrozmìrného 
bloku J.9

Trojrozmìrný blok v rámci deskového segmentu mùžete 
pøesunout pomocí støední èáry. J.9

J.9 ✧ Pøetáhnìte støední èáru v jejím støedním bodì na 
požadovanou pozici za stisknutého tlaèítka myši. 

Otáèení trojrozmìrného 
bloku J.9

Orientaci trojrozmìrného bloku mùžete zmìnit naklonìním 
støední èáry nebo pootoèením tomografických obrazù. J.9

J.9 ✧ Klepnìte na støední èáru (ne na její støední bod) a otoète ji 
požadovaným smìrem s pøidržením tlaèítka myši.

Celý trojrozmìrný blok se otoèí spoleènì s navigaèní èárou 
pøíslušným smìrem. J.9
J.9–10 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Nebo J.9

✧ Kliknìte na pracovní nebo deskový segment a zmìòte 
orientaci tomografického obrazu použitím pøíkazù v nabídce 
a tlaèítek na obrazovce. 
→ Strana J.3–11, Nastavení pohledù v sadì dat objektu
Verze VE31D J.9–11 
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3D Editor 3D Evaluation
Úprava po jednotlivých blocích pomocí 
editoru blokù J.9

Pøi generování a dodateèném zpracování objektù mùžete z 
blokù pùvodních sad dat postupnì extrahovat struktury. To 
provedete tak, že nejprve urèíte trojrozmìrný blok a poté ho 
umístíte na konec souboru dat. Po extrakci voxelù pøesuòte 
trojrozmìrný blok v rámci souboru dat tak, aby se pøipojil na 
koncovou pozici prvního bloku. Potom zahajte další extrakci a 
tímto zpùsobem pokraèujte, dokud nepokryjete celý soubor dat. J.9

Trojrozmìrný blok posunete nahoru nebo dolù vždy o stejnou 
vzdálenosti (o jednu šíøku bloku) takto. J.9

J.9 ✧ Kliknutím na tlaèítko Move Slab + posunete trojrozmìrný 
blok o jeho šíøku opaèným smìrem, než je šipka bloku.

Nebo J.9

J.9 ✧ Kliknutím na tlaèítko Move Slab – posunete trojrozmìrný 
blok vždy o stejnou vzdálenost ve smìru šipky bloku.

Nebo J.9

J.9 ✧ Posuòte navigaèní èáru za horní nebo spodní hranièní èáru 
trojrozmìrného bloku.

Po provedení posunu trojrozmìrného bloku se pøedchozí horní 
hranièní èára stane spodní èarou ohranièení a naopak. J.9
J.9–12 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation 3D Editor
Vytváøení trojrozmìrných objektù J.9

Extrakcí urèitých voxelù ze sady dat objektu vytvoøíte pomocí 3D 
Editor objekty, které pøedstavují orgány a struktury, napø. cévy, 
kosti a mìkké tkánì. J.9

Z voxelù pùvodní sady dat umístìných v pøedepsaném rozsahu 
mùžete vytvoøit pomocí funkce Region Growing objekt. 
Následnì mùžete objekty expandovat pøidáním voxelù z jiných 
rozsahù hodnot. J.9

Pomocí funkcí Seed Points a Blocker mùžete urèit jako objekt 
pouze ty oblasti, které jste zvolili a které jsou trojrozmìrnì 
propojené, pøièemž se do úvahy bere zadaný rozsah prahových 
hodnot. J.9

➭ V blokovém segmentu (nahoøe vlevo) mùžete aplikovat 
vytváøení objektù na celou sadu dat objektu nebo je omezit na 
jeden trojrozmìrný blok. 
→ Strana J.9–7, Slab Editor
Verze VE31D J.9–13 
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3D Editor 3D Evaluation
Vytvoøení objektu pomocí prahové hodnoty J.9

Nové objekty se obvykle vytváøí v režimu Region Growing. J.9

✧ Zvolte Settings > Editor Region Growing...

nebo J.9

J.9 ✧ Kliknìte na tlaèítko Region Growing na panelu nástrojù 
dialogového okna 3D: Object Editor.

Nástroje pro práci s prahovými hodnotami se nyní zobrazí v 
dialogovém oknì 3D: Object Editor. J.9

J.9

(1) Nástroje pro práci s prahovými hodnotami
J.9–14 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Výbìr nového objektu J.9 Seznam objektù vytvoøených pro naètenou sadu dat objektu se 
zobrazí v prostøední oblasti dialogového okna 3D: Object 
Editor. Pokud upravujete seznam poprvé, obsahuje údaj new.J.9

➭ Jestliže už byly objekty pro danou sadu dat objektu 
nadefinovány, mùžete je nyní zvolit ze seznamu objektù a 
následnì je zpracovat. 
→ Strana J.9–24, Práce se seznamem objektù

J.9 ✧ Kliknìte na new pro definování nového objektu. 
 

Nastavení prahové hodnotyJ.9 Zobrazí se dialogové okno 3D: Object Editor. Nejprve budou 
zobrazeny výchozí nebo poslední prahové hodnoty použité pro 
rekonstrukci objektu. Pøiøazené oblasti jsou v pracovním 
segmentu (vpravo nahoøe) barevnì zvýraznìny. J.9

Pro vytvoøení nových objektù mùžete použít pøeddefinované 
páry prahových hodnot nebo urèit nové rozsahy prahových 
hodnot. J.9
Verze VE31D J.9–15 
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3D Editor 3D Evaluation
J.9 ✧ Zvolte prahovou hodnotu ze seznamu Presets vhodnou pro 
váš diagnostický problém. 
 

Nebo J.9

J.9 ✧ Zadejte nové prahové hodnoty do èíselníku a potvrïte je 
klávesou Enter. 
 

Nebo J.9

J.9  
J.9

✧ Nastavte prahovou hodnotu pomocí jezdce.

❏ Pøetažením koncových okrajù jezdce myší zvìtšíte nebo 
zmenšíte rozsah prahových hodnot.

❏ Posunutím støedové znaèky jezdce zmìníte polohu rozsahu 
prahových hodnot. 

Zadané prahové hodnoty se vztahují na znázornìní v pracovním 
segmentu. J.9
J.9–16 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Zobrazení objektu J.9 Po nastavení prahových hodnot zahajte rekonstrukci objektu. J.9

J.9 ✧ Kliknìte na tlaèítko Add to Object. 

Rekonstruovaný objekt se objeví ve výsledném segmentu. J.9
Verze VE31D J.9–17 
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3D Editor 3D Evaluation
Zpìt J.9 Poslední úlohu mùžete odvolat, napø. Add to Object, pokud 
byly zadané údaje nesprávné. J.9

J.9 ✧ Kliknìte na tlaèítko Undo Last. 
 

Uložení pøednastavených 
hodnot J.9

Pokud jste nalezli pøijatelné páry prahových hodnot, mùžete je 
uložit do seznamu pøednastavených hodnot pod novým 
názvem. 
→ Strana J.6–11, Vytváøení a zpracovávání pøednastavených 
prahových hodnot J.9

J.9 ✧ Pøepište pùvodní název požadovaným názvem. 

J.9 ✧ Kliknutím na tlaèítko uložte nové prahové hodnoty. 
J.9–18 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Vytvoøení objektu pomocí funkce Region 
Growing J.9

Po vytvoøení objektu urèením jeho prahových hodnot mùžete 
jeho velikost omezit pomocí funkcí Set Seed Points a Draw 
Blocker. J.9

Výbìr objektu J.9

J.9 ✧ Kliknìte na objekt v seznamu objektù. 
 

Nastavení zdrojových bodù J.9 V pracovním segmentu je zobrazen zvolený objekt v rámci 
zadaných prahových hodnot. J.9

J.9 ✧ Kliknìte na tlaèítko Set Seed Point v oblasti okna Region 
Growing. 

J.9 Kurzor myši zmìní tvar. 
J.9

✧ Klepnìte na pøíslušné body v pracovním segmentu levým 
tlaèítkem myši pro nastavení bodù Seed Points.
Verze VE31D J.9–19 
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3D Editor 3D Evaluation
J.9

➭ Mùžete nastavit libovolný poèet Seed Points a posouvat je 
kliknutím na nì a táhnutím myší. 

Vymazání zdrojových bodù J.9 Pokud jste nastavili pøíliš mnoho Seed Points, mùžete je 
vymazat. J.9

J.9 ✧ Kliknìte levým tlaèítkem myši na Seed Point a stisknìte 
klávesu Del na vaší klávesnici.

J.9
J.9–20 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Nastavení omezovaèe  
bloku J.9

Pomocí omezovaèù blokù mùžete omezit rozšíøení voxelových 
oblastí od zdrojových bodù. Toto provedete urèením hranièních 
èar, za nimiž není povoleno rozšíøení voxelových oblastí. J.9

✧ Pøepnìte do zobrazení MIP v pracovním segmentu.

➭ Pokud je to nutné, použijte Slab Editor. 
→ Strana J.9–7, Slab Editor

J.9 ✧ Klepnìte na tlaèítko Draw Blocker v oblasti okna Region 
Growing.

J.9 Kurzor myši zmìní tvar. J.9

✧ Kliknìte levým tlaèítkem myši na požadovaný poèáteèní bod 
hranièní linky v pracovním segmentu.

✧ Klepnìte na libovolné místo ve snímku, kde se má zmìnit 
smìr kreslené køivky.

Nebo J.9

✧ Zakreslete souvislou èáru tažením kurzoru myši po obrazu pøi 
stisknutém levém tlaèítku myši. 

✧ Ukonèete èáru poklepáním.
Verze VE31D J.9–21 
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3D Editor 3D Evaluation
J.9

➭ Do pracovního segmentu mùžete nakreslit jednu nebo více 
ruènì kreslených køivek. 

Odstranìní omezovaèe 
bloku J.9

Nepotøebnou ruènì kreslenou køivku mùžete kdykoli odstranit.J.9

J.9 ✧ Kliknìte levým tlaèítkem myši na Blocker, který chcete 
odstranit, a stisknìte klávesu Del.
J.9–22 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Zobrazení objektu J.9 Po nastavení Seed Points a zakreslení všech požadovaných 
Blockers mùžete zahájit rekonstrukci objektu. J.9

J.9 ✧ Kliknìte na tlaèítko Replace Object. 

➭ Mùžete také nastavit rozsah prahových hodnot od zaèátku a 
použít funkci Seed Points a Blockers. Nový objekt mùžete 
vygenerovat pomocí volby Add to Object.

Upravený objekt se objeví ve výsledném segmentu. J.9

Zpìt J.9 Poslední krok mùžete vrátit zpìt, napø. Replace Object, pokud 
jsou položky nesprávné. J.9

J.9 ✧ Kliknìte na tlaèítko Undo Last. 
Verze VE31D J.9–23 
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Práce se seznamem objektù J.9

Seznam objektù se objeví, jakmile je otevøeno okno 3D: Object 
Editor. V seznamu budou zobrazeny všechny pøeddefinované a 
nové objekty. J.9

(1) Název objektu

(2) Zaškrtávací pole pro zobrazení objektu v deskovém 
segmentu

(3) Zvolený objekt pro zobrazení ve výsledném segmentu

(4) Nový (prázdný) objekt 

V seznamu objektù mùžete vybrat jeden nebo nìkolik objektù 
souèasnì. Zvolené objekty se zobrazí ve výsledném segmentu.J.9

V seznamu objektù je zobrazen název, barva, viditelnost, objem 
a stav objektu. Jakmile v pracovním segmentu zmìníte 
pøeddefinovaný objekt, do seznamu je zadán stav „modified". J.9

➭ Objemy objektù nejsou pøesné. To platí zejména pro obrázky, 
v nichž nebylo opraveno zkreslení.

➭ Po naètení obrázkù, k nimž je nutné dodat další informace 
(napø. obrázkù MR, v nichž nebylo opraveno zkreslení), se v 
seznamu objektù objeví sloupec "Remark".
J.9–24 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Výbìr objektù J.9

Když otevøete dialogové okno 3D: Object Editor, stávající 
objekty naèteného souboru dat objektu objeví v seznamu 
objektù. Seznam je aktualizován po každé aktualizaci objektu. J.9

Jednotlivý objekt J.9

J.9 ✧ Klepnìte na objekt v seznamu objektù.

Zvolený objekt se objeví ve výsledném segmentu. J.9

➭ Zvolený objekt se neobjeví v deskovém segmentu, dokud jej 
neaktivujete v seznamu objektù pomocí zaškrtávacího pole.

Nìkolik objektù J.9

J.9 ✧ Zaškrtnìte nìkolik objektù, jeden po druhém, se stisknutou 
klávesou Ctrl.

Všechny zvolené objekty se zobrazí ve výsledném segmentu v 
barvì, která je jim pøiøazena. J.9
Verze VE31D J.9–25 
únor 2006
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3D Editor 3D Evaluation
Zmìna vlastností objektu J.9

Ve výsledném segmentu mùžete mìnit barvu objektù. Vytvoøíte 
tak realistiètìjší znázornìní struktury. Mùžete udržovat váš 
seznam objektù srozumitelný pøiøazením pøíslušných názvù 
(napø. Kost pro kostní strukturu). J.9

Pøiøazení barvy J.9

J.9 ✧ Poklepejte levým tlaèítkem myši na pole Color zvoleného 
objektu.

Zobrazí se barevná paleta. J.9

J.9 ✧ Vyberte požadovanou barvu a výbìr potvrïte stisknutím 
tlaèítka OK.

Objekt se objeví ve výsledném segmentu s novou barvou. J.9
J.9–26 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Zmìna názvu objektu J.9

J.9 ✧ Pomocí myši vyberte objekt ze seznamu objektù.

✧ Kliknìte znovu na položku a pøitom krátce pøidržte tlaèítko 
myši. 

Zobrazí se textové vstupní pole. J.9

J.9 ✧ Z klávesnice zadejte název nového objektu a potvrïte jej 
klávesou Return. 

Zobrazování objektù v deskovém segmentu J.9

Objekty obsažené v seznamu objektù mohou být jednotlivì 
skryty nebo zobrazeny v deskovém segmentu. Tímto zpùsobem 
urèujete, které oblasti se budou ukládat jako nová série pro další 
zpracování. J.9

Zobrazení objektù J.9

J.9 ✧ Zaškrtnìte pole objektù, které se mají zobrazit v deskovém 
segmentu.
Verze VE31D J.9–27 
únor 2006

 0.0



3D Editor 3D Evaluation
Skrytí objektu J.9

J.9 ✧ Odškrtnìte pole pøíslušného objektu. 

 

J.9–28 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Zobrazení doplòkové  
oblasti J.9

Punched Volume obsahuje všechny voxely pùvodní datového 
souboru, které ještì nejsou obsaženy v objektech. J.9

J.9 ✧ Aktivujte Punched Volume pro zobrazení reziduální sady 
dat.

Punched Volume a všechny objekty aktivované v seznamu 
objektu jsou zobrazeny. J.9

➭ Pokud chcete v sadì dat skrýt napøíklad pouze kosti, 
odškrtnìte kostní objekty ze seznamu a aktivujte všechny 
zbývající objekty stejnì jako Punched Volume.

J.9
Verze VE31D J.9–29 
únor 2006
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3D Editor 3D Evaluation
Aktualizace zobrazení J.9

Kdykoliv vytváøíte nebo mìníte objekty, musíte aktualizovat 
pohledy. Pouze tehdy se zmìny provedené s objekty aktivují. 
Napøíklad objekt skrytý v seznamu objektù se neodstraní ze 
zobrazení v horních dvou segmentech, dokud se zobrazení 
neaktualizuje. J.9

J.9 ✧ Kliknutím na tlaèítko Update Masking aplikujete zmìny 
objektu. 
J.9–30 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Ukládání, pøidávání, mazání objektù J.9

V seznamu objektù mùžete spravovat existující objekty a 
objekty právì vytvoøené. Doporuèujeme bìhem práce ukládat 
pøechodné verze, které pak mùžete v pøípadì potøeby obnovit. 
Pokud chcete uchovat urèitou verzi objektu, ale chcete s ní i 
nadále pracovat, jednoduše vytvoøte duplikát. J.9

Vymažte ze seznamu všechny již nepotøebné objekty. Tak 
uchováte seznam objektù a databázi s uloženými objekty v 
pøijatelné velikosti. J.9

Uložení pøechodné verze 
objektu J.9

J.9

✧ Pomocí myši vyberte ze seznamu objektù objekty, jejichž 
pøechodnou verzi chcete uložit.

J.9 ✧ Kliknìte na tlaèítko Save Selected Objects. 
 

Obnovení verze 
objektu J.9

Pokraèovali jste na práci s objektem, jehož pøechodnou verzi jste 
vytvoøili, a chtìli byste obnovit pøedchozí verzi. J.9

✧ Pomocí myši zvolte požadovaný objekt ze seznamu objektù.

J.9 ✧ Kliknìte na tlaèítko Reload Selected Objects. 

!0

J.9 J.9

Jestliže tuto verzi obnovíte, budou všechny zmìny provedené 
s objektem po uložení pøechodné verze ztraceny. J.9
Verze VE31D J.9–31 
únor 2006
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3D Editor 3D Evaluation
Duplikování objektu J.9 Bìhem práce s objektem jste dospìli k verzi, kterou byste 
nechtìli ztratit tím, že budete pokraèovat v další práci s ní. 
Duplikujte tento objekt a pak pokraèujte v práci na novì 
duplikovaném objektu. Tímto zpùsobem mùžete vytvoøit 
nìkolik verzí objektu pomocí dalších duplikátù. J.9

✧ Pomocí myši vyberte ze seznamu objektù objekt, který chcete 
duplikovat.

J.9 ✧ Klepnìte na tlaèítko Duplicate Selected Object.

Nový objekt je uložen pod stejným názvem, ale s pøíponou 1
(nebo 2, 3,... pro další duplikáty tohoto objektu) na konci 
seznamu objektù. 

J.9

Vytvoøení nového objektu J.9 Pro každou novou extrakci voxelù ze sady dat objektu vytvoøte 
nový objekt. J.9

J.9 ✧ Klepnìte na tlaèítko New Object.

Na konec seznamu objektù bude pøipojen nový objekt s názvem 
new [1] (nebo new [2], new [3],...). J.9
J.9–32 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Vymazání objektu J.9 Ze seznamu mùžete vymazat všechny již nepotøebné objekty. J.9

J.9 ✧ Pomocí myši vyberte objekty, které chcete ze seznamu 
objektù vymazat. 
 

J.9 ✧ Kliknìte na tlaèítko Delete Selected Objects. 

✧ Potvrïte vymazání vybraných objektù v zobrazeném 
dialogovém oknì.
Verze VE31D J.9–33 
únor 2006
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3D Editor 3D Evaluation
Dodateèné zpracování objektù J.9

3D Editor obsahuje funkce Object Punching a Morphological 
Operations pro jemnou úpravu objektù. J.9

Pomocí tìchto funkcí mùžete upravovat existující objekty, ke 
kterým máte pøístup ze seznamu objektù. J.9

Viz také 
→ Strana J.3–47, Nastavení masky viditelnosti J.9

Vyøezávání struktur J.9

V režimu Object Punching mùžete z objektu vyøezávat volnì 
urèené oblasti. J.9

Aktivace 
Object Punching J.9

✧ Zvolte Settings > Editor Region Growing....

Nebo J.9

J.9 ✧ kliknìte na tlaèítko Object Punching na panelu nástrojù 
dialogového okna 3D: Object Editor. 
J.9–34 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Nástroje režimu Object Punching jsou zobrazeny ve spodní 
polovinì dialogového okna 3D: Object Editor. J.9

(1) Nástroje režimu Object Punching. 
Verze VE31D J.9–35 
únor 2006
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3D Editor 3D Evaluation
Definování hloubky  
vyøezání J.9

Vyøezání struktur mùžete rozšíøit na celou sadu dat objektu 
nebo je omezit na jeden trojrozmìrný blok (Slab). Pokud 
pracujete v režimu bloku, je hloubka vyøezání omezena velikostí 
trojrozmìrného bloku. J.9

J.9 ✧ Kliknutím na tlaèítko Use Slab skryjete nebo zobrazíte 
trojrozmìrný blok v blokovém segmentu.

✧ Pokud je to nutné, nastavte požadovanou polohu, rozsah a 
orientaci trojrozmìrného bloku. 
→ Strana J.9–7, Slab Editor 
 

Zakreslení hranice výøezu J.9 Nyní zakreslete kontury kolem struktur objektù, které chcete 
vyøíznout ve výsledném segmentu. J.9

J.9 ✧ Kliknìte na tlaèítko Draw Contour. 

J.9 Kurzor myši zmìní tvar. J.9

✧ Klepnutím myši nastavte poèáteèní bod kontury.

✧ Nastavte pomocí myši další body kontury.
J.9–36 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation 3D Editor
Jednotlivé body kontury budou propojeny rovnými èarami. J.9

Nebo J.9

✧ Yakreslete souvislou èáru kolem požadované struktury se 
souèasnì stisknutým levým tlaèítkem myši.

✧ Poklepáním uzavøete všechny pøíslušné kontury.
Verze VE31D J.9–37 
únor 2006
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3D Editor 3D Evaluation
Úprava hranic výøezu J.9 Hranice výøezu zakreslené pomocí úchytù mùžete prodlužovat, 
zkracovat a posouvat. J.9

✧ Klepnutím na hranici výøezu zobrazte úchyty.

J.9 ✧ Pomocí boèních úchytù zmìòte délku a orientaci hranic 
výøezu.

✧ Pomocí støední grafické znaèky mùžete hranici výøezu 
posunout. 
 
 
 

Odstranìní hranic výøezu J.9 Jestliže zakreslená kontura nesplòuje vaše požadavky, èáru 
vymažte. J.9

✧ Èáru oznaète klepnutím na ni.

✧ Stisknutím klávesy Del na klávesnici hranici výøezu vymažete.
J.9–38 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Vyøezávání struktur J.9 Po zakreslení kontury a úpravì její polohy a rozsahu mùžete 
zobrazit nebo vymazat struktury v kontuøe. J.9

J.9

J.9 ✧ Klepnìte na tlaèítko Keep Inside.

Struktury mimo hranice budou vymazány. J.9

 

Verze VE31D J.9–39 
únor 2006
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3D Editor 3D Evaluation
Nebo J.9

J.9 ✧ Klepnìte na tlaèítko Remove Inside.

Struktury uvnitø hranice budou odstranìny. J.9

➭ Pomocí nástrojù Draw Contour a Remove Inside mùžete z 
objektu postupnì odstraòovat struktury a postupnì 
upravovat objekt podle jeho nejdùležitìjších struktur. 

Zpìt J.9 Pokud neúmyslnì odstraníte libovolnou strukturu, mùžete 
vrátit poslední krok zpìt. J.9

J.9 ✧ Kliknìte na tlaèítko Undo Last.
J.9–40 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Morfologické úpravy J.9

Morfologické operace aplikujete, pokud struktury uvnitø objektu 
nemohou být oddìleny jednoduše pomocí nástrojù pro 
vyøezávání. Mùžete odstraòovat hranièní oblasti v zobrazení 
pomocí obrušování, nebo zmenšování a následného 
roztahování, nebo zvìtšování objektu. Pokud provedete stejné 
operace v obráceném poøadí, budou v objektu vyplnìny malé 
dutiny. J.9

➭ Pomocí funkce Morphological Operations, mùžete také 
vytvoøit mìkèí pøechody, napøíklad pro zobrazení VRT. 

Aktivace morfologických 
operací J.9

✧ Vyvolejte Settings > Editor Morphological Operations....

Nebo J.9

J.9 ✧ kliknìte na tlaèítko Morphological Operations na panelu 
nástrojù dialogového okna 3D: Object Editor. 
Verze VE31D J.9–41 
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3D Editor 3D Evaluation
Nástroje pro morfologické operace se zobrazí ve spodní 
polovinì dialogového okna 3D: Object Editor. J.9

(1) Nástroje režimu Morphological Operations
J.9–42 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Obrušování objektu J.9

J.9 ✧ Pomocí èíselníku zadejte tlouš¤ku povrchu, o kterou má být 
objekt obroušen nebo o kterou má být smrštìn.

J.9 ✧ Potom klepnìte na tlaèítko Erode Object.

Zmenšený objekt se objeví ve výsledném segmentu. J.9

Pokud stále existují struktury skrývající objekt, mùžete zadat 
novou tlouš¤ku povrchu a obrousit objekt znovu. 

J.9

Zpìt J.9 Pokud je výsledek neuspokojivý, mùžete vzít poslední krok zpìt.J.9

J.9 ✧ Kliknìte na tlaèítko Undo Last.
Verze VE31D J.9–43 
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3D Editor 3D Evaluation
Roztahování objektu J.9 Obrousili jste objekt tak, že již neobsahuje skryté struktury. Nyní 
objekt roztáhnìte nebo zvìtšete na požadovanou velikost. J.9

J.9 ✧ Pomocí èíselníku zadejte tlouš¤ku povrchu, o kterou bude 
objekt roztažen. 

J.9 ✧ Potom klepnìte na tlaèítko Dilate Object.

Objekt bude zobrazen s pøíslušnými oblastmi ve výsledném 
segmentu. J.9

➭ Pokud jste pro roztažení objektu nepoužili správnou tlouš¤ku 
povrchu, použijte funkci Undo.
J.9–44 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D Editor
Uzavøení aplikace 3D Editor J.9

Po urèení a vyhodnocení všech struktur jako objektù, které se 
mají zobrazit, mùžete uzavøít 3D Editor. J.9

Po uzavøení 3D Editor budou objekty spoleènì s pùvodní sérií 
uloženy do místní databáze. J.9

Uzavøení aplikace 3D EditorJ.9 Objekt se použije automaticky pøi pøíštím naètení obrazù. V 
tomto kontextu také viz 
→ Strana J.3–47, Nastavení masky viditelnosti J.9

J.9 ✧ Kliknìte na tlaèítko Close v dialogovém oknì 3D: Object 
Editor a 3D Editor se zavøe.

Nebo J.9

J.9 ✧ Klepnìte na tlaèítko Close.
Verze VE31D J.9–45 
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3D Editor 3D Evaluation
J.9–46 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.10

 
3D – odstranìní kosti J.10
Nový nástroj Bone Removal napomáhá k pøesné diagnóze 
odstranìním struktur kostí ze souborù dat. Mùžete jej využít pro 
vizualizaci krevních cév bez narušení anatomických struktur. 
Napø. pro analýzu zlomeniny lze ze souborù vyjmout vybrané 
kosti a zobrazit je. J.10

Pro extrakci nebo maskování struktur mùžete postupovat podle 
pracovního postupu uvedeném v dialogovém oknì 3D: Bone 
Removal. J.10

J.10

J.10

J.10

UPOZORNÌNÍ

Poloautomatický algoritmus použitý pro odstranìní kostí mùže 
odstranit tkáò (napø. cévy, stenty nebo plaky) nebo zanechat 
zlomky kostí. J.10

Nemusí být viditelné všechny pøíslušné struktury tkánì. 
Nepøíslušné zlomky mohou mít také vliv na další výpoèty.J.10

✧ Opravte maskování nastavením meze, síly segmentace a 
tolerance šumu; pøidejte pøíslušné položky nebo odstraòte 
nežádoucí èásti ruènì z masky kosti.
Verze VE31D J.10–1 
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3D – odstranìní kosti 3D Evaluation
Segmentování kostí J.10

J.10 ✧ Stisknìte tlaèítko Bone Removal na kartì dílèí úlohy 
Settings.

-NEBO- J.10

✧ Z hlavní nabídky zvolte Settings > Bone Removal.

Otevøe se slepý Step 1: Select Region. J.10

 

J.10–2 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D – odstranìní kosti
Krok 1: výbìr oblastí J.10

Chcete-li segmentovat struktury, vyberte odpovídající oblast 
tìla. S tímto výbìrem nastavte výchozí globální parametry 
segmentace. J.10

J.10 ✧ Chcete-li vybrat vhodný režim k Bone Removal, kliknìte na 
tlaèítko Body nebo na tlaèítko Head. 
 
 
 
 

J.10 ✧ K extrahování vybraných kostí napø. pro analýzu zlomeniny 
kliknìte na tlaèítko Fracture. 

➭ Doporuèuje se nemìnit výchozí parametry. 

✧ Chcete-li modifikovat pøeddefinovanou prahovou hodnotu 
HU, která závisí na vybraném typu objemu, zvolte pøíkaz 
Advanced >>.
Verze VE31D J.10–3 
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3D – odstranìní kosti 3D Evaluation
J.10 Dialogové okno Advanced >> se zvìtší. J.10

✧ Chcete-li zmìnit prahovou hodnotu HU, pøesuòte posuvník 
Threshold.

Nebo J.10

✧ Kliknutím levým tlaèítkem myši na jednu ze šipek danou 
hodnotu zvyšte (nahoru) nebo snižte (dolù). Hodnotu také 
lze zadat pøímo do zadávacího pole. 
J.10–4 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D – odstranìní kosti
!0

J.10 J.10

➭ Pouze hodnoty nad prahovou hodnotou HU budou uvažovány 
pro další zpracování.

✧ Chcete-li se vrátit k pùvodní pøednastavené hodnotì, zvolte 
pøíkaz Default.

✧ Pomocí pøíkazu Store uložte toto nastavení místnì jako 
novou výchozí hodnotu.

➭ Nastavení hodnoty HU zùstává platné, dokud ji neupravíte.

Varovný symbol oznaèuje, že poèáteèní výchozí prahová 
hodnota 175 HU by se mìla opatrnì opravit pouze v pøípadì, 
že je to nezbytné. J.10
Verze VE31D J.10–5 
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3D – odstranìní kosti 3D Evaluation
Krok 2: Zlepšit J.10

Jakmile jste vybrali vhodný režim segmentace, zahájí se 
pøedbìžné zpracování. Když se procedura ukonèí, automaticky 
se zobrazí Step 2: Refine. J.10
J.10–6 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation 3D – odstranìní kosti
J.10

Ruèní oprava J.10 Manuálnì lze opravit automatickou segmentaci kostí ve všech 
segmentech. J.10

J.10 ✧ Vyberte tlaèítko Set Marker, èímž definujete strukturu jako 
jinou než kostní. 

✧ Umístìte znaèku do kteréhokoli segmentu.

Znaèka je nastavena. Barva znaèky závisí na tom, kde je 
nastavena: v kostní nebo jiné než kostní oblasti. Znaèka mùže 
buï pøidat kost k masce kosti (modrá znaèka) v oblastech, kde 
není definována žádná kost, nebo odstranit kost z masky kosti 
(èervená znaèka) v oblastech, ke je zobrazena kost. J.10

➭ Tažením se znaèky posouvají v rovinì.

Znaèky se zobrazují ve všech pohledech, jakmile provedete Step 
2: Refine a mohou být: J.10

❏ umístìny do jakéhokoliv pohledu (MPR nebo 3D)
❏ vybrány a vymazány

➭ Stisknutím mezerníku na klávesnici mùžete umístit více 
znaèek po sobì.

J.10

UPOZORNÌNÍ

Zobrazení obrazu bude s menším rozlišením, když vylepšíte 
(jako uživatel) masku kosti. J.10

Nemusí být viditelné všechny pøíslušné struktury tkánì. J.10

✧ Ovìøte diagnózu po skonèení maskování kosti na obrazech 
s normálním rozlišením.
Verze VE31D J.10–7 
únor 2006
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3D – odstranìní kosti 3D Evaluation
Nastavení globálních 
parametrù J.10

Tento režim je urèen pouze pro zkušené uživatele. J.10

✧ Zvolením Advanced >> upravíte globální parametry pro 
automatickou segmentaci.

Dialogové okno Advanced >> se zvìtší. J.10

✧ Posuòte posuvník Segmentation Strength tak, abyste 
upravili výchozí hodnotu 50,0 a zlepšili tak pøesnost 
segmentace.

➭ V pøípadì, že jste vybrali Fracture analysis v Step 1, posuvník 
Segmentation Strength není aktivní.
J.10–8 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D – odstranìní kosti
❏ Hodnota 0,0 ponechá témìø všechny kosti neoznaèené
❏ Hodnota 100,0 oznaèí témìø všechny struktury jako kost

➭ Jen struktury s hodnotou HU nad nastavenou prahovou 
hodnotou (výchozí hodnota 175 HU) lze rozeznat jako kosti. 
Objekty s objemem menším než nastavená hodnota nebudou 
oznaèeny jako kost (napø. kalcifikace cévy).

✧ Chcete-li zlepšit rozdíl hodnoty HU mezi fúzovanými objekty, 
posuòte posuvník Noise Tolerance tak, abyste upravili 
výslednou hodnotu.

➭ Toto nastavení ovlivòuje fúzi objektù: Èím je šum v obrazech 
vyšší, tím vyšší musí být hodnota HU.

Všechny struktury, rozeznané jako kostní struktury, se v 
pohledu MPR zvýrazní modøe a v pohledu VRT transparentnì 
modøe. Dvojitým kliknutím na segment aktivujte pohled Blow 
up, abyste získali více podrobností. J.10

J.10
Verze VE31D J.10–9 
únor 2006
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3D – odstranìní kosti 3D Evaluation
Zrušení oprav segmentace J.10 Funkce Undo all, Undo a Redo lze uplatnit na všechny úpravy 
nastavení globálních parametrù. J.10

J.10 ✧ Vyberte pøíkaz Undo all, abyste zrušili všechny pøedchozí 
opravy segmentace a vrátili se k poèáteènímu výsledku 
segmentace. 

J.10 ✧ Stisknutím tlaèítka Undo zrušíte døíve opravené segmentace 
krok za krokem. 

➭ Vrátit zpìt lze až 20 krokù zlepšování.

J.10 ✧ Chcete-li obnovit pøedchozí zrušenou opravu segmentace, 
vyberte pøíkaz Redo. 
 

J.10–10 Návod k použití pro uživatele systému syngo
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3D Evaluation 3D – odstranìní kosti
Krok 3: Ukonèení J.10

Abyste ukonèili segmentaci kostí, ujistìte se, že všechny 
relevantní kostní struktury pro diagnostiku jsou správnì 
oznaèeny a vyjmuty. Nyní mùžete vybrat režim zobrazení pro 
diagnózu a uložit výsledky. J.10

Výbìr režimu zobrazení pro 
pohledy 3D J.10

✧ Kliknìte na pøíkaz Step 3: Finish dialogového okna 3D: Bone 
Removal.

Otevøe se slepý Step 3: Finish. J.10

 

➭ Pro režim Fracture je tlaèítko Bone stisknuto implicitnì.
Verze VE31D J.10–11 
únor 2006
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3D – odstranìní kosti 3D Evaluation
J.10 ✧ Kliknìte na pøíkaz Bone, abyste zobrazili kostní struktury. 
 
 

J.10 ✧ Kliknutím na tlaèítko Highlight zobrazíte jiné než kostní 
struktury ve VRT a kostní struktury ve zvýraznìném VRT. 
 

J.10 ✧ Kliknìte na pøíkaz Non-Bone, abyste zobrazili jiné než kostní 
struktury. 
 

J.10 ✧ Kliknìte na pøíkaz Both, abyste zobrazili kostní a jiné než 
kostní struktury. 

J.10 ➭ Nastavení pro režim zobrazení zùstává platné, i když se slepý 
Step 3: Finish dialogového okna Bone Segmantation zavøe. 
Režim zobrazení lze kdykoliv zmìnit opìtovným vyvoláním 
dialogového okna Step 3: Finish dialogového okna 3D: Bone 
Removal.  

Uložení výsledkù 
segmentace J.10

Výsledky segmentace lze uložit pro opìtovné použití. 
J.10

Výsledky segmentace se použijí automaticky pøi pøíštím naètení 
obrazù. V tomto kontextu také viz 
→ Strana J.3–47, Nastavení masky viditelnosti J.10

J.10 ✧ Chcete-li uložit masku kosti, obsahující výsledky kostní 
segmentace, kliknìte na tlaèítko Save.

➭ Výsledky segmentace kostí lze obnovit použitím uložené 
masky kosti na pùvodní soubor dat.
J.10–12 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.11

 
Fúze J.11
Funkce Fusion vám umožòuje kombinovat výsledky rùzných 
poøizovacích technik nebo snímky poøízené v rùzných dobách 
jejich pøekrýváním. J.11

Pomocí funkce Fusion se prostorovì vyrovnají a pøekryjí dvì 
série snímkù naètené v 3D. Výchozí soubory dat jsou slouèeny 
do nového souboru dat. V této sadì dat jsou shodné páry 
snímkù z tìchto dvou naètených sérií prolnuty a potom je lze 
pro diagnostické úèely zobrazovat jako dva obrazy na sobì. J.11

Možnosti J.11 Tyto funkce jsou volitelné: J.11

❏ vyrovnávání pomocí referenèních bodù

❏ automatická registrace

❏ sjednocování povrchù

J.11

➭ Fúzi nelze použít u systému se dvìma monitory, ale bude se 
používat pouze jeden monitor, pøièemž druhý zùstane 
prázdný a nevyužitý. 

J.11

UPOZORNÌNÍ

Diagnóza na základì prolínajících se obrazù J.11

Nesprávná diagnóza J.11

✧ Jestliže dobøe nevíte, jaké akce byly s obrazem provedeny, 
neprovádìjte diagnózu na základnì prolnutých obrazù.
Verze VE31D J.11–1 
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Fúze 3D Evaluation
Funkce Fusion J.11

Jestliže chcete vyhodnocovat pomocí funkce Fusion, musíte 
provést následující tøi kroky: J.11

❏ naèíst dvì rùzné série snímkù pacienta,

❏ pøekrýt dvì série snímkù,

❏ upravit parametry zobrazení. 

Naètení J.11 V prvním kroku naètete dvì sady dat objektu na kartì 3D, jednu 
referenèní sérii a jednu modelovou sérii. J.11

Referenèní série slouží jako podklad pøi následném pøekrývání 
dvou sad dat objektu. J.11

Modelová série se prostorovì vyrovná s referenèní sérií. J.11

Vyrovnání J.11 Pøi vyrovnávání jsou data modelové série vyrovnána s referenèní 
sérií. J.11

Dvì série obrázkù mùžete vyrovnat automaticky (Automatic 
Registration) zvolením prahových hodnot (Surface Matching), 
pøiøazením bodù (landmarks) nebo vizuálním posunutím 
modelové série (visual alignment). J.11

Upravování sady dat 
prolínajícího se snímku J.11

Po úspìšném vyrovnání mùžete sady dat snímkù upravit, aby 
jejich zobrazení bylo pøesnìjší. Jednotlivé série snímkù mùžete 
vyvážit a zmìnit barevné zobrazení prolínajících se snímkù. U 
slouèené sady dat snímkù pak mùžete použít celou škálu funkcí 
pro trojrozmìrné zpracování. J.11

→ Strana J.3–40, Urèení typù výstupù J.11
J.11–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Spuštìní funkce Fusion J.11

K provádìní funkce Fusion potøebujete dvì sady dat objemu, 
referenèní sérii a modelovou sérii. J.11

Obì série snímkù by se mìly vztahovat na pøibližnì stejný 
rozsah vyšetøení. J.11

J.11

➭ Jestliže zvolíte sadu dat již zpracovanou funkcí Fusion, bude 
naètena na kartì 3D spoleènì s døíve uloženým vyrovnáním. 
Pøekryté série pak už není nutné znovu vyrovnávat.
Verze VE31D J.11–3 
únor 2006
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Fúze 3D Evaluation
Naètení sady dat snímkù J.11

Pro vyhodnocení funkcí Fusion vyberete obvykle dvì série 
snímkù v programu Patient Browser a jednu po druhé 
pøevedete na kartu úlohy 3D. J.11

Jestliže jste referenèní sérii již zpracovali v 3D pomocí jiné 
funkce (napø. editorem), mùžete naèíst chybìjící modelovou 
sérii z programu Patient Browser. J.11

➭ Jestliže chcete naèíst série snímkù rùzných pacientù, musíte 
potvrdit pøíslušné hlášení. Pøekrytí snímkù rùzných pacientù 
bude oznaèeno v textu snímku.

J.11

➭ Je-li naètený soubor dat PET nebo NM, okno 3D: Rotating MIP
se zobrazí automaticky, je-li k dispozici licence pro tuto funkci. 
→ Strana J.5–41, Otáèení MIP

J.11

UPOZORNÌNÍ

Neúmyslné naètení sad obrazových dat rùzných pacientù J.11

Možnost zámìny pacientù a nesprávné diagnózy J.11

✧ Pøi naèítání referenèní a modelové série dbejte na to, abyste 
zvolili data správného pacienta. Budete požádáni o 
potvrzení pøíslušného hlášení.
J.11–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Naètení nové série J.11 ✧ Spus¤te program Patient Browser (Patient > Browser...).

✧ V navigaèní nebo obsahové oblasti vyberte sérii, kterou 
chcete používat jako referenèní obrazy. 
→ Strana C.2–6, Procházení údajù o pacientovi a jejich výbìr

✧ Z hlavní nabídky zvolte Applications > 3D > MPR.

Nebo J.11

J.11 ✧ Kliknìte na tlaèítko 3D MPR v panelu nástrojù Patient 
Browser.

➭ Jestliže jste aktivovali funkci Close after Loading, dialogové 
okno Patient Browser se zavøe okamžitì po naètení obrazù. 

✧ V navigaèní nebo obsahové oblasti programu Patient 
Browser vyberte sérii, kterou chcete používat jako modelové 
snímky.

✧ Z hlavní nabídky zvolte Applications > 3D > Fusion.

Nebo J.11

J.11 ✧ Kliknìte na tlaèítko 3D Fusion v panelu nástrojù Patient 
Browser. 

J.11
Verze VE31D J.11–5 
únor 2006
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Fúze 3D Evaluation
Následné naèítání modelové 
série J.11

Již jste naèetli data snímku do karty úlohy 3D a teï chcete tato 
data pøekrýt sadou dat snímku jiné úlohy. J.11

✧ Spus¤te program Patient Browser (Patient > Patient 
Browser...).

✧ V navigaèní nebo obsahové oblasti programu Patient 
Browser vyberte sérii, kterou chcete použít pro modelové 
snímky.

✧ Z hlavní nabídky zvolte Applications > 3D > Fusion.

Nebo J.11

J.11 ✧ klepnìte na tlaèítko Fusion v panelu nástrojù programu 
Patient Browser.
J.11–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Karta 3D v režimu Fusion J.11

Snímky naètené referenèní a modelové série jsou pøekrytì 
zobrazeny v prvních tøech segmentech. J.11

Ve ètvrtém segmentu je zobrazeno dialogové okno, které vám 
pomáhá pøi vyrovnávání snímkù v referenèní a modelové sérii.J.11

(1) Obrazová oblast 
tøi pravoúhlá zobrazení naètených obrazù.

(2) Dialogové okno 3D: Fusion Registration 
obslužné prvky pro pøekrývání obrazù.

(3) Karta dílèí úlohy Settings 
tlaèítka pro pøekrývání a zobrazování obrazù.
Verze VE31D J.11–7 
únor 2006
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Fúze 3D Evaluation
Vyrovnání série snímkù J.11

Po naètení série snímkù urèené pro zpracování pomocí funkce 
Fusion, mùžete vyrovnat jejich orientaci a otoèení. Tyto kroky 
provedete pomocí dialogového okna 3D: Fusion Registration.J.11

✧ Z hlavní nabídky zvolte Fusion > Fusion Registration....

Nebo J.11

J.11 ✧ Kliknìte na tlaèítko Registration na kartì dílèí úlohy Image.

 

J.11–8 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Fúze
Dialogové okno 3D: Fusion Registration obsahuje následující 
funkce: J.11

❏ Registration Matrix 
Tato funkce uvádí všechny dostupné matrice (matrice 
definované uživatelem, poèáteèní a výchozí matrice). Po 
zadání nového jména na tomto místì mùžete aktuální 
registraci uložit jako novou matrici nebo ji vymazat.

J.11 ❏ Landmarks  
Obì naètené série obrazù jsou automaticky zpracovány tak, 
aby se pomocí vhodných referenèních bodù navzájem 
shodovaly.

J.11 ❏ Visual Alignment 
Tyto dvì naètené série obrazù jsou zpracovány (ruènì) tak, 
aby se vizuálnì navzájem shodovaly. 

J.11 ❏ Surface Matching 
Tyto dvì naètené série obrazù jsou zpracovány tak, aby se na 
základì pøednastavených prahových hodnot pro strukturu 
tkánì navzájem shodovaly. 

J.11 ❏ Automatic Registration 
Tyto dvì naètené série jsou zpracovány tak, aby se navzájem 
shodovaly. 
Verze VE31D J.11–9 
únor 2006
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Fúze 3D Evaluation
Registration Matrix J.11

Uložením odpovídající registraèní matice uložíte prùbìžné kroky 
nebo koneèný výsledek registrace fúze. Mùžete také pøiøadit 
poèáteèní nebo výchozí matrici. J.11

Matrice bude uložena do Local Database. Najdete ji v referenèní 
sérii "3D Application Data" jako nesnímkový objekt. J.11

Jestliže registrujete sérii poprvé (a neurèili jste ještì žádné 
matrice), budou zobrazeny pouze matrice Initial a Default. J.11

Initial J.11 Jestliže není naposledy uložené pøekrytí vhodné, mùžete jej 
vrátit do výchozí polohy. J.11

✧ Ze seznamu Registration matrix vyberte položku Initial. 

Default J.11 Jestliže pracujete s kombinovaným zaøízením (napø. se 
skenerem CT-PET), máte ještì další volbu: naèíst výchozí 
vyrovnání uložené v systému a použít jej k vyrovnání referenèní 
a modelové série. J.11

✧ Ze seznamu Registration matrix vyberte položku Default. 

User Defined J.11 Po vyrovnání série (která zmìní matrici) a použití tlaèítka Save 
Matrix uloží se pro tuto registraci matrice s názvem „User 
Defined" (název matrice mùžete zmìnit). J.11

Pozdìji mùžete uložit novìjší verze nebo již existující verze 
aktualizovat. 

J.11
J.11–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Opìtovné používání matricJ.11 Pøi dalším naètení dvou sérií bude automaticky naètena 
naposledy použitá matrice. Tuto matrici mùžete dále upravovat 
nebo ji zmìnit a uložit pod jiným názvem. J.11

➭ Matrici pro registrovanou sérii mùžete znovu použít spoleènì 
s jinou sérií, pokud jsou geometricky kompatibilní. 

Uložení registraèní matrice  
J.11

V dialogovém oknì 3D: Fusion Registration zadejte do pole 
Registration matrix namísto uvedeného názvu nový název nebo 
jestliže chcete existující verzi matrice aktualizovat, uložte ji pod 
stejným názvem. J.11

➭ Není možné pøepsat matrici Default a Initial. Pokud se 
takovou matrici pokusíte pøepsat, uloží se matrice pod 
vygenerovaným názvem: ”User Defined”.

J.11 ✧ Kliknìte na ikonu Save Matrix. 
 
 

Vymazání uložené matrice J.11 ✧ Ze seznamu Registration Matrix vyberte název.

J.11 ✧ Kliknìte na ikonu Delete Matrix.

Vybraná registraèní matrice bude vymazána ze seznamu a z 
databáze. J.11

➭ Není možné odstranit matrici Default a Initial.
Verze VE31D J.11–11 
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Fúze 3D Evaluation
Vizuální vyrovnání snímkù J.11

Pomocí funkce Visual Alignment uvedete referenèní a 
modelovou sérii navzájem v soulad, a to tak, že postupnì 
vyrovnáváte modelové obrazy ve tøech segmentech s 
referenèními obrazy. J.11

J.11 ✧ Kliknutím na tlaèítko Visual Alignment v dialogovém oknì 
3D: Fusion Registration zobrazte funkce Visual Alignment.

(1) Dvojitá smìrová šipka 
pro pøesuny velkých obrazù

(2) Jednoduchá smìrová šipka 
pro pøesuny malých obrazù

(3) Dvojitá otoèná šipka 
pro otáèení velkých obrazù

(4) Jednoduchá otoèná šipka 
pro otáèení malých obrazù

(1)

(2)

(3)

(4)
J.11–12 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Tyto dvì série snímkù jsou zobrazeny pøekrytì. Ve tøech 
segmentech oblasti snímku vidíte tøi ortogonální pohledy 
referenèních a modelových snímkù. Rùzné zbarvení vám má 
pomoci pøi jejich rozlišení. J.11

 

Verze VE31D J.11–13 
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Fúze 3D Evaluation
Zpracování obrázkù J.11 Pomocí funkce zoom/pan a rotate object najdete nejvhodnìjší 
polohu, z níž mùžete zahájit vyrovnání dvou sérií. J.11

J.11 ✧ Aktivujte možnost zoom/pan pomocí funkce SmartSelect. 
 
 
 
 

Nebo J.11

J.11 ✧ kliknìte na ikonu Zoom/Pan v horní èásti ovládací oblasti. 

✧ Zvìtšete, zmenšete obraz nebo jej posuòte. 

✧ Aktivujte možnost rotate object pomocí funkce SmartSelect.

Nebo J.11

J.11 ✧ Kliknìte na ikonu tlaèítka v horní èásti ovládací oblasti. 

✧ Otoète snímek.

J.11
J.11–14 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Posunutí modelové série J.11 ✧ Jestliže chcete model vyrovnat, aktivujte volbu align model 
pomocí funkce SmartSelect.

✧ Za stisknutého tlaèítka myši pøetáhnìte modelovou sérii ze 
støedu segmentu požadovaným smìrem

Nebo J.11

J.11 ✧ Klepnìte na jednoduchou šipku udávající smìr v pøehledném 
znázornìní okna funkce Visual Alignment.

Modelová série se posune zvoleným smìrem o 1 mm. J.11

Nebo J.11

J.11 ✧ Klepnìte na dvojitou šipku udávající smìr.

Modelová série se posune zvoleným smìrem o 10 mm. 
J.11

Otoèení modelové série J.11 ✧ Jestliže chcete model vyrovnat, aktivujte volbu align model 
pomocí funkce SmartSelect.

✧ Jestliže chcete modelovou sérii otoèit v rovinì, stisknìte levé 
tlaèítko myši a se stisknutým tlaèítkem posuòte kurzor myši 
kolem okraje segmentu

Nebo J.11

J.11 ✧ Klepnìte na jednoduchou šipku udávající smìr otáèení v 
pøehledném znázornìní okna funkce Visual Alignment.

Modelová série se otoèí zvoleným smìrem o 1°. J.11

Nebo J.11

J.11 ✧ Klepnìte na dvojitou šipku udávající smìr otáèení.

Modelová série se otoèí zvoleným smìrem v krocích po 10°. 
J.11
Verze VE31D J.11–15 
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Fúze 3D Evaluation
Uložení vyrovnaných 
snímkù J.11

Všechna úspìšnì provedená vyrovnání mùžete okamžitì uložit. J.11

Tyto uložené verze mùžete v pøípadì potøeby kdykoli naèíst 
zvolením odpovídající matrice ze seznamu registraèních matric.J.11

!0

J.11 J.11

J.11 ✧ Kliknutím na tlaèítko Save Matrix uložte aktuální matrici 
vyrovnání. 

➭ Vyrovnání mùžete ukládat jak èasto chcete. Pøedchozí 
výsledek pak bude pøepsán novým.

Kdykoli pøi otáèení a pohybování snímky dosáhnete zlepšení, 
mìli byste nové vyrovnání uložit do databáze. Jestliže se série 
zaènou opìt rozcházet, mùžete se vrátit k pøedešlému 
výsledku. J.11
J.11–16 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Vyrovnávání obrazù pomocí referenèních 
bodù J.11

Jestliže jste v obou sadách dat nalezli zvláštní struktury, mùžete 
série snímkù vyrovnat pomocí referenèních bodù. J.11

J.11 ✧ Kliknìte na tlaèítko Landmarks v dialogovém oknì 3D: 
Fusion Registration, aby se zobrazily funkce Landmarks.

 

(1) Tlaèítka 
pro nastavení a úpravu referenèních bodù.

(2) Seznam referenèních bodù 
s odchylkou od aktuálního vyrovnání (když existují alespoò 
tøi páry urèených referenèních bodù)

(1)

(2)
Verze VE31D J.11–17 
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Fúze 3D Evaluation
Standardní rozvržení J.11 Referenèní série se zobrazuje ve dvou levých segmentech a 
modelová série v pravých segmentech oblasti snímku. Každým 
segmentem snímku se mùžete zabývat samostatnì. J.11

(1) Referenèní obrazy 
Sagitální pohled nahoøe, axiální pohled dole

(2) Modelové obrazy 
Sagitální pohled nahoøe, axiální pohled dole

(3) Referenèní èáry s nitkovým køížem 
na všech obrazech
J.11–18 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Rozvržení 9:1 J.11 Volitelnì mùžete vybrat rozvržení segmentu 9:1. J.11

✧ Chcete-li zobrazit obrazy v rozvržení 9:1, vyvolejte View > 9:1 
z hlavní nabídky.

Nebo J.11

J.11 ✧ Stisknìte tlaèítko 9:1 na kartì dílèí úlohy Image.

J.11

Referenèní série se zobrazuje v levém sloupci, modelová série ve 
støedním sloupci a fúzované obrazy se zobrazují v pravém 
sloupci obrazové oblasti. Postup vyrovnání mùžete sledovat ve 
tøetím sloupci. J.11
Verze VE31D J.11–19 
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Fúze 3D Evaluation
Do pomìru rozvržení 4:1 se kdykoli mùžete vrátit. J.11

✧ V hlavní nabídce zvolte pøíkaz View > 4:1.

Nebo J.11

J.11 ✧ Stisknìte tlaèítko 4:1 na kartì dílèí úlohy Image.
J.11–20 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Urèování referenèních  
bodù J.11

Nejdøíve urèete referenèní bod v rozpoznatelném místì v 
objemu. Potom umístìte pøidružený druhý referenèní bod do 
pøíslušné polohy v druhé sérii. Výsledkem je pár referenèních 
bodù, na kterém je založen systém vyrovnávání modelové série 
se sérií referenèní. J.11

✧ V referenèních segmentech nastavte pohledy, na nichž jasnì 
vidíte polohu pro referenèní bod.

✧ Pøidržením levého tlaèítka myši pøesuòte nitkový køíž do 
nìkterého referenèního segmentu k požadované poloze 
referenèního bodu.

✧ V druhém referenèním segmentu zkontrolujte, zda je nitkový 
køíž umístìn ve správné poloze a v pøípadì nutnosti ho 
pøesuòte.

✧ Stejným zpùsobem nyní urèete pøidružený referenèní bod na 
modelové stranì.

J.11 ✧ Klepnutím na tlaèítko Add bude pár referenèních bodù 
použit.

Nový referenèní bod je oèíslován a zadán do seznamu 
referenèních bodù. Systém teï pøidržuje modelovou sérii v 
urèených referenèních bodech s referenèní sérií. J.11

➭ Èím více bodù urèíte, tím pøesnìjší bude pøekrývání tìchto 
dvou sérií snímkù. Pøed trojrozmìrným vyrovnáním sérií 
musíte urèit minimálnì tøi referenèní body. Mùžete zadat až 
100 znaèek.
Verze VE31D J.11–21 
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Fúze 3D Evaluation
Zobrazení referenèního 
bodu J.11

J.11

✧ Klepnìte v seznamu na záznam týkající se referenèního 
bodu.

J.11 ✧ Kliknìte na tlaèítko Go to.

Nebo J.11

✧ Poklepejte na pøíslušný záznam.

Nitkový køíž se pøesune do polohy, kde se nachází zvolený 
referenèní bod. Zobrazený referenèní bod je oznaèen v tabulce 
modrým pozadím. 

J.11

Pøesunutí referenèního 
bodu J.11

✧ Zobrazte referenèní bod.

✧ Se stisknutým levým tlaèítkem myši pøesuòte nitkový køíž v 
obou sériích do požadované polohy.

✧ Klepnìte na tlaèítko Update.

J.11

Vymazání referenèního 
bodu J.11

✧ Zobrazte referenèní bod.

J.11 ✧ Klepnìte na tlaèítko Remove.

Oznaèený referenèní bod je vymazán. 
J.11
J.11–22 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Vymazání všech 
referenèních  
bodù J.11

J.11 ✧ Jestliže chcete vymazat všechny urèené referenèní body, 
klepnìte na tlaèítko Remove All.

Zobrazí se dialogové okno, v nìmž musíte vymazání všech 
referenèních bodù potvrdit. J.11

J.11

Uložení vyrovnaných 
snímkù J.11

J.11 ✧ Kliknutím na tlaèítko Save Matrix uložte aktuální matrici 
vyrovnání. 
→ Strana J.11–16, Uložení vyrovnaných snímkù 
→ Strana J.11–15, Otoèení modelové série
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Fúze 3D Evaluation
Automatická registrace J.11

Pomocí funkce Automatic Registration je modelová série 
automaticky vyrovnána s referenèní sérií. Tento postup se 
používá zejména pro série snímkù stejného pacienta snímané 
rùznými zpùsoby. J.11

J.11 ✧ Kliknìte na tlaèítko Automatic Registration v dialogovém 
oknì 3D: Fusion Registration, aby se zobrazily funkce 
Automatic Registration.

J.11

✧ Je dùležité pøibližnì vyrovnat modelovou sérii v segmentech 
s referenèní sérií. 
→ Strana J.11–15, Posunutí modelové série 
→ Strana J.11–15, Otoèení modelové série

✧ Pro velmi pøesné pøekrytí zvolte položku Precise registration 
a pro rychlé pøekrytí zvolte položku Fast registration.

J.11 ✧ Klepnìte na tlaèítko Register.
J.11–24 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Obì série snímkù jsou nyní pøipraveny se spojit a úspìšnì 
navzájem vyrovnat. Prùbìh pøekrývání mùžete sledovat v 
oblasti snímku ve tøech ortogonálních pohledech. J.11
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Fúze 3D Evaluation
Zobrazí se dialogové okno s prùbìhem vyrovnávání. J.11

J.11 ✧ Jestliže jste s spokojeni výsledkem a nechcete èekat na 
dokonèení operace, klepnìte na tlaèítko Stop.

Bude zachováno souèasné vyrovnání. J.11

Uložení vyrovnaných 
snímkù J.11

J.11 ✧ Kliknutím na tlaèítko Save Matrix uložte aktuální matrici 
vyrovnání. 
→ Strana J.11–16, Uložení vyrovnaných snímkù

J.11
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3D Evaluation Fúze
Sjednocování povrchù J.11

Pomocí funkce Surface Matching vyrovnáte modelové snímky 
s referenèními snímky na základì prahových hodnot 
odpovídajících struktuøe urèité tkánì. Tento postup se používá 
pøi porovnávání rùzných sad dat stejného pacienta. J.11

J.11 ✧ Kliknìte na tlaèítko Surface Matching v dialogovém oknì 
3D: Fusion Registration, aby se zobrazily funkce Surface 
Matching.

J.11

(1) Prahové hodnoty referenèních sérií

(2) Prahové hodnoty modelové série

(1) (2)
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Fúze 3D Evaluation
Referenèní série se zobrazuje ve dvou levých segmentech a 
modelová série v pravých segmentech oblasti snímku. J.11

(1) Referenèní obrazy 
Axiální pohled (MPR) nahoøe, koronální pohled (SSD) dole

(2) Modelové obrazy 
Axiální pohled (MPR) nahoøe, koronální pohled (SSD) dole

(1)
(2)
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3D Evaluation Fúze
Zadání prahových hodnot J.11 ✧ Zvolte strukturu tkánì, kterou chcete ve dvou sériích snímkù 
sjednotit (napø. kost, kùže).

✧ Vyberte modalitnì závislé prahové hodnoty pro referenèní 
sérii, které odpovídají dané struktuøe tkánì.

✧ Vyberte odpovídající prahové hodnoty pro modelovou sérii.

Oblasti snímku v daném rozmezí v odpovídajících segmentech 
jsou barevnì zvýraznìny. J.11

Zahájení pøekrývání J.11

J.11 ✧ Kliknìte na tlaèítko Register v dialogovém oknì 3D: Fusion 
Registration.

Obì série snímkù jsou nyní pøipraveny se spojit a úspìšnì 
navzájem vyrovnat. Prùbìh pøekrývání mùžete sledovat v 
oblasti snímku ve tøech ortogonálních pohledech. J.11
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Fúze 3D Evaluation
Prùbìh vyrovnání je zobrazen pomocí sloupcového ukazatele.J.11
J.11–30 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
J.11

J.11 ✧ Jestliže jste s spokojeni výsledkem a nechcete èekat na 
dokonèení pøekrývání, klepnìte na tlaèítko Stop.

Bude zachováno souèasné vyrovnání. J.11

Zmìna prahových 
hodnot J.11

Jakmile zaènete s pøekrýváním, tlaèítko Register se zmìní na 
Define. 
Pomocí funkce Define máte možnost opakovat pøekrývání s 
jinými prahovými hodnotami. J.11
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Fúze 3D Evaluation
J.11

J.11 ✧ Klepnìte na tlaèítko Define.

Obrazy referenèní a modelové série se nyní zobrazí opìt vedle 
sebe a prahové hodnoty mùžete zmìnit. 

J.11

Uložení vyrovnání J.11

J.11 ✧ Kliknutím na tlaèítko Save Matrix uložte aktuální matrici 
vyrovnání. 
→ Strana J.11–16, Uložení vyrovnaných snímkù

J.11
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3D Evaluation Fúze
Ukonèení vyrovnání J.11

Jestliže je vyrovnání modelové a referenèní série dostateènì 
pøesné, mùžete pøekrytí uložit do místní databáze. J.11

Použití pøekrytí J.11 J.11

J.11 ✧ Kliknutím na tlaèítko OK zachovejte dosud provedené 
vyrovnání. 

Zrušení pøekrývání J.11

J.11 ✧ Jestliže chcete vyrovnání odstranit z databáze, klepnìte na 
tlaèítko Cancel.
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Fúze 3D Evaluation
Zobrazení pøekrývajících se snímkùJ.11

Po vyrovnání sady dat obrazù a potvrzení pøekrytí mùžete tyto 
sady dat zobrazit jak vedle sebe (Side-by-Side), tak pøekrytì 
(Fusion). J.11

Režim Side by Side J.11

V režimu Side by Side jsou obì sady dat obrazù zobrazeny vedle 
sebe v samostatných segmentech. J.11

✧ Z hlavní nabídky zvolte Fusion > Fusion Side by Side.

Nebo J.11

J.11 ✧ Kliknutím na tlaèítko Side by Side na kartì dílèí úlohy Image 
aktivujte zobrazení vedle sebe.
J.11–34 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
 

Levá oblast snímku se používá pro zobrazení referenèních 
snímkù a pravá pro modelové snímky. Pøi pøiøazování v prostoru 
se zobrazí dva spojené kurzory myši, které se synchronnì 
pohybují obìma sadami dat. Zdvojený kurzor myši je barevnì 
oznaèen. J.11
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Fúze 3D Evaluation
Volitelné rozvržení J.11 Volitelnì mùžete vybrat rozvržení segmentu 9:1. 
→ Strana J.11–19, Rozvržení 9:1 J.11

Levý sloupec je použit k zobrazení referenèních obrazù, støední 
pro modelové obrazy a pravý sloupec pro obrazy smíšené 
metodou alfa. Pøi pohybu kurzorem myši pøes jeden segment se 
v horizontálních sousedících segmentech zobrazí dva spojené 
kurzory, pohybující se synchronizovanì. J.11
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3D Evaluation Fúze
Nastavení pohledu J.11 V režimu Side by Side procházíte sadou obrazù v referenèním 
segmentu. V modelovém segmentu se automaticky zobrazí 
odpovídající snímek. Pohled slouèené sady dat mùžete zmìnit 
nìkterým následujícím zpùsobem: J.11

❏ Procházení 
→ Strana J.3–17, Listování pomocí záložek

❏ Natoèení objektu pomocí myši 
→ Strana J.3–20, Natoèení objektu pomocí myši

❏ Nastavení standardních pohledù 
→ Strana J.3–28, Nastavení standardních pohledù

❏ Použití nitkového køíže 
→ Strana J.3–13, Použití trojrozmìrného nitkového køíže

J.11

Nastavení režimu zobrazeníJ.11 V režimu Side by Side jsou možné následující režimy zobrazení:J.11

J.11 ❏ MPR, MPR Thick 
 

J.11 ❏ MIP, MIP Thin 
 

❏ MinIP, MinIP Thin 

J.11 ❏ Fused MPR, Fused MIP 
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Fúze 3D Evaluation
J.11 ❏ SSD 
 

J.11 ❏ VRT, VRT Thin 
 

✧ Klepnìte na pøíslušné tlaèítko na kartì dílèí úlohy Type.

➭ Pro tøetí sloupec volitelného rozvržení 9:1 jsou jedinými 
dostupnými režimy zobrazení režimy Fused MPR a Fused MIP. 

Ukonèení režimu Side by 
Side J.11

J.11 ✧ Kliknutím na tlaèítko Side by Side uzavøete pohled Side by 
Side.

Slouèená sada dat je nyní zobrazena v režimu Fúze. J.11
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3D Evaluation Fúze
Režim Fusion J.11

V režimu Fusion jsou obì sady obrazových dat zobrazeny jako 
dva diapozitivy na sobì. J.11

✧ V hlavní nabídce zvolte Fusion > Fused MPR.

Nebo J.11

J.11 ✧ Klepnìte na tlaèítko Fused MPR na kartì dílèí úlohy Type do 
zvoleného segmentu typu MPR.

 

Tyto dvì sady dat snímkù se zobrazují v rùzných barvách, které 
pomáhají pøi jejich rozlišení. Pøekrývající se sada dat snímku má 
podobu tøí ortogonálních zobrazení ve tøech segmentech, tedy 
stejnou jako pro funkci Visual Alignment. J.11
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Fúze 3D Evaluation
Nastavení pohledu J.11 V režimu Fúze procházíte v každém segmentu sadou snímkù. 
Pohled slouèené sady dat mùžete zmìnit nìkterým následujícím 
zpùsobem: J.11

❏ Procházení 
→ Strana J.3–17, Listování pomocí záložek

❏ Natoèení objektu pomocí myši 
→ Strana J.3–20, Natoèení objektu pomocí myši

❏ Nastavení standardních pohledù 
→ Strana J.3–28, Nastavení standardních pohledù

❏ Použití nitkového køíže 
→ Strana J.3–13, Použití trojrozmìrného nitkového køíže

!0

J.11 J.11

Vytváøení zakøivených øezù, objektù aplikace 3D Editor a výøez 
VOI má vliv pouze na referenèní sérii. J.11
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3D Evaluation Fúze
Zmìna zobrazení J.11

Po úspìšném pøekrytí obrazù mùžete optimalizovat nastavení 
hodnot okna, smìšovací pomìr a barevné zobrazení obrazù tak, 
abyste snadnìji rozpoznali struktury jednotlivých sad 
obrazových dat. J.11

✧ V hlavní nabídce zvolte Fusion > Fusion Definition. 

Nebo J.11

✧ Klepnìte pravým tlaèítkem myši na tlaèítko Fused MPR.

J.11 Zobrazí se dialogové okno 3D: Fusion Definition MPR.

 

J.11
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Fúze 3D Evaluation
Vyvážení snímkù v 
segmentu J.11

✧ Stisknutím støedního tlaèítka myši v levém segmentu a 
pøetažením myši se stisknutým tlaèítkem zmìòte polohu 
okna (jas) a šíøku okna (kontrast) referenèní série.

Nebo J.11

✧ Stisknutím støedního tlaèítka myši v pravém segmentu a 
pøetažením myši se stisknutým tlaèítkem zmìòte polohu 
okna (jas) a šíøku okna (kontrast) modelové série. 
→ Strana E.4–15, Vyvážení pomocí myši

Vyvážení v dialogovém  
oknì J.11

J.11

✧ Posunutím jezdce dané sady dat zmìòte nastavení vyvážení 
(jas).

✧ Posunutím pravého nebo levého okraje diapozitivu zmìòte 
šíøku okna (kontrast). 

Nebo J.11

✧ pomocí èíselníku zadejte hodnoty vyvážení a potvrïte je 
klávesou Enter. 

➭ Jestliže pracujete s nukleárními lékaøskými snímky, mùžete 
jezdce urèujícího oblast oken posunout i mimo rozmezí 
zobrazené v dialogovém oknì. 
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3D Evaluation Fúze
SUV (standardní hodnoty 
vychytávání) J.11

Zaškrtávací políèko SUV (standardní hodnota vychytávání) bude 
zobrazeno pouze u snímkù PET. J.11

J.11 ✧ Toto pole zaškrtnìte, pokud chcete namísto výchozích 
procentuálních hodnot použít hodnoty SUV pro tkáò.

J.11

J.11

J.11

UPOZORNÌNÍ

Výpoèet SUV je založen na nejstarším datu a èase poøízení 
zvolených a naètených sad dat a první obraz (s nejstarším 
datem a èasem poøízení) není v daném výbìru. J.11

Nesprávný výpoèet SUV J.11

✧ Ujistìte se, že jste vybrali první obraz ze souboru dat pro 
správný výpoèet.
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Fúze 3D Evaluation
Smìšovací pomìr J.11 Jestliže chcete zdùraznit urèitou informaci nìkteré ze dvou sady 
dat snímkù, zvyšte její relativní váhu v prolínajícím se snímku.J.11

✧ Levým tlaèítkem myši táhnìte jezdce smìrem k sadì dat, 
jehož intenzitu chcete zvýšit. 
 

Zobrazení J.11 Referenèní sérii mùžete odlišit od modelové série pøesnìji, 
pokud zmìníte barevné oznaèení sady dat snímkù. J.11

✧ V pøíslušném seznamu vyberte požadované barevné 
znázornìní pro referenèní nebo modelovou sadu dat (LUT, 
Look Up Table). 
→ Strana J.8–9, Zmìna zobrazení snímku pomocí barevných 
tabulek LUT 
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3D Evaluation Fúze
Rozšíøené J.11 Zobrazí se dialogové okno 3D: Fusion Definition MPR je èást 
pro rozšíøené krytí, na základì kterého v prolnutém zobrazení 
skryjete obrazové body v urèitém rozmezí. J.11

J.11 ✧ Klepnìte na tlaèítko Advanced >>.

Dialogové okno Fusion Definition se zvìtší a mùžete do nìj 
zadat rozmezí, v jakém chcete obrazové body skrýt. J.11

➭ Pokud chcete skrýt oblast èíselného nastavení, jednoduše 
kliknìte znovu na tlaèítko Advanced << . 
Verze VE31D J.11–45 
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Fúze 3D Evaluation
Krytí J.11 Pomocí krycí funkce mùžete urèit prahové hodnoty viditelnosti 
pro referenèní sérii a jiné hodnoty pro modelovou sérii. Pro 
smìšování alfa se používají pouze hodnoty stupnice šedi v rámci 
prahových hodnot. J.11

✧ Rozmezí skrytých obrazových bodù zmìníte pohybem levé 
nebo pravé úchytky jezdce

Nebo J.11

✧ Zadáním hodnoty do odpovídajících polí L(ow) nebo H(igh).

Nebo J.11

✧ Pøetažením jezdce do jiné polohy, èímž zcela posunete 
rozmezí.

Zmìna se okamžitì odrazí v zobrazených smíšených 
segmentech. Všechny obrazové body mimo interval prahové 
hodnoty budou ignorovány. V ostatních sériích nebudou více 
smíšeny. J.11

➭ Prahové hodnoty krytí budou uloženy v registraèní matrici, 
stejnì jako všechny další smìšovací parametry.
J.11–46 Návod k použití pro uživatele systému syngo
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3D Evaluation Fúze
Fúzovaný volný pohled J.11

Fúzovaný volný pohled bude aktivován pouze pokud jsou 
naèteny dvì sady dat, jinak bude aktivován volný pohled. J.11

Ve fúzovaném volném pohledu mùžete pomocí rovin zábìru a 
trojrozmìrného výøezu oddìlit èást prolnuté sady dat objektu a 
pøitom skrýt oblast, kterou nepotøebujete zobrazit. J.11

V segmentu fúzovaného volného pohledu se sada dat naètená 
jako první zobrazí v režimu VRT. Sada dat naètená jako druhá je 
rovina zábìru (MIP nebo MPR) smíšená metodou alfa do první 
sady dat, podle pøedem vypoèítané registraèní matice. J.11

J.11

(1) Segmenty smíšené metodou alfa v režimu Fusion

(2) Segment fúzovaného volného pohledu
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Fúze 3D Evaluation
Otevøení  
fúzovaného volného 
pohledu J.11

✧ Z hlavní nabídky zvolte položku Settings > Free View Fused.

Nebo J.11

J.11 ✧ Kliknìte na tlaèítko Free View na kartì dílèí úlohy Settings. 

Fúzovaný volný pohled se zobrazí ve výstupním segmentu a 
automaticky se otevøe dialog Fused VRT Definition. J.11

J.11
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3D Evaluation Fúze
Režim zobrazení J.11 Režim zobrazení roviny zábìru mùžete vybrat. J.11

J.11 ✧ Kliknìte na ikonu MIP nebo MPR. 
 

Viditelnost J.11 Jestliže chcete zdùraznit urèitou informaci nìkteré ze dvou sady 
dat snímkù, zvyšte její relativní váhu v prolínajícím se snímku.J.11

✧ Levým tlaèítkem myši táhnìte jezdce smìrem k sadì dat, jejíž 
intenzitu chcete zvýšit (0% - MIP/MPR je prùhledný, 100% - 
MIP/MPR je neprùhledný). 
 

Tabulka vyhledávání barevJ.11 Referenèní sérii mùžete odlišit od modelové série pøesnìji, 
pokud zmìníte barevné oznaèení sady dat modelu. J.11

✧ Pro modelový soubor dat si požadované barevné znázornìní 
vyberte v pøíslušném seznamu (LUT, Look Up Table). 
→ Strana J.8–9, Zmìna zobrazení snímku pomocí barevných 
tabulek LUT 
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Fúze 3D Evaluation
Smart LUT J.11 J.11

✧ Chcete-li pøipojit nastavení okna a krytí, zaškrtnìte toto 
políèko.

J.11 Spodní hodnota okna se stane spodní mezí krytí a horní mez 
krytí je nastavena na maximum. J.11

➭ Pokud je toto políèko zaškrtnuto, posuvník Masking a 
zadávací pole budou neaktivní. 

Hodnota okna J.11 J.11

✧ Posunutím jezdce dané modelové sady dat zmìòte nastavení 
okna (jas).

✧ Posunutím pravého nebo levého okraje diapozitivu zmìòte 
šíøku okna (kontrast). 

Nebo J.11

✧ Pomocí èíselníku zadejte hodnoty vyvážení a potvrïte je 
klávesou Enter. 

SUV J.11 Zaškrtávací políèko SUV (standardní hodnota vychytávání) bude 
zobrazeno pouze u snímkù PET. J.11

J.11 ✧ Toto pole zaškrtnìte, pokud chcete namísto výchozích 
procentuálních hodnot použít hodnoty SUV pro tkáò. 
J.11–50 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Fúze
Krytí J.11 Pomocí krycí funkce mùžete urèit prahové hodnoty viditelnosti 
pro referenèní sérii a jiné hodnoty pro modelovou sérii. Pro 
smìšování alfa se používají pouze hodnoty stupnice šedi v rámci 
prahových hodnot. J.11

✧ Rozmezí skrytých obrazových bodù zmìníte pohybem levé 
nebo pravé úchytky jezdce

Nebo J.11

✧ Zadáním hodnoty do odpovídajících polí L(ow) nebo H(igh)

Nebo J.11

✧ pøetažením jezdce do jiné polohy, èímž zcela posunete 
rozmezí.

Tato zmìna se ihned projeví v segmentu fúzovaného volného 
pohledu. Všechny obrazové body mimo interval prahové 
hodnoty budou ignorovány. V ostatních sériích nebudou více 
smíšeny. J.11

➭ Parametry VRT je možné nastavit pomocí dialogu 3D: VRT 
Definition. Je možné vyvolat dialog Fused VRT Definition a 
3D: VRT Definition souèasnì. 

Zavøení dialogu J.11 ✧ Chcete-li dialog zavøít, klepnìte na tlaèítko Close.

➭ Dialog mùžete kdykoliv znovu otevøít volbou Settings > 
Fusion VRT Definition... z hlavní nabídky.

J.11
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Fúze 3D Evaluation
Interakce v segmentu 
fúzovaného volného 
pohledu J.11

Spoleèné interakce v segmentu fúzovaného volného pohledu, 
stejnì tak jako interakce s rovinami zábìru a výøezem, jsou 
stejné jako pro volný pohled.  
→ Strana J.3–49, Volný pohled J.11

Navíc mùžete provést následující interakce: J.11

✧ Klepnìte na místo s vysokou aktivitou. Referenèní obrazy 
ostatních segmentù jsou umístìny do prùseèíku s tímto 
bodem. 

✧ Klepnìte na levou polovinu segmentu støedním tlaèítkem 
myši a pøesuòte kurzor myši, s pøidrženým tlaèítkem, ke 
zmìnì okna referenèní sady dat (VRT).

✧ Klepnìte na pravou polovinu segmentu støedním tlaèítkem 
myši a pøesuòte kurzor myši, s pøidrženým tlaèítkem, ke 
zmìnì okna modelové sady dat (MPR/MIP).
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3D Evaluation Fúze
Ukládání výsledných snímkù J.11

Výsledné prolnuté snímky mùžete uložit do místní databáze, 
odeslat je do uzlu DICOM nebo je zkopírovat na kartu úlohy 
Filming. J.11

Obrazy jsou uloženy tak, jak jsou aktuálnì zobrazeny, s 
následujícími názvy sérií: J.11

❏ Pokud ukládáte jednotlivý obrázek: <Filtername+ 
"Collection"> (napø, <MIP Collection>, <MPR curved 
Collection>)

❏ Pokud ukládáte jednotlivý fúzovaný obrázek (FUSED MPR/
MIP, FUSED VRT MIP/MPR): <ALPHA Collection> 

❏ Pokud ukládáte urèitý rozsah fúzovaných obrázkù (FUSED 
MPR, FUSED MIP): <ALPHA Range> (napø., < ALPHA Range 
[2]>)

➭ Když ukládáte fúzovaný obraz, je uložen ve studii referenèní 
sady dat. Uložená obrazová data je možné pouze prohlížet, 
nemohou být vyhodnocovány.  
Jestliže výsledky fúze pochází ze sérií dvou rùzných pacientù, 
bude toto uvedeno v textu snímku. 
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Fúze 3D Evaluation
Výsledky pro bìžné prohlížecí aplikace J.11

Výsledky Fusion mùžete uložit i tak, aby je bylo možné otevøít v 
bìžných prohlížecích aplikacích jako je napøíklad MagicView. 
Tyto prohlížeèe se používají k porovnání originálù s prolnutými 
snímky. J.11

Pro prohlížení rùzných sérií v systémech PACS 
synchronizovaným zpùsobem (podle aktuální registrace) 
mùžete vytvoøit následující odpovídající si série: J.11

❏ První série se skládá z trojrozmìrného rozsahu referenèní 
série.

❏ Druhá série se skládá z trojrozmìrného rozsahu modelové 
série. 

❏ Tøetí série se skládá z trojrozmìrného rozsahu obrazù 
fúzovaných ze dvou sérií (volitelné). 

Tyto série mùžete vygenerovat tìmito zpùsoby: J.11

❏ Pøevzorkování dat

❏ Explicitním vytvoøením rozsahù.

J.11
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3D Evaluation Fúze
Pøevzorkování dat J.11 ✧ Jestliže chcete pøevzorkovat data, vyberte z hlavní nabídky 
položku Fusion > Resample Data.

V místní databázi se uloží tøi nové série s polohou, tlouš¤kou, 
orientací a rozlišením referenèní série. J.11

❏ sada pøevzorkovaných dat modelové série: 
”Pøevzorkovaná<modalita ><#>

❏ sada pøevzorkovaných dat prolínajícího se snímku: 
”Pøevzorkovaná<modalita reference><modalita 
modelu><#>”

➭ ”#” zaèíná jednièkou a zvyšuje se o urèitý pøírùstek pøi každém 
novém výpoètu.

➭ Rozlišení referenèní série závisí na konfiguraci.  
→ Strana J.16–9, Konfigurace pøevzorkování 

➭ Bìhem výpoètu nebudou snímky zobrazeny. V dialogovém 
oknì 3D: Resample Data in Progress bude zobrazen prùbìh 
výpoètu. 
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Fúze 3D Evaluation
Vytváøení rozsahù J.11 ✧ Z hlavní nabídky zvolte Settings > Parallel Ranges....

Oblast se vypoèítá pomocí obrazù smíšených metodou alfa a 
zobrazí se dialog 3D: Parallel Ranges (CT). J.11

✧ Z rozevíracího seznamu Output Type vyberte modalitu 
referenèní série, napø. CT. 

✧ Vyberte parametry požadovaného rozsahu a stisknìte 
tlaèítko Start.

✧ Uložte vypoèítaný rozsah. 
→ Strana J.13–2, Ruèní ukládání trojrozmìrných snímkù 
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3D Evaluation Fúze
J.11 ✧ Nemìòte parametry rozsahu a zopakujte poslední dva kroky.

✧ Nejprve vyberte modalitu modelové série, napø. PET, 
spoèítejte oblast a uložte ji. 

✧ Poté vyberte napø. CT_PET pro výpoèet oblasti fúzovaných 
obrazù. 

➭ Jestliže mají oba soubory dat stejnou modalitu, bude pøidáno 
„pre" a „post": "<MOD>pre" nebo "<MOD>post", napø., "PTpre".

✧ Rozevírací seznam Output Type bude viditelný pouze v 
pøípadì, že je naètena druhá sada dat a funkce Parallel 
Ranges nebo Expand ranges jsou aktivní. 

✧ Rozlišení vypoèítaného rozsahu typu výstupu „from model” 
závisí na konfiguraci. 
→ Strana J.16–9, Konfigurace pøevzorkování

!0

J.11 J.11

J.11

Bìhem provádìní tìchto krokù nemùžete mìnit parametry 
rozsahu a grafiku rozsahu. J.11
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Fúze 3D Evaluation
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KAPITOLA 0.0

J.12

 
Virtuální endoskopie J.12
Funkce Fly Through umožòuje vizualizovat zobrazení anatomie 
vytvoøením trojrozmìrných “objektových” modelù. Používá se k
vizualizaci dutin, napø. tlustého støeva, prùduškového systému 
a artérií z poloh uvnitø objektu. J.12

Všechny datové záznamy, které lze naèíst v 3D, slouží jako 
výchozí data pro vyhodnocení pomocí funkce Fly Through. J.12

Postup J.12 Funkce Fly Through slouží k pohybu v dutinách v objektech 
vizualizovaných v tzv. segmentu letu: J.12

❏ volný pohyb v objektu,

❏ urèený pohyb v objektu (pohyb po vypoèítané nebo urèené 
dráze).

Do modelového objektu se umístí virtuální kamera a zobrazí se 
vnitøní stìny objektù (dokonce i vnitøního ucha a cév). J.12

Pohled letu objektem 
(FVV) J.12

Tzv. pohled letu objektem (FVV) se zobrazí v referenèních 
segmentech a znázoròuje zorné pole virtuální kamery. J.12

J.12 ➭ Zmìnou vlastností a polohy FVV mùžete zmìnit zobrazení 
segmentu letu.

J.12
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Virtuální endoskopie 3D Evaluation
Právní pokyny J.12 ❏ Federální zákon omezuje prodej tohoto zaøízení na prodej 
prostøednictvím lékaøe nebo na základì jeho objednávky 
(pouze v USA).

❏ Toto zaøízení se neodbavuje jako snímací zaøízení.

❏ Tento postup nenahrazuje obvyklé endoskopické nebo 
angiografické postupy.

!0

J.12 J.12

Zobrazené barvy jsou simulované a nepøedstavují skuteèné 
anatomické barvy. J.12
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3D Evaluation Virtuální endoskopie
Spuštìní virtuální endoskopie J.12

Po naètení snímkù na kartu 3D urèete poèáteèní bod vizualizace. 
Poté spus¤te Fly Through. J.12

✧ Zvolte referenèní segment.

➭ Jestliže je aktivován režim letu, bude FVV v tomto segmentu 
zobrazen kolmo k rovinì obrazu. 
→ Strana J.12–10, Pohled letu objektem (FVV)

✧ Posuòte prùseèík referenèních èar ve zvoleném referenèním 
snímku k požadované dutinì.

J.12 ✧ Zvolte v nabídce Settings > Fly Through.

Nebo J.12

J.12 ✧ Klepnìte na tlaèítko Fly Through na kartì dílèí úlohy 
Settings.
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Virtuální endoskopie 3D Evaluation
V pravém dolním segmentu se objeví pohled letu v režimu SSD 
(Surface Shaded Display). J.12

FVV se zobrazí ve 3 referenèních segmentech. J.12

(1) Sagitální pohled

(2) Transverzální pohled

(3) Koronální pohled

(4) Segment letu
J.12–4 Návod k použití pro uživatele systému syngo

 0.0



3D Evaluation Virtuální endoskopie
Zmìna režimu zobrazení J.12

V referenèních segmentech zvolte obvyklým zpùsobem na kartì 
dílèí úlohy Type požadovaný režim. J.12

V segmentu Fly mùžete pøepínat mezi zobrazením SSD a VRT. 
J.12

SSD (Pohled letu) J.12 Režim SSD (Pohled letu) je standardnì nastaven v segmentu 
letu a odpovídá režimu SSD trojrozmìrných snímkù. J.12

✧ Vyberte segment letu.

J.12 ✧ Kliknutím na tlaèítko SSD na kartì dílèí úlohy Type zadejte 
režim SSD. 

✧ Klepnutím pravým tlaèítkem myši na tlaèítko SSD na kartì 
dílèí úlohy Type zmìòte nastavení SSD.
Verze VE31D J.12–5 
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Virtuální endoskopie 3D Evaluation
Zobrazí se dialogové okno 3D: SD Definition – Fly View (CT).J.12

✧ Zmìòte nastavení režimu SSD  
→ Strana J.6–3, Definice SSD.

➭ Nìkteré pøednastavené hodnoty pro režim SSD (Pohled letu) 
se liší od hodnot pro režim SSD.

Režim SSD (Pohled letu) umožòuje urèit vlastnosti a barvu 
povrchu. J.12
J.12–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
J.12 ✧ Klepnìte na tlaèítko Light Source.

Zobrazí se dialogové okno 3D: Light Source Definition – FLY 
THROUGH. J.12

Vyberte nebo urèete požadovaný zdroj svìtla. 
→ Strana J.6–8, Zdroj svìtla 

J.12

J.12 ✧ Jestliže chcete zmìnit barvu povrchu, kliknìte na položku 
Color. 

✧ Ze zobrazené palety vyberte požadovanou barvu a stisknutím 
tlaèítka OK výbìr potvrïte.

Zmìnìné nastavení se automaticky aktualizuje v segmentu 
letu. 

J.12

J.12
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Virtuální endoskopie 3D Evaluation
VRT (Pohled cévy) J.12 Režim VRT (Pohled letu) segmentu letu odpovídá režimu VRT 
trojrozmìrných snímkù. J.12

✧ Vyberte segment letu.

J.12 ✧ Kliknutím na tlaèítko VRT na kartì dílèí úlohy Type zadejte 
režim VRT. 

✧ V hlavní nabídce zvolte Type > VRT Definition....

Zobrazí se dialogové okno 3D: VRT Definition - Fly View. J.12

✧ Zmìòte nastavení režimu VRT 
→ Strana J.7–13, Pokroèilý režim
J.12–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
Volný pohyb v objektu J.12

Pomocí volného pohybu v režimu letu mùžete pro libovolnou 
polohu v objektu vypoèítat perspektivní pohled v segmentu 
letu. To provedete posunutím FVV zobrazeného v referenèních 
segmentech jako by to byla virtuální kamera a otoèením v 
požadovaném smìru pohledu. J.12

Tyto pohyby mùžete øídit v segmentu letu pomocí funkce 
SmartSelect a kliknutím myší. 
→ Strana J.3–39, SmartSelect J.12

➭ Všechny pohyby a zmìny provedené v jednom ze segmentù 
se aktualizují i ve všech ostatních segmentech.

Zpracování trojrozmìrných snímkù v referenèních segmentech 
je stále možné bez omezení.  
(Pouze prostøednictvím funkce Rotate Images v režimu letu 
nejsou snímky otoèeny okolo støedu trojrozmìrného výøezu 
VOI, ale okolo pozorovacího bodu v FVV.) J.12

➭ Kdykoliv bìhem volného pohybu máte možnost:

❏ ukládat snímky klepnutím na tlaèítko Save

❏ nastavit body pro urèení dráhy.  
Dráha slouží k urèení pohybù a k automatickému ukládání 
obrazù v segmentu letu. 
→ Strana J.12–20, Urèení dráhy

J.12
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Virtuální endoskopie 3D Evaluation
Pohled letu objektem (FVV) J.12

FVV v referenèních segmentech odpovídá skuteènému zorného 
poli virtuální kamery. Poloha a orientace FVV urèuje oblast 
znázornìnou v segmentu letu. Pozorovací bod FVV je 
prùseèíkem referenèních èar a souèasnì støedem pohledu letu v 
segmentu letu. J.12

Jestliže je aktivován režim letu, FVV se ve zvoleném segmentu 
zobrazí kolmo k rovinì snímku. J.12

Roviny prohlížení J.12 Oblast znázornìná v pohledu letu je ohranièena pøední a zadní 
rovinou zábìru. J.12

V pohledu letu jsou zobrazeny všechny voxely mezi pøední a 
zadní rovinou zábìru. J.12

Rovina prohlížení je seènou rovinou FVV a roviny snímku a je 
kolmá ke smìru pohledu. J.12

Pozorovací 
bod J.12

Smìr pohledu J.12

Rovina snímku J.12

Zorný úhel 
Pøední rovina zábìru J.12

Zadní rovina zábìru J.12

Rovina prohlížení J.12

Bod roviny zábìruJ.12

Hloubka 
pohled

Pozorovací 
vzdálenost J.12

Statický bod J.12

Oko
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3D Evaluation Virtuální endoskopie
Dùležité body J.12 Statický bod pøedstavuje virtuální kameru. Tento bod je 
místem, kde zaèíná zorné pole ve tvaru jehlanu. J.12

Oko znázoròuje polohu statického bodu, udává zaèátek 
pohledu zorného pole. J.12

Pozorovací bod je umístìn v prùseèíku referenèních èar v 
referenèních segmentech a je pro anatomii významným bodem 
roviny snímku. Tudíž smìr pohledu je èára spojující statický bod 
s pozorovacím bodem. J.12

Bod roviny zábìru je prùseèíkem smìru pohledu a zadní 
rovinou zábìru. J.12

Pozorovací vzdálenosti J.12 Pozorovací vzdálenost je vzdálenost mezi statickým bodem a 
pozorovacím bodem. Tato vzdálenost odpovídá vzdálenosti 
mezi virtuální kamerou a zaostøeným objektem. J.12

Hloubka pohledu je vzdálenost mezi statickým bodem a 
bodem roviny zábìru. Tato vzdálenost odpovídá hloubce 
pohledu virtuální kamery. J.12

Zorný úhel urèuje šíøku FVV. J.12

➭ Èást FVV nad rovinou snímku je znázornìna plnou èarou a 
èást pod rovinou je znázornìna pøerušovanou èarou.

J.12
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Virtuální endoskopie 3D Evaluation
Zmìna pohledu letu pomocí FVV J.12

Zobrazení segmentu Fly mùžete ovlivnit zmìnou vlastností a 
polohy FVV v jiných segmentech. 

J.12

Pozorovací bod J.12 ✧ Pøetáhnìte pozorovacý bod na místo v objektu, které chcete 
znázornit v segmentu Fly. 

Smìr pohledu J.12 ✧ Smìr pohledu zmìníte posunutím statického bodu nebo oka. 
Tento pohyb odpovídá otoèení okolo pozorovaného bodu.

Nebo J.12

✧ Posuòte bod roviny zábìru otoèením FVV okolo statického 
bodu. 

Hloubka pohledu J.12 ✧ Pøetažením jedné strany pøední roviny zábìru ke statickému 
nebo pozorovanému bodu zvìtšíte nebo zmenšíte viditelné 
popøedí.

✧ Pøetažením jedné strany zadní roviny zábìru ke statickému 
nebo pozorovacímu bodu zvìtšíte nebo zmenšíte viditelné 
pozadí.

Zorný úhel J.12 ✧ Zkrácením nebo prodloužením okrajù FVV jejich pøetažením 
dojde ke zvìtšení nebo zmenšení zorného úhlu. 

J.12
J.12–12 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
Pozorovací vzdálenost J.12 ✧ Zvolte v hlavní nabídce Settings > Fly View Volume.

Zobrazí se dialogové okno 3D: Fly View Volume. J.12

J.12

J.12 ✧ Vzdálenost mezi statickým bodem a pozorovaným bodem 
zmìòte pomocí èíselníku.

✧ Klepnutím na položku Close potvrïte nastavení.
Verze VE31D J.12–13 
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Virtuální endoskopie 3D Evaluation
Pøednastavené hodnoty J.12 Ve vašem systému jsou uloženy sady pøeddefinovaných 
parametrù pro nastavení FVV. J.12

Pokud pøepnete zobrazení do režimu letu, použije se datový 
záznam spojený s naètenou sérií. Pokud takové spojení 
neexistuje (napø. pro nové série), použije se výchozí sada pro 
pohled letu objektem. J.12

✧ Zvolením Settings > Fly View Volume v hlavní nabídce 
zobrazte okno 3D: Fly View Volume.

J.12 ✧ Ze seznamu vyberte sadu parametrù, kterou chcete spojit s 
naètenou sérií.

Nebo J.12

✧ Zadejte název nové sady parametrù, kterou chcete vytvoøit. 

J.12 ✧ Jestliže chcete po zmìnì parametrù FVV uložit novou sadu 
parametrù pod zadaným názvem, klepnìte na položku Save 
Preset. 

Všechny parametry FVV budou pøijaty. 
J.12

J.12 ✧ Jestliže chcete vymazat aktuálnì vybranou sadu parametrù, 
klepnìte na položku Delete Preset.

➭ Standardní sady parametrù nelze vymazat. 

J.12 ✧ Kliknutím na položku Link Preset pøiøaïte ke zvolené sadì 
parametrù název. 
→ Strana J.3–120, Uložení sady parametrù jako 
pøednastavených hodnot
J.12–14 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
Zmìna pohledu letu v segmentu letu J.12

V segmentu letu mùžete ovládat volný pohyb v objektu pomocí 
funkce SmartSelect, tlaèítka Zoom/Pan a pomocí „Click 
Rotate”. J.12

Pozorovací bod J.12 Pozorovací bod mùžete posunovat v rovinì obrázku pomocí 
tlaèítka Pan a pomocí „Klikni - otoè". Kolmo k rovinì obrázku 
posunete pozorovací bod pomocí push/pull. J.12

J.12 ✧ Klepnìte na tlaèítko Zoom/Pan v horní èásti ovládací oblasti 
a pøetáhnìte støed snímku v segmentu letu do požadované 
polohy

Nebo J.12

✧ Kliknìte na místo v obrazu endoskopického pohledu, èímž se 
toto místo umístí do støedu segmentu („Klikni - otoè"). 
Pozorovací bod se otoèí okolo statického bodu.

Nebo J.12

J.12 ✧ Aktivujte funkci push/pull pomocí funkce SmartSelect a 
vertikálnì pohnìte myší.

Virtuální kamera se v dutinì posune vpøed nebo vzad. Èím dále 
posunete myš nahoru nebo dolù, tím rychleji se virtuální 
kamera posune vpøed nebo vzad. J.12

Smìr pohledu obrátíte posunutím myši horizontálnì. J.12

J.12
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Virtuální endoskopie 3D Evaluation
Zorný úhel J.12

J.12 ✧ Klepnìte na tlaèítko Zoom/Pan v horní èásti ovládací oblasti.

✧ Klepnutím levým tlaèítkem myši a pøetažením myši kolem 
okraje segmentu snímek zmenšíte nebo zvìtšíte.

➭ Úhel FVV zmìníte stejným zpùsobem, jako zvìtšujete èi 
zmenšujete segment letu. 

Smìr pohledu J.12

J.12 ✧ Aktivujte možnost rotate around viewing point pomocí 
funkce SmartSelect.

✧ Pøetažením myši od støedu segmentu k okraji otoèíte FVV 
okolo statického bodu.

Tato možnost odpovídá pohybu statického bodu v referenèních 
segmentech. 

J.12

Nebo J.12

✧ Aktivujte možnost rotate view pomocí funkce SmartSelect.

✧ Pøetažením myši od støedu segmentu k okraji otoèíte FVV 
okolo statického bodu.

Tato možnost odpovídá pohybu pozorovaného bodu nebo bodu 
roviny zábìru v referenèních segmentech. 

J.12

Pøetáèení J.12 ✧ Aktivujte možnost rotate around viewing point nebo rotate 
view pomocí funkce SmartSelect. 

✧ Posunutím myši kolem hranice segmentu otoèíte snímek v 
rovinì okolo støedu segmentu.
J.12–16 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
Klepnutí na objekt letu J.12 Jestliže klliknete do segmentu letu, provede se automatická 
navigace do trojrozmìrného bodu, který jste kliknutím 
oznaèili. J.12

Trojrozmìrný zakliknutý bod má stejné souøadnice jako první 
pixel povrchu pod místem kliknutí. J.12

Otoèením a plynulým pohybem FVV se místo, na které jste 
klepli, stane pozorovaným bodem a posune se doprostøed 
segmentu. Pozorovací vzdálenost a zorný úhel se nezmìní. J.12

Pohyb se aktualizuje ve všech ostatních segmentech. 
J.12

Obnova hodnot J.12 J.12

J.12 ✧ Jestliže se chcete vrátit k poèáteèním hodnotám, klepnìte na 
položku Home Zoom/Pan. 

Obnoví se hodnoty nastavené po spuštìní aplikace. J.12

Referenèní èáry J.12 Referenèní èáry v segmentu letu máte možnost zobrazit nebo 
skrýt. J.12

J.12 ✧ Vyberte segment letu.

✧ Kliknìte na tlaèítko Hide Reference lines v ovládací èásti na 
kartì 3D. 

Ortho Sync J.12 Pomocí funkce Ortho Sync mùžete v referenèních segmentech 
zobrazit ortogonální pohledy segmentu letu. J.12

✧ Vyberte segment letu.

J.12 ✧ Klepnìte na tlaèítko Ortho Sync na kartì dílèí úlohy 
Orientation.

V levém horním referenèním segmentu se zobrazí rovina 
snímku segmentu letu, v pravém horním segmentu horizontální 
rovina a v levném dolním segmentu kolmá rovina. J.12
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Virtuální endoskopie 3D Evaluation
Definovaný pohyb objektem J.12

Na rozdíl od volného pohybu objektem se pomocí definovaného 
pohybu pohybujete pøedem urèenou dráhou. J.12

V režimu auto navigation se pohybujete dutinou pomocí 
tlaèítek myši. Tato dráha je automaticky vypoèítána a neustále 
aktualizována systémem. J.12

Virtuální kamera se pohybuje po dráze, kterou vytvoøíte 
interaktivnì pomocí dialogového okna 3D: Fly: Fly Path 
Planning. J.12

J.12
J.12–18 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
Autonavigace J.12

Pomocí autonavigace se pohybujete uvnitø dutiny. V pøípadì 
potøeby mùžete souèasnì nastavit body pro "let kamery". J.12

J.12 ✧ Prostøednictvím funkce SmartSelect vyberte a aktivujte režim 
auto navigation v segmentu Fly.

✧ Klepnutím levým tlaèítkem myši a pøetažením myši v 
segmentu letu nahoru zahájíte pohyb vpøed.

Nebo J.12

✧ Kliknutím levým tlaèítkem myši a pøetažením myši v 
segmentu Fly dolù zahájíte pohyb vzad. 

✧ Pøetažením myši doleva nebo doprava obrátíte smìr 
pohledu.

Virtuální kamera se pohybuje po smìru èáry vypoèítané 
systémem pro danou dutinu. Èím dále posunete myš nahoru 
nebo dolù, tím rychleji se virtuální kamera posune vpøed nebo 
vzad. J.12

J.12 ➭ Bìhem Auto Navigation mùžete nastavit body dráhy pomocí 
klávesy Mark (Num 3) na klávesnici. 
→ Strana J.12–22, Vložení bodu

J.12
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Virtuální endoskopie 3D Evaluation
Urèení dráhy J.12

Dráha je trojrozmìrná lomená èára umožòující pohyb objektem. 
K tomuto úèelu je urèeno nìkolik bodù, které udávají pohyb FVV 
v objektu (“polohy” pozorovacího bodu). J.12

✧ V hlavní nabídce zvolte Settings > Fly Path Planning....

Nebo J.12

J.12 ✧ Kliknìte pravým tlaèítkem myši na tlaèítko Fly Through na 
kartì dílèí úlohy Settings v ovládací èásti.

Zobrazí se dialogové okno 3D: Fly Path Planning. J.12
J.12–20 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
Jestliže z døívìjšího vyšetøení existuje dráha, zobrazí se tato 
dráha v referenèních segmentech a v dialogovém oknì. J.12

 
J.12

(1) Path Visualization Line 
Znázoròuje nataženou dráhu mezi „polohami” 
pozorovacího bodu.

(2) Position Torch 
Poloha této baterky na èáøe dráhy pøedstavuje aktuální 
polohu kamery.

(3) Path Point 
„Stanice” pozorovacího bodu podél dráhy.

(4) Zoom Slider 
Pokud je hustota bodù v urèité èásti pøíliš vysoká, mùžete 
èáru dráhy zvìtšit.

To, zda délka èáry dráhy odpovídá skuteèné délce dráhy èi nikoli, 
závisí na konfiguraèním nastavení. 
→ Strana J.16–10, Konfigurace virtuální endoskopie 
 
 
 
 
 
 

J.12
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Virtuální endoskopie 3D Evaluation
Vložení bodu J.12 Dráhu vytvoøíte urèením význaèných poloh jako bodù dráhy 
bìhem volného pohybu v objektu nebo bìhem automatické 
navigace. Pøíslušná nastavení FVV (smìr pohledu, zorný úhel 
atd.) se uloží spolu s polohou pozorovacích bodù. J.12

✧ Pohybujte se prostorem do polohy, kterou chcete oznaèit 
jako bod dráhy.

Nebo J.12

✧ Pøetáhnìte polohovou baterku na požadované místo na èáøe 
znázoròující dráhu.

J.12 ✧ Na klávesnici stisknìte klávesu Mark (Num 3). 
 

Nebo J.12

J.12 ✧ Kliknìte na tlaèítko Insert Point v dialogovém oknì 3D: Fly 
Path Planning, chcete-li pøidat nový bod do dráhy.

Tento bod se vloží na aktuální místo polohové baterky a zobrazí 
se v dialogovém oknì na èáøe znázoròující dráhu i v 
referenèních segmentech. J.12

➭ Jestliže klepnete na již existující bod èáry znázoròující dráhu, 
tento bod bude nahrazen novým.

Oznaèení bodu dráhy J.12 Po vytvoøení dráhy budou body dráhy opatøeny po sobì 
jdoucími èísly a s tímto èíslem použity v èáøe znázoròující dráhu. 
Toto automatické oznaèení bodu dráhy mùžete nahradit jiným 
vhodným oznaèením. J.12

✧ Dvojitì kliknìte na název bodu v dialogovém oknì 3D: Fly 
Path Planning.

✧ Zadejte požadované oznaèení a potvrïte jej klepnutím na 
klávesu Enter.
J.12–22 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
Odstranìní bodu J.12 J.12

✧ Bod dráhy vymažete klepnutím na položku Remove Point.

J.12 Dbejte pøitom na to, aby polohová baterka v dialogovém oknì 
oznaèovala bod, který chcete odstranit. 

J.12

Název dráhy J.12

J.12 ✧ Zadejte název dráhy.

J.12

Uložení dráhy J.12

J.12 ✧ Jestliže chcete uložit aktuální verzi dráhy, kliknìte na položku 
Save Path. 

!0

J.12 J.12

Vymazání dráhy J.12

J.12 ✧ Jestliže chcete vymazat všechny existující body dráhy, 
klepnìte na položku Clear Path. 

J.12

Je možné uložit pouze jednu dráhu. Jakákoli existující dráha 
bude pøepsána. J.12
Verze VE31D J.12–23 
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Virtuální endoskopie 3D Evaluation
Zobrazení dráhy J.12 Body dráhy jsou v referenèních segmentech rùznì zobrazeny. 
Vìtší body jsou umístìny blíže k rovinì snímku, zatímco menší 
body jsou umístìny dále. Na rozdíl od bodù mimo rovinu 
obrazu, body v rovinì obrazu jsou transparentní. 
Dráha spojující body je pøedstavována plnou èárou nad rovinou 
obrazu a pøerušovanou èárou pod rovinou obrazu. J.12

Skrytí dráhy J.12

J.12 ✧ Jestliže chcete potlaèit zobrazení dráhy v referenèních 
segmentech, klepnìte na položku Hide Path.

J.12

J.12

J.12
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3D Evaluation Virtuální endoskopie
Let podél dráhy J.12

Jakmile urèíte dráhu, mùžete se po ní v objektu pohybovat (”let 
kamery”). J.12

Zastavte se na požadovaných místech a v segmentu letu uložte 
snímky nebo vytvoøte sérii snímkù pøi letu kamery aktivováním 
automatického ukládání. J.12

Podél dráhy se pohybujete pomocí tlaèítek v dialogovém oknì 
nebo pomocí polohové baterky na èáøe znázoròující dráhu. J.12

Vzdálenost kroku J.12 Pomocí funkce velikosti kroku urèíte vzdálenost podél dráhy, v 
jaké se v segmentu letu vytvoøí nový snímek. J.12

✧ Velikost kroku nastavíte pomocí jezdce.

J.12 J.12

Ukládání snímkù pøi letu J.12

J.12 ✧ Jestliže chcete bìhem letu ukládat snímky, klepnìte na 
položku Save Images while Flying.

Poèet uložených snímkù je dán velikostí kroku. J.12

➭ Jestliže poèet snímkù, které chcete uložit, pøevyšuje pøedem 
nakonfigurovaný limit, musíte odpovídající poznámku 
potvrdit tlaèítkem Yes.
Verze VE31D J.12–25 
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Virtuální endoskopie 3D Evaluation
Let dopøedu J.12

J.12 ✧ Let zahájíte kliknutím na položku Fly Forwards. 

Let bude zahájen z aktuální polohy (oznaèené polohovou 
baterkou) a konèí v posledním bodì. J.12

➭ Jestliže dva pøilehlé body dráhy mají rùzné vlastnosti FVV, tyto 
vlastnosti se plynule zmìní bìhem letu mezi tìmito body. 
Jestliže napøíklad zorný úhel bodu 3 je 30° a bodu 4 je 40°, 
zorný úhel na letu mezi body 3 a 4 se plynule zvýší z 30° na 
40°. 

Zastavení letu J.12

J.12 ✧ Let zastavíte klepnutím na položku Stop Flying.

J.12  
 

J.12

Let zpìt J.12

J.12 ✧ Jestliže se chcete z aktuální polohy pohybovat zpìt do první 
polohy dráhy, klepnìte na položku Fly Backwards.

FVV obrátí smìr pohledu. J.12

 
 

J.12
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3D Evaluation Virtuální endoskopie
Polohová baterka J.12

J.12 ✧ Pøetáhnìte polohovou baterku do požadované polohy.

✧ Klepnìte na bod èáry znázoròující dráhu.

Polohová baterka se pøesune na toto místo. Zobrazení v 
segmentech bude odpovídajícím zpùsobem aktualizováno. 

J.12

✧ Klepnìte na èáru znázoròující dráhu.

Polohová baterka se pøesune na místo, kam jste klepli. 
Zobrazení v segmentech bude odpovídajícím zpùsobem 
aktualizováno. 

J.12

✧ Smìr pohledu FVV zmìníte klepnutím na šipku vedle baterky.  
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Virtuální endoskopie 3D Evaluation
Stav mimo dráhu J.12 J.12

J.12 Poloha baterky znázoròuje polohu bodù, na které klepnete v 
oblasti snímku. J.12

Kliknutím na místo vedle dráhy zmìníte polohu polohové 
baterky. 

J.12

Tento stav mimo dráhu mùžete vyøešit následujícím 
zpùsobem: J.12

✧ Klepnutím na baterku zachovejte její relativní polohu na èáøe 
dráhy.

✧ Pøetažením baterky podél èáry dráhy baterku pøesuòte.

✧ Klepnutím na dráhu nebo bod na dráhì pøesuòte baterku na 
místo, kam jste klepli.

FVV se pøizpùsobí nové poloze baterky. J.12

➭ Aktuální nastavení FVV vložíte stisknutím tlaèítka Insert 
Point.
J.12–28 Návod k použití pro uživatele systému syngo
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3D Evaluation Virtuální endoskopie
Zavøení virtuální endoskopie J.12

Po ovìøení uložení, nafilmování nebo odeslání všech dùležitých 
snímkù mùžete segment Fly Through uzavøít. J.12

✧ Pro tento úèel vyberte v hlavní nabídce položku Settings > 
Fly Through.

Nebo J.12

J.12 ✧ Kliknìte na tlaèítko Fly Through na kartì dílèí úlohy 
Settings. 

Nebo J.12

J.12 ✧ Kliknìte na tlaèítko Close. 

Z oblasti snímku zmizí segment letu. J.12

J.12

J.12
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Virtuální endoskopie 3D Evaluation
J.12–30 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.13

Ukládání trojrozmìrných 
sérií a snímkù J.13
K dokumentaèním úèelùm mùžete uložit série snímkù nebo 
pohledù, které jste generovali na kartì úloh 3D. J.13

Snímky mùžete buï rychle uložit do již existujících sérií, nebo je 
uložit do nových sérií. J.13

Rekonstruované série mùžete uložit automaticky jako nové 
série po rekonstrukci. J.13
Verze VE31D J.13–1 
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Ukládání trojrozmìrných sérií a snímkù 3D Evaluation
Ruèní ukládání trojrozmìrných 
snímkù J.13

Po vygenerování nových sérií paralelních, radiálních nebo 
expandovaných snímkù èi pohledù na kartì úloh 3D je mùžete 
uložit do hlavní databáze. J.13

➭ V oknì 3D Configuration mùžete stanovit, zda chcete uložit i 
referenèní èáry a referenèní obraz série. 
→ Strana J.16–5, Konfigurace ukládání 
→ Strana J.16–3, Ukládání snímkù s referenèními èarami  

Ukládání s výchozím nastavením J.13

Chcete-li pøi ukládání snímkù nebo sérií použít výchozí 
nastavení, klepnìte na tlaèítko Save. J.13

➭ Použijete-li tlaèítko Save, budou platná ta nastavení, která jste 
provedli v dialogovém oknì Save as. 

✧ Kliknìte na obraz, který chcete uložit.

✧ Aktivujte funkci Patient > Save.

Nebo J.13

J.13 ✧ Kliknìte na tlaèítko Save ve spodní èásti ovládací oblasti. 
 
 

J.13–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Ukládání trojrozmìrných sérií a snímkù
Oznaèení série J.13 Po stisknutí Save s obrázky uloží, pod následujícími názvy sérií:J.13

❏ Pokud ukládáte oblast (paralelní, rozšíøenou, radiální, 
zakøivenou): <typ filtru+" Range"+èíslo (v pøípadì duplikátù)> 
(napø. <MIP Range[4]>, <MPRRange[3]>)

❏ Pokud ukládáte jednotlivý obrázek: <Filtername+ 
"Collection"> (napø, <MIP Collection>, <MPR curved 
Collection>(

❏ Pokud ukládáte jednotlivý fúzovaný obrázek (FUSED MPR/
MIP, FUSED VRT MIP/MPR): <ALPHA Collection>

❏ Pokud ukládáte urèitý rozsah fúzovaných obrázkù (FUSED 
MPR, FUSED MIP): <ALPHA Range> (napø., < ALPHA Range 
[2]>)

J.13
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Ukládání trojrozmìrných sérií a snímkù 3D Evaluation
Nastavování pøi ukládání J.13

Pøi prvním ukládání rekonstruované série budete nejdøíve muset 
provést nìkolik výchozích nastavení. J.13

✧ Vyberte snímek v referenèním segmentu nebo snímky ve 
výstupním segmentu.

✧ Zvolte pøíkaz Patient > Save As....

Nebo J.13

J.13 ✧ Kliknìte na Save As.... 

Zobrazí se dialogové okno 3D: Save As. J.13

 

J.13–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Ukládání trojrozmìrných sérií a snímkù
Údaje na snímku J.13 Údaje o snímku se nacházejí v pravé horní èásti dialogového 
okna: J.13

❏ jméno pacienta,
❏ zobrazovací metoda (modalita),
❏ datum vyšetøení,
❏ poèet snímkù,
❏ typ trojrozmìrného výstupu (MIP, MIP Thin, MinIP, MinIP 

Thin, MPR, MPR Thick, MPR Curved, MPR Thick Curved, MIP 
Thin Curved, VRT, VRT Thin, SSD).

Tato informace se uloží souèasnì se sérií. J.13

Vyšetøující lékaø J.13

 

✧ Zadejte jméno lékaøe, kterému chcete poskytnout sérii 
obrazù pacienta. 
 

Poznámky J.13 Mùžete zadat komentáø k sérii. Tyto komentáøe pak budou 
uloženy spolu se snímky. J.13

 

✧ Zadejte text komentáøe.

➭ Vstupní pole obsahuje výchozí text komentáøe, který je 
komentáøem uloženým spolu s pùvodními snímky. Pokud 
mìly rùzné snímky rùzné komentáøe, výchozí text komentáøe 
neexistuje.
Verze VE31D J.13–5 
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Ukládání trojrozmìrných sérií a snímkù 3D Evaluation
Ukládání snímkù do série J.13 Chcete-li uložit do jedné série všechny obrazy, které jste 
generovali ze souboru dat, zvolte pøíkaz Save all images in one 
series. J.13

Všechny snímky budou nyní uloženy pod stejným názvem série 
v hlavní databázi bez ohledu na typ trojrozmìrného výstupu, 
podle nìhož byly vygenerovány (MPR, MPR Thick, MPR Curved, 
MPR Thick Curved, MIP Thin Curved, MIP, MIP Thin, MinIP, MinIP 
Thin, VRT, VRT Thin nebo SSD). J.13

 

✧ Klepnìte na pøíkaz Save all images in one series.

✧ Zadejte název série nebo jej vyberte ze seznamu. 

Pøi každém vygenerování a uložení obrazù z pùvodního souboru 
dat na kartu 3D budou tyto obrazy pøipojeny k sérii, která je zde 
zadána. 
 
 

J.13
J.13–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Ukládání trojrozmìrných sérií a snímkù
Seskupování snímkù podle 
typu výstupu J.13

Jestliže pøi zpracování pùvodního souboru dat vygenerujete 
snímky rùzných typù výstupu (MIP, MinIP, MPR, MPR Thick, MPR 
Curved, MPR Thick Curved, MIP Thin Curved, VRT, VRT Thin nebo 
SSD), mùžete tyto snímky pøi ukládání do databáze roztøídit 
podle typu výstupu. J.13

 

✧ Klepnìte na pøíkaz Group all images by type.

✧ Zadejte název série nebo je vyberte ze seznamu.

Všechny snímky, které jste vygenerovali z tohoto pùvodního 
souboru dat, budou nyní uloženy pod názvem této série a 
oznaèením typu výstupu.  

J.13

➭ Pokud vygenerujete celou sérii obrazù, uloží se tyto obrazy 
vždy pod jiným názvem série. 
→ Strana J.13–9, Ukládání trojrozmìrných sérií
Verze VE31D J.13–7 
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Ukládání trojrozmìrných sérií a snímkù 3D Evaluation
Pøíklad J.13 Jako název série seskupených obrázkù zadáte “Name”. Potom 
postupnì uložíte 1 snímek SSD, 2 snímky MPR, 1 snímek MIP, 1 
snímek MPR Thick, 1 snímek MPR a 1 další snímek SSD. J.13

Tímto zpùsobem vygenerujete ètyøi série: J.13

 

(1) Kolekce snímkù SSD "Name"
(2) Kolekce snímkù MPR "Name"
(3) Kolekce snímkù MIP "Name"
(4) Kolekce obrazù MPR Thick „Name" 

J.13 ✧ Uložte sérii klepnutím na tlaèítko OK.

Nebo J.13

J.13 ✧ Zrušte vytvoøené vstupy klepnutím na Cancel.

1.

2.

3.

4.

5.

6.
J.13–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Ukládání trojrozmìrných sérií a snímkù
Ukládání trojrozmìrných sérií J.13

Mùžete uložit také rekonstruované snímky, napøíklad jako 
paralelní snímky s komentáøem. J.13

✧ Ve výstupním segmentu nejdøíve zvolte sérii.

✧ Zvolte pøíkaz Patient > Save As....

Nebo J.13

J.13 ✧ Kliknìte na Save As.... 
 

Zobrazí se dialogové okno 3D: Save As. J.13
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Ukládání trojrozmìrných sérií a snímkù 3D Evaluation
Zadání názvu série J.13

 

✧ Do kombinovaného okna zadejte název série.

Nebo J.13

✧ Zvolte název série ze seznamu. 

Poznámky J.13 Mùžete zadat komentáø k sérii. Tyto komentáøe pak budou 
uloženy spolu se snímky. J.13

 

✧ Zadejte text komentáøe. 

J.13 ✧ Uložte sérii klepnutím na tlaèítko OK.

Nebo 
J.13

J.13 ✧ Zrušte vytvoøené vstupy klepnutím na Cancel.
J.13–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Ukládání trojrozmìrných sérií a snímkù
Automatické ukládání série J.13

Chcete-li uložit rekonstruovanou sérii co nejrychleji a 
nejsnadnìji, mùžete ji nechat ukládat automaticky bìhem 
rekonstrukce. J.13

✧ Kliknìte na pøíkaz Enable auto-save na kartì dílèí úlohy 
Ranges v oknì 3D Configuration. 
→ Strana J.16–5, Aktivace automatického ukládání

Všechny série pak budou po rekonstrukci automaticky uloženy.J.13

➭ V oknì 3D Configuration mùžete definovat, zda chcete nebo 
nechcete navíc uložit referenèní obraz série. 
→ Strana J.16–5, Ukládání referenèního obrazu
Verze VE31D J.13–11 
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Ukládání trojrozmìrných sérií a snímkù 3D Evaluation
Název automaticky uložené série se pak bude skládat z 
následujících èástí: J.13

❏ názvu pùvodní série nebo názvu zadaného do pole Range 
series name v dialogovém oknì 3D: Save As.

❏ typu výstupu, napøíklad MPR

❏ poøadového èísla.

➭ Pomocí funkce auto-save mùžete velmi rychle vytvoøit velké 
objekty dat a zaplnit kapacitu pevného disku. V pravidelných 
intervalech kontrolujte data uložená na pevném disku. 
Ukládejte data, která ještì potøebujete, a smažte data, která 
již potøebovat nebudete. 
→ Strana F.2–1, Ukládání dat

J.13
J.13–12 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

J.14

Exponování na film, 
vyhodnocování a odesílání 
trojrozmìrných obrazù J.14
Pro Pøenos obrázkù na film je tøeba je odeslat aplikaèní kartì 
Filming, odkud mohou být dále odeslány do kamery, pøípadnì 
do tiskárny. J.14

Nebo je možné data urèená k dalšímu zpracování odeslat kartì 
úlohy Viewing, což vám umožní zadávat komentáøe k novým 
sériím obrázkù prostøednictvím textových a grafických prvkù, a 
nebo pokraèovat ve zpracování s využitím nabízených 
dvourozmìrných vyhodnocovacích nástrojù. J.14

Je-li váš systém souèástí sítì, mùžete data odeslat na jinou 
pracovní stanici, kde mùže zpracování pokraèovat. J.14
Verze VE31D J.14–1 
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Exponování na film, vyhodnocování a odesílání trojrozmìrných obrazù 3D Evaluation
Exponování trojrozmìrných obrazù 
na film J.14

Pokud chcete zdokumentovat obrazy nebo série obrazù, mùžete 
je odeslat do kamery (a exponovat na film) nebo na tiskárnu (a 
vytisknout na papír). 

J.14

✧ Zvolte obrázek v segmentu, klepnutím na tento obrázek.

Nebo J.14

✧ Zvolte obrazy ve výstupním segmentu. 

✧ Použijte funkci Patient > Save and Copy to Film Sheet.

Nebo J.14

J.14 ✧ Kliknìte na tlaèítko Save and Copy To Film Sheet, které se 
nachází v dolní èásti ovládací oblasti karty úlohy 3D.

Nebo J.14

J.14 ✧ Stisknìte klávesu Save and Copy To Film Sheet na klávesnici 
se symboly.

V závislosti na nastaveních, která jste definovali pro rozvržení 
filmu, budou obrazy buï pøevedeny do kamery èi tiskárny 
pøímo, nebo zùstanou na kartì úlohy Filming pro potøeby 
zpracování, dokud je neodešlete do kamery èi tiskárny ruènì. 
→ Kapitola G.2, Automatické/manuální exponování na film 
 

J.14

➭ V oknì 3D Configuration mùžete nastavit, zda má být 
exponován na film také referenèní obraz série. 
→ Strana J.16–6, Konfigurace filmování
J.14–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Exponování na film, vyhodnocování a odesílání trojrozmìrných obrazù
Pøevod snímkù na kartu úlohy 
Viewing J.14

Pokud chcete vyhodnocovat nebo zpracovávat vybrané obrazy 
ve dvourozmìrném zobrazení, je tøeba obrazy pøesunout na 
kartu úlohy Viewing. 

J.14

✧ Zvolte snímek v referenèním segmentu klepnutím na tento 
snímek.

Nebo J.14

✧ Zvolte obrazy ve výstupním segmentu. 

✧ Spus¤te funkci Patient > Save and Load to Viewing.

Nebo J.14

J.14 ✧ Kliknìte na tlaèítko Save and Load to Viewing ve spodní 
èásti ovládací oblasti. 
 

Obrazy budou pøevedeny na kartu úlohy Viewing, kde je lze 
zpracovat. 
→ Strana E.4–1, Zpracování snímkù 
→ Strana E.5–1, 2D vyhodnocení J.14

J.14
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Exponování na film, vyhodnocování a odesílání trojrozmìrných obrazù 3D Evaluation
Odesílání snímkù pøes sí¤ a 
archivace J.14

Pokud chcete odeslat trojrozmìrné obrazy na jiné místo v 
nemocnici, mùžete to provést pøímo z karty úlohy 3D. 

J.14

✧ Zvolte snímek v referenèním segmentu klepnutím na tento 
snímek.

Nebo J.14

✧ Zvolte obrazy ve výstupním segmentu. 

J.14 ✧ Kliknìte na tlaèítko Send to Node 1 v ovládací oblasti karty 
úlohy 3D. 

Nebo J.14

J.14 ✧ Stisknìte klávesu Send to Node 1 na klávesnici se symboly.
J.14–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Exponování na film, vyhodnocování a odesílání trojrozmìrných obrazù
Dialogové okno Send To se zobrazí pouze v pøípadì, že byl 
nakonfigurován více než jeden sí¤ový uzel. J.14

 

 

✧ Zvolte cílovou pracovní stanici nebo cílovou databázi. 

J.14 ✧ Kliknìte na tlaèítko Send, urèené k pøesunu vybraných 
obrazù. 
 

➭ Pomocí položky nabídky Transfer lze zpøístupnit další funkce, 
které slouží k archivaci a odesílání obrazù. 
Podrobné informace viz: 
→ Strana F.1–4, Automatické ukládání a odesílání
Verze VE31D J.14–5 
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Exponování na film, vyhodnocování a odesílání trojrozmìrných obrazù 3D Evaluation
Zavøení snímkù pacienta J.14 Zavøít mùžete všechny právì zobrazené obrazy. J.14

✧ Zvolte položku Patient > Close Patient.

nebo J.14

J.14 ✧ Kliknìte na tlaèítko Close Patient ve spodní èásti ovládací 
oblasti. 

Všechny obrazy se zavøou a odstraní z karty úlohy 3D. J.14

J.14
J.14–6 Návod k použití pro uživatele systému syngo

 0.0



KAPITOLA 0.0

J.15

 
Práce se dvìma monitory J.15
Funkce 3D Multi Monitor vám umožní využívat prostor dvou 
monitorù pro zobrazení obrazù. J.15

Pøi práci s jedním souborem dat je obsah výstupního segmentu 
(tj. 4. segmentu systému s jedním monitorem) v režimu Blow-
up na druhém monitoru (kromì funkcí Fly Through a Bone 
Removal). J.15

Kromì toho umožòuje speciální režim Compare zobrazit dva 
vyrovnané soubory dat, na každém monitoru jeden. Mùžete jej 
použít pro porovnání pøedbìžných a následných studií nebo pro 
porovnání kontrastních a nativních obrazù. J.15

➭ Fúzi nelze použít u systému se dvìma monitory, ale bude se 
používat pouze jeden monitor, pøièemž druhý zùstane 
prázdný a nevyužitý. 
Verze VE31D J.15–1 
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Práce se dvìma monitory 3D Evaluation
Zobrazení J.15

První monitor zobrazuje kartu úlohy 3D, jak je popsáno. 
→ Strana J.1–11, Karta úlohy 3D J.15

Druhý monitor má široké rozvržení obrazovky, tj. není 
zobrazena ovládací oblast a složka pacienta. J.15

J.15

Režim 3D Blow-Up J.15 Je-li naèten jen jeden soubor dat, normálnì se 3 obrazy MPR 
zobrazí na prvním monitoru a promítnutý obraz objemu (zde 
Free View) mùže být zobrazen ve zvìtšeném segmentu na 
druhém monitoru. 

J.15

J.15
J.15–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce se dvìma monitory
Režim Compare J.15 Jestliže jsou souèasnì naèteny dva datové soubory od jednoho 
nebo dvou pacientù stejné modality, použije se režim Compare. 
Na každém monitoru se zobrazí jeden datový soubor. J.15

Datové soubory jsou ve vzájemném vztahu, tj. jakákoli akce 
provedená na jednom datovém souboru bude provedena také 
na druhém datovém souboru. 

J.15

J.15
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Práce se dvìma monitory 3D Evaluation
Registrace datového souboru J.15

Jakmile naètete dvì vhodné série obrazù do režimu porovnání 
3D, provede se automatická registrace, tj. série na druhém 
monitoru se automaticky prostorovì vyrovná se sérií naètenou 
na prvním monitoru. J.15

➭ Existuje-li pøedchozí registrace, použije se.

 J.15

  J.15

J.15

UPOZORNÌNÍ

Automatická registrace pro rozvržení pøi porovnání není 
dostateèná. J.15

Nedostateèný podklad diagnózy J.15

✧ Zkontrolujte registraci a použijte funkci ruèní registrace pro 
nové nastavení registrace, jestliže je automatická registrace 
nedostateèná.
J.15–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce se dvìma monitory
Naètení J.15

Podle výbìru a aktuálního „stavu naplnìní", tj. karta úlohy je 
prázdná nebo je již naètena jedna série, spustí se 3D v rùzných 
režimech. 

J.15

Naètení jednoho souboru 
dat J.15

Karta úlohy 3D je prázdná. Vyberete jednu sérii v oknì Patient 
Browser, na kartì Viewing nebo v oknì 3D Series List. Když 
naètete tyto obrazy do MPR, MIP, SSD nebo VRT kliknutím na 
tlaèítko 3D MPR nebo výbìrem jedné se série MPR, MIP, SSD 
nebo VRT nabídky Application > 3D, spustí se režim 3D Blow 
Up. 
→ Strana J.15–2, Režim 3D Blow-Up 

J.15

Naètení druhé série J.15 Jedna série je již naètena na kartu úlohy 3D a vy vyberete 
druhou sérii. Když naètete tyto obrazy na kartu Fusion, spustí se 
režim Fusion (pouze na prvním monitoru). 

J.15

Naètení dvou sérií  
souèasnì J.15

Karta úlohy 3D je prázdná a vy vyberete dva soubory dat 
jednoho nebo dvou pacientù stejné modality. Když naètete tyto 
obrazy do MPR, MIP, SSD nebo VRT kliknutím na tlaèítko 3D MPR
nebo výbìrem jedné se série MPR, MIP, SSD nebo VRT nabídky 
Application > 3D, spustí se režim Compare. Uvnitø karty úloh 3D 
jsou datové soubory ve vzájemném vztahu, tj. jakákoli akce 
provedená na jednom datovém souboru bude provedena také 
na druhém datovém souboru. 
→ Strana J.15–10, Spuštìní režimu Compare 

J.15
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Práce se dvìma monitory 3D Evaluation
Seznam sérií pro 3D J.15

Jestliže jsou podmínky pro rozvržení Compare splnìny, je 
možné naèíst dvì série. 
→ Strana J.15–3, Režim Compare J.15

Údaje o pacientovi si mùžete prohlédnout v dialogovém oknì 
3D Series List. J.15

 

(1) Údaje o pacientovi
(2) Série vhodné pro trojrozmìrné zobrazení (platný seznam - 

valid)
(3) Série nevhodné pro trojrozmìrné zobrazení (neplatný 

seznam- invalid)
J.15–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce se dvìma monitory
Seznam pacientù J.15 Jsou možné dvì položky pacienta (napø. v pøípadì zmìny jména 
pacienta po sòatku nebo chybném pravopise). J.15

Vybrán mùže být jen jeden pacient. Zobrazí se s šedým pozadím. 
Všechny položky seznamu platných a neplatných sérií, které 
patøí k tomuto pacientovi jsou také oznaèené šedým pozadím. 
Takže je možné rozlišit mezi sériemi rùzných pacientù.  

J.15

Platný seznam J.15 Po výbìru platného seznamu jsou všechny položky seznamu, 
které lze dále vybrat pro naètení na kartu 3D souèasnì, 
oznaèeny modrým písmem jako pomùcka pro výbìr. J.15

Jestliže jsou splnìny podmínky pro rozvržení Compare, lze 
vybrat a pøenést najednou dvì série. 

J.15

Neplatný seznam J.15 Všechny série nevhodné pro trojrozmìrnou rekonstrukci se 
zobrazí ve spodním seznamu (Invalid Series). J.15

Pouze série náležející k položce pacienta s šedým pozadím jsou 
také šedé. J.15
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Práce se dvìma monitory 3D Evaluation
Rozvržení Compare J.15 Je vybrána první série platných sérií. Všechny série na seznamu 
platných sérií, které lze naèíst spoleènì s touto sérií do rozvržení 
3D Compare jsou zobrazeny s barevným pozadím. J.15

Jestliže jsou dva datové soubory stejné modality a od jednoho 
nebo dvou pacientù, lze je pøenést na karty úloh 3D v režimu 
Compare.  
 J.15

J.15

J.15

UPOZORNÌNÍ

Neúmyslné naètení sérií rùzných pacientù v režimu 3D 
Compare J.15

Možnost zámìny pacientù a nesprávné diagnózy J.15

✧ Pøi naèítání dat rùzných pacientù v režimu 3D Compare 
musíte potvrdit naèítání. 
J.15–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce se dvìma monitory
Chování se dvìma kartami úloh a jinými 
aplikacemi J.15

Mohlo by se stát, že karta úlohy 3D se zobrazí na jednom 
monitoru v popøedí karet úloh jiných aplikací, zatímco je v 
pozadí na druhém monitoru, napø. v popøedí bìží exponování 
na film. J.15

➭ Když kliknete uvnitø viditelné èásti karty úloh 3D, neviditelná 
èást karty úloh 3D zùstane skryta.

➭ Když kliknete na nìkterou ze dvou záložek karty úloh 3D, obì 
karty úloh 3D se zobrazí v popøedí.

➭ Dokud je viditelná alespoò jedna karta úloh 3D, žádný z 
dialogù nástrojù 3D (napø. Ranges) není skryt. Pak by se 
mohlo stát, že se zobrazí dialogové okno 3D v popøedí karty 
úloh jiné aplikace. Všechny dialogy 3D obsahují v záhlavích 
„3D", aby bylo zøejmé, kam patøí.
Verze VE31D J.15–9 
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Práce se dvìma monitory 3D Evaluation
Spuštìní režimu Compare J.15

Když jsou dva datové soubory stejné modality odeslány na kartu 
3D souèasnì, spustí se režim Compare. J.15

Na prvním monitoru se zobrazí poslední datový soubor. J.15

Když jsou naèteny dva soubory dat rùzných pacientù, zobrazí se 
varovné hlášení. J.15
J.15–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce se dvìma monitory
Manuální registrace J.15

Po naètení dvou datových souborù se provede automatická 
registrace a aplikuje se na tyto datové soubory. J.15

Nejste-li spokojeni s výsledkem automatické registrace, mùžete 
provést manuální registraci. 

J.15

Vyrovnání vedle sebe J.15 Pøed spuštìním manuální registrace byste mìli umístit dva 
datové soubory tak, aby první datový soubor zobrazoval 
anatomickou nebo patologickou strukturu zájmu (související 
druhý datový soubor samozøejmì tuto strukturu nezobrazuje). 
Uvnitø manuální registrace pak mùžete upravit druhý datový 
soubor (nezávisle na prvním datovém souboru), tak aby 
zobrazoval stejnou strukturu. Tím jste vytvoøili novou registraci, 
kterou od nynìjška mùžete používat. J.15
Verze VE31D J.15–11 
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Práce se dvìma monitory 3D Evaluation
J.15 ✧ Kliknìte na symbol tlaèítko 3D: Compare Mode Registration 
na kartì dílèí úlohy Image.

Zobrazí se dialogové okno 3D: Compare Mode Registration. 
Segmenty jsou v režimu manuálního vyrovnání. J.15

➭ Upravte obrazy jednoho datového souboru tak, aby 
zobrazovaly stejnou anatomickou nebo patologickou 
strukturu zájmu, jako obrazy druhého datového souboru. 
Proveïte to napø. pomocí záložek, referenèních èar, režimu 
posunu nebo režimu otáèení.
J.15–12 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce se dvìma monitory
Automatická registrace J.15

Pomocí funkce Automatic Registration mùžete vrátit zpìt 
manuální registraci. J.15

J.15 ✧ Kliknìte na ikonu Automatic Registration v dialogovém 
oknì 3D: Compare Mode Registration. 

Zobrazí se okno Automatic Registration. J.15

J.15

✧ Pro velmi pøesné vyrovnání zvolte položku Precise 
registration a pro rychlé vyrovnání zvolte položku Fast 
registration.

J.15 ✧ Klepnìte na tlaèítko Register.

J.15
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Práce se dvìma monitory 3D Evaluation
Uložení registraèní matrice J.15

Pole Registration Matrix uvádí všechny dostupné matrice 
(matrice definované uživatelem, poèáteèní a výchozí matrice). 
Po zadání nového jména na tomto místì mùžete aktuální 
registraci uložit jako novou matici do místní databáze nebo ji 
vymazat. J.15

Zadejte nový název do pole Registration matrix pøepsáním 
stávajícího názvu nebo ponechte aktuální název pro uložení 
jako aktualizovanou verzi. J.15

➭ Není možné pøepsat matrici Initial. Pokud se takovou matrici 
pokusíte pøepsat, uloží se matrice pod vygenerovaným 
názvem: ”User Defined”.

J.15 ✧ Kliknìte na ikonu Save Matrix. 
 
 

Vymazání uložené matrice J.15 ✧ Ze seznamu Registration Matrix vyberte název.

J.15 ✧ Kliknìte na ikonu Delete Matrix.

Vybraná registraèní matrice bude vymazána ze seznamu a z 
databáze. J.15

➭ Není možné odstranit matrici Initial.

J.15
J.15–14 Návod k použití pro uživatele systému syngo
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3D Evaluation Práce se dvìma monitory
Režim Correlation J.15

Po automatické registraci a pøípadné manuální korelaci 
registrace jsou oba datové soubory ve vzájemném vztahu. To 
znamená, že jakákoli akce provedená na jednom datovém 
souboru bude také provedena na druhém datovém souboru. J.15

Akce, které budou podporovány datovými soubory ve 
vzájemném vztahu na obou monitorech: J.15

❏ Otáèení MPR 
→ Strana J.3–16, Natoèení pomocí nitkového køíže

❏ Zvìtšení a posun 
→ Strana E.4–22, Zvìtšování a posun snímkù

❏ Posun 
→ Strana J.3–18, Posun

❏ Volný pohled 
→ Strana J.3–49, Volný pohled

❏ VOI okno zábìru 
→ Strana J.3–56, Operace s clipboxem

❏ Zvìtšení segmentu 
→ Strana J.3–37, Zvìtšení segmentu

➭ Zobrazí se dva vzájemnì vztažené kurzory myši. Tyto dva 
kurzory mají rùznou barvu, aby se rozlišilo mezi aktivním 
(bílým) kurzorem, který umožòuje manipulace datového 
souboru v segmentu, a souvisejícím (žlutým) kurzorem, který 
je zobrazen v odpovídajícím segmentu.

➭ Spustíte-li režim na jednom monitoru a potom vyberete 
segment na druhém monitoru, objeví se hlášení „Do you 
want to end the current mode?" (Chcete ukonèit aktuální 
režim?), kterou musíte potvrdit.
Verze VE31D J.15–15 
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Práce se dvìma monitory 3D Evaluation
J.15–16 Návod k použití pro uživatele systému syngo

 0.0



KAPITOLA 0.0

J.16

 
Konfigurace 3D zobrazeníJ.16
V nabídce 3D Configuration mùžete zmìnit nìkolik nastavení:J.16

❏ zobrazit nebo skrýt popis orientace

❏ uložit snímky s referenèními èárami nebo bez nich

❏ automatické ukládání sérií

❏ ukládání s referenèním snímkem

❏ filmování s referenèním snímkem

❏ automatická orientace referenèního snímku

❏ pøevzorkování sady dat

❏ aktualizovat zmìny ve Fly Through a konfigurovat zobrazení 
dráhy 
 

✧ Vyvolejte okno syngo - Configuration Panel  
(Options > Configuration... v hlavní nabídce).

J.16 ✧ Poklepnutím na tuto ikonu zobrazte dialogové okno 3D 
Configuration.  

➭ V èásti Základy tohoto manuálu si mùžete pøeèíst, jak otevøít a 
opustit okno konfigurace, ukládat zmìny a vrátit nastavení do 
pùvodního stavu pøi dodání zaøízení. 
→ Kapitola A.4, Konfigurace uživatelského rozhraní
Verze VE31D J.16–1 
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Konfigurace 3D zobrazení 3D Evaluation
Konfigurace informací o snímku J.16

Mùžete konfigurovat rùzné orientaèní pomùcky, které se 
zobrazují ve snímcích. J.16

✧ Pøemístìte kartu Segment Information do popøedí.

 

J.16–2 Návod k použití pro uživatele systému syngo
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3D Evaluation Konfigurace 3D zobrazení
Zobrazení popisu orientaceJ.16

J.16 ✧ Kliknìte na volbu Display orientation description, pokud 
chcete zobrazit popis orientace. 
→ Strana J.3–5, Orientaèní pomùcky na snímku 

Ukládání snímkù s 
referenèními èarami J.16

J.16

J.16 ✧ Kliknìte na volbu Save images with reference lines, pokud 
chcete referenèní èáry uloženy s obrazem pøi jeho kopírování 
na kartu Viewing nebo Filming. 
→ Strana J.3–13, Použití trojrozmìrného nitkového køíže 
Verze VE31D J.16–3 
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Konfigurace 3D zobrazení 3D Evaluation
Konfigurace zpracování sérií J.16

Na kartì Ranges mùžete nastavovat ukládání a filmování sérií. 
Dále mùžete konfigurovat orientaci referenèního snímku, 
pokud generujete paralelní a radiální øady. J.16

✧ Klepnutím pøemístìte kartu dílèí úlohy Ranges do popøedí.

 

J.16–4 Návod k použití pro uživatele systému syngo
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3D Evaluation Konfigurace 3D zobrazení
Konfigurace ukládání J.16

Rekonstruované série (rozsahy) mohou být plnì automaticky 
ukládány s referenèním obrazem nebo bez nìj. 

J.16

Aktivace automatického 
ukládání J.16

J.16 ✧ Kliknìte na volbu Enable auto-save, pokud chcete 
automaticky ukládat všechny rekonstruované série.

Ukládání 
referenèního obrazu J.16

✧ Kliknìte na volbu Include the reference image when 
saving ranges or curved cuts, pokud chcete uložit i 
referenèní obraz série. 
→ Strana J.3–78, Generování série z trojrozmìrných snímkù
Verze VE31D J.16–5 
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Konfigurace 3D zobrazení 3D Evaluation
Konfigurace filmování J.16

Rekonstruované série mohou být filmovány s, nebo bez 
referenèního snímku. J.16

 

✧ Kliknìte na volbu Include the reference image when 
filming the ranges or curved cuts, pokud chcete exponovat 
na film také referenèní obraz série.
J.16–6 Návod k použití pro uživatele systému syngo
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3D Evaluation Konfigurace 3D zobrazení
Konfigurace orientace referenèního snímku J.16

Pokud generujete paralelní a radiální série pomocí uložených 
výchozích nastavení, máte možnost automatického naètení 
výchozího nastavení orientace referenèního snímku. J.16

✧ Kliknìte na volbu Apply orientation saved in preset to 
reference image.

Pokud v budoucnosti otevøete dialogové okno pro vytváøení 
paralelních a radiálních sérií, referenèní snímek se automaticky 
zorientuje. Bude použita orientace nastavená pro referenèní 
snímek v dobì, kdy jste ukládali výchozí nastavení pøíslušné 
skupiny sérií. J.16

J.16
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Konfigurace 3D zobrazení 3D Evaluation
Konfigurace kvalitativního filtru J.16

Pro výpoèet radiálních øad mùžete použít speciální filtr s 
vysokým rozlišením pro zvýšení kvality obrazu pøi filmování. 
Kvalitativní filtr je aplikován bìhem výpoètu øady na snímky, u 
kterých velikost matrice nepøekraèuje nastavené meze. J.16

 

✧ Zaškrtnutím volby Use high quality filter MIP and MinIP 
zapnete filtrování vysoké kvality.

✧ Maximální velikost matrice pro filtrování nastavte pomocí 
èíselníku.
J.16–8 Návod k použití pro uživatele systému syngo
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3D Evaluation Konfigurace 3D zobrazení
Konfigurace pøevzorkování J.16

Data mùžete pøevzorkovat pomocí pùvodního rozlišení nebo 
pomocí fúzované série. J.16

J.16 ✧ Kliknìte na volbu Always resample with original 
resolution, pokud má být rozlišení pøevzorkované série 
stejné jako rozlišení referenèní série.

To se používá i k výpoètu rozsahu modelové série. 
J.16

J.16 ✧ Klepnìte na volbu Always resample with fused series, 
pokud pøevzorkovaná série má být vytvoøena z fúzované 
série.
Verze VE31D J.16–9 
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Konfigurace 3D zobrazení 3D Evaluation
Konfigurace virtuální endoskopie J.16

Na kartì Fly Through mùžete konfigurovat aktualizaci zmìn v 
segmentech a zobrazení èar pro vizualizaci dráhy. J.16

✧ Klepnutím na kartu Fly Through pøemístìte kartu do 
popøedí.
J.16–10 Návod k použití pro uživatele systému syngo
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3D Evaluation Konfigurace 3D zobrazení
Aktualizace zmìn J.16

Máte možnost zvolit okamžitou nebo následnou aktualizaci 
segmentù snímku. J.16

 

✧ Na tuto volbu klepnìte, pokud se zmìny v jednom segmentu 
mají okamžitì zobrazit i v ostatních segmentech.

Jinak se zmìny v jednom segmentu zaktualizují až po dokonèení 
práce s ostatními segmenty. J.16
Verze VE31D J.16–11 
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Konfigurace 3D zobrazení 3D Evaluation
Zobrazení dráhy J.16

Dráhu zobrazíte pomocí bodù v dialogovém oknì 3D: Path 
Planning, a to jako funkci poloh tìchto bodù (v mìøítku) nebo 
podle všech vlastností FVV. J.16

✧ Klepnìte na tuto volbu, pokud chcete dráhu zobrazit v 
závislosti na všech vlastnostech spojených s jednotlivými 
body.

Jestliže dva body mají stejnou pozici, ale rozdílné vlastnosti FVV 
(napøíklad smìr pohledu), vypoèítá se vzdálenost mezi tìmito 
body ze souètu rozdílných vlastností. J.16

✧ Pokud chcete zobrazit dráhu pouze v závislosti na polohách 
bodù, zrušte tuto volbu.

Jestliže dva body mají stejnou polohy, ale rozdílné vlastnosti 
FVV (napø. smìr pohledu), budou zobrazeny nad sebou na èáøe 
pro vizualizaci dráhy. J.16

J.16

J.16

J.16
J.16–12 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

K.1

 
Úvod K.1
Výsledkem tomografického vyšetøení je posloupnost obrazù 
pevného datového objemu. 
Zkombinováním dvourozmìrných obrazù je možné získat 
trojrozmìrné zobrazení oblasti zájmu. K.1

(1) Dvourozmìrné tomografické snímky
(2) Sada dat objektu 

Funkce Fly Through umožòuje vizualizovat zobrazení anatomie 
vytvoøením trojrozmìrných “objektových” modelù. Používá se k
vizualizaci dutin, napø. tlustého støeva, prùduškového systému 
a artérií z poloh uvnitø objektu. K.1

(1) (2)
Verze VE31D K.1–1 
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Úvod Virtuální endoskopie
Právní pokyny K.1 ❏ Federální zákon omezuje prodej tohoto zaøízení na prodej 
prostøednictvím lékaøe nebo na základì jeho objednávky 
(pouze v USA).

❏ Toto zaøízení se neodbavuje jako snímací zaøízení.

❏ Tento postup nenahrazuje obvyklé endoskopické nebo 
angiografické postupy.

!0

K.1 K.1

K.1

Zobrazené barvy jsou simulované a nepøedstavují skuteèné 
anatomické barvy. K.1
K.1–2 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Úvod
Karta úlohy Fly K.1

Své prostorové obrazy zpracováváte na kartì úlohy Fly. K.1

Karta úlohy je dále rozdìlena do tìchto hlavních èástí: K.1

 

(1) Hlavní nabídka rozšíøená o položky týkající se karty Fly
(2) Ovládací oblast pro snadné spouštìní funkcí
(3) Oblast snímku rozdìlená do ètyø segmentù
(4) Stavový øádek pro zpìtnou vazbu a chybová hlášení
Verze VE31D K.1–3 
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Úvod Virtuální endoskopie
Zpùsob vyhodnocení K.1

Systém nabízí následující metody, jak kombinací 
dvourozmìrných snímkù dosáhnout trojrozmìrného pohledu:K.1

❏ Multiplanární rekonstrukce (MPR) se používá k umístìní øezù 
v požadované oblasti v rùzných smìrech. Výsledkem jsou 
dvourozmìrné snímky.

❏ U vyšetøení pomocí kontrastní látky a zejména u angiografie 
mùžete použít projekci maximální intenzity (MIP).

❏ K vyhodnocení kostního a cévního vyšetøení, které chcete 
zobrazit ve virtuálním trojrozmìrném provedení, mùžete 
napøíklad použít metodu perspektivního zobrazení se 
stínovaným povrchem (pSSD).

❏ Technika zobrazování objektu (VRT nebo pVRT) se napøíklad 
používá k rozlišení struktury orgánù od tkánì a v pøípadì 
barevného trojrozmìrného k zobrazení k rozlišení kostí od 
tkánì a orgánù.

K.1
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Virtuální endoskopie Úvod
Multiplanární rekonstrukce (MPR) K.1

Pomocí multiplanární rekonstrukce mùžete vypoèítat 
sekundární snímky libovolných rovin z objektu, napøíklad 
sagitální, koronální nebo jakýkoliv zakøivený pohled. K.1

Rekonstruovat mùžete jak jednotlivé snímky, tak sérii snímkù. K.1

 

(1) Transversální/axiální
(2) Koronální
(3) Paraxiální
(4) Sagitální
(5) Paraxiální
(6) Sagitální
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Úvod Virtuální endoskopie
U multiplanární rekonstrukce se dvojrozmìrné snímky vždy 
vypoèítávají z "objektu". Napøíè znázornìním se však mùžete 
rychle pohybovat pomocí trojrozmìrného nitkového køíže nebo 
myši. Tak získáte dojem, že obraz je trojrozmìrný. K.1

Èím menší je vzdálenost mezi øezy nebo èím více se pùvodní 
snímky pøekrývají, tím vìtší je rozlišovací schopnost ve smìru 
vyšetøení. K.1

Minimální tlouš¤ka øezu snímku MPR je jeden voxel. Mùžete však 
vygenerovat i silnìjší øezy (MPR Thick). Støední hodnoty 
stupnice šedi jsou vypoèítány pro voxely umístìné za sebou. K.1

 

(1) Øez MPR (tlouš¤ka øezu 1 voxel)
(2) MPR Thick (tlouš¤ku øezu lze nastavit)
K.1–6 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Úvod
Projekce maximální intenzity (MIP) K.1

Ve zvoleném pohledu pøes objekt jsou urèeny a promítnuty na 
povrch prvky objektu (tzv. voxely) s nejvyšší/nejnižší intenzitou 
bez ohledu na to, zda se v sadì nacházejí vpøedu nebo vzadu. 
Tato metoda vytváøí projekci maximální/minimální intenzity. K.1

Pøi použití této metody mùžete napøíklad využít skuteènosti, že 
cévy naplnìné kopntrastní látkou se v objektu vždy zobrazují 
jako struktury s hodnotami stupnice šedi maximální intenzity. K.1

(1) Voxely na snímcích MIP
(2) Hodnota stupnice šedi maximální intenzity

Voxel s maximální intenzitou je zobrazen na snímku MIP. K.1

Nìkteré struktury, zejména kosti, zpùsobují rušení projekce. V 
místì pøekrývání kostí s cévami v projekci MIP mohou voxely 
(hustších) kostí pøekrýt voxely cév. 

K.1
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Úvod Virtuální endoskopie
Zobrazení se stínovaným povrchem (pSSD) K.1

Pomocí této metody rekonstruujete povrch objektù. Tyto 
objekty se skládají z voxelù (objektových voxelù), jejichž 
stupnice šedi mají rozsah urèený dvìma mezními hodnotami, a 
sice horní a dolní mezní hodnotou stupnice šedi. Tato metoda je 
obzvláštì vhodná k zobrazování struktur kostí nebo cév po 
aplikaci kontrastní látky. K.1

 

(1) Voxely na snímku pSSD
(2) Sada dat objektu nejpøednìjšího voxelu na povrchu

Nejpøednìjší voxel daného rozsahu objektu, který je v urèeném 
rozsahu stupnice šedi, je zobrazen na snímku pSSD. K.1
K.1–8 Návod k použití pro uživatele systému syngo

 0.0



Virtuální endoskopie Úvod
Smìr pohledu v reálném èase mùžete zmìnit myší nebo 
trojrozmìrným nitkovým køížem. K.1

Mùžete napøíklad vyøíznout libovolné struktury, abyste 
zdùraznili zvláštì dùležité oblasti. K.1

Stupnice šedi, které se zobrazí na displeji, už nejsou mìøenými 
hodnotami. Mají pouze poskytnout dojem prostoru. K.1

Jemné rozlišení hustoty tkánì už není možné, napøíklad 
kalcifikaci cév a kontrastní látku v cévách už nelze v zobrazení 
pSSD rozlišit podle jejich hustoty. K.1
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Úvod Virtuální endoskopie
Technika zobrazování objektu (VRT a pVRT) K.1

Technika zobrazování objektu (VRT) je zpùsob, jak vytvoøit 
barevné snímky, u nichž se dosáhne trojrozmìrného efektu 
takovými parametry jako je prùhlednost, stínování a barevný 
pøechod. K.1

Na snímku je obsažena celá sada dat objektu. Požadované 
oblasti (napøíklad kost a cévy) lze interaktivnì zdùraznit 
pøiøazením vhodných hodnot barvy a prùhlednosti. K.1

Metoda VRT vychází z myšlenky, že urèené vlastnosti zobrazení 
(barva, jas, kontrast a prùhlednost) jsou pøiøazeny k voxelùm 
sady dat objektu v závislosti na výchozí hodnotì obrazového 
bodu (hodnota HU nebo hodnota signálu MR). V praxi je rozsah 
vstupních hodnot obrazových bodù pøiøazen ke specifickým 
druhùm tkánì. K.1

K.1
K.1–10 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

K.2

 
Naèítání obrazù K.2
K trojrozmìrnému zpracování snímkù se používají snímky z 
vyšetøení, které jsou uloženy v místní databázi systému nebo v 
archivu. K.2

Pokud je systém integrován do nemocnièní sítì, mùžete pøijímat 
data snímkù z ostatních oddìlení a pak je v systému 
vyhodnocovat. K.2

Tato data jsou pøístupná v oknì Patient Browser. V tomto oknì 
mùžete vyhledávat pacienty, studie, série nebo jednotlivé 
snímky a pøesunout je na kartu úlohy Fly. K.2

Snímky mùžete také pøesunout z okna Viewing na kartu úlohy 
Fly. K.2
Verze VE31D K.2–1 
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Naèítání obrazù Virtuální endoskopie
Zaèátek vyhodnocování letu K.2

Máte rùzné možnosti, jak spustit aplikaci Fly. 
K.2

Výbìr obrazù/sérií pro 
zpracování K.2

Nejprve vyberte snímky nebo série, které chcete zobrazit 
trojrozmìrnì v prohlížeèi Patient Browser nebo na kartì úlohy 
Viewing. K.2

V tomto kroku mùžete zvolit pro jednoho pacienta více sérií. 
 

K.2

Volba tlaèítka Fly K.2 ✧ Klepnìte na tlaèítko Fly na øádku nabídek karty Patient 
Browser.

Nebo K.2

✧ V nabídce Patient Browser vyberte Applications > 3D > Fly. 

Proveïte pøetažení nebo 
poklepejte na Patient 
Browser K.2

✧ Pøesuòte snímky vybrané na kartì Patient Browser 
pøetažením na kartu úlohy Fly nebo poklepáním.

➭ Jestliže karta úlohy není v popøedí, mùžete snímky pøetáhnout 
též z prohlížeèe Browser na odpovídající záložku. Karta úlohy 
se pøesune do popøedí a snímky se naètou do oblasti snímkù.

Bìhem pøesunu systém testuje, zda jsou vámi zvolené snímky a 
série použitelné pro následné zpracování v aplikaci Fly. V 
pøípadì potøeby systém zobrazí okno s hlášením upozoròujícím 
na nekonzistentnost série. K.2
K.2–2 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Naèítání obrazù
Výbìr obrazù pro trojrozmìrné zobrazení musí minimálnì 
splòovat následující kritéria: K.2

❏ Musí být naèteny alespoò 3 snímky.

❏ Všechny obrazy musí být rovnobìžné a musí se nacházet v 
jedné ose. 

Vybrána jedna série K.2 Pokud jste zvolili pouze jednu sérii, která také splòuje výše 
uvedená kritéria, otevøe se karty úlohy Fly, snímky se do ní 
pøesunou a jejich vyhodnocování mùže ihned zaèít. K.2

V pravém dolním segmentu se objeví pohled letu v režimu pSSD 
(perspective Surface Shaded Display – perspektivní zobrazení se 
stínovaným povrchem). K.2

Ve tøech referenèních segmentech se zobrazí Fly View Volume 
(FVV). K.2
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Naèítání obrazù Virtuální endoskopie
(1) Sagitální pohled

(2) Transverzální pohled

(3) Koronální pohled

(4) Segment letu

K.2
K.2–4 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Naèítání obrazù
Nyní mùžete pøejít zde: 
→ Kapitola K.4, Multiplanární rekonstrukce (MPR) 
→ Kapitola K.5, Projekce maximální intenzity 
→ Kapitola K.6, Rekonstrukce povrchù (pSSD) 
→ Kapitola K.7, Technika vykreslování objektu (VRT/pVRT) 
→ Kapitola K.8, Let 

K.2

Vybráno nìkolik sérií K.2 Pokud vyberete nìkolik sérií nebo nevhodné série, zobrazí se 
okno 3D Series List.  
→ Strana K.2–7, Seznam sérií pro 3D 

K.2

Trojrozmìrné zobrazení sérií 
z okna 3D Series List K.2

Posledním krokem je volba série z okna 3D Series List a její 
pøenesení do karty úloh Fly. K.2

Na kartì úlohy Fly se zvolená série zobrazí trojrozmìrnì pomocí 
zvolené metody. Nyní mùžete zobrazení vyhodnotit. K.2

➭ Na kartì úlohy Fly nelze zpracovávat více sérií souèasnì.
Verze VE31D K.2–5 
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Naèítání obrazù Virtuální endoskopie
Otevøení karty úlohy Fly K.2

Po naètení obrazù na kartu úlohy Fly se mùžete pøepnout do 
jiných úloh a poté se na kartu úlohy Fly vrátit a pokraèovat ve 
vyhodnocení obrazù. 

K.2

K.2 ✧ Kliknutím na záložku karty se vrátíte na kartu úlohy Fly. 

Karta úlohy Fly se pøesune do popøedí ve stejném stavu, v jakém 
jste ji opustili. 

K.2
K.2–6 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Naèítání obrazù
Seznam sérií pro 3D K.2

Výsledky vašeho výbìru jsou zobrazeny v dialogovém oknì 3D 
Series List. K.2

Otevøení okna 3D Series 
List K.2

Okno 3D Series List mùžete otevøít také explicitnì, napøíklad 
abyste do karty funkcí Fly naèetli jinou sérii. 
→ Strana K.2–15, Další série ze seznamu sérií 3D 

K.2

✧ Spus¤te pøíkaz Patient > Open Series List... v hlavní nabídce 
karty úlohy Fly.

V dialogovém oknì Progress se zobrazí tøídìní obrazù. Tøídìní 
mùžete zrušit stisknutím tlaèítka Cancel. K.2

K.2
Verze VE31D K.2–7 
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Naèítání obrazù Virtuální endoskopie
Zobrazí se dialogové okno 3D Series List. Toto okno je 
rozdìleno na následující pole: K.2

 

(1) Údaje o pacientovi
(2) Série vhodné pro trojrozmìrné zobrazení (platný seznam - 

valid)
(3) Série nevhodné pro trojrozmìrné zobrazení (neplatný 

seznam- invalid)
K.2–8 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Naèítání obrazù
Seznam pacientù K.2 Zobrazen je pouze jeden záznam pacienta s šedým pozadím. 
Všechny položky seznamu platných a neplatných sérií, které 
patøí k tomuto pacientovi jsou také šedé. K.2

Platný seznam K.2 Podle toho, kolik sérií jste vybrali v oknì Patient Browser, mùže 
se zobrazit nìkolik položek seznamu. Vybrána a pøenesena 
mùže být pouze jedna série najednou. K.2

Neplatný seznam K.2 Všechny série nevhodné pro trojrozmìrnou rekonstrukci se 
zobrazí ve spodním seznamu (Invalid Series). Vedle údajù o 
sérii se zobrazí také poznámka, která vám poskytne podrobnìjší 
dùvod pro zamítnutí. K.2

➭ Váš poèítaèový systém má pouze omezenou kapacitu pro 
uložení. Poèet snímkù pro trojrozmìrné zobrazení je tedy také 
omezen. V oknì 3D Series List najdete obrazy, které nelze 
naèíst do seznamu Invalid Series.

➭ Jestliže bylo vybráno více sérií, tlaèítko Select je 
deaktivováno. Naètení do 3D není možné. 
Verze VE31D K.2–9 
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Naèítání obrazù Virtuální endoskopie
Skrytí seznamu neplatných 
sérií K.2

Seznam Invalid Series mùžete pro zachování pøehlednosti 
dialogového okna 3D Series List skrýt. K.2

K.2 ✧ Klepnìte na zaškrtávací políèko Show invalid series list, 
odstraòte zaškrtnutí a tím danou volbu zrušte.

Obrazovka se okamžitì aktualizuje, zobrazení seznamu Valid 
Series bude vìtší. Seznam Invalid Series se již nezobrazuje. K.2

➭ Pokud žádná ze zvolených sérií není vhodná pro trojrozmìrné 
zobrazení, takže seznam Valid Series je prázdný, nelze 
seznam Invalid Series skrýt.
K.2–10 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Naèítání obrazù
Sluèování sérií K.2

Pokud jste pro trojrozmìrné zobrazení zvolili série, jejichž 
rozsahy vyšetøení se pøekrývají, mùžete v oknì Series List
rozhodnout, zda chcete tyto série slouèit a vytvoøit tak pro svùj 
trojrozmìrný model jedinou sérii. Tímto zpùsobem je možné 
zvìtšit zobrazovaný objekt nebo zvýšit kvalitu zobrazení. K.2

➭ Série, které chcete slouèit, musí být poøízeny s maximálním 
odstupem 30 minut. 
 

K.2 ✧ Pokud chcete slouèit vhodné série, zvolte možnost Merge 
when possible.

Obrazovka se okamžitì aktualizuje. K.2

➭ Jestliže byl snímek CT poøízen dvakrát ve stejné poloze, 
použije se vždy poslední snímek. Jestliže byly série poøízeny 
rozdílnými snímacími metodami (sekvenèní nebo spirálovou), 
použije se vždy spirálovì poøízený snímek.

➭ Pokud byly série získány pomocí MR, systém použije v první 
polovinì rozsahu, který se pøekrývá, obrazy z první série a ve 
druhé polovinì rozsahu, který se pøekrývá, obrazy z druhé 
série. 

K.2 ✧ Pokud chcete slouèené série znovu oddìlit, zrušte volbu 
možnosti Merge when possible.
Verze VE31D K.2–11 
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Naèítání obrazù Virtuální endoskopie
Pøesun sérií na kartu Fly K.2

Pokud seznam Valid Series obsahuje více sérií vhodných pro 
trojrozmìrné zobrazení, musíte rozhodnout, kterou sérii chcete 
zobrazit a vyhodnotit v trojrozmìrném zobrazení. K.2

➭ Na kartì úlohy Fly mùžete vždy zobrazit a zpracovávat pouze 
jednu sérii najednou.

➭ Na kartu úlohy Fly mohou být pøesunuty pouze lékaøské 
snímky.  

✧ V seznamu Valid Series dvojitì kliknìte na sérii, kterou 
chcete zpracovat jako první.

Nebo K.2

K.2 ✧ V seznamu vyberte sérii a klepnìte na tlaèítko.

Série bude pøenesena na kartu úlohy Fly a dialogové okno 3D 
Series List se zavøe. 

K.2

Zavøít bez pøesunu K.2 Po pøevodu obrazù do seznamu 3D Series List mùžete zastavit 
zpracování, napøíklad zpracování obrazù. K.2

K.2 ✧ Kliknutím na tlaèítko Cancel zavøete dialogové okno 3D 
Series List.

Vrátíte se na kartu úlohy Viewing nebo do prohlížeèe Patient 
Browser. K.2
K.2–12 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Naèítání obrazù
Neuložená data na kartì 
úloh Fly K.2

Chcete-li naèíst sérii na kartu úloh Fly a na kartì úloh Fly jsou 
neuložená data, zobrazí se dialogové okno Confirm. K.2

 

K.2 ✧ Tlaèítkem Yes potvrïte naètení nové série na kartu úlohy Fly 
bez uložení a stará série se zavøe. 
 

Nebo K.2

K.2 ✧ Klepnìte na tlaèítko No, pokud chcete pokraèovat ve 
zpracování staré série na kartì úlohy Fly.

Nový seznam se nepøesune. Zobrazí se dialogové okno Series 
List, ze kterého mùžete napøíklad vybrat jiný seznam. K.2

Nebo K.2

K.2 ✧ Pøesun nové série zrušte klepnutím na tlaèítko Cancel.

Vrátíte se do prohlížeèe Patient Browser nebo na kartu úlohy 
Viewing. K.2
Verze VE31D K.2–13 
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Naèítání obrazù Virtuální endoskopie
Dlouhý výpoèet na kartì 
úloh Fly K.2

Chcete-li naèíst sérii na kartu úloh Fly a na kartì úloh Fly bìží 
dlouhý výpoèet, zobrazí se dialogové okno Confirm. K.2

 

K.2 ✧ Tlaèítkem Yes potvrïte zastavení výpoètu a naètení nové 
série na kartu úloh Fly a zavøete starou sérii. 
 

Nebo K.2

K.2 ✧ Klepnìte na tlaèítko No, pokud chcete pokraèovat ve 
zpracování staré série na kartì úlohy Fly.

Nový seznam se nepøesune. Zobrazí se dialogové okno Series 
List, ze kterého mùžete napøíklad vybrat jiný seznam. K.2

Nebo K.2

K.2 ✧ Pøesun nové série zrušte klepnutím na tlaèítko Cancel.

Vrátíte se do prohlížeèe Patient Browser nebo na kartu úlohy 
Viewing. K.2
K.2–14 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Naèítání obrazù
Další série ze seznamu sérií 3D K.2

Z karty úlohy Fly se mùžete kdykoliv dostat také k dalším sériím, 
které jste pøedem vybrali ke zpracování v oknì 3D Series List. K.2

✧ Otevøete dialogové okno 3D Series List pomocí položky 
Patient > Open Series List....

✧ Klepnutím na tlaèítko Select vyberte jinou sérii a pøesuòte ji.

Po potvrzení dialogového okna se døíve naètená série zavøe. K.2

K.2
Verze VE31D K.2–15 
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Naèítání obrazù Virtuální endoskopie
K.2–16 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

K.3

Práce s virtuální 
endoskopií K.3
Rùzné orientaèní pomùcky, jako napøíklad orientaèní krychle, 
vám usnadòují orientaci v objektu. Tyto pomùcky se vztahují k 
souøadnému systému pacienta a tento systém zobrazuje smìr 
pohledu nebo orientaci snímku. K.3

V objektu se mùžete pohybovat tak, abyste našli snímky 
relevantní pro diagnózu. K tomuto úèelu použijte záložky nebo 
otáèejte sadou dat snímku pomocí myši. K.3

Potom zvolte typ výstupu, napø. MPR, MIP, pSSD nebo pVRT 
nebo použijte již nastavený typ. K.3
Verze VE31D K.3–1 
únor 2006   

 0.0



Práce s virtuální endoskopií Virtuální endoskopie
Souøadný systém pacienta K.3

Orientace snímkù je urèena souøadným systémem vztaženým k 
pacientovi. Tato data urèují u každého snímku smìr, ze kterého 
se díváte na pacienta (trojrozmìrnì) a polohu øezu v oblasti 
zájmu (dvourozmìrnì). K.3
K.3–2 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Smìry K.3 Smìry jsou v souøadném systému pacienta popsány 
následujícím zpùsobem: K.3

 

(1) F znamená smìr od nohou k hlavì,
(2) R znamená smìr zprava doleva,
(3) A znamená smìr zepøedu dozadu,
(4) H znamená smìr od hlavy k nohám,
(5) L znamená smìr zleva doprava,
(6) P znamená smìr zezadu dopøedu.

Smìry se zobrazují na obrazech jako orientaèní znaèky. 
→ Strana K.3–6, Orientaèní znaèky K.3
Verze VE31D K.3–3 
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Práce s virtuální endoskopií Virtuální endoskopie
Standardní anatomické  
pohledy K.3

Pohledy podél nìkteré z os souøadného systému pacienta se 
nazývají standardní anatomické pohledy. Øezy sledované v 
tìchto pohledech vypadají takto: K.3

 

(1) Sagitální øez
(2) Transverzální øez
(3) Koronální øez

(1) (2) (3)
K.3–4 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Orientaèní pomùcky na snímku K.3

Pro orientaci jsou na snímku zobrazeny rùzné pomùcky. Tyto 
pomùcky ukazují smìr, ze kterého pozorujete daný obraz. 

K.3

Popis orientace K.3

K.3 U snímkù MR jsou zobrazeny údaje o úhlech standardních 
pohledù (sagitálního, transverzálního a koronálního). Pokud 
napøíklad nakloníte snímek z roviny transverzálního pohledu 
smìrem ke koronální rovinì, zjistíte tak úhel, o jaký jste rovinu 
natoèili. Mùžete natoèit i znázornìní v jedné rovinì. Pokud 
natoèíte snímek ve smìru jiné roviny pohledu (v tomto pøípadì 
sagitální), zobrazuje se i tento úhel natoèení vzhledem ke 
standardnímu pohledu. K.3

K.3 U obrazù CT se zobrazí úhel natoèení a náklonu ve vztahu ke 
standardním pohledùm. Tím je popsána orientace stejným 
zpùsobem jako u obrazù MR. K.3

Popis orientace je také exponován na film a ukládán. 
K.3

Orientaèní krychle 
K.3

Orientaèní krychle je zobrazována na všech snímcích. Oznaèuje 
polohu zobrazené vrstvy vzhledem k souøadnému systému 
pacienta. 
→ Strana K.3–2, Souøadný systém pacienta K.3

Tato krychle je spolu se snímky také filmována a ukládána. K.3
Verze VE31D K.3–5 
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Práce s virtuální endoskopií Virtuální endoskopie
Orientaèní znaèky K.3 Orientaèní znaèky ukazují orientaci pacienta na snímku. Jsou 
totožné se smìry v souøadném systému pacienta. Tento text se 
vždy zobrazuje uprostøed horního a levého okraje snímku. K.3

❏ L, R - vlevo, vpravo 
Smìr pozorování sagitální zleva nebo zprava

❏ A, P - anteriorní, posteriorní 
Smìr pozorování koronální zepøedu nebo zezadu

❏ H, F - hlava, nohy 
Smìr pozorování transverzální od hlavy nebo nohou

→ Strana K.3–28, Nastavení standardních pohledù K.3

 

H

R

K.3–6 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Zobrazení snímku v letu K.3

Oblast snímku je na kartì úlohy Fly rozdìlena do ètyø segmentù. 
Jednotlivé segmenty mají rozdílnou funkci v závislosti na tom, v 
jakém režimu právì pracujete. K.3

Oblast snímku v referenèním režimu K.3

První tøi segmenty jsou segmenty referenèní, ètvrtý segment je 
výstupním segmentem.  

K.3

Referenèní segmenty K.3 Ve tøech referenèních segmentech jsou snímky nejprve 
zobrazeny v pohledech, které jsou paralelní a kolmé ke smìru 
snímání K.3

Natáèením a pøesouváním pohledù mùžete urèit polohu a 
orientaci roviny, která bude použita jako referenèní snímek k 
rekonstrukci snímkù nebo sérií. K.3

Referenèní segmenty jsou použity k zobrazení rùzných pohledù 
na sadu dat objektu, zatímco referenèní zobrazení (pohled) je 
použito jako reference pro trojrozmìrnou rekonstrukci. 

K.3

Výstupní segment K.3 Ve výstupním segmentu je zobrazen rekonstruovaný 
trojrozmìrný pohled typu pSSd. K.3
Verze VE31D K.3–7 
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Práce s virtuální endoskopií Virtuální endoskopie
 

(1) Referenèní segment (sagitální pohled)
(2) Referenèní segment (koronální pohled)
(3) Referenèní segment (transverzální pohled)
(4) Výstupní segment

K.3
K.3–8 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Informace o obrazu K.3

Na snímcích jsou zobrazeny údaje o pacientovi, vyšetøení a 
datech snímku. K.3

➭ Mùžete nastavit, které údaje budou na obrazu zobrazeny. 
→ Strana A.4–8, Konfigurace textu snímkù

Zobrazené údaje se na snímku vždy umís¤ují na stejné místo 
podle následujícího obrázku: K.3

 

(1) Údaje o pacientovi
(2) Orientaèní znaèky 

→ Strana K.3–6, Orientaèní znaèky
(3) Kompresní pomìr
(4) Tlouš¤ka øezu (pouze u MPR, MPR Thick, MIP Thin, 

MinIP Thin)
(5) Poznámky ke snímku
(6) Automaticky nastavené hodnoty èoèky obrazových bodù
(7) Hodnoty vyvážení
(8) Orientaèní krychle 

→ Strana K.3–5, Orientaèní krychle
(9) Popis orientace 

→ Strana K.3–5, Popis orientace
(10)Informace o nemocnici/systému

(2)

(2)

(1)

(4)

(8)

(9)

(5) (7)(6)

(10)

(3)
Verze VE31D K.3–9 
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Práce s virtuální endoskopií Virtuální endoskopie
Na snímku nejsou zobrazeny následující standardní textové 
prvky: K.3

❏ Specifické parametry skenu (napø. naklonìní gantry) 
(za normálních okolností v levém dolním rohu)

❏ Mìøítko 
(u pravého okraje)

➭ To, zda budou v popisu orientace zobrazeny èi nikoli, závisí na 
konfiguraèním nastavení. 
→ Strana K.9–2, Konfigurace informací o snímku
K.3–10 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Nastavení pohledù v sadì dat 
objektu K.3

Trojrozmìrné zpracování snímkù umožòuje vytváøet snímky v 
libovolné orientaci a poloze v rámci sady dat objektu. 
"Pohybujete" se v objektu a mùžete jej natoèit libovolným 
smìrem. V závislosti na používané metodì máte k dispozici 
rùzné pomùcky. K.3

Nastavení referenèního snímku K.3

Po naètení snímkù na kartì úlohy Fly se mùžete pohybovat v 
trojrozmìrném modelu za použití pomùcek na této kartì úlohy. K.3

Nejprve vygenerujte požadovaný pohled. Tento pohled mùžete 
použít jako referenèní snímek, jako základ pro další zpracování. K.3

✧ Nejprve vygenerujte požadovaný pohled.

✧ Kliknìte na "referenèní segment" požadovaného pohledu.

Tento pohled mùžete použít jako referenèní snímek, jako základ 
pro další zpracování. Segment je nyní ohranièen tlustou èárou.K.3

K.3
Verze VE31D K.3–11 
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Práce s virtuální endoskopií Virtuální endoskopie
Výbìr referenèního 
obrazu K.3

Nastavte pohled, ve kterém chcete provést následné 
trojrozmìrné vyhodnocení v jednom ze tøí referenèních 
segmentù. Tento pohled se stává referenèním snímkem. K.3

✧ Klepnutím na tento segment vyberte snímek

Snímek je ohranièen tlustou èarou. V následujícím pøíkladì jde o 
levý horní segment. K.3

 

K.3–12 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Použití trojrozmìrného nitkového køíže K.3

Èáry nitkového køíže (referenèní èáry) ve standardním pohledu 
oznaèují polohu dvou rovin øezù, které jsou na sebe kolmé (èáry 
znázoròují èáry øezu). Tyto dvì roviny jsou zobrazeny v dalších 
dvou referenèních segmentech. K.3

Snímek øezu odpovídající èáøe øezu poznáte podle toho, že 
ohranièení segmentu se snímkem øezu má stejnou barvu jako 
pøíslušná èára øezu. K.3

Levý horní segment je ohranièen èervenou èarou. Poloha 
odpovídajícího snímku v sadì dat objektu je ve zbývajících dvou 
referenèních segmentech oznaèena èervenou èarou. Obdobnì 
je poloha snímku v modrém rámci oznaèena modrými èarami a 
poloha snímku v zeleném rámci je oznaèena zelenými èarami.K.3

 
 
 
 
 
 
 
 
 
 

Šipky ukazují smìr pohledu, ze kterého rovinu sledujete. K.3

Pøerušované èáry oznaèují roviny, které nejsou kolmé k 
zobrazovanému pohledu. 

K.3
Verze VE31D K.3–13 
únor 2006

 0.0



Práce s virtuální endoskopií Virtuální endoskopie
Pøesunutí referenèních èar K.3 Pomocí èar se mùžete pohledem v referenèních segmentech 
pohybovat libovolným smìrem. K.3

K.3 ✧ Kliknìte na referenèní linku a s pøidržením levého tlaèítka 
myši ji pøesuòte.

Nebo K.3

✧ Kliknìte na prùseèík èar a pøesuòte tak obì referenèní èáry 
souèasnì. 

Kromì toho mùžete referenèní èáry do cílové polohy pøesouvat 
skokem klepnutím myší. K.3

✧ Kliknìte na linku a potom kliknìte na cílovou pozici levým 
tlaèítkem myši.

Referenèní èára se tam okamžitì pøesune. K.3

 

K.3–14 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Nebo K.3

✧ Vyberte celý referenèní obrázek a kliknìte na cílovou pozici 
levým tlaèítkem myši (bez vybrané referenèní linky).

Obì èáry se pøesunou tak, že v místì klepnutí je nyní jejich 
prùseèík. K.3

 

Verze VE31D K.3–15 
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Práce s virtuální endoskopií Virtuální endoskopie
Natoèení pomocí nitkového 
køíže K.3

Natoèením pøíslušné èáry nitkového køíže v nìkterém ze dvou 
ostatních segmentù zmìníte pohled v referenèním segmentu.K.3

Nejprve umožnìte natoèení zrušením režimu Fixed Mode a 
umožnìním režimu Free Mode. K.3

K.3 ✧ Výbìrem režimu Free Mode aktivujte volný režim. 
 
 

K.3 ✧ Nyní natoète referenèní èáry kolem zobrazeného bodu 
otáèení.

Takto vytvoøíte natoèené roviny (pouze jedna referenèní èára je 
naklonìná) nebo dvojnásobnì natoèené roviny (obì referenèní 
èáry jsou naklonìné). K.3

Pokud chcete zastavit pohyb v urèitém úhlu, mùžete zrušit 
oznaèení volby Free Mode. K.3

K.3 ✧ Klepnìte na aktivní tlaèítko.
K.3–16 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Listování pomocí záložek K.3

Pokud zvolíte typ výstupu MPR nebo MPR Thick, v pravém 
horním rohu referenèních segmentù se zobrazí záložky. K.3

Pomocí záložek se mùžete v objektu pøesouvat øez po øezu 
dopøedu nebo dozadu. Soubìžnì se pøesouvá i pøíslušná èára 
nitkového køíže v dalším segmentu. K.3

 

(1) Listování dozadu
(2) Listování dopøedu
Verze VE31D K.3–17 
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Práce s virtuální endoskopií Virtuální endoskopie
Posun K.3

Interaktivní obdobou záložek je posun. Objektem se mùžete 
pøesouvat øez po øezu dopøedu nebo dozadu. Souèasnì jsou 
aktualizovány i ostatní segmenty. 

K.3

Posun pomocí myši K.3 ✧ Klepnìte na segment, kterým chcete procházet.

✧ V hlavní nabídce spus¤te položku Orientation > Shift.

Nebo K.3

K.3 ✧ Aktivujte možnost parallel shift pomocí funkce SmartSelect 
(kliknutí pravým tlaèítkem myši). 
→ Strana K.3–38, SmartSelect  
 
 
 
 

K.3 Kurzor myši zmìní tvar. 
 

K.3

✧ Stisknutím tlaèítka myši a táhnutím mírnì nahoru se budete 
posunovat pomalu skrz objem. 

Kurzor myši se zmìní.  
K.3

✧ Táhnutím kurzoru myši dále nahoru se budete posunovat 
rychleji skrz objem.

Rovina obrazu se posune hloubìji do objemu a zobrazí øezy „za" 
aktuálním øezem. K.3
K.3–18 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
K.3 ✧ Táhnìte myší dolù.

Kurzor myši se zmìní. 
K.3

Rovina obrazu se posune ven z objemu a zobrazí øezy „pøed" 
aktuálním øezem. K.3

Posun pomocí klávesnice K.3 ✧ Procházejte jednotlivými snímky v sadì pomocí kláves 
Image+ nebo Image- na klávesnici.

Posun pomocí klávesnice K.3 ✧ Procházejte jednotlivými snímky v sadì pomocí kláves 
Image+ nebo Image- na klávesnici.

K.3
Verze VE31D K.3–19 
únor 2006

 0.0



Práce s virtuální endoskopií Virtuální endoskopie
Natoèení objektu pomocí myši K.3

Natoèením zobrazení snímku v segmentu pomocí myši mùžete 
vytvoøit i natoèené nebo dvojnásobnì natoèené snímky. K.3

✧ Zvolte položku Orientation > Rotate Images.

Nebo K.3

K.3 ✧ Kliknìte na tlaèítko v horní èásti ovládací oblasti. 
 

Nebo K.3

✧ Spus¤te funkci „rotate object” pomocí funkce SmartSelect.

Když umístíte kurzor myši na segment, kurzor zmìní tvar. K.3

K.3 ✧ Pohybujte kurzorem myši se stisknutým levým tlaèítkem 
myši.

❏ Pohybem myší ze støedu segmentu nahoru, dolù, doleva 
nebo doprava nakloníte snímek pøíslušným smìrem.

Když umístíte kurzor myši na hranici segmentu, kurzor zmìní 
tvar. K.3

K.3 ✧ Pohybujte kurzorem myši se stisknutým levým tlaèítkem 
myši. 

❏ Pohybem myší podél hranice segmentu otoèíte objektem v 
rovinì pøíslušným smìrem.
K.3–20 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Práce s virtuální endoskopií
Otáèení okolo jedné osy  
(šikmé roviny øezu) K.3

Jestliže chcete vytvoøit naklonìné øezy, natoète øez okolo jedné
z os souøadného systému pacienta. Zaènìte u standardního 
pohledu. Abyste to mohli provést, otoète referenèní èáru. 
Pøíslušný výstupní obraz se otoèí okolo støedu. K.3

Orientace je zobrazována na snímku jako kombinace dvou 
orientaèních znaèek. Toto oznaèení je srovnatelné s oznaèením 
používaným u kompasu, napøíklad SZ jako oznaèení 
severozápadu. K.3

Jedna ze dvou referenèních èar na snímku je nyní teèkovaná. 
Odpovídající rovina je tedy vzhledem k zobrazovanému snímku 
naklonìná. K.3

Pro každý standardní pohled existují dva rùzné smìry natoèení 
(kolem osy), každý z nich je vysvìtlen graficky na následujících 
pøíkladech. K.3

➭ Na následujících pøíkladech je pacient uložen hlavou napøed 
na zádech.
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Práce s virtuální endoskopií Virtuální endoskopie
Transverzální øez K.3 Transverzální øez mùžete natoèit smìrem ke koronální nebo 
sagitální rovinì. K.3

❏ Natoèení transverzálního øezu smìrem k sagitálnímu øezu 
(vlevo)

❏ Natoèení transverzálního øezu smìrem ke koronálnímu øezu 
(vpravo)

 

V závislosti na smìru natoèení se zobrazují další kombinace 
orientaèních znaèek, napøíklad RH, LF, AH, PF. K.3

R

H

RH

Kor Sag

Tra

RF
R

AH

R A K.3

H

F

Kor Sag

AR

H

Tra

F
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Virtuální endoskopie Práce s virtuální endoskopií
Sagitální øez K.3 Sagitální øez mùžete natoèit smìrem k transverzální nebo 
koronální rovinì. K.3

❏ Natoèení sagitálního øezu smìrem k transverzálnímu øezu 
(vlevo)

❏ Natoèení sagitálního øezu smìrem ke koronálnímu øezu 
(vpravo)

 

V závislosti na smìru natoèení mohou být výsledkem jiné 
kombinace orientaèních znaèek jako napøíklad AL, PR, HR nebo 
PL. K.3

AKor Sag

Tra

Kor Sag

Tra

A

HL

A

H

H

AR

R

F

AR

H

FA K.3
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Práce s virtuální endoskopií Virtuální endoskopie
Koronální øez K.3 Koronální øez mùžete natoèit smìrem k transverzální nebo 
sagitální rovinì. K.3

❏ Natoèení koronálního øezu smìrem k transverzálnímu øezu 
(vlevo)

❏ Natoèení koronálního øezu smìrem k sagitálnímu øezu 
(vpravo)

 

V závislosti na smìru natoèení mohou být výsledkem jiné 
kombinace orientaèních znaèek jako napøíklad RH, HP, FA nebo 
LF. K.3

Kor Sag

A

Kor Sag

A

HA

R

H

RA

Tra

R

H

R

H

Tra
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Virtuální endoskopie Práce s virtuální endoskopií
Otáèení okolo dvou os (šikmé a zkosené 
roviny øezù) K.3

Natoèením jednoho øezu postupnì okolo dvou rùzných os 
souøadného systému pacienta získáte roviny øezu naklonìné ve 
dvou osách. Rovina již potom není kolmá k žádné ose 
souøadného systému. Orientace snímku je zobrazována jako 
kombinace tøí orientaèních znaèek. K.3

 

(1) Natoèení sagitálního øezu smìrem k transverzálnímu øezu
(2) Natoèení øezu Sag/Tra smìrem ke koronálnímu
(3) Výsledný pohled

Sag

A

Kor
H

Tra

Kor Sag

A

H

Tra

AR

HR

(1) (2)

(3)

R

F F

R
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Práce s virtuální endoskopií Virtuální endoskopie
Ovládání orientace snímku K.3

Natoèením snímku v referenèním segmentu zmìníte zorný 
úhel. Pro snadnou orientaci jsou na tìchto obrazech zobrazeny 
orientaèní znaèky. 
→ Strana K.3–6, Orientaèní znaèky 

K.3

Preferované smìry K.3 Pro orientaci a pøi otáèení snímku ve vybrané rovinì øezu 
používá program také následující preferované smìry: K.3

 

(1) Vsagitálním pohledu jsou snímky zobrazeny takto: pøední 
èást-hlava (pøední èást pacienta vlevo a hlava nahoøe). 
Orientaèní znaèka H je nahoøe.

(2) V transverzálním pohledu jsou snímky zobrazeny takto: 
pravá èást-pøední èást (pøední èást nahoøe, smìr pohledu 
míøí k hlavì). Orientaèní znaèka A je nahoøe.

(3) V koronálním pohledu jsou snímky zobrazeny takto: pravá 
èást-pøední èást (pøední èást, hlava nahoøe). Orientaèní 
znaèka H je nahoøe.

A H

RA

A

R

H

(1) (2) (3)
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Virtuální endoskopie Práce s virtuální endoskopií
Automatické ovládání 
orientace K.3

Pokud natáèíte a nakláníte snímek ze sagitální roviny napøíklad 
smìrem k transverzální rovinì, mùžete se nakonec dostat do 
transverzálního pohledu. Program poté natoèí obrázek o dalších 
90° tak, aby se opìt zobrazil v preferovaném smìru, napø. 
pøední èást-hlava na pravá èást-pøední èást. K.3

 

✧ V hlavní nabídce zvolte položku Orientation > Orientation 
Control a aktivujte tak ovládání orientace.

Nebo K.3

✧ Kliknìte na tlaèítko v horní èásti ovládací oblasti. 

K.3

ARF

ARFRH

LF
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Práce s virtuální endoskopií Virtuální endoskopie
Nastavení standardních pohledù K.3

Standardní pohledy se používají jako poèáteèní bod pro 
zpracování snímkù pomocí karty úlohyFly. K.3

Pohledy mùžete pro jednotlivé segmenty nastavit nezávisle. Pro 
každý segment mùžete urèit jiný pohled nebo pro všechny 
segmenty mùžete urèit stejný pohled. 
 

K.3

Transversální pohled K.3

K.3 V transverzálním pohledu pozorujete tomografické obrazy 
pacienta, které jsou kolmé na jeho osu (osa, která probíhá od 
hlavy k nohám pacienta). 
Váš smìr pozorování tedy je shora nebo zdola, tzn. kranio-
kaudální nebo kaudo-kraniální. 
 
 
 
 
 

K.3

K.3 ✧ Zvolte položku Orientation > Head to Feet nebo kliknìte na 
tlaèítko na kartì dílèí úlohy Orientation.

Smìr pohledu se zmìní na transverzální, kranio > kaudální, tj. 
od hlavy k nohám. K.3

Nebo K.3

K.3 ✧ Zvolte položku Orientation > Feet to Head nebo kliknìte na 
tlaèítko na kartì dílèí úlohy Orientation.

Smìr pohledu se zmìní na transverzální, kaudo > kraniální, tj. 
od nohou k hlavì. 

K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Sagitální pohled K.3 K.3

K.3 V sagitálním pohledu vidíte pacienta ze strany (zleva nebo 
zprava) 
 
 
 
 
 
 
 
 

K.3

K.3 ✧ Zvolte položku Orientation > Left to Right nebo kliknìte na 
toto tlaèítko na kartì dílèí úlohy Orientation.

Smìr pohledu se zmìní na sagitální zleva. Vidíte pacienta z levé 
strany. K.3

Nebo K.3

K.3 ✧ Zvolte položku Orientation > Right to Left nebo kliknìte na 
toto tlaèítko na kartì dílèí úlohy Orientation.

Smìr pohledu se zmìní na sagitální zprava. Vidíte pacienta z 
pravé strany. 
 

K.3
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Práce s virtuální endoskopií Virtuální endoskopie
Koronální pohled K.3 K.3

K.3 V koronálním pohledu vidíte pacienta zepøedu nebo zezadu. 
 
 
 
 
 
 
 
 
 

K.3

K.3 ✧ Zvolte položku Orientation > Front to Back nebo kliknìte na 
tlaèítko na kartì dílèí úlohy Orientation.

Zorný úhel se zmìní na pøední koronální. Vidíte pacienta 
zepøedu. K.3

Nebo K.3

K.3 ✧ Zvolte položku Orientation > Back to Front nebo kliknìte na 
tlaèítko na kartì dílèí úlohy Orientation.

Zorný úhel se zmìní na zadní koronální. Vidíte pacienta zezadu. 
 
 

K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Obnova 
standardního pohledu K.3

Standardní pohledy slouží jako orientaèní pomùcky. Z 
libovolného pohledu se mùžete vrátit ke standardnímu pohledu 
a zaèít zpracování znovu.  

K.3

✧ Pohled nastavený pøi zahájení zpracování obnovte spuštìním 
položky Orientation > Default Orientation.

Nebo K.3

K.3 ✧ Kliknìte na tlaèítko Default Orientation na kartì dílèí úlohy 
Orientation.
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Práce s virtuální endoskopií Virtuální endoskopie
Zafixování úhlu K.3

Jakmile jste nastavili zobrazení na urèitý zorný úhel, mùžete 
tento úhel pohledu nastavit. Po nastavení úhlu již nemùžete 
referenèní èáry natoèit, mùžete je pouze pøesouvat. K.3

✧ Zvolením položky Orientation > Free Mode (symbol 
zaškrtnutí zmizí) mùžete pøesouvat referenèní èáry pouze 
paralelnì.

Nebo K.3

K.3 ✧ Kliknutím na aktivní tlaèítko Free Mode v horní èásti ovládací 
oblasti zrušíte tuto možnost. 
 
 
 Aktivní Neaktivní
K.3–32 Návod k použití pro uživatele systému syngo

 0.0



Virtuální endoskopie Práce s virtuální endoskopií
Úhel mezi referenèními èarami zùstává stejný. Referenèní èáry 
nyní zobrazují standardní pohled. K.3
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Práce s virtuální endoskopií Virtuální endoskopie
Zobrazení kolmé na 
referenèní snímek (Ortho 
Sync) K.3

Pro zobrazení øezù podél hlavních os orgánù, napø. srdce, 
vìtšinou aktivujete ortogonální pohled. Proto tento pohled 
nejdøíve nastavte v referenèním snímku. K.3

✧ Zvolte položku Orientation > Ortho Sync.

Nebo K.3

K.3 ✧ klepnìte na tlaèítko Ortho Sync v horní èásti ovládací oblasti.
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Virtuální endoskopie Práce s virtuální endoskopií
V ostatních referenèních segmentech jsou nyní zobrazeny 
pohledy kolmé k referenènímu obrazu. V následujícím pøíkladì 
jde o levý horní obraz. K.3

➭ Tyto snímky nemusí být kolmé k souøadnému systému 
pacienta.
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Práce s virtuální endoskopií Virtuální endoskopie
Zvìtšení segmentu K.3

Referenèní segmenty mùžete zvìtšit, a tak je vyhodnotit 
podrobnìji. Místo ètyø segmentù obrazu se zobrazí pouze jeden 
pohled vybraného segmentu. 

K.3

Aktivace zvìtšení K.3 ✧ Zvolte položku View > Blow Up Segment.

Nebo K.3

✧ Poklepejte na zvolený segment.

Nyní je zobrazen jediný pohled zvoleného segmentu. K.3
K.3–36 Návod k použití pro uživatele systému syngo

 0.0



Virtuální endoskopie Práce s virtuální endoskopií
Na zvìtšený obraz mùžete použít tytéž funkce jako na 
dìlení 2:2. 

K.3

Zrušení zvìtšení K.3 Pokud chcete obnovit normální pohled, zrušte možnost Blow 
Up. K.3

✧ Otevøete znovu položku View > Blow Up Segment v hlavní 
nabídce.

Nebo K.3

✧ Poklepejte na jediný zobrazený pohled.

➭ Jestliže zvìtšený segment vyprázdníte, zvìtšení se 
automaticky zruší.
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Práce s virtuální endoskopií Virtuální endoskopie
SmartSelect K.3

Funkce SmartSelect slouží k pøepínání funkcí pøímo v segmentu 
obrazu bez otevøení pøíslušných nabídek. 

K.3

Explicitní režim K.3 ✧ Umístìte kurzor myši do pøíslušného segmentu a pøidržte 
pravé tlaèítko myši.

K.3 Zobrazí se grafická místní nabídka K.3

✧ Pøetáhnìte kurzor myši na jednu ze ètyø položek nabídky a 
potom tlaèítko myši uvolnìte.

Nyní mùžete vybranou možnost použít obvyklým zpùsobem 
pomocí levého tlaèítka myši. 
 
 

K.3

K.3 ✧ Pøesuòte myš do støedového snímku a uvolnìte tlaèítko myši.

Rámec se zvýrazní modøe a všechny ètyøi možnosti budou 
vypnuty. 
 
 
 
 
 

K.3

Implicitní režim K.3 Pokud již ovládáte funkci SmartSelect, nemusíte otvírat místní 
nabídku. Staèí pohybovat myší požadovaným smìrem se 
stisknutým pravým tlaèítkem a tím vybrat urèitou možnost. K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Urèení typù výstupù K.3

Typ výstupu pro libovolný segment lze kdykoli zmìnit, tj. z 
multiplanární rekonstrukce (MPR) na projekci maximální 
intenzity (MIP) nebo na techniku zobrazování objektu (VRT) v 
referenèních segmentech a z perspektivního zobrazení se 
stínovaným povrchem (pSSD) na techniku perspektivního 
zobrazování objektu (pVRT) v segmentu Fly. K.3

V závislosti na metodì práce nejprve vygenerujete referenèní 
obraz, napøíklad požadovaný pohled v MPR, a potom pøepnete 
na pohled MIP nebo VRT. 

K.3

✧ Klepnìte na segment, pro který chcete zmìnit typ výstupu.

➭ Pokud chcete pøepnout všechny segmenty, musíte je vybrat a 
pøepnout samostatnì jeden po druhém.
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Práce s virtuální endoskopií Virtuální endoskopie
Nastavení MPR K.3

Multiplanární rekonstrukcí mùžete vygenerovat tomografické 
snímky v pohledu a poloze urèené v sadì dat objektu. K.3

K.3 ✧ Vyberte referenèní segment a spus¤te funkci Type > MPR 
nebo kliknìte na tlaèítko MPR na kartì dílèí úlohy Type. 
 

Nebo K.3

✧ pøeveïte obrazy do režimu MPR pøímo z okna Patient 
Browser nebo z karty úlohy Viewing.

K.3 ✧ Spus¤te funkci Applications > MPR nebo klepnìte na 
tlaèítkoMPR.
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Virtuální endoskopie Práce s virtuální endoskopií
Nastavení MIP K.3

Projekce maximální intenzity (MIP) používá k rekonstrukci 
nejintenzivnìjší hodnoty stupnice šedi ze snímkù. Napøíklad pøi 
vyšetøení pomocí kontrastní látky jsou cévy struktury s 
hodnotami maximální intenzity. Tyto voxely vezme systém v 
úvahu. Zobrazení MIP je tedy velmi vhodné pro vyšetøení cév. K.3

K.3 ✧ Vyberte referenèní segment a spus¤te funkci Type > MPR 
nebo klepnìte na tlaèítko MIP na kartì dílèí úlohy Type.

Typ výstupu ve zvoleném segmentu se pøepne. K.3

Nebo K.3

✧ pøeveïte snímky do režimu MIP pøímo na kartì úlohy Patient 
Browser nebo Viewing.

✧ Spus¤te funkci Applications > MIP.
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Práce s virtuální endoskopií Virtuální endoskopie
Nastavení pSSD K.3

V segmentu letu lze vygenerovat strukturu povrchu. K.3

✧ Vyberte segment Fly a v hlavní nabídce spus¤te funkci Type 
> Perspective SSD.

Nebo K.3

K.3 ✧ Kliknìte na tlaèítko Perspective SSD na kartì dílèí úlohy 
Type.

V segmentu letu se automaticky vygeneruje pohled povrchu. 
Systém používá výchozí hodnoty stupnice šedi závislé na 
modalitì jako prahové hodnoty pro extrakci povrchu. K.3

K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Zobrazí se dialogové okno Fly: SSD Definition – Fly View. K.3

V tomto oknì mùžete zadávat prahové hodnoty a spouštìt 
extrakci pSSD. K.3

→ Strana K.6–2, Rekonstrukce pSSD se zmìnìnými prahovými 
hodnotami K.3
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Práce s virtuální endoskopií Virtuální endoskopie
Nastavení VRT a pVRT K.3

Pomocí techniky zobrazování objektu (VRT) mùžete 
vygenerovat snímky v barvách, ve kterých je zobrazena celá 
sada dat objektu. Zobrazení VRT poskytuje mnoho informací o 
vyšetøované sadì dat objektu. K.3

Zobrazení VRT lze použít pro referenèní segmenty a zobrazení 
pVRT pro segment letu. K.3

Na kartì Fly K.3

K.3 ✧ Vyberte referenèní segment a spus¤te funkci Type > VRT 
nebo klepnìte na tlaèítko VRT na kartì dílèí úlohy Type.

 
Nebo K.3

K.3 ✧ Vyberte segment letu a spus¤te funkci Type > Perspective 
VRT nebo kliknìte na tlaèítko Prospective VRT na kartì dílèí 
úlohy Type. 

Ve zvoleném segmentu bude vygenerován trojrozmìrný 
snímek. Systém pro toto zobrazení používá sady 
pøednastavených parametrù. K.3

➭ VRT Gallery je dodávána spolu se sérií pøednastavených sad 
parametrù. Tyto sady pøednastavených parametrù mùžete 
mìnit. 
→ Strana K.7–13, Pokroèilý režim 

Na kartì Viewing nebo 
Patient Browser K.3

Pøeveïte snímky do režimu VRT pøímo na kartì úlohy Patient 
Browser nebo Viewing. K.3

✧ Vyberte vyšetøení nebo sérii, kterou chcete upravit.

✧ Zvolte položku Applications > 3D > VRT. 
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Virtuální endoskopie Práce s virtuální endoskopií
Výbìr a zpracování snímkù K.3

Po pøenesení sady dat objektu na kartu úlohy Fly mùžete 
zobrazení snímkù v segmentech optimalizovat. K.3

U naètených snímkù mùžete uzpùsobit hodnoty vyvážení. Èásti 
snímku mùžete zvìtšit. Oblasti, které vás zajímají, mùžete 
umístit doprostøed snímku. K.3

Výbìr snímkù a grafiky K.3

Nejprve musíte vybrat snímky nebo grafiku, které chcete 
zpracovávat. K.3

Na kartì úlohy Fly se snímky dìlí na snímky zobrazené v 
referenèním segmentu a na série umístìné ve výstupním 
segmentu. K.3

Volba referenèního 
segmentu K.3

V referenèním segmentu mùžete vybrat pouze jeden referenèní 
snímek. K.3

✧ Kliknìte na obrázek, který chcete zpracovávat, levým 
tlaèítkem myši.

Segment je nyní ohranièen tlustou èárou. 
K.3

Volba výstupního  
segmentu K.3

Rekonstruovaná série se zobrazí ve výstupním segmentu 
(vpravo dole). K.3

✧ Chcete-li vybrat všechny snímky rekonstruované série, 
klepnìte na výstupní segment.
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Práce s virtuální endoskopií Virtuální endoskopie
Výbìr grafiky K.3 Grafika se zpravidla zobrazuje na snímcích referenèních 
segmentù. K.3

✧ Zobrazení vyberete tak, že kliknete levým tlaèítkem myši na 
jeho èáru.

V grafice se pak zobrazí úchyty a bod otoèení. 
K.3

Pøímé zpracování snímkù a 
grafiky K.3

Mnoho fází zpracování lze provádìt, aniž byste vybírali 
konkrétní snímky nebo grafiku. K.3

✧ Pøesuòte kurzor myši na obrázek nebo grafiku a stiskem 
tlaèítka myši okamžitì spus¤te operaci.

Nyní mùžete napøíklad nastavit vyvážení obrazu nebo 
pøesunout referenèní èáru trojrozmìrného nitkového køíže. K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Zobrazení a skrytí referenèních èar K.3

Chcete-li si prohlédnout detaily obrazu, trojrozmìrný nitkový 
køíž mùže obèas pøekážet. K.3

Tyto grafické prvky mùžete skrýt a dle potøeby opìt zobrazit. 
K.3

K.3 ✧ Chcete-li skrýt referenèní èáry, klepnìte na tlaèítko Hide 
Reference Lines v horní èásti ovládací oblasti.

➭ Chcete-li pohledy obrazù zmìnit, použijte myš. 
 

K.3 ✧ Chcete-li referenèní èáry znovu zobrazit, klepnìte na Hide 
Reference Lines.
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Práce s virtuální endoskopií Virtuální endoskopie
Vyvážení snímkù K.3

Pokud pøenášíte sadu dat objektu na kartu úlohy Fly, snímky se 
zobrazí s hodnotami vyvážení, se kterými byly naposledy 
uloženy. K.3

Obèas je z dùvodu vyjasnìní detailù podstatných pro diagnózu 
nutné pøiøadit snímkùm nové hodnoty vyvážení. K.3

➭ Na snímcích pSSD lze mìnit jas a stíny na povrchu. 

➭ Podrobnosti o vyvažování obsahuje také èást 
→ Strana E.4–2, Vyvážení snímkù. 

Pøednastavené hodnoty vyvážení K.3

Øada specifických nastavení okna pro orgán, studii a uživatele je 
uložena na kartì úlohy Viewing a je také dostupná na kartì 
úlohy 3D. 
→ Strana E.4–13, Pøiøazení pøeddefinovaných nastavení okna K.3

Nìkterá z tìchto nastavení vyvážení byla provedena servisní 
službou spoleènosti Siemens. Mùžete je zmìnit v oknì Viewing 
Configuration, pøípadnì definovat nìkolik nových, vlastních 
nastavení okna. K.3

→ Strana E.7–8, Hodnoty vyvážení specifické pro daného 
uživatele a daný orgán K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Zpracování pohledu snímku K.3

Èásti snímku, které vás nejvíce zajímají, mùžete zvìtšovat. Není-
li obraz ve zmìnìném mìøítko již pøizpùsoben segmentu, 
mùžete jej posunout, abyste umístili pøíslušnou èást opìt do 
støedu obrazu (posun). 
Podrobný popis nastavení pohledu obrazu nalezenete zde: 
→ Strana E.4–1, Zpracování snímkù K.3

Kromì možností pro zpracování pohledu obrazu známých na 
kartách Viewing a Filming nabízí funkce Fly novou funkci Roll. 

K.3

Otoèení K.3 ✧ Zvolte položku Orientation > Rotate Images.

Nebo K.3

K.3 ✧ Kliknìte na tlaèítko Rotate v horní èásti ovládací oblasti. 

Nebo K.3

✧ Kliknutím pravým tlaèítkem myši aktivujte funkci SmartSelect 
a vyberte položku rotate object.

K.3 Rovinu snímku mùžete otoèit kolem støedu snímku pøetažením 
myši podél okraje segmentu. K.3

K.3
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Práce s virtuální endoskopií Virtuální endoskopie
Zvìtšení a posun K.3 ✧ Zvolte položku Image > Zoom/Pan.

Nebo K.3

K.3 ✧ Klepnìte na tlaèítko Zoom/Pan v horní èásti ovládací oblasti.

Nebo K.3

✧ Kliknutím pravým tlaèítkem myši aktivujte funkci SmartSelect 
a vyberte položku zoom/pan.
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Virtuální endoskopie Práce s virtuální endoskopií
Uložení snímkù K.3

Snímky, které jste generovali na kartì úlohy Fly, mùžete uložit 
pro dokumentaèní úèely. K.3

Snímky mùžete buï rychle uložit do již existujících sérií, nebo je 
uložit do nových sérií. K.3
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Práce s virtuální endoskopií Virtuální endoskopie
Ruèní ukládání snímkù K.3

Po generování projekcí na kartì úlohy Fly mùžete projekce 
uložit v hlavní databázi. 

K.3

Ukládání s výchozím 
nastavením K.3

Chcete-li pøi ukládání snímkù nebo sérií použít výchozí 
nastavení, klepnìte na tlaèítko Save. K.3

➭ Když používáte tlaèítko Save, nastavení, která jste provedli v 
dialogu Fly: Save as, jsou platná. 

✧ Klepnìte na výstupní segment a vyberte snímek, nìkolik 
snímkù nebo celou sérii.

✧ Aktivujte funkci Patient > Save.

Nebo K.3

K.3 ✧ Klepnìte na tlaèítko Save ve spodní èásti ovládací oblasti.
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Virtuální endoskopie Práce s virtuální endoskopií
Nastavování pøi ukládání K.3 Pøi prvním ukládání rekonstruované série budete nejdøíve muset 
provést nìkolik výchozích nastavení. K.3

✧ Vyberte snímek v referenèním segmentu nebo snímky ve 
výstupním segmentu.

✧ Zvolte pøíkaz Patient > Save As....

Nebo K.3

K.3 ✧ Kliknìte na Save As.... 

Zobrazí se dialogové okno 3D: Save As. K.3
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Práce s virtuální endoskopií Virtuální endoskopie
Údaje na snímku K.3 Údaje o snímku se nacházejí v pravé horní èásti dialogového 
okna: K.3

❏ jméno pacienta,
❏ zobrazovací metoda (modalita),
❏ datum vyšetøení,
❏ poèet snímkù,
❏ output type (MIP, MPR, MPR Thick, MPR Curved, MPR Thick 

Curved, VRT, pSSD).

Tato informace se uloží souèasnì se sérií. K.3

Vyšetøující lékaø K.3

 

✧ Zadejte jméno lékaøe, kterému chcete poskytnout sérii 
obrazù pacienta. 
 

Poznámky K.3 Mùžete zadat komentáø k sérii. Tyto komentáøe pak budou 
uloženy spolu se snímky. K.3

 

✧ Zadejte text komentáøe.

➭ Vstupní pole obsahuje výchozí text komentáøe, který je 
komentáøem uloženým spolu s pùvodními snímky. Pokud 
mìly rùzné snímky rùzné komentáøe, výchozí text komentáøe 
neexistuje.
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Virtuální endoskopie Práce s virtuální endoskopií
Ukládání snímkù do série K.3 Chcete-li uložit do jedné série všechny snímky, které jste 
generovali ze souboru dat, zvolte pøíkaz Save all images in one 
series. K.3

Všechny snímky se nyní uloží do hlavní databáze pod stejným 
názvem série bez ohledu na typ výstupu, pomocí kterého byly 
generovány (MPR, MPR Thick, MPR Curved, MPR Thick Cureved, 
MIP, VRT nebo pSSD). K.3

 

✧ Klepnìte na pøíkaz Save all images in one series.

✧ Zadejte název série nebo jej vyberte ze seznamu. 

Pøi každém generování a ukládání obrazù na kartì Fly z 
pùvodního souboru dat se tyto obrazy pøidají ke zde zadané 
sérii. 
 
 

K.3
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Práce s virtuální endoskopií Virtuální endoskopie
Seskupování snímkù podle 
typu výstupu K.3

Generujete-li snímky rùzných typù výstupù (MIP, MPR, MPR 
Thick, MPR Curved, MPR Thick Cureved, VRT nebo pSSD) pøi 
zpracovávání pùvodního souboru dat, mùžete je do databáze 
uložit podle typu výstupu. K.3

 

✧ Klepnìte na pøíkaz Group all images by type.

✧ Zadejte název série nebo je vyberte ze seznamu.

Všechny snímky, které jste vygenerovali z tohoto pùvodního 
souboru dat, budou nyní uloženy pod názvem této série a 
oznaèením typu výstupu.  

K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Pøíklad K.3 Jako název série seskupených obrázkù zadáte “Name”. Potom 
jeden za druhým uložíte 1 snímek pSSD, 2 snímky MPR, 1 
snímek MIP, 1 snímek MPR Thick, 1 snímek MPR a ještì 1 snímek 
pSSD. K.3

Tímto zpùsobem vygenerujete ètyøi série: K.3

 

(1) Kolekce pSSD „Name"
(2) Kolekce snímkù MPR „Name"
(3) Kolekce snímkù MIP „Name"
(4) Kolekce obrazù MPR Thick „Name" 

K.3 ✧ Uložte sérii klepnutím na tlaèítko OK.

Nebo K.3

K.3 ✧ Zrušte vytvoøené vstupy klepnutím na Cancel.

1.

2.

3.

4.

5.

6.
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Práce s virtuální endoskopií Virtuální endoskopie
Filmování, vyhodnocování a 
odesílání snímkù K.3

Pro Pøenos obrázkù na film je tøeba je odeslat aplikaèní kartì 
Filming, odkud mohou být dále odeslány do kamery, pøípadnì 
do tiskárny. K.3

Nebo je možné data urèená k dalšímu zpracování odeslat kartì 
úlohy Viewing, což vám umožní zadávat komentáøe k novým 
sériím obrázkù prostøednictvím textových a grafických prvkù, a 
nebo pokraèovat ve zpracování s využitím nabízených 
dvourozmìrných vyhodnocovacích nástrojù. K.3

Je-li váš systém souèástí sítì, mùžete data odeslat na jinou 
pracovní stanici, kde mùže zpracování pokraèovat. K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Exponování obrazù z letu na film K.3

Pokud chcete zdokumentovat obrazy nebo série obrazù, mùžete 
je odeslat do kamery (a exponovat na film) nebo na tiskárnu (a 
vytisknout na papír). 

K.3

✧ Zvolte snímek v referenèním segmentu klepnutím na tento 
snímek.

Nebo K.3

✧ Zvolte obrazy ve výstupním segmentu. 

✧ Použijte funkci Patient > Save and Copy to Film Sheet.

Nebo K.3

K.3 ✧ Kliknìte na tlaèítko Save and Copy To Film Sheet, které se 
nachází v dolní èásti ovládací oblasti karty úlohy Fly.

Nebo K.3

K.3 ✧ Stisknìte klávesu Save and Copy To Film Sheet na klávesnici 
se symboly.

V závislosti na nastaveních, která jste definovali pro rozvržení 
filmu, budou obrazy buï pøevedeny do kamery èi tiskárny 
pøímo, nebo zùstanou na kartì úlohy Filming pro potøeby 
zpracování, dokud je neodešlete do kamery èi tiskárny ruènì. 
→ Kapitola G.2, Automatické/manuální exponování na film 
 

K.3
Verze VE31D K.3–59 
únor 2006

 0.0



Práce s virtuální endoskopií Virtuální endoskopie
Pøenesení snímkù na kartu úlohy Viewing K.3

Pokud chcete vyhodnocovat nebo zpracovávat vybrané obrazy 
ve dvourozmìrném zobrazení, je tøeba obrazy pøesunout na 
kartu úlohy Viewing. 

K.3

✧ Zvolte snímek v referenèním segmentu klepnutím na tento 
snímek.

Nebo K.3

✧ Zvolte obrazy ve výstupním segmentu. 

✧ Spus¤te funkci Patient > Save and Load to Viewing.

Nebo K.3

K.3 ✧ Kliknìte na tlaèítko Save and Load to Viewing ve spodní 
èásti ovládací oblasti. 
 

Obrazy budou pøevedeny na kartu úlohy Viewing, kde je lze 
zpracovat. 
→ Strana E.4–1, Zpracování snímkù 
→ Strana E.5–1, 2D vyhodnocení K.3

K.3
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Virtuální endoskopie Práce s virtuální endoskopií
Zasílání snímkù pøes sí¤ a archivace K.3

Pokud chcete odeslat obrazy do jiného místa v nemocnici, 
mùžete to provést pøímo z karty úlohy Fly. 

K.3

✧ Zvolte snímek v referenèním segmentu klepnutím na tento 
snímek.

Nebo K.3

✧ Zvolte obrazy ve výstupním segmentu. 

K.3 ✧ Kliknìte na tlaèítko Send to Node 1 v ovládací oblasti karty 
úlohy Fly. 

Nebo K.3

K.3 ✧ Stisknìte klávesu Send to Node 1 na klávesnici se symboly.
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Práce s virtuální endoskopií Virtuální endoskopie
Dialogové okno Send To se zobrazí pouze v pøípadì, že byl 
nakonfigurován více než jeden sí¤ový uzel. K.3

 

 

✧ Zvolte cílovou pracovní stanici nebo cílovou databázi. 

K.3 ✧ Kliknìte na tlaèítko Send, urèené k pøesunu vybraných 
obrazù. 
 

➭ Pomocí položky nabídky Transfer lze zpøístupnit další funkce, 
které slouží k archivaci a odesílání obrazù. 
Podrobné informace viz: 
→ Strana F.1–4, Automatické ukládání a odesílání

K.3

K.3
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KAPITOLA 0.0

K.4

Multiplanární 
rekonstrukce (MPR) K.4
Multiplanární rekonstrukce se nejdøíve zobrazí v pohledech, 
které jsou rovnobìžné a kolmé ke smìru snímání. K.4

Pohledy, které jsou pro vás dùležité, pak mùžete generovat 
procházením objektu pomocí funkcí karty úlohy Fly, napøíklad 
pomocí trojrozmìrného nitkového køíže nebo myši. K.4
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Multiplanární rekonstrukce (MPR) Virtuální endoskopie
Pøenos dat do MPR ve Fly K.4

V oknì Patient Browser nebo na kartì úlohy Viewing (nebo z 
dialogového okna 3D Series List) jste vybrali sérii obrazù k 
zobrazení v režimu MPR a potom ji pøevedli na kartu úlohy Fly. 
→ Strana K.3–40, Nastavení MPR K.4

Tato série se naète a zobrazí v režimu MPR. K.4

➭ Pokud jste již provedli naètení obrazù na kartì úlohy Fly a 
doèasnì jste aktivovali jinou aplikaci, kliknutím na záložku 
znovu aktivujte kartu úlohy Fly. 
→ Strana K.2–6, Otevøení karty úlohy Fly

➭ Pokud jste dokonèili zpracování prvních trojrozmìrných sérií a 
uložili jste je, mùžete naèíst další oznaèenou sérii pøímo z okna 
3D Series List (Patient > Open Series List...). Pokud je 
poslední pacient urèený ke zpracování naèten v aplikaci Fly, 
zobrazí se dialogové okno, ve kterém mùžete specifikovat, 
zda chcete pokraèovat ve zpracování nebo naèíst novou sérii. 
→ Strana K.2–15, Další série ze seznamu sérií 3D
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Virtuální endoskopie Multiplanární rekonstrukce (MPR)
Zmìna tlouš¤ky øezu (MPR Thick) K.4

Pomocí MPR pro tlusté øezy mùžete definovat tlouš¤ku 
pùvodního øezu, z nìhož se má snímek rekonstruovat. Program 
vypoèítá prùmìr z nìkolika hodnot stupnice šedi a použije tyto 
prùmìry pro vytvoøení obrazu. 
 

K.4

✧ Pro nastavení typu výstupu MPR Thick zvolte položku Type > 
MPR Thick.

Nebo K.4

K.4 ✧ Kliknìte na tlaèítko MPR Thick na kartì dílèí úlohy Type. 
 

✧ Zvolením Type > MPR Thickness... zobrazíte dialogové okno 
Fly: MPR Thick pro nastavení tlouš¤ky øezu.

Nebo K.4

K.4 ✧ Pravým tlaèítkem myši stisknìte tlaèítko MPR Thick na kartì 
dílèí úlohy Type. 
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Multiplanární rekonstrukce (MPR) Virtuální endoskopie
K.4

 

✧ Zadejte tlouš¤ku obrazu (v mm). 

K.4 ✧ Zadání potvrïte stisknutím tlaèítka OK. 

Nebo K.4

K.4 ✧ Klepnutím na položku Default zvolte pøedem nastavenou 
tlouš¤ku snímku.

Zvolené nastavení se použije pro všechny rekonstrukce MPR 
Thick. K.4

➭ Hodnota pro MPR image thickness se zobrazí na obrazu. 
Vždy je také exponována na film a uložena. 

Zmìna výchozího nastaveníK.4

K.4 ✧ Klepnutím na položku Set as default uložte novou 
pøednastavenou hodnotu tlouš¤ky snímku. 

➭ Pøi naèítání nové sady dat se použije uložená pøednastavená 
hodnota. 

K.4
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KAPITOLA 0.0

K.5

Projekce maximální 
intenzity K.5
Projekce maximální intenzity (MIP) používá k rekonstrukci 
nejintenzivnìjší hodnoty stupnice šedi ze snímkù. Napøíklad u 
vyšetøení pomocí kontrastní látky jsou cévy strukturami o 
maximální intenzitì. Zobrazení MIP je tedy velmi vhodné pro 
vyšetøení cév. K.5

Projekce maximální intenzity (MIP) se èasto používá v 
angiografii, napø. k zobrazení prùbìhu cévy nebo aplikované 
kontrastní látky. K.5

K.5
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Projekce maximální intenzity Virtuální endoskopie
Pøenos dat do MIP ve Fly K.5

Vybrali jste sérií snímkù k zobrazení v režimu MIP a pøenesli jste 
ji na kartu úlohy Fly. K.5

Série se zobrazí v režimu zobrazení MIP. 
→ Strana K.3–41, Nastavení MIP K.5

➭ Pokud jste již provedli naètení obrazù na kartì úlohy Fly a 
doèasnì jste aktivovali jinou aplikaci, kliknutím na záložku 
znovu aktivujte kartu úlohy Fly. 
→ Strana K.2–6, Otevøení karty úlohy Fly

➭ Pokud jste dokonèili zpracování prvních trojrozmìrných sérií a 
uložili jste je, mùžete naèíst další oznaèenou sérii pøímo z okna 
3D Series List (Patient > Open Series List...). Pokud je 
poslední pacient urèený ke zpracování naèten v aplikaci Fly, 
zobrazí se dialogové okno, ve kterém mùžete specifikovat, 
zda chcete pokraèovat ve zpracování nebo naèíst novou sérii. 
→ Strana K.2–15, Další série ze seznamu sérií 3D
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Virtuální endoskopie Projekce maximální intenzity 
 

(1) Sagitální pohled
(2) Transversální pohled
(3) Koronální pohled

K.5
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Projekce maximální intenzity Virtuální endoskopie
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KAPITOLA 0.0

K.6

Rekonstrukce  
povrchù (pSSD) K.6
Perspektivní zobrazení se stínovaným povrchem (pSSD)je 
založeno na extrakci dvou stupnic šedi mezi dvìma 
pøeddefinovanými prahovými hodnotami. Typ výstupu pSSD 
provádí rekonstrukci struktur se stínovaným povrchem a 
zobrazuje je trojrozmìrnì v segmentu Fly. K.6

Jako prahové hodnoty pro extrakci povrchù ve výstupu pSSD 
jsou bìžnì používány výchozí hodnoty pro urèitou modalitu, 
které jsou uložené v systému. K.6

Pokud tyto výchozí hodnoty nejsou pro daný diagnostický 
problém vhodné, mùžete je individuálnì pøizpùsobit. Tímto 
zpùsobem mùžete optimálnì zobrazit struktury, které vás 
zajímají. K.6

➭ Snímky pSSD mají pouze jednu úroveò vyvážení.
Verze VE31D K.6–1 
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Rekonstrukce povrchù (pSSD) Virtuální endoskopie
Rekonstrukce pSSD se zmìnìnými prahovými 
hodnotami K.6

Pokud rekonstrukce pSSD založená na výchozích prahových 
hodnotách v systému není vhodná pro daný diagnostický 
problém, mùžete tyto hodnoty upravit. Poté mùžete provést 
opìtovnou rekonstrukci obrazu povrchu. 

K.6

Definice pSSD K.6 ✧ Zvolte pøíkazType > SSD Definition..., který slouží k pøepnutí 
do režimu prahových hodnot.

Nebo K.6

K.6 ✧ Kliknutím na tlaèítko Perspective SSD na kartì dílèí úlohy 
Type zadejte režim pSSD. 

Kliknutím pravým tlaèítkem myši na tlaèítko Perspective SSD
na kartì dílèí úlohy Type zmìòte nastavení pSSD. K.6
K.6–2 Návod k použití pro uživatele systému syngo

 0.0



Virtuální endoskopie Rekonstrukce povrchù (pSSD)
Oblasti, které jsou v rámci v rozmezí nastavených prahových 
hodnot, jsou vyznaèeny ve všech snímcích typu výstupu MPR 
nebo MIP. K.6

 

(1) Zvýraznìné obrazové body
(2) Snímek pSSD
Verze VE31D K.6–3 
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Rekonstrukce povrchù (pSSD) Virtuální endoskopie
Zobrazí se dialogové okno Fly: SSD Definition - Fly View. K.6

 

V dialogovém oknì Fly: SSD Definition - Fly View jsou pro 
extrakci Perspective SSD zobrazeny pøedvolené, pøípadnì 
naposledy použité prahové hodnoty. 

K.6

K.6

K.6 ✧ Do vstupních polí zadejte nové prahové hodnoty a potvrïte 
je stisknutím klávesy Return. 
 
 

K.6
K.6–4 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Rekonstrukce povrchù (pSSD)
Zadané prahové hodnoty budou aplikovány na zobrazení v 
referenèních segmentech. 

K.6

Jiný zpùsob zmìny prahových hodnot: K.6

✧ Levým tlaèítkem myši kliknìte na jezdce a pøetáhnìte jej 
vlevo nebo vpravo; prahová hodnota se zvýší nebo sníží. 
→ Strana A.2–29, Jezdec

Nové prahové hodnoty budou okamžitì po zmìnì 
prostøednictvím jezdce nebo kláves se šipkami použity a 
zobrazeny v polích Low nebo High Value. K.6
Verze VE31D K.6–5 
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Rekonstrukce povrchù (pSSD) Virtuální endoskopie
Pøiøazení prahových 
hodnot K.6

Pøednastavené dolní (Low) a horní (High) prahové hodnoty jsou 
zobrazeny v seznamu Presets. K.6

K.6 ✧ Klepnutím na pøíslušnou položku v seznamu zvolte prahovou 
hodnotu, která odpovídá danému diagnostickému 
problému.

Hodnoty pøíslušné položky seznamu jsou zobrazeny v polích 
Low a High Value. Obrazové body nacházející se v rozmezí 
prahových hodnot jsou v referenèních segmentech barevnì 
zvýraznìny. K.6

➭ Informace týkající se zpùsobu generování pøednastavených 
prahových hodnot naleznete zde:  
→ Strana K.6–10, Vytváøení a zpracovávání pøednastavených 
prahových hodnot 

K.6 ✧ Po nalezení požadovaných prahových hodnot kluknìte na 
tlaèítko High Quality. 

Zobrazení pSSD ve výstupním segmentu bude pøepoèítáno. 
Indikátor prùbìhu vás informuje u prùbìhu extrakce. K.6

Po ukonèení procesu bude ve výstupním segmentu zobrazen 
snímek pSSD vycházející z novì nastavených prahových 
hodnot. K.6

➭ Výsledný obraz lze otáèet a pøesouvat dle potøeby. 

K.6 ✧ Jestliže chcete zmìnit barvu povrchu, klepnìte na položku 
Color. 

✧ Ze zobrazené palety vyberte požadovanou barvu a stisknutím 
tlaèítka OK výbìr potvrïte.

Zmìnìné nastavení se automaticky aktualizuje v segmentu 
letu. 

K.6
K.6–6 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Rekonstrukce povrchù (pSSD)
Zdroj svìtla K.6 Zdroj svìtla lze nastavit, a tak dosáhnout lepšího stavu 
zobrazení povrchu anatomických struktur. K.6

K.6 ✧ Klepnìte na tlaèítko Light Source.

Zobrazí se dialogové okno Fly: Light Source Definition - Fly 
Path Planning. K.6

K.6
Verze VE31D K.6–7 
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Rekonstrukce povrchù (pSSD) Virtuální endoskopie
Zároveò se ve zvoleném segmentu zobrazí šipka oznaèující smìr 
zdroje svìtla. K.6

✧ Smìr zdroje svìtla zmìníte klepnutím na šipku ve vybraném 
segmentu a jejím posunutím.

K.6

K.6
K.6–8 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Rekonstrukce povrchù (pSSD)
K.6 ✧ Zvolte jedno z pøeddefinovaných nastavení. 

Nebo K.6

✧ Pomocí jezdcù nastavte požadované okolní svìtlo, difúzní 
odraz, zrcadlový odraz a lesk. 

➭ Položka Double Sided Light Source a tlaèítko Reset Light 
Source Direction nejsou aktivní.

K.6 ✧ Nastavení potvrïte klepnutím na tlaèítko OK.

Nebo K.6

✧ Uložte nastavení jako novou pøedvolbu.
Verze VE31D K.6–9 
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Rekonstrukce povrchù (pSSD) Virtuální endoskopie
Návrat do referenèního 
režimu K.6

Je-li zobrazení nového povrchu, jak požadujete, zavøete 
dialogové okno Fly: SSD Definition - Fly View a vra¤te se do 
referenèního režimu. K.6

K.6 ✧ Kliknìte na tlaèítko Close. 
 

Vytváøení a zpracovávání pøednastavených 
prahových hodnot K.6

Pomocí pøednastavené dolní (Low) a horní (High) hodnoty 
mùžete ukládat optimalizované prahové hodnoty pro rùzné 
diagnostické problémy. 

K.6
K.6–10 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Rekonstrukce povrchù (pSSD)
Vytváøení nových prahových 
hodnot K.6

Dolní a horní prahové hodnoty jsou uvedeny pod pøíslušným 
oznaèením v seznamu Presets v dialogovém oknì Threshold. 

K.6

K.6 Horní pole seznamu Presets je zpoèátku prázdné nebo obsahuje 
naposledy zvolenou položku ze seznamu Presets. K.6

✧ Pøepište pùvodní oznaèení, pøípadnì do prázdného pole 
zadejte oznaèení nové.

✧ Nové oznaèení potvrïte stisknutím klávesy Return.

Pøepsané oznaèení se stále nachází v seznamu Presets. K.6

✧ Nyní upravte hodnoty pro horní nebo dolní prahovou úroveò 
pomocí jezdce èi kurzorových kláves.

Nebo K.6

✧ Zadejte prahové hodnoty do vstupních polí Low a High 
Value.

✧ Potvrïte zadané èíselné hodnoty stiskem klávesy Return na 
klávesnici a ovìøte si, zda zadané hodnoty vyhovují vašim 
požadavkùm. 

K.6 ✧ Uložte prahové hodnoty kliknutím na tlaèítko Save Preset.  
Souèasnì s prahovými hodnotami budou uloženy parametry 
zdroje svìtla. 
Verze VE31D K.6–11 
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Rekonstrukce povrchù (pSSD) Virtuální endoskopie
Zpracování prahových 
hodnot K.6

Pokud dvojice prahových hodnot pøestane splòovat vaše 
požadavky, mùžete tyto dvì hodnoty kdykoliv zmìnit. 

K.6

✧ Nejprve zvolte pøíslušnou dvojici prahových hodnot 
klepnutím na tuto dvojici v seznamu Presets.

Hodnoty jsou zobrazeny v polích Low a High Value. 
K.6

✧ Pomocí jezdcù upravte prahové hodnoty tak, aby vyhovovaly 
vašim požadavkùm.

Nebo K.6

✧ Zadejte hodnoty do vstupních polí Low a High Value. 

✧ Potvrïte nastavení stisknutím klávesy Return. 
 

K.6 ✧ Klepnutím na pøíslušné tlaèítko nové prahové hodnoty 
uložte.
K.6–12 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Rekonstrukce povrchù (pSSD)
Odstranìní dvojice 
prahových hodnot K.6

Pokud nebudete pøíslušné dolní a horní prahové hodnoty v 
budoucnu používat, je vhodné je odstranit. Rozsah seznamu 
prahových hodnot tak nepøekroèí pøijatelnou velikost. K.6

✧ Nejprve zvolte pøíslušnou dvojici prahových hodnot kliknutím 
na tuto dvojici v seznamu Presets v dialogovém oknì Fly: 
SSD Definition - Fly View.

K.6 ✧ Kliknìte na tlaèítko. 

Vybraná položka bude odstranìna. K.6

➭ Specifické výchozí hodnoty pro urèitou modalitu odstranit 
nelze.

K.6
Verze VE31D K.6–13 
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Rekonstrukce povrchù (pSSD) Virtuální endoskopie
K.6–14 Návod k použití pro uživatele systému syngo
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K.7

Technika vykreslování 
objektu (VRT/pVRT) K.7
Technika zobrazování objektù (VRT) slouží k získání 
pøesnìjšího znázornìní a oddìlení typù tkání. Tak mùžete získat 
trojrozmìrné znázornìní. K.7

Ke zvýraznìní nìkterých aspektù anatomické oblasti mùžete 
mìnit barvu, jas nebo prùhlednost rozdílných oblastí. K.7

Jako zobrazovací parametry pro pohled VRT jsou ve vašem 
poèítaèi v nabídce VRT Gallery uložena bìžná výchozí 
nastavení. K.7

Pokud výchozí nastavení neodpovídají danému diagnostickému 
problému, mùžete jednotlivá nastavení zmìnit. Tak docílíte 
optimálního zdùraznìní požadovaných struktur. K.7

➭ Techniku zobrazování objektù lze použít pouze za 
pøedpokladu, že barevná hloubka systému èiní alespoò 24 
bitù.
Verze VE31D K.7–1 
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
Pøenos dat do VRT na kartì úlohy 
Fly K.7

Sérií obrazù na kartu úloh Fly mùžete pøenést z Patient 
Browser, z karty úlohy Viewer nebo z dialogového okna 3D 
Series List v režimu VRT. 
→ Strana K.3–44, Nastavení VRT a pVRT K.7

Karta úloh Fly se zobrazí v pohledu VRT. K.7

➭ Pokud jste již provedli naètení obrazù na kartì úlohy Fly a 
pouze jste se doèasnì pøepnuli do jiné aplikace, kliknutím na 
záložku karty se pøepnìte zpìt kartu úlohy Fly.  
→ Strana K.2–6, Otevøení karty úlohy Fly

➭ Pokud jste ukonèili zpracování a ukládání první série, mùžete 
naèíst další pøedem registrované série pøímo z karty úlohy Fly
(Patient > Open Series List...). Pokud se pacient, který má být 
zpracován jako poslední, stále nachází na kartì úlohy Fly, 
zobrazí se dialogové okno. V nìm mùžete rozhodnout, zda 
chcete pokraèovat ve zpracování nebo naèíst novou sérii. 
→ Strana K.2–15, Další série ze seznamu sérií 3D
K.7–2 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
Verze VE31D K.7–3 
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
Pøiøazení sad parametrù K.7

Pøi použití techniky vykreslování objektù je zobrazení sady dat 
objektu definováno vlastnostmi barvy a prùhlednosti. Barva 
urèuje svìtlo vyzaøované objektem. Pomocí prùhlednosti lze 
definovat, jakým zpùsobem bude objekt pohlcovat a odrážet 
svìtelné paprsky. K.7

Zpùsob, jímž objekt pohlcuje, vyzaøuje nebo odráží svìtelné 
paprsky, závisí na vlastnostech sady dat. Ty se mohou v rámci 
trojrozmìrného prostoru lišit. K.7

Informace o barvì a svìtle nejsou v pùvodních sadách dat 
obsaženy. CT hodnota nebo hodnota signálu MR musí proto být 
pøiøazena k hodnotám použitým v režimu VRT. K.7

Znázornìní obrazù je definováno v sadách parametrù, které 
jsou uloženy v VRT Gallery. Tyto sady parametrù jsou 
automaticky nebo manuálnì pøiøazeny k pùvodní množinì dat 
v režimu VRT. K.7
K.7–4 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
Automatické pøiøazení sady parametrù K.7

Ke každé sadì parametrù je pøiøazen název. K.7

Po naètení snímkù do režimu VRT vyhledá systém sadu 
parametrù se shodným názvem (napøíklad hlava) v VRT Gallery. 
Pokud pøíslušnou sadu parametrù nalezne, pøevede pøedvolené 
tkáòové tøídy do snímku. K.7

Pokud systém v VRT Gallery vhodnou sadu parametrù 
nenalezne, zobrazí snímek VRT s použitím naposledy zvolené 
sady parametrù z VRT Gallery. K.7
Verze VE31D K.7–5 
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
Manuální pøiøazení sady parametrù K.7

Pokud zobrazení VRT s automaticky pøiøazenou sadou 
parametrù nevyhovuje vašim požadavkùm, zvolte v VRT Gallery
jinou sadu parametrù. K.7

Otevøení dialogového okna 
VRT Gallery K.7

✧ Zvolením Type > VRT Gallery... zobrazíte dialogové okno 
Fly: VRT Gallery - Fly View.

Nebo K.7

K.7 ✧ Kliknìte na tlaèítko VRT na kartì dílèí úlohy Type pravým 
tlaèítkem myši. 

Nebo 
K.7

K.7 ✧ Kliknutím na tlaèítko VRT Gallery na kartì dílèí úlohy 
Histogram. 
 
 

Zobrazí se dialogové okno Fly: VRT Gallery - Fly View. V rámci 
VRT Gallery jsou sady parametrù øazeny abecednì z levého 
horního rohu do pravého dolního rohu. K.7
K.7–6 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
K.7

➭ Pokud se nezobrazí celý obsah okna, lze další parametry 
zobrazit pomocí posuvníku podél spodní hranice okna.
Verze VE31D K.7–7 
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
Pøiøazení sady parametrù K.7 ✧ Kliknìte na sadu parametrù levým tlaèítkem myši, èímž dojde 
k pøenosu pøeddefinovaných tkáòových tøíd do aktuálního 
zobrazení VRT.
K.7–8 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
Zavøení dialogového okna 
VRT Gallery K.7

K.7 ✧ Dialogové okno uzavøete tlaèítkem OK.

Snímek VRT se zobrazí s vybranou sadou parametrù. K.7

Nebo K.7

K.7 ✧ Stisknìte tlaèítko Close.

Galerie VRT je uzavøena. Zobrazení VRT zùstane v nezmìnìné 
podobì. K.7
Verze VE31D K.7–9 
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
Vytváøení a úprava sad parametrù K.7

VRT Gallery nabízí celou øadu sad parametrù pro rùzné typy sad 
dat snímku. Pomocí funkce VRT Definition mùžete vytváøet 
dodateèné sady parametrù a upravovat stávající sady 
parametrù. Tak mùžete VRT Gallery znaènì rozšíøit a jednoduše 
pøiøadit nastavení parametrù, která budou pøesnì odpovídat 
danému diagnostickému problému. K.7

Sadu parametrù mùžete upravit nastavením následujících 
vlastností: K.7

❏ Prùhlednost
❏ Barva 

Jednoduchý a pokroèilý 
režim K.7

Máte dvì možnosti nastavení parametrù VRT: K.7

❏ jednoduchý režim a

❏ složitìjší pokroèilý režim.
K.7–10 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
Jednoduchý režim K.7

Jakmile použijete filtr VRT na data pacienta poprvé, zobrazí se 
karta dílèí úlohy Histogram. K.7

(1) Øízení histogramu s jednou køivkou se dvìma body 
vyvážení (nemùžete pøidávat nebo mazat køivky nebo 
body)

(2) Øízení barev zobrazující barevné rozložení (interakce není 
možná)

(3) Jezdec zmìny mìøítka pro øízení histogramu 

(4) Pøednastavené tlaèítko pro otevøení galerie VRT

(5) Tlaèítko stínování

(6) Tlaèítko Light Source
Verze VE31D K.7–11 
únor 2006
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
Interakce K.7 ❏ Výbìr lichobìžníku

✧ Kliknutím na lichobìžník jej oznaète.

❏ Úprava lichobìžníku

✧ Kliknutím na lichobìžník jej posunete nebo upravíte jeho 
tvar, aby se zmìnila prùhlednost. 

❏ Odstranìní lichobìžníku

✧ Stisknutím klávesy Del odstraníte vybrané køivky.

Nebo K.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Delete curve z místní nabídky

➭ Všechny úpravy se automaticky zobrazí na obrazech. 

Pøepnutí do pokroèilého 
režimu K.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Open Expert Mode... z místní nabídky

Nebo K.7

✧ Dvojitì kliknìte na pozadí histogramu.

Zobrazí se dialogové okno Fly: VRT Definition - Fly View. 
→ Strana K.7–13, Pokroèilý režim K.7
K.7–12 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
Pokroèilý režim K.7

Složitìjší zpùsob nastavení parametrù VRT jednotlivì pro každý 
typ tkánì nabízí dialog Fly: VRT Definition - Fly View.  

K.7

Otevøení Fly: VRT Definition - 
Fly View K.7

✧ Zvolením Type > VRT Definition... zobrazíte dialogové okno 
Fly: VRT Definition - Fly View.

Nebo K.7

✧ Kliknìte pravým tlaèítkem myši na sadu parametrù v oknì 
VRT Gallery.

Nebo K.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu karty dílèí 
úlohy Histogram a zvolte položku Open Expert Mode... z 
místní nabídky.

Nebo K.7

✧ Dvojitì kliknìte na pozadí histogramu karty dílèí úlohy 
Histogram.

Zobrazí se dialogové okno Fly: VRT Definition - Fly View. 
K.7
Verze VE31D K.7–13 
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
K.7

(1) Seznam sad parametrù

(2) Grafické nastavení parametru definice VRT - vizualizace 
histogramu hodnot šedi aktuálnì naèteného souboru dat a 
umožnìní definovat neprùhlednosti

(3) Lišta øízení barev - vizualizace aktuálního barevného 
rozložení a umožnìní jej mìnit

(4) Jezdec pro zvìtšování a zmenšování oblasti histogramu

(5) Tlaèítka stínování a zdroje svìtla

K.7

➭ Zmìny provedené v oknì VRT Definition budou po uložení 
pøednastavených hodnot použity v oknì VRT Gallery.
K.7–14 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
Výbìr sady parametrù K.7 Nejprve zvolte sadu parametrù, kterou chcete upravit, nebo jejíž 
nastavení jsou velmi podobná nastavením nové sady 
parametrù, již si pøejete vytvoøit. K.7

K.7 ✧ Zvolte sadu parametrù z výbìrového seznamu.

✧ Jestliže chcete vytvoøit novou sadu parametrù, pøepište daný 
název sady parametrù jiným názvem. 

Øízení histogramu K.7 V rámci øízení histogramu naèteného datového souboru mùžete 
nastavit køivky neprùhlednosti. Každá šedá hodnota v 
obrazových bodech obrazu má pøirazenou neprùhlednost. K.7

K.7 Køivka neprùhlednosti se skládá z nìkolika samostatných 
lichobìžníkù.  
Lichobìžníky se skládají z uživatelem definovaných bodù  
vyvážení (1 a 3, 4 a 6) a normálních bodù (2, 5). K.7

➭ Pøi posunu kurzoru nad bod zobrazí nápovìda hodnotu x a y, 
kde x je hodnota šedi a y pro neprùhlednost, napø. „150/80%”.

➭ Všechny úpravy obou bodù a køivek se ihned zobrazí na 
obrazech. 

❏ Interakce - body vyvážení

✧ Posunutím bodu vyvážení vlevo nebo vpravo zúžíte nebo 
roztáhnete celou køivku.

➭ Body vyvážení jsou definovány systémem, nemùžete je 
nastavit. 
Verze VE31D K.7–15 
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
❏ Interakce – normální body

✧ Kliknutím na normální bod vyberete celou køivku.

✧ Posuòte normální bod nahoru, dolù, doleva a doprava.

✧ Kliknutím pravým tlaèítkem otevøete místní nabídku a 
vyberte Delete Point, chcete-li odstranit bod, nebo Change 
Curve Color (pouze ve spojeném režimu), chcete-li pøiøadit 
barvu vybranému bodu. 

❏ Interakce – køivky

✧ Kliknutím na køivku mezi dvojicemi bodù vyvážení posunete 
køivku doleva nebo doprava.

✧ Kliknutím na køivku mimo dvojice bodù vyvážení posunete 
køivku nahoru nebo dolù. 

❏ Zmìna mìøítka

V závislosti na modalitì pokrývají data z vyšetøení pacienta 
pouze omezený rozsah obrazových bodù, který je následnì 
vyhodnocen v režimu VRT. V oknì histogramu se nejprve 
zobrazí kompletní rozsah hodnot. Mùžete rozsah dat z vyšetøení 
zvìtšovat èi zmenšovat, pøípadnì jej v histogramu vycentrovat. 
Tímto zpùsobem mùžete graficky zpracovat nastavení 
parametrù snadnìji pomocí zobrazených lichobìžníkù. K.7

K.7 ✧ K rozšíøení nebo zúžení rozsahu histogramu pøetáhnìte 
pomocí myši vnìjší okraj jezdce.

Nebo K.7

✧ Ke zmìnì mìøítka histogramu táhnìte myší svislými smìry 
na pozadí histogramu a držte pøitom stisknuté levé tlaèítko 
myši.

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
Home Zoom/Pan z místní nabídky, abyste vynulovali 
hodnoty (zobrazí se opìt celý rozsah). 
K.7–16 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
❏ Posun

K.7 ✧ Pøesunutím støedového úchytu jezdce provedete zmìnu 
polohy v histogramu.

Nebo K.7

✧ K posunu histogramu táhnìte myší vodorovným smìrem na 
pozadí histogramu a držte pøitom stisknuté levé tlaèítko myši. 

❏ Vložení normálních bodù

✧ Dvojitým kliknutím na køivku mezi dvojicí bodù vyvážení 
vložíte nový bod na místo kliknutí. 

Nebo K.7

✧ Kliknutím na køivku mezi dvojicí bodù vyvážení a kliknutím 
pravým tlaèítkem otevøete místní nápovìdu a vyberte Insert 
point. 

❏ Vložení ramp a lichobìžníkù

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Add Left Ramp z místní nabídky.

Nebo K.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Add Right Ramp z místní nabídky.

Nebo K.7

✧ Kliknìte pravým tlaèítkem na pozadí histogramu a zvolte 
položku Add Trapeze z místní nabídky. 
Verze VE31D K.7–17 
únor 2006
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
❏ Skrytí køivek

✧ Kliknutím na køivku mezi dvojicí bodù vyvážení vyberte køivku 
a kliknutím pravým tlaèítkem otevøete místní nápovìdu a 
vyberte položku Hide Curve.

➭ Samotná køivka zùstane viditelná (èárkovaná), ale pro výpoèty 
zobrazení obrazu se nebere v úvahu.

✧ Kliknutím na skrytou køivku a kliknutím pravým tlaèítkem 
otevøete místní nabídku a zvolte položku Unhide Curve, 
chcete-li opìt, aby køivka byla brána v úvahu. 

Øízení barev K.7 Mùžete definovat rozložení barev, tj. pøiøadit barvu každé 
hodnotì šedi. K.7

❏ Vložení bodu

✧ Dvojitým kliknutím na pozadí barevné lišty vložíte bod na 
místo kliknutí. 

Nebo K.7

✧ Kliknìte pravým tlaèítkem na pozadí barevné lišty a zvolte 
položku Insert Point z místní nabídky.

➭ Zobrazí se barevná paleta. 

❏ Odstranìní bodu

✧ Kliknìte pravým tlaèítkem a zvolte položku Delete Point z 
místní nabídky.

Nebo K.7

✧ Kliknutím na bod jej vyberte a stisknutím klávesy Del vybraný 
bod odstraòte. 
K.7–18 Návod k použití pro uživatele systému syngo

 0.0



Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
❏ Posunutí bodu

✧ Bod posunete jeho pøetažením se stisknutým levým tlaèítkem 
myši.

➭ Pøi pøetahování zobrazuje nápovìda aktuální hodnotu, napø. 
Hounsfield v pøípadì obrazù CT.

➭ Mùžete také posunout celou barevnou škálu jejím posunutím 
se stisknutým levého tlaèítka myši. 

❏ Zobrazení barevné palety

✧ Dvojitì kliknìte na bod.

Nebo K.7

✧ Kliknìte pravým tlaèítkem na bod a zvolte položku Change 
Curve Color z místní nabídky.

Zobrazí se barevná paleta. K.7

✧ Vyberte požadovanou barvu a výbìr potvrïte stisknutím 
tlaèítka OK.

➭ Øízení barev vypoèítá nové rozložení barev mezi novým 
bodem a pøedchozím/dalším bodem.

Objekt se objeví ve výsledném segmentu s novou barvou. K.7
Verze VE31D K.7–19 
únor 2006
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
Spojení køivky 
neprùhlednosti a barvy K.7

V závislosti na modalitì mùže být výhodné spojit køivku 
neprùhlednosti s barevnou lištou. K.7

K.7 ✧ Zvolte položku Color Bar Linked, chcete-li spojit body køivky 
neprùhlednosti s barevnou lištou.

Ve spojeném režimu jsou body neprùhlednosti vztaženy k 
bodùm v barevné lištì. To mùže být užiteèné pro obrazy MR, kde 
se hodnoty šedi liší u jednotlivých datových souborù. Pro obrazy 
MR je užiteènìjší mít kombinaci barvy a hodnot neprùhlednosti, 
aby se našly a zvýraznily urèité tkánì. K.7

➭ V tomto režimu je barevná lišta neaktivní, body nelze 
pøidávat, odstraòovat nebo posunovat.

K.7 ✧ Zrušte položku Color Bar Linked, nechcete-li spojit body 
køivky neprùhlednosti s barevnou lištou.

Ve nespojeném režimu jsou body funkce neprùhlednosti 
nezávislé na bodech v barevné lištì. To mùže být výhodne pro 
obrazy CT, kde hodnoty šedi obvykle odpovídají stejné tkáni.  

K.7
K.7–20 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
Nastavení stínování K.7

K.7 ✧ Kliknutím na volbu Shading vytvoøíte stínované zobrazení.

➭ Pokud je volba Shading aktivována, zpracovává se zobrazení 
VRT pomocí stínovacího algoritmu, takže simulovaný zdroj 
svìtla vytváøí na obraze stíny. Tak se dosáhne dokonalejší 
trojrozmìrný pohled. 

Zdroj svìtla K.7 Po zaškrtnutí možnosti Shading bude tlaèítko Light Source
aktivní a bude možné vybrat zdroj svìtla. K.7

K.7 ✧ Klepnìte na tlaèítko Light Source.

Zobrazí se dialogové okno Light Source Definition - Fly View.K.7

✧ → Strana K.6–7, Zdroj svìtla
Verze VE31D K.7–21 
únor 2006
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
Uložení sady parametrù K.7

Pokud chcete sadu parametrù používat i v budoucnu, 
doporuèujeme uložit ji do systému. K.7

K.7 ✧ Název sady v Preset rozumnì zkra¤te, aby tak byla zachována 
obecnost pøiøazení, a potvrïte stiskem klávesy Return.

K.7 ✧ Tlaèítkem Save Preset sadu parametrù uložte.

Pøi pøíštím naètení budou pøednastavené hodnoty pøiøazeny 
sériím, které v názvu obsahují zadaný název na zaèátku. 

K.7
K.7–22 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Technika vykreslování objektu (VRT/pVRT)
Vymazání sady parametrù K.7

Každou ze sad parametrù je možné z dialogového okna VRT 
Gallery odstranit. K.7

K.7 ✧ Chcete-li sadu parametrù odstranit z výbìrového seznamu, 
klepnìte na tlaèítko Delete Preset.

Jakmile bude sada parametrù z výbìrového seznamu 
odstranìna, zmizí také ikona obrazu z dialogového okna Fly: 
VRT Gallery - Fly View. 
 

K.7

Zavøení okna VRT Definition K.7

Po uložení veškerých požadovaných nastavení v dialogovém 
oknì VRT Definition lze dialogové okno zavøít. K.7

K.7 ✧ Kliknutím na tlaèítko Close zavøete dialogové okno Fly: VRT 
Definition - Fly View.

Nebo K.7

K.7 ✧ Stisknìte tlaèítko.

K.7
Verze VE31D K.7–23 
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Technika vykreslování objektu (VRT/pVRT) Virtuální endoskopie
K.7–24 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

K.8

 
Fly K.8
Všechny datové záznamy, které lze naèíst na kartì úlohy Fly, 
slouží jako výchozí data pro vyhodnocení pomocí funkce Fly 
Through. 

K.8

Postup K.8 Funkce Fly Through slouží k pohybu v dutinách v objektech 
vizualizovaných v tzv. segmentu letu: K.8

❏ volný pohyb v objektu,

❏ urèený pohyb v objektu (pohyb po vypoèítané nebo urèené 
dráze).

Do modelového objektu se umístí virtuální kamera a zobrazí se 
vnitøní stìny objektù (dokonce i vnitøního ucha a cév).  

K.8

Pohled letu objektem (FVV)K.8 Tzv. pohled letu objektem (FVV) se zobrazí v referenèních 
segmentech a znázoròuje zorné pole virtuální kamery. K.8

K.8 ➭ Zmìnou vlastností a polohy FVV mùžete zmìnit zobrazení 
segmentu letu.

K.8

K.8

K.8

K.8

Spuštìní režimu letu K.8 Jestliže jste pøenesli obrázky typu MIP, VRT nebo MPR do 
aplikace Fly, musíte režim Fly spustit explicitnì. K.8

K.8 ✧ Kliknìte na tlaèítko Fly Through na kartì dílèí úlohy Fly.

K.8
Verze VE31D K.8–1 
únor 2006   
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Fly Virtuální endoskopie
Volný pohyb v objektu K.8

Pomocí volného pohybu v režimu letu mùžete pro libovolnou 
polohu v objektu vypoèítat perspektivní pohled v segmentu 
letu. To provedete posunutím FVV zobrazeného v referenèních 
segmentech jako by to byla virtuální kamera a otoèením v 
požadovaném smìru pohledu. K.8

Tyto pohyby mùžete øídit v segmentu letu pomocí funkce 
SmartSelect a kliknutím myší. 
→ Strana K.3–38, SmartSelect K.8

➭ Všechny pohyby a zmìny provedené v jednom ze segmentù 
se aktualizují i ve všech ostatních segmentech.

Zpracování trojrozmìrných snímkù v referenèních segmentech 
je stále možné bez omezení.  
(Snímky lze otoèit okolo pozorovaného bodu pohledu FVV 
pouze prostøednictvím funkce Rotate Images v režimu Fly.) K.8

➭ Kdykoliv bìhem volného pohybu máte možnost:

❏ ukládat snímky klepnutím na tlaèítko Save

❏ nastavit body pro urèení dráhy.  
Dráha slouží k urèení pohybù a k automatickému ukládání 
obrazù v segmentu letu. 
→ Strana K.8–13, Urèení dráhy

K.8
K.8–2 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Pohled letu objektem (FVV) K.8

FVV v referenèních segmentech odpovídá skuteènému zorného 
poli virtuální kamery. Poloha a orientace FVV urèuje oblast 
znázornìnou v segmentu letu. Pozorovací bod FVV je 
prùseèíkem referenèních èar a souèasnì støedem pohledu letu v 
segmentu letu. K.8

Jestliže je aktivován režim Fly, FVV se ve zvoleném segmentu 
zobrazí kolmo k rovinì obrazu. 

K.8

Roviny prohlížení K.8 Oblast znázornìná v pohledu letu je ohranièena pøední a zadní 
rovinou zábìru. K.8

V pohledu letu jsou zobrazeny všechny voxely mezi pøední a 
zadní rovinou zábìru. K.8

Rovina prohlížení je seènou rovinou FVV a roviny snímku a je 
kolmá ke smìru pohledu. K.8

K.8

Smìr pohledu K.8

Rovina snímku K.8

Zorný úhel 
Pøední rovina zábìru K.8

Zadní rovina zábìru K.8

Rovina prohlížení K.8

Bod roviny zábìru K.8

Hloubka 
pohledu K.8

Pozorovací 
vzdálenost K.8

Statický bod K.8

Oko

Pozorovací 
bod 

K.8
Verze VE31D K.8–3 
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Fly Virtuální endoskopie
Dùležité body K.8 Statický bod pøedstavuje virtuální kameru. Tento bod je 
místem, kde zaèíná zorné pole ve tvaru jehlanu. K.8

Oko znázoròuje polohu statického bodu, udává zaèátek 
pohledu zorného pole. K.8

Pozorovací bod je umístìn v prùseèíku referenèních èar v 
referenèních segmentech a je pro anatomii významným bodem 
roviny snímku. Tudíž smìr pohledu je èára spojující statický bod 
s pozorovacím bodem. K.8

Bod roviny zábìru je prùseèíkem smìru pohledu a zadní 
rovinou zábìru. 

K.8

Pozorovací vzdálenosti K.8 Pozorovací vzdálenost je vzdálenost mezi statickým bodem a 
pozorovacím bodem. Tato vzdálenost odpovídá vzdálenosti 
mezi virtuální kamerou a zaostøeným objektem. K.8

Hloubka pohledu je vzdálenost mezi statickým bodem a 
bodem roviny zábìru. Tato vzdálenost odpovídá hloubce 
pohledu virtuální kamery. K.8

Zorný úhel urèuje šíøku FVV. K.8

➭ Èást FVV nad rovinou snímku je znázornìna plnou èarou a 
èást pod rovinou je znázornìna pøerušovanou èarou.

K.8
K.8–4 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Zmìna pohledu letu pomocí FVV K.8

Zobrazení segmentu Fly mùžete ovlivnit zmìnou vlastností a 
polohy FVV v jiných segmentech. 

K.8

Pozorovací bod K.8 ✧ Pøetáhnìte pozorovacý bod na místo v objektu, které chcete 
znázornit v segmentu letu. 

Smìr pohledu K.8 ✧ Smìr pohledu zmìníte posunutím statického bodu nebo oka. 
Tento pohyb odpovídá otoèení okolo pozorovaného bodu.

Nebo K.8

✧ Posuòte bod roviny zábìru otoèením FVV okolo statického 
bodu. 

Hloubka pohledu K.8 ✧ Pøetažením jedné strany pøední roviny zábìru ke statickému 
nebo pozorovanému bodu zvìtšíte nebo zmenšíte viditelné 
popøedí.

✧ Pøetažením jedné strany zadní roviny zábìru ke statickému 
nebo pozorovacímu bodu oddálíte nebo pøiblížite viditelné 
pozadí. 

Zorný úhel K.8 ✧ Zkrácením nebo prodloužením okrajù FVV jejich pøetažením 
dojde ke zvìtšení nebo zmenšení zorného úhlu. 

K.8
Verze VE31D K.8–5 
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Fly Virtuální endoskopie
Pozorovací vzdálenost K.8 ✧ V hlavní nabídce zvolte pøíkaz Settings > Fly View 
Volume....

Zobrazí se dialogové okno Fly: Fly View Volume. K.8

K.8

K.8 ✧ Vzdálenost mezi statickým bodem a pozorovaným bodem 
zmìòte pomocí èíselníku.

✧ Klepnutím na položku Close potvrïte nastavení.
K.8–6 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Pøednastavené hodnoty K.8 Ve vašem systému jsou uloženy sady pøeddefinovaných 
parametrù pro nastavení FVV. K.8

Pokud pøepnete zobrazení do režimu letu, použije se datový 
záznam spojený s naètenou sérií. Pokud takové spojení 
neexistuje (napø. pro nové série), použije se výchozí sada pro 
pohled letu objektem. K.8

✧ Zvolením Settings > Fly View Volume... v hlavní nabídce 
zobrazte dialogové okno Fly: Fly View Volume.

K.8 ✧ Ze seznamu vyberte sadu parametrù, kterou chcete spojit s 
naètenou sérií

Nebo K.8

✧ zadejte název nové sady parametrù, kterou chcete vytvoøit. 

K.8 ✧ Jestliže chcete po zmìnì parametrù FVV uložit novou sadu 
parametrù pod zadaným názvem, klepnìte na položku Save 
Preset. 

Všechny parametry FVV budou pøijaty. 
K.8

K.8 ✧ Jestliže chcete vymazat aktuálnì vybranou sadu parametrù, 
kliknìte na položku Delete Preset.

➭ Standardní sady parametrù nelze vymazat. 

K.8 ✧ Kliknutím na položku Link Preset pøiøaïte ke zvolené sadì 
parametrù název. 
Verze VE31D K.8–7 
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Fly Virtuální endoskopie
Zmìna pohledu letu v segmentu letu K.8

V segmentu Fly mùžete ovládat volný pohyb v objektu pomocí 
funkce SmartSelect, tlaèítka Zoom/Pan a pomocí „Click Rotate”. 

K.8

Pozorovací bod K.8 Pozorovací bod mùžete posunovat v rovinì obrázku pomocí 
tlaèítka Pan a pomocí "Klikni - otoè". Kolmo k rovinì obrázku 
posunete pozorovací bod pomocí push/pull. K.8

K.8 ✧ Klepnìte na tlaèítko Zoom/Pan v horní èásti ovládací oblasti 
a pøetáhnìte støed snímku v segmentu letu do požadované 
polohy

Nebo K.8

✧ Kliknìte na místo v obrazu endoskopického pohledu, èímž se 
toto místo umístí do støedu segmentu („Klikni - otoè"). 
Pozorovací bod se otoèí okolo statického bodu.

Nebo K.8

K.8 ✧ Aktivujte funkci push/pull pomocí funkce SmartSelect a 
vertikálnì pohnìte myší.

Virtuální kamera se v dutinì posune vpøed nebo vzad. Èím dále 
posunete myš nahoru nebo dolù, tím rychleji se virtuální 
kamera posune vpøed nebo vzad. K.8

Smìr pohledu obrátíte posunutím myši horizontálnì. K.8

K.8
K.8–8 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Zorný úhel K.8

K.8 ✧ Klepnìte na tlaèítko Zoom/Pan v horní èásti ovládací oblasti.

✧ Klepnutím levým tlaèítkem myši a pøetažením myši kolem 
okraje segmentu snímek zmenšíte nebo zvìtšíte.

➭ Úhel FVV zmìníte stejným zpùsobem, jako zvìtšujete èi 
zmenšujete segment letu. 

Smìr pohledu K.8

K.8 ✧ Aktivujte možnost rotate around viewing point pomocí 
funkce SmartSelect.

✧ Pøetažením myši od støedu segmentu k okraji otoèíte FVV 
okolo statického bodu.

Tato možnost odpovídá pohybu statického bodu v referenèních 
segmentech. 

K.8

Nebo K.8

✧ Aktivujte možnost rotate view pomocí funkce SmartSelect.

✧ Pøetažením myši od støedu segmentu k okraji otoèíte FVV 
okolo statického bodu.

Tato možnost odpovídá pohybu pozorovaného bodu nebo bodu 
roviny zábìru v referenèních segmentech. 

K.8

Pøetáèení K.8 ✧ Aktivujte možnost rotate around viewing point nebo rotate 
view pomocí funkce SmartSelect. 

✧ Posunutím myši kolem hranice segmentu otoèíte snímek v 
rovinì okolo støedu segmentu.
Verze VE31D K.8–9 
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Fly Virtuální endoskopie
Klepnutí na objekt letu K.8 Jestliže klepnete na segment letu, provede se automatická 
navigace smìrem k bodu klepnutí. K.8

Trojrozmìrný zakliknutý bod má stejné souøadnice jako první 
pixel povrchu pod místem kliknutí. K.8

Otoèením a plynulým pohybem FVV se místo, na které jste 
klepli, stane pozorovaným bodem a posune se doprostøed 
segmentu. Pozorovací vzdálenost a zorný úhel se nezmìní. K.8

Pohyb se aktualizuje ve všech ostatních segmentech. 
K.8

Obnova hodnot K.8 K.8

K.8 ✧ Jestliže se chcete vrátit k poèáteèním hodnotám, klepnìte na 
položku Home Zoom/Pan. 

Obnoví se hodnoty nastavené po spuštìní aplikace. 
K.8

Referenèní èáry K.8 Referenèní èáry v segmentu letu máte možnost zobrazit nebo 
skrýt. K.8

K.8 ✧ Vyberte segment letu.

✧ Kliknìte na tlaèítko Hide Reference lines v ovládací èásti na 
kartì Fly. 

Ortho Sync K.8 Pomocí funkce Ortho Sync mùžete v referenèních segmentech 
zobrazit ortogonální pohledy segmentu letu. K.8

✧ Vyberte segment letu.

K.8 ✧ Klepnìte na tlaèítko Ortho Sync na kartì dílèí úlohy 
Orientation.

V levém horním referenèním segmentu se zobrazí rovina 
snímku segmentu letu, v pravém horním segmentu horizontální 
rovina a v levném dolním segmentu kolmá rovina. K.8
K.8–10 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Definovaný pohyb objektem K.8

Na rozdíl od volného pohybu objektem se pomocí definovaného 
pohybu pohybujete pøedem urèenou dráhou. K.8

V režimu auto navigation se pohybujete dutinou pomocí 
tlaèítek myši. Tato dráha je automaticky vypoèítána a neustále 
aktualizována systémem. K.8

Virtuální kamera se pohybuje po dráze, kterou vytvoøíte 
interaktivnì pomocí dialogového okna Fly: Fly Path Planning.K.8

K.8
Verze VE31D K.8–11 
únor 2006
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Fly Virtuální endoskopie
Autonavigace K.8

Pomocí autonavigace se pohybujete uvnitø dutiny. V pøípadì 
potøeby mùžete souèasnì nastavit body pro "let kamery". K.8

K.8 ✧ Prostøednictvím funkce SmartSelect vyberte a aktivujte režim 
auto navigation v segmentu letu.

✧ Klepnutím levým tlaèítkem myši a pøetažením myši v 
segmentu letu nahoru zahájíte pohyb vpøed

Nebo K.8

✧ Kliknutím levým tlaèítkem myši a pøetažením myši v 
segmentu letu dolù zahájíte pohyb vzad. 

✧ Pøetažením myši doleva nebo doprava obrátíte smìr 
pohledu.

Virtuální kamera se pohybuje po smìru èáry vypoèítané 
systémem pro danou dutinu. Èím dále posunete myš nahoru 
nebo dolù, tím rychleji se virtuální kamera posune vpøed nebo 
vzad. K.8

K.8 ➭ Bìhem automatické navigace mùžete nastavit body dráhy 
pomocí klávesy Mark (Num 3) na klávesnici. 
→ Strana K.8–15, Vložení bodu

K.8
K.8–12 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Urèení dráhy K.8

Dráha je trojrozmìrná lomená èára umožòující pohyb objektem. 
K tomuto úèelu je urèeno nìkolik bodù, které udávají pohyb FVV 
v objektu (“polohy” pozorovacího bodu). K.8

✧ V hlavní nabídce zvolte Settings > Fly Path Planning....

Nebo K.8

K.8 ✧ Klepnìte na tlaèítko Path Planning na kartì dílèí úlohy Fly 
ovládací plochy.

Zobrazí se dialogové okno Fly: Fly Path Planning. K.8
Verze VE31D K.8–13 
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Fly Virtuální endoskopie
Jestliže z døívìjšího vyšetøení existuje dráha, zobrazí se tato 
dráha v referenèních segmentech a v dialogovém oknì. K.8

 
K.8

(1) Path Visualization Line 
Znázoròuje nataženou dráhu mezi „polohami” 
pozorovacího bodu.

(2) Position Torch 
Poloha této baterky na èáøe dráhy pøedstavuje aktuální 
polohu kamery.

(3) Path Point 
„Stanice” pozorovacího bodu podél dráhy.

(4) Zoom Slider 
Pokud je hustota bodù v urèité èásti pøíliš vysoká, mùžete 
èáru dráhy zvìtšit.

To, zda délka èáry dráhy odpovídá skuteèné délce dráhy èi nikoli, 
závisí na konfiguraèním nastavení. 
→ Strana K.9–1, Konfigurace letu 
 
 
 
 
 
 

K.8
K.8–14 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Vložení bodu K.8 Dráhu vytvoøíte urèením význaèných poloh jako bodù dráhy 
bìhem volného pohybu v objektu nebo bìhem automatické 
navigace. Pøíslušná nastavení FVV (smìr pohledu, zorný úhel 
atd.) se uloží spolu s polohou pozorovacích bodù. K.8

✧ Pohybujte se prostorem do polohy, kterou chcete oznaèit 
jako bod dráhy.

Nebo K.8

✧ Pøetáhnìte polohovou baterku na požadované místo na èáøe 
znázoròující dráhu.

K.8 ✧ Na klávesnici stisknìte klávesu Mark (Num 3). 
 

Nebo K.8

K.8 ✧ Kliknìte na tlaèítko Insert Point v dialogovém oknì Fly: Fly 
Path Planning, chcete-li pøidat nový bod do dráhy.

Tento bod se vloží na aktuální místo polohové baterky a zobrazí 
se v dialogovém oknì na èáøe znázoròující dráhu i v 
referenèních segmentech. K.8

➭ Jestliže klepnete na již existující bod èáry znázoròující dráhu, 
tento bod bude nahrazen novým.

Oznaèení bodu dráhy K.8 Po vytvoøení dráhy budou body dráhy opatøeny po sobì 
jdoucími èísly a s tímto èíslem použity v èáøe znázoròující dráhu. 
Toto automatické oznaèení bodu dráhy mùžete nahradit jiným 
vhodným oznaèením. K.8

✧ Dvojitì kliknìte na název bodu v dialogovém oknì Fly: Fly 
Path Planning.

✧ Zadejte požadované oznaèení a potvrïte jej klepnutím na 
klávesu Enter.
Verze VE31D K.8–15 
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Fly Virtuální endoskopie
Odstranìní bodu K.8 K.8

✧ Bod dráhy vymažete klepnutím na položku Remove Point.

K.8 Dbejte pøitom na to, aby polohová baterka v dialogovém oknì 
oznaèovala bod, který chcete odstranit. 

K.8

Název dráhy K.8

K.8 ✧ Zadejte název dráhy.

K.8

Uložení dráhy K.8

K.8 ✧ Jestliže chcete uložit aktuální verzi dráhy, kliknìte na položku 
Save Path. 

!0

K.8 K.8

Vymazání dráhy K.8

K.8 ✧ Jestliže chcete vymazat všechny existující body dráhy, 
klepnìte na položku Clear Path. 

K.8

Je možné uložit pouze jednu dráhu. Jakákoli existující dráha 
bude pøepsána. K.8
K.8–16 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Zobrazení dráhy K.8 Body dráhy jsou v referenèních segmentech rùznì zobrazeny. 
Vìtší body jsou umístìny blíže k rovinì snímku, zatímco menší 
body jsou umístìny dále. Na rozdíl od bodù mimo rovinu 
obrazu, body v rovinì obrazu jsou transparentní. 
Dráha spojující body je pøedstavována plnou èárou nad rovinou 
obrazu a pøerušovanou èárou pod rovinou obrazu. K.8

Skrytí dráhy K.8

K.8 ✧ Jestliže chcete potlaèit zobrazení dráhy v referenèních 
segmentech, klepnìte na položku Hide Path.

K.8

K.8

K.8
Verze VE31D K.8–17 
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Fly Virtuální endoskopie
Let podél dráhy K.8

Jakmile urèíte dráhu, mùžete se po ní v objektu pohybovat (”let 
kamery”). K.8

Zastavte se na požadovaných místech a v segmentu letu uložte 
snímky nebo vytvoøte sérii snímkù pøi letu kamery aktivováním 
automatického ukládání. K.8

Podél dráhy se pohybujete pomocí tlaèítek v dialogovém oknì 
nebo pomocí polohové baterky na èáøe znázoròující dráhu. 

K.8

Vzdálenost kroku K.8 Pomocí funkce velikosti kroku urèíte vzdálenost podél dráhy, v 
jaké se v segmentu letu vytvoøí nový snímek. K.8

✧ Velikost kroku nastavíte pomocí posuvníku. 

K.8 K.8

Ukládání snímkù pøi letu K.8

K.8 ✧ Jestliže chcete bìhem letu ukládat snímky, klepnìte na 
položku Save Images while Flying.

Poèet uložených snímkù je dán velikostí kroku. K.8

➭ Jestliže poèet snímkù, které chcete uložit, pøevyšuje pøedem 
nakonfigurovaný limit, musíte odpovídající poznámku 
potvrdit tlaèítkem Yes.
K.8–18 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Fly
Let dopøedu K.8

K.8 ✧ Let zahájíte kliknutím na položku Fly Forwards. 

Let bude zahájen z aktuální polohy (oznaèené polohovou 
baterkou) a konèí v posledním bodì. K.8

➭ Jestliže dva pøilehlé body dráhy mají rùzné vlastnosti FVV, tyto 
vlastnosti se plynule zmìní bìhem letu mezi tìmito body. 
Jestliže napøíklad zorný úhel bodu 3 je 30° a bodu 4 je 40°, 
zorný úhel na letu mezi body 3 a 4 se plynule zvýší z 30° na 
40°. 

Zastavení letu K.8

K.8 ✧ Let zastavíte klepnutím na položku Stop Flying.

K.8  
 

K.8

Let zpìt K.8

K.8 ✧ Jestliže se chcete z aktuální polohy pohybovat zpìt do první 
polohy dráhy, klepnìte na položku Fly Backwards.

FVV obrátí smìr pohledu. K.8

 
 

K.8
Verze VE31D K.8–19 
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Fly Virtuální endoskopie
Polohová baterka K.8

K.8 ✧ Pøetáhnìte polohovou baterku do požadované polohy.

✧ Klepnìte na bod èáry znázoròující dráhu.

Polohová baterka se pøesune na toto místo. Zobrazení v 
segmentech bude odpovídajícím zpùsobem aktualizováno. 

K.8

✧ Klepnìte na èáru znázoròující dráhu.

Polohová baterka se pøesune na místo, kam jste klepli. 
Zobrazení v segmentech bude odpovídajícím zpùsobem 
aktualizováno. 

K.8

✧ Smìr pohledu FVV zmìníte klepnutím na šipku vedle baterky.  
 
 

K.8–20 Návod k použití pro uživatele systému syngo

 0.0



Virtuální endoskopie Fly
Stav mimo dráhu K.8 K.8

K.8 Poloha baterky znázoròuje polohu bodù, na které klepnete v 
oblasti snímku. K.8

Klepnutím na místo vedle dráhy zmìníte polohu polohové 
baterky. 

K.8

Tento stav mimo dráhu mùžete vyøešit následujícím zpùsobem:K.8

✧ Klepnutím na baterku zachovejte její relativní polohu na èáøe 
dráhy.

✧ Pøetažením baterky podél èáry dráhy baterku pøesuòte.

✧ Klepnutím na dráhu nebo bod na dráhì pøesuòte baterku na 
místo, kam jste klepli.

FVV se pøizpùsobí nové poloze baterky. K.8

➭ Aktuální nastavení FVV vložíte stisknutím tlaèítka Insert 
Point.
Verze VE31D K.8–21 
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Fly Virtuální endoskopie
Zavøení virtuální endoskopie K.8

Po ovìøení uložení, nafilmování nebo odeslání všech dùležitých 
snímkù mùžete segment Fly Through uzavøít. K.8

✧ Pro tento úèel vyberte v hlavní nabídce položku Settings > 
Fly Through.

Nebo K.8

K.8 ✧ Kliknìte na tlaèítko Fly Through na kartì dílèí úlohy Fly. 

Nebo K.8

K.8 ✧ Kliknìte na tlaèítko Close. 

Z oblasti snímku zmizí segment letu. K.8

K.8

K.8
K.8–22 Návod k použití pro uživatele systému syngo
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KAPITOLA 0.0

K.9

 
Konfigurace letu K.9
V nabídce 3D Configuration mùžete zmìnit nìkolik nastavení:K.9

❏ zobrazit nebo skrýt popis orientace,

❏ uložit snímky s referenèními èárami nebo bez nich,

❏ aktualizovat zmìny ve Fly Through a konfigurovat zobrazení 
dráhy 
 

✧ Vyvolejte okno syngo - Configuration Panel  
(Options > Configuration... v hlavní nabídce).

K.9 ✧ Poklepnutím na tuto ikonu zobrazte dialogové okno 3D 
Configuration.  

➭ V èásti Základy tohoto manuálu si mùžete pøeèíst, jak otevøít a 
opustit okno konfigurace, ukládat zmìny a vrátit nastavení do 
pùvodního stavu pøi dodání zaøízení. 
→ Kapitola A.4, Konfigurace uživatelského rozhraní
Verze VE31D K.9–1 
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Konfigurace letu Virtuální endoskopie
Konfigurace informací o snímku K.9

Mùžete konfigurovat rùzné orientaèní pomùcky, které se 
zobrazují ve snímcích. K.9

✧ Pøemístìte kartu Segment Information do popøedí.

 

K.9–2 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Konfigurace letu
Zobrazení popisu orientaceK.9

K.9 ✧ Kliknìte na volbu Display orientation description, pokud 
chcete zobrazit popis orientace. 
→ Strana K.3–5, Orientaèní pomùcky na snímku 

Ukládání snímkù s 
referenèními èarami K.9

K.9

K.9 ✧ Kliknìte na volbu Save images with reference lines, pokud 
chcete referenèní èáry uloženy s obrazem pøi jeho kopírování 
na kartu Viewing nebo Filming. 
→ Strana K.3–13, Použití trojrozmìrného nitkového køíže 
Verze VE31D K.9–3 
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Konfigurace letu Virtuální endoskopie
Konfigurace zpracování sérií K.9

Na kartì Ranges mùžete nastavovat ukládání a filmování sérií. 
Dále mùžete konfigurovat orientaci referenèního snímku, 
pokud generujete paralelní a radiální øady. K.9

✧ Klepnutím pøemístìte kartu dílèí úlohy Ranges do popøedí.

 

K.9–4 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Konfigurace letu
Konfigurace ukládání K.9

Rekonstruované série (rozsahy) mohou být plnì automaticky 
ukládány s referenèním obrazem nebo bez nìj. 

K.9

Aktivace automatického 
ukládání K.9

K.9 ✧ Kliknìte na volbu Enable auto-save, pokud chcete 
automaticky ukládat všechny rekonstruované série.

Ukládání 
referenèního obrazu K.9

✧ Kliknìte na volbu Include the reference image when 
saving ranges or curved cuts, pokud chcete uložit i 
referenèní obraz série. 
→ Strana J.3–78, Generování série z trojrozmìrných snímkù
Verze VE31D K.9–5 
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Konfigurace letu Virtuální endoskopie
Konfigurace filmování K.9

Rekonstruované série mohou být filmovány s, nebo bez 
referenèního snímku. K.9

 

✧ Kliknìte na volbu Include the reference image when 
filming the ranges or curved cuts, pokud chcete 
naexponovat na film také referenèní obraz série.
K.9–6 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Konfigurace letu
Konfigurace orientace referenèního snímku K.9

Pokud generujete paralelní a radiální série pomocí uložených 
výchozích nastavení, máte možnost automatického naètení 
výchozího nastavení orientace referenèního snímku. K.9

✧ Kliknìte na volbu Apply orientation saved in preset to 
reference image.

Pokud v budoucnosti otevøete dialogové okno pro vytváøení 
paralelních a radiálních sérií, referenèní snímek se automaticky 
zorientuje. Bude použita orientace nastavená pro referenèní 
snímek v dobì, kdy jste ukládali výchozí nastavení pøíslušné 
skupiny sérií. K.9

K.9
Verze VE31D K.9–7 
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Konfigurace letu Virtuální endoskopie
Konfigurace kvalitativního filtru K.9

Pro výpoèet radiálních øad mùžete použít speciální filtr s 
vysokým rozlišením pro zvýšení kvality obrazu pøi filmování. 
Kvalitativní filtr je aplikován bìhem výpoètu øady na snímky, u 
kterých velikost matrice nepøekraèuje nastavené meze. K.9

 

✧ Zaškrtnutím volby Use high quality filter MIP and MinIP 
zapnete filtrování vysoké kvality.

✧ Maximální velikost matrice pro filtrování nastavte pomocí 
èíselníku.
K.9–8 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Konfigurace letu
Konfigurace pøevzorkování K.9

Data mùžete pøevzorkovat pomocí pùvodního rozlišení nebo 
pomocí fúzované série. K.9

K.9 ✧ Kliknìte na volbu Always resample with original 
resolution, pokud má být rozlišení pøevzorkované série 
stejné jako rozlišení referenèní série.

To se používá i k výpoètu rozsahu modelové série. 
K.9

K.9 ✧ Klepnìte na volbu Always resample with fused series, 
pokud pøevzorkovaná série má být vytvoøena z fúzované 
série.
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Konfigurace letu Virtuální endoskopie
Konfigurace virtuální endoskopie K.9

Na kartì Fly Through mùžete konfigurovat aktualizaci zmìn v 
segmentech a zobrazení èar pro vizualizaci dráhy. K.9

✧ Klepnutím na kartu Fly Through pøemístìte kartu do 
popøedí.
K.9–10 Návod k použití pro uživatele systému syngo
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Virtuální endoskopie Konfigurace letu
Aktualizace zmìn K.9

Máte možnost zvolit okamžitou nebo následnou aktualizaci 
segmentù snímku. K.9

 

✧ Na tuto volbu klepnìte, pokud se zmìny v jednom segmentu 
mají okamžitì zobrazit i v ostatních segmentech.

Jinak se zmìny v jednom segmentu zaktualizují až po dokonèení 
práce s ostatními segmenty. K.9
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Konfigurace letu Virtuální endoskopie
Zobrazení dráhy K.9

Mùže zobrazit dráhu s body dráhy v dialogovém oknì Fly: Path 
Planning jako funkci polohy tìchto bodù (v mìøítku) nebo 
podle všech vlastnostní FVV. K.9

✧ Klepnìte na tuto volbu, pokud chcete dráhu zobrazit v 
závislosti na všech vlastnostech spojených s jednotlivými 
body.

Jestliže dva body mají stejnou pozici, ale rozdílné vlastnosti FVV 
(napøíklad smìr pohledu), vypoèítá se vzdálenost mezi tìmito 
body ze souètu rozdílných vlastností. K.9

✧ Pokud chcete zobrazit dráhu pouze v závislosti na polohách 
bodù, zrušte tuto volbu.

Jestliže dva body mají stejnou polohy, ale rozdílné vlastnosti 
FVV (napø. smìr pohledu), budou zobrazeny nad sebou na èáøe 
pro vizualizaci dráhy. K.9

K.9
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Ve
úno
DODATEK 0.0

L

 
Glosáø
ACS L.0 Picture Archiving & Communication System 
 (Systém archivace a komunikace obrazù); sí¤ Siemens pro 
archivaci a pøenos lékaøských obrazù. L.0

Anatomický L.0 Tøídìní podle poøadí (pouze na úrovni pøípadù): 
1. Poloha obrazu v kombinaci s orientací obrazu 
2. TT 
3. TD 
4. Datum poøízení v kombinaci s èasem poøízení. 
5. Èíslo obrazu L.0

AX L.0 Angiografie a rentgen. L.0

BV L.0 Viz hodnota_b. L.0

Chronologický L.0 Tøídìní podle poøadí (pouze na úrovni poøadí pøípadù): 
1. Datum poøízení v kombinaci s èasem poøízení 
2. Poloha obrazu v kombinaci s orientací obrazu. L.0

Èíslo køivky L.0 Èíslo, které tutu køivku oznaèuje. L.0

Èíslo nezpracovaných dat L.0 Poøadové èíslo pøedem zpracovaných dat mìøení. L.0

Èíslo obrazu L.0 Èíslo objektu L.0

CT L.0 Poèítaèová tomografie. L.0

Datum a èas køivky L.0 Datum a èas vytvoøení køivky. L.0

Datum a èas pøíchodu studieL.0 Datum a èas, kdy pacient pøišel na místo pøíjmu studie. L.0

Dávka RT L.0 Objekt, který pøedstavuje rozdìlení dávky vypoèítané systémy 
pro plánování léèby radioterapií. L.0

Doba mìøení L.0 Technika mìøení MR. Doba mìøení pro dvourozmìrné mìøení 
je následující:  
Doba mìøení = poèet snímání x TR x poèet poøízení. L.0

Doba odezvy (TE) L.0 Parametr mìøení. Doba mezi excitaèním impulsem sekvence a 
výslednou odezvou použitou jako signál MR. Urèuje kontrast 
snímku. L.0
rze VE31D L–1 
r 2006

 0.0



Glosáø Dodatek
Doba opakování (TR) L.0 Parametr mìøení. Všeobecnì je to doba mezi dvìma 
excitaèními impulsy. V rámci intervalu TR mùžete získat signály 
s jednou nebo více dobami odezvy nebo jedním nebo více 
fázovými kódováními (v závislosti na technice mìøení). TR je 
jedním z parametrù mìøení, které urèují kontrast. L.0

Doba poøízení (TA) L.0 Technika mìøení MR. Doba požadovaná pro dokonèení sbìru 
dat bìhem protokolu mìøení. L.0

Doba prodlevy L.0 Viz Prodleva spuštìní (TD). L.0

Doba skenování 
(CT, MR) L.0

Viz Doba mìøení. L.0

Etnická skupina L.0 Etnická skupina nebo rasa pacienta. L.0

FA 
(MR) L.0

Viz Úhel pøeklopení. L.0

FoV 
(CT, MR) L.0

Viz Zorné pole. L.0

Hlavní orientace L.0 Orientace snímku. L.0

Hodnota_b L.0 Difúzní zobrazení. Faktor difúzního vážení. Èím vyšší je 
hodnota b, tím silnìjší je difúzní vážení. L.0

Hodnota kódu L.0 Požadováno, jestliže je pøítomna položka sekvence. 
Hodnota kódu je strojovì èitelný a strojovì vyhledatelný 
identifikátor, který je v rámci kódovacího schématu 
jednoznaènì oznaèen identifikátorem kódovacího schématu a 
verzí kódovacího schématu. L.0

ID stavu studie L.0 Oznaèuje stav dané studie. L.0
L–2 Návod k použití pro uživatele systému syngo
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Dodatek Glosáø
Výèet hodnot: 
– CREATED = vytvoøena, avšak nezaøazena do èasového plánu 
– SCHEDULED = zaøazena do èasového plánu, ale dosud 
nespuštìna 
- ARRIVED = pacient už dorazil, studie ale ještì nebyla zahájena 
– STARTED = spuštìna, ale nedokonèena 
– COMPLETED = dokonèena, kvalita obrazù ale ještì nebyla 
verifikována 
– VERIFIED = dokonèena a kvalita obrazù verifikována 
– READ = prostudována lékaøem L.0

ID studie L.0 Identifikátor studie generovaný uživatelem nebo zaøízením. L.0

Index expozice L.0 1) Citlivost, citlivost snímání. L.0

2) Citlivost detektoru v urèitých jednotkách výrobce. L.0

Poznámka: Tato hodnota má být poskytnuta na jednom místì, 
kde lze nalézt urèité informace výrobce jako poznámky na 
obrazovce nebo filmu s významem pro pouèeného 
pozorovatele. L.0

Indikátor kódovacího 
schématu L.0

Je požadována v pøípadì pøítomnosti položky poøadí. L.0

Indikátor kódovacího schématu, verze kódovacího schématu a 
osobní UID tvùrce kódovacího schématu jednoznaènì definují 
tabulku (kódovací systém), kde je hodnota kódu spojena s 
významem kódu. L.0

Jádro L.0 Konvoluèní jádro: Oznaèení popisující konvoluèní jádro nebo 
algoritmus používaný pro rekonstrukci dat. L.0

Komentáøe požadavkù 
služby zobrazení L.0

Poznámka: Atribut komentáøù má sloužit k pøevedení 
nestrukturovaných informací, které se mohou zobrazit 
operátorovi zaøízení (napøíklad modalita). L.0

Kontrast L.0 Kvalita obrazù. Relativní rozdíl v síle signálu mezi dvìma 
sousedními typy tkánì. L.0

Kontrastní látka L.0 Kvalita obrazù. Chemická smìs pro zlepšení kontrastu. Na 
rozdíl od rentgenových technik, kde je kontrastní látka pøímo 
vidìt, má v MR kontrastní látka nepøímý úèinek; snižuje 
relaxaèní dobu vody v tkáni. L.0
Verze VE31D L–3 
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Glosáø Dodatek
Krok postupu L.0 Plánované série. L.0

kV L.0 Kilovolt (1 kV = 1 000   voltù); jednotka používaná pro mìøení 
napìtí rentgenky. L.0

Jádro se používá pro rekonstrukci nezpracovaných dat. Jádro 
závisí na èásti tìla a typu poøízení. L.0

Magnetická rezonance 
(MR) L.0

Fyzika MR. Pohlcení nebo vysílání elektromagnetické energie 
atomovým jádrem ve statickém magnetickém poli po excitaci 
elektromagnetickým vyzaøováním RF pøi rezonanèní frekvenci.L.0

mAs L.0 Miliampér za sekundu  ; jednotka používaná pøi mìøení proudu 
rentgenky (mA) a doby snímání (s). Ekvivalent aplikované 
radiaèní dávky. L.0

Materiál filtru L.0 Materiál pohlcující rentgenové paprsky, který je použit ve 
filtru. L.0

Definovaná slova: MOLYBDENUM, ALUMINIUM, COPPER, 
RHODIUM, NIOBIUM, EUROPIUM, LEAD. L.0

Matice 
(MR) L.0

Viz Obrazová matice. 
Viz Matice nezpracovaných dat. L.0

Matice mìøení L.0 Viz Matice nezpracovaných dat; nezamìòujte s pojmem
snímková matice. L.0

Matice nezpracovaných datL.0 Technika mìøení MR. Stejnì jako v pøípadì hologramu 
obsahuje každý bod matice nezpracovaných dat èást informací 
pro úplný snímek. Bod v matici nezpracovaných dat neodpovídá 
bodu v obrazové matici. 
Øady uspoøádané okolo støedu matice nezpracovaných dat 
urèují základní strukturu a kontrast v obrazu. Vnìjší øady matice 
nezpracovaných dat poskytují informace týkající se hranic a 
obrysù obrazu, podrobných strukturách, a také urèují rozlišení. 
Pomocí dvourozmìrné Fourierovy transformace je matice 
nezpracovaných dat pøevedena na obrazovou matici. Z tohoto 
dùvodu se øady nezpracovaných dat nazývají také Fourierovy 
øady. L.0

Maximální tlouš¤ka filtru L.0 Maximální tlouš¤ka materiálu pohlcujícího rentgenové paprsky 
použitého ve filtrech v mm. L.0
L–4 Návod k použití pro uživatele systému syngo
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Dodatek Glosáø
Minimální tlouš¤ka filtru L.0 Minimální tlouš¤ka materiálu pohlcujícího rentgenové paprsky 
použitého ve filtrech v mm. L.0

MO L.0 Hlavní orientace. L.0

MPPS L.0 Provedený krok postupu podle modality. L.0

MR L.0 Viz Magnetická rezonance. L.0

Naklonìní gantry 
(CT) L.0

Naklonìní gantry bìhem vyšetøení. L.0

1) CT: Nominální úhel sklonu gantry ve stupních. Není urèeno 
pro matematické výpoèty. 
2) NM: s.o. a sklon gantry/detektoru pro data snímku NM je úhel 
èelní strany detektoru vzhledem k pacientovì hlavní ose (tj. k 
ose pacienta od hlavy k patám nebo k ose stolu, na nìmž 
pacient leží) ve stupních. Sklon s kladnou hodnotou je smìrem 
k nohám pacienta. L.0

Název protokolu L.0 Skenovací protokol použitý pro vyšetøení. 
Uživatelem definovaný popis podmínek, v jejichž rámci byly 
série provedeny. L.0

Název stanice logického  
plánovaèe L.0

Název zvolený pro vzdálený uzel. L.0

NR L.0 Viz Èíslo obrazu. L.0

Objekt L.0 Obraz. L.0

Obrazový bod L.0 Kvalita obrazù. Nejmenší prvek digitálního obrazu. Pro 
zobrazení obrazu MR obsahuje každý obrazový bod v obrazové 
matici urèitou hodnotu stupnice šedi. 
Velikost obrazového bodu = zorné pole/velikost matrice. L.0

Orientováno na objekt L.0 Tøídìní podle poøadí (pouze na úrovni pøípadu): 
1. Èíslo obrazu 
2. Poloha obrazu v kombinaci s orientací obrazu L.0

Osobní aplikace L.0 Prostøednictvím položky nabídky Private Applications (Osobní 
aplikace) mùžete pøipojit funkce nebo jiné aplikace, které 
nejsou souèástí systému syngo. L.0
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Glosáø Dodatek
Plánovaný krok postupu 
(SPS) L.0

Plánovaná série v plánovaèi. 
Jeden nebo více plánovaných krokù postupu pro jeden 
požadovaný postup. L.0

Plán RT L.0 Objekt, který pøedstavuje plány léèení. L.0

Poloha øezu 
(MR) L.0

Parametr mìøení. Poloha øezu, který se má zmìøit v rámci 
vyšetøované oblasti. L.0

Položka akce L.0 Plánované pøípady. L.0

Popis derivace L.0 Pokud je typ snímku oznaèen jako derivovaný snímek, popis 
derivace je volitelný textový popis zpùsobu, jímž byl snímek 
derivován z pùvodního snímku. Stejnì jako v pøípadì snímkù DX 
jej lze použít k popisu operací derivace, jako je napøíklad 
zvìtšení okraje, doèasné filtrování, elektronické odèítání a jiné 
lineární i nelineární transformace. L.0

Popis dùvìrnosti L.0 Popis omezení dùvìrnosti údajù o pacientovi. 
Popis omezení dùvìrnosti týkající údajù o pacientovi. 
Zvláštní oznaèení pro operátora modality týkající se dùvìrnosti 
pacientových údajù (napøíklad informace o tom, že jméno 
pacienta nemá být použito v pøítomnosti jiných pacientù). L.0

Popis nezpracovaných dat L.0 Typ nesnímkových dat: Vlastnosti identifikace dat CSA L.0

Poøizovací zaøízení Popis 
zpracování L.0

1) Popis CR: Popisuje zpracování spojené se snímkem pro urèité 
zaøízení (napøíklad popis orgánu). L.0

2) Popis DX: Oznaèuje jakýkoliv zpùsob vizuálního zpracování 
snímkù pøed výmìnou. L.0

3) Dodateèný popis: Popis zpracování poøizovacího zaøízení 
poskytuje urèité sdìlení v popisném textu elektronického 
zpracování snímkù pøed výmìnou. L.0

Postup L.0 Plánované vyšetøení. L.0

Požadovaná kontrastní 
látka L.0

Kontrastní látka požadovaná pro použití u plánovaného kroku 
postupu nebo plánovaného postupu. L.0

Požadovaná priorita 
postupu L.0

Požadovaná naléhavost typu postupu.  
Definovaná slova: STAT, HIGH, ROUTINE, MEDIUM, LOW L.0

Požadovaný postup L.0 Plánovaná studie v plánovaèi. L.0
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Dodatek Glosáø
Požadující službu L.0 Oddìlení instituce, kde požadavek vznikl. L.0

Pøijímací cívka L.0 Použitá pøijímací cívka. L.0

Primární úhel L.0 Primární úhel polohovacího zaøízení: L.0

1) Poloha rentgenových paprskù okolo pacienta ze smìru RAO 
do LAO, kde pohyb od RAO do vertikály je kladný, jestliže typ 
polohovadla je CARM. 
2) Poloha rentgenových paprskù ve stupních v koronální 
anatomické rovinì, jako by pacient stále, kde pohyb 
rentgenového zdroje zprava do vertikály je kladný, pøièemž 
vertikála je nula. L.0

Premedikace L.0 Lék, který se má podat na zaèátku naplánovaného kroku 
postupu, napøíklad Nuclear Medicine radiopharmaceutical. L.0

Prodleva spuštìní L.0 Spuštìní EKG. Interval mezi spuštìním a povolením mìøení. L.0

Rámce 
(AX) L.0

Ukazatel poètu rámcù a nárùstu rámce. 
Obraz s vícenásobným rámcem je definován jako obraz, jehož 
data obrazových bodù se skládají z posloupné sady jednotlivých 
rámcù obrazových bodù obrazu. Obraz s vícenásobným rámcem 
se pøenese jako jeden plynulý tok obrazových bodù. Záhlaví 
rámcù v mezích toku dat neexistuje. L.0

Øez L.0 Parametr mìøení. Úzký, trojrozmìrný kvádr jednoznaènì 
definovaný polohou øezu, FOV a tlouš¤kou øezu. Støední rovina 
øezu je rovinou zobrazení. L.0

Režim Multi View L.0 Lze porovnávat rùzné studie. L.0

RT L.0 Radioterapie. L.0

RT léèba L.0 Objekt, který pøedstavuje léèbu. L.0

RT obraz L.0 Objekt snímku s atributy urèité radioterapie a volitelnou 
reprezentací s vícenásobným rámcem. L.0

Celkový poèet rámcù obsažených v mezích snímku s 
vícenásobným rámcem se pøevede v položce Poèet rámcù. L.0

Sada struktury RT L.0 Objekt pøedstavující struktury pacienta a související data, která 
jsou definována v objektu získaném pøes zaøízení anatomického 
snímání. L.0
Verze VE31D L–7 
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Glosáø Dodatek
Sekundární úhel L.0 Sekundární úhel polohovadla. 
Poloha rentgenových paprskù (ve stupních) v sagitální 
anatomické rovinì, jako by pacient stál na místì, kde je pohyb 
zdroje rentgenových paprskù zepøedu dozadu kladný a 
vertikální poloha je nulová. L.0

Šíøka vrstvy 
(CT, MR) L.0

Tlouš¤ka øezu urèená kolimovaným øezem a (pro spirálové 
snímání) použitým algoritmem rekonstrukce. L.0

Skenovací protokol 
(CT) L.0

Viz Název protokolu. L.0

Snímková matice L.0 Zobrazení snímku. Snímek MR zahrnuje nìkolik jednotlivých 
prvkù snímku (obrazových bodù). Obrazové body jsou pøiøazeny 
k matici ve formì šachovnicového nárysu. Každý obrazový bod 
ve snímkové matici zobrazuje urèitou hodnotu stupnice šedi. 
Zobrazena jako celek tato šedá matice poskytuje obraz. 
Nezamìòovat s maticí mìøení. L.0

SP (MR) L.0 Viz Poloha øezu. L.0

Spouštìè 
(CT, MR) L.0

Fyziologické øízené zobrazení. Referenèní bod ve fyziologickém 
signálu, který povolí snímání (napøíklad vlna R v signálu EKG). L.0

Spouštìní EKG L.0 Fyziologické zobrazení. Synchronizuje mìøení se srdeèním 
signálem pacienta. Vlna R se používá jako spouštìè. Tento 
zpùsob je zvláštì užiteèný pøi vyšetøení srdce nebo hrudníku, 
protože snímky mohou být v dùsledku srdeèních kontrakcí 
rozmazané. L.0

SPS L.0 Viz Plánovaný krok postupu. L.0

Spuštìný L.0 Tøídìní podle poøadí (pouze na úrovni poøadí pøípadù): 
1. TT 
2. TD 
3. SP v kombinaci s polohou obrazu. L.0

Stav pacienta L.0 Stav pacienta: Popis stavu pacienta (v bezvìdomí, 
dezorientovaný, poškozený zrak a podobnì). L.0

Stav pacienta L.0 Zdravotní stav pacienta (napøíklad poškozený zrak nebo ztráta 
orientace). L.0
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Dodatek Glosáø
Stav plánovaného kroku 
postupu L.0

Definuje stav plánovaného kroku postupu. 
Definované termíny: SCHEDULED nebo ARRIVED

SUV L.0 Standard Uptake Value (Standardní hodnota vychytávání) 
SUV pøedstavuje množství spotøeby glukózy pro urèitou oblast 
zájmu. Je definována jako pomìr èinnosti v tkáni na jeden 
mililitr k èinnosti aplikované dávky na tìlesnou hmotnost 
pacienta. SUV lze vypoèítat rùznými zpùsoby.  
SUV není absolutní hodnota. L.0

TA L.0 Viz Doba poøízení. L.0

TD L.0 Viz Prodleva spuštìní. L.0

TE 
(MR) L.0

Viz Doba odezvy. L.0

TI 
(MR) L.0

Viz Inverzní doba. L.0

TInverzní doba (TI) L.0 Parametr mìøení. Interval mezi pulsem 180° a excitaèním 
impulsem 90° v obráceném poøadí obnovení. L.0

Tlouš¤ka vrstvy 
(CT, MR) L.0

Parametr mìøení. Hodnota tlouš¤ky øezu, který se má zmìøit. 
Èím je øez silnìjší, tím silnìjší je signál a tím lepší je pomìr 
signálu k šumu. Prostorové rozlišení však klesne. L.0

TR 
(MR) L.0

Viz Doba opakování. L.0

TT L.0 Èas spuštìní. L.0

Typ cíle prezentace L.0 Typ cíle prezentace identifikuje dùvody zobrazení nebo jiného 
druhu prezentace všech snímkù v rámci dané série. L.0

Výèet hodnot: 
FOR PRESENTATION, FOR PROCESSING L.0

TTyp filtru L.0 Typ filtru (filtrù) vloženého do svazku rentgenových paprskù 
(napøíklad klíny). L.0
Verze VE31D L–9 
únor 2006  
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Typ filtru L.0 1) Štítek pro typ filtru vloženého do svazku rentgenových 
paprskù. 
2) Typ filtru (filtrù) vloženého do svazku rentgenových paprskù 
(napøíklad klíny).  
Definovaná slova: STRIP, WEDGE, BUTTERFLY, MULTIPLE, 
NONE. L.0

yp objektu L.0 Typ snímku: Vlastnosti identifikace snímku. L.0

Úhel pøeklopení L.0 Úhel ustáleného stavu ve stupních, k nìmuž je pøeklopen 
magnetický vektor z magnetického vektoru primárního pole. L.0

Úhel sloupce L.0 Úhel rentgenových paprskù ve stupních vztahující se k 
ortogonální ose k rovinì detektoru.  
Kladné hodnoty oznaèují, že sklon smìøuje k èelu stolu. 
Má význam pouze v pøípadì, že typ polohovadla je COLUMN. 
Poznámka: Pøedpokládá se, že rovina detektoru je rovnobìžná s 
rovinou stolu. L.0

UID pøípadu studie L.0 Jednoznaèný identifikátor studie. L.0

Umístìní pacienta L.0 Popisuje aktuální známé umístìní pacienta. L.0

Umístìní plánovaného 
kroku postupu L.0

Umístìní, kam je provedení kroku postupu naplánováno. L.0

Verze kódovacího 
schématu L.0

Je požadována v pøípadì pøítomnosti položky poøadí a v pøípadì, 
že hodnota indikátoru kódovacího schématu není dostaèující 
pro jednoznaènou identifikaci hodnoty kódu. L.0

Voxel L.0 Zobrazení. Prvek objemu vzorku, který má být vyšetøen. 
Velikost voxelu = tlouš¤ka øezu x velikost obrazového bodu. L.0

Vyšetøující lékaø L.0 Pùvodní lékaø, který øídí dané vyšetøení. L.0

Vysílací cívka 
(MR) L.0

Použitá vysílací cívka. L.0

Význam kódu L.0 Je požadována v pøípadì pøítomnosti položky poøadí.  
Význam kódu je popisný text, který slouží uživatelùm 
informaèního objektu.  
Význam kódu je èistì poznámkový, popisný atribut. Z toho 
ovšem nevyplývá, že jej lze vyplnit libovolným textem. Lze 
použít pouze hodnoty definované kódovacím schématem. L.0
L–10 Návod k použití pro uživatele systému syngo
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Zorné pole (FOV) L.0 Parametr mìøení. Základní (plošná) velikost øezu, který se má 
zmìøit (v mm). Èím menší je zorné pole, tím vìtší bude rozlišení, 
protože voxely jsou pro stejnou velikost matice menší.  
Nìkdy se nazývá “pole mìøení”. L.0

Zvláštní potøeby L.0 Zvláštní pøípravy, které je u daného pacienta nutno provést 
(pacient je napøíklad upoután na invalidní vozík nebo je 
zapotøebí služeb tlumoèníka). L.0
Verze VE31D L–11 
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DODATEK 0.0
M

rze VE31D
r 2006
 
Rejstøík
3D

Automatické ukládání 
J.13–11
Filmování snímkù J.14–2
Konfigurace J.16–1
Kontrola vhodnosti dat 
J.2–3
MIP (projekce maximální 
intenzity) J.5–4
MIP Thin J.5–31, J.5–36
MPR (multiplanární 
rekonstrukce) J.4–1
MPR thick J.4–3
Nastavení pohledu letu 
Objektem J.12–13
Obrazová oblast J.1–11
Orientaèní krychle J.3–5
Orientaèní znaèky J.3–6
Ovládací oblast J.1–11
Pøesun obrazù z 
prohlížeèe Browser J.2–2
Pøesun obrazù z 
prohlížeèe Viewer J.2–2
Pøesunutí snímkù do 
prohlížeèe J.14–3
Popis orientace J.3–5
Režim VOI J.5–6
Referenèní segment J.3–8
Referenèní snímek J.3–11
Série ze seznamu 3D 
series List J.2–15
Seskupování snímkù 
podle typu výstupu J.13–7
Seznam sérií pro 3D (na 
jednom monitoru) J.2–6
SSD (zobrazení se 
Stínovaným povrchem) 
J.6–1

Udaje na snímku J.3–9
Uložení snímkù J.13–2
Uložit jako (celá série) 
J.13–9
Uložit jako (jednotlivé 
snímky) J.13–4
Výstupní segment J.3–8

3D Editor J.9–1
Morphological Operations 
J.9–41
Object Editor J.9–14
Object Punching J.9–34
Region Growing J.9–14

A

Antivirová ochrana A.3–1
Antivirová ochrana Siemens 
A.3–1
Aplikace A.2–2, A.3–13

Definované uživatelem 
C.3–8, D.3–6

Aplikace definované 
Uživatelem C.3–8, D.3–6

Konfigurace C.8–20
Archivace F.1–3

Chyby F.2–34
Na disk CD-R v režimu 
jedné relace F.2–17
Na disk CD-R v režimu 
vícenásobné relace 
F.2–24
Na médium MOD F.2–12
V síti F.2–32
Zobrazení ve stavovém 
øádku F.5–2

Archivace dat
Komprese dat F.6–14

Archivaèní média C.1–3, 
M–1 
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Rejstøík Dodatek

M–2
D.1–3
Naèítání dat C.2–26, 
D.1–3

Automatická aktualizace 
B.5–12
Automatická expozice G.2–9

Deaktivace G.2–10
Pøerušení G.2–11

Automatická registrace 
J.11–24, J.15–13
Automatické exponování na 
film G.1–3, G.2–2
Automatické vyvážení E.4–10
Autonavigace J.12–19, 
K.8–12

C

CD
Jednotka F.2–3
Vkládání F.2–4
Vysunutí F.2–6

CD-R
Jedna relace F.2–17
Pojmenování F.2–18
Vícenásobná relace 
F.2–24
Zápis F.2–22

Chyby
Bìhem pøenosu dat F.5–2
Bìhem ukládání F.2–34

Clear Scheduler C.6–16
Clona E.5–40
Configuration panel A.4–1
Curved ranges

Nastavení J.3–95

D

Data
Archivace C.5–2
Data série C.1–5, D.1–5
Data snímku C.1–5, D.1–5
Data studie C.1–5, D.1–5
Export na datové médium 
C.5–5
Filtrování dat C.2–12, 
G–11
Historie zmìn C.4–15
Import C.2–28, C.2–39
Nezpracovaná data 
C.1–5, D.1–5
Ochrana pøed 
odstranìním C.6–14
Odesílání pøes sí″  C.5–4
Odstraòování C.6–8
Oprava údajù o pacientovi 
C.4–2
Oznaèení C.6–6, D.2–10
Pøeskupování C.4–10
Sluèování C.4–10
Stav práce C.6–2
Stromová struktura dat 
C.2–2, D.2–2
Údaje o pacientovi C.1–5, 
D.1–5
Úroveò pøípadu C.1–5, 
D.1–5
Úrovnì dat C.1–4, D.1–4
Výbìr z archivaèních 
médií C.2–28
Zrušení oznaèení C.6–7, 
D.2–10

Data vyšetøení
Oprava C.4–2

Databáze
Návod k použití pro uživatele systému syngo
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Verze VE31D
únor 2006
Aktualizace C.2–5, D.2–4
Místní C.1–2
Plánovaè C.1–2

Datová média F.2–2
Zmìna C.2–27

Datum ukonèení platnosti 
licence B.5–10
Dialogové okno A.2–26
DICOM F.3–1

Formát F.4–1
Disketa

Vkládání F.2–5
Distanèní èára E.5–18

Pøesouvání E.5–20, 
J.3–61
Zmìna E.5–20, J.3–61

Dvojnásobnì naklonìná 
rovina øezu J.3–25, K.3–25

E

Èára
Výpoèet profilu E.5–26

Èára od ruky E.5–22, J.3–62
Bod po bodu E.5–22
Statistika E.5–24, J.3–63
Volný tvar E.5–23

Èasové rozpìtí B.5–13
Èíselná klávesnice A.2–8
Èíselník A.2–28
Èoèka obrazových bodù 
E.5–36, J.3–73

Prùbìžné zobrazování 
hodnot E.5–36, J.3–73

Exponování na film
Automatická expozice 
G.2–9
Expozice listu filmu 
G.2–14

Ovládací oblast G.3–11
Plný list filmu G.2–15
Plnì automatické G.1–3
Poloautomatické G.1–4
Postup s dvìma kroky 
G.1–2
Ruèní G.1–5
Standardní rozvržení 
G.1–8
Úloha zpracování filmu 
G.1–6
Vícenásobná úloha 
Zpracování filmu G.1–6
Virtuální list filmu G.1–7
Virtuální list filmu do 
kamery nebo tiskárny 
G.2–8
Volba úlohy zpracování 
filmu G.2–13
Z karty úlohy 3D G.2–5
Z karty úlohy Examination 
G.2–2
Z karty úlohy Viewing 
G.2–5
Z prohlížeèe G.2–5
Zobrazení listu filmu 
G.3–11

Export
Formáty snímkù F.4–1
Názvy souborù F.4–6

Export
Chyby F.2–34
Do systému souborù 
F.4–2
Na datové médium F.1–3
Obrazy F.1–4

Export snímkù
Do systému souborù 
C.5–6
M–3 
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M–4
F

Faktor zvìtšení E.4–24
Filmování snímkù C.5–7, 
D.3–9
Filtr

Deaktivace C.2–14, 
D.2–18
Filtry definované 
uživatelem C.2–15, 
D.2–13
Standardní filtry C.2–12, 
G–11
Ukládání C.2–18, D.2–16
Vyjmutí C.2–19, D.2–17
Vytvoøení C.2–15, D.2–13

Fokus E.3–33
Formátování F.2–8
Formáty

Pro export F.4–1
Formáty snímkù

Pro export F.4–1
Fúze J.11–21, J.11–34

Naètení nové série J.11–5
Spuštìní J.11–3
Vizuální vyrovnání 
J.11–12
Zmìna zobrazení J.11–41
Znaèka J.11–17

Fúzovaný volný pohled 
(volitelnì) J.11–47

G

Grafické nástroje
Aktivní/neaktivní E.5–2

Grafika
Zobrazení a skrytí G.4–14, 
J.8–4, K.3–47

H

Hibernate A.2–49
HIS/RIS B.1–2

Pracovní seznam C.1–2, 
C.2–4
Vyhledávání pacienta 
B.4–15

Histogram E.5–16, J.7–11, 
K.7–11
Historie zmìn C.4–1
Hodnoty vyvážení

Ukládání E.6–6

I

Identifikaèní èíslo pacienta, 
B.3–4, B.3–7
Import

Obrazy C.2–28, F.1–4, 
F.4–7
Ze systému souborù 
F.4–7

Informaèní oblast C.1–8, 
D.1–8

J

Jazyk
Nastavení A.4–7

Jedna relace F.2–15
Jednoduchý režim J.7–11, 
K.7–11
Jednotky F.2–3

Pøipojené C.1–3
Jezdec A.2–29
Jméno pacienta,

Oprava C.4–2
Jméno upravovatele C.4–6, 
Návod k použití pro uživatele systému syngo
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Verze VE31D
únor 2006
C.4–14
JPEG F.6–14

K

Kamera G.5–5
Chyba pøi exponování 
Filmu G.5–2
Vadná G.5–12
Vybírání G.3–6, G.4–2, 
G.5–11

Karta dílèí úlohy A.2–33, 
E.1–9
Karta úlohy A.2–32
Karta úlohy Filming

Spuštìní G.3–10
Klávesa Ctrl A.2–14
Klávesa Shift A.2–14
Klávesnice A.2–6
Klávesnice

Èíselná A.2–8
Symbol A.2–8

Klávesnice se symboly A.2–8
Záznam pacienta C.3–2

Kombinované okno A.2–28
Komentáøe ke snímku E.5–47
Komprese dat F.6–14
Konfigurace

Aplikace definované 
uživatelem C.8–20

Konfigurace listù filmu G.6–9
Rozdìlení listu filmu 
G.6–10
Velikost filmu G.6–8

Konfigurace textu snímkù 
A.4–8
Konfigurace uživatelského 
rozhraní

Automatický pøenos dat 

F.6–3
Definování rozvržení pro 
urèitou studii G.6–4
Hodnoty vyvážení 
specifické pro daný orgán 
E.7–8
Hodnoty vyvážení 
specifické pro daného 
uživatele E.7–8
Karta úlohy Viewing 
E.7–1
Komprese dat F.6–14
Nastavení listu filmu 
G.6–9
Nastavení úlohy 
zpracování filmu G.6–6
Odebrání položek 
seznamu z prohlížeèe 
C.8–12
Panel nástrojù prohlížeèe 
C.8–3
Pøidání položek seznamu 
do prohlížeèe C.8–12
Pøiøazování rozvržení 
filmu G.6–15
Potvrzení odstranìní 
C.8–5
Povolení k vymazání 
C.8–4
Pracovní seznam HIS/RIS 
B.5–9
Rozvržení filmu G.6–2
Skrytí úrovnì dat v 
prohlížeèi C.8–15
Smazání rozvržení filmu 
G.6–18
Výbìrové seznamy pro 
registraci pacienta B.5–2
Vyhledávání pacienta 
M–5 
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M–6
B.5–5
Zmìna standardního 
rozvržení G.6–3
Zobrazení seznamu/
zobrazení ikon v 
prohlížeèi C.8–16
Zobrazení stavu práce 
C.8–4
Zobrazování statistik 
oblastí ROI E.7–2
Zrušení pøiøazeného 
rozvržení G.6–18

Kontrola prostøedkù A.2–41
Kontrolní protokol A.1–2
Kopírování a vkládání A.2–15

Grafika E.5–50
Koronální pohled J.3–30, 
K.3–30
Kruhová ROI E.5–4
Krytí J.11–51
Kurzor A.2–3

L

Let
Obrazová oblast K.1–3
Ovládací oblast K.1–3
Pøesun obrazù z 
Prohlížeèe Viewer K.2–2

Let
Plánování dráhy letu 
K.8–13

List filmu
Kopírování G.3–27
Odstraòování snímkù 
G.3–24
Pøesouvání G.3–28
Procházení G.3–16
Výbìr více položek 

G.3–18
Volba segmentu G.3–19
Vybírání G.3–17
Záložky G.3–4
Zaplnìní G.3–7, G.3–25
Zobrazení G.4–4, G.4–5
Zrušení výbìru G.3–17

Lossy JPEG F.6–14

M

Maska viditelnosti J.3–47
Média

Vkládání a vysouvání 
F.2–4

Miniatury C.1–13, C.1–16, 
D.1–13, D.1–16
Minimální støední hodnota 
èoèky obrazového bodu 
E.5–39
MinIP (projekce minimální 
intenzity) J.1–5
Mìøení

Pixely pomocí nitkového 
køíže E.5–33
Úhel E.5–27, J.3–64
Vzdálenost E.5–18, 
E.5–22, J.3–62

MIP (projekce maximální 
intenzity) J.1–5, J.5–4, K.1–7, 
K.5–2

Radiální rozsah J.5–30, 
J.5–31, J.5–36

MIP Thin J.5–31, J.5–36
Série J.5–34, J.5–39

Místní databáze C.1–2
Místní nabídka

Pomocí kláves A.2–5
MOD F.2–6, F.2–12
Návod k použití pro uživatele systému syngo
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Verze VE31D
únor 2006
Finalizace média F.2–7
Formátování F.2–8, 
F.2–10
Jednotka F.2–3
Není zformátováno 
F.2–13
Plné F.2–14
Pojmenování F.2–9
Poznámky F.2–11
Vkládání F.2–4

Møížka E.5–42
Movie E.3–18
MPR (multiplanární 
rekonstrukce) J.1–3, J.4–1, 
K.1–5, K.4–1

Paralelní oblast J.4–6
Radiální rozsah J.4–6
Rozšíøená oblast J.4–6
Tlusté øezy J.4–3, K.4–3
Zakøivené èásti J.4–7

MPR Thick J.4–3, K.4–3
Myš

Klepnutí A.2–4
Kurzor myši A.2–3
Pøetažení a puštìní A.2–5
Poklepání A.2–4
Tažení A.2–4

N

Nabídka
Dílèí nabídka A.2–38
Místní A.2–39
Možnosti A.2–37
Øádek nabídek A.2–36
Rozevírací A.2–36

Náhled exponování na film
Odstraòování snímkù 
G.3–7

Ovládací oblast G.3–5
Pøidání snímkù G.3–8
Procházení listù filmu 
G.3–4
Spuštìní G.3–2
Úloha zpracování filmu 
G.3–4
Volba kamery nebo 
tiskárny G.3–6
Zavøení G.3–2
Zmìna vlastností filmu 
G.3–6

Naklonìné roviny øezu J.3–21, 
K.3–21
Naléhavý pøípad

Identifikaèní èíslo 
pacienta, B.3–4

Name
Oprava dat C.4–2

Nápovìda
Nápovìda online A.2–7

Nastavení MinIP J.3–43
Nastavení okna specifická pro 
orgán E.4–13
Nastavení okna specifická pro 
uživatele E.4–13
Nastavení pohledu letu 
objektem K.8–6
Navigaèní oblast C.1–8, D.1–8
Název dráhy J.12–23, K.8–16
Názvy souborù

Exportované snímky 
F.4–6

Nezpracovaná data C.1–5, 
D.1–5

Miniatury C.1–16, D.1–16
Nitkový køíž E.5–33
Nouzová registrace B.2–2
Nový list filmu G.3–8
M–7 
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M–8
O

Obdélníková ROI E.5–4
Obnovení zobrazení C.2–5, 
D.2–4
Obnovení zobrazení snímku 
E.4–31
Obraz

Miniatury C.1–16, D.1–16
Natáèení v trojrozmìrném 
zobrazení J.3–20
Oøezání dokumentu 
G.4–9
Otáèení ve virtuální 
endoskopii K.3–20
Pøizpùsobení segmentu 
G.4–9
Pùvodní snímek G.4–10
Zmìna mìøítka a posun 
G.3–34
Zobrazení textu G.4–12

Obrazová oblast E.1–4
Hodnoty vyvážení E.2–22
Mìøítko E.2–22
Orientaèní znaèky E.2–22
Poznámky ke snímku 
E.2–22
Textové informace 
E.2–22
Zmìna rozvržení E.2–18
Zobrazení/skrytí textu 
E.2–23

Obrazy
Exponování na film C.5–7, 
D.3–9, E.6–12
Export do systému 
souborù F.4–2
Import C.2–28, F.4–7
Import ze systému 

souborù F.4–7
Otáèení E.4–34
Pøeklápìní E.4–37
Pøevracení stupnic šedi 
E.4–39
Pøipojení ke stávající sérii 
E.6–5
Pøizpùsobení segmentu 
E.4–23
Posun E.4–29
Tisk E.6–12
Uložení snímkù jako nové 
série E.6–4
Vybírání E.3–32
Zmìna mìøítka E.4–22

Obsahová oblast C.1–9
Obsahová oblast D.1–9

Pøizpùsobení nastavení 
C.1–13, D.1–13

Ochrana proti zápisu F.2–5
Odeslání F.3–3

Automatické F.1–4
Chyby F.2–34
Ikony ve stavovém øádku 
F.5–2
V síti F.1–3

Odhlášení A.2–48
Odstranìní bodu J.12–23, 
K.8–16
Odstranìní kosti J.10–1
Odstraòování

Data C.6–8
Grafika E.5–51
Snímky na listu filmu 
G.3–7
Text A.2–18
Úloha zpracování filmu 
G.2–17

Øízení místních úloh F.5–4
Návod k použití pro uživatele systému syngo
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Øízení sí″ ových úloh F.5–5
Okno

Aktivní A.2–25
Konfiguraèní okno A.4–3
Maximalizovat A.2–21
Minimalizovat A.2–21
Nabídka pøíkazù pro okno 
A.2–19
Nastavení zobrazení okna 
A.2–19
Øádek nabídek A.2–19
Obnovit velikost A.2–21
Okraj A.2–19
Panel nástrojù A.2–19
Pøepínání mezi okny 
A.2–25
Pøesouvání A.2–23
Posunování A.2–24
Posuvník A.2–19
Pracovní plocha A.2–19
Stavový øádek A.2–19
Záhlaví okna A.2–19
Zavøení A.2–21
Zmìna velikosti A.2–22

Okno videosekvence J.5–45
Oøezání dokumentu G.4–9
Operaèní systém A.1–1

Windows XP® A.1–1
Oprava dat

Data vyšetøení C.4–2
Jméno pacienta, C.4–2
Jméno upravovatele 
C.4–6
Pacient již existuje C.4–8
Údaje o pacientovi 
B.4–14, C.4–2
Uložení zmìn C.4–7

Orientace snímku E.1–6
Orientaèní krychle J.3–5, 

K.3–5
Orientaèní znaèky J.3–6, 
K.3–6
Ortho Sync J.12–17, K.8–10
Otáèení

90° E.4–34
Proti smìru hodinových 
ruèièek E.4–35
Ve smìru hodinových 
ruèièek E.4–34
Volný úhel E.4–35

Otáèení MIP (volitelnì) J.5–41
Otáèení požadovaného 
objektu (VOI) J.5–10
Otevøení karty úlohy 3D J.2–5
Otevøení karty úlohy Fly K.2–6
Ovládací oblast E.1–7
Oznaèení

Položky dat C.6–6, 
D.2–10
Slova A.2–18
Text A.2–18

P

Pacient
Souøadný systém J.3–2, 
K.3–2

Panel nástrojù, C.1–8, C.8–3, 
D.1–8
Paralelní oblast J.3–83, J.3–93

Zmìna rozsahu J.3–87, 
J.3–97

Paralelní oblasti
Nastavení J.3–85

Pás E.2–13
Patient Worklist Query B.4–17
Plánovaè C.1–2

Aktualizace C.2–4
M–9 
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M–10
Plánování dráhy letu J.12–20
Pøedbìžná registrace B.3–1, 
B.3–28
Pøednastavené hodnoty 
J.12–14, K.8–7
Pøeklápìní

Horizontálnì E.4–38
Vertikálnì E.4–37

Pøenos
Chybová hlášení F.5–2

Pøenos dat
Obnovování úloh F.5–10
Odstranìní úloh F.5–12
Opìtovné spouštìní úloh 
F.5–11
Pozastavování úloh 
F.5–10
Stav F.5–8
Urgentní F.5–13
Zápis na disk CD F.5–12

Pøepínaè A.2–27
Pøesouvání

Referenèní linka J.3–14, 
K.3–14

Pøetažení A.2–15
Pøenášení dat z prohlížeèe 
Browser na kartu Viewing 
C.3–5, D.3–4

Pøetáèení J.12–16, K.8–9
Pohled letu objektem (FVV) 
J.12–1, J.12–10, K.8–1, K.8–3
Pohled stromové struktury 
C.2–2, D.2–2
Pohotovostní režim A.2–49
Pøihlášení A.1–1
Pøihlášení jiného uživatele 
A.2–48
Pøímé zpracování snímkù 
E.3–44

Pøizpùsobení segmentu 
E.4–23, G.4–9
Poklepání A.2–16
Pokroèilý režim J.7–13
Pokroèilý režim K.7–13
Polohová baterka J.12–27, 
K.8–20
Popis orientace J.3–5, K.3–5
Popis tlaèítka A.2–30
Posun E.4–29, G.3–34

Obnovení zobrazení 
snímku E.4–31
Pomocí myši E.4–29

Posunování E.3–2
Mezi sériemi E.3–12
Pacienti E.3–17
Po stránkách E.3–7
Pomocí klávesnice E.3–8
Pomocí posuvníku E.3–10
Pomocí záložek E.3–5
Postupné jednotlivými 
snímky E.3–4
Studie E.3–14

Posuvník A.2–24, E.3–10
Potvrzení odstranìní C.6–12, 
C.8–5
Potvrzení uložení C.6–9, 
C.8–6
Poznámky E.5–45, J.3–76
Pozorovací bod J.12–11, 
J.12–12, J.12–15, K.8–4, 
K.8–5, K.8–8
Pozorovací vzdálenost 
J.12–13, K.8–6
Práce s virtuální endoskopií

Obnova pùvodního 
Pohledu K.3–31
Pøepnutí na MIP K.3–41
Pøepnutí na MPR K.3–40
Návod k použití pro uživatele systému syngo

 0.0



Dodatek Rejstøík

Verze VE31D
únor 2006
Pøepnutí na SSD K.3–42
Zobrazení a skrytí grafiky 
K.3–47

Práce v trojrozmìrném 
zobrazení

Obnova pùvodního 
Pohledu J.3–31
Pøepnutí na MIP J.3–42
Pøepnutí na MPR J.3–41
Pøepnutí na SSD J.3–44
Zobrazení a skrytí grafiky 
J.8–4

Prahová hodnota
Pøednastavené hodnoty 
J.6–7, K.6–6
Vytváøení 
Pøednastavených hodnot 
J.6–12, K.6–11

Prahové hodnoty J.11–29
Procházení E.3–7
Profil E.5–26
Program

Spuštìní A.1–1
Ukonèení A.2–47

Prohlížecí nástroj F.2–16
Prohlížeè

Filtry na panelu nástrojù 
C.2–13
Informaèní oblast C.1–12, 
D.1–12
Objekty vícenásobného 
výbìru C.2–11, D.2–9
Pohled stromové 
struktury C.1–12, D.1–12
Pøizpùsobení nastavení 
obsahové oblasti C.1–13, 
D.1–13
Pøizpùsobení okna 
C.1–10, D.1–10

spuštìní C.1–6, D.1–6
Zmìna velikosti okna 
C.1–10, D.1–10
Zobrazení/skrytí èástí 
okna C.1–12, D.1–12
Zvìtšování/zmenšování 
navigaèní/obsahové 
oblasti C.1–11, D.1–11

Prohlížení
Grafické nástroje E.5–1
Informace o pacientovi 
E.1–7
Karty dílèích úloh E.1–9
Movie E.3–18
Naèítání snímkù s 
vícenásobným rámcem 
E.2–6
Naèítání snímkù z 
prohlížeèe E.2–2
Oblast zájmu (ROI) E.5–4
Pøenos snímkù na kartu 
úlohy 3D E.6–14
Pøetažení snímkù z 
prohlížeèe pomocí myši 
E.2–4
Posuvník E.3–10
Režim zobrazení E.2–11
Snímky, text a grafika 
E.1–5
Zavøení sérií E.6–16
Zavøení snímkù E.6–16
Zavøení snímkù pacienta 
E.6–17, J.14–6

Prohlížení
Rozvržení obrazové 
oblasti E.1–4, E.2–17
Textové bloky E.2–22

Protivirová ochrana A.1–8
Pùvodní snímek G.4–10
M–11 
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M–12
Q

Query & Retrieve 
Configuration C.2–41

R

Radial ranges
Nastavení J.3–108

Radiální rozsah
Generování J.3–106, 
J.3–117, J.6–15
Grafické zobrazení 
J.3–107
Nastavení J.3–119
Pøesouvání J.3–111
Zmìna J.3–110

Rastrový obrázek
Formát F.4–1

Režim Compare J.15–10
Režim Fúze J.11–39
Režim Multi View G–10
Režim porovnávání studií 
E.2–11
Record Off-line Files G–10
Referenèní body J.11–21
Referenèní èáry J.12–17, 
K.8–10
Referenèní linka

Volný úhel J.3–20, K.3–20
Referenèní snímek

Zobrazení G.4–15
Region Growing

Draw Blocker J.9–19
Seed Points J.9–19

Regional settings A.4–6
Registrace

Datum narození, vstupní 
formát B.3–8

Doplòkové údaje o 
pacientovi B.3–12
Identifikaèní èíslo 
pacienta, B.3–7
Lkaø, který si vyšetøení 
vyžádal B.3–15
Nouzová B.2–2
Nový pacient B.3–1
Ošetøující lékaø, B.3–15
Osobní údaje B.1–6
Pacient B.3–24, B.4–13
Podrobné informace 
B.3–12
Pøedbìžná registrace 
pacienta B.3–28, B.4–13
Pøíjmové identifikaèní 
èíslo B.3–16
Pokoj B.3–16
Povinné údaje B.1–6
Poznámky B.3–11
Spuštìní B.1–3
Údaje o doporuèení k 
vyšetøení B.1–6, B.3–15
Údaje o instituci B.1–6
Údaje týkající se studie 
B.1–6
Vstupní diagnóza B.3–15
Vyhledávací seznam 
dotazu na pracovní 
seznam B.4–19
Vyhledávací seznam 
registrace B.4–7
Vyhledávání pacienta 
B.4–4
Známý pacient B.4–1

Restart A.1–1, A.2–49
RIS/HIS B.1–2, C.1–2, C.2–4

Vyhledávání pacienta 
B.4–15
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ROI (pozorovaná oblast) E.5–4
Kruhová E.5–4
Obdélníková E.5–4
Pøesouvání E.5–6, J.3–69
Statistika E.5–13, J.3–72
Výpoèet histogramu 
E.5–16
Volné zakreslení E.5–7, 
J.3–70
Zakreslení E.5–5, G–68
Zmìna velikosti E.5–6, 
J.3–69

Rozšíøená oblast
Generování J.3–103
Nastavení J.3–104

Rozdìlení listu filmu G.6–10
Rozvržení 9/1 (volitelnì) 
J.11–19, J.11–36
Rozvržení filmu

Pro urèitou studii G.1–8
Standardní G.1–8
Zmìna pro aktuální úlohu 
G.1–8

Rozvržení pro urèitou studii 
G.1–8
Ruèní filmování G.1–5

S

Sada E.2–15
Sada parametrù

Automatické pøiøazení 
J.7–5, K.7–5
Manuální pøiøazení J.7–6, 
K.7–6
Vytváøení a úprava 
J.7–10, K.7–10

Sagitální pohled J.3–29, 
K.3–29

Schránka A.2–16, E.6–15
Search selected C.2–38
Servis

Místní servis A.5–4
Údržba A.5–2
Vzdálený servis A.5–5

Seznam dat
Tisk C.2–24, D.2–20

Seznam sérií pro 3D
Pøenos sérií na kartu úlohy 
3D J.2–12, K.2–12
Skrytí seznamu Invalid 
Series J.2–9, K.2–10
Sluèování sérií J.2–10, 
K.2–11
Zvoleno pøíliš mnoho 
snímkù J.2–8, J.15–7, 
K.2–9

Seznam sérií pro 3D (dva 
monitory) J.15–6
Seznam snímkù G–37
Seznam studií G–20
Sjednocování povrchù 
J.11–27
Skrytí dráhy J.12–24, K.8–17
Slab Editor

Otáèení trojrozmìrného 
bloku J.9–10
Pøesun trojrozmìrného 
bloku J.9–10
Zmenšení trojrozmìrného 
bloku J.9–9
Zvìtšení trojrozmìrného 
bloku J.9–9

Sluèování
Úloha zpracování filmu 
G.2–17

Smart LUT J.11–50
Snímky s vícenásobným 
M–13 
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M–14
rámcem
Naèítání k prohlížení 
E.2–6
Ikládání E.6–2
Zpracování obrázkù E.4–1

Souøadný systém J.3–2, K.3–2
Spuštìní programu A.1–1
SSD (Pohled letu) J.12–5
SSD (zobrazení se stínovaným 
povrchem) J.1–8, J.6–1, 
K.1–8, K.6–1

Tvorba snímkù J.6–2
Zahájení extrakce J.6–7, 
K.6–6
Zmìna prahových hodnot 
J.6–3, K.6–2

Standardní anatomický 
pohled J.3–4, K.3–4
Standardní pohled

Koronální J.3–4, J.3–30, 
K.3–4, K.3–30
Obnova J.3–31, K.3–31
Sagitální J.3–4, J.3–29, 
K.3–4, K.3–29
Transverzální J.3–4, 
J.3–28, K.3–4, K.3–28

Standardní rozvržení filmu 
G.1–8
Statistika

Zobrazení a skrytí E.5–14, 
E.5–21, E.5–25

Stav MPPS C.7–4
Stav oznaèení C.6–7, C.7–1
Stav pøehrávání J.5–42
Stav práce

Zadávání C.6–5
Zkratky C.6–2

Stav úlohy zpracování filmu 
C.5–10, D.3–12, G.5–4

Stav Zastaveno J.5–44
Stavový øádek A.2–40

Pøenos dat F.5–2
Støed okna E.4–3
Stupnice šedi E.4–39
SUV J.11–50

Š

Šíøka okna E.4–3

T

Text obrazu
Editor A.2–43

Text obrazu
Konfigurace A.4–8

Textové informace
Na snímcích A.2–43

Tiskárna G.5–5
Chyba pøi tisku G.5–2
Vybírání G.3–6, G.4–2

Tlaèítka
K provádìní pøíkazù 
A.2–29
Neaktivní A.2–30
Tlaèítko s ikonou A.2–30

Tlaèítko s ikonou A.2–30
Tlouš″ ka øezu (MPR Thick) 
J.4–3, K.4–3
Transversální pohled J.3–28, 
K.3–28
Typ komprese F.6–14

U

Uživatelské rozhraní
Nastavení jazyka A.4–7

Údaje o pacientovi
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oprava C.4–2
Úhel E.5–27, J.3–64

Zmìna E.5–30, J.3–67
Zmìna smìru úhlu 
E.5–31, J.3–68

Ukládání
Automaticky F.1–4
Hodnoty vyvážení E.6–6
Obrazy E.6–3

Ukládání dat F.2–1
Ukonèení

Program A.2–47
Režim VOI J.5–29

Uložení dráhy J.12–23, 
K.8–16
Úloha zpracování filmu G.1–6

Kontrola G.5–3
Manipulace G.5–8
Nìkolik listù filmu G.3–15
Odeslání do kamery nebo 
tiskárny G.2–13
Odstraòování G.2–17, 
G.5–10
Opakování G.5–9
Opìtovná aktivace fronty 
G.5–13
Otevøení G.3–12
Oznaèení G.3–12
Poèet kopií G.3–14
Pøesmìrování G.5–12
Pøidávání snímkù z karty 
3D G.3–30
Pøidávání snímkù z karty 
Viewing G.3–30
Pøidávání snímkù z 
Prohlížeèe G.3–30
Pøipojení nového listu 
filmu G.3–29
Pokraèování G.5–9

Sluèování G.2–17
Ukonèení G.5–9
Urgentní G.5–10
Vkládání G.3–28
Vybírání G.3–13
Zmìna priority G.5–10
Zobrazení G.3–4

Upozornìní
Chybná diagnóza z 
Dùvodu nedostateèné 
Kvality obrazu. H.1–11
Data mohou být pøiøazena 
K nesprávnému 
pacientovi. B.3–27
Data odeslaná/vyhledaná 
Z PACS nebo jiného uzlu 
se zdají být ztracena. 
C.2–29
Datový disk je plný a nelze 
provádìt další vyšetøení. 
Soubory nebudou 
uživatelsky odstranitelné. 
F.4–10
Datový disk je plný a nelze 
provádìt další vyšetøení. 
Uživatel už nemùže 
soubory smazat. H.1–10
Døíve uložená data již 
nelze èíst. F.2–24
Èoèka obrazových bodù 
mùže zobrazit nesprávné 
hodnoty. E.5–38
Èoèka obrazových bodù 
mùže zobrazovat odlišné 
hodnoty. E.5–38, J.3–75
Hrozí ztráta všech dat a 
poškození média F.2–11
Je možná nesprávná 
diagnóza. A.2–46
M–15 
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M–16
Jiný systém/zaøízení mùže 
ukazovat, že médium je 
prázdné, poškozené nebo 
data z poslední relace 
chybìjí. F.2–7
Ke ztrátì dat mùže dojít, 
pokud je odesílatel 
vymaže, napø. 
prostøednictvím 
automatického smazání, a 
pokud je pøíjemce nemùže 
uložit. C.6–9, C.8–6
Kvalita obrazu mùže být 
nedostateèná. J.2–11
Možná nesprávná 
diagnóza E.5–17, J.3–58
Možnost nesprávné 
diagnózy! G.1–1, G.1–9
Možnost zámìny pacientù 
a nesprávné diagnózy 
J.11–4, J.15–8
Možnost ztráty dat C.8–6, 
F.2–13
Mohou se zobrazit 
rozevírací okna a zpùsobit 
nedorozumìní. A.5–1
Mùže dojít ke ztrátì 
oblastí snímkù, které jsou 
dùležité pro stanovení 
diagnózy. C.5–1, F.1–10
Mùže dojít ke ztrátì 
výtisku obrazu. C.6–8
nebezpeèí poškození dat 
nebo systému! A.2–48
Nedostateèný podklad 
diagnózy J.15–4
Nemusí být viditelné 
všechny pøíslušné 
struktury tkánì. J.10–7

Nemusí být viditelné 
všechny pøíslušné 
struktury tkánì. 
Nepøíslušné zlomky 
mohou mít také vliv na 
další výpoèty. J.10–1
Neoèekávané chování 
systému. A.1–7
Neoprávnìný pøístup 
A.1–7
Nesprávný výpoèet SUV 
J.11–43
Nesprávná diagnóza 
J.4–10, J.11–1
Nesprávné obrazové 
informace mohou být 
pøíèinou nesprávné 
diagnózy C.4–10
Nevratné smazání všech 
dat uložených na médiu. 
F.2–8
Odkazy se mohou ztratit. 
C.4–11
Okna konfigurace 
Windows A.4–1
Pøi ukonèení vzdáleného 
servisu budou ukonèeny 
všechny servisní procesy a 
mùže dojít k selhání 
systému. A.5–6
Reference mezi obrazy a 
objekty RT nemohou být 
zachovány pøi opravì/
pøeskupení. C.4–11
Snížená kvalita obrazu 
(menší rozlišení) 
vzhledem k výchozí úrovni 
zvìtšení. J.4–5
Systém není v nouzových 
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stavech dostupný. A.2–42
Úpravy obrazù se mohou 
ztratit. E.6–2
Výsledné snímky již 
nejsou zcela identické s 
pùvodními snímky. Mùže 
dojít ke ztrátì informací, 
které jsou z lékaøského 
hlediska dùležité. F.6–15
Vyšetøení již není možné 
nebo vyšetøení je 
pøerušeno. H.1–11
Zobrazení jména, napø. 
jména pacienta, mùže být 
neúplné nebo zavádìjící. 
A.1–2
Ztráta dat F.2–3
Ztráta dat bìhem 
požadované doby 
uchování F.1–1
Ztráta dat nebo dojem 
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